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Chapter 1 : 

Introduction 

  

Welcome to LUSAS 

LUSAS is one of the world's leading structural analysis systems. By choosing to use 

LUSAS you are joining a large worldwide community of engineers who use LUSAS 

everyday to solve a wide range of engineering analysis problems. 

Before starting to use LUSAS it is strongly recommended that you read the Getting 

Started Guide in its entirety. It provides an essential overview of the LUSAS Modeller 

user interface and of the processes involved in creating models, running analyses and 

viewing results. The guide also lists the LUSAS documentation available for you to 

use and provides information on additional resources including how to obtain technical 

support. 

About LUSAS 

The LUSAS system uses finite element analysis techniques to provide accurate 

solutions for all types of linear and nonlinear stress, dynamic, and thermal/field 

problems. The two main components of the system are:  

 LUSAS Modeller - a fully interactive graphical user interface for model 

building and viewing of results from an analysis. 

 LUSAS Solver - a powerful finite element analysis engine that carries out the 

analysis of the problem defined in LUSAS Modeller. 

LUSAS Application Products 

LUSAS is made available as different application products with the user interface 

tailored specially to the needs of a particular application. `For example bridge 

engineers will see facilities provided specifically for the analysis of bridge structures. 

Such facilities are normally conveniently grouped together inside a product application 
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menu, such as Bridge, Civil, Composite etc, that is loaded between the Utilities and 

Window menu items in the main menu. The application products include: 

 LUSAS Bridge - for bridge engineering analysis, design and assessment. 

 LUSAS Civil & Structural - for civil, structural, nuclear, seismic, 

geotechnical and offshore engineering. 

 LUSAS Analyst - for automotive, aerospace, defence, manufacturing, and 

general engineering analysis. 

 LUSAS Composite - for engineers designing composite products or 

components. 

 LUSAS Academic - available to academic establishments for teaching and 

research use and allows use of all of the above products together with most of 

the options available for those products. 

LUSAS Product Options 

In addition to LUSAS software being provided as particular individual application 

products, product options are also available which extend the analysis capabilities of 

these products. Product options can be made available for use by the supply of an 

appropriate security key that 'unlocks’ the product option, allowing immediate access 

to the extended facilities in your currently installed software. If your current license 

doesn’t support these product options then please contact your LUSAS supplier to find 

out how you can gain access to them.  

The following software options are available for all products: 

 Fast Solvers - This option includes additional solvers. The Fast Multifrontal 

Direct Solver can provide solutions several times faster than the standard 

Frontal Direct Solver for certain analysis problems. The Fast Multifrontal 

Block Lanczos Eigensolver can, similarly, return results several times faster 

than the standard Frontal Eigensolvers for certain problems. The complex 

eigensolver provides efficient solutions for large-scale damped natural 

frequency problems. 

 Nonlinear - The Nonlinear option provides the very latest powerful techniques 

for solving problems having either material, geometric or boundary 

nonlinearity. 

 Dynamics - Straightforward modal dynamics problems can be solved using 

Interactive Modal dynamics (IMD) techniques provided in all LUSAS 

products. The Dynamics Option contains the facilities required to solve a wider 

range of dynamic problems in both the time and frequency domains. By 

combining the Dynamics and Nonlinear options both high and low velocity 

nonlinear impact problems can be solved using either implicit or explicit 

solution techniques. 
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 Thermal/Field - The Thermal / Field option contains extensive facilities for 

both simple and advanced steady state, and transient thermal / field analyses. 

By combining the Thermal / Field option with other appropriate options, heat 

transfer due to conduction, convection and radiation can be analysed. In 

addition, the effects due to phase change of material may also be included. 

 Heat of Hydration - Allows modelling the heat of hydration of concrete and 

hygro-thermal analysis.. The heat of concrete hydration can be computed 

during a thermo-mechanical coupled analysis and the temperatures and degree 

of hydration can be read into a structural analysis. Hygro-thermal analyses 

allow the determination of heat of hydration across a body of concrete, taking 

into account the availability of water for the exothermic reaction with time, 

based on the concrete mix, shape, exposed faces, insulated surfaces, 

environmental conditions etc. 

 IMDPlus - The IMDPlus option extends the Interactive Modal Dynamics 

(IMD) techniques provided in all LUSAS products. Whilst IMD models a 

single loading event in a single direction, IMDPlus allows multiple loading 

events with more advanced loading conditions to be solved. IMDPlus is used 

for three primary uses: Seismic response analysis of structures subjected to 

acceleration time histories of support motion; moving load analysis of 

structures, such as bridges, subjected to moving vehicle or train loads, where 

the magnitude and configuration of the loading remains constant throughout the 

analysis; and moving mass analysis of structures, such as bridges, subjected to 

moving vehicle or train loads, where spring-mass systems are used at the 

axle/bogie positions of a vehicle.  

  

The following options are available for LUSAS Bridge only: 

 Traffic Load Optimisation - The Traffic Load Optimisation facility 

complements and extends the vehicle loading capabilities of LUSAS Bridge 

and helps to simplify the evaluation of worst load position for various road and 

rail load configurations. Vehicle load optimisation is used to identify critical 

vehicle loading patterns on bridges and apply these loading patterns to analysis 

models. Rail load optimisation provides the means to define parameters for a 

particular design code, and generate the most critical rail track loading pattern 

for a selected track layout, for each influence shape under consideration. Both 

facilities reduce the amount of time spent generating models and leads to more 

efficient and economic design, assessment or load rating of bridge structures. 

 Steel and Composite Deck Designer - This carries out comprehensive 

calculations for multiple sections on steel or steel/composite bridge decks to the 

Eurocodes. 

 Rail Track Analysis - The Rail Track Analysis option permits track/bridge 

interaction analysis to the International Union of Railways Code UIC 774-3. It 

allows you to automatically build models from data defined in MS Excel 
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spreadsheets, run an analysis, and quickly produce results in spreadsheet or 

results file formats. 

The following options are available for LUSAS Bridge and LUSAS Civil & Structural 

only: 

 RC Frame Design - Design checks due to bending with or without axial force 

can be carried out for regular or arbitrary shaped reinforced concrete sections at 

the Ultimate Limit State (ULS) and Serviceability limit states (SLS) for a 

specified RC design code. 

 Steel Frame Design - Design code checking of steel members for a specified 

steel design code. Design check results are visualised as Utilisation ratios on a 

contour or values layer for a selected design code, and active load combination 

or design envelope. Results components for individual design checks can be 

chosen for viewing, and maximum utilisation factors can also be obtained. 

What's new 

When you run LUSAS Modeller you will be presented with information that links to a 

‘What’s new’ page.  Links on this page will tell you what has changed since the last 

major version and also cover any interim releases. It will be of particular interest to 

existing users upgrading from an earlier version of LUSAS. 

What is Finite Element Analysis? 

Until the advent of computers, the only way to find the answer to the engineering 

question "What would happen if I did this to my new design?" was to build a 

prototype and carry out the necessary tests. Today computers allow designs to be 

assessed much more quickly and easily. Evaluating a complex engineering design by 

exact mathematical models, however, is not a simple process.  

Since we cannot calculate the response of a complex shape to any external loading, we 

must divide the complex shape up into lots of smaller simpler shapes. These are the 

finite elements that give the method its name. The shape of each finite element is 

defined by the coordinates of its nodes. Adjoining elements with common nodes will 

interact. 

file:///C:/SVN/Content/whats_new/Whats_New.htm


  Chapter 1 : Introduction 

    

5 

Engineering Problem    Finite Element Model 

 

  

 

The real engineering problem responds in an infinite number of ways to external 

forces. The manner in which the Finite Element Model will react is given by the 

degrees of freedom, which are expressed at the nodes. For example, a three-

dimensional solid element has three degrees of freedom at each node representing the 

three global directions in which it may move. 

Since we can express the response of a single Finite Element to a known stimulus we 

can build up a model for the whole structure by assembling all of the simple 

expressions into a set of simultaneous equations with the degrees of freedom at each 

node as the unknowns. These are then solved using a matrix solution technique. 

For a mechanical analysis, once the displacements are known the strains and stresses 

can be calculated. For a thermal analysis, the gradients and fluxes can be calculated 

from the potentials. 

What Help and Documentation is Provided? 

Comprehensive documentation is provided with LUSAS. All documentation is 

available in electronic format. Some is available in the form of printed manuals.. 

The documentation includes: 

 Installation Guide 

 Getting Started Guide 

 Modeller Reference Manual 

 Worked Examples 

 Application Manual (Bridge, Civil & Structural) 

 IMDPlus User Manual 

 Rail Track Analysis User Manual 

 Element Reference Manual 
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 Solver Reference Manual 

 Theory Manual (Volume 1 and 2) 

 Verification Manual 

 CAD Toolkit User Manual 

 LUSAS Programmable Interface (LPI) Guides 

 LUSAS Programmable Interface (LPI) Online Help 

 LNG Tank System User Manual Part 1 - Tank Modelling 

 LNG Tank System User Manual Part 2 - Design Checking 

 Glossary 

 

Installation Guide 

 Details of installing LUSAS software for various licensing options. 

 Available in PDF and printed form. 

Getting Started Guide 

 Contains a brief overview of LUSAS. 

 Available in PDF and printed form. 

Modeller Reference Manual 

 Provides detailed reference material for modelling and results viewing with 

LUSAS Modeller. 

 Provided in on-line help format and also available in PDF and printed form. 

Worked Examples  

 General and application specific worked examples to help you get up to speed 

with modelling, analysis and viewing of results for a range of different analysis 

types. 

 Available in PDF and printed form. 
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Application Manual (Bridge, Civil & Structural) 

 Describes the bridge, civil and structural application specific features of 

LUSAS and their uses. 

 Available in PDF and printed form. 

IMDPlus User Manual 

Contains details of how to carry out multiple loading events with advanced loading 

conditions for three main uses: 

 Seismic response analysis of structures subjected to acceleration time histories 

of support motion. 

 Moving load analysis of structures, such as bridges, subjected to moving 

vehicle or train loads, where the magnitude and configuration of the loading 

remains constant throughout the analysis. 

 Moving mass analysis of structures, such as bridges, subjected to moving 

vehicle or train loads, where spring-mass systems are used at the axle/bogie 

positions of a vehicle. The configuration of the systems remains constant 

throughout the analysis but as they move across the structure, the dynamic 

response of the unsprung and sprung masses affects the loading acting on the 

structure due to inertia effects. 

 Provided in on-line help format and also available in PDF and printed form. 

Rail Track Analysis User Manual 

 Provides detailed reference material for the Rail Track Analysis option which 

permits track/bridge interaction analysis to the International Union of Railways 

Code UIC 774-3. 

 Available in PDF form. 

Element Reference Manual 

 Contains full element specifications. This is the place to go to find out which 

functionality your elements support and what output you will obtain from your 

element selection. 

 Provided in on-line help format and also available in PDF and printed form. 
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Solver Reference Manual 

 The data files required by the LUSAS Solver can be edited directly with a text 

editor. This manual contains full details of the data syntax supported by 

LUSAS Solver. 

 Available in PDF and printed form. 

Theory Manuals (Volume 1 and 2) 

 These contain more detailed theoretical information for the more experienced 

user. They cover topics specific to LUSAS and where appropriate list 

references to other publications. The topics covered include: 

 Analysis procedures including: linear, nonlinear, dynamics, eigenvalue 

extraction, modal analysis, all forms of field analysis, fourier analysis 

and superelement analysis. 

 Geometric nonlinearity. 

 Constitutive material model formulations. 

 Loads and boundary conditions with particular reference to general load 

types, constraint equations, slidelines and thermal surfaces. 

 More complex post processing calculations, including nodal 

extrapolation and calculation of Wood-Armer reinforcement moments. 

 Element formulation theory. 

 Available in PDF and printed form. 

Verification Manual 

 A manual of LUSAS testcase examples benchmarked against known solutions. 

 Available in PDF form only. 

CAD Toolkit User Manual 

 Describes interfaces to LUSAS involving the use of external pre- and post-

processing packages. 

 Provided in PDF form only. 



  Chapter 1 : Introduction 

    

9 

LUSAS Programmable Interface (LPI) Customisation and 

Developer Guides 

 Provides information for users and application programmers wishing to 

customize the LUSAS environment or interface LUSAS with other 

applications. 

 Available in PDF form only. 

LUSAS Programmable Interface (LPI) Online Help 

 Provides information for application programmers wishing to customize the 

LUSAS environment or interface LUSAS with other applications. 

 Provided in on-line help format only. This can be accessed from the Start > All 

Programs > LUSAS > LUSAS Help menu. 

LNG Tank System User Manual Part 1 - Tank Modelling 

 Provides information for building base models of full containment circular 

tanks. 

 Available in PDF form only. 

LNG Tank System User Manual Part 2 - Design Checking 

 Provides information for carrying out design check of full containment circular 

tanks. 

 Available in PDF form only. 

Glossary 

 Contains definitions of general terms used in all manuals. 

 Provided in on-line help format only. 
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Chapter 2 : Using 

Modeller 

  

Using LUSAS - An overview 

Carrying out an analysis with LUSAS will involve three main stages:  

 Modelling 

 Running the analysis 

 Viewing the results 

 

Modelling is sometimes referred to as ‘pre-processing’ and viewing and manipulating 

the the results is sometimes referred to as ‘post-processing’. Further details of these 

stages are provided below. 

Model Types 

Two types of model can be created in LUSAS:  

 Feature-based geometry models these are based on features (such as points, 

lines, surfaces and volumes) that are defined inside LUSAS, or are created from 

imported geometry and require the definition of mesh objects such as elements 

with their associated nodes.  

 Mesh-only models - these comprise only mesh objects (elements and their 

associated nodes, edges and faces) and are created by importing only those 

types of LUSAS model data, or third party data that are supported. 

 

With very few exceptions the majority of LUSAS models are featured-based. 
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Modelling 

Modelling involves creating a geometric representation of a structure and defining its 

characteristic behaviour in terms of its physical properties such as material, loading, 

and support. 

Geometry 

Within LUSAS Modeller the geometry of the model is defined using points, lines, 

surfaces and volumes. A volume needs surfaces to enclose it and to define its 

boundary. Similarly a surface needs lines to form its perimeter and lines need points to 

define their ends. The shape of a surface between its boundary lines, and the shape of a 

line between its end points can be simple (straight lines, flat surfaces) or complex, 

depending on the manner in which it was created.  

Many different tools exist within LUSAS Modeller to aid the creation of geometry. In 

particular the geometry can be entered numerically, in terms of coordinates, by cursor 

(using the mouse) or by copying, splitting, intersecting and transforming previously 

existing parts of the model. Geometry can also be imported from third-party interface 

files. 

Meshing attributes 

Whilst points, lines, surfaces and volumes allow the geometry of the problem to be 

represented or imported, to solve the problem, the geometric features must be broken 

down into discrete nodes and elements. This process is known as meshing and the 

collective term for all the elements and nodes, once created, is the 'Mesh'. Special 

attributes, called mesh attributes, are created and assigned to relevant geometry 

features to define the type and number of nodes and elements that will be used to 

represent each part of the geometry. 

A significant advantage of this approach is that the density of the mesh can easily be 

changed without rebuilding the geometry or reassigning any attributes. Simply 

modifying a mesh attribute automatically changes the mesh density in any part of the 

model where it is assigned. 

Similarly, the element type can be changed in exactly the same way. Different element 

types are suitable for different kinds of analysis, and the system provides an easy way 

to change from one to another. 

Generally LUSAS Modeller automatically and incrementally updates the mesh 

whenever a change is made to any part of the geometry or any mesh attributes. 

However these automatic updates are not allowed when results are being displayed, 

and they can also be switched off if at other times if required, for example to save 

time. This is known as locking the mesh. When the mesh is locked it will only be 

updated when specifically requested. 
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Other attributes 

Other attributes are used to define aspects of the behaviour of parts of the model, or 

the external factors which are imposed on it. Within LUSAS Modeller, there are 

several types of attribute such as materials, loading and supports. Within each attribute 

type there may be further sub-divisions, for example there are isotropic materials, 

anisotropic materials, and orthotropic materials, among others. 

In each case an attribute is first created, and then subsequently attached to all or 

selected parts of the model. This attachment process is known as assigning. Thus a 

material can be assigned to a line. Once assigned, the line takes on the properties of 

the material until further notice. Assignment often involves specification of additional 

information that does not define the attribute or the geometry, but rather defines how 

one is applied to the other. This includes directions, scale factors and similar.  

A special attribute, called a geometric attribute, is used when some or all of a model is 

comprised of lines or surfaces. In this situation, LUSAS Modeller needs to know the 

cross-sectional appearance and behaviour of lines, and also how thick the surfaces are. 

Geometric attribute assignments provide this information, and therefore form part of 

the model’s appearance. Models comprised entirely of volumes do not need geometric 

assignments. 

Many different tools exist within LUSAS Modeller to give interactive feedback on the 

nature of assigned attributes. This process is generally termed visualisation. 

Visualisation usually takes the form of coloured infills, arrows, textual labels or 

similar. 

Analyses 

Within a single model file any number of analyses may be defined. Each analysis will 

inherit most of the assignments, options and settings of what is called the base analysis 

for the model. Use of the multiple analyses facility does away with the need to create 

separate models, or maintain “clone” copies of a model, in order to switch between 

and create results from linear static analysis and other analysis types. 

Loadcases 

In a linear analysis, it is convenient to gather certain types of applied loading together, 

if it is applied at the same. for example gravity and wind loading which are applied at 

the same time. A loadcase is the term for such a collection of loading. Each loadcase is 

solved separately and the results are available separately. Results can be combined 

together during the results viewing stage if required. 

In a nonlinear analysis, LUSAS loadcases are equivalent to analysis stages. Within 

each loadcase, the loading, supports, or type of analysis can be changed. Control 

parameters can be set for each loadcase. 
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Utilities 

Some kinds of analysis require or create extra data that is similar to attributes, but 

cannot be assigned to geometry. LUSAS Modeller refers to such data as utilities. 

Tendon profiles, reference paths and the settings made or entered to plot a graph, for 

instance, are all examples of utilities. 

Controls 

Finally, for analyses other than simple linear static, it is sometimes necessary to 

control the analysis process itself.  LUSAS Modeller uses controls for this purpose. 

Controls are either nonlinear, transient, eigenvalue or fourier in nature. 

Further Modelling Information 

Browse the LUSAS Modeller interactive online help system, or see the Modeller 

Reference Manual for detailed information about any of the above.  

Running the Analysis 

Once the modelling process is complete, the model is passed to LUSAS Solver for 

analysis. LUSAS Solver will then create results that are automatically loaded back into 

modeller for viewing and optional post-processing. 

Viewing the Results 

Results are available to be viewed in many different ways, and the results can, if 

desired, be combined with attribute visualisation to make a plot, for example, that 

shows the applied loading and the resulting deformations. 

This is just a selection of some of the results facilities that are available: 

 Averaged (also known as smoothed) contours 

 Unaveraged (also known as unsmoothed) contours 

 Inspection locations 

 Deformed mesh 

 Wood-Armer reinforcement calculations 

 Slicing a plane through a solid 

 Slicing a line across a surface 

 Yield markers 

 Graphs 

 Vectors of stress, displacement, reactions, etc. 

 Animations of the above, either through time or in response to excitation. 
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 Combinations and envelopes of results. 

 Model reports 

Worked examples 

A large selection of tutorial examples are available to help you to get up to speed with 

LUSAS and it is strongly recommended that you work your way through a selection of 

the examples to get a feel for the software before starting on your particular problem.   

See Online help > Worked Examples for more information. 

Modeller Licence Selection 

When running LUSAS, the Modeller licence selection dialog lists all software 

products that are available for selection, along with details of the licenced product 

options, licence type, server name, number of available licences and the number of 

days left until expiry. Invalid licences (those that have already been completely taken 

by others prior to the display of this dialog, or are unavailable for some other reason) 

are greyed out. Licences expiring within 14 days are displayed in red. 

The licence selection dialog is always displayed on start-up of LUSAS unless it has 

been disabled by unchecking an option on the Licencing page of the LUSAS 

Configuration Utility, or unless there is only one licence available to LUSAS. 

Use the Modeller licence selection dialog to select a licence for use. Use the LUSAS 

Configuration Utility to add licences to the list of those available. 
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License order and usage 

Standalone or network licences are 'tumbled' based upon Configuration Utility 

settings. The order of the licence types listed on the Modeller licence selection dialog 

follows the order of the keys set on the Licensing page of the LUSAS Configuration 

Utility. If the display of the main licencing dialog has been disabled the first licence in 

the list of those available will be used in preference to all others. As licences are used 

the number of licences available for others to use is updated accordingly. When 

LUSAS Modeller is run the system will work its way down the list of licences until a 

valid and available licence is found.  

Creating shortcuts 

 The Create shortcut... button provides the means to tie a licence type to a 

shortcut used to run Modeller or Solver and with the choice to Emulate LT or 

use Teaching and Training limits. It enables LUSAS Modeller or LUSAS 

Solver to run without having to select a licence type each time (unless that 

licence has already been used).  

Example of shortcut created: 

 <LUSAS Installation folder>\Programs\lusas_m.exe 

LICNAM=[SENTINELLM,TECHNICAL01,6274(6270)] 
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Licence details 

 By selecting a licence and then selecting Licence details additional information 

such as the product options, the licence version, the Key ID and the licence 

expiry date can be viewed. 

 Selecting a licence that is invalid and clicking the licence details button will 

yield extra details as to why the license in unavailable. 

Refresh 

 Refresh simply updates the numbers of licences available. 

Emulating LT Behaviour   

 When Emulate LT is selected it restricts the user interface to that of an LT 

licence, even though the selected licence may be a standard or plus licence. 

This may be of use when training staff who are new to LUSAS. 

Teaching and training limits 

 When Teaching and training limits is selected no licence is taken. 

LUSAS can be used as normal for this session only but with the restricted 

model size, node, element and loadcase limits of the Teaching and Training 

version. 

The LUSAS Modeller User Interface 

The principal regions and components of the Modeller user interface are described 

here. 
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Main Menu and Toolbars 

The main menu and associated toolbars which contain toolbar buttons provide the 

means to define model related geometry and other data. On initial start-up of LUSAS 

Modeller the Main, Define and View Toolbars are displayed. All toolbars can be 

shown, hidden, or customised, using the View> Toolbars menu item.  

Choosing an analysis category when defining a new model modifies the user interface 

to generally show only those menu items, dialog options and settings that are 

appropriate to the analysis category stated 

View window 

A View window is where each model is developed and manipulated. Any number of 

view windows can be created with each displaying a unique view of a model. Pre-

defined view layers inside each window show/visualise/draw model information that 

can be generally manipulated in the current view window as required. 

Modelling in LUSAS 

A LUSAS model is graphically represented by geometry features (points, lines, 

surfaces, volumes) which are assigned attributes (mesh, geometric, material, support, 

loading etc.). Geometry is defined using a whole range of tools under the Geometry 

menu, or the buttons on the Toolbars. Attributes are defined from the Attributes menu. 

Once defined, attributes are listed in the relevant Treeview panel. 

Main Panels 

Six main panels each with its own Treeview provide access to model and results data 

and show a list of objects of a particular type. These panels are visible by default, but 

can hidden / made visible by selecting the View > Main Panels menu item. They are: 

  Layers - controls the display of model data and results data to a view 

window. Each drawing layer is responsible for drawing one particluar aspect of 

this data such as geometry, mesh, and attributes layers for instance. See Layers 

for more information. 

  Groups - used to store selected user-defined collections of objects 

(geometry, nodes or elements) under a collective name. See Groups for more 

information. 

  Attributes is used to store named collections of data that may be attached 

(assigned) to the model geometry, such as the element type and discretisation 

on the geometry; section properties and thicknesses; the materials used; how 

the model is supported or restrained; and how the model is loaded. See 

Attributes for more information 
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  Analyses - shows all analyses that have been defined including loadcases, 

eigenvalues, results, and control chapters. Also in this treeview are post-

procressing concepts such as combinations and envelopes. See Analyses 

Treeview for more information. 

  Utilities - contains utility items used in the definition of model geometry or 

attributes, or to control an analysis, or to provide a particular functionality, such 

as to define a load combination or produce a report for example. See Model 

Utilities for more information. 

  Reports - contains named reports, each of which is made up of multiple 

chapters. Chapters may be defined to view modelling information, results, 

screenshots and similar. See Generating reports for more information. 

Two other main panels provide details of properties and associativity for selected 

objects. The panels are hidden until accessed by a selecting a feature/object and 

choosing the relevant context menu item for that feature/object. They can also be made 

visible by selecting the View > Main Panels menu item. The panels can be docked, 

and separate tabs are provided for each panel when done. Double-clicking a docked 

window will isolate it again. The panels are: 

 Properties - displays the current properties of selected geometry features 

(points, lines, surface, volumes) and selected mesh objects (nodes, edges, 

elements, faces). See Properties Panel for more information.  

 Hierarchy - shows the merge status, and lists the higher and lower order 

features/objects of a single selected geometry feature or mesh object. The type 

and feature number of the selected feature is shown. Selection of a feature 

within the hierarchy panel will update the panel to show the hierarchy for that 

feature. The following setting and listing options are provided: 

 Is mergable (only present for Geometry features) Sets the merge status. 

 Lower order (not applicable to Points) Lists the lower order features that 

define the selected feature. 

 Higher order (not applicable to Volumes) Lists the higher order features 

that the selected feature defines. 

Manipulation of data in a Treeview 

Treeviews use drag and drop functionality. For example, an attribute in the Attributes 

 Treeview can be assigned to pre-selected model geometry by dragging the 

attribute into the model View window, or by copying and pasting an attribute onto 

another valid Treeview item as for instance, a group name, as held in the Groups  

Treeview. 

All Treeviews (with the exception of the Layers  Treeview) support multiple 

selection of objects in that treeview in order to carry-out a subsequent operation on the 

selected items, such as a deletion or a copy, for instance. Selection-specific context 
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menus provide additional options. When selecting treeview objects the following 

applies: 

 Left-clicking on an item clears the previous selection and sets this item as the 

only one selected. 

 Pressing the Ctrl key and left-clicking on an item toggles the items selected 

status between on and off 

 Pressing the Shift key and left-clicking on two items allows a range to be 

selected between the first item and the last one selected. 

 A multiple selection is also available by clicking and dragging to define a 

rectangular area inside the Treeview control.  

 Right-clicking following a selection displays a context menu specific to the 

selection made. 

Only appropriate context menu options are provided for multiple selected items. For 

instance a 'Deassign' option may be provided because it would be valid for all objects, 

but an 'Assign' option will be disabled because confusion could occur over the 

additional data required, for example loadcase or analysis. 

See Treeview icons for details of treeview content. 

Selection Panels 

These panels are not displayed by default but can be viewed by choosing the 

appropriate the View> Selection Panels menu item, or by right-clicking in a view 

window and selecting the appropriate context menu item. The windows can be docked, 

and separate tabs are provided for each window when done. Double-clicking a docked 

window will isolate it again. 

 Selected Items This panel can be viewed using the View> Selection Panels > 

Selection menu item. Once visible it will contain a list of all currently selected 

items which may then be individually deselected. 

 Selection Memory This panel can be viewed using the View> Selection Panels 

> Memory menu item. Once visible it will contain a list of all items currently in 

Selection Memory which may then be individually deselected. 

 Cyclable Items This panel can be viewed using the View> Selection Panels > 

Cyclable Items menu item. Once visible it will contain a list of all cyclable 

items. Where multiple items could possibly be selected by the same mouse 

click, cycling is the process of stepping through those items one at a time. An 

item can then be individually selected or deselected. 
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 Visible items This panel can be viewed using the View> Selection Panels > 

Visible Items menu item. Once opened it contains details of all visible items 

selected in the view window. 

LPI Command Bar 

The LUSAS Programmable Interface (LPI) Command Bar window can be added to 

the user interface by using the View > LPI Command Bar menu item. For advanced 

use, it allows typing of commands that would otherwise be chosen or selected within 

the Modeller user interface. See the LUSAS Programmable Interface Customisation 

and Automation Guide for more details. 

Text Output Window 

The Text Output Window displays messages and warnings during a modelling session. 

When an error message or warning relating to a particular object is written to the text 

output window, extra information is sometimes available by double-clicking on that 

line of text. 

Status Bar 

The Status Bar displays progress messages and help text during a modelling session, 

the model units, the current cursor position in model units (if the model is displayed in 

an orthogonal plane) and the item or number of items in the current selection. X, 

Y and Z panel entries, when clicked, will orientate the model to align with those axes. 

The View> Status Bar menu item may be used to hide or show the Status Bar. 

Datatips and Tooltips 

Datatips and Tooltips provide basic information about whatever is under the cursor. 

Datatips generally report on information within a Modeller view window such as 

model geometry, attributes and assignments etc. Tool tips report on uses of toolbar 

buttons or expected input for grid cells etc. 

Context Menus 

Although commands can be accessed from the main menu, pressing the right-hand 

mouse button with an object selected usually displays a context menu which provides 

access to relevant operations. Treeview panel items also have a context menu which 

provides access to additional functionality such as editing of data, control of visibility, 

visualisation of assignments, and selective control of results plotting on selected 

attributes. Right-clicking in most Treeview panels provides a sorting capability. 

Property Dialogs 

General data relating to a model are presented in property dialogs. Properties may 

relate to the whole model or the current window, or a single geometric feature. Most 

objects have properties. To view an object’s properties, select it, press the right mouse 
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button, then choose Properties from the context menu. Geometric properties of 

features or mesh objects are shown in a Properties panel. 

Online Help 

LUSAS contains a comprehensive online help system. 

 Most dialogs include a Help button which provides information on that dialog. 

 Selecting Help > Help Topics from the main menu provides access to all the 

Help files. 

If the Help Contents, the Help Index and the Search facility are not shown when a help 

page is first displayed pressing the Show button will show these tabs in the HTML 

Help Window. 

Treeview Panels and Icons 

Treeviews 

The Tree Frame of the Modeller User Interface has six tabbed panels each with its 

own Treeview. The Treeviews provide access to model and results data and show a 

list of objects of a particular type. The Treeview panels comprise: 

 Layers  

 Groups  

 Attributes  

 Analyses   

 Utilities   

 Reports   

Whilst the icons seen in the various Treeview panels are generally described in 

relevant sections of the Modeller User Manual for completeness they are also 

summarised here. 

Layers Treeview  

A symbol adjacent to each layer name in the Layers  Treeview shows the display 

status of each layer:  

 The display of a layer has been turned 'on' (coloured layers image) 

 The display of a layer has been turned 'off' (greyed-out layers image) 
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 No results are loaded or currently available for this layer, or inappropriate settings 

have been defined (red circle with a line through it) 

 View properties: options and settings 

Groups Treeview  

A symbol adjacent to each group name in the Groups  Treeview shows the 

visibility and status of each group. 

 Default group icon. 

 The addition of a black dot denotes the current group into which all new geometry 

will be added when created.  

When 'Show visibility feedback in treeview' is selected the following group icons are 

provided: 

 All of the objects in this group are visible (green tick)  

 The addition of a black dot denotes the current group into which all new 

geometry will be added when created.  

 Some of the objects in this group are visible (blue tick)  

 None of the objects in this group are visible (red cross)  

When 'Show visibility feedback in treeview' is selected and a results file is loaded the 

following icons are provided: 

 All of the objects in this group are showing results (green tick, green border) 

 Some of the objects in this group are visible and some are showing results (blue 

tick, blue border) 

 All of the objects in this group are visible but only some are showing results 

(green tick, blue border) 

Note that visibility feedback is intended for relatively few numbers of groups. 

Attributes Treeview  

A symbol adjacent to each attribute name in the Attributes  Treeview shows the 

status of each attribute present. 

 An attribute has been assigned to the model (coloured image) 
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 An attribute has yet to be assigned to the model or used in the definition of another 

attribute (grey image) 

 A black dot on a coloured attribute icon shows that an attribute which has been 

assigned to the model has been set active (for example setting active a local coordinate 

assignment). 

 A black dot on a grey attribute icon shows that an attribute which has yet to be 

assigned to the model has been set active. 

 Fibre in a structural analysis, or active lamina in a composite analysis.  

 Active fibre in a structural analysis, or active lamina in a composite analysis.  

 An attribute icon (coloured or grey) with a surrounding red box indicates an 

attribute that has been set as default, meaning it will automatically be assigned to 

features of the model as they are generated. 

 A 'Not valid' symbol shows that an attribute assignment is pending or invalid in 

some way, requiring investigation and correction. 

 A warning symbol will appear in the following situations: 

  If any attributes that were previously created have been superceded by a 

change to a model. In this case a model must be re-solved to re-create those 

attributes.. 

 If attributes defined are not compatible with a stated analysis category. 

 Direction definition options 

Analyses Treeview  

A symbol adjacent to each analysis or loadcase related entry in the Analyses  

Treeview shows the status of each entry. 

 A 'base' analysis on which any other analyses present may be dependent upon 

(green 'solve' symbol) 

 An analysis that may be dependent upon a 'base' analysis (cyan 'solve' symbol) 

 A branched analysis (magenta 'solve' symbol) 

 A black dot on an analysis icon (green, cyan or magenta) indicates the analysis 

contains the active loadcase 

 Vehicle Load Optimisation results folder 
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 Rail Load Optimisation results folder 

 Onerous results table 

Load curves 

 Active load curve (coloured load curve image) 

 Inactive load curve (greyed-out image) 

 Loading assignments should be moved to the load curves 

Loadcases 

 Active loadcase (coloured loadcase image) 

 Inactive loadcase (greyed-out image) 

 Active loadcase with gravity assigned as a property of the loadcase (coloured 

loadcase image with a loading arrow) 

 Inactive loadcase with gravity assigned as a property of the loadcase (greyed 

loadcase and loading arrow) 

 Active influence prior to being solved 

 Inactive influence prior to being solved 

 Active loadcase has results available (coloured results contour image)  

 Inactive loadcase has results available (coloured results contour image)  

 Active loadcase has results available and gravity was assigned to the loadcase as a 

property of the loadcase (coloured results contour image with a loading arrow) 

 Inactive loadcase has results available and gravity was assigned to the loadcase as 

a property of the loadcase (greyed-out results contour image with a loading arrow) 

 Active loadcase has gravity assigned to the loadcase as a property of the loadcase 

but the loadcase is turned off for solving (coloured loading arrow with a red cross) 

 Inactive loadcase has gravity assigned to the loadcase as a property of the loadcase 

but the loadcase is turned off for solving (greyed-out loading arrow with a red cross) 

 Active loadcase does not have gravity assigned to it as a property of the loadcase 

and the loadcase has been turned off for solving. (red cross) 

 Inactive loadcase does not have gravity assigned to it as a property of the loadcase 

and the loadcase has been turned off for solving. (grey cross) 
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 Combination and envelope results options; Nonlinear and Transient options; 

Nonlinear options 

Post processing 

 Active load combination (coloured loadcase image with a plus symbol) 

 Inactive load combination (greyed-out loadcase image and plus symbol) 

 Active load combination containing a combination of data that warrants a warning 

(coloured loadcase image with a plus symbol and warning triangle). Hovering over the 

icon will show a datatip stating why the warning has been issued. 

 Inactive load combination containing a combination of data that warrants a 

warning (coloured loadcase image with a plus symbol and warning triangle) Hovering 

over the icon will show a datatip stating why the warning has been issued. 

 Active envelope (coloured loadcase image with an envelope symbol) 

 Inactive envelope (greyed-out loadcase image and an envelope symbol) 

 Active load envelope containing a combination of data that warrants a warning 

(coloured loadcase image with an envelope and warning triangle). Hovering over the 

icon will show a datatip stating why the warning has been issued. 

 Inactive load envelope containing a combination of data that warrants a warning 

(greyed-out loadcase, envelope and warning triangle). Hovering over the icon will 

show a datatip stating why the warning has been issued. 

 Active RC Frame Design loadcase (coloured loadcase image with a stylised 

symbol of a reinforced member) 

 Inactive RC Frame Design loadcase (greyed-out loadcase image with a stylised 

symbol of a reinforced member) 

Cable tuning 

 Active cable tuning results loadcase (coloured cable stay image) 

 Inactive cable tuning results loadcase (greyed-out cable stay image) 

 Inappropriate settings have been defined (red circle with a line through it) 

Target values 

 Active target values loadcase (coloured target image) 

 Inactive target values loadcase (greyed-out target image) 
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 Inappropriate settings have been defined (red circle with a line through it) 

Influence analysis 

Various to show influence point defined.  

Other 

 Model properties options and controls; Coupled analysis options; Solver options; 

Combination and Envelope options 

Utilities Treeview  

Icons used in the Utilities  Treeview: 

 Graph created by the Graph Wizard Utility 

 Graph set to not auto-update on screen or if added to a report 

 Saved view 

 Print Results Wizard table entry 

 Used for all other general utility entries such as graph datasets, variation data, 

tendon data etc. 

Bridge generator icons 

 Composite I-girder section 

 Girder 

 Span 

 Support 

 Bridge 

 Stiffener 

  Bracing assembly 

 Bracing run 

Reports Treeview  

Icons used in the Report  Treeview: 

 Main report entry 
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 Model or results chapter 

 Image entry (chapter) - note that manual inserted image data does not 

automatically update each time a report is generated. 

 Saved view entry (chapter) - automatically updates each time a report is updated 

 One-click report entry (chapter) 

 Graph entry (chapter) 

Creating a New Model 

A new model is created by using the File> New menu item.  

File name 

Creating a new model requires a model file name to be entered. A short model file 

name is recommended since this is also used to create folders and filenames that 

contain associated model data. If the path to a file is too long, the Windows path limit 

of 260 characters may be exceeded. See File and Folder Naming in LUSAS for more 

information. 

Working folder 

 A working folder must be defined where the model will be saved. Files relating to a 

model (such as results files and intermediate files) can be saved beneath a model 

folder. See Model File Locations for details.  

Model properties 

Analysis Type 

Specifying an analysis type modifies the interface for the type of analysis to be carried 

out and also defines the class of model to be created. Analysis type are: 

 Structural 

 Thermal 

 Hygro-thermal 

 Coupled thermal/structural 

 Coupled hygro-thermal structural 

 

Analysis Category 

Specifying an analysis category modifies the user interface to generally show only 

those menu items, dialog options and settings that are appropriate to the analysis 

category stated. Selecting an analysis category as part of creating a new model defines 
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which startup templates are available for selection. It also determines the initial 

vertical axis for the model, and the orientation of element types and library items as 

displayed on the Geometric Line dialog. Options available are: 

 2D Grillage/Plate 

 2D Inplane 

 2D Axisymmetric 

 3D 

 

Models created prior to Version 16 will have an analysis category assigned to them 

automatically by LUSAS when they are opened in a later release (but only where a 

suitable analysis category can be established based upon the elements present within 

the model). If an analysis category cannot be assigned by LUSAS automatically 

(perhaps because a range of conflicting elements is defined within the model) an 

analysis category will need to be stated. 

Basic settings and permissible uses for each analysis category are shown in the 

following table: 

 
Analysis Category 

Default 
vertical axis 

 
Permissible freedoms 

Permissible geometric usage 
types 

2D Grillage/Plate 
(structural) 

Z Z, THX, THY Grillage 

 2D Inplane Y X,Y,THZ Bar / link, cross section beam, 2D 
thick beam, 2D thin beam, plane 
strain beam, ASPC thickness 

 2D Axisymmetric Y X,Y,THZ Axisymmetric membrane / shell 

 3D Z X,Y,Z,THX,THY,THZ Bar / link, cross section beam, 3D 
thick beam, 3D thin beam 

 

Notes: 

 A model's analysis category can be changed on the Model Properties dialog, 

but this should be used with caution since subsequent dialog choices made may 

not be supported in certain levels of the software, or may be inappropriate for a 

particular type of analysis. 

 Changing the Analysis category only changes the vertical axis if it cannot 

remain the same because it would be invalid for the analysis category chosen. 

 The orientation of the vertical axis dictates the labelling of the top of the view 

axis cube. See "Manipulating the View of a Model" on page 47 for more 

details. 
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Model units and timescale units 

A set of consistent modelling units must be specified when starting a new model. 

Timescale units must also be chosen. Note that changing model units after they have 

been used does not modify the numerical value of any existing inputs. For example, 

for model units, an input of 1m will become 1mm (not 1000mm). Note that changing 

the timescale units does not modify the duration of any existing time inputs. For 

example, an input of 12 hours will become 0.5 days (not 12 days). Changing model 

units may require any previously defined material or geometric properties to be re-

created and re-assigned to the model. Contact LUSAS technical support for more 

information. 

Optional settings 

Startup template 

Dependent upon the analysis category selected, a selection of startup templates are 

listed for selection. These pre-load the Attributes  Treeview with selected mesh, 

geometric, support, and loading attributes, and other settings suitable for that analysis 

type. User-defined startup templates can also be created and accessed via the button 

alongside the Startup template drop-down list. 

Layout grid 

A regular or user-specified set of construction grid lines to aid with defining geometric 

model features can be defined as part of creating a model. See layout grid for more 

details. 

Job no.  

Optional text input field. 

Model title 

The model titles is used during an analysis and annotated to the plot border. To 

subsequently change the title specified use the File> Model Properties menu item. 

When a model is created 

A "Startup Script Files" on page 96 automatically runs after a new model is created. 

This allows for user-defined combinations of commands to be run to set preferred 

defaults, colour schemes, other preferences.  

An alternative to adding combinations of commands to a pre-defined script file is to 

create and run your own script to make settings after a model has been created. See 

"Visual Basic Script Files" on page 94 for details. 
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Changing initial settings 

The Model Properties dialog allows some of the initial settings to be changed, if 

appropriate, after the new model dialog has been exited. It is recommended that 

modelling units are not changed after the model is created.  

New model creation from command line input 

A new model can also be created by running LUSAS Modeller from a command line, 

specifying the location of a script (to set any preferences) and stating a name for the 

model as follows: 

"C:\Program Files(x86)\LUSAS<version number>\Programs\lusas_m.exe" 

run=C:<folder_name>myScript.vbs C:<folder_name>model_name.mdl 

Model Units 

Model units are specified as part of the creation of a new model and are reported at all 

times in the status bar at the bottom of the Modeller window. Once set, for all dialogs 

with grid cells permitting dimensional input, the units expected are displayed as a 

tooltip when the cursor is hovered over the input cell.  

Timescale units are related to model units and dictate how time-based values are 

displayed on dialogs during modelling, and how they are output when processing 

results. 

Input  

Metric units may be input in UK/US decimal point, or European comma formats. 

When Imperial modelling units have been set coordinates and lengths can be input in 

feet and inches, instead of just feet or just inches. For example, a distance of 5 feet, 11 

and a half inches can be input and output now as 5:11.5 (or as 5'11.5"), rather than 

either 71.5" or 5.92'.  

The precision of user-entered real numbers is preserved both internally within LUSAS 

Modeller, and when re-displayed on dialogs. All real numbers are displayed in 

engineering-style notation (that is in 3,6,9 etc, powers of 10; as in 89.6E3) rather than 

8.96E4 or 0.896E5. This applies to all text entry fields, including the grids used in 

many places throughout the Modeller user interface.  

Expressions 

Expressions may be entered anywhere in LUSAS Modeller where numbers may be 

input. For example, in point definition, it is possible to enter 3+10, 4*6, and 5-1 as 

valid coordinates. All arithmetic operators, including braces, are available, as well as 

the standard elementary functions sin, cos, log etc. This facility is available in all text 

entry fields throughout the Modeller user interface. See Expressions and Functions 

Supported for more details. 
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Units Conversion 

Model units can be converted at the time of input on all dialogs where dimensional 

input is expected by clicking inside the right-hand edge of the edit box or grid cell and 

accessing the Units Converter and Variation Utility. A range of conversion units are 

supplied according to the type of input expected. Model units stated are those 

previously set. 

 
Reporting of expected model units and triggering of the Units Convertor dialog 

For edit boxes, or grid cells, that support coordinate entry the conversion utility allows 

conversion of multiple comma separated values in the one text box. So, for instance, a 

coordinate entered as 100,200,300 would be converted to (0.1, 0.2, 0.3) if a 

millimetres to metres conversion was selected. 

Displaying and reporting 

Displaying and reporting of model and results data (both to a View window and to 

print file output) is done in accordance with the consistent set of units stated on the 

Model Properties dialog. A setting on this dialog provides an option for Imperial 

modelling units to output coordinate and lengths in feet and inches (e.g. 5'11.5") 

format. 

Changing the model units in use 

Model units can be changed on the Model Properties dialog after a model has been 

started, but it should be noted that this will change only the label of the units for all 

existing attribute, geometry, and loading definitions. For example, a length of one 

metre in the model will become one foot if the model units were changed to imperial. 

Note this behaviour is different to that of changing timescale units. Changing model 

units may require any previously defined material or geometric properties to be re-

created and re-assigned to the model. Contact LUSAS technical support for more 

information. 

Timescale Units 

Timescale units are specified as part of the creation of a new model and can be 

changed on the Model Properties dialog. Choosing a timescale unit dictates how time-

based values are displayed on dialogs during modelling, and how they are output when 

file:///C:/SVN/Content/dlg1using/dlg_units_convertor.htm
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processing results. Setting a timescale unit does not change the consistent set of model 

units defined for a model; it simply permits the input or display of chosen timescale 

units in a different unit of time to that defined by the model units, wherever they are 

expected to be defined or displayed/output. 

Timescale units may be input in seconds, minutes, hours or days. By default, seconds 

are initially selected to comply with the consistent modelling units options provided.  

Timescale units are displayed as a tooltip when the cursor is hovered over the input 

cell on any dialogs that require time-based values.  

Timescale units can be changed on the Model Properties dialog after a model has been 

started, in which case the tooltip seen on dialogs that support time-based input will 

show the updated units. Any previously entered time-based values will be displayed 

accordingly, for example, a value of 60 representing a timescale in seconds will be 

displayed and reported as 1 if a timescale unit of minutes was subsequently chosen. 

Note this behaviour is different to that of changing model units. 

Model Types 

Two types of model can be created in LUSAS:  

 Feature-based geometry models - these are based on defined features (such as 

points, lines, surfaces and volumes) or are created from imported geometry and 

require the definition of mesh objects such as elements with their associated 

nodes. 

 Mesh-only models - these comprise only mesh objects (elements and their 

associated nodes, edges and faces) and are created by importing only those 

types of LUSAS or third party data that are supported. 

 

The Modeller user interface presents different menu and context menu items according 

to the type of model and analysis category in use. Cursor selection filters also differ 

according to the model in use.  

Attribute assignments to different model types 

Both feature-based models and mesh-only models require the assignment of materials, 

properties and thicknesses, loading and supports etc to geometric features or the 

comparable and equivalent mesh objects prior to an analysis taking place.  

Note: In general, whenever an assignment of an attribute to a geometric feature is 

described in this manual, the same attribute assignment can be made to an equivalent 

mesh object if a mesh-only model is being used. See the table below for details. 

  

file:///C:/SVN/Content/1using/Selecting_model_features.htm
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Feature-based 
model 

Mesh-only solid 
model 

Mesh-only surface 
model 

Mesh-only line 
model 

POINT NODE - - 

LINE ELEMENT EDGE - ELEMENT 

SURFACE ELEMENT FACE ELEMENT - 

VOLUME ELEMENT - - 

Geometric features and their comparable equivalent mesh objects for attribute assignment 

purposes 

Feature-based geometry models 

Feature-based geometry models are created using the four geometric feature types in 

LUSAS (points, lines, surfaces and volumes). In LUSAS, geometry is defined using a 

whole range of tools under the Geometry menu, or the buttons on the Toolbars. 

Feature-based geometry models can also be created by importing supported data from 

third-party software packages using the File > Import menu item. Once created, the 

geometry features are then assigned attributes (materials, properties and thicknesses, 

loading, supports and mesh/element type etc.) to fully describe the model prior to an 

analysis taking place. One of the many benefits obtained from using this feature-based 

modelling method is that built-in associativity ensures that if the model geometry is 

amended, all assigned loadings, supports, geometric attributes and particularly any 

mesh assignments and arrangements are automatically updated to suit. 

When a feature-based geometry model is being edited all user interface menu items 

appropriate to the application software in use are available. 

Mesh-only models 

Mesh-only models are comprised of nodes and elements and do not contain any 

geometric layer data or feature types, or indeed any geometric data at all. As a result, 

the option to add a Geometry layer is not accessible. Mesh only models are created by 

importing finite element data files created either by the prior running of an analysis in 

LUSAS, or by importing data files from other supported software applications. The 

File > Import menu item is used to do this. During the mesh import process, LUSAS 

Modeller creates separate Groups for each element type encountered and for models 

created from LUSAS data file these will be familiar LUSAS element names. For 

models created from other third-party software they will be the names used within that 

system, whatever they may be. An option to create additional groups during the import 

process based upon the element material type is also available.  

On import of a LUSAS Solver data file, element types that are present in the datafile 

are used directly for the elements that are imported. For datafiles other than those 

created by LUSAS Solver, the proprietary element types that are present in the datafile 

are mapped to an equivalent LUSAS element based upon each element's shape and its 

topology. If the Coupled analysis type has been selected on the New Model dialog 

prior to a mesh import being carried out then coupled elements will be created during 
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the import process. If a different analysis type is specified after the import of mesh 

data the element types previously used will be changed accordingly. 

Local coordinate systems are not imported into newly created mesh-only models so 

these need to be defined as necessary to obtain specific types of results as, for 

example, to get moments around a cylindrical axis. 

Assigning attribute data to mesh objects in mesh-only models 

No import of any attribute data is done when element data is imported, so the mesh 

objects (the elements and their nodes, edges and faces) must be assigned attributes 

(materials, properties and thicknesses, loading and supports), prior to carrying out an 

analysis within LUSAS, in a similar way and as documented for a feature-based 

geometry model. Rather than selecting points, lines, surfaces or volumes to make an 

attribute assignment, nodes, edges, faces, or elements are selected instead. To assist in 

the attribute assignment process the cursor selection filter can be used to identify 

specific mesh objects. 

Editing mesh-only models 

When a mesh-only model is being edited any main menu items normally used with 

feature-based models that are not valid are removed or shown greyed-out to prevent 

selection. Mesh-only menu items (such as Geometry > Element for instance) are added 

to the main menu. Context menus may contain different menu items also. 

Additional elements cannot be added to a mesh-only model. Once imported, the 

number and shapes of the elements are fixed but the type of element may be changed 

by use of the Change Element Type option on the context menu on the element group 

name. In doing so, the number of nodes defining the element topology may be reduced 

but not increased. For instance, an 8-noded brick element may be defined for use on 

previously defined 20-noded brick elements. 

Restricted / unsupported functionality for mesh-only models 

With reference to the user interface menus for feature-based geometry models the 

following differences exist for mesh-only models: 

 The Utilities > Slice resultants beams and shells menu item is not currently 

supported  

 The Analyses > IMDPlus > Moving load and Analyses > IMDPlus 

> Moving Mass menu items are not currently supported 

 The Bridge > Moving load menu item is not currently supported. 

 Prestress modelling is not currently supported. 

 Single tendon definition is only permissible by importing data from a 

spreadsheet. 
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 Reference paths can only be created currently by typing in the coordinates 

defining the path. 

Model Properties 

 The Model Properties dialog allows many settings relating to the current model to be 

defined. Model properties may be accessed from the File> Model Properties menu 

item, by right-clicking the model name (top level) in the Layers  Treeview and 

selecting Properties from the context menu, or by double-clicking the Model 

Properties object  in the Analyses  Treeview. 

The model properties are defined on the following tabs: 

 General 

 Backups 

 Notes 

 Geometry 

 Meshing 

 Attributes 

 Options 

 Defaults 

 Solver System Variables 

General 

 Title Brief description of the current model as entered in the New Model 

startup dialog. 

 Analysis category An analysis category must be chosen when a model is first 

created. It defines the category of analysis that will be carried out with this 

model. Analysis category choices are 2D Grillage/Plate, 2D Inplane, 2D 

Axisymmetric, and 3D. It can be changed on the Model Properties dialog, but 

this should be used with caution since subsequent dialog choices made may not 

be supported in certain levels of the software, or may be inappropriate for a 

particular type of analysis. Models created prior to Version 16 will have an 

analysis category assigned to them automatically by LUSAS when they are 

opened in Version 16 (but only when a suitable analysis category can be 

established based upon the elements present within the model). If an analysis 

category cannot be assigned by LUSAS automatically (perhaps because a range 

of now conflicting elements is defined within the model) a dialog will appear 

asking for an analysis category to be chosen. 
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 Only show compatible options When checked, shows only those menu items, 

dialog options and settings that are relevant for the stated analysis category. 

When unchecked, will show all dialog options and settings irrelevant of the 

analysis category set, and permits changing the analysis category on attribute 

dialogs that support this facility on a case-by-case basis. It should be used with 

caution. 

 Model units Specifies the modelling units. These are used to preset the units 

seen on many of the units dependent dialogs, and to annotate the LUSAS 

output. A set of consistent modelling units must be specified when starting a 

new model. Timescale units must also be chosen. Note that changing model 

units after they have been used does not modify the numerical value of any 

existing inputs. Changing model units may require any previously defined 

material or geometric properties to be re-created and re-assigned to the model. 

Contact LUSAS technical support for more information. 

 Output in feet and inches (only if imperial units are set) ensures that 

modelling units used to define coordinates and lengths are reported in feet and 

inches, instead of just feet or just inches. For example, a length may be output 

as 5'11.5", rather than 71.5" or 5.92'. 

 Timescale units dictate how time-based values are displayed on dialogs during 

modelling, and how they are output when processing results. Units can be 

specified as seconds, minutes, hours, days or increments. 

 Precision shown in dialogs Controls the number of significant figures or 

decimal places displayed in the dialogs. 

 Decimal marker specifies how decimal points should be handled. Options are: 

Follow Windows, UK/US decimal point, and European comma formats. 

 Vertical axis Set automatically by setting the Analysis category for new 

models. Used to determine the direction that gravity loading will be applied if 

added using the Bridge or Civil > Gravity menu item. It is also used to define 

the initial vertical axis and orientation of element types and library items as 

displayed on the Geometric Line dialog prior to them being added to a model. It 

also defines the model orientation viewed when using the isometric, dimetric 

and trimetric views. Note that changing the Analysis category (see above) only 

changes the vertical axis if it cannot remain the same because it would be 

invalid for the analysis category chosen. 

 Gravity - Value set for the acceleration of free fall, as used when creating a 

Gravity loading from the Bridge of Civil menu item, and in a number of 

attribute definitions. 

 Enable undo - On by default. Allows any number of actions, since the last 

model save, that have resulted in editing of the model data, to be undone. See 

"Undo/Redo" on page 69 for more detail. 
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Backups 

Controls where and how many backup versions (revisions)of the model are saved. 

 Auto backup Maintains another (current) copy of the model file in a specified 

location. 

 Older revisions Maintains a specified number of older copies (versions) of the 

model file in an associated model data folder for that model name. For 32-bit 

installations this folder is named 'LusasFiles32'. Whenever a model is saved, 

the previous revision is saved, and if the number of older revisions stated has 

been exceeded the oldest revision is deleted. 

Notes 

Notes relating to a model can be typed in a Notes panel accessed via the Utitilites > 

Notes menu item. The Notes placeholder on the Model Properties dialog is retained to 

direct users to the new location and method of adding notes. 

Geometry 

The method by which the geometry is displayed is controlled using the Geometry 

drawing layer. 

 Merge Options 

 Action controls the criteria that must be satisfied before features sharing a 

common definition will be merged. 

 New geometry unmergable sets the merge status of all new features to 

Unmergable rather than the default which is Mergable. 

 Tolerance controls the distance within which Point features must lie 

before they will be considered for merging. Note: The merge tolerance 

should only be changed with extreme caution because changing it from its 

default value can lead to instability of the underlying geometry engine. 

See Merging Features for more details. 

 Default faceting 

The default faceting controls the number of facets used for shading lines and 

surfaces. Increasing the number of facets improves the shaded geometry 

visualisation but takes longer to display. See Facet Density for more details. 

 Active Local Coordinate 

Sets the coordinate system as either the Global coordinate, or any defined local 

Cartesian, cylindrical or spherical coordinate. 

file:///C:/SVN/Content/dlg0prop/idd_props_geometry_overlay.htm
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If a local coordinate is set active then all subsequent geometry definition is 

carried out in transformed coordinates. 

Advanced Geometry Properties 

 Splitting Defaults 

The state of the splitting defaults may be set from the advanced geometry dialog 

for all operations involving splitting operations. The defaults control the check 

box state and may be overridden during geometry creation. Splitting of features is 

achieved by use of the Geometry > (Feature) > By Splitting menu items. 

 Creation Defaults 

 Process objects in selection order forces objects to be processed in 

selection order rather than Modellers best fit. 

 Allow hollow volume creation allows hollow volumes to be created. This 

option is automatically set true when IGES files are imported. Once set the 

create volume button will try to create a closed hollow volume when it is 

not possible to create a solid volume. In addition, extra menu items will 

appear under the Geometry> Volume to enable hollow volumes to be 

defined. A value for Hollow volume tolerance may be set. 

Hole Removal Defaults 

The state of the holes removal defaults may be set from the advanced geometry dialog 

for all operations involving hole removal operations. The defaults control the check 

box state and may be overridden during geometry creation. See Creating Holes in 

Surfaces for more information. 

 Merge Defaults 

The state of the merge defaults may be set from the advanced geometry dialog for all 

operations involving merging. The defaults control the check box state, and may be 

overridden during geometry creation. See Merging and Unmerging Features for 

more information. 

Meshing 

 Equivalence Defines the default nodal equivalence tolerance used in a 

equivalence attribute. 

 Tolerance A default value of 1e-3 is set. 

 Automatic (if selected) carries out equivalencing automatically for all 

nodes in the model and no equivalence attribute assignment is required. 

See Nodal Equivalencing for details. 

 Line Mesh Defaults 
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 Default line divisions Sets the default number of mesh divisions on a line 

and the maximum subtended angle per element for an arc or splines. 

 Default angle subtended If an element exceeds the max subtended angle 

the number of divisions on the arc or spline will be increased. 

 Default beam orientation method 

 Orientate beams and columns using model vertical axis When selected, 

identifies the alignment of the beams present in a supported third-party 

import file, or for beams within the model, and sets the beam element axes 

for each beam to a suitable orientation to represent either a vertical column 

or a horizontal beam, as typically used in modelling building frames. 

Unselected, the beam element axes for each beam are set to the default 

LUSAS orientation. 

 Miscellaneous 

 Create a group of objects that failed to mesh after meshing creates a 

group named $failedToMeshObjects which contains all features which 

failed to mesh. 

Advanced Meshing Parameters 

 Draw failed parts of mesh only - draws those parts of the mesh that failed to 

mesh 

 Linearise line / surface element edges Moves the position of the mid-side 

nodes on quadratic elements to lie on a straight line connecting the corner 

nodes. 

 Constrain adjacent linear/quadratic edges forces mid-side nodes on lines or 

surfaces to be averaged between the corner/end node positions. This option is 

turned on by default. 

 Element edge collapsing invokes edge collapsing which removes 

elements/faces with short edges and small subtended angles by merging them 

with neighbouring elements. 

 Irregular tet meshing specifies the number of the passes and attempts to be 

made by the tetrahedral mesh generation when attempting to mesh a volume. 

 Script to run after meshing allows running of a user-defined script after 

meshing as, for example, if a quality check was desired to be run on mesh 

quality. 
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Attributes 

 General Options 

 Apply concentrated loads in cylindrical coordinates for Fourier 

elements (LUSAS Solver option 202). 

 Body force given as acceleration This option is turned on by default. 

Turning it off converts body forces to global loads per unit volume. 

(LUSAS Solver option 48). 

 Activate spring supports in undeformed location This option is turned 

off by default. 

 Allow modification of LUSAS generated attributes overrides the default 

behaviour of not allowing any changes to be made to Modeller-generated 

attributes including loadings generated as a result of carrying out cable 

tuning analysis, vehicle load optimisation, prestress calculations, rail track 

analysis, or composite bridge deck design. 

 Input soil grain density for two-phase elements This is option is turned 

off by default. If chosen, soil grain density can be defined on the Elastic 

tab of the Isotropic material properties dialog in place of specifying the 

fully saturated soil density, which is the default.  

 Apply automatic restraints to prescribed loads This option is turned on 

by default. If turned off, it is primarily for use with load curves and 

prescribed displacements, where user-defined restraints can be applied in 

place of any automatically assigned ones. 

 Slideline Options 

 Suppress stringent slave search For simpler geometries, such as flat 

surfaces in contact, a slight reduction in processing time may be achieved 

by suppressing the "stringent" local node search but this is not usually 

recommended. (LUSAS Solver option 184). See the Theory Manual for 

more details. 

 Suppress initial slide-surface stiffness check Slideline stiffnesses are 

automatically scaled at the beginning of an analysis if the average 

master/slave stiffnesses differ by a factor greater than 100. This is to 

account for contact between bodies that have significantly different 

material properties. See the Theory Manual for more details. 

 Suppress initial penetration check The coordinates of all contact nodes 

that have penetrated prior to the commencement of an analysis, are reset 

back to the closest point on the contacted surface. This option should be 

set if the node resetting is to be suppressed, such as when performing an 

interference fit analysis. See the Theory Manual for more details. 
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Options 

Solver options  

Solver options can be specified on the 'Solve now' dialog, be set to be common to all 

analyses by making subsequent selections on the 'Solver Options' dialog , or be set 

individually for each analysis. When specified individually. a Solver options object 

 is added to the Analyses  Treeview for each analysis entry. Double-clicking this 

object provides access to specify the Solver type and optimisation options. 

Options common to all analyses 

Solver Options 

When the type of solver selected is set to Default the fast multi-frontal solver will be 

used if this option is included in the licence agreement. This may be overridden by 

selecting the solver required. For further information see Selecting a Solver. 

 Optimiser Options When using the standard frontal solver the frontwidth of 

the problem may be reduced by optimising the order in which the elements are 

presented to the frontal solver. The type of optimiser to be used is selected from 

an options dialog. No optimisation is required when using the fast multi-frontal 

solver. For further information see Selecting a Frontal Optimiser.  

 Platform If 32 and 64 bit versions of LUSAS Solver have been installed, you 

can specify which version of LUSAS Solver should be used with your current 

instance of LUSAS Modeller: 

 Follow Modeller - use the same version of LUSAS Solver as being used 

by LUSAS Modeller 

 32 Bit - use the 32 bit version of Solver 

 64 bit - use the 64 bit version of Solver 

 The Advanced... button enables a new Modeller option to be specified or 

particular default values or settings to be modified. Advanced settings should 

generally only be modified with the assistance of LUSAS technical support. 

 

Element Options  

See the Element Reference Manual for details of which elements can be used with 

these options 

 Assign 6 degrees of freedom to all thick shell element nodes By default this 

option is on. It has the effect of adding a rotational spring stiffness to the 

drilling rotation of the thick shell elements making the analysis more stable. 

The value of the spring stiffness can be adjusted using the system parameter 

STFINP. For problems in which geometric nonlinearity (Option 87) is being 
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used more accurate results may be obtained by switching this option off and 

letting LUSAS automatically establish the need for 5 or 6 degrees of freedom at 

a node. (LUSAS Solver option 278). 

 Axisymmetric about the global X-axis When selected, LUSAS considers the 

line of axisymmetry in an analysis to be about the global X axis and not the 

default, which is the global Y axis. (LUSAS Solver option 47). 

 Lumped mass matrix (structural) Formulate lumped mass matrix instead of 

consistent mass matrix for elements. (LUSAS Solver option 105).  

 Lumped mass matrix (thermal) Formulate lumped mass matrix instead of 

consistent mass matrix for elements. (LUSAS Solver option 105).  

 Write strains to output file causes element strains to be written to the Solver 

output file.  

 Preserve loading whilst elements deactivated retains the loading assigned to 

all elements in model (activated and deactivated) until a subsequent load case is 

applied. Typical usage would, for example, be when carrying out a staged 

construction analysis. Self weight would be assigned to all elements (activated 

and deactivated) in the loadcase representing stage 1 of the analysis. As stage 2 

and subsequent loadcases are activated the loading initially applied to elements 

in stage 1 would automatically be applied as the elements become active. Note 

that when using this option no additional loading should be applied to any 

loadcases following the one that contained the load assignments. If done so, the 

initial applied loading for those loadcases will be lost. 

 Improved transverse shear for thick shells When selected, and only if 

equivalent stress is computed, a parabolic distribution of shear stress is 

calculated, having a mid-shell maximum value of 1.5 x Fyaverage. Top and 

bottom shell shears will report as zero. When not checked, constant shear is 

obtained. 

 Show results for rigid zone elements By default, the elements representing 

rigid ends of beams do not present element-based results when results are 

viewed, displayed or printed. By selecting this option these may be obtained. 

 Internal displacements and deformations for beams By default this option is 

off. When set, it uses the LUSAS Solver calculated deformations at each 

internal calculation point in each beam element. Setting this option 'on' allows 

for plotting of displacement contours for beam elements. 

 Residual bending flexibility correction When selected, improves the bending 

performance of thin shell (TTS3) elements. 

 

Integration options 

 Fine integration for stiffness and mass Invokes a finer numerical integration 

rule for elements. (LUSAS Solver option 18). 
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 Fine integration for stiffness and mass (thermal) Invokes a finer numerical 

integration rule for elements. (LUSAS Solver option 18). 

 Fine integration for mass HX16 and HX20 Formulate mass matrix with fine 

integration. (LUSAS Solver option 91). See the Element Reference Manual for 

more details. 

 Coarse integration for semi-loof shells Invokes coarse numerical integration 

rule for semiloof elements. This option under-integrates the semi-loof shell 

element which may have the effect of removing low energy mechanisms when 

the element is very thin and/or pressure loaded. (LUSAS Solver option 19). See 

the Element Reference Manual for more details. 

 Newton-Cotes Integration for beam elements Newton-Cotes is a form of 

numerical integration or quadrature. It is often used for through-thickness 

integrals since sampling points are located at the extremes of the range. 

(LUSAS Solver option 134). See the Element Reference Manual for more 

details. 

 

Element options are accessed via the Model Properties dialog or the Model Properties 

control object  in the Analyses  Treeview. Element options can only be specified 

to be common for all analyses. 

Draping Options 

The draping options control the composite lamina draping process. The draping 

process works by effectively draping a square mesh of pinned bars over the structure. 

The length of the bars is considered to be the drape mesh size. A smaller bar size 

provides a more accurate drape at the expense of computer time and memory usage. 

Typically the drape mesh size should be about half the element size. 

 Drape by mesh size - Desired drape cell size. If the desired drape cell size 

would generate more than the specified maximum number of drape cells then 

the drape mesh size would be adjusted to generate the maximum number of 

drape cells. Likewise, if the desired drape cell size would generate less than the 

specified minimum number of drape cells then the drape mesh size would be 

adjusted to generate the minimum number of drape cells. 

 Drape by number - Desired number of drape cells on draping surface. This 

must be between the maximum and minimum values stated below. 

 Drape by face multiplier - A number that is used to multiply the actual 

number of mesh divisions on a draping surface to arrive at a desired drape cell 

number. This must be between the maximum and minimum values stated 

below. A default value of 4 is entered. 

 Maximum number of drape cells - Maximum number of drape cells to be 

generated. 
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 Minimum number of drape cells - Minimum number of drape cells to be 

generated. 

 Extend drape grid one row - Ensures the edges of the component are fully 

enclosed by the draping grid. Note that the grids for LUSAS draped solids and 

shells are automatically trimmed at Surface boundaries. 

 

Draping options can be accessed via the Model Properties or Draping options object 

 in the Analyses  Treeview. Draping options can only be specified to be 

common for all analyses. 

Averaging options 

Averaging options are accessed via the Model Properties dialog or the Model 

Properties control object  in the Analyses  Treeview. 

The Averaging Options dialog allows averaging rules to be applied to state when 

results averaging should and should not take place between adjacent pairs of elements 

in line, surface and volume features. For each pair of elements that is considered, if all 

the averaging rules "pass" then averaging of results across those elements is permitted. 

 Feature Checked 'off' for all elements by default - meaning that averaging of 

results across each pair of elements being considered will be done if the other 

averaging rules chosen permit. 

 Different assignments Checked 'on' by default - meaning do not average 

results across adjacent elements with different attribute assignments. 

 Common LOF assignment Checked 'on' by default - meaning do not average 

results across adjacent elements in common lower-order features, such as when 

a line is shared by a surface, or a point is shared by two lines. Note that the 

assignment if a null mesh does not count as a discontinuity. For general 

assignments no attempt is made to check whether the assignment(s) apply in 

the active loadcase. 

 Visibility Checked 'off' by default - meaning average results across invisible 

adjacent elements if other averaging rules chosen permit. When checked, 

emulates the averaging behaviour for visible / invisible features/elements from 

Version 15.2. 

 Junction Checked 'on' by default - meaning do not average results at a junction 

(where three or more elements meet at a common lower order feature - such as 

where elements form a 'T' or a more complex 'framed' junction. 

 Angle exceeds a specified number of degrees (12.0 by default). Checked 'on' by 

default - meaning do not average results across adjacent elements beyond that 

angular tolerance. A special case applies when transforming to material, local 

coordinate, path or global directions where for beams, only the x axis is 
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compared, and for shells, only the z axis is compared. For other elements, and 

other transformations, all three axes are compared. 

 Defaults when pressed, returns the dialog to the settings stated above. 

 

Averaging options can only be specified to be common for all analyses. See Results 

Files and Results Processing for more information. 

Defaults 

Set the defaults for Pens that are used to draw Points, Lines, Surfaces and Volumes, 

and symbols, arrows and text, which are used when visualising attributes. Actual 

settings are controlled from the Attribute Visualisation layer for the current window. 

Solver System Variables 

By default the LUSAS Solver is set up to operate efficiently for a wide range of 

modelling and analysis problems. In some cases it may be occasionally necessary to 

adjust the Solver system variables. Variables that can be modified inside Modeller are 

accessed via the File> Model Properties> Solver System Variables dialog. Making 

changes to Solver system variables should generally be done only after seeking 

advice from LUSAS Technical Support. 

Using View Windows 

Each Modeller window can display a unique view of a model, with an optional view 

axis and orientation cube. View layers inside each window hold model information 

that can be added or removed from the current window as required. Multiple windows 

can be opened using the Window > New Window menu item, and tiled using the 

Window > Tile Horizontally or Tile Vertically options. Closing the only window 

displayed will close the model. 

Windows consist of the following components: 

 Drawing Layers  By default the first panel of the tree frame displays each 

model window currently open, and shows the view layers contained in that 

window. 

 View Properties Double-clicking in a window or right-clicking in a window 

with no selection, will display the view properties of that window. The View 

Properties can be altered as required. 

 

Pen Library 

The choice of colour for various operations is linked to the Pen Library. The Pen 

Library contains twenty pens, each numbered, each with a colour, style and thickness 

that may be set if desired.  

file:///C:/SVN/Content/dlg1using/Solver_System_Variables.htm
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Pens are used in a number of dialogs. Whenever a pen is used a Choose pen button 

allows access to the Pen Library to specify a different pen, or to change the pen colour 

or style. If a particular pen style or colour is changed then this will affect every 

operation that references that pen. 

Copying Windows 

A window can be copied by selecting and copying the window name in the  

Treeview, then pasting the window back into the  Treeview. The window layers 

and settings are also copied. 

Saving views 

A view of a model may be saved by name into the Utilities  treeview using the 

Window> Save View menu item. Saved views can be applied to new or existing 

views, and can also be inserted into reports. See Saved Views for more information. 

Manipulating the View of a Model 

A number of rotational, pan and zoom tools, pre-defined projections, and model 

orientation tools are available to manipulate the view of the model. 

View cube 

 

Each view window can optionally display a view axis cube. This is used 

to provide visual feedback on the orientation of a model, and rotates and 

updates as the model is rotated or orientated. The cube has labelled faces 

with default names of Left, Right, Bottom, Top, Back and Front, and 

edges and corners that highlight when a cursor is moved over them.  

  

 Selecting a face, edge or corner of the cube will orientate the model to be 

viewed from the selected direction. The top of the cube is aligned to the 

defined vertical axis for the model. 

 Right-clicking on the model cube will open the View Properties dialog, from 

which additional settings can be made. 

Orthogonal Model Views 

These buttons are located in the status bar. 

  = View along the +X axis towards the origin 

  = View along the +Y axis towards the origin 
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  = View along the +Z axis towards the origin 

Any of the views along these axes can be modified by using these key sequences 

which select an alternative view orientation: 

Shift key +  = View along the -X axis towards the origin  

Ctrl key +  = View along the -Y axis towards the origin 

Ctrl + Shift key +  = View along the -Z axis towards the origin 

Equivalent toolbar buttons for these view shortcuts can be found on the customisable 

toolbar dialog or by clicking the right mouse button on the orthogonal model view 

buttons. 

View projections 

Isometric, Dimetric and Trimetric standard views of the model can be selected, as well 

as a perspective projection. 

 
Isometric Sets an isometric projection for the view 

 
Dimetric Sets an dimetric projection for the view 

 
Trimetric Sets a trimetric projection for the view 

 
Perspective Sets a perspective projection according to properties specified in 

the View properties dialog. 

Rotating the Model 

Three methods of rotating the view of the model are available, each one is a button on 

the View toolbar: 
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Dynamic rotate Dynamic 

rotation is carried out by 

selecting the dynamic rotate 

button, or by pressing the 

scroll wheel button and either 

the left or right mouse button 

or by holding down the R 

key, while moving the mouse 

in normal cursor mode. The 

model will be rotated about 

the centre of the model unless 

any part of the model is 

selected in which case the 

model will rotate about the centre of the selection. The model rotates around 

various multiple axes when the cursor is moved. By holding down the Control 

key, the Control and Shift keys or the Shift key while using the dynamic 

rotate the model can be rotated independently about the screen Z, Y and X axis 

respectively. Click on the normal cursor to return to selection mode. Note also 

that holding down the Alt key provides a one-key option for rotating about the 

screen Y axis. 

  

  

  

Note. Models are dynamically rotated using the 

'model ball' method. With this method, a model can 

be imagined to be surrounded by a sphere such that 

a mouse-click and a drag of the cursor on the screen 

represents clicking on the surface of the sphere and 

dragging to rotate it to a new position. In doing so, 

it is important to note that the model rotation is 

restrained to rotate only around the model's vertical 

axis (as defined on the Vertical Axis dialog) - 

unless any model viewing shortcuts are being used 

at the same time. A benefit of this approach is that, no matter where on the 

screen you click to start the rotation of your model, if you return the mouse 

pointer to the same spot, (whilst you are dynamically rotating the model), the 

model will return to its original position and orientation on the screen. 

  

  

Incremental rotate Allows the model to be 

rotated by an specified rotation about a chosen 

global axis. The specified rotation may be 

modified by adjusting the rotation increment on 

the window's properties. 
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View along axis Views the model along a 

chosen global axis. Note that this toolbar button 

is not provided as part of the standard user 

interface but it can be added by selecting the 

View > Toolbars > Customise > menu item. This 

facility is also available by clicking in the X, Y 

or Z boxes in the Status Bar (holding-down the 

Shift key, if needed, to obtain the views along 

the negative screen axes.)  

Zooming in and out 

 
Zoom tool This tool works in two ways: 

1. By dragging a box around part of the model the view will zoom into 

that area.  

2. Clicking on part of the model will zoom in progressively for each click. 

Hold the Control key to zoom out. 

Note that this facility is deactivated when a perspective projection is in use. 

 

Dynamic Zoom is carried out by selecting the dynamic zoom button, or by 

scrolling the mouse wheel or by holding down the Z key while moving the 

cursor in normal cursor more. If any part of the model is selected the location 

of the centre of the selection will remain fixed, similar to dynamic rotate. 

Otherwise the zoom takes place with respect to the centre of the view window. 

Using the cursor the model can be visually enlarged or reduced in size. 

Note that when a perspective projection is in use and it is required to zoom in 

to a particular part of the model, select a feature(s) of interest first prior to 

selecting the dynamic zoom button. 

Panning (Dragging) the Model 

 
Dynamic Pan is carried out by selecting the Dyanimic pan button, or by 

depressing the scroll wheel button or holding down the D key while moving 

the mouse in normal cursor mode.  

Notes 

 Rotation, zoom and pan model manipulations are applicable for all cursor input 

modes including normal cursor selection of features, defining lines by cursor or 

when section slicing.  
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 For larger models when the refresh time is significant the model display will 

reduce to an outline view when using rotate, zoom and pan.   

Resetting the View 

 
Home Restores the view to a scaled to fit view in the XY plane. 

 
Resize When the resize button is depressed the model will fit into the available 

screen area.  

See Appendix C - Model Viewing Shortcuts for a complete listing of all model 

viewing facilities and keyboard shortcuts available 

Saved Views 

A view of a model may be saved by name into the Utilities  Treeview using the 

Window> Save View menu item. Views saved in this way are always retained and 

available when a model is saved, or when a model containing them is opened in a 

higher version of LUSAS. Saved views can be applied to other views and can be 

inserted into reports. 

The following settings can be optionally saved for use when the saved view is applied 

to an existing or new view: 

 Rotation Saves the current rotation setting for the view (which consists of a 

vector and an origin as specified on the View tab of the View properties) 

 Resize to fit window / page Forces the saved view contents to fit the view 

window / report page when the saved view is applied to another or new window 

(Working mode only), or added to a report. The initial setting of this option is 

governed by any setting of the Resize toolbar button. This option is not 

available in Page layout mode because page layout mode always resizes to fit 

page.  

 Zoom and pan Saves the current zoom and pan setting in use for the view 

(Working mode only). This option is not available in Page layout mode, 

because zoom and pan is meaningless when page layout mode always resizes to 

fit page. 

 Projection Saves the perspective view, if set. 

 Layers Saves the window layer names (and their settings) present in the  

Treeview for the view. 

 Colours See 'Saved View Colours' heading below. 

 Page size & borders The page size and border setting as defined from the 

File> Page Setup menu item. 

 Pen Library The pen library referenced every time a item is drawn.  
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Notes 

 The use of meaningful saved view names is recommended, especially for 

results and report uses.  

 To save a view with the same name as an existing Saved view name, over-type 

the name on the Saved view dialog. 

 A Saved view entry is identified in the Utilities  treeview by this icon . 

The entry can be edited (to see the view settings it contains), be renamed or 

deleted by the means of its context menu 

Uses 

Updating of view windows 

A Saved View  entry in the Utilities  treeview can be dragged and dropped onto 

any View window to automatically update the view settings and the display in that 

View window to use those settings contained in the saved view. A Saved view entry 

can also be assigned to a New window or the Current window by using the respective 

Apply to> context menu items. Using these methods a number of standard model or 

results views can be set-up for easy and quick viewing of the predefined views of the 

model and of selected results plots. 

Reports 

Saved views can be inserted into reports and when done will ensure that the report, 

when generated, will always contain up-to-date images of any model or results plots. 

This is because the image data contained in a saved view is re-generated each time a 

report is created. A saved view name is automatically used as the title for the inserted 

image of the view in a generated report. This title is comprised of the view name 

followed by a loadcase name in parenthesis. For a default view name and loadcase 

name the inserted image of a saved view in a report would be titled: 'View1 (Loadcase 

1)'. As a result it makes sense to name a saved view explicitly according to the 

contents of the view, for example, 'Isometric view', or 'Maximum displacement', or 

'Contours of Mz'. 

Working mode (View > Working Mode) should be used if zoomed-in views of a 

model are required to be added to a report, because Page layout mode always re-sizes 

a model to fit a page size. 

Saved View Colours 

The selection of 'Colours' in the context of saving and reloading a saved view is to 

reinstate the following options: 

 Whether to use Windows colours or manually specified background and 

selection colours. 
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  If manually specified, the choice of background and selection colours. 

 The seed colours used for contouring (as shown on the contour dialog). 

 Whether or not the coordinate system is visualised. 

 All the display settings for the coordinate system visualisations - origin, pen, 

size, etc. (as shown on the view properties dialog). 

Using Layers 

Selective viewing of model and results data is done using separate pre-named layers in 

the Layers  Treeview. Layers can be added to each view window by right-clicking 

on a blank part of that view, or by right-clicking the window name in the Layers  

Treeview, or by selecting the View> Drawing Layers menu item.  

The following layers can be generally manipulated from the Layers  Treeview: 

General modelling layers 

 Geometry 

 Mesh 

 Attributes 

 Labels 

 Annotation 

 Utilities 

 

When an influence analysis has been carried out the following additional entry will be 

added to the Layers  Treeview. This layer cannot be added manually. 

 Influence shape 

 

Results processing layers 

 Contours 

 Vectors 

 Deformed mesh 

 Influence shape 

 Diagrams 

 Values 

file:///C:/SVN/Content/dlg0prop/idd_props_geometry_overlay.htm
file:///C:/SVN/Content/dlg0prop/idd_props_mesh_overlay.htm
file:///C:/SVN/Content/dlg0prop/idd_props_visualise_overlay.htm
file:///C:/SVN/Content/dlg0prop/idd_props_visualise_overlay.htm
file:///C:/SVN/Content/dlg5util/idd_props_text_annotation.htm
file:///C:/SVN/Content/dlg0prop/idd_props_visualise_utilities.htm
file:///C:/SVN/Content/dlg7post/idd_props_contour_overlay_component.htm
file:///C:/SVN/Content/dlg7post/idd_props_vector_overlay_display.htm
file:///C:/SVN/Content/dlg7post/idd_props_mesh_deform.htm
file:///C:/SVN/Content/dlg7post/idd_props_diagram_overlay_component.htm
file:///C:/SVN/Content/dlg7post/idd_props_value_overlay_display.htm
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Manipulation of Layers 

The order in which the layers are drawn to the view window is defined by the order or 

the layers in the Layers  Treeview. The top layer in the Treeview is drawn first. If 

the display of one layer is eclipsed by another layer, (i.e. the mesh is eclipsed by the 

contours, or the annotation is eclipsed by the deformed mesh), the eclipsed layer can 

be moved down in the Layers  Treeview by selecting it, then dragging and 

dropping it to a new position to cause it to be drawn following a particular layer.  

A context menu (accessed by right-clicking on each layer name in the Layers  

Treeview) provides additional manipulation options: 

 Copy (and Paste) allows a layer (and its corresponding layer settings) to be 

copied and pasted between different view windows of the same model. 

 Delete removes the layer from the view window 

 On/Off controls the display of the layer in the view window. Turning a layer 

off retains the layer in the Layers  Treeview but removes the display of that 

layer from the view window. 

 Reset returns the layer to its default settings 

 Move up / Move down moves the selected layer to be drawn before or after the 

preceding or following layer. 

 Properties Double-clicking on a layer name (whether or not is it On or Off) 

will display a Properties dialog where the style of the viewed layer can be 

changed. Clicking OK will turn On a previously turned Off layer. 

Layer symbols explained 

A symbol adjacent to each layer name in the Layers  Treeview shows the display 

status of each layer:  

 A coloured layer symbol indicates that the display of a layer has been turned 'on'. 

 A greyed-out layer symbol indicates that the layer has been turned 'off'. 

 A red circle with a line through it indicates that no results are loaded or currently 

available for this layer, or inappropriate settings are currently set. 

 View properties: options and settings 

Selecting Model Features 

Items displayed in the view window may be selected with the cursor by clicking on 

them individually or by rectangular, circular or polygonal area selection. Following 

selection, items may be added or removed from the initial selection by carrying out 

further selections based upon either menu choices or upon particular keystrokes used. 
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Items in a current selection may be viewed in the Browse Selection window which can 

be displayed from the View> Browse Selection menu item or using a right-hand 

mouse click in the Selected area of the status bar at the bottom of the graphics area. By 

means of checkboxes the selected items may be individually unselected. 

Cursor-based selections 

 

The standard cursor can be used to select any object, i.e. Points, Lines, 

Surfaces, Volumes, Nodes, Elements, Annotation according to the model 

type in use. It can also be used to make rectangular area selections.  

Default behaviour is to select items that are wholly within a selection box 

regardless of whether left-to-right or right-to-left movement of the cursor has 

taken place when selecting the extents. A right-to-left definition of extents 

can be optionally set to select all features crossed by the selection box (as 

often used by CAD software).  

Greater control over what is selected can be achieved by changing the cursor 

selection filter. The cursor options listed change according to the type of 

model in use. 
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Selection filters for feature-based 

models 

 The selection cursor will select any object, i.e. 

Points, Lines, Surfaces, Volumes, Nodes, 

Elements, Annotation 

 The selection filters allow only specific objects 

to be selected, i.e. with the Line filter only Lines 

can be selected and with the Surface filter only 

Surfaces can be selected. 

 Selection filters can be activated either from the 

drop buttons to the right of the cursor button, or 

using keyboard shortcuts. To display the drop 

buttons click on the down-arrow to the right of 

the cursor button.  Alternatively hold down the appropriate key whilst selecting 

using the normal cursor as follows: 

  

G – Geometry selection filter 

P – Point selection filter 

L – Line selection filter 

S – Surface selection filter 

V – Volume selection filter 

M – Mesh selection filter 

N – Node selection filter 

E – Element selection filter 

A – Annotation selection filter 

When a specific selection option has been chosen the on-screen cursor will 

show a graphical representation of the chosen option. 
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Selection filters for mesh-only models 

 The selection cursor will select only Nodes, 

Elements or Annotation 

 The selection filters allow only specific objects 

to be selected, i.e. with the Edges filter only 

edges of elements can be selected and with the 

Faces filter only Faces can be selected. 

 Selection filters can be activated either from the 

drop buttons to the right of the cursor button, or 

using keyboard shortcuts. To display the drop buttons click on the down-arrow 

to the right of the cursor button.  Alternatively hold down the appropriate key 

whilst selecting using the normal cursor as follows: 

  

M – Mesh selection filter 

N – Node selection filter 

B – Edge selection filter  

F – Face selection filter 

E – Element selection filter 

A – Annotation selection filter 

When a specific selection option has been chosen the on-screen cursor will 

show a graphical representation of the chosen option 

See Appendix C - Model Selection Shortcuts for a complete listing of all the 

selection keys available. 
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Planar selection filters 

These can be used to define planes in which, or axes 

along which features can be selected. When used in 

isolation all features/objects in a chosen axis or plane 

will be selected within a cursor selection. When a 

planar option is set prior to using the previously 

mentioned Feature/Mesh Object Selection option 

individual points or lines or elements etc can be 

selected within the axis or plane chosen. 

Axes and planes are defined by model view axes and 

the model vertical axis. 

When a specific selection option has been chosen the 

on-screen cursor will show a graphical representation 

of the chosen option. 

See Appendix C - Model Selection Shortcuts for a complete description of these 

selection filters. 

Area selections 

Regions or areas of the model may be selected as a rectangular, a circle, or a polygon 

either using the appropriate toolbar buttons or the keyboard short cut.  

 

To select a rectangular area click to define one corner, hold the mouse button 

down, and drag the cursor to the opposite diagonal corner. This can also be 

achieved using the standard cursor. 

 Default behaviour is to select items that are wholly within a selection box 

regardless of whether left-to-right or right-to-left movement of the cursor has 

taken place when selecting the extents. A right-to-left definition of extents can 

be optionally set to select all features crossed by the selection box (as often 

used by CAD software).  

 

Pick the circle selection tool or hold down the C key then select the centre of 

the circle and drag the edge of the circle to the required radius. 

 

Pick the polygon selection tool or hold down the X key then select each corner 

of a polygon and either double click to close the polygon or select Close 

Polygon from the context menu. It is invalid to define a vertex which would 

cause two lines on the perimeter to cross. Because more than one click is 

needed to define a polygon, individual items may not be selected whilst in 

polygon select mode. 
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Cumulative selection 

Note that cursor selection options are cumulative, so it is possible, for example, to 

make a rectangular selection of only all the vertical surfaces within a model. This 

would be achieved by selecting the   Select Vertical only toolbar button, prior to 

either selecting the   Surface selection toolbar button, or selecting the  

Rectangle Select toolbar button whilst holding down the S key to limit the selection to 

just Surfaces. 

Browsing Selected Features 

Items in the current selection may be viewed in the Selected items panel, which can be 

displayed from the View> Selected Items menu item. This panel can also be triggered 

by a right mouse button click in the Selected area of the status bar at the bottom of the 

Modeller user interface, or by right-clicking in a View window. Selected features can 

be deselected and reselected as necessary from those listed. 

Cursor and Area Selection Modifiers 

Items can be added to, toggled, or removed from a selection by the use of specific 

keys. The default keys used are the same as you mat be familiar with from other 

Windows programs: 

 Holding down the Shift key whilst selecting items will Add the newly selected 

items to those currently selected. 

 Holding down the Control key while selecting items will enable the selection 

state of the item selected to be Toggled.   

 Holding down the Shift and Control keys while selecting will Remove items 

found from the current selection 

 By default all items completely enclosed in a selected area will be selected. By 

holding down the Alt key, items intersecting the selection perimeter will also 

be selected. The Alt key may be used with, or independently from, the Shift or 

Ctrl keys. The Alt key can also be used with feature selection shortcuts e.g. 

Alt + Shft + L adds lines to the current selection. 

 All visible items can be selected together using the Select All command which 

can be invoked from the Edit> Select All menu item, from the right-click 

context menu or using the Control + A keyboard shortcut.  

 As stated for other cursor-based selections, default behaviour is to select items 

that are wholly within a selection box regardless of whether left-to-right or 

right-to-left movement of the cursor has taken place when selecting the extents. 

A right-to-left definition of extents can be optionally set to select all features 

crossed by the selection box (as often used by CAD software).   
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Mapping of Keyboard Modifiers for Cursor and Area 

Selection 

The Cursor drop-down menu contains a Keyboard Mapping... menu item which 

allows the default Windows-based cursor and area selection keyboard modifiers to be 

changed to suit those that are generally used with CAD modelling systems or be user-

defined.  

 Windows - Uses the defaults stated in the Cursor and Area Selection Keyboard 

Modifiers section. 

 CAD - Uses the defaults shown in the following table. 

 

Keyboard modifier actions when selecting items using Windows defaults and those 

generally used by CAD systems: 

Key type or sequence Windows CAD systems (generally) 

No keys Set Toggle selection 

Ctrl Toggle selection Set 

Shift Add to selection  Remove from selection 

Ctrl+Shift Remove from selection Add to selection 

  

User-defined modification of the keyboard modifiers requires the Intersection key to 

be defined initially, followed by drop-down menu selections for the No keys, Ctrl, 

Shift, and Ctrl+ Shift key types/sequence, where each has to be uniquely set to be Set, 

Add, Toggle or Remove. 

Selecting coplanar neighbours 

After selecting a surface or element face the Select Coplanar Neighbours menu item 

can be selected from its context menu. This provides a quick way to select a number of 

surfaces or element faces according to their alignment in relation to the selected 

surface or element face. By specifying an angular tolerance all surfaces or element 

faces where the angle between the normals of adjacent surfaces or element faces lies 

within that tolerance will be added to the selection. This is of particular use when 

defining a draping surface as used in composites analysis. An option to ignore internal 

faces helps to ensure that when an element has faces that both lie within the angular 

tolerance, only the external face is selected. 

Advanced Selection Filter 

The advanced selection filter accessed via the context menu item Advanced 

selection... for a view window enables geometry, nodes or elements to be selected 

based on a number of different criteria. Items may be selected by number or range or 

numbers, for example entering 1T5I2 (representing 'one to five in increments of 2') 
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will select items numbered 1,3, and 5. Similarly, entering 4T7,10,12 will select 

items 'four to seven, ten, and twelve. When a results only file is loaded the geometric 

and material attributes reflect the numbers in the solver data file. Geometry can by 

selected according to the connectivity of the feature to surrounding features; End 

Points, Free Lines and External Surfaces can be highlighted in this manner. 

Cycling through the Selection 

When features lie close together, or overlap, it can be difficult to select the required 

feature first time. In these circumstances, each separate press of the Tab key or click 

with the mouse at the same position selects a different feature. The currently selected 

feature is displayed in the Status Bar at the bottom of the screen.  

Alternatively, click in the Status Bar to cycle the selectable features. Or right-click in 

the Status Bar to display a context menu from which Next, Previous, Closest or 

Furthest may be selected. 

Even closer control over the selection of items at the same cursor location can be 

attained using the Cyclable Items panel, which is available from the View> Selection 

Panels> Cyclable Items menu, or by a right mouse button click in the Selected area of 

the status bar at the bottom of the Modeller user interface, or by right-clicking in a 

View window. 

Associate Selection Downwards 

Associate selection downwards is an option to automatically select lower order 

features when selecting objects in the model. For example, selecting a Surface will 

also select the Lines and Points that define the Surface. This option may be invoked 

from the Edit> Associate Selection Downwards menu item. Associate selection 

downwards is set off by default. 

Associate Operations Downwards 

Associate Operations downwards is a option to operate on lower order features 

when a command is issued. For example, deleting a Surface will also delete the Lines 

and Points which define that Surface. This option may be invoked from the Edit> 

Associate Operations Downwards menu item. Associate operations downwards is set 

on by default. 

Selection Memory 

Some operations require features to be stored in selection memory prior to other 

features being selected in order to complete an operation. One example of use would 

include the setting of a single point in selection memory prior to the normal selection 

of a number of other points prior to selecting the Geometry> Line> By joining menu 

item to create a fan of lines from the selected point. Another example would be to 
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define the master and slave members when making joint material assignments to sets 

of multiple lines. Here, the set of lines representing the master would be set in 

selection memory and the set of lines representing slave items would be selected 

normally prior to the material being assigned. 

The selection memory commands are available from the Edit> Selection Memory 

menu item or from the context menu enabled by right-clicking in the graphics area. 

The selection memory commands are: 

 Set - clears the selection memory and set the contents to the items in the 

selection. 

 Add - adds the selected items into selection memory. 

 Remove - removes the selected item from selection memory. (Only available if 

the selected item is already in selection memory) 

 Recall - places all objects in selection memory into the main selection. Objects 

are not removed from selection memory. 

 Clear - clears the selection memory. 

 Browse- displays the Selection Memory browse window. 

 

Selection Colour 

The Pen used to draw items in the selection or the selection memory may be changed 

from the View properties. To display the View properties double-click (without 

anything selected) in the View window and choose Properties from context menu. 

Properties panel 

The Properties panel displays the current properties of any number of selected 

geometry features (points, lines, surface, volumes) or selected mesh objects (nodes, 

edges, elements, faces) and displays the attributes which are assigned to those selected 

items. It allows for changing the properties of selected features/objects and for 

assigning or deassigning attributes to and from those items. 

The panel is initially hidden until accessed by a selecting any number of 

features/objects and choosing the Properties context menu item for that object. It can 

also be made visible by selecting the View > Main Panels menu item. The panel can 

be docked, in which case a tab is provided to re-access it, or it can be set to 'float'. 

Double-clicking a docked window will isolate it again.  

For the remainder of this topic when referencing features the term ‘objects’ also 

applies. 

 When a property of the selected feature(s) is the same for all the features then 

the value of the property is displayed in the properties grid .  
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 When a property of the selected feature is not the same for all the features then 

the text 'Different Properties' is displayed as the value of the property. 

Depending on other parameters the property can be disabled or enabled. 

Selection of multiple features/objects 

When multiple features/objects are selected the properties grid can only display 

properties of the same feature type simultaneously. So, for example, if a point and a 

line are selected, the grid cannot display the properties of both at the same time. 

Instead the grid shows the properties of the highest order of the selected feature, and 

populates a combo box at the bottom of the panel with the selected feature types (for 

example 'Line' and 'Point'). By selecting a feature type in this combo box the 

properties for each feature type in the selection can be displayed separately. 

When objects of different sub-types are selected, only common properties may be 

viewed and modified. So, for example, if a straight line and an arc line are selected, 

the first section of the grid that usually displays coordinates is omitted, and only the 

groups and the assignments sections will be available. 

Assignments 

The properties grid also displays the attributes which are assigned to the selected 

features. The assignments are categorised by their type. A type is only present in the 

grid if at least one attribute of this type exists in the model. That means for example 

that if no material attributes exist in the model, the material category will not exist in 

the grid. Depending upon the attribute, the following assignment options may be 

listed: 

 Assigned If an attribute is assigned to all the selected features then its name is 

displayed at the left grid column and the word “Assigned” is displayed as its 

value. If the attribute is assigned to only some of the selected features the text 

“Different Properties” will be displayed, consistent with other non-attribute 

properties. If an attribute is not assigned to any of the selected features then it 

does not appear in the grid. 

 Deassign The attribute will be deassigned from the feature type selected. 

 Edit displays the corresponding attribute definition dialog so the attribute can 

be edited 

 Details This option is only available when the assignments have additional data 

and that data is the same for all of them. For example if all the selected features 

have attribute 'A' not only assigned but also assigned in the same analysis then 

the 'Details' option will be available, and by selecting this a dialog will display 

the assignment’s data. 

 More This is similar to the Details option; when the assignments have 

additional data and that data is different, the action 'More' is available. As an 

example: if attribute 'B' is defined, and there are four lines in a model, and two 
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analyses called 'Analysis 1' and 'Analysis 2'. If attribute 'B' is assigned to one of 

the lines in 'Analysis 1', and to two of the lines in 'Analysis 2', and for one line 

it is not assigned at all, the 'More' option will be available. By selecting this 

option a dialog will display the assignments categorized by their data. 

 (New)This option (at the end of each attribute type's section) allows a new 

attribute assignment to be made to the selected features. 

Groups 

Features may or may not belong to any number of groups. 'Included', or 'Not included' 

will be seen within the grid accordingly. 

Showing assignments for the active loadcase only 

 Show assignments to active loadcase only If this check box at the bottom of 

the Properties panel is checked only those assignments for the current active 

loadcase will be listed in the grid. 

Hierarchy Panel 

The Hierarchy panel lists the higher and lower order features/objects of the currently 

selected single geometry feature or mesh object 

The panel is initially hidden until accessed by a selecting a feature/object and choosing 

the Hierarchy context menu item for that feature/object. It can also be made visible by 

selecting the View > Main Panels menu item. The panel can be docked, in which case 

a tab is provided to re-access it, or it can be set to 'float'. 

For the remainder of this topic when referencing features, the term objects also 

applies. 

The type and feature number of the selected feature is shown. 

 Is mergable (only present for Geometry features). Sets the merge status. 

 Lower order  (not applicable to Points). Lists the lower order features that 

define the selected feature. 

 Higher order  (not applicable to Volumes). Lists the higher order features that 

the selected feature defines) 

 

Selection of a feature within the hierarchy panel will update the panel to show the 

hierarchy for that feature. 

Groups 

The Groups  Treeview is used to store selected user-defined collections of objects 

(geometry, nodes or elements) under a collective name. For example, a certain set of 
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geometry might be grouped together with the name Nut, whilst another set might be 

grouped and named Bolt.  

LUSAS also automatically creates groups as part of the general modelling process as 

slice sections are created, or as a result of an analysis when slidelines are present in the 

model. With slice sections, groups are created with the group name Slices with each 

slice section having a group name of Slice 1, Slice 2 etc. With slidelines, a group 

named Slideline Results is created containing master and slave group names for each 

defined slideline. 

Groups are also automatically created when importing data files from other supported 

third-party software applications to create mesh-only models. In this case groups are 

named after element or with material references, if present in the data file. 

When using LUSAS HPM software, groups are automatically created to simplify the 

modelling of the composite parts, as well as the interface surface and other items. 

Uses of Groups 

 Enabling unique components to be identified, manipulated, hidden, or have 

results plotted only on those features. 

 Allowing the assignment of attributes to a group in one step. The appropriate 

geometry features will be used if attributes can not be assigned to all geometry 

types. 

 Identifying all the features that failed to mesh during any command that 

invokes meshing. See Fixing Meshing Problems 

 When defining slice sections through a model in order to view the internal 

arrangement or to plot results. 

 To allow easy manipulation of master and slave results following a slideline 

analysis. 

 

Defining Groups 

Groups can be defined by pressing the Group  button on the main toolbar or by 

selecting the Geometry> Group> New Group menu item. Groups can be defined for 

selected items, visible items, or an empty group can be created ready for adding items 

to it at a later stage 

All current group definitions are listed in the Group panel of the  Treeview. 

Manipulation of Groups can be carried out using the context menu of the Group panel, 

and/or using the sub-menu entries under the main Geometry> Group menu item.  
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Naming Groups 

Groups can be given a meaningful name at the time they are defined. They may later 

be renamed in the  Treeview or from the group properties accessed from the 

context menu.  

Manipulating Groups 

From a group’s context menu the following 

commands will act on that group in the current 

window: 

 Visible Makes all members of the group 

visible.  

 Invisible Makes all members of the group 

invisible.  

 Set as Only Visible Makes the whole model 

invisible and then sets all the members of the 

group to be visible. 

 Advanced Visibility Enables the visibility of the higher and lower order 

features of the members of a group to be manipulated. 

 Results Plots permits results to be selectively plotted for the chosen group. For 

details see plotting results for groups in the results viewing section. 

 Change element type (mesh-only models) permits changing the element type 

of a group of imported elements by description, or by entering a specific known 

element name. 

 Current Group Set the group to be the current group. 

 Rename Enables a group to renamed. 

 Delete Deletes the group. The group is deleted but the contents of the group are 

not. 

 Select Members Adds the members of the group to the current selection. 

 Deselect Members Removes the members of the group from the current 

selection. 

 Add to Group Adds the currently selected items to the group. 

 Remove from Group Removes the currently selected items from the group. 

 Properties Displays a list of the member items of the group. 
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When the group defines a slice section the otherwise generally available Rename, 

Delete, Add to group, and Remove from group options are unavailable but additional 

slice-related options are include on the context menu: 

 Draw axes Draws the local axes for the slice section. Note that options on the 

Contours properties dialog allow for plotting of results on slice sections and at 

slice axis directions. 

 Print Properties Displays information about the slice including cross-sectional 

area of the slice, centroid and section property data. 

 Print Forces Displays force and moment information for the slice. 

 

Group names are added to the Groups treeview in creation order, but can be re-ordered 

by using the Sort by name context menu item accessed from the Groups tab. 

Group symbols explained 

By default a symbol adjacent to each group name in the Groups  Treeview shows 

the visibility and status of each group. 

 Default group icon. 

 The addition of a black dot denotes the current group into which all new geometry 

will be added when created.  

When modelling: 

When 'Show visibility feedback in treeview' is selected the following group icons are 

provided: 

 (green tick) All of the objects in this group are visible. 

When 'Show visibility feedback in treeview' is selected the following group icons are 

provided: 

 A black dot next to a symbol denotes the current group into which all new 

geometry will be added when created.  

 (blue tick) Some of the objects in this group are visible. 

 (red cross) None of the objects in this group are visible. 

When a results file is loaded: 

When 'Show visibility feedback in treeview' is selected and a results file is loaded the 

following icons are provided: 

 (green tick, green border) All of the objects in this group are showing results. 
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 (blue tick, blue border) Some of the objects in this group are visible and some are 

showing results. 

 (green tick, blue border) All of the objects in this group are visible but only some 

are showing results 

Group visibility / symbol feedback panel 

The 'Show visibility feedback in 

treeview' option at the bottom of the 

Groups  Treeview reports on 

whether any groups have been made 

invisible, or whether the model is fully 

visible. The visibility / results feedback settings control whether the group symbols are 

displayed to show the status of the objects in the group, or whether no group visibility 

symbols are to be used.  

Note that for particular sizes of model, and numbers of objects within a number of 

groups, it may be necessary to turn-off the automatic group feedback option to retain 

optimum display speeds. 

Changing the Visibility of Features 

By default all model geometry is visible (providing the geometry layer is present and 

turned 'on' in the Layers  Treeview, and providing it is not hidden by another layer) 

but as models get larger it is convenient to temporarily turn-off the display of parts of 

the model.  

Features may be made invisible using any of the following methods: 

 By selecting features and choosing Invisible from the context menu activated 

from the view window. 

 By selecting an attribute from the  Treeview  and choosing Invisible from 

its context menu. 

 By creating a group from selected model features and choosing Invisible from 

the group name's context menu to make the members of the group invisible.  

Features may be made visible by using any of the following methods: 

 By choosing All Visible from the context menu activated from the View 

window (used if any features have been made invisible) 

 By choosing Visible from an attribute's context menu to re-display the features 

assigned to the attribute 

 By choosing Visible from a group name's context menu to make the members 

of the group visible again. 
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In addition the advanced visibility dialog activated from the View window's context 

menu allows fine control on the visible / invisible items by controlling the visibility of 

higher order and lower order features. i.e. This allows all Lines attached to a Point to 

made visible or all Surfaces connected to a Line to be made invisible. 

Notes: 

 All visible features will always have their lower order features visible. i.e. If a 

line is visible its defining points will also be visible. 

 When a feature is made visible any associated elements or nodes will also be 

made visible. Use the Advanced Visibility dialog to override this behaviour. 

 An element can only be made invisible if its defining feature is invisible. To 

make a chosen element invisible, select the element and then use the Advanced 

Visibility dialog to make the element invisible by selecting the Also apply to 

higher order option. This makes the selected elements and the defining 

features invisible without making the unselected elements invisible. 

Undo/Redo 

 The Undo button allows any number of actions, since the last model save, 

that has resulted in editing of the model data, to be undone. If more than the last action 

is to be undone then the actions to be undone may be selected from the undo history 

list by clicking on the down arrow at the side of the undo button. Note that the undo 

button does not undo any model rotation or zoom operations. Instead specific toolbar 

buttons can be used to undo these operations, if required. See the notes below. 

 Redo is available immediately after choosing an undo event to enable the 

undone action to be reinstated. 

Notes: 

 Accidentally deleting an attribute (such a material attribute) is treated as a 

'simple' undo resulting in that attribute simply being reinstated if the undo 

button is pressed. For a more complex operation, the undo facility works by 

replaying the session file from the last save. Because of this, it is advisable to 

save the model frequently to speed-up the undo facility. 

 Undo is only available when a model file is loaded. (i.e. undo is not available 

when a results file is loaded without a corresponding model file. 

  Undo rotate and  Undo zoom buttons can be added to an 

appropriate toolbar as follows: 
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1. Select the View > Toolbars menu item 

2. Select the Customize button 

3.  Select the Customize tab and choose to view the complete set of 

Rotate and Zoom toolbar buttons.  

4. Drag and drop the buttons onto an appropriate toolbar. 

Page Layout Mode 

Two viewing modes are available, both accessed from the View menu: 

 Working Mode is useful for model generation. In working mode annotation is 

scaled and moved so it is always visible. 

 Page Layout Mode enables the model to be viewed as it would appear on a 

printed page. This makes annotation easier to position and allows pictures to be 

created to a specified scale. 

Scaling 

In Page Layout Mode the model is scaled and positioned within the margins defined 

using Page Setup> File menu item. This behaviour may be modified by toggling the 

scale to fit window   button.  

If a picture is to be created to a specified scale the page size should first be set using 

the File> Print Setup menu item. The desired scale and position should then be set on 

the View tab of the View Properties accessed from the context menu. In this dialog 

the scale to fit window option should be switched off and the scale and origin 

position defined. 

Annotating the Model 

The View window may be annotated using the Tools> Annotation menu item. 

Annotation can be placed by either cursor positioning or by specifying a coordinate 

location in Frame or Model coordinates. Annotation added to the model is displayed in 

the Annotation layer in the  Treeview. 

Cursor positioned annotation 

 Line Single lines may be added in a selection of colours and line styles.  

 Polygon Filled or unfilled polygons may be annotated on the screen in a 

selection of colours. Left click to indicate successive polygon vertices. When at 

least three vertices have been indicated, right click and select Cancel or Close 

from the context menu.  
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 Bitmap Adds a bitmap from a selected file 

 Banner Adds the LUSAS banner 

 Arrow Defines an annotation arrow of a default size and colour 

Coordinate positioned annotation 

Several types of annotation are available: 

 Text Any number of lines of text may be plotted in a selection of fonts, 

character heights, angles and colours. Requires text setting-out point to be 

defined. 

 Line Requires start and end points of line to be defined. Single or multiple lines 

may be added in a selection of colours and line styles. 

 Polygon Requires points to be defined for each vertex. 

 Bitmap Adds a bitmap from a selected file at a specified location point 

 Banner Adds the LUSAS banner at a specified location point 

 Arrow Defines an annotation arrow at specified start and finish points in 

chosen pen colour. 

 Symbol A selection of symbols may 

be plotted in a selection of sizes, 

angles and colours.  

 

Other Annotation 

 Window border Displays an annotated frame around the Window containing 

the LUSAS version number in use with the model name, the date, the model 

title, and the model units.  

 Window summary Window summary 

annotation is added in the form of an 

automatically assembled text block. It displays 

information about the model such as its view 

scale and orientation, and if a results file is 

loaded a summary of key values for a particular 

loadcase. 

 

 Window summary position The location of the summary block of text with 

reference to the left, right, bottom or top of paper. Note that the Window 
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summary can be moved easier graphically by selecting it and then dragging it to 

a new position. 

Notes 

 If the annotation is eclipsed by other model data drag the layer (in the 

Treeview) to the bottom of the stack so that it is drawn last. 

 An annotation toolbar is available but by default is hidden. It can be displayed 

from the View> Toolbar menu item. From this toolbar coordinate positioned 

text and bitmaps can be defined, and cursor positioned lines, boxes, polygons 

and arrows added. 

Editing Annotation 

After being added to a model window, both cursor positioned and coordinate position 

annotation can be easily moved by selecting it with the cursor and dragging to a new 

position. In addition all defining parameters such as location, style and in some cases 

content can be edited.  

To modify the properties of a piece of annotation select the annotation, right-click, 

then choose Properties from the context menu. The following properties apply to most 

annotation types: 

 Anchor point Annotation can be located with respect to the model (model 

coordinates), or to the window frame (frame coordinates). 

 Visibility The annotation can be made visible on all windows or just the 

current one. 

 Pen The pen used to draw lines or polygons can be selected from the pen 

library. Line thicknesses can be edited. The font used for text annotation can be 

modified by clicking on the Font button. 

 Name The identifying name of the annotation item. If no name is entered an 

automatic numeric identifier is allocated. 

Notes 

 By default the anchor point of all annotation is positioned in frame coordinates 

from the bottom left corner of the page. This enables the annotation to be 

positioned separately from the model. If negative values are specified for the 

anchor coordinates then the annotation is positioned from the top right corner 

of the page. 

 Annotation may be tied to the model by specifying the anchor point in model 

coordinates. 
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 Annotation positioned in frame coordinates can be moved by selecting the 

annotation in the graphics window and dragging to the required location. 

 Annotation lines are used where 2D graphing results are to be recreated at 

defined locations. See Results on Sections Through a Model 

 Polygons are used when a section through a 3D model is to be recreated at a 

defined location. See Results on Sections Through A Model 

Saving a Model 

When a model is saved using the File> Save menu item all model properties, views 

and associated values are saved also. If a results file was open when the model was 

saved this is not re-opened automatically when the model is re-opened later. 

Customising the Environment 

Various user-definable settings and facilities allow the interface to be customized. 

 View properties contain options relating to the current window. 

 Startup templates can be used to pre-load the Attributes Treeview of the 

interface with selected attributes for a particular analysis, set default mesh or 

material types, or define preferred colour schemes - to name just a few uses. 

 Startup scripts automatically run after a new model is created, an existing 

model is opened, or a model is solved. These files allow user-defined 

combinations of commands to be inserted to set preferred defaults, colour 

schemes, or results contour preferences. 

 Toolbars and toolbar buttons can be customised and user-defined toolbar 

buttons can added to the user-interface either to sit on a new toolbar group or 

alongside existing buttons in an existing group. 

View Properties 

The View Properties dialog allows general information relating to how both the model 

and results are viewed for a selected window. 

View properties may be displayed in various ways: by double-clicking inside a 

window (with no features selected); by right-clicking a window name in the Layers 

 Treeview and then selecting Properties from the context menu, or by double-

clicking the view properties entry for a particular Window in the Layers  Treeview. 

View properties are defined on the following tabs: 

 General Show or hide the screen ruler, selection tolerance, and enables the 

window background and selection colours to be modified. 
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 View Shows the view rotation vector and rotation increment. Add or removes a 

window border or window summary. Controls if elements activated in the 

active loadcase are displayed or not. Enables the scale and origin position to be 

set and allows the current view settings to be saved. 

 View axes Controls whether views axes and the view axis cube are displayed 

and at what position. The axes style and axis cube settings can also be set. 

 Deformations Specify the amount by which the nodal deformations are scaled. 

 Screen When connecting a laptop or PC to an external screen or projector it is 

possible to specify which screen should be used to ensure that fonts and other 

rendered information can be seen at an appropriate resolution. 

 

General 

 View name is the name of the current window 

 Show Rulers Shows, (or hides), the X,Y,Z axis rulers of the current window. 

 Selection tolerance Sets how close the cursor has to be to a feature to be able 

to select it.  

 

LUSAS uses standard Microsoft Windows colours to define the screen colours by 

default. By deselecting the Use Windows colours option the following colours can be 

changed: 

 Background colour Sets the window background colour. 

 Selection Pen Sets the pen colour used to draw model feature when they are 

selected. 

 Selection memory Pen Sets the pen colour used to draw model features when 

they are in selection memory. 

 

View 

 Scale to fit window/page When enabled automatically adjusts the zoom level 

to fit the model to the view window/page. 

 Scale  (with Scale to fit window/page disabled) allows the scale ratio of 

the view to be set manually 

 Origin position Defines the origin of the view. 

 Perspective projection Switches from isometric to perspective viewing of the 

model. When set, an option to set a Fixed camera position is also available. 

This controls whether there is relative motion between the camera and the 

model when pan and zoom are used. 

 View angle determines the rate at which the perspective distortion occurs. 

A suggested initial setting is 45. 

file:///C:/SVN/Content/dlg0prop/idd_props_view.htm
file:///C:/SVN/Content/dlg0prop/idd_props_view_axes.htm
file:///C:/SVN/Content/dlg7post/idd_props_mesh_deform.htm
file:///C:/SVN/Content/dlg0prop/idd_props_view_screen.htm
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 Close depth This parameter determines how far in front of the view 

position objects are removed from the visualisation. If it is set to zero, an 

object will grow to infinite size on the screen before it disappears from 

view. If it is greater than zero, then objects will disappear from view as the 

depth is reduced. This is input as a percentage of the view depth at 100% 

zoom, and is defaulted to 1%.  

 Show only activated elements Controls whether only the elements activated in 

the active loadcase are displayed or not. 

 Border annotation Displays an annotated frame containing the LUSAS 

version number in use with the model name, date, title, and the model units. 

 Summary annotation An automatically assembled text block that displays 

information about the model such as its view scale and orientation and, if a 

results file is loaded, a summary of key values and settings for a particular 

loadcase. 

 Rotation Vector An equivalent eye position coordinate. Entering (0, 0, 1) 

views the model from the Z axis, and (1, 2, 3) gives a three-dimensional view 

 Rotation increment Sets the rotation increment used for incremental rotation. 

 Location Opens a dialog to allow the location of the summary block of text to 

be set with reference to the left, right, bottom or top of paper. Note that the 

Window summary can be moved more easily graphically by selecting it and 

then dragging it to a new position.  

 Save View Saves the current view settings in a named entry in the Utilities  

treeview. See Saved views for more information. 

 

View Axes 

 Visualise coordinate system Visualises the active coordinate system in the 

view window using the position and style specified. The active coordinate 

system may be set from the Geometry tab of the model properties dialog. 

 Anchor point Anchors the coordinate axes position to either a model 

coordinate, or a frame (window) coordinate. 

 Styles Defines the style used to draw the coordinate axes and optionally sets the 

font used for axes labelling. 

 

View Axis cube 

 Show Axis Cube Turns on / off the axis cube that reports on the orientation of 

the model, and can also be used to orientate the model. 

file:///C:/SVN/Content/dlg5util/Window_Border.htm
file:///C:/SVN/Content/dlg5util/Window_Summary_Key.htm
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 Anchor Anchors the axis cube to a frame (window) coordinate. Positive 

numbers position the cube from bottom-left of screen. Negative number 

position the cube from top-right of screen. 

 Navigation controls When checked adds the Home, Dynamic Rotation, 

Resize, and Perspective buttons beneath the axis cube. 

 Styles The size of the cube, the labelling on the faces of the cube, and the font 

used for the labelling can all be set. 

 

Deformations 

 Specify magnitude Sets the maximum nodal deflection for the mesh as seen on 

the screen (in mm). 

 Specify factor Sets an exaggeration factor for the maximum nodal deflection 

for the mesh. 

 

Initial deformations / cable sag 

 Exaggerate initial deformations / cable sag By default the initial 

deformations in a prior solved mode used as the starting point for the 

'undeformed' mesh of another analysis, or the sag in lines representing cables 

are plotted without any exaggeration are displayed at a factor of 1.0 ignoring 

any deformed mesh scaling settings made. By checking this option, cable sag is 

plotted using the scaling magnitude or factor on this dialog. 

 

Screen 

 Automatic Contains a dropdown containing an entry for each connected screen 

for which physical size information can be determined. Selecting an entry and 

pressing apply will rescale all the objects within LUSAS Modeller to a size 

appropriate for the selected screen. If no screen sizes can be detected, then the 

manual field will be selected by default and populated using a screen pixel-

based calculation. 

 Manual size Allows a screen size to be specified (measured in inches between 

diagonal corners of the screen). 

 

Customize Startup Templates 

Startup templates can be used to pre-load the Attributes Treeview with selected 

attributes for a particular analysis, set default mesh or material types, or define 

preferred colour schemes - to name just a few uses. User-defined startup templates are 

created by recording the setting of a variety of selections and then associating the 

recording with a template name. 
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Case Study. Creating a Startup Template 

In this example a startup template will be created to define a material type, set it as the 

default, and also set user-defined display colours for a View window. 

1. Run LUSAS and create a new blank model of any filename. 

2. Select File > Script > Start Recording and enter my_defaults as the 

filename. 

3. Select Attributes > Material > Material Library, choose Mild Steel and 

click OK. 

4. In the Attributes Treeview, right-click on Mild Steel Ungraded and select Set 

Default.  

5. In the Graphics Area, right-click and select Properties 

6. Deselect Use Windows colours, select a Black background colour, choose a 

Yellow selection pen and click OK when done. 

7. Select File > Script > Stop Recording 

8. Exit from LUSAS. 

Using the Startup Template 

1. Run LUSAS and on the New Model dialog select the  button adjacent to 

the Startup template drop-down list. 

2. On the Customize Startup Template dialog select the  button adjacent to 

the Script field. Enter My defaults into the Name field. Press the Add button 

to add the script and name to the table. Click OK. 

3. On the New Model dialog, select My defaults from the Startup template drop-

down list and click OK. 

4. The startup template script will run setting all values to those previously 

chosen. 

 

Toolbars and Toolbar buttons 

The toolbars used on the Modeller user interface can be adjusted by using the View > 

Toolbars menu item. The Customise dialog presented shows available toolbar groups, 

allows toolbar groups to be turned on or off, allows new toolbar groups to be defined, 

customised toolbar groups to be created, or user-defined toolbar buttons to be added to 

the user-interface either to sit on a new toolbar group or to sit alongside existing 

buttons in an existing group. Toolbar manipulation is provided by Microsoft and is 

incorporated into LUSAS Modeller for general use.  
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Main category toolbar group buttons available, 

showing text labels 

The toolbars tab shows the status of each toolbar 

group 

Turning toolbar groups on and off 

Toolbar groups are listed in the Toolbars dialog and may be turned on or off by 

checking each item in the list. The following options are also available: 

 Show text labels displays the text label beneath each button in the toolbar 

group. 

 

Creating a new toolbar group 

Favourite toolbar buttons (and any user-defined toolbar buttons) can be grouped 

together into a new toolbar group.  

 Use the New button on the Toolbars dialog to create a new, named toolbar 

group such as 'Personal'. An empty 'Personal' button group will be added to the 

Modeller user interface. 

Creating customized toolbar groups 

Toolbar buttons can be added to existing toolbar groups or placed on a new toolbar 

button group. 

 Use the Commands tab to select a toolbar category and then, from the 

arrangement of buttons shown for that category, drag and drop a toolbar button 

into the existing or newly named toolbar group on the user interface. Note that 

toolbar buttons may be removed from toolbar groups by holding down the Alt 

key and then dragging the button into the View window. 
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Creating user-defined toolbar button actions 

Nine user-definable toolbar buttons are provided for linking to a specified action. With 

the Commands tab selected these can be seen if the User entry is selected in the 

Categories list. Scripts can be recorded and specified to be played when a particular 

user-defined toolbar button is selected. 

 In Modeller, use File > Script > Start Recording to record an action to be 

taken (such as the adding a Contours layer to the Treeview and the selecting a 

particular entity such as Force / Moment, and a component such as Mz, for 

example). Then use File > Script Stop Recording to save the script with a 

name such as 'Bending.vbs' to a folder. 

 Then use the User tab to define the action that a particular user-defined toolbar 

button should take when pressed. This involves inserting a text string to 

reference the script that was recorded. A typical entry would read: Fileopen 

"C:\Scripts\Bending_Mz.vbs" 

  
 

User-definable buttons available  

showing text labels 

 

A script can be assigned to each  

numbered user button 

Changing the user-defined toolbar button images 

The default numbered user button images as supplied are held on a single bitmap 

image that is144 pixels wide and 15 pixels high. Each toolbar button image is created 

in sequence and occupies a region that is 16 pixels wide and 15 pixels high. The 

bitmap is named userToolbar.bmp (case-sensitive) and can be found in <LUSAS 

Installation Folder>\Programs\Config folder.  

  
  

User toolbar button bitmap  

image as supplied 

 

Example of user-defined toolbar  

button bitmap image 
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It is recommended that the supplied file is copied and renamed to 

userToolbar_supplied.bmp prior to making any changes to this supplied file. Changes 

made to the button images will be seen when LUSAS Modeller is next run. 

Options 

Use the Options tab to show: 

 Show Screen Tips on toolbars shows a temporary description of the toolbar 

button when the cursor is moved over the button. 

 Large Buttons shows an enlarged view of the original size toolbar button. 
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Chapter 3 : File 

Types 

  

LUSAS File Types 

LUSAS can create or use a significant number of different file types. The main file 

types are summarised below.  

 Model Files (.mdl) are created by 32-bit LUSAS Modeller and are used to store 

all model definition information. The extension .smdl is used for model files 

saved using a 64-bit LUSAS Modeller. 

 Solver (Analysis) Data Files (.dat) are created by LUSAS Modeller during the 

tabulation phase. They contain the data required by LUSAS Solver to perform 

an analysis. 

 Solver Output Files (.out) are text files which are created by LUSAS Solver. 

They contain an echo of the input data, details of any errors or warnings which 

have occurred during the analysis and tabulated results if requested.  

 Solver Results Files (.mys) are created by LUSAS Solver and contain all of the 

analysis results for access by LUSAS Modeller. Results files are also 

occasionally referred to as plot files. 

 Solver Restart Files (.rst) enable a nonlinear, dynamic, transient or viscous 

problem to be restarted after it has failed, or if it has been chosen to stop an 

analysis during a solve, as well as re-start an analysis from a stated increment 

or loadcase 

 History Files (.his) are created by LUSAS Solver and contain specified 

analysis results for access by LUSAS Modeller. 

 Visual Basic Script Files (.vbs) contain a collection of LUSAS Modeller 

commands which, when the script is run, are carried out automatically. Script 

files can be recorded by LUSAS Modeller or edited directly using a text editor. 

file:///C:/SVN/Content/2popups/idh_solver_output_files_out.htm
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 Session Files (.ses) are created automatically every time LUSAS Modeller is 

run. They contain a record of all commands issued during a session. 

 Interface Files (.dxf, .igs, .stp, .stl, .def, .nf and others) allow graphical and 

related structural information to be exchanged between LUSAS Modeller and 

external packages. 

 Command Files (*.cmd) are used to import and export models from and to 

version 13 of LUSAS Modeller where only geometry features supported by 

version 13 Modeller will be exported. 

 Library files (.csv) are created by LUSAS Modeller to store user-defined 

cross-sections. In addition to this library files, LUSAS Modeller also uses 

supplied libraries of pre-defined materials and section properties that cannot be 

edited by users. Another library file (with a .lmd extension) allows users to 

store and transfer attribute data (such as mesh, geometric, material, loading, and 

supports) and associated utilities data between models. See Transferring Data 

Between Models for details. 

 Picture Files (.pic, .bmp, .jpg, .wmf) allow the contents of a View window to 

be saved in a standard file format. Picture files are used to subsequently display 

the information or, in conjunction with the LUSAS Expose program, to create 

files which may be printed or plotted. In addition to proprietary LUSAS picture 

files, screen content can be saved in BMP, JPG or WMF file formats for use 

with third-party applications. 

All file types assume the default extensions that are given in brackets. When 

specifying filenames it is good practice to simply supply the filename without the file 

extension. LUSAS will then supply the correct extension for the file type being written 

which will ensure that existing files are not inadvertently overwritten by specification 

of the wrong file type. 

Model Files 

Model files contain all the information relating to the model, its current database and 

settings. The information is stored in an binary form and may only be accessed using 

LUSAS Modeller. A model file is not saved automatically, but LUSAS Modeller 

prompts on exit as a reminder to save changes to a model file. The following are 

accessed from the File menu: 

 New  Prompts to close an existing model file, and creates a new model file. 

 Open Opens previously saved models. Modeller will prompt for confirmation 

before the currently loaded model is closed. See notes for opening models 

created prior to Version 15.0 

 Close Closes the currently open model file. 

 Save Saves the current model to disk at any time. See Model file locations for 

more details 
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 Save As Allows specification of an alternative filename. Selecting Save as for 

an existing model with results will create a new model file and, if necessary, a 

new folder but the existing results (and other intermediate files) will not be 

copied.  

Opening a LUSAS model will automatically offer to open available results files, if 

found and if listed in the Manage Results Files dialog. 

Opening pre-LUSAS version 15.0 model files 

Opening models created prior to LUSAS version 15.0 which reference more than one 

results file will result in a different File Open dialog being presented from that 

displayed for models with one (or no) results file referenced. See the following for 

more details: 

 Opening pre-LUSAS Version 15.0 models that do not reference multiple 

results files 

 Opening pre-LUSAS Version 15.0 models that reference multiple results 

files   

Notes 

 When using Version 14 releases of Modeller, old Version 13 models can be 

opened if Version 13 is installed but this may take longer than usual as the files 

require conversion to the Version 14 format. 

 When saving a model, disk space may be saved by deleting the mesh and 

faceting data using the Advanced button on the File>  Save As menu item. 

This data will be regenerated when the model is reloaded. 

  Section property data, that may be referenced in a model is saved in a section 

property library that may have a different folder location. 

Opening pre-LUSAS Version 15.0 models that do not 

reference multiple results files 

From LUSAS Version 15.0 onwards the locations of all files referenced by a model 

are saved by specifying model file locations.  

Opening models created prior to Version 15.0 (that do not reference multiple results 

files) will result in this dialog being displayed: 
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On the File open dialog displayed: 

 Open model and convert to new format updates the model to the latest 

format. As a result, when it is saved older versions of LUSAS will no longer be 

able to read it. The filenames of the results files are updated to include a 

reference to the analysis name, and all results and associated model data files 

are saved according to settings made on the Modeller settings page of the 

LUSAS Configuration Utility. 

 Open model read-only keeps the model available for viewing / editing in older 

versions of LUSAS. Filenames of the results files are unchanged. 

 Open results too opens all associated results files for the model. Results files 

for models created prior to Version 15.0 will be listed in the Analyses  

Treeview beneath the Analysis 1 entry.  

Opening pre-LUSAS Version 15.0 models that 

reference multiple results files 

From LUSAS Version 15.0 onwards the locations of all files referenced by a model 

are saved either with, or beneath the model folder by specifying model file locations.  

Models created prior to Version 15.0 allowed combinations and envelopes to be 

created that referenced loadcases from more than one results file. Combination and 

envelope data was saved if the model file was saved. On re-opening such a model, the 

results files used in the combinations or envelopes had to be loaded on top of the 

model, in the order that they were first loaded, for the combinations and envelopes to 

be valid. This was because within the combination or envelope itself the results file 

was referenced by a file number (File: 1, File 2 etc) rather than by its name. 

When opening pre-Version 15.0 models the path and filename of all results filenames 

associated with the model need to be specified if the files are to be automatically 

accessed by LUSAS Modeller each time the model is opened. To not specify a 

filename for the associated results files listed may invalidate the results obtained from 

a combination or envelope depending upon the loadcases included in them. 

Opening a model created prior to Version 15.0, that contains combinations and 

envelopes that, between them, refer to more than one results file, will result in this 

dialog being displayed: 

file:///C:/SVN/Content/dlg0config/Introduction.htm
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On this example dialog the model opened has three results files associated with it: 

results file ID 1, 2 and 3. The location of results file 1 is assumed to be the same folder 

as the model file location because prior to Version 15.0 a results file was (by default) 

written to the same folder and with the same name as the model filename. Results files 

2 and 3 are automatically assigned to Analysis 1 so that they will be saved with that 

analysis when the model is saved. However, the location of any of the results files 

referenced by a combination or envelope saved in the model is, for historical reasons, 

unknown, hence the empty path for results files 2 and 3 in the Filename column. To 

ensure that any combinations and envelopes defined using these files remain valid in 

Version 15.0 and above, the location and filename of these 'unknown' results files need 

to be stated. To do this requires a knowledge or a record of the filenames and the order 

in which the results files were loaded in earlier versions.  

So in summary: 

 ID is the identification number of a results file that is referenced in an envelope 

or combination. 

 Analysis The drop-down list selection made here determines whether a results 

file entry (that is added to the Analyses  Treeview) is saved in that treeview 

when the model is saved.  

 Choosing Analysis 1 (the default option) saves the results file entry in the 

Analyses  Treeview when the model is saved.  

 Choosing None does not save the results file entry in the Analyses  

Treeview when the model is saved. These results files will have to be re-

attached each time the model is read. 

 Filename defines the location and filename of a referenced results file. 

 The  button can be used to correct any filename assumptions made by 

Modeller and to specify the location and filename of any results files that do 

not have a path specified. 
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 The Open check box (when checked) indicates that the results file is to be 

opened when the OK button is pressed. 

 

Warning. The  button will remove the results file ID, Analysis 

and filename entries for that row from the grid and break the link to the 

results file in all combinations and envelopes that make use that results file 

ID. All loadcase entries for the results file will be removed from all 

combinations or envelopes that refer to them. 

 

The Folder for files whose location is not specified is set to be that of the created 

associated model data folder for the model. For a 32-bit installation this folder will be 

called 'LusasFiles32'. The entering of relative paths and model names in the empty 

cells in the Filename column (as opposed to using the  button which specifies full 

paths) mean each entry is evaluated with respect to this folder location. 

Once links are established they are retained within Modeller and can be accessed and 

modified via the File > Manage Results files menu item which provides the same 

functionality. 

Notes 

 Results files added to the grid but not connected to any particular analysis 

(those assigned 'None' in the Analysis column of the grid) will be listed in the 

Analyses  Treeview in sequence beneath the other analysis entries. This 

effectively provides the Version 14.7 working environment for old models 

within the new multiple analysis capability of LUSAS, but means that the 

results files included in the Analyses  Treeview can only be updated by 

opening and solving each relevant model (as was the case in pre-LUSAS 

Version 15 releases). 

Model file locations 

Model folders explained 

 LusasFiles32 is the default folder name and container for a 32-bit installation 

for all project related files (apart from temporary files) that are created by 

LUSAS in the course of modelling or solving an analysis. For a 64-bit 

installation the folder name is "LusasFiles". Each project folder will include 

results files (.mys), solver output files (.out) and solver data files (.dat) for 

instance. Within each project folder, two additional subdirectories are also 

created called 'Backups' and 'Sessions': 

 Backups A copy of the original model is preserved in this folder when 

the model is loaded for editing. The number of revisions of a model that 

can be saved to this folder can be set on the Backups tab of the 

Modeller Properties dialog. The default number of revisions saved is 
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two, but this can be modified. Whenever the model is saved, the 

previous revision is saved here and (assuming the number of revisions 

has been reached ) the oldest revision is deleted. 

 Sessions All session files (.ses) are stored in this subfolder. The model 

recovery file (.rcv) is also stored here. 

Notes  

 When loading a pre-version 19.1 model that has associated files held in the 

historical 'Associated Model Data' folder and on user confirmation of 

upgrading the model to the latest version, these files will be moved to the 

LusasFiles32 folder.  

  In addition to the backup file locations stated it is also possible to maintain 

another (current) copy of the model file in another location. See the Backups 

tab on the Modeller Properties dialog. 

 The folder location of temporary files, created in the course of modelling with 

LUSAS, is specified on the Temporary Files page of the LUSAS 

Configuration Utility. 

 The Windows operating system limits the length of a path to a file to 260 

characters. See File and folder naming in LUSAS. 

 Files written to and present in 'LusasFiles32' folders can be re-created from 

model files. As a result, whilst entire folder structures of folders containing 

LUSAS model data can be chosen to be backed up by system administrators 

for record and security purposes, there is no need to back-up 'LusasFiles32' 

folders if it is chosen to not do so for diskspace, storage capacity or other 

reasons.  

Model Merge 

Model merge allows two or more people to create separate models of specific parts of 

a structure (as for example for different storeys of a building, or different elements of a 

stadium) and then combine them at a later date into one master model. To do this a 

previously saved model can be merged with a currently-loaded model using the File> 

Model merge... menu item. The resulting dialog presented provides options to specify 

how the geometry, attributes, loadcases and groups from the imported model are to be 

merged with equivalent objects in the currently open model.  

Merge attributes 

The following choices are available for merging model data 

 Off The attributes of imported model and currently open model will not be 

merged.  

file:///C:/SVN/Content/dlg0config/Temporary_File_Information.htm
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 By name The imported model attributes of the same type will be merged with 

those of the currently open model if they have the same name. 

 By name and data The imported model attributes of the same type will be 

merged with those of the currently open model if they have the same name and 

the same definition data. 

Merge geometry 

Features will be merged only if they share common lower order features, in addition 

feature merging is dependent upon attribute assignments. By default, identical 

assignments must be found on two features, for those features to be merged. The 

merge type parameter controls how LUSAS handles feature merging. The following 

merge types are supported: 

 Off where no merging is carried out. 

 Exact where features are merged only if all assignments are identical. This is 

the default. 

 Wild where features are merged if feature assignments of the same type for 

both features match. The assignments of both features are retained where the 

assignment type is unique to one feature. 

 Ignore Assignments ignores the assignments when deciding if two objects 

should merge (this is the opposite of "Exact" where the two objects must have 

the same assignments to merge). The assignments of the feature merged out 

will be transferred to the feature retained unless the retained feature already has 

an assignment of that type. 

Notes 

 If two coincident features are not merged, two sets of coincident nodes will be 

generated when they are meshed and the finite element mesh will be 

unconnected at the feature discontinuity. This may be corrected at the meshing 

stage by merging the nodes using the equivalence facility. 

Other options 

 Merge groups by name The groups in the imported model will be merged 

with those in the current model if the groups have the same name. The groups 

are merged by adding the members of the imported groups to those groups in 

the currently open model. This option is on by default. 

 Merge loadcases The source and destination analyses will be merged if the 

source analysis has the same name as an existing destination analysis and the 

two analyses have the same number of loadcases with the same names in the 

same order. This option is off by default. 
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Naming convention for merged attributes and analysis names 

When the names of imported objects have the same name as objects in the currently 

open model, and are not to be merged, the following takes place: 

 For attributes, loadcases and groups a number in parentheses is appended to 

the original name, so an imported model attribute name of “Lmsh1” would 

become “Lmsh1 (2)” in the currently open model. 

 For analyses the word 'Imported' in parentheses is appended to the imported 

analysis name, so an imported model analysis name of “Wind loading” would 

become the destination analysis “Wind loading (Imported)”. Note all 

inheritance is removed from the imported analyses as they are copied into the 

current model because the base analysis in the current model will most likely 

have different assignments to that in the imported model, and there can be only 

one base analysis in the final model. 

 For geometry objects the number and name of geometry objects will be 

retained, if possible, in the current model. Where this is not possible a number 

in parentheses will be appended to the object name if it has one.  

 The object number used to identify each item in the Attributes  Treeview 

will be changed to give some indication of its origins. For example, if Point 23 

in the source database clashes with point 23 in the destination database, then 

rather than just using the next available number say point will use the number 

123 (23 + 100) in the current model, rather than just using the next available. 

Notes 

 Mesh-only models cannot be imported / merged. 

 The two models must have the same units because geometry or attributes are 

not scaled during the import/merge process. 

 When a model has been imported and merged with the current model the File 

> Save menu item acts as if it were the File Save As option, requiring a 

filename to be specified, protecting the current model from being accidentally 

overwritten.. 

File and folder naming in LUSAS 

The Windows operating system limits the length of a path to a file to 260 characters. 

For most modelling situations this should not prove to be a problem but for some 

modelling and analysis applications within LUSAS, notably when carrying out vehicle 

load optimisation (VLO) analysis, this limit may conceivably be met. This will 

typically occur if very long model names are used in conjunction with the use of very 

long names for attributes and analysis runs that are used in VLO analysis.  



Modeller Reference Manual   

    

90 

In the most extreme case files relating to a model can be saved beneath a model folder 

in a folder named 'LusasFiles32' (for a 32-bit installation - see Model File Locations 

for details), in a folder named after the model name. VLO folder and filenames based 

upon user-defined file names are then created beneath that folder. This adds a 

VLO output folder (based upon the model name), and a concatenation of the VLO run 

name, the influence attribute name, and the coordinate value of the position on the 

model to which the influence attribute has been assigned, to make up the full path to a 

particular file. 

A typical 'longest' path name for a file would therefore be constructed from: 

<userspath> / LusasFiles32 / <usersmodelname> / <usersmodelname>_VLOoutput / 

<usersVLORunname> _ <usersInfluenceName> - (0.00000, 0.00000, 0.00000) - 

(element 99999, element 99999).dsp 

Allowing for those parts of a path that are fixed in nature (such as the predefined 

named folder structure and the coordinates and element name) leaves approximately 

150 characters with which to define a model name (noting that the model name 

appears twice in the path), a VLO analysis run name, and an influence attribute name. 

Solver Data Files 

Solver data files contain the data required by LUSAS Solver to perform an analysis. 

Solver data files (.DAT) are automatically created by LUSAS Modeller during the 

tabulation phase which is triggered either by pressing the Solve  button, or by 

selecting any of the other Solve or Solve now options available for the analysis entries 

in the Analyses Treeview. 

A Solver Data file can also be created manually by using the File> Export Solve 

datafile... menu item.  

All methods produce a data file in readable ASCII text format and the file may, if 

necessary, be modified with a standard text editor. The format of the analysis data file 

is described fully in the Solver Reference Manual 

Solver Output Files 

When an analysis is performed by LUSAS Solver it creates a text output file which 

contains a record of the input data, details of all errors diagnostics and warnings and 

tabulated results. 

Solver Restart Files 

When an analysis is performed by LUSAS Solver, data can be written to a restart file 

to enable a nonlinear, dynamic, transient or viscous problem to be restarted. 

Solver restart files are not created by default. Their creation must be specified in 

LUSAS Modeller prior to running an analysis by choosing the File> Export Solver 
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datafile... menu item, accessing the Advanced Solution Options dialog and selecting 

Generate option. 

 The restart facility enables failed or terminated analyses to be restarted from the last 

saved or chosen increment, or loadcase. This is particularly useful for a number of 

situations: 

 When the termination of the analysis was due to a failure of the solution 

process rather than a problem with the modelling of the structure the solution 

may be restarted from the last converged increment with a different or modified 

solution strategy. For example, a failed increment may be restarted under either 

constant load or arc-length control.  

 To break up larger, longer runs of 100s or 1000s of increments or time steps 

into several sequential runs to reduce the size of each results file created. This 

may also be done simply to safeguard against any potential interruption to the 

solving that may otherwise mean starting the analysis again from the beginning. 

 To solve to a certain point or stage in an analysis, and then continue from this 

point with several different further loading configurations that each be 

considered in separate parallel restart runs. 

Notes 

 Restarts from a Solver restart file are not directly supported by LUSAS 

Modeller, so must be run using LUSAS Solver. See the Solver Manual for 

more details. 

 Restarts from a Solver restart file are indirectly supported by LUSAS 

Modeller. For more information see "Specifying an initial state for an analysis" 

on page 585 

Solver Results Files 

Results files When the Solve button is pressed in LUSAS Modeller one or more 

analyses are carried out by LUSAS Solver and a results file will be produced in a 

specified Model folder. LUSAS results files, or plot files as theyare sometimes 

referred to, have a .mys extension. 

The information in a Solver results file is stored in a binary format and may only be 

accessed using LUSAS Modeller. The results file will contain the results of the 

analysis and sufficient model information to process the results. Full details of the 

finite element mesh (nodes and elements), material and geometric property numbers, 

support positions and equivalent nodal loads are stored in the results file so that results 

processing can be carried out without a model file if desired. 
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Opening available results files for a model   

When a model is opened, Modeller will attempt to open all available associated results 

files for that model. The File > Open Available Results Files menu item also exists 

for the same purpose. Results files are loaded on top of the current model and results 

loadcases are added to the relevant Analysis entries in the Analyses  Treeview. 

Results files that are associated with a model can be seen by selecting the File > 

Manage Results files menu item. 

Opening a results file without a model being open 

A results file can be opened in isolation from a model by using the File menu: 

 Open By changing the Files of type drop-down list, results files (.mys) can be 

selected. This opens a results file in isolation from a model. Modeller will 

prompt for confirmation before the currently loaded model is closed.  

 Close Closes the currently open results file. 

Opening a results file in isolation from a model does not provide access to any 

generated post processing loadcases such as envelopes, combinations etc that are 

saved with the model file. 

Closing results files 

 All open results files can be closed at the same time using the File > Close All 

Results Files menu item. 

 Results files can also be closed individually by right-clicking on a loadcase 

name in the Analyses  Treeview and selecting the Close file menu item. 

Notes 

 If a model has been re-meshed since the results file for that model was created 

the cannot be loaded. Instead the model must be re-solved to create and 

automatically open the results file. 

 If a model has been modified in same other way (than just being re-meshed) an 

option to load or not load the results is made available. 

 For transient and nonlinear analyses the frequency that LUSAS Solver writes 

results to the results file is specified when defining the analysis control. If this 

is not specified results are saved in the results file on every time step or load 

increment. 
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Manage Results Files 

From Version 15.0 of LUSAS onwards the locations of all intermediate and results 

files created during the building and solving of a model can be specified to be created 

either within a folder for each model, in the same folder as the model, or a specific 

location dependent upon the Model File Locations used. 

The File > Manage Results Files menu item displays a grid that lists all results files 

that are associated with the open model.  

 

It is recommended to always let LUSAS manage results files.  

The Folder for files whose location is not specified is set to be that of the created 

associated model data for this model. For a 32-bit installation this folder will be called 

'LusasFiles32'. The entering of relative paths and model names in the empty cells in 

the Filename column (as opposed to using the  button which specifies full paths) 

mean each entry is evaluated with respect to this folder location. 

In the results file grid: 

 ID is the identification number of a results file. 

 Analysis This column shows the name of the analysis for which the results file 

is applicable. The drop-down list of analyses is populated according to the 

analysis types present in the model.  

 Changing an analysis name associates the results file with a 

particular analysis in the Analyses  Treeview. It is not recommended 

to do this. 

 Choosing None does not save the results file entry in the Analyses 

 Treeview when the model is saved.  

 Filename defines the location and filename of a referenced results file. 

 The  button can be used to correct any filename assumptions made by 

Modeller and to specify the location and filename of any results files that do 

not have a path specified. 

 The Open check box (when checked) indicates that the results file is to be 

opened when the OK button is pressed. 
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Warning. The  button will remove the results file ID, Analysis 

and filename entries for that row from the grid and break the link to the 

results file in all combinations and envelopes that make use that results file 

ID. All loadcase entries for the results file will be removed from all 

combinations or envelopes that refer to them. 

If a results file is to be added to the grid the Let LUSAS manage results files check 

box should be unchecked and the Add file button used to add an extra row to the grid 

to enable an Analysis reference, file location and other settings to be made. 

Notes 

 Results files added to the grid but not connected to any particular analysis 

(those assigned 'None' in the Analysis column of the grid) will be listed in the 

Analyses  Treeview in sequence beneath the other analysis entries. This 

effectively provides the Version 14.7 working environment for old models 

within the new multiple analysis capability that was introduced in Version 

15.0, but means that the results files included in the Analyses  Treeview can 

only be updated by opening and solving each relevant model (as was the case 

in pre-Version 15 releases). 

History Files 

History files are used to output the named variables, and selected node and element 

results from LUSAS Solver in an ASCII format. Specification of the node and element 

numbers to be output to this file is defined from the File> Export Solver datafile... 

menu item, or by setting Advanced Output Options that are set as part of defining a 

Structural Analysis (or Thermal Analysis). The output frequency for incremental 

analyses is controlled using analysis control. The results stored in the time history file 

can be accessed for graphing. 

The history file format consists of a header section with a title, list of named variables, 

type of nodal results and type of element results, followed by the results for each 

time/increment number. The format is shown below. Note. Due to space limitations, 

the number format has been adjusted. Standard history files will contain accuracy to 

machine precision. 

The named variables, selected nodal results and selected element Gauss point results 

will be output for each time step or increment as specified in the analysis control. 

Visual Basic Script Files 

Visual Basic Script files (.vbs) files are particularly useful for automating and carrying 

out repetitive tasksin LUSAS. Typical applications of scripts include: 
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 Use with startup templates to pre-load the Attributes Treeview with selected 

attributes for a particular analysis, set default mesh or material types, or define 

preferred colour schemes.  

 Reading of geometric data, such as column dimensions, section properties and 

span lengths / storey heights etc., from a spreadsheet to automatically build 

multi-span bridge or building models. 

 Rapid generation of parametrically-idealised structures. 

 Automating the creation of numerous load combinations and envelopes. 

 Consistent reproduction of model and results images for use in reports. 

Worked examples, as provided by LUSAS, make use of script files to build models for 

users to develop further, or to solve without issues if user errors have occurred during 

the process of building a model. 

Using scripts in LUSAS 

In LUSAS, script file manipulation is controlled from the Files> Script menu item. 

The following functionality is available: 

 Run Script replays an existing script file after choosing it from the Open 

dialog. 

 Start Recording creates a script file. If a non-default file extension is specified 

or if the file already exists you will be prompted for confirmation before 

proceeding. Existing script files can be appended to if required. While 

recording, all attempted commands are logged to the script file using the 

LUSAS scripting language. 

 Stop Recording closes the script file. 

 

In addition to running a script from the Files menu, user-defined toolbar buttons can 

also be used.  

Startup script files which automatically run after a new model is created, an existing 

model is opened, or a model is solved are provided for users to customise. 

A set of example scripts is provided in LUSAS to assist in the understanding of 

standard concepts including file handling, how to access LUSAS geometry / attribute 

data, and how to import / export data from / to Microsoft Word or Excel, or other 

programs.  

For more detailed information on scripts refer to the LPI Customisation and 

Automation Guide. 
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Exporting script files 

A VBS file may be created from a LUSAS model by using the File> Export... menu 

item. 

Startup Script Files 

 Startup script files are provided which automatically run after a new model is created, 

an existing model is opened, or a model is solved. These files are created in Visual 

Basic Script (.VBS) format and are supplied blank for user-defined combinations of 

commands to be inserted to set preferred defaults, colour schemes, or results contour 

preferences. 

The files provided are: 

 AfterSolve.vbs 

 AfterNewModel.vbs 

 AfterOpenModel.vbs 

For use by the current user 

To carry out actions in one of these files that will affect the current user only, create 

the file you want to alter here: 

%LOCALAPPDATA%\<LusasVersionNumber>\x86 

For example on Windows 7 for AfterSolve.vbs you would create: 

C:\Users\<Name>\AppData\Local\<LusasVersionNumber>\x86\AfterSolve.vbs 

For use by all users 

To carry out the actions in one of these files that will affect all users you would create 

your file here: 

%PROGRAMDATA%\<LusasVersionNumber>\x86\config 

For example on Windows 7 for AfterSolve.vbs you would create: 

C:\ProgramData\<LusasVersionNumber>\x86\config\AfterSolve.vbs 

Note: The easiest way to add VBS commands to a startup script file is to record a 

series of operations in LUSAS and save the resulting file. See Script Files for details. 

Session and Recovery Files 

Each time Modeller is run or the model is saved a new recovery file is created in the 

current working folder. This recovery file is named after the model name with the .rcv 

extension. Every attempted command, whether entered from the user interface or via 
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the command line, is logged in this file using the scripting language. When the model 

is saved or the user exits Modeller the recovery file is renamed to a session file with an 

incrementing version number.  

Picture Files 

About Picture Files 

LUSAS picture files are a historical proprietary image format that may be used for 

storing graphical information for subsequent conversion to an alternative file format 

using the LUSAS picture file utility program, Expose. From Expose, .pic, and types of 

.wmf, .ps and.eps files can be produced. 

LUSAS picture files are stored in readable ASCII text format. The individual picture 

file records use the following general format: 

code, r1, r2, r3, r4, i1, i2, i3 

The information is stored in packets of data as defined in the following table. 

Code    Function    Parameters    Description 

1   Move   r1, r2   Moves to the drawing location specified by the x (r1) and y (r2) 
coordinate (mm). 

2   Draw   r1, r2   Draws a line from the current position to the drawing location 
specified by the x (r1) and y (r2) coordinate (mm). 

3   Symbol   r1, r2, r3, r4, 
i1 

  Plots a LUSAS built-in symbol at a specified screen position. 
(0-Square,1- Circle, 2-Triangle, 3-Double Triangle, 4-
Diamond, 5-Cross, 6-Boxed Cross, 7-Asterisk, 8-Horizontal 
Arrow (origin at apex), 9-Horizontal Arrow (origin at base), 10-
Vertical Arrow, 11-Vertical Line, 12-X, 13-Y, 14-Z, 15-Barred X  

4   Character   r1, r2, r3, r4, 
i1 

  Plots an ASCII character at a specified screen position with: x 
coordinate (r1), y coordinate (r2), rotation angle in degrees 
(r3), character height in mm (r4) and ASCII character code 
(i1). 

5   Colour   r1, r2, r3   Percentage colour content with: red % (r1), green % (r2) and 
blue % (r3). 

9       r1, r2, r3, r4, 
i1 

  Starts a colour-filled multi-sided polygon with: number of 
vertices (i1). Real numbers (r1-r4) are not used. 

0       r1, r2   Creates a polygon vertex with: x and y coordinate (r1-r2). 
Must be used in conjunction with and appear immediately 
after code 8 or 9 above. 

10   Clipping 
Rectangle 

  r1, r2, r3, r4   Sets current clipping rectangle x1-r1, y1-r2, x2-r3, y2-r4 
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20   Multi-Line 
Text 

  r1, r2, r3 ,r4 
,i1 ,i2 

  Defines mutli-line text located at x-r1, y-r2, rotation-r3 
(degrees), size-r4 (mm), alignment-i1 (0-top left, 2-top right, 6-
top centre, 8-bottom left, 10-bottom right, 14-bottom centre, 
16-middle left, 18-middle right, 22-middle centre, 24-baseline 
left, 26-baseline right, 30-baseline centre), nLines-i2 (number 
of subsequent lines of text) 

Saving Picture Files 

Pictures may be saved using the File> Picture Save menu item. 

Notes 

 Views of a LUSAS model can also be saved for use in other applications as 

BMP, JPEG, or PNG files using the File> Picture Save menu item. For more 

information see Printing and Saving Pictures 

 Picture files do not support the perspective viewing facility. 

Print Files 

When using the print result wizard the output may be re-directed to a Print File. A 

print file has a .prn extension. The opening and closing of print files is controlled 

using the Files> Print File menu item. The following facilities are available: 

 File> Print File> Open The print file is opened by specifying a valid filename. 

LUSAS will prompt for confirmation to proceed if the specified file already 

exists or if a non-default file extension is used.  

 File> Print File> Close The print file may be closed at any time. With no print 

file open, printed output will be directed to a text output display window. 

Notes 

 Output to the text window can be directed to a log file. See Text Window for 

more details. 

Page Setup 

Accessed via the File > Page Setup menu item, it allows the paper size and orientation 

to be specified when printing the contents of the Modeller window to a printer or a 

file. Print margins may also be set to control the position of the model data on the page 

to allow for binding edges or for the inclusion of contour key information so that it 

does not lie on top of a model. 

file:///C:/SVN/Content/1using/idh_an_introduction_to_lusas_modeller.htm
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Notes 

 Margin values specified control the position of the model data on screen for 

both Page Layout Mode and also for Working Mode. 

Interface Files 

Interface files are used to transfer external modelling or material data into and out of 

LUSAS Modeller. The full model or a selected portion of a model can, dependent 

upon the file format chosen, be exported to a chosen interface file. 

Currently supported interface file formats: 

 ABAQUS input files (.inp) (used to import node and element data) 

 ANSYS cdb files (.cdb) (used to import node and element data) 

 BIM/BrIM (*.ifc) (used to import and export BIM/BrIM file data) 

 CMD (.cmd) Format for import of LUSAS Modeller model files saved as 

command (CMD) files in previous versions of LUSAS. 

 DXF (.dxf) AutoCAD Drawing eXchange Format.  

 ETABS input files (.e2k) (used to import geometry and property/attribute 

data) 

 IGES (.igs) Initial Graphics Exchange Specification. Format for import and 

export of geometry data. 

 MIDAS input files (.mct, .mgt) (used to import geometry and 

property/attribute data) 

 NASTRAN Bulk Data files (.bdf,.dat) (used to import node and element data) 

 PATRAN (.def) Neutral file format for inputting phase I geometry information 

and outputting phase II mesh information 

 SAP input files (.s2k) (used to import geometry and property/attribute data) 

 Search area topology (.inf) contain details of search areas used by Autoloader 

vehicle load optimisation software. These when imported into LUSAS are 

converted into geometric line and surface data for graphical cross-checking.  

 Solver Data Files (.dat) LUSAS Solver data files (used to import or export 

node and element data) 

 STEP (.stp) STandard for the Exchange of Product data. 

 STL (.stl) Stereolithography data files. 
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 Visual Basic Script Files (*.vbs) contain LUSAS Modeller commands so that, 

when they are replayed, a sequence of operations may be carried out 

automatically.  

Summary of Interface File Import / Export Capability 

Interface file name and 
extension 

Import file into LUSAS 
Modeller? 

Export file from LUSAS 
Modeller? 

ABAQUS (.input) YES NO 

ANSYS (.cdb) YES NO 

BIM/BrIM (.ifc) YES YES 

CMD (.cmd) YES  YES 

DXF (.dxf) YES YES 

ETABS (.e2k) YES NO 

IGES (.igs) YES YES 

MIDAS Input File (.mgt) YES NO 

NASTRAN Bulk Data Files (.bdf, 
.dat) 

YES NO 

PATRAN (.def) YES NO 

SAP (.s2k) YES NO 

LUSAS Solver data Files YES YES 

STEP (.step, .stp) YES YES 

STL (.stl) YES YES 

Visual Basic Script (.vbs) YES YES 

Notes 

 See Importing Interface Data for details of how to import interface files. 

 See Importing Mesh Data for details of how to import finite element data 

files created either by the prior running of an analysis in LUSAS or by 

importing interface files from other supported third-party software applications 

 DXF, IGES and STEP files often contain much more detailed information than 

is required to create a finite element model, so a certain amount of model 

tidying should be expected after carrying out an import.  

 In addition to interface files that can be imported or exported from within 

LUSAS Modeller, other standalone programs are available for particular 

applications and are documented in the CAD Toolkit User manual.  

file:///C:/SVN/Content/2files/file_import_mesh.htm
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Transferring Data Between Models 

The library browser allows users to transfer attribute data (such as mesh, geometric, 

material, loading, and supports) and associated utilities and report data between 

models. Selected data is saved to a LUSAS Model Data file (*.lmd). The browser is 

accessed using the File > Import/Export Model data menu item. Any number of 

library model data files may be created. 

Transferring data 

The library browser displays a list of the attributes and utilities for the currently open 

model, alongside a list of attributes and utilities that have been saved in the selected 

LUSAS model data library file.  

 Selected data can be transferred from the model to the library by using the 

check boxes on the Model side of the dialog to select the attributes for transfer 

and then pressing the Export from model to library radio button. 

 Selected data can be transferred from the library to the model by using the 

check boxes on the Library side of the dialog to select the attributes for transfer 

and then pressing the Import from library to model library radio button. 

Checkboxes are disabled (as shown by  ) according to whether import or export of 

data has been chosen. 

Clash detection when transferring 

Name clash detection checks are carried out to ensure that data is not unknowingly 

over-written.  

Clashes will occur when the same attribute or utility name (with the values or settings) 

is used in the model as in the library file. If clashes occur during the transfer process 

the attribute name or utility in the library file can either be overwritten or the offending 

attribute(s) can be renamed in the Attributes  Treeview panels of the model prior to 

a subsequent re-transfer to the library being attempted.  

When transferring data from a model data library to the model, clashes will occur 

when the same attribute or utility name (with the values or settings) is used in the 

library as in the model file. If a clash is detected the following name clash resolution 

options are provided: 

 Overwrite model item with the one from the library 

 Do not import this item keeps model and library items as they were 

 Append unique name extension appends a user-defined extension to the 

attribute name 

 Prepend unique name prefix gives the attribute name a user-defined prefix 
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 Use this choice for all other name clashes applies one of the previous 

selections to all other clashes of names. 

 

Deleting items  

If any model attributes, utilities or reports are selected using the check boxes available 

pressing either the Delete from model button or the Delete from library button will 

delete those items from their respective sources. As a result, the Library Browser 

dialog also provides the means to carry out multiple deletions of attribute/utilities data 

from a model (something not possible currently via the main Attributes  and 

Utilities  Treeviews).  

Notes 

 Note that whilst the Attributes  and Utilities  Treeview panels may show 

data sorted by id number (default) or by name (optional) the listing of entries in 

the File Library browser is always by name. If necessary, model treeview 

contents can be sorted to match by selecting the menu item Sort by name from 

the context menu for a Treeview tab. 

 If one attribute (such as a composite definition) relies upon another attribute 

(such as a set of material properties) it is not possible to transfer one without 

the other(s). 

 If variations have been used in the definition of an attribute then transferring 

that attribute from the model to the library (and vice-versa) will also transfer 

the relevant utilities datasets describing the variations used. 

  Attributes should not be edited in the library file. 

Exporting Model Data 

Model data can be exported to a chosen interface file format by using the File> 

Export menu item.  

File types supported 

 BIM / BrIM Structural domain files 

 BIM / BrIM Architectural domain files 

 DXF Files 

 Iges Files 

 STEP Files 

 Stereolithography Files 

 Visual Basic Script Files - Files created comply with Microsoft VBScript but 

content is proprietary to LUSAS. 
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 Mesh Only (exc. volumes) - LUSAS proprietary file 

 

Export options 

Depending upon the export file format chosen all, or some of the following export 

options will be available for a selected analysis: 

 Current window 

 All 

 Visible  

 

Depending upon the export file format chosen, some of the following export options 

will be available: 

 Geometry and Mesh (excluding volumes) 

 Geometry and Mesh (including volumes) 

 Geometry Only 

 Geometry and assignments 

 Mesh only (excluding volumes) 

 Mesh only (including volumes) 

 Nodes Only 

 Analyses only 

 Attributes only 

 Analyses, attributes and assignments 

 Deformed mesh factor (only accessible when a results file is loaded) The 

mesh may be tabulated with node coordinates computed from the deformations 

in the active loadcase multiplied by a specified factor. This is useful when the 

deformed mesh caused by one analysis is to be used as the starting point for a 

further analysis. 

 

 Importing Solver datafile data 

Geometry and Mesh data that has been written to a Solver data file may be imported 

into Modeller for particular types of analysis. 

 Point, Line, Surface and Volume geometry data can be imported to create a 

feature-based geometry model using the File> Import... menu item.  

 Element data can be imported to create a mesh-only model by using the File> 

Import menu item. When a file is selected the Advanced button can be used to 

specify import parameters. See Model Types for more information. 
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Geometry and mesh data from supported interface files can be imported using the 

File> Import... menu item. When a file is selected the Advanced button can be used 

to specify import parameters. After all feature entities have been imported, a feature 

merge will be carried out according to the merge setting defined under Model 

properties.  

Importing Mesh Data 

Mesh-only models can be created by importing finite element data files created either 

by the prior running of an analysis in LUSAS or, more usually, by importing data files 

from other supported third-party software applications.  

During the mesh import process, Modeller creates separate Groups for each element 

type encountered. For models created from LUSAS data file these will be familiar 

LUSAS element names. For models created from other software they will be the 

names used within that system, whatever they may be. See Mesh-only models for 

more information. 

After import the vertical axis for the model may need to be defined to ensure correct 

isometric viewing and loading of the model. 

File Import (Advanced option) 

Only those options applicable to the file being imported will be available for selection. 

Option Description Default 

Create 
material 
groups 

Create named groups for elements in the data file having the same 
material property. A maximum number of groups can be specified and if 
more groups are created the number specified only the most common 
element groups in the model will be created. This option is for use with 
LUSAS Solver data files and Nastran bulk data files only. 
  

False 

Exporting a Solver data file 

The File> Export Solver datafile... menu item can be used to export Solver datafiles 

for solution on another computer. It provides the means to select which analyses and 

loadcases are written to a solver data file for all or only visible elements, without any 

solving taking place.  

 The data written to a Solver data file can be controlled according to the following: 

 Analysis Choose the Analysis type to be tabulated. 

 Loadcases / Influences  Choose All loadcases or selected Specified loadcases 

for tabulation 

 Elements Choose All elements, Selected elements or only those Visible 

elements for tabulation 
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Controlling the content of a LUSAS Solver Output File 

When a solution takes place, an output file is generated. Advanced (solution) output 

options can be defined for each solution. These options can be accessed from the 

Advanced button on the Export Solver datafile dialog, or by setting Advanced Output 

Options that are set as part of defining a Structural Analysis (or Thermal Analysis).  

By default no results are written to the LUSAS output file. Results can however be 

written to the output file for All elements and nodes, or for those in the current 

Selection or Selection Memory. The following options allow the results written to the 

output file to be specified. 

 Element results such as stress and strain (as controlled by the LUSAS Solver 

options set from the File> Model Properties menu item) can be written to the 

output file at Node and/or Gauss points and also written to a history file if 

required. 

 Node displacements and reactions can be written to the output file, and also be 

written to a history file if required. 

 History when checked outputs the named variables, and selected node and 

element results from LUSAS Solver to a History file 

 Generate plot file If selected configures the LUSAS Solver data file to create a 

plot file (mys). (default) 

 Generate restart file If selected configures the LUSAS Solver data file to 

create a Restart file (rst). 

Notes 

 During the tabulation process progress will be reported to the Text Window. If 

problems are encountered warnings and/or error messages will be displayed in 

the same window. Such warnings and errors can be caused by inconsistencies 

in the model data which may produce erroneous analysis data files. These 

errors should be acted on before continuing with an analysis. 

 LUSAS is configured to run the majority of analyses without the need to adjust 

the system parameters. In some circumstances however it may be necessary to 

adjust one or more of these parameters. System parameters may be modified 

from within the File> Model Properties using the Defaults tab. Modified 

parameters will be tabulated in a SYSTEM chapter at the start of the LUSAS 

Solver data file. 

Importing Interface File Data 

Geometry and mesh data from supported interface files can be imported using the 

File> Import... menu item. When a file is selected the Advanced button can be used 

to specify import parameters. After all feature entities have been imported, a feature 
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merge will be carried out according to the merge setting defined under Model 

properties.  

File Import Options (Advanced) 

Only those options applicable to the file being imported will be available for selection. 

Option Description Default 

Translate 
annotation type 
geometry entities 

Include entities marked as annotation. 
  

False 

Translate blanked 
entities 

Include entities marked as blank. 
  

False 

Merge trimming 
lines 

Attempts to merge the trimming lines of trimmed 
surface entities. 

False 

Delete dependent 
geometry 

Will delete geometry objects created from entities 
marked as dependent. 

True 

Delete points not 
defining lines 

All points not connected to a line are removed. True 

Delete lines not 
defining surfaces  

All lines not connected to a surface are removed. True 

Delete 
unconnected lines 

Deletes unconnected lines that do not define any 
surfaces. 

True 

Use domain space 
trimming curves 

Use domain space trimming curves in preference to 
model spacing trimming curves. 

False 

Lock the mesh 
post import 

Locks the mesh following import to ensure it is not 
changed unintentionally. 

False 

Model is solid 
volumes 

If selected, fills in any missing data to create a solid 
volume. 

False 

Coalesce surfaces Removes similar lines from adjoining surfaces to 
simplify the model. 

False 

Coalesce volumes Removes similar surfaces from adjoining volumes 
to simplify the model. 

True 

Create material 
groups 

Create named groups for features in the data file 
having the same material property 

False 

Maximum number 
of groups 

Maximum number of groups permitted to be created 
from material property types 

500 

Use dimensions 
from file geometry 
post import 

If selected uses the dimensions and units as 
specified in the imported file 

True 

Merge geometry 
post import 

Merges geometry within the general specified 
merge tolerance. 

True 

Minimum line 
length 

Facets containing lines of less than this specified 
length will be ignored. 

False 
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Minimum angle 
degrees 

Facets containing lines of less than this specified 
length will be ignored. 

False 

Pre-translation 
scale 

Scaling factor applied to all entities before 
translation. 

1.0 

Radius of 
curvature to 
length ratio 

Minimum allowable radius of curvature to line length 
ratio in surface trimming. 

1% 

Parsing error limit Import terminate after specified number of error (0 
indicates no limit). 

2 

Entity types to 
exclude 

List of entity type numbers to ignore (if checked), 
entities of these type numbers will not be translated 
unless they define entities that are to be translated.  

Ignore 106 
(copious data) 
and 108 (plane 
surface)  

Drawing layers to 
process 

Allows selection of named layers when importing 
DXF or IGES data. 

None 

 

ABAQUS Input File Import 

Data from Abaqus Input Files (.inp) can be imported to create a feature-based 

geometry model using the File> Import... menu item or a mesh-only model by using 

the File > Import Mesh menu item. When a file is selected the Advanced button can 

be used to specify import parameters. See Model Types for more information. 

ANSYS CDB File Import 

Data from ANSYS CDB Files (.CDB) can be imported to create a feature-based 

geometry model using the File> Import... menu item or a mesh-only model by using 

the File> Import Mesh menu item. When a file is selected the Advanced button can 

be used to specify import parameters. See Model Types for more information. 

BIM / BrIM File Import/Export 

Import 

Basic geometry data from third-party BIM/BrIM files can be imported to create a 

feature-based geometry model in LUSAS using the File> Import... menu item, or a 

mesh-only model by using the File > Import Mesh menu item. The type of feature 

that is created within LUSAS Modeller will depend upon which entities have been 

created in the CAD system from which the BIM/BrIM file was created. For example: 

 An extruded area solid (IfcExtrudedAreaSolid) entity will create line features 

with assigned sections within LUSAS Modeller.  

 A closed shell (IfcClosedShell) will create a volume (comprised of surface and 

line features) within LUSAS Modeller. 
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Prior to carrying out a BIM/BrIM file import, the use of extruded area solid entity in 

the CAD system model should be used in preference to a closed shell entity since this 

will produce a more efficient LUSAS beam element model that will solve faster than a 

volume model, which requires a greater number of elements to be assigned to achieve 

a solution. 

When a file is selected the Advanced button can be used to specify import parameters. 

See Model Types for more information. 

Notes 

 Any attributes and assignments that were previously exported from LUSAS to 

a BIM/BrIM file will also be imported if the BIM/BrIM file containing those 

items is imported. 

 Currently all BIM/BrIM file data that cannot be translated into data that can be 

used by LUSAS will be disregarded for the purposes of the import. 

Export 

Both BIM/BrIM Structural domain files (*.ifc) and BIM/BrIM Architectural domain 

files (*.ifc) are supported for export. Either LUSAS model geometry only, or model 

geometry and attributes can be exported. 

Notes 

 When Geometry only is selected for export standard BIM/BrIM file entities 

are written to represent that data. LUSAS feature information is also written to 

the export file using a private format to enable LUSAS Modeller to import a 

BIM/BrIM file and recreate correctly named features of a model from a 

previous export. All details of loadcases, attributes, assignments, and similar 

are missing in this type of file. 

 When Geometry and attributes are selected for export, LUSAS analyses, 

loadcases, attributes and assignments data are also written to the export file 

using a private LUSAS format to enable LUSAS Modeller to import a 

BIM/BrIM file and re-create a model from a previous export.  

DXF Interface Files 

The AutoCAD Drawing eXchange Format or DXF file, as it is more commonly 

known, can be used to import and export data to and from LUSAS. 

DXF Import 

DXF files are imported using the File> Import...  menu item. 
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DXF entities supported by the LUSAS DXF import facility are listed in the following 

table: 

DXF Entity    Imported as LUSAS Feature 

POINT   Point. 

LINE   Straight Line. 

3DLINE   Straight Line. 

ARC   Arc Line. 

CIRCLE   Two arc Lines. 

POLYLINE   Spline Line. 

SOLID   Straight-edged Surface. 

3DFACE   Straight-edged Surface. 

TRACE   Straight-edged Surface. 

POLYGON MESH   Multiple straight-edged Surface. 

POLYFACE MESH   Bicubic Surface. 

EXTENDED ENTITIES 

  

  Not supported. 

Tip. Units and entity orientation can be modified by defining a local coordinate and 

making this active before importing. For example, the units may be changed from mm 

to m during conversion by defining a scale local coordinate with X, Y and Z scale 

factors of 1e-3. The entity orientation may be changed from landscape to portrait with 

the aid of an XY rotation local coordinate with an angle of 90 degrees. 

Notes 

 The amount of information which may be transferred via the DXF file is 

limited due to limitations in the DXF file format (for example, a volume cannot 

be expressed in standard DXF data). 

 AutoCAD version 13 uses DXF extended entities for some items. LUSAS does 

not support import of extended entities and will warn to this effect if an 

AutoCAD version 13 DXF file is detected. 
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DXF Export 

A DXF interface file may be created from LUSAS for use in an external program 

using the File> Export... menu item. 

LUSAS attributes are converted into their equivalent DXF entity. Control over the 

amount of information exported is provided, i.e. All or Visible features and/or mesh 

may be specified. This is valid for both pre-processing model files and results files. 

The following parameter is available on the export dialog to control creation of DXF 

files: 

 Level Indicator indicates whether Geometry Only, Mesh Only or 

Geometry and Mesh are to be exported. The level indicator is only required 

when a model file is open and features are active. When no model is loaded, 

such as during post-processing, only the mesh is exported. Additional options 

are available to include Volume mesh entities in the export process. Only 

element faces are exported when exporting Volume feature mesh records. 

LUSAS feature types supported by the DXF export facility are listed in the table 

below: 

LUSAS Feature/Mesh    Exported as DXF Entity 

Feature LINE (straight)   3DLINE 

Feature LINE (arc)   ARC 

Feature LINE (spline)   POLYLINE 

Feature SURFACE (straight-edged)   3DFACE 

Feature SURFACE (general curved)   3DLINE/ARC/POLYLINE 

Mesh LINE (linear or quadratic edge)   3DLINE 

Mesh SURFACE (linear or quadratic 
face) 

  POLYFACE MESH 

Mesh VOLUME (linear or quadratic face) 

  

  POLYFACE MESH 

Notes 

 The exporting of models generates DXF files containing structural information 

only. This facility is not intended for exchanging graphical information, for this 

purpose picture files should be used. 

 Only the element faces are exported when exporting volume feature mesh 

records 



  Chapter 3 : File Types 

    

111 

 For further information on the DXF file format, users are referred to the 

AutoCAD © Reference Manual. 

ETABS Input File Import 

Basic data from ETABS Input Files (.e2k) can be imported to create a feature-based 

geometry model using the File> Import... menu item or a mesh-only model by using 

the File > Import Mesh menu item. When a file is selected the Advanced button can 

be used to specify import parameters. See Model Types for more information. 

Notes 

 Meshing: ETABS does not use the same default beam orientation algorithm as 

LUSAS Modeller. As a result, when an ETABS input file is imported the 

Model Properties meshing option 'Orientate as columns and beams' is 

automatically switched on to identify the alignment of the beams present, and 

the beam element axes for each beam are set to a suitable orientation to 

represent either a vertical column or a horizontal beam, as typically used in 

modelling building frames. 

 Materials: These are directly available from the ETABS input file. A material 

attribute is created in LUSAS Modeller for each material present. 

 Geometric properties: These are directly available from the ETABS input 

file. Geometric properties may be stated in the input file either by reference to 

the ETABS section library, for a section description with section dimensions, 

or for a simple rectangular section dimensions with properties. For all these 

methods a geometric section property is created in the Attributes treeview 

within LUSAS Modeller for each beam present. A section library containing 

sections listed in the ETABS section library is provided on a 

LUSAS installation kit. 

 Supports: Fixed and spring supports are imported. 

 Loading: Concentrated, face, beam, temperature and self weight load types are 

imported. Wind and seismic loading cannot be imported. 

 ETABS storey / grid line data is not currently imported. 

 Importing an ETABS input file sets the vertical axis within LUSAS Modeller 

to be the Z axis. Imported beam sections are orientated accordingly. 

IGES Import / Export 

IGES files are imported from the File> Import... menu item. When a file is selected 

the import process may be controlled from the Advanced button by specifying import 

parameters.  
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LUSAS Model geometry may be exported to IGES using the File> Export... menu 

item. 

Notes: 

 IGES data is made up of a number of discrete surfaces. These need to be 

merged together to create volumes which can then be meshed. 

 When IGES import is used the option to crate hollow volumes is automatically 

invoked. 

 Any active local coordinates will be ignored.  

 All IGES annotation lines and font data is ignored.  

 The IGES interface only supports fixed length ASCII IGES files.  

 All curve and surface geometric type entities are translated into LUSAS 

Modeller.  
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Supported IGES Entities: 

Entity Description 

100 circular arc 

102 composite curve 

104  conic arc 

106 copious data 

108 plane surface 

110 straight line 

112 parametric spline curve 

114 parametric spline surface 

116  point 

118  ruled surface 

120  surface of revolution 

122 tabulated cylinder 

124 transformation matrix 

126  rational B-spline curve 

128  rational B-spline surface 

130  offset curve 

140  offset surface 

141  trimming line of bounded surface 

142  trimming line of parametric surface 

143 trimmed bounded surface  

144  trimmed parametric surface 

186 B-rep volume 

502 Manifold Brep vertex list 

504  Manifold Brep edge list 

508 Manifold Brep loop 

510  Manifold Brep face 

514 Manifold Brep shell 

 

Note. Only those found in the selected IGES file are displayed in the exclusions list. 

MIDAS Input File Import 

Basic data from MIDAS Input Files (.mct, .mgt) can be imported to create a feature-

based geometry model using the File> Import... menu item, or a mesh-only model by 
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using the File > Import Mesh menu item. When a file is selected the Advanced 

button can be used to specify import parameters. See Model Types for more 

information. 

Notes 

 Mesh properties: MIDAS does not use the same default beam orientation 

algorithm as LUSAS Modeller. As a result, when a MIDAS input file is 

imported the Model Properties option 'Orientate as columns and beams' is 

automatically switched on to identify the alignment of the beams present, and 

the beam element axes for each beam are set to a suitable orientation to 

represent either a vertical column or a horizontal beam, as typically used in 

modelling building frames. 

 Material properties: These are not directly available to LUSAS from the 

MIDAS input file. Often, materials are listed in the input file with reference to 

an internal material within MIDAS; sometimes some material values are 

present in the input file, but not all values. As a result, a material attribute is 

created within LUSAS Modeller for each material name that is present in the 

input file, and values of zero are present when no properties for a parameter 

can be derived. The Text Output window within Modeller will list all issues 

with an import. To update the properties it will be necessary for users to locate 

the material library data in the MIDAS installation directory and enter or 

update corresponding values for each material name within LUSAS Modeller. 

 Geometric properties: These are not directly available to LUSAS from the 

MIDAS Input File. The MIDAS file defines beam section properties either by a 

name that references an internal library, or by section dimensions, where it is 

not clear what part of the section the dimensions relate to. As a result a dummy 

attribute with zero values is created. To update the properties it will be 

necessary for users to locate the relevant geometric property data in the 

MIDAS installation directory and enter corresponding values for each 

geometric property name within LUSAS Modeller. 

 Supports: Fixed and spring supports are imported. 

 Loading: Concentrated, face, beam, temperature and self weight load types are 

imported. Wind and seismic loading cannot be imported. 

 MIDAS grid line definitions are not currently imported . 

NASTRAN BDF and DAT Import 

Data from NASTRAN Bulk Data Files (.BDF) or DAT (,dat) files can be imported to 

create a feature-based geometry model using the File> Import... menu item or a mesh-

only model by using the File > Import Mesh menu item. When a file is selected the 

Advanced button can be used to specify import parameters. See Model Types for 

more information. 
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PATRAN Interface Files 

About PATRAN 

The PATRAN neutral file contains the full finite element model information. The 

Neutral file is split into two data categories: Phase I contains the definition of the 

geometric entities, and Phase II contains all of the finite element (node and element) 

information. 

PATRAN Import 

PATRAN files are imported using the File> Import... menu item.  

Phase I data (geometric entities) is read from the PATRAN neutral file. Phase II data 

is ignored. The following table shows the supported Neutral file packet types for 

import into LUSAS: 

Packet    Title    LUSAS Equivalent 

25   Title   Used for information purposes only. 

26   Time/Date/Version   Used for information purposes only. 

31   grid   Point. 

32   line   Spline Line defined by 2 Points. 

33   patch   Bicubic Surface defined by 4 spline Lines. 

34   hyperpatch   Volume. 

47   trimmed surface   Bicubic Surface and spline Lines defining the trimmed 
regions. 

Tip. Imported PATRAN data is particularly suited to tidying, since all defined 

geometry is spline data. See Tidying Imported Lines and Surfaces for more details. 

PATRAN Export 

Export of LUSAS data to PATRAN was last supported in LUSAS V14.3 

SAP Input File Import 

Basic data from SAP Input Files (.s2k) can be imported to create a feature-based 

geometry model using the File> Import... menu item or a mesh-only model by using 

the File > Import Mesh menu item. When a file is selected the Advanced button can 

be used to specify import parameters. See Model Types for more information. 
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Notes 

 Meshing: SAP does not use the same default beam orientation algorithm as 

LUSAS Modeller. As a result, when a SAP input file is imported the Model 

Properties option 'Orientate as columns and beams' is automatically switched 

on to identify the alignment of the beams present, and the beam element axes 

for each beam are set to a suitable orientation to represent either a vertical 

column or a horizontal beam, as typically used in modelling building frames. 

 Material properties: These are directly available from the SAP Input File. A 

material attribute is created in the Attributes treeview within LUSAS Modeller 

for each material present. 

 Geometric properties: The SAP input file defines both beam section 

dimensions and the section properties. A geometric section property is created 

in the Attributes treeview within LUSAS Modeller for each beam present. 

 Supports: Fixed and spring supports are imported 

 Loading: Concentrated, face, beam, temperature and self weight load types are 

imported. Wind and seismic loading cannot be imported. 

 SAP grid line definitions are not currently imported . 

 Importing a SAP input file sets the vertical axis within LUSAS Modeller to be 

the Z axis. Imported beam sections are orientated accordingly. 

STEP Import / Export 

STandard for the Exchange of Product data (STEP) files are imported according to 

Part 42 of the Geometric and Topological Representation by using the File> Import... 

menu item. 

When a file is selected the import process may be controlled by clicking the 

Advanced button and specifying appropriate parameters.  

LUSAS model geometry, mesh or node information may be exported to STL format 

from the File> Export... menu item. 

STL Import / Export 

STL files are used by Stereolithography software. They hold information needed to 

produce 3D models on Stereolithography machines. 

STL files are imported using the File> Import... menu item. When a file is selected 

the import process may be controlled from the Advanced button by specify the 

parameters.  

LUSAS model geometry may be exported to STL format from the File> Export... 

menu item. 
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Notes: 

 STL data defines vertices of triangles that define the shape of a surface. 

Command Files 

V13 Command files are used to import and export models from and to version 13 of 

LUSAS Modeller. 

Models are imported using the File> Import... menu by selecting the V13 CMD Files 

(*.cmd) entry in the File of type combo.  

 

Models may also be exported in cmd format using the File> Export... menu and 

selecting the V13 CMD Files (*.cmd) entry from the Save as type combo.  

Notes 

 When exporting to a cmd file an analysis type must be chosen. All of a base 

analysis is written to the cmd file, but if another analysis references a base 

analysis that data will not be written to the cmd file. To overcome this, the 

attributes referenced in the base analysis should be assigned directly to the 

other analysis prior to the File> Export menu item being chosen. 

 Only geometry features supported by version 13 Modeller will be exported. 
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Chapter 4 : Model 

Geometry 

  

Introduction 

There are four geometric feature types in LUSAS to which attributes such as a mesh 

type, geometric properties, material, supports and loading can be assigned: 

 Points define the vertices of the finite element model. 

 Lines define the edges of the finite element model. (Combined  Lines define 

edges built from a series of continuous lines). 

 Surfaces define external faces or internal construction surfaces of a model. 

 Volumes define simple solid components of a model. 

Features are defined hierarchically , i.e. Points define Lines, Lines define Surfaces, 

Surfaces define Volumes. 

Associative modelling 

If higher order features are created using techniques which do not involve lower order 

features, for example, by specifying coordinates, Modeller will automatically generate 

the lower order features from which to define them. Furthermore, due to feature 

associativity, when a lower order feature, for example a point, is moved, the higher 

order features defined by it, for example a line, is also moved. 

Features may be deleted from the model provided they are not referenced by a higher 

order feature. For example, a Line may not be deleted if it is used in a Surface 

definition. 

Geometry creation 

Geometry can be created by selecting a relevant Geometry menu item for each 

geometric feature type, for example Geometry> Line, or be imported from other 

systems. See Importing Geometry Data. 
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Notes 

 By default, coordinates are expressed in terms of a global Cartesian axis 

system. Local coordinates may be used by setting a pre-defined local 

coordinate active. This is achieved by defining a local coordinate and choosing 

the Set Active command on the context menu. See Local Coordinate Systems. 

 Modelling units used to define coordinates and lengths can be input and 

reported in feet and inches, instead of just feet or just inches. For example, a 

distance can be input and output as 5'11.5. 

 Attributes are assigned on a feature basis, therefore the positions of geometric 

and material discontinuities, supports and loads must be carefully considered 

when defining the features. 

 On dialogs with grid cells expecting dimensional input, the units expected are 

displayed as a data tip when the cursor is hovered over the input cell 

Visualising Geometry 

There are a number of ways to visualise geometry all of which are controlled from the 

Geometry  layer properties activated from the Geometry layer context menu. The 

Geometry layer controls the display of all geometry. If the Geometry layer does not 

exist or is hidden by another layer the geometry will not be drawn.  

Show Geometry 

The Geometry layer properties may be set to not show certain geometry types. To aid 

visualisation Points, Lines, Combined Lines, Surfaces and Volumes can all be 

independently not shown as required.  

Note. Not showing a geometry type is not the same as making all items of that type 

invisible as the presence of that geometry will affect the visibility of lower order 

features. (i.e. A Line cannot be made invisible if a Surface using that line is not shown 

(visible but not drawn) because the drawing of Surfaces has been suppressed in the 

Geometry layer properties). 

Display Style 

Geometry can be displayed in a number of styles. By default Geometry is viewed in 

wireframe mode with hidden parts shown but a wide variety of styles can be obtained 

by mixing the options for wireframe with and without hidden line and solid plots. 

Some examples follow: 

file:///C:/SVN/Content/dlg0prop/idd_props_geometry_overlay.htm
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Default wireframe geometry visualisation 

 

Wireframe with hidden Parts removed 

 

Wireframe with hidden parts draw dashed 

 

Solid fill with wireframe and hidden parts 

removed 

 

Solid fill with wireframe (hidden parts removed) and Points hidden 

Facet Density 

By default lines and surfaces are assigned a facet density which is used in 

visualisation. Facet density effectively controls how smooth a line or surface will look 

when drawn to the screen. Straight lines, arcs and splines are all drawn using facets of 

a particular line length. Surfaces are drawn using facets that are triangular. The default 

facet density may be changed prior to geometry definition from the Geometry tab of 

the Model Properties dialog or after geometry definition by selecting the appropriate 
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Lines and Surfaces and modifying the facet density from the  Geometry> Surface> 

Facet density or Geometry> Line> Facet density menu items. 

  

The facet density may be specified either as: 

 Maximum facet length (in model units). 

 Maximum deviation d (in model units). 

or for Lines as: 

 Minimum adjacent angle (in degrees). 

 Minimum number of facets for straight line, full arc line 

and spline line. 

or for Surfaces as 

 Minimum number of facets for planar surface, surface 

with seam and other surfaces. 

Note that facet density only affects the display of the geometric 

feature and not the actual geometric accuracy of the model. 

 

Notes  

 The display speed is inversely proportion to the number of facets used to define 

the geometry. 

 The facet density can be visualised by selecting the Facet option on the 

Geometry Layer properties dialog. The facet density display can be restricted 

to only selected Lines and Surfaces using the Facet only if selected option. 

Using Colour for Geometry 

The colour in which geometry is drawn may be specified in many ways.  

From the Geometry layer properties specify Colour by: 

 Own colour An individual feature may be drawn in a pen different from the 

default geometry type pen. The pen is specified on the properties dialog. Select 

the single feature and right click then choose Properties to display the feature 

properties. Until a pen is set for an individual feature, that feature will be drawn 

using the default pen. 

 Normals Surfaces are coloured according to whether they are orientated 

showing the top or bottom of the surface. 
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 Assignment Features are coloured according to which attribute is assigned to 

them. Features with no attribute assigned are drawn in grey. The picture below 

shows an example of this. 

 Group Features are coloured according to which group they are in. Features 

not in a group are drawn in grey 

 Type Each geometry type has a default pen, associated with it. This option 

causes all geometry to be drawn in that pen. The colours may be set from the 

Model Properties. By default the settings are red for Points, magenta for Lines, 

orange for Combined lines, green for Surfaces, blue for Volumes. 

 Line / Surface Connectivity Features are drawn in colours according to the 

number of higher order features connected to them and areas of the model that 

have not been merged together correctly after import are highlighted by being 

drawn in a different colour. One example of use is for checking models created 

from the import of 3D CAD data where the use of this option would enable any 

surfaces that were not correctly forming volumes to be seen. Use of the merge 

facility would correct any unmerged and isolated features. 

 

Orientation Axes 

Orientation axes may be viewed as a local axis set for Lines, Surfaces and Volumes . 

The local x, y and z axes are shown, with a double arrowhead on the x axis and a 

single arrowhead on the y axis and no arrow head on the z axis.  

When features are meshed, the orientation of the feature determines the orientation and 

spacing of the elements. Therefore the orientation of Lines, Surfaces and Volumes can 

be changed by reversing or cycling the features. See Changing Geometry 

Orientation for more details. 

In all of the following illustrations the local axes are orthogonal. 
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 Line directions or Line axes can be 

drawn to indicate the local x direction 

of Line. 

 

 Surface axes or Surface normals can 

be displayed. Axes are positioned 

adjacent to the first Line in the Surface 

definition. In the example shown the 

axes are orthogonal but viewed from an 

angle to show the z axis orientation 

 

 Volume axes can be displayed. The 

origin for the axis is closest to the first 

point in the first Surface of the Volume 

definition. 

 

Tip: To aid axes visualisation on larger models choose the Orientations only if 

selected option. This will display axes only on selected features. 

Labels 

Labels can be added to the view of a model from the View> Insert Layer> Labels 

menu item, or from the window context menu. The label options are controlled from 

the labels property dialog. 

Labels may be added to geometry features as follows: 

 Name 

 Position 

 Mesh 

 Geometry 

 Thermal surfaces 

 Retained freedoms 

 Damping  

 Activate 
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 Material 

 Supports 

 Loading 

 Transformed freedoms 

 Composite 

 Slideline 

 Constraints 

 Deactivate 

 Equivalence 

 Search area 

 Influence 

 Age 

 Tendon 

Node, element and Gauss point labels may also be displayed. 

Notes 

 Line labels for standard Lines are drawn at 3/4 distance from the start of the 

line. This can be a useful indication of the line orientation.  

 If a Line is used as part of a Combined Line definition, the Line label is located 

at 8/10 distance and the corresponding Combined Line label is located at 6/10 

distance along the Line segment. This is to avoid the labels overwriting each 

other. 

 For complex models labels may be displayed only on selected features by 

choosing the Label selected items only option on the label properties dialog. 

Points 

Points define the vertices of a model and are used in the definition of lines. Point 

geometry is defined from the Geometry> Point menu item, or by the use of the New 

Point toolbar icons.  

Defining points 

Points can be defined by the following methods: 

 By Coordinates Defines a Point by entering the X, Y and Z coordinates (Z is 

optional). If a non-Cartesian local coordinate system is in use the coordinates 

are specified in the coordinate system of that local coordinate set. The dialog 

box labels will be updated to reflect the required coordinate input. 

 By Grid Allows points to be defined with respect to a geometry definition grid 

(which displays a regularly spaced set of points) or a layout grid. On each 

cursor click, a point is created at the nearest grid intersection. 

 By Cursor Allows definition of a series of Points on the screen with the cursor. 

The Points can snap to a grid in the XY, YZ or XZ plane. The out -of-plane 
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ordinate can be specified as non-zero if desired. This facility is useful for 

positioning Points on Lines or Surfaces which will be used for splitting that 

feature later. 

 From Mesh Defines a Point at the position of every node of the selected mesh. 

 See Geometry From Mesh. This is useful for defining a Point feature to 

which loads or supports can be subsequently assigned. The Point must be 

equivalenced with the underlying meshed feature in order for the Point's 

assigned attributes to be transferred to the underlying nodes. Subsequent re-

meshing of the structure with different mesh spacing characteristics may result 

in movement of the underlying nodal positions.  

 By Intersection Defines a Point or a number of 

Points at the intersections of two or more selected 

Lines. When the Lines selected do not physically 

intersect Points may be created at the nearest 

intersections. These nearest intersections are 

controlled by the following options.  

 All point pairs creates Points at all 

possible intersections. 

 Nearest point pair only creates a Point on each line where the 

projection of the Lines is at its nearest. 

 Nearest pair to reference position defines Points on each line at 

the intersection nearest to the defined reference Point. 

 Limit distance between points only creates Points at intersections 

that are within a specified distance 

 Allow extended lines will create Points at the intersection of the 

extension of the selected Lines. 

 By Projection Defines a Point at the (perpendicular) 

projection of a selected Point onto a selected Line or 

Surface. 

 By Extension Defines a point at the extension of a 

selected Line. The extension may be defined as a 

parametric or actual length. 

 Make Planar moves the selected points onto a plane 

defined either as an offset from an orthogonal plane, or onto a plane defined by 

3 coordinates, or as a best fit to the selected points. A local coordinate may be 

used to define the orthogonal axes if required. 
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Case Study. Editing Point Properties 

By selecting a single Point, then right-clicking to display the context menu, 

properties relating to that Point can be displayed. From an individual Point’s 

properties the coordinates can be altered, and attribute assignments may be 

manipulated.  

  

Lines 

Lines connect point features and are used in the definition of surfaces. Line geometry 

is defined from the Geometry> Line menu item, or by the use of the New Line 

toolbar icons. Line directions are defined by the order of the points defining the line. 

Line types available are: 

 Line defined by two Points. 

 Arc/Circle defined by two Points and a Line map ( a means of selecting the 

meaning of a third definition point) 

 Elliptical arc / Ellipse defined by point coordinates and specification of major 

and minor axes directions, and major and minor radii. 

 Spline defined by two or more Points. 

 Lines may also be created by Splitting lines, and Intersecting with other lines 

Defining lines 

Lines can be defined by the following menthods: 

 By Coordinates Defines a Line by entering the X, Y and Z coordinates. 

Entering more than two coordinates will define linked Lines. If a non-Cartesian 

local coordinate system is in use the coordinates are specified in the coordinate 

system of that local coordinate. 

 By Grid Allows lines to be defined singly with respect to a geometry definition 

grid (which displays a regularly spaced set of points) or a layout grid, or by 

creating multiple lines in the horizontal or vertical directions, again with 

respect to a layout grid. See Defining lines and surfaces with respect to a 

layout grid for more details. 

 By Cursor Allows definition of a series of straight Lines on the screen with the 

cursor. The Lines can snap to a grid in the XY, YZ or XZ plane. The out of 

plane ordinate can be specified as non-zero if desired. 

 By PointsDefines a Line from selected Points. A dialog is displayed to specify 

the Line type as either Straight Line(s), Arc, or Spline. 
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 Tangent > Point to Line Defines a 

Line between a selected Point and the 

tangent to a selected Arc. An error 

will occur if no tangent is possible. In 

this example Line 2 is created by 

specifying Line 1 and Point 4. Point 5 

is automatically created. 

 

 Tangent > Line between Arcs 

Defines a Line which is tangent to 

two coplanar Arcs. The new Line can 

be defined as an inside or outside 

tangent. Options are available to split 

the Arcs at the new Points, and then 

delete the original Arcs. 

 

 By Sweeping Defines a Line by 

sweeping a Point through a 

transformation (translation, rotation, 

mirror or scale). In this example Line 

1 is created by sweeping Point 1 

through a translation in X and Y.  

 By Offsetting Defines a Line or 

series of Lines offset from a selected 

Line or series of Lines. If multiple 

Lines are selected a new set of Lines 

can be offset in one operation. The 

direction of the generated lines can be 

controlled by selecting a point in the 

direction of the new lines required, 

prior to selecting the lines to be used 

for offsetting.. If multiple Lines are 

selected the outside fillets may be 

created with arcs or straight Lines. 
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 By Joining Defines a number of 

Lines by joining two sets of Points. 

Points put in selection memory define 

the start of each Line, and Points 

selected in a subsequent 'normal' 

selection define the end of each Line. 

The Points must pair up equally. 

Lines are joined according to the 

order in which the Points were 

selected, (or Point number when 

boxing a selection), i.e. first point in 

selection memory joins to first point 

in the selection, etc. In this example 

Lines 1 to 3 were defined, by first 

adding Points 1 to 3 to selection 

memory, then selecting Points 4 to 6, 

and then using this command. 

 

Note also that a fan of lines from one 

point to many others can be created 

by setting one point only in selection 

memory prior to selecting the other 

set of points in a 'normal' selection. 

This is useful for creating lines to 

represent the cables radiating from the 

top of a tower to the deck on a cable 

stayed bridge for example.  

 

    

 By Intersection Lines may be 

defined by intersecting two or more 

Surfaces. Intersects all Surfaces 

within a single selection with all other 

Surfaces within that selection. If no 

intersection is found a warning will 

be issued. 

 

 By Manifolding (via projection) 

Existing Lines may be projected or 

laid onto an existing Surface. A 

Surface to be projected onto is 

selected, followed by the Line to be 

projected and the Geometry> Line> 

By Manifolding menu item is used to 
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create the new manifolded Line. The 

new Line is created in the plane of the 

surface.  

 By Manifolding (via Point creation) 

Lines can also be created directly 

onto a Surface by creating points 

lying on a surface (use the 

Geometry> Point> Cursor menu item 

to snap points, as for instance to a 

curved surface as in the example 

shown) prior to using the Geometry> 

Line> By Manifolding  menu item to 

create the manifolded line. Points 

created prior to choosing the 

command can be, but do not have to 

be, on the boundary of the Surface. In 

this example Points 7 and 8 lie within 

the Surface boundary, while Points 13 

and 14 lie on the boundary. 

 

 From Mesh Defines a Line based 

upon points at the position of every 

node of the selected mesh elements. 

 See Geometry From Mesh.  

  

Defining Arcs and Circles 

Arcs and circles are defined from the Geometry> Line> Arc/Circle menu item. 

  From Coords/Points Coordinates can be entered manually or taken from 

selected Points. The coordinates define the arc in a number of ways: 

 Start Point, Bulge Point and 

End Point Defines an Arc or 

 Circle which passes through 

three coordinate points. In this 

example Line 1 is defined by 

selecting Points 1, 2, 3 and 

specifying Point 2 as the 

‘bulge’ point. Line 2 is 

defined by selecting P4 and 

P5, then entering the 

coordinates to define a 

‘bulge’ Point, P6 (which is 

not actually created) 
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 Start Point, Directional 

Point, End Point, and 

Radius Defines an Arc or 

Circle between two 

coordinate points, to a 

specified radius. A third 

coordinate point is required to 

indicate the direction in which 

the arc or circle bulges. In this 

example arcs are created from 

Point 1 to Point 2 with a 

radius of R, using Direction 

Point 3. Choosing Minor Arc 

creates Line 1, while choosing 

Major Arc creates Line 2. A 

Major Arc subtends an angle 

greater than 180 degrees at 

the arc centre, while a Minor 

Arc subtends an angle less 

than 180 degrees. 

 

 Start Point, Centre Point 

and End Point Defines an 

Arc or Circle between two 

coordinates, with a third 

coordinate defining the centre 

of the arc or circle. The centre 

must be equidistant from the 

start and end points. In this 

example arcs are created by 

selecting Points 2, 3, 4 with 

Point 3 as the arc centre. 

Choosing Minor Arc defines 

Line 1. Choosing Major Arc 

defines Line 2 (dotted line for 

clarity). Note that the centre 

point is not linked to the line, 

so the geometry will not 

update if it is moved. 

 In Plane (seen when defining 

a circle) is a point (which 

does not have to be on the 

circumference of the circle) 

that will define the plane in 
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which the circle is drawn 

from the defined centre, and 

start and end point of the arc 

defining the circle. 

 Radius If a radius is 

specified, the start and end 

point locations of the drawn 

arc are adjusted to match the 

radius. If the radius is not 

specified. then it is defined by 

the distance between the 

centre and start point. 

 Tangent to Lines Inserts an Arc or 

Circle with a specified radius, tangent 

to two selected Lines. The selected 

lines must be straight Lines or Arcs. 

In this example Line 3 is created by 

selecting Lines 1 and 2, then 

specifying a radius and Minor Arc. 

Alternatively, Line 4 is created by 

selecting Lines 1 and 2, then 

specifying a different radius and 

Major Arc. 

 

 By Sweeping Points Defines Arcs by 

sweeping selected Points through a 

specified rotation. In this example 

Point 1 is swept into Line 1 using a 

rotational transformation and 

choosing the Minor Arc option. 
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Example of defining a circle 

The following values and settings 

would define a circle of radius 3, 

about an origin of 0,0: Centre 0,0 / 

Radius 3 / Start/End -3,0 / In Plane 

1,1 

Note that when a radius is specified 

the Start / End coordinate does not 

have to lie at the actual start or end 

of the arc because it defines the 

direction in which the point defining 

the arc lies. When no radius is specified the Start / End coordinate is used to defined 

the radius of the circle about the defined centre. The In Plane value of 1,1 simply 

defines the plane in which the circle lies - and because no z value is defined the circle 

will lie in the x-y plane. 

Elliptical Arc and Ellipse Definition 

Elliptical arcs and ellipses are defined from the Geometry> Line> Ellipse menu item. 

Coordinates can be entered manually or taken from selected points. 

Ellipse point coordinates and settings are used to define the arc/ellipse in the following 

ways: 

  

 Start Point, Centre Point and End Point Defines an arc between the start and 

end coordinates, with the other specified coordinate defining the centre of the 

ellipse about which the arc is generated..  

 In Plane (only seen when defining an ellipse) is a point (which does not have 

to be on the circumference of the ellipse) that will define the plane in which the 

ellipse is drawn from the defined centre, and start and end point of the arc 

defining the ellipse. 

 The Axis direction is specified by selecting either a Major axis or Minor axis 

along with stating an x, y, z direction vector to define the direction in which the 

major or minor axis resides. For example entering values of '0 1 0' would define 

an axis in the Y direction. 

 Minor part, Major part or Full ellipse options draw either an elliptical arc of 

the shortest length between the start and end points, an arc of the longest length 

between two points, or a full ellipse based upon all the associated data. 
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Example of defining an 

ellipse 

The following values and settings would 

define an ellipse of major diameter 20, 

minor diameter 10, about an origin of 

0,0,0: Centre 0,0,0 / Start/End 10,0,0 / 

In Plane 0,5,0 / Major axis with a 

direction vector of '1 0 0' / Full ellipse / 

Major radius 10 / Minor radius 5. 

 

 

Alternative method 

As an alternative to the above stated method, ellipses can also be created by drawing a 

circle, dividing it into (say) 4 arc lines, selecting these lines, and then by selecting the 

context menu option Move and choosing the Scale option, scale factors can be 

specified for each direction relative to the centre of the circle. Note that if the circle is 

defined by a single line, it will not be possible to scale it in this way; the circle must be 

divided up such that each arc line can become a spline line that takes the correct 

curvature. 

Spline Definition 

Spline Lines are defined from the Geometry> Line> Spline menu item. 

Note that the inetrmediate points used to create a spline are not linked to the spline, so 

the geometry will not update if these points are moved. 

 By Points Defines a spline from three or more selected Points. 

 Points and End Tangents Defines a 

Spline passing through two or more 

selected Points. The end directions 

are defined by entering end tangent 

vectors. In this example Line 1 is 

defined by specifying Points 1;2 and 

inputting start and end tangents by 

vectors (1, 0, 0) and (0, -1, 0) 

respectively. Both the direction and 

length of the end tangents control the 

spline shape. In this example, a 

different shape of spline would be 

defined, passing through the same 
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Points, if the end tangents were 

changed to (3, 0, 0) and (0, -0.5, 0) 

respectively. 

 Tangent to Lines Defines a Spline 

passing through two or more selected 

Points. The Spline end vectors are 

taken from the directions of two 

selected Lines. The tangent Lines do 

not have to connect with the Spline. 

In this example Line 3 is defined by 

selecting Points 2, 3, 4, 5 to define the 

path, and Lines 1 and 2 as end 

tangents. 

 

Splitting Lines 

Lines may be split at a Point, or split into a number of equal or unequal divisions to 

form new Lines. The splitting Lines dialogs contain options to automatically split and 

delete the original Lines, and to replace the split Lines with Combined Lines. Note that 

when splitting Lines the original Line can only be deleted if it did not define any 

Surfaces, or if the 'Use in dependent Surfaces' option is selected. As a further option a 

combined line may be created. This is useful if a regular mesh is required. 

Any attributes assigned to a feature that is split will be automatically assigned to the 

new features created. 

Line splitting commands are accessed from the Geometry> Line> By Splitting menu 

item. 

 At a Point Splits an existing Line into 

two new Lines at a selected Point on 

the Line, Spline or Arc. A splitting 

tolerance can be set to increase the 

allowable distance between a Point 

and the Line being split. In the 

example here Line 3 is split at Point 5 

into 2 new component Lines defining 

Combined Line 5. Line 3 is also 

replaced in the definition of Surface 

1. 
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 In Equal Divisions Splits an existing 

Line into a specified number of equal 

divisions. A new Line is defined at 

each division. In the example shown 

Line 1 is split into 4 new Lines of 

equal length, and the original Line is 

deleted. 
 

 Parametric or Actual Distance 

Splits an existing Line into a number 

of divisions based on specification of 

parametric distance values along the 

Line. The direction of the existing 

line is used to calculate the splitting 

positions. A new line is created at 

each division. In this example Line 1 

is split at a parametric distance of 

0.75. Line 2 is created at 3/4 of the 

original length and Line 3 at 1/4. 

Specification of a parametric 

divisions list as 0.1;0.5;0.75 will split 

a line at 1/10, 1/2 and 3/4 distance 

into 4 new lines. 

 

Combined Lines 

A Combined Line is a Line which is composed of several continuous individual Lines. 

Combined Lines may be used in exactly the same ways as other Lines to allow 

Surfaces to be meshed using regular mesh patterns. This is especially useful for 

meshing surfaces defined by more than four Lines.  

Combined lines must be used when carrying out a steel design code check whenever a 

series of lines are used to represent a single steel member, such as when one beam is 

supporting a number of cross-beams along its length. The series of lines representing 

the supporting beam will need to be specified as a combined line. 

Combined Lines are defined from the Geometry> Line> Combined Line menu item 

after pre-selecting the lines required.   

 Lines Defines a Combined Line 

from two or more selected Lines 

that are continuous but do not 

form a closed loop. Any number 

and type of existing Lines can be 

used to define a Combined Line. 
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In the example here Lines 3 and 4 

are used to define Combined Line 

6. Lines 3 and 4 are replaced in 

the definition of Surface 1. 

Notes  

 Automatic numbering uses the next highest available number for Lines or 

Combined Lines. 

 Mesh attributes cannot be assigned directly to Combined Lines, but must be 

assigned to the Lines defining the Combined Line. 

 Using Combined Lines in the definition of Surfaces provides an additional 

means of producing transition meshes. 

 

Case Study. Using Combined Lines 

Combined lines may be used in a surface definition in order to use a regular mesh. 

1. Define a Surface using the New Surface button , and enter the coordinates 

(0,0,0), (100,0,0), (120,20,0),  (100,100,0) and (0,100,0). 

2. Define a Line mesh attribute (using Attributes> Mesh> Line) with of element 

type None with mesh divisions of 1 and assign it to the shorter Line on the left 

hand side of the surface. 

3. Define a Line mesh attribute (using Attributes> Mesh> Line) with of element 

type None with mesh divisions of 3 and assign it to the longer Line on the left 

hand side of the surface. 

4. Define a Surface mesh attribute using (using Attributes> Mesh> Surface) 

 with Plane Stress, Quadrilateral, Linear elements and assign it to the surface. 

This will automatically select an irregular mesh for a five-sided Surface as 

shown below.  

5. Now define a Combined Line by selecting the Lines on the left hand side of the 

model and press the  button from the Line menu item. 

6. Since the Surface definition has been altered the Surface will be remeshed. A 

regular mesh will now be adopted because the line divisions on the Combined 

Line match those on the opposite Line.  
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Irregular Mesh 

A regular Surface mesh using Plane 

Stress, Quadrilateral, Linear elements 

is assigned to the Surface with the 

resulting mesh shown. (An irregular 

mesh is used as surface does not have 

3 or 4 sides). 

 

Regular Mesh Using Combined Lines 

The lines on the right hand side are used to 

define a Combined Line. A remesh occurs 

because the surface has been redefined and 

a regular mesh is generated because the 

surface is now defined with 3 Lines and 1 

Combined Line. 

 

Surfaces 

Surfaces define the faces of a model and are used in the definition of volumes. Surface 

definition commands are found under the Geometry> Surface menu item. Surface 

types are: 

 Regular defined by 3 or 4 Lines. 

 Irregular defined by 5 or more Lines. 

Note. For meshing purposes an irregular surface can be considered to be a regular 

surface using Combined Lines. 

Defining Surfaces 

Surfaces can be defined by the following methods: 

 By Coordinates Defines a Surface by entering a list of X, Y and Z coordinates 

(Z is optional). If a non-Cartesian local coordinate system is in use the 

coordinates are specified in the coordinate system of that local coordinate. 

Coordinates can be entered using global (default) or local coordinate systems. 

 By Grid Allows surfaces to be defined singly with respect to a geometry 

definition grid (which displays a regularly spaced set of points) or a layout 

grid, or by creating multiple surfaces in the horizontal or vertical directions, 

again with respect to a layout grid. See Defining lines and surfaces with 

respect to a layout grid for more details. 

 By Cursor Allows definition of a series of flat rectangular Surfaces on the 

screen with the cursor. The Surfaces can snap to a grid in the XY, YZ or XZ 

plane. The out of plane ordinate can be specified as non-zero if desired. 
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 By Points Defines a Surface from three or more selected Points. A Surface can 

be defined from any number of Points. 

 By Lines Defines a Surface from the selected Lines. When defining Surfaces in 

this way, any number of Lines may be specified in any order and a Surface will 

be formed from the greatest number of lines that form a closed loop. If a 

number of disconnected Lines are selected a Lofted Surface will be created. A 

lofted Surface is defined as Surface with a smooth transition between 2 or more 

Lines. 

 From Mesh Defines a Surface based upon lines and points at the position of 

every node of the selected mesh. See Geometry From Mesh. 

 

  

  Surfaces generated from selected Lines   

  

 

Lofted Surface generated from selected Lines 

Note: The direction in which the Surface is defined is used to define the Surface 

orientation, The surface orientation is used at a later stage to define element normals 

and local loading directions. 

Coalescing Surfaces 

Two or more surfaces can be reduced to one surface defined by lines or combined 

lines if the surfaces share a common line. 

Creating Holes in Surfaces 

These are defined by using the Geometry> Surface> Create Holes menu item. 
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 Create Defines a hole or number or holes in a Surface. Closed loop(s) of Lines 

or the Surface(s) representing the hole(s) and the Surface to be holed should be 

selected prior to choosing this menu option. 

 Move Moves or modifies selected hole(s) within a Surface. To move a hole 

select the Lines and/or Points forming the perimeter of the hole. If only some 

Lines or Points are selected the hole will be stretched by only moving the 

selected features. Note that moving a hole actually deletes the original hole and 

recreates a new hole. This means the feature numbers of the Points and Lines 

will not be maintained. 

 Copy Creates multiple holes within a Surface. 

 Delete Deletes the selected hole(s). The hole boundary lines may be deleted, 

retained as Lines or used to create new Surfaces. 

 Delete Deletes all selected holes from a selected Surface. The hole boundary 

lines may be deleted, retained as Lines or used to create new Surfaces. 

Case Study. Creating a Surface with 

Holes 

It is often convenient to create a Surface with 

embedded holes rather than create a number of 

Surfaces around a hole. To create a single Surface 

with a number of holes carry out the following: 

1. Create the outer Surface and a defined a 

separate 'inner' Surface for each hole. 

2. Select all Surfaces. 

3. Use the Geometry> Surface> Holes> 

Create menu item to create a single Surface 

with holes. Ensure that the Delete geometry 

defining holes option is chosen to remove 

the original 'inner' Surfaces defining the 

holes. The lower-order points and lines of 

those surfaces will be re-created because 

they are required define the inner 

boundaries of the enclosing surface. 

 

  

Redefine Perimeter 

A Surface perimeter may be modified by selecting the Surface and the new boundary 

Lines. The new Surface perimeter will be created from a closed loop of Lines formed 

from the old Surface perimeter and the new boundary Lines. The perimeter of the 
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Surface will be defined from the closed loop of Lines with the maximum number of 

segments. If two possible loops of Lines have the same number of segments a 

additional Line from the existing Surface boundary should be selected to resolve the 

ambiguity. 

Case Study. Redefine Surface Perimeter 

To redefine the perimeter of a Surface use the 

following steps. 

1. Create a Rectangular Surface. 

2. Define the new perimeter with Lines which 

start and finish at existing Points on the 

Surface. 

3. Select the Surface and the new perimeter Lines. 

4. Use the Geometry> Surface> Redefine 

Perimeter> Redefine menu item to define the 

new Surface perimeter. 

 

  

Sweeping Surfaces 

 By Sweeping Defines a Surface by sweeping a selected Line through a 

transformation (translation, rotation, mirror or scale). 

Line 1 is swept using an X and Y 

translation to create Surface 1: 

A cylindrical Surface is defined by 

sweeping Line 1 through a rotation: 
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Offsetting 

 By Offsetting Defines a Surface at 

a specified distance normal to a 

selected Surface. The positive 

offset direction is defined by the 

Surface normal unless an 

additional Point is selected. 
 

Splitting Surfaces 

Surfaces may be defined by splitting an existing surface in a number of ways using the 

menu items under Geometry> Surface> Splitting. Surface splitting commands 

contain an option to automatically delete the old Surfaces and Lines which have been 

split. Attributes assigned to the split feature will automatically be assigned to features 

of the same type created during the split process. The following splitting methods are 

supported. 

 By Line Splits a selected Surface at an 

existing Line. The end Points of the Line 

must lie on different boundary Lines of the 

Surface. It is advisable to split curved 

Surfaces using Lines that are manifolded 

over the Surface. In the example shown 

here, the original Surface is split at Line 5. 

Points 5 and 6, defining Line 5, must lie on 

the original Surface boundary Lines. 
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 By Points Splits a selected Surface at two 

boundary positions indicated by Points. A 

new Line will be manifolded onto the 

existing Surface and the Surface will be 

split at this Line. In the example shown, 

Surfaces 2 and 3 are created in the 

parametric space of the original Surface 

using the Points on the boundary. The new 

Line is manifolded onto the original 

Surface. 

 

 At a Point Splits a selected Surface at a 

single Point defined on the surface inside 

the boundary. Four new Surfaces are 

created by manifolding straight Lines or 

arcs onto the existing Surface using the 

relative position of the splitting Point. In 

this example, the original Surface is split at 

Point 5. The resulting Surfaces (2-5), use 

parametric space to calculate boundary 

Point positions. 

 

 In Equal Divisions Splits a selected 

Surface into separate Surfaces at a specified 

number of equal divisions. The direction of 

the split is expressed using local Surface 

axes. In the example shown here, the 

original Surface is split in its local x 

direction into equal divisions forming 3 

new Surfaces. 

 

 At Parametric Distances Splits a selected 

Surface into separate Surfaces at specified 

parametric divisions. For example, 

specifying the parametric distances as 0.25 

and 0.75 will split a Surface at the 1/4 and 

3/4 position in parametric space in the 

specified local direction. In this example, 

the original Surface is split in its local y 

direction at parametric divisions 0.25;0.75. 
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Joining 

 By Joining Defines a number of Surfaces 

by joining two sets of selected Points or 

Lines.  

The first set of Lines should be added to 

selection memory, the second set should be 

selected. The Lines should pair up equally. 

Surfaces are joined according to the order in 

which the Lines were selected, i.e. first Line in 

selection memory joins to first Line in selection, 

etc. 

In the example shown Surfaces 1 and 2 are 

defined by first selecting Lines 1 and 2, then 

adding them to selection memory, then selecting 

Lines 3 and 4 and using the Surface by joining 

command. 

Other surface joining examples 

A single line can be put in selection memory and 

a set of lines selected in a normal selection and 

surfaces created. 

A single point in selection memory and a set of 

lines in normal selection can be used to create a 

pyramid shape of triangular surfaces. 

 

  

Intersection 

 By Intersection Defines a Surface at the intersection of two selected Volumes. 

Manifolding 

Manifolding is the process of creating geometry which lies on the surface map of an 

existing Surface. 

 By Manifolding Existing Surfaces may be projected or laid onto an existing 

Surface. A Surface to be projected onto is placed into Selection Memory and 

the Surface to be projected is then selected prior to choosing the Geometry> 

Surface > By Manifolding menu item. The new Surface is created normal to 

the selected item (in selection memory) and will lie on the map of the 

underlying Surface. 
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 Manifold by Lines Defines a Surface 

positioned on an existing underlying 

Surface with its boundary specified by 

edges or vertices. In this example a 

Surface is created by Joining any 

combination of the Points and Lines 

shown. Any new Lines created will 

automatically be manifolded onto the 

underlying Surface. 

 

  

Extrusion 

 By Extrusion Defines Surface by 

extruding selected Lines a specified 

distance. The positive direction may be 

defined by an additional Point if selected. 

For Arcs the default direction is assumed 

to lie in the plane of the Arc. 

 

Volumes 

About Volume Features 

Volumes define the solid geometry of the model and come in two forms. 

 Solid Volumes are defined by a number of connect Surfaces. These are 

recognised by the geometry engine which allows Boolean operations to be 

performed. Solid Volumes are the default form of Volume and are created 

when geometry is defined in Modeller. 

 Hollow Volumes are defined by a number of disconnected Surfaces. These are 

not recognised by the geometry engine. Hollow Volumes are usually only of 

use when the geometry has been imported from CAD. 

For meshing purposes volumes may be split into the following categories. 

 Regular volumes may be defined as Tetrahedral (a 4 sided volume with all 

faces defined by triangular surfaces), Pentahedral (a 5 sided prism with top 

and bottom faces defined by triangular surfaces and side faces defined by 

quadrilateral surfaces), Hexahedral (a 6-sided cuboid with all faces defined by 

quadrilateral surfaces). 

 Swept irregular are defined by 2 identical irregular Surfaces joined at 

equivalent positions on the boundaries by quadrilateral Surfaces. The Lines 

joining the two irregular surfaces must be either straight Lines or arcs with a 

common centre. 
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 Irregular are defined by any number and type of surface but can only be 

meshed with tetrahedral elements. 

Defining Volumes 

Volumes can be defined by the following methods: 

 By using the Shape Wizard to create regular volumes. 

 By selecting Surfaces to define a Volume from four or more selected 

connected Surfaces. The surfaces may be entered in any order. When defining 

Volumes in this way any number of Surfaces may be selected to define a 

Volume. Duplicate and unconnected Surfaces will be filtered out. 

 By Sweeping to define a Volume by sweeping a selected Surface through a 

transformation (translation, rotation, mirror, or scale). 

  

A surface is swept through a translation to  

create a Hexadedral. 

A surface is swept though a rotation to  

create a Volume. 

 By splitting Splits a selected volume by a selected surface. 

 By joining Joins two selected features to form a Volume, either a Point to a 

Surface, or a Line to a Surface, or two Surfaces. The features are joined by 

straight lines. 

   

Surface 1 is joined  

to Point 4 to form a 

pentahedral. 

Surface 1 is joined  

to Line 5. 

Surface 1 is joined to Surface 2  

to form a hexahedral. Two triangular 

Surfaces joined this way would form a 

pentahedral. 

Groups of Volumes may be defined by joining two sets of selected Surfaces. The first 

set should be added to selection memory and the second set of surfaces should be 

selected. The surfaces will pair up equally, that is, volumes will be joined according to 
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the order in which the surfaces were selected. The first set of surfaces in selection 

memory joins the first set of Surfaces in selection etc. 

 By extrusion Enables a Volume to be 

defined by extruding a specified distance 

normal to a selected Surface. The positive 

direction is defined by the Surface normal 

unless an additional Point is selected. 

Extrusion can be towards or away from 

the specified reference Point. 
 

Coalescing volumes 

The internal Surfaces from a Volume model may be removed by coalescing Volumes. 

This will result in a model with fewer Volumes which may be meshed using 

Tetrahedral elements. 

 From mesh Defines a Volume based upon the position of every node of the 

selected mesh. See Geometry From Mesh. 

 

Case Study. Coalesce Volumes 

Sometimes a results file exists without a corresponding model file. The coalesce 

Volumes feature allows the results mesh to be converted to a Volume model so it can 

be modified and used in a subsequent analysis. 

1. Open results file and use the File> Save As menu item to save it as a .mdl file 

2. Use Control+A to select the mesh and convert it to Volumes using the 

Geometry> Volume> From Mesh menu item and select the Coalesce 

Volumes option. 

3. Create a loadcase. 

Delete Holes 

When geometry is imported from CAD it may have small holes defined which are of 

no significance in the analysis. These holes may be removed using the 

Geometry> Volume> Delete Holes menu item. 

Delete Voids 

Voids are cavities in a Volume which do not penetrate the defining surfaces. Voids are 

removed using the Geometry> Volume> Delete Voids menu item. 

Orientating Volumes Axes 

In some analysis types the Volume axes is used to define the material direction. The 

Volume axis may be orientated by the following methods: 
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 Axis to Surface 

 Cycle Axes 

 Cycle Relative 

See Changing Geometry / Element Orientation for details. 

Hollow Volumes 

Hollow volumes, just like normal solid volumes, are defined by a set of surfaces. 

However, unlike normal solid volumes, the defining lines and points of those surfaces 

do not need to be perfectly merged together. Hollow volumes are mainly used when 

geometry has been imported from CAD systems, when such merging may be difficult 

or impossible. Once defined, hollow volumes behave in almost exactly the same way 

as normal solid volumes. For example, they may be meshed and have attributes 

assigned and deassigned in the usual way. The main difference is that in a geometric 

Boolean operation a hollow volume will behave like a set of surfaces, hence the name.  

Types of hollow volumes 

Hollow volumes may be open or closed. To 

understand the difference, consider just one 

defining edge of the volume between two defining 

surfaces. If that edge consists of exactly one line, 

or exactly two lines of very similar length and 

shape, then those lines can be considered a 

matching pair. If all the defining edges of the 

volume can be matched in this way, the volume is 

said to be closed. However, if one or more edges 

of the volume cannot be matched in this way then 

the volume is said to be open. 

For the example shown, most of the lines form matching pairs. However, one of the 

defining surfaces has an edge that is defined by two lines, with a point in the middle. 

This pair of lines cannot be matched to the corresponding single line on the adjacent 

surface, and so this volume is classed as open. 

The distinction between open and closed hollow volumes is only important when it 

comes to meshing. A closed hollow volume can be meshed in exactly the same way as 

a normal solid volume. However, a regular mesh cannot be assigned to an open hollow 

volume, and so these must be meshed using an irregular mesh. 

Defining hollow volumes 

The user interface to enable the creation of hollow volumes may be invoked from the 

Advanced Dialog of the Geometry Properties dialog (accessed by File> Model 
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Properties> Geometry tab> Advanced). This option is automatically invoked when 

geometry is imported from CAD. When this option is chosen the volume definition 

tools will try to automatically create a solid volume as normal. However, if this 

process fails, a further attempt will be made to create a closed hollow volume from the 

selected surfaces using the defined closure tolerance. 

 Open hollow volumes can only be created via the Geometry> Volume> 

Hollow Volume> Create menu item. 

 Surfaces may be added or removed from an open hollow volume definition 

using the Geometry> Volume> Hollow Volume> Add and Geometry> 

Volume> Hollow Volume> Remove menu items. 

Once a hollow volume has been defined its status (open or closed) can be determined 

from its properties dialog. In some cases an open hollow volume may be changed to a 

closed hollow volume by simply increasing the closure tolerance on the volume 

properties dialog. When meshing a closed hollow volume, any nodes closer together 

than the volume’s node merge tolerance (defined on the volume properties dialog) are 

merged. For closed hollow volumes this defaults to the volume closure tolerance. 

Layout Grids 

Layout grids are typically used to aid with modelling a 2D layout of a structure, but 

they can be copied to create multiple grid levels for a 3D model, as for example to 

provide a setting-out grid for each storey of a building frame. When layout grids are 

used points, lines and surfaces can be defined by cursor with reference to grid 

intersections by a variety of methods, doing away with the need to otherwise enter 

coordinate input to define these features. 

Layout grids can be defined when creating a model from the New Model dialog, or at 

any time from the Utilities> Layout Grid menu item. Any number of layout grids can 

be created within a model. Once created, the data that defines each grid can be viewed, 

edited or copied, and set to be visible or invisible by accessing its context menu in the 

Utilities  Treeview. Grids are drawn by the Utilities  Layer. 

Layout grid settings 

Style 

 Rectangular defines a grid of lines spaced at regular or varying distances in the 

X and Y directions. 

 Skewed (when checked) permits specifying a Skew angle for either set of 

lines in the X or Y direction. 
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 Circular defines a grid of lines spaced at regular or varying distances in the 

radial and circumferential directions. 

 Straight circumferential lines (when checked) draws the circumferential 

grid lines as straight lines as opposed to drawing arcs. 

Origin and placement 

The origin and the placement of the grid, the plane in which the grid will lie, and the 

rotation of the grid in that plane) can be stated. 

Display Settings 

 Pen settings permit the colour of the line and grid labels to be changed. 

 Drawing style defines whether lines are drawn as Lines, Dots, or Lines and 

dots 

 Label settings Grid labels can be specified for the grid lines in the X, or radial 

direction, and in the Y, or circumferential direction. Labels can be alphabetic or 

numeric, and be positioned at the top, bottom, top and bottom (both) or neither 

end of each grid line. Alphabetic labels will be auto generated as 'A', 'B', C' etc 

and increment to 'AA', AB' etc . An option to reverse the direction of the 

labelling is provided. By default grid labels are drawn flat to screen, with flat to 

grid (in the plane of the grid lines) an alternative option. 

Grid data 

For both styles of layout grid the number of grid lines in the X, or radial spacing, and 

in the Y, or circumferential spacing can be stated with respect to fixed, absolute or 

incremental spacings. 

 Fixed means that a single value is used as the spacing between each pair of grid 

lines.  

 Absolute means that each spacing is a distance from the origin. 

 Incremental means that the first spacing is a distance from the origin, and all 

subsequent spacings are a distance from the previous grid line. 
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Examples of use 

  

Rectangular skewed grid Circular grid (with an in-plane rotation angle) 

  

Rectangular and circular grids (in-plane) Multiple rectangular grids (out-of-plane) 

 See also Defining Lines and Surfaces by Grid. 

Defining lines and surfaces with respect to a layout 

grid 

Defining single lines or surfaces 

The Geometry> Line> By Grid> Single and Geometry> Surface> By Grid> Single 

menu items permit the creation of a single line or surface with respect to grid 

intersection points on a layout grid. 

Defining multiple lines or surfaces 

The Geometry> Line> By Grid> Settings and Geometry> Surface> By Grid> 

Settings menu items provide access to options to control how multiple lines or 

surfaces are created when defining those features with respect to a layout grid using 

the Geometry> Line> By Grid> Multiple Horizontal or the Geometry> Surface 

> By Grid> Multiple Vertical menu items. 



Modeller Reference Manual   

    

152 

By clicking and dragging the cursor to box-around a set of layout grid lines and points, 

lines or surfaces can be drawn either horizontally in the plane of the grid, or vertically 

between grid layouts at selected grid intersections.  

For options relating to vertical features at least two vertically offset grids must be 

present with grid point intersections in alignment. Vertical features are always 

generated downwards from a selection made on a chosen layout grid to the lowest 

visible layout grid, so the selection must be made on the highest relevant layout grid to 

achieve a desired result. 

Horizontal lines and surfaces 

 Break feature at each grid vertex Creates a separate line or surface for each 

complete enclosed set of grid lines, and if the Alt key is pressed down at the 

same time, for each grid line intersected by the boxed-selection. 

 Create only one feature per mouse drag per grid Creates just a single line or 

surface feature for each complete enclosed set of grid lines, and if the Alt key is 

pressed down at the same time, for each set of grid lines intersected by the 

boxed-selection. When creating lines, if more than one row and more than one 

column of grid lines is selected, then a rectangle of four lines will be created 

between the outermost enclosed corner of grid points within the boxed 

selection. 

Lines and Surfaces 

 Create feature(s) for nearest grid only If checked, creates features only on 

the nearest layout grid. Otherwise, if this option is not checked and other grids 

exist with the same origin but in different levels, lines or surfaces will be 

created in all grid levels, providing the grid intersection points coincide. 

 Break vertical feature(s) at each grid Creates a separate line or surface for 

each enclosed set of grid intersection points, and if the Alt key is pressed down 

at the same time, for each grid line intersected by the boxed-selection.  

 Create vertical feature(s) unbroken downwards to bottom visible grid 
Creates just a single line or surface feature for each complete enclosed set of 

grid points/lines, and if the Alt key is pressed down at the same time, for each 

set of grid lines intersected by the boxed-selection.  
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Examples of use 

  

Define multiple horizontal lines by grid, with 

"Break feature at each grid vertex" selected 

(without the ALT key pressed) 

Define multiple horizontal lines by grid, with 

"Break feature at each grid vertex" selected (with 

the ALT key pressed) 

  

Define multiple horizontal lines by grid, with 

"Create only one feature per mouse drag per 

grid" (with the Alt key pressed) 

Define multiple horizontal lines by grid, by 

selecting a mid-level grid, with "Break feature at 

each grid vertex" selected (without the ALT key 

pressed) 

  

Define multiple vertical lines by grid, with "Break 

feature at each grid vertex" selected (without the 

ALT key pressed) 

Define multiple vertical surfaces by grid, with 

"Break feature at each grid vertex" selected 

(without the ALT key pressed) 
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Define multiple horizontal surfaces by grid, with 

"Break feature at each grid vertex" selected 

(without the ALT key pressed) 

Define multiple vertical surfaces by grid, with 

"Break feature at each grid vertex" selected, and 

"Create feature unbroken downwards to bottom 

visible grid" (without the ALT key pressed) 

  

Shape Wizard 

The shape wizard defines analytical shapes which may orientated with a local 

coordinate system and positioned by a user-defined origin. If a point is selected the 

selected shape's origin will default to the coordinates of the selected point. Shapes may 

be defined using Lines, Surfaces or Volumes. 

The following shapes are supported; cube, cuboid, cylinder, and cone. The origin of 

each shape is indicated by the axes. 

 

Notes.  

 Specifying a negative length or height results in that dimension being defined 

along the negative axis direction. 
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 For the cylindrical shape there is an option to create the cylinder with a seam 

which effectively creates a cylinder using only one surface rather than the 

default two surfaces. 

Boolean Geometry Construction 

Boolean operations allow complex geometry to be defined by combining, subtracting 

or intersecting existing Surfaces or Volumes. 

  

 Union (with simplify internal geometry) enables a Surface 

or Volume to be defined by union of any number of selected 

Surfaces or Volumes. 

 Union (without simplify internal geometry) enables a 

number of Surfaces or Volumes to be defined by union of any 

number of selected Surfaces or Volumes. 

 Subtraction enables a Surface or Volume to be defined by 

subtracting one Surface or Volume from another Surface or 

Volume. 

 Intersection enables a Surface or Volume to be defined as the 

intersection of two selected Surfaces or Volumes. 

 Slice Enables a selected Volume to be sliced by a plane and 

the resulting geometry to be deleted either side of the slice if 

required. The slice plane may be defined in any global or local 

plane which may be visualised prior to the slice operation.  A 

Surface of any shape may be used to slice a Volume by 

Subtracting the Surface from the Volume. 

  

  

 

Separate 

(unconnected) 

cube and 

cylinder = two 

volumes 
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Union of cube and 

cylinder (simplify 

internal geometry) =  

1 volume 

Union of cube and 

cylinder (no simplify 

internal geometry) =  

4 volumes 

Subtraction of 

cylinder from cube =  

1 volume 

Intersection 

of cube and 

cylinder =  

1 volume 

Geometry from Mesh 

An existing finite element mesh defined in a Solver results model file (.mys) file can 

be converted into features such that each element is converted into a single feature. 

Use of this facility will produce a similar model to that created by the use of the File > 

Import menu item which permits the import of a Solver data file(.dat) to create a 

model.  

In using the Geometry from Mesh facilities, lower order features are automatically 

created, and the command describes the highest order of feature type that is to be 

created. For example, if a Line convert command is used on a single HX8 solid 

element mesh, then 8 Points would be defined at the node positions and 12 Lines 

would be defined from the edges of the HX8. As a result, be warned that very large 

models can be produced . 

The currently selected elements are converted using the following menu items: 

 Geometry> Point > From Mesh creates Points from nodes. 

 Geometry> Line > From Mesh creates Points from nodes and Lines from 

beam elements, surface and volume element edges.  

 Geometry> Surface > From Mesh creates Points from nodes, Lines from 

beam elements and Surfaces from surface elements and volume element faces.  

 Geometry> Volume > From Mesh creates Points from nodes, Lines from 

beam elements, Surfaces from surface elements and Volumes from volume 

elements. 
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To convert from mesh the results database must be saved as a model file with access 

for writing prior to conversion. Firstly open the .mys using the menu item File> Open, 

then save as a model file using File> Save As. Select the elements you wish to convert 

to geometry and pick the appropriate From Mesh menu item. 

Deformed mesh factor 

The coordinates of all nodes in the mesh (used to define points) can be adjusted based 

upon a specified deformed mesh factor.  

Notes 

 No attributes will be converted. 

 When converting to Volumes to resulting Volumes may be coalesced by 

removing the internal Surfaces. 

 The conversion commands always create new features and cannot be used to 

edit existing features. 

 Quadratic element edges with 3 nodes are converted to spline Lines with an 

exact match using the end node positions. A Point is defined at the mid-side 

node position but is not used in the Line definition. 

Moving, Copying and Sweeping Geometry 

Geometry may be moved or copied to new positions, or 'swept' to create higher order 

geometry from lower-order features using transformations. Compound transformations 

may be used in which a series of transformations are carried out in a specified order. 

When a feature is moved or copied, features will be merged as defined by the current 

merge status. See Merging and Unmerging Features. 

  

 Move When a feature is moved to a 

new location its lower order features 

will also be moved and its higher 

order features will be updated.. In 

the example shown here, Point 3 is 

moved using an X and Y translation. 

Due to feature associativity the 

definition of Lines 2 and 3 and of 

Surface 1 is automatically updated. 

Moving can be used to separate 

features on a temporary basis to 

assist in the manipulation of 

features, for example when defining 
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slidelines or joints.  

Note: When moving holes the Surface is 

actually deleted and recreated so the 

feature numbers will not be maintained. 

  

 Copy Features may be copied any 

number of times. When a feature is 

copied its lower order features will 

also be copied using the same 

transformations. Copied features 

will inherit the same attribute 

assignments as the original features. 

In the example shown here the Line 

at the bottom is copied 4 times using 

a transformation in the X and Y 

direction. 

 

 Sweeping Geometry New 

geometry can be created by 

sweeping existing lower order 

geometry into higher order 

geometry using a transformation, 

as for example, by sweeping a 

Point to create a Line, or a Line 

to create a Surface, or a Surface 

to create a Volume. To do so a 

transformation or sweep type 

needs to be specified. Note that 

when sweeping a line to create a 

surface, or a surface to create a 

volume, the surface axes or 

volumes axes of the newly 

generated surface of volume (and 

hence the axes of the elements 

within those features) may not 

align with the feature axes of the 

adjacent surface or volume, and 

will require re-orienting. See 

Changing Geometry / Element 

Orientation for more 

information. 
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Transformations 

Transformations are used in two ways: 

 When moving, copying or sweeping geometry a transformation is specified, 

and may be saved if required. 

 For special applications such as to orient discrete point and patch loads, or to 

define a reflective mirror plane for thermal analyses. 

Transformation attributes are defined using the Utilities> Transformation menu item, 

as well as from a move, copy or sweep dialog. Certain transformations can be defined 

by adding two or three geometric Points to selection memory before initiating the 

transformation command.  

 

The following transformation types are available: 

 Translation Linear translation along 

a specified vector coordinate. The 

vector coordinate will use the active 

coordinate set (See notes for an 

exception for cylindrical and 

spherical coordinate sets). Two 

Points added to selection memory 

can be used to define the vector 

coordinates. In this example, the 

translation is defined using Points 1 

and 2, which stores a translation of 

X and Y. This is then used to copy 

the Surface shown. 

 

 Rotation (in a global plane) A 

specified angular rotation in either 

the XY, YZ, or ZX global plane at a 

specified origin. 

 

In this example Surface 1 is copied 

about the global origin through 

positive 90 degrees. A right hand 

corkscrew rule is used for rotations. 

Local coordinate systems can be 

used to rotate about non-global axes. 
 

file:///C:/SVN/Content/0howto/idh_how_to_set_the_active_coordinate_system.htm
file:///C:/SVN/Content/0howto/idh_how_to_set_the_active_coordinate_system.htm
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 Mirror A mirror plane may be 

defined by specifying three points in 

space to define an arbitrary plane, or 

two points to define a plane parallel 

to either the Z, Y, or X axis. Three 

Points added to selection memory 

can be used to define an arbitrary 

mirror plane, and two Points added 

to selection memory can be used to 

define a mirror line in the XY plane 

(not the YZ or ZX planes) 

 

Note:.Care should be taken when 

mirroring Lines and Surfaces as 

their orientations may be reversed so 

some Surfaces may effectively be 

turned upside down. Lines may also 

point in the opposite direction. See 

Changing Geometry Orientation 
to resolve any problems. 

 

 Scale A scale factor and the origin 

point of the scale is specified . 
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 Matrix rotation A direction cosine 

either specified directly, or using 

two or three Points added to 

selection memory. Points in 

selection memory define a plane, the 

rotation of the global XY plane to 

this new plane defines the 

transformation. Note. If the 

determinant of the matrix is not 

unity then the effects may not be as 

desired. 

 

This example defines a rotation by 

defining a plane relative to the 

global Cartesian axis set by 

indicating three Points: at the origin 

(P1), along the local x axis (P2) and 

defining the local xy plane (P3). The 

resulting transformation is a rotation 

of 90 degrees about the global axes. 

 

Notes 

 In a transformation dialog, (including the move, copy, or sweep commands), 

click on the Use button to use a transformation defined from Points in selection 

memory.  

 A transformation is not updated when the points defining it are changed. 

 When a cylindrical or spherical coordinate set is active only X,Y and Z 

transformation input is supported. 

Compound Transformations 

Saved transformations may be used together to create a compound transformation, i.e. 

two or more transformations can be performed on selected geometry at once. To carry 

out a compound transformation (firstly from the Utilities> Transformation menu 

item) define the required transformations and save them with suitable names. Then 

when copying, moving or sweeping select the Compound option and specify which 

transformations to use by adding them to the right side box. Single transformations 

may be used more than once if required. The order in which the transformation is 

performed is significant, therefore click the up and down buttons to get the correct 

order, starting from the top. 
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Merging and Unmerging Features 

When a new feature is generated, if its position coincides with an identical feature then 

by default the two features will be merged (removing one of the features) provided the 

merge characteristics are satisfied. 

In addition to the automatic merging carried out during feature generation, any 

combination of features can be merged at any time. Care should be taken to merge 

from the lower order features upwards, as higher order features can only merge if 

defined by the same lower order features. 

Merge/Unmerge Commands 

The following merge/unmerge commands are available from the Geometry menu, 

under each feature type. 

 Merge Merges all mergable features currently selected subject to the current 

merge characteristics and tolerance. Lower order features must be merged first. 

for example two Lines cannot be merged until the Points defining the Lines are 

themselves merged. When selected at the same time, LUSAS merges lower 

order features before higher order features. 

 Make Mergable/Unmergable Sets the merge status of selected features. 

Merging can happen unintentionally in the normal course of events when 

additional features are defined in the same position as existing features. Using 

this command, it is possible to prevent two coincident features being merged by 

making one of the features unmergable. The merge status of an individual 

feature may be viewed, and altered, by displaying the properties of the selected 

feature, (right-click button), on the Hierarchy tab. 

 Unmerge Duplicates or retracts selected features into higher order features 

which reference them in their definition. When a feature is unmerged from its 

higher order features, any new features defined are automatically set to be 

unmergable.  

Merge Options 

Several merge settings can be set from the Geometry tab on the Model Properties 

dialog. 

 Ask for Confirmation Configures Modeller to prompt for confirmation before 

selected features are merged. (Confirmation tab). 

 Merge Tolerance Controls the distance within which Point features must lie 

before they will be considered for merging. (Geometry tab). 

 Make New Features Unmergable Sets the merge status of all new features to 

Unmergable. (Geometry tab). 
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 Merge Characteristics Controls the criteria that must be satisfied before 

features sharing a common definition will be merged. (Geometry tab). See 

below. 

 

Merge Characteristics 

Features will be merged only if they share common lower order features, in addition 

feature merging is dependent upon attribute assignments. By default, identical 

assignments must be found on two features, for those features to be merged. The 

merge type parameter controls how LUSAS handles feature merging. The following 

merge types are supported: 

 Off where no merging is carried out. 

 Exact where features are merged only if all assignments are identical. This is 

the default. 

 Wild where features are merged if feature assignments of the same type for 

both features match. The assignments of both features are retained where the 

assignment type is unique to one feature. 

 Ignore Assignments  ignores the assignments when deciding if two objects 

should merge (this is the opposite of "Exact" where the two objects must have 

the same assignments to merge). The assignments of the feature merged out 

will be transferred to the feature retained unless the retained feature already has 

that particular assignment. 

Notes 

 If several features are merged with merge status set to ignore assignments and 

the assignments are indeed different, the remaining feature will inherit the 

assignment of the lowest numbered deleted feature. 

 If two coincident features are not merged, two sets of coincident nodes will be 

generated when they are meshed and the finite element mesh will be 

unconnected at the feature discontinuity. This may be corrected at the meshing 

stage by merging the nodes using the equivalence facility. 
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Using the Merge (and Unmerge) Commands 

 Merge Point Coordinates of 

Points to be merged must lie 

within the merge tolerance. By 

default assignments must be 

exactly the same for a Point to be 

merged. 

 

  
  

 Merge Line Lower order features 

must be common for merging to 

take place. By default assignments 

must be exactly the same for a 

Line to be merged. 
 

    

 Merge Surface Lower order 

features must be common for 

merging to take place. By default 

assignments must be exactly the 

same for a Surface to be merged. 
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Merge Case Study 1 

Merging Lines with different non-zero assignments. Wild and Ignore Assignments will 

merge Lines successfully. 
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Merge Case Study 2 

Merging Lines with additional material assignment on Line 2. Material assignments 

differ, therefore only Ignore assignments will merge successfully. 

 

Using the Unmerge Commands 

  

To unmerge a feature from a higher order feature (i.e. a point from a line) select both 

the feature to be unmerged and the higher order feature from which to unmerge it. In 

the following examples red represents "New" and green "Modified" geometry. 
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 Unmerge Point in 

LineUnmerge Point 2 in Line 2. 

A new Point 4 is copied from 

Point 2 and Line 2 is redefined 

using Point 4. Points 2 and 4 are 

coincident. Point 4 is 

unmergable. 
 

 Unmerge Point in 

SurfaceUnmerge Point 5 in 

Surface 2. A new Point 8 is 

copied from Point 5, a new Line 

9 is defined and Line 6 is 

redefined using Point 8. New 

features are set to be 

unmergable. Point 5 and Point 8 

are coincident. 

 

 Unmerge Point in 

VolumeUnmerge Point 1 in 

Volume 1. A new Point, 2 new 

Lines and a new Surface are 

defined and affected Surfaces 

and the Volume are redefined. 

The new Point is coincident 

with Point 1. 
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 Unmerge Line in 

SurfaceUnmerge Line 5 in 

Surface 2. A copy of Line 5 is 

defined which replaces Line 5 in 

the definition of Surface 2. 

Points are unaffected. 

 

 Unmerge Line in 

VolumeUnmerge Line 1 in 

Volume 2. A copy of Line 1 is 

defined joining the same end 

Points The new Line replaces 

Line 1 in the definition of the 

affected Surfaces in Volume 2 

 

 Unmerge Surface in 

VolumeUnmerge Surface 1 in 

Volume 2. A copy of Surface 1 

is defined which replaces 

Surface 1 in the definition of 

Volume 2. 
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Case Study. Forcing Features to Merge 

Sometimes when creating the geometry duplicate features are created. If these have 

different assignments the default merge setting will prevent coincident features from 

merging. In this case it is useful to request the merge settings to ignore assignments. 

LUSAS can be forced to merge duplicate features in the following way: 

1. Set the merge status to ignore assignments by choosing the File> Model 

Properties dialog box, Geometry tab and pick Ignore assignments for the 

Merge action. 

2. Select the whole model using Edit> Select All. Then merge the model features 

using the Merge Features button  on the Advanced Define toolbar and pick 

the option to merge defining geometry. 

3. Reset the merge status to Exact. 

Note: If some features have been previously unmerged these must first have their 

merge status reset to Mergable using Geometry> Feature type> Make Mergable. 

Changing Geometry / Element Orientation 

For feature-based models the orientation of the Geometry is generally used to define 

the local axes of the elements. For mesh-only models the local axes of the elements 

will be the same initially as those defined in the data file that was used to create the 

model.  

Selecting features for re-orientation 

The following commands enable the local axes of Lines (where stated), Surfaces and 

Volumes (and Elements for a mesh-only model) to be re-oriented. First, the feature or 

element to be used as a basis for the re-orientation to be carried out must be selected 

(followed by the selection of any additional features to which the re-orientation of the 

first feature or element should apply) and then a menu item based upon Geometry > 

(Feature) > (Command) should be chosen. 

 Reverse Lines, Combined Lines and Surfaces can have their direction reversed. 

This example shows the 

effect of a Line reversal. 

The local x axes of all 

elements on this Line will 

be reversed.  
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In the Surface example the 

local x axis remains along 

the first Line in the Surface 

definition, but the Surface 

normal is reversed. 

Elements meshed on this 

Surface will be inverted. 

 

 Axes to Surface This command reorders the Surfaces that define a Volume 

such that the selected Surface becomes the first Surface in the volume 

definition. The z axis of the Volume is orientated normal to the first Surface, 

and pointing from that Surface towards the middle of the Volume. When the z 

axis of the Surface and the z axis of the selected Volume are the same their x, y 

and z axes will align. But if the z axis of the selected Surface and z axis of the 

selected Volume are in opposite directions (as may occur when Surfaces are 

shared between Volumes), the x axis of the Surface is used as the x axis of the 

Volume and the y axis of the Volume will be re-orientated accordingly. If 

required, the local x and y axes of the selected Volume(s) may be additionally 

changed using the Cycle Surface command. 

 

 

 Cycle Surfaces (or surface/solid elements in a mesh-only model) may have 

their definition order cycled, and Volumes may have the definition of the first 

Surface in the Volume definition cycled (and for mesh-only models, Elements 

may have the definition of the first Face in the Element definition cycled). In 

this example, the original Surface defined by Lines 1, 2, 3 and 4 is shown in 

grey. Cycling by changes Surface definition to Lines 2, 3, 4, 1. Cycling again 

defines the Surface as Lines 3, 4, 1, 2 . Surface normal directions remain 

consistent throughout. 
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 Cycle Relative Cycles the definition order relative to the first feature of the 

same type in the current selection. Lines may have their local x-axes aligned to 

a chosen Line, and Surfaces and Volumes (or surface/solid elements in a mesh-

only model) may be reoriented in this way. In this example Surfaces 2, 3 and 4 

are cycled using Surface 1 (shown greyed) as the reference orientation. 

 

 Cycle to Neighbours (Mesh-only models) Cycles the element axes of all 

neighbouring and selected elements relative to the first element in the current 

selection. Whilst similar in effect to the Cycle Relative option for the example 

shown above (which would obtain the same result for that particular example), 

it caters for the case where, for certain orientations of elements, the cycle 

relative option would not be applicable. The example below shows one such 

example. 

  

 

Cycle to Neighbours (correctly aligns element axes of the selected elements with initially selected 

neighbouring element) 
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Cycle Relative (only aligns element axes of the selected elements to best angle with respect to initially 

selected neighbouring element) 

  

 Cycle to Faces (Mesh-only models) Solid elements may have their local z 

direction set from a selected Face. Element axes are defined by the direction of 

the axes on the first Face in their definition. This command reorders the Faces 

defining the Element such that the first Face in the definition is the selected 

Face. The local x and y axes of the element itself may then be changed using 

the Cycle command. 

Notes 

 When cycling Surfaces it is not the Lines that change, but the order of the 

Lines in the Surface definition. Since the Surface local x axis lies along the 

first Line in the Surface definition the orientation of the Surface changes.  

 When cycling Volumes the cycle command only changes the order of Surfaces 

in the Volume definition. Since the Volume axes are determined by the 

orientation of the Lines that define the first Surface in the Volume, the 

orientation of the Volume changes. 
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Case Study. Changing Element Orientation For a Feature-based 

Model 

When it is necessary for the local axes of Lines and Surfaces to be consistent this can 

be achieved by reversing and cycling the features. Consistent axes for underlying 

Lines, Surfaces and Volumes ensure that their elements also have consistent axes. 

1. Draw the orientation axes for the features which are required to be consistent 

(Geometry Layer Properties). It may be useful to draw just Surface normals. 

2. In the case of lines, reverse any lines whose orientation is to be changed. 

3. In the case of Surfaces, reverse Surface normals (local z axis) and cycle 

Surfaces xy axes until all axes are consistent. Surfaces can be cycled relative to 

a reference Surface if required. 

4. In the case of Volumes, set up the Volume local z axis and cycle xy axes by 

cycling the first Surface in the Volume definition until all axes are consistent. 

Volumes can be cycled relative to a reference Volume. 

Measuring Line Geometry 

Three measurement facilities are available to report dimensional data about lines. 

These are accessed from the Geometry> Line menu. They are: 

 Distance between lines 

 Angle between lines 

 Length of line 

 

In each case the lines to be measured should be selected prior to the selection of the 

corresponding menu command. 

Note. Angle between lines will always report the smallest angle between the two lines 

selected, regardless of their relative position, direction or selection order. 

CAD Interfacing 

CAD interfacing is the process of importing or exporting the geometry and other data 

from and to a CAD package.  

When importing from CAD, only the relevant data should be exchanged. Annotation 

and construction lines should not be included as these will then be converted into 

LUSAS geometry. Control over the data imported into LUSAS is achieved using the 

Advanced button accessed from the File> Import Geometry menu item. Similarly, 

control over what is exported is achieved by options on the Export dialog accessed 

from the File> Export menu item. For more information see Interface Files 
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Chapter 5 : Model 

Attributes 

  

Attributes 

Attributes are used to describe the properties of the model. They are defined by using 

the Attributes> menu item. Once defined, attributes are shown in the Attributes  

Treeview. They can be assigned to selected geometry features (or to mesh objects in 

a mesh-only model) and are not lost if the geometry is edited, or if the model is re-

meshed. Some attributes, such as material, geometric, and constraint attributes are 

always assigned on a per-analysis basis. Some attributes, such as activate, deactivate, 

support and loading attributes (usually) are assigned on a per-loadcase basis. Attribute 

assignments are inherited when geometry features are copied and are retained when 

geometry features are moved. Attributes are manipulated using the context menu 

available for each item in the Attributes  Treeview. 

The attribute types are: 

General Attributes 

 Mesh attributes describe the element type and discretisation on the geometry. 

 Geometric attributes specify any relevant geometrical information that is not 

inherent in the feature geometry, for example section properties or thickness. 

 Material attributes define the behaviour of the element material, including 

linear, plasticity, creep and damage effects. 

 Support attributes specify how the structure is restrained. Applicable to 

structural, pore water and thermal analyses. 

 Loading attributes specify how the structure is loaded. 
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Specific Attributes 

 Local Coordinate provides a transformation for loads and supports, and an 

alternative to the global coordinate system. 

 Composite defines the lay-up properties of composite materials in the model. 

 Slideline attributes control the interaction between disconnected meshes. 

 Constraint Equation provides the ability to constrain the mesh to deform in 

certain pre-defined ways. 

 Thermal Surface defines thermal surfaces, which are required for modelling 

thermal effects. 

 Retained Freedom specifies the master nodes used in a Guyan reduction or 

superelement analysis. 

 Damping defines the damping properties for use in dynamic analyses. 

 Activate and Deactivate allows elements to be added (birth) and removed 

(death) throughout an analysis, e.g. in a tunnelling process or a staged 

construction. 

 Equivalence allows nodes which are close to each other but on different 

features to be merged into one according to defined tolerances. 

 Influence attributes define the type of behaviour of the structure at and around 

an influence point. 

 Search Area restricts discrete (point and patch) loads to only apply over 

certain areas of the model. 

 Age defines the time between creation and activation of features in the model.  

 Crack tip define a crack tip attribute to allow a crack tip location to be defined 

at a point or line in a model. 

 

Results Processing Attributes 

These attributes can be assigned to the model before or after an analysis in order to 

modify or obtain results of the chosen type. 

 Results transformation attributes allow results to be transformed (orientated) 

to a consistent direction. 

 Inspection locations are defined points of interest on the model for results 

extraction / viewing purposes. 

 Wood-Armer attributes contains details of slab reinforcement arrangements. 

 Steel Frame Design attributes are used to specify additional information about 

model features in order to enable design checks to supported design codes. 
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 RC Slab Design attributes are used to specify the reinforcement arrangement to 

be used throughout, or in a specified region of a model.  

 

Design Factor Plot Attributes 

 Design strength define strength data for use in conjunction with Design Factor 

Plots 

Defining and Assigning Attributes 

Attributes are defined from the Attributes menu. Defined attributes are shown in the 

Attributes  Treeview and can be assigned to selected geometry features (or to mesh 

objects in a mesh-only model) by dragging and dropping them onto selected features 

of the model or assigning them from their context menu.  

Attribute symbols explained 

A symbol adjacent to each attribute name in the Attributes  Treeview shows the 

status of each attribute present. 

 An attribute has been assigned to the model (coloured image) 

 An attribute has yet to be assigned to the model or used in the definition of another 

attribute (grey image) 

 A black dot on a coloured attribute icon shows that an attribute, which has been 

assigned to the model, has been set active (for example setting active a local 

coordinate assignment). 

 A black dot on a grey attribute icon shows that an attribute, which has yet to be 

assigned to the model, has been set active. 

 Fibre in a structural analysis, or active lamina in a composite analysis.  

 Active fibre in a structural analysis, or active lamina in a composite analysis.  

 An attribute icon (coloured or grey) with a surrounding red box indicates an 

attribute that has been set as default, meaning it will automatically be assigned to 

features of the model as they are generated. 

 A 'Not valid' symbol shows that an attribute assignment is pending or invalid in 

some way, requiring investigation and correction. 

 A warning symbol will appear in the following situations: 

file:///C:/SVN/Content/dlgother/IDH_DEFINING_THE_STRENGTH_DATA.htm


Modeller Reference Manual   

    

178 

  If any attributes that were previously created have been superceded by a 

change to a model. In this case a model must be re-solved to re-create those 

attributes.. 

 If attributes defined are not compatible with a stated analysis category. 

 Direction definition options 

Attribute manipulation 

Attributes are manipulated using the context menu in the Attributes  Treeview 

(accessed by clicking the right mouse button on the attribute). The following attribute-

specific menu options are available: 

General editing 

 Edit Definition Allows the properties that were originally defined to be 

modified on the dialog that was used to create them. 

 Edit / Edit Attribute Allows the properties of the attribute to be modified. 

Note that for particular structural loading attributes, editing the properties of 

multiple load attributes of the same loading type is possible. See Editing of 

Multiple Loading Attributes for details. 

 Copy Enables the attribute to be copied and assigned to a selected group, or 

view window in the current model using the Paste option. 

 Rename Attributes can be given meaningful names, for example 'Steel' to 

describe a material, or 'Beam - 4 Divisions' to describe a Line mesh. 

 Delete Deletes the selected attribute. See Deleting attributes from the 

Treeview below. 

 

Assignment editing / visualisation 

 Edit Assignments Simultaneously view, edit and manage any number of 

attribute assignments. Editing of data can be by individual selection, or by 

selection of the parent folder containing a set of attributes. For loads, editing of 

multiple assignments is only possible for selected loads of a common type. 

 Select Assignments Selects in the view window the features that have the 

selected attribute assignment.  

 Deselect Assignments Deselects from the view window the features that have 

the selected attribute assignment.  

 Visualise Assignments Switches on and off in the view window the 

visualisation of features that have the selected attribute assignment. Note this is 

not an action but a change of state. 
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 View Assignments Shows loadcases and analyses to which attributes such as 

materials, supports and loadings etc. have been assigned. 

 

Visibility 

 Visible Makes visible all features to which the selected attribute is assigned. 

 Invisible Makes invisible all features to which the selected attribute is 

assigned. 

 Set As Only Visible Sets the whole model invisible and then makes visible 

only those features to which the selected attribute is assigned. 

 Advanced Visibility Provides fine control over the visibility of features to 

which the selected attribute is assigned. 

 

Results plotting 

 Results Plots permits results for selected attributes to be selectively plotted. 

 

Updating section properties 

 Update from library Updates all section properties for the selected geometric 

attribute with those held in a library for a section of the same name. 

 

Temperature 

 Temperature dependence Allows editing of temperature dependent properties 

of material attributes. 

 

Prestress only 

 Create discrete loads Creates a duplicate analysis with loadcases of the same 

names as those in a stated analysis, and as many discrete load attributes, search 

area attributes, and assignments as necessary to copy and represent the prestress 

data for the tendon loading attribute(s) selected. 

 View forces and moments Shows the discrete loading values (forces and 

moments) calculated by the prestress loading facility for the attribute tendon 

load assignment selected in the Analyses treeview. 

 

Making assignments 

 Assign Assigns the selected attribute to the selected features. The attribute will 

only be assigned to features where the assignment would be valid. Some 

attributes require further information in order to be assigned and in these cases 

a dialog is displayed. For attributes that can only be assigned once to a feature, 
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assigning another attribute will overwrite any previous assignment of that 

attribute type. 

 Assign to all Assigns the selected attribute to all currently defined geometric 

features (or mesh objects in a mesh-only model) and to all new geometric 

features as they are created. Some attributes require further information in order 

to be assigned and in these cases a dialog is displayed. A tick is displayed in the 

attribute context menu when Assign to all is switched on, selecting the Assign 

to all menu item again deassigns the attribute from all and removes the tick.  

 Deassign Deassigns the selected attribute. Choose From All or From 

Selection. 

 Set Default Automatically assigns the selected attribute to all new features as 

they are created.  

 

Attribute names are added to the Attributes treeview in creation order, but can be re-

ordered by using the Sort by name context menu item accessed from the Attributes 

tab. 

Clarifying where attributes have been assigned 

When Modeller is unable to automatically carry out an operation such as 'Set As Only 

Visible" or 'Select Assignments' on a set of objects to which an attribute is assigned, 

clarification will be sought, requesting the user to identify an analysis or loadcase from 

those that include the chosen attribute. 

Editing of multiple loading attributes 

For particular structural loading attributes, editing of the properties of multiple load 

attributes of the same loading type is possible. See About Loading. 

Currently only editing of multiple load attributes of the same type is supported. Note 

that all other non-load attributes require editing individually. 

Visualising Attribute Assignments 

Attribute assignments can be visualised using: 

 Attributes layer The Attributes layer is a window layer in the Layers  

Treeview that is normally added during the initial start-up of Modeller. The 

Attributes layer properties define the styles by which assigned attributes are 

visualised. The attributes layer properties may be edited directly by double 

clicking the layer name in the Layers  Treeview. Assigned attributes can 

also be visualised individually by selecting an attribute name in the Attributes 

 Treeview and clicking the right mouse button to choose Select 

Assignments from the context menu. This is the easiest way to interrogate the 

assignment of a single attribute. Note that the option Visualise Assignments is 
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not an action but a change of state. It sets the visualisation of assignments to 

'on' or 'off', such that any assignments will be drawn or not drawn for that 

attribute. 

 Contour layer (materials/geometry/loading attributes only) Allows the model 

to be contoured with a specified value obtained from the material, geometric or 

loading attribute assignments. This is especially useful when an attribute value 

changes across the model. e.g. when defined using a variation. To use this 

feature click the right mouse button in the view window (with nothing 

selected), choose Contours from the context menu, then select either Loading 

(model), Geometry (model) or Materials (model). 

 Colour by attribute (Accessed from the properties dialog of the Geometry 

layer) colours the geometry according to which attributes are assigned to which 

features. A key is generated to identify the colours. 

 The options Combine assignments using loadcase history and Show only 

assignments in the active loadcase (accessed from the properties dialog of the 

Attribute layer for supports/activate attributes only) allows load dependent 

attributes to be visualised from the accumulated load history or from only those 

attributes assigned to the active loadcase.  

 

In addition to the above, toolbar buttons for Supports  and Loading  can be 

used to turn-on and turn-off the display of any supports or loadings that are assigned to 

a particular loadcase. 

 See Geometric Properties for the visualisation of beam cross sections and 

surface thickness (fleshing). 

 See Composites for visualising composites materials. 

Deassigning Attributes 

Attributes may be deassigned from all or selected features by selecting the attribute in 

the Attributes  Treeview  with the right hand mouse button and picking the 

Deassign entry from the context menu. The menu item entries From Selection or 

From All may then be chosen to deassign from the items in the current selection or 

from all the features in the model. Unassigned attributes will be denoted with a 

greyed-out bitmap . 

Attributes may also be deassigned by selecting View Assignments from the context 

menu for the attribute and unchecking the relevant loadcase. 

Copying attributes between models 

Attributes can be copied between models by using the Library Browser. See 

Transferring Data Between Models for details. 
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Deleting attributes from the Treeview 

Attributes can be deleted from the Attributes  Treeview individually by selecting 

the attribute name and pressing the Delete key, or choosing 'Delete attribute' from its 

context menu. Attributes can also be deleted en-mass by attribute type (e.g. Mesh, 

Geometric, Supports, Loading etc), by selecting an attribute folder name and selecting 

Delete all from its context menu. Deletion of selected attribute data can be carried out 

in one operation using the Library Browser. See Transferring Data Between Models 

for details. 

Drawing Attribute Labels 

Labels are a layer in the Layers  Treeview. To display attribute labels:  

1. With nothing selected, click the right mouse button in the graphics area and 

choose Labels from the context menu.  

2. Switch on labels for the chosen attribute type. 

Set Default Assignment 

Certain attributes, (mesh, geometric, material, composite), can be assigned 

automatically to all newly created features. Default attributes are set by right-clicking 

the attribute in the Attributes  Treeview , then choosing the Set Default entry from 

the context menu. This is useful for models with constant materials or thickness 

throughout, or where the same element is to be applied to all features. Attributes that 

are set as default are displayed with a red box around them  in the Attributes  

Treeview. 

Attribute dependency across analyses / loadcases 

See Base Analyses for a table that summarises how attributes assigned in a base 

analysis are inherited in other dependent analyses. 

About Meshing 

Feature-based models are defined in terms of geometry features which are sub-

divided into finite elements for analysis. This process is called meshing. Mesh 

attributes contain information about: 

 Element Type Specifies the element type to be used in a Line, Surface or 

Volume mesh. Attributes may be selected either by describing the generic 

element type, or naming the specific element. See Element Selection. 

 Element Discretisation Controls the density of the mesh, by specifying the 

element length or the number of mesh divisions, spacing values and ratios. 

 Mesh Type Controls the mesh type e.g. regular, transition or irregular. 
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For feature-based geometry models, mesh attributes are defined from the Attributes> 

Mesh menu item for a particular feature type i.e. Point, Line, Surface or Volume. The 

mesh attributes are then assigned to the required selected features. The orientation of 

the model Geometry is used to define the local axes of the elements. See Changing 

Geometry / Element Orientation if element axes need to be changed. Assigned mesh 

attributes apply to all analyses defined for that model. 

Mesh-only models 

Mesh-only models are comprised of nodes and elements and do not contain any 

geometric feature types, or indeed any geometric data at all. The number and shapes of 

the elements of a mesh-only model are fixed. The type of element may be changed and 

this is done by use of the Change Element Type option on the context menu on the 

element group name. In doing so, the number of nodes defining the element topology 

may be reduced but not increased. For instance, an 8-noded brick elements may be 

defined for use on previously defined 20-noded brick elements. See Changing 

Geometry / Element Orientation if element axes need to be changed.  

Mesh Types 

Various mesh patterns can be generated: 

 Regular Only used on regular Surfaces and Volumes. Any element shape may 

be selected for regular meshing. Options exist to automatically allow transition 

or irregular meshes to be generated when regular meshing is not possible. 

 Irregular Used for Surfaces and Volumes. An irregular Surface mesh may 

consist of triangular or quadrilateral elements. A irregular Volume mesh must 

consist of tetrahedral elements. Irregular Volume meshes will only be generated 

if specified as acceptable in the mesh attribute. 

 Interface Meshes Only applicable to joint and interface elements. 

 

Mesh Visualisation 

The Mesh layer properties control how the mesh is displayed in the current Window. 

The same controls are available for the undeformed mesh and the deformed mesh, but 

since they are different layers in the  Treeview, different properties can be applied 

to each layer.  

Mesh settings 

 Wireframe Displays the element mesh as a wireframe using the pen specified. 

Only the visible mesh lines are drawn. 

 Solid Displays the mesh as solid panels using the colour specified. Click on the 

coloured square to change the colour used. 
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 Maximum shade Controls (using a percentage value) the darkness of any 

specified solid mesh colour.  

 Hidden parts Displays all elements and not just the visible element faces. 

Dotted displays the hidden edges in a dotted line. 

 Show nodes Draws the mesh nodes. Nodes define the vertices of elements. 

 Outline only Displays only the outline of the mesh for each assigned feature. 

This is also useful for spotting cracks or discontinuities in the mesh due to 

features not being merged or equivalenced correctly. The Threshold (deg) 

value controls when edges of elements are drawn. Edges of adjacent elements 

are drawn when the angle between the normals of adjacent elements exceeds 

the threshold value. 

 Show normals Displays the element normal for Surface elements. 

 Show element axes  Displays the element axes as a local axis set.  

 Orientations only if selected Displays the surface normal or element axes only 

if the element is selected. 

 % of elements remaining Shrinks the elements to the percentage specified. 

 Colour by Enables the mesh colour to be changed. 

 Mesh colour - colours elements in default mesh colour. 

 Group - colours elements by group. 

 Connectivity - colours element edges by number of neighbours. 

 Element Type - colours elements by element type. 

 Normals - colours elements by surface normal direction. 

Note. The arrow sizes used for element axes and normals are defined on the Default 

tab of the Model Properties. 

Mesh Visualisation settings 

 Joint elements Marks any joint elements in the model with a symbol (user-

definable). 

 Active mesh Marks the active elements with a symbol (user-definable). 

 Point mass elements Marks the point mass location with a filled circle of a 

user-definable size. 

 Beam end releases Draws the beam end release for elements that use end 

releases. 

 Rigid zones Draws the extent of any rigid zones in a thicker and darker mesh 

colour. 
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Meshing Points  

Point mesh attributes are used to assign non-structural point mass elements, joint 

elements and mesh spacing parameters to the model. Point mass and spacing attributes 

are assigned to a single Point whereas joint attributes are assigned to pairs of Points. 

The first Point is referred to as the Master, the second is the Slave. Joint property 

assignments should be made to the Master Point. 

Meshing Lines 

Line meshing is carried out by defining a Line mesh attribute and assigning this to a 

selected Line. Line mesh attributes are defined from the Attributes> Mesh> Line 

menu item. The number of elements can be specified using either element length or 

number of divisions.  

Note that when modelling varying cross sections with constant section beam elements 

care should be taken to ensure that sufficient elements have been assigned. Greater 

than 8 elements should be used for small variations in cross section along the length of 

the geometry to which the section has been assigned, and considerably more elements 

should be used for larger variations. 

Line Mesh Spacing 

By default elements are evenly spaced but this can be user-defined. Non-uniform 

spacing is specified by clicking on the Spacing button from the Line mesh dialog then 

using one of the following methods: 

 Uniform Spacing  

 Uniform Transition Specify a ratio of the 

first to last mesh division length. The spacing 

ratios are assigned in the direction of the line 

to which they are applied. This example uses 

a ratio of 4 which is the ratio of the length of 

the first element to the last. To reverse the 

mesh spacing the ratio could be specified as 

0.25 (or the Line could be reversed). 
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 General Spacing Enter a grid of numbers 

which defines the individual segment length 

ratios explicitly. They are specified in the 

form: 

 Number Defines  the number of 

elements at this ratio, (from the start 

of the line as defined by the line 

direction). The numbers must add up 

to the number of divisions specified, 

e.g. for the example below 2+2 = 4 

divisions. 

 Ratio Defines the spacing ratio of the 

elements in the 1st column to the 

total number of elements.  

This example uses general spacing 2@2, 

2@4 (spacing ratios are applied in the 

direction of the Line). 

 

When specifying spacing the Line direction is important as the spacing is defined from 

the start to the end of the line. If the spacing appears to be in the incorrect direction the 

line may be reversed by selecting the Line and using the Geometry> Line> Reverse 

menu item.  

Note that the inclusion of rigid end zones in a line mesh attribute does not change the 

number of line mesh divisions defined or reported for that element in the Line Mesh 

Spacing dialog. The defined number of line mesh divisions is fitted to the length of 

line that remains if any rigid end zones have been defined. 

If desired, the element spacing can also be defined using a background grid mesh. 

The use of a background mesh is specified when the mesh attribute is assigned to the 

Line. 

Internal points 

For thick beam elements, and for steel frame or RC frame design checking use only, 

each element is discretised into ten divisions for calculation and results viewing 

purposes. This produces nine equally-spaced internal points along each element with 

two end points coinciding with the nodal locations of the element. 

Line Element Axis Orientation 

The element x axis always runs along the Line. Orientation of the local y and z axes of 

3D beam elements may be defined using a beta angle or a local coordinate when the 

Line mesh attribute is assigned to the Line. By default the element z axis coincides 

with the global Z axis and the element y axis forms a right hand set. Elements may 

also be orientated using a local coordinate which is assigned to the geometry. 
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Beam End Conditions 

Included Joints and End Releases for Beam Elements 

Joints can be included at the ends of each Line for supported element types (grillage 

element and all 3D beam elements) by choosing to include a joint as part of specifying 

an end condition for a line mesh attribute. The joints are automatically selected to best 

suit the non-rigid element type. When a joint is inserted an additional node is added at 

a zero distance from an end node. If joints are included but no joint material properties 

are assigned to them, default properties are used instead using the material and 

geometric properties that are assigned to the Line. If required, different joint material 

properties can be defined and assigned to relevant ends of lines to overwrite the 

default joint values. So, in any given analysis, it is possible for any line to have three 

material assignments – one for itself, one for the joint at its start, and one for the joint 

at its end. The latter two must be joint materials, and must be assigned using the 

'Assigned to line end(s)' option when the assignment is made. 

Freedoms at the ends of a Line can be freed to rotate or translate using an element with 

end releases. See the Element Library for more information on these element types. 

When defining a Line mesh attribute, with a valid element selected, click on the End 

Conditions button and set appropriate end releases. Releasing beam element end 

freedoms can be used as an alternative to using a joint element, for example when 

defining a pin between two beams. 

 

  

Included joints and end releases for beam elements 

Rigid Zones for Beam Elements 

When modelling the connections between beams and columns in a building frame, a 

short rigid length of beam element may be required to model the length of the beam 
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that extends from the nodal intersection with one beam or column, to a position on the 

beam that defines the extent of a rigid zone for modelling and analysis purposes. 

When rigid zones are defined additional rigid elements (of the same type as the line 

element itself) are inserted at the start and / or end of each line mesh 'set' of spacings, 

but the inclusion of rigid end zones in a line mesh attribute does not change the 

number of line mesh divisions that were defined for that element. Released freedoms 

are not tabulated at the end of the line to which they apply, but at the start of the non-

rigid elements, for which the line mesh spacing that is defined is applied to. For more 

details see Rigid Zones. 

Note that a line meshed with rigid end zones may not be used to define a meshed 

surface. 

 

Rigid zones for beam elements 

Meshing Surfaces 

Regular Surface Meshing 

Regular meshing is used to generate a set pattern of elements on Surfaces and 

Volumes. Only surfaces which are regular (defined by 3 or 4 lines) can be meshed 

using a regular mesh pattern. 

 In order to generate a regular grid 

mesh pattern the number of mesh 

divisions on opposite sides of the 

Surface must match. If they do not 

match transition patterns will be used (if allowed in the mesh attribute 

definition). The examples shown here mesh triangular and quadrilateral 

Surfaces using both triangular and quadrilateral elements.  

  

 The Surface mesh may be graded 

using mesh spacing parameters in 

'None' element Line meshes 

assigned to the boundary Lines. In 

the examples shown here mesh spacing has been used to bias the elements into 

the apex of the triangle or one corner of the rectangle. 
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Irregular Surface Meshing 

Irregular meshing is used to generate elements on any arbitrary Surface. 

 Element Size specifying the required approximate element edge length. 

Meshing Volumes 

Volumes are meshed using regular mesh patterns, transition mesh patterns, or irregular 

tetrahedral meshing.  

Tetrahedral Volumes 

Tetrahedral Elements Pentahedral/Tetrahedral Elements  

  

Pentahedral Volumes 

  

Pentahedral Elements Hexahedral/Pentahedral Elements 
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Hexahedral Volumes 

Pentahedral Elements Hexahedral Elements Hexahedral/Pentahedral Elements 

   

The mesh density for volumes is taken from the boundary surface mesh density. 

Regular Volume Meshing 

In order to generate a regular mesh pattern the number of mesh divisions on opposite 

faces of the volume must match. If they do not match then transition patterns will be 

used. Pentahedral/tetrahedral elements will automatically be inserted in the appropriate 

positions of a transition mesh. 

Extruded Irregular Mesh 

Volumes defined by sweeping an irregular 

Surface may be meshed with a regular 

Volume mesh attribute. The interconnecting 

Lines between the irregular end Surfaces 

must all be straight, or all minor or major 

arcs with a common axis of rotation. The 

side Surfaces must all be defined by four 

Lines so they can be meshed with a regular 

grid of quadrilateral faces. The irregular 

opposite Surfaces must not share any 

common boundary lines therefore wedge-

shaped Volumes cannot be meshed as 

extruded irregular Volumes. 
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Case Study: Meshing Volumes by Extruding Irregular Surfaces 

It is possible to mesh an irregular volume with hexahedral or pentahedral elements if 

the volume has been formed by sweeping an irregular surface. 

1. Define an irregular Surface with more than 4 sides. 

2. Define a Volume by sweeping the irregular surface. 

3. Define a Volume mesh attribute with Hexahedral or Pentahedral elements, use 

a regular mesh with automatic divisions to ensure an equal number of divisions 

on the swept edges. 

4. Assign the Volume mesh attribute to the Volume. 

Irregular Tetrahedral Meshing 

Arbitrary shaped irregular Volumes defined 

by any number of Surfaces may be meshed 

with tetrahedral elements. The element size 

may be specified on the mesh attribute, 

taken from the defining geometry or 

interpolated from a background grid. The 

mesh may be refined around small features 

and stress concentration using 'None' 

Surface and Line mesh attributes. By 

default the maximum angle around an arc 

subtended by a single element is 90 

degrees. This may be adjusted on the 

Meshing tab of the Model Properties 

dialog.  

 

Notes 

 A good initial mesh is usually obtained by specifying the element size as 

approximately1/50th of the diagonal model size. Specifying too small an 

element size will cause too many elements to be generated and may result in 

LUSAS using up all the available memory. Specifying too large an element 

size will cause the meshing algorithm to fail. 

 The success of tetrahedral meshing is dependent on the quality of the Surface 

mesh. If the meshing algorithm fails, invoke edge collapsing or set the Volume 

mesh to "From defining geometry" and adjust the element size using Line and 

Surfaces mesh attributes of type None. If the meshing still fails try breaking the 

Volume into a number of smaller Volumes. 
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Edge Collapsing 

The quality of the mesh may be improved using edge collapsing. Edge collapsing 

removes elements with very short sides or acute angles by merging them with 

neighbouring elements. This is particularly useful when generating tetrahedral 

elements on imported CAD models where very short lines are present. Edge collapsing 

is invoked from the Advanced button on the Meshing tab of the Model Properties 

dialog. 

  

 
 

Mesh before edge collapsing Mesh after edge collapsing (short edge removed) 

  

Mesh before edge collapsing Mesh after edge collapsing  

(Elements with small subtended angles removed) 

Controlling the Mesh Density  

The simplest way to define the mesh density is to define the number of divisions to be 

used in the mesh attribute. This method should only be used for simple models 

because changing the mesh density when multiple mesh attributes have been defined is 
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both time consuming and prone to error. For most model the mesh density should be 

controlled using boundary discretisation. 

Boundary Discretisation 

In the case of Surface or Volume meshing, the number of mesh divisions may either 

be specified directly in the Surface or Volume mesh attribute, or using Line or Surface 

mesh attributes of element type ‘None’. In many realistic problems, where several 

Surfaces or Volumes exist, using attributes with an elements of type 'None' is the most 

convenient way to define the mesh density. For Lines the spacing is specified using 

either element length or number of divisions and for Surfaces the mesh size is 

specified as the element edge length.  

Notes  

 If the element size is specified differently in the Line and Surface mesh 

attribute the Line element size will be used. 

 If the element size has not been specified the default number of mesh 

divisions will be used. 

  

 Regular Surface Meshing The applied boundary discretisation (left) produces 

the irregular mesh pattern on the Surface (right). 

 

  

 Irregular Surface Meshing The applied boundary discretisation (top) 

produces the irregular mesh pattern on the Surface (bottom). 
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Default Number of Mesh Divisions  

If the discretisation has not been specified in the mesh attribute, or by using a Line 

mesh of element type ‘None’ the Line will be sub-divided according to the default 

number of mesh divisions. This is specified on Meshing tab of the File> Model 

Properties dialog. 

Background Grid Meshing 

Background grid meshing is a method of controlling the size of elements generated 

during automatic meshing. It is generally only used when specification of spacing and 

stretching parameters at Points is required to grade the mesh pattern locally when 

irregular surface meshing. 

A background grid is a collection of triangular or tetrahedral shapes which completely 

encompasses the features to be meshed. A Line, Surface or Volume mesh is used to 

define the element type in the usual way and point meshes assigned to the points of the 

background grid are used to control the element size in the vicinity of each point. Finer 

control is achieved by using more Points in the background grid definition or by using 

Line mesh assignments to override the mesh size on specific edges. 

The background grid may be specified explicitly from Points at each vertex or 

generated automatically. Any mesh distortion required may be entered using the point 

mesh stretching parameters. If generated automatically, tetrahedral shapes will always 

be used. 

 With a Surface or Volume already drawn and selected, a background grid can be 

defined by selecting the Utilities> Background Grids menu item. 
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Constant Mesh Spacing 

Same spacing parameters (Point meshes) 

are assigned to all Points in background 

grid. 

   Varied Mesh Spacing 

Different spacing parameters (Point 

meshes) are assigned to the top Points 

(spacing=7) and the bottom Points 

(spacing=1) in the background grid. 

 

  

 

Notes 

 Background grid meshing requires all Points defining the background grid to 

have a point mesh assignment. 

 To remove a background grid delete the Background Grid from the  

Treeview. 
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Case Study. Using Background Grid Meshing 

1. With a Surface or Volume already drawn and selected, define a background 

grid by selecting the Utilities> Background Grids menu item and choosing 

Enclose Selection. Define one element in each direction and give the 

background grid a name. 

2. Define Point mesh attributes from the Attributes> Mesh> Point menu item 

with the desired element sizes for use at assigned points on the background 

grid. For example Point mesh spacing attributes of 0.5 and 2.5 might be used 

for opposing corners of the grid, and a spacing of 2.0 might be used for the 

remaining points. 

3. Assign the Point mesh attributes to the appropriate Points on the Background 

Grid. All points must be assigned a point mesh attribute. 

4. Define a Surface or Volume mesh attribute with an Irregular mesh type, 

leaving the element size blank. 

5. Select the Surface or Volume and assign the Surface or Volume mesh attribute 

to the model selecting the From background grid in the mesh assignment 

dialog. The mesh generated will be based upon the governing point mesh 

values defined for the background grid. 

 

  

Composite Material Assignment 

When a Volume feature with a composite material assignment is meshed  the nodes 

are moved onto the composite layer boundaries. This ensures an exact number of 

layers in each element. 
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Connecting Beam and Shells 

Beam Shell Connectivity 

Extend the beams along the edge of the 

shell indicated by thick lines. 

   Beam Solid Connectivity 

Extend the beams along the edge of the 

solid elements indicated by thick lines. 

Torsion is restrained using out of plane 

beams. 
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Shell Solid Connectivity 

Extend the shells over a portion of the 

solids indicated by the dark shaded area. 

    

 

    

  

Case Study: Connecting Shells and Solids 

Solid and shell elements may be connected but the procedure is not as straightforward 

as it first may appear. Solids and shells have different sets of nodal freedoms and the 

rotational freedom present in the shells can only be passed through to the solid 

elements by extending the shell around the side of the solid, thus passing through the 

rotation via combined translation effects. This form of connection stops rotation 

relative to a solid which only has translational degrees of freedom. 

The following procedure outlines the general method of fixing shells to solids: 

1. Define the Surfaces and Volumes. 

2. Define suitable mesh attributes, for example define linear hexahedral elements 

and linear quadrilateral shell elements and assign these to the Volume and 

Surface parts of the model. 

3. Now assign the surface mesh attribute to a surface that forms part of the solid 

elements and which shares a common edge with the shell Surface that is being 

fixed to the solid part of the model. Do not forget to assign material and 

geometric attributes to the surface attached to the solid.  

Note: It is advisable to make a connection such as this reasonably distant from the 

main area of interest as it may affect the quality of the results locally. 
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Fixing Mesh Problems 

When meshing, any features which failed to mesh are noted in the text window. These 

can be identified using the Identify Object dialog invoked by double clicking on the 

error message in the text window. Alternatively, a group can be created containing all 

the features that failed to mesh. Only features that are not part of meshed higher order 

features will be added to the group. To activate this facility choose the check box 

Create a group of features that failed to mesh invoked from the Advanced button 

on the Meshing tab of the Model Properties dialog.  

When importing CAD models meshing errors can sometimes occur due to very short 

lines and small surface slivers in the model. These problems can be alleviated in the 

meshing process by using edge collapsing. 

When meshing open hollow volumes with tetrahedral elements, the edges with nodes 

which have failed to merge are displayed automatically. 

  

Unmerged nodes on volumes which failed to 

mesh. 

Mesh with nodes merged by adjusting node 

merge tolerance 

Notes 

 Unmerged nodes are most easily seen when meshed using solid fill. 

 Nodes which have failed to merge may be forced to merge by adjusting the 

node merge tolerance on the volume properties dialog or by assigning a 

suitable line mesh of type None to the lines. 

Mesh Utilities  

Mesh utilities provide the means to query distances between nodes; to control the 

meshing and re-meshing of all or parts of a model and to use a defromed mesh as a 

starting point for a further analysis. Mesh utilities are accessed from the Utility > 

Mesh menu item 

file:///C:/SVN/Content/1using/idh_an_introduction_to_lusas_modeller.htm
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 Distance Between Nodes - displays in the Text Output window the relative 

distance between any selected nodes. 

 Show Closest Nodes - displays in the Text Output window the distance 

between the closest nodes of any of those selected. 

 

To control changes being made to a mesh the following menu items can be used in 

various inter-related ways. 

 Mesh Lock - Disables automatic remeshing of a model and prevents any 

changes to a mesh being made. LUSAS automatically locks the mesh on a 

model when a results file is loaded because any subsequent mesh changes may 

lead to the assembly of results in a misleading fashion. Mesh changes involve 

renumbering or reorientation of elements and results are associated with node 

and element numbers.. Therefore results requested after a remesh (without the 

mesh being locked) may appear in the wrong location and in the wrong order in 

the structure.You can unlock the mesh using the menu item Utilities > Mesh > 

(uncheck) Mesh Lock and Utilities > Mesh > Mesh reset 

 Mesh Reset - Deletes the current mesh and forces a complete re-mesh of the 

whole model using the assigned mesh attributes. If Mesh Lock is 'on' this will 

not occur. 

 Mesh Now - meshes the whole model regardless of any Mesh Lock being set. 

 Mesh Selected Items - meshes only those features selected. 

 Use Deformations - uses the deformed mesh caused by one analysis to be used 

as the starting point for a further analysis. The mesh may be tabulated with 

node coordinates computed from the deformations in the active loadcase 

multiplied by a specified factor. To do so, a model file and its results file must 

be loaded with the required results loadcase set active.  

 

Checking mesh refinement in a model 

Checking the mesh refinement in a model is an essential part of any finite element 

analysis. By nature, all finite element analysis is an approximation, a "model" of a real 

(or potentially real) object. The results will only be accurate if the mesh is defined in 

such a way as to simulate the change in load effects across the structure effectively. 

The appropriate degree of mesh refinement can only really be discovered by 

experimentation: increasing the refinement and observing changes in the results. When 

refinement produces a negligible change in key results, the level of refinement 

required has been exceeded. A "negligible" change in results might be where the 

inaccuracy derived from the FE analysis may be considered small by comparison to 

other assumptions inherent in the design calculations. There is no hard rule because 

the load effects vary across "real" structures according to the structural form and 

loading conditions. 



  Chapter 5 : Model Attributes 

    

201 

It is normal to find that a higher level of refinement is needed in certain parts of the 

structure compared to other areas. Changing between linear and quadratic order 

elements can help identify the behaviour of the structure and the refinement 

considerations. 

Modelling cables 

Modelling of cables generally requires modelling of tension-stiffening behaviour 

where the axial stiffness of the cable is dependent upon the sag of the cable, which in 

turn is dependent upon the tension in the cable. As a result modelling of cables 

generally requires a geometrically nonlinear analysis that may involve a number of 

nonlinear behaviours such as: 

 Large displacements Cable-supported structures are often highly stressed and 

relatively light. Consequently large displacements can occur that alter the 

global geometry of the structure. These must be taken into account if the results 

from the model are to be meaningful. 

 Stress stiffening in each cable Long inclined cables "sag" under dead load, 

with the sag decreasing when cable tension increases. The stiffness of the cable 

becomes greater as it is straightened. 

 Tension-only behaviour Where short cables can be idealised as either having 

full stiffness in tension and zero stiffness in compression, this behaviour can be 

included in the model in preference to the more complex stress-stiffening 

approach. 

 

However, in some cases, cables may be adequately represented with linear 

assumptions.  

A number of different approaches may be used to model cables either considering or 

ignoring any initial sag in cables. An overview of the elements available, and 

modelling and analysis methods follows, along with compatibility considerations for 

use with cable tuning facilities. 

Modelling cables with sag 

Modelling of cables when cable sag is present requires a nonlinear analysis and can be 

done using the following elements and methods: 

 Beam elements with GNL For this, lines representing cables are modelled 

using beam elements in conjunction with a geometrically nonlinear analysis. In 

order to take both large displacements and stress-stiffening into account, a full 

nonlinear approach should be used. The lines representing the cables are 

assigned a thick nonlinear beam (BMI21) mesh attribute, with sufficient 

divisions in order to model the sag of the cable under transverse loads (such as 

self weight). Initial stresses in the cables can be added, using a structural initial 

stress/strain load (or using a structural temperature load if preferred) - see 

"Structural Loading" on page 403 for details. It would be necessary to model 
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the cable with a line representing the initial sag if the tensions are relatively 

low. Nonlinear controls must be set, including geometric nonlinearity. It is 

suggested to use BMI21 or BMI31 elements with the co-rotational option set 

(by visiting the Nonlinear and Transient control options). Better results may be 

obtained if the Total Lagrangian option is also switched on. Note that Total 

Lagrangian option should not be used isolation. 

 

Modelling cables without sag 

Modelling of cables without sag using any of the approaches below is an 

approximation, which must be selected on a case-by-case basis. Linear assumptions 

are only applicable under conditions where the cables are in tension for all design 

conditions; where tension remains always high, typically of the order of 30% of the 

Ultimate Tensile Stress; or when the horizontal offset of the cable end is small in 

relation to the overall length of the cable. 

 Fully linear For this, lines representing cables should be assigned a linear 

material, and should be meshed with only one 2D or 3D bar or beam element 

per line. The mesh attribute should have one mesh division, avoiding 

unrestrained nodes along the length of the cable, which would lead to 

unrestrained lateral deformations in the case of bar elements. Initial 

stresses/strains in the cable may be optionally determined by running a linear 

cable tuning analysis that calculates load factors for selected lines in a model 

that represent cables in order to achieve defined target values set for various 

feature types and results components. For a linear cable tuning analysis no 

nonlinear controls or assignments must be present. The approximation used for 

the cable stiffness will be unchanged by the tensioning of the cable. 

 Tension-only but otherwise linear In some cases, short cables can be 

idealised as having tension-only behaviour. Lines in a model representing 

cables should be assigned a 2D or 3D bar element mesh attribute as 

appropriate. The bar mesh attribute should have one mesh division, avoiding 

unrestrained nodes along the length of the cable, which would lead to 

unrestrained lateral deformations, and the behaviour is modelled using tension / 

compression only bar material. Nonlinear controls must be set, but geometric 

nonlinear formulations do not need to be invoked because the behaviour of the 

bars will be linear when in tension. This approach does not take into account 

either large displacements or stress stiffening in each cable but may be 

acceptable in certain applications. 

 Linear with large end displacements The large displacement behaviour of 

cables in which there is no sag (such as in vertical stays (hangers) or short, 

highly stressed inclined cable stays) can be taken into account with a simplified 

nonlinear approach. The lines representing cables may be assigned a 2D or 3D 

bar element mesh attribute as appropriate. Generally the bar mesh attribute 

should have one mesh division, avoiding unrestrained nodes along the length of 

the cable, which could lead to unrestrained lateral deformations. Initial stresses 
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in the cables/stays/hangers can be added, using a structural initial stress/strain 

load (or by using a structural temperature load if preferred) - see "Structural 

Loading" on page 403 for details. A nonlinear cable tuning loadcase can also be 

used to apply initial stresses. Nonlinear controls must be set including 

geometric nonlinearity (the Total Lagrangian option is appropriate for bar and 

beam elements). This approach will not reflect stress stiffening in each cable if 

any cable sag is present. 

 

Compatibility of cable modelling approaches with cable tuning 

facilities 

 
Cable modelling approach 

  Use with linear cable 
tuning 

  Use with nonlinear cable tuning 
loadcase 

Beam elements with GNL   Not valid   Valid 

Fully linear   Valid   Valid 

Linear other than tension-only 
behaviour 

  Not valid   Valid 

Linear with large end 
displacements 

  Not valid   Valid 

See Linear cable tuning and Nonlinear cable tuning loadcase for more details. 

Worked examples 

See Online help > Worked Examples > For LUSAS Bridge and LUSAS Civil & 

Structural >  'Linear cable tuning analysis of a pedestrian bridge', which shows how 

linear cable tuning analysis using bar elements is carried out for a simple structure. 

See Online help > Worked Examples > For LUSAS Bridge and LUSAS Civil & 

Structural > '3D Nonlinear Static Analysis of a Cable Stayed Mast' for an example in 

using beam elements with geometric nonlinearity (without sag). 

Rigid Zones 

When modelling the connection between beams and columns in a steel or concrete 

building frame, a short rigid length of beam element may be required to model the 

length of the beam that extends from the nodal intersection with one beam or column - 

the 'intersection of interest', to a position on the beam that defines the extent of a rigid 

zone for modelling and analysis purposes. 

 Rigid zones can be specified when defining a Line mesh attribute using the 

Attributes > Mesh > Line menu item. Different properties can be defined for the start 

and/or end of a line mesh attribute, and rigid zone lengths can be user-defined, or 

calculated according to a formula based upon the size and eccentricity of intersecting 

beam and column members.  

Additional rigid elements (of the same type as the line element itself) are inserted at 

the start and / or end of each line mesh 'set' of spacings, but the inclusion of rigid end 

file:///C:/SVN/Content/6analysi/idh_linear_cable_tuning_analysis.htm
file:///C:/SVN/Content/6analysi/idh_nonlinear_cable_tuning_loadcase.htm
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zones in a line mesh attribute does not change the number of line mesh divisions that 

were defined for that element. The defined number of line mesh divisions are fitted to 

the length of line that remains when any rigid end zones have been defined. Rigid 

zones receive the same loading as the non-rigid elements assigned to a line. A rigid 

zone factor specifies the degree of rigidity of the rigid end zone element that is 

inserted at the end of a beam element. The value is constrained between 0 (fully 

flexible) and 1 (fully rigid). 

When rigid zones are created, the released freedoms are not tabulated at the end of the 

line to which they apply, but at the start of the non-rigid elements, for which the line 

mesh spacing has been defined.  The following image shows line meshing options 

related to rigid zones. 

 

  

Line meshing options showing introduction  

of rigid zones for columns and beams 

Examples of line meshing with rigid zones 

Joints (defined at rigid end zones) 

Joints can be optionally included at the transition between the rigid zone element and 

the non-rigid elements as part of defining the end conditions for a beam. These joints, 

which are automatically inserted by Modeller, are chosen according to the non-rigid 

elements to which they connect. The inserted joints are given default linear joint 

material properties (also based upon the material and geometric properties of the line 

on which they occur) sufficient for a suitable rigid connection to be achieved. Note 

that the attributes for joints created in this way do not appear in the Attributes 
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 treeview. If required, different joint material properties can be defined and assigned to 

relevant ends of lines to overwrite the default joint values. Point-type joint material 

properties can be assigned to the ends of lines with rigid zones in addition to the 

material properties assigned to the line for the beam elements. Different joint 

properties may be assigned to each end of the line or the same properties may be 

assigned to both ends according to the selection made on the assignment dialog. So, in 

any given analysis, it is possible for any line to have three material assignments – one 

for itself, one for the joint at its start, and one for the joint at its end. The latter two 

must be joint materials, and must be assigned using the 'Assigned to line end(s) option 

when the assignment is made. 

Rigid end zone properties 

The material properties of the elements automatically added to represent the rigid 

zones are set to be the same as those of the adjoining non-rigid elements unless the 

density is to be excluded as specified by the 'Include mass' check box on the dialog 

shown on the Rigid zone page of the Line Mesh End Conditions dialog. 

Definition or calculation of rigid zone length 

Rigid zone length calculation is only for 

use with vertical lines representing 

columns that intersect with horizontal 

beams at 'intersections of interest'. 

 Columns, for the purposes of 

rigid zone calculation, are lines 

that lie along the vertical axis 

defined for the model, that lie at 

intersections of interest. When 

considering the rigid zone of the 

column itself, the column may be 

above or below the intersection.  

 Beams, for the purposes of rigid 

zone calculation, are straight 

lines that meet a vertical line 

representing a column at an 

intersection of interest. Non-

horizontal lines may meet at the 

intersection, but these will be ignored, and if they are marked as needing their 

rigid zone length to be automatically calculated, an error will be produced. 

When considering the rigid zone length of a beam, the column considered is 

always below the intersection, unless there is no column below but there is a 

column above. in which case the column above is used in any rigid zone length 

calculation made for the beam. 

The following options are available to define a rigid zone: 
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 None No rigid zone is to be defined. 

 Specified Length A user-specified rigid zone length 

 Beam / column connection A formula based calculation based on the width 

and depth of connecting column and beam members can be defined using the 

Specify... button. For example, with reference to the dialog image right, a rigid 

length (L) of a beam could be defined as being 100% of the distance from the 

nodal line to the face of a column (a) minus 25% the beam's own depth (b), as 

in L=(1 x a) - (0.25 x b). 

 One of two options inform Modeller what to do when automatic beam/column 

detection for the above option fails: 

 Report error and fail to mesh Any error will be written to the text output 

window, describing the condition(s) that prevent(s) rigid zones being 

calculated for the features selected. 

 Assume no rigid mesh For ends of columns, such as those at the foot of 

the structure, no rigid zone will be assumed since no beams frame-in to the 

column at these locations. 

 Rigid zone factor specifies the degree of rigidity of the rigid end zone element 

that is inserted at the end of a beam element. The value is constrained between 

0 (fully flexible) and 1 (fully rigid). 

 Include mass allows the inclusion or exclusion of mass from the rigid end zone 

elements. If mass is excluded then the material density is tabulated as zero for 

the rigid end zone elements. 

 

Assigning rigid zones to lines in a model 

Rigid zones are assigned to lines in a model as part of assigning the line mesh attribute 

that contains the rigid zone definition. Single, multiple, or all lines in a model (if 

appropriate) can be selected prior to assigning an attribute. Lines having ends that do 

not intersect with other lines such as lines representing columns that 'sit' directly on 

supports, or ends of lines representing cantilevered beams, are not assigned rigid zone 

lengths. Because the calculation of rigid zone lengths is dependent upon both mesh 

and geometric section properties being assigned to each line feature there are potential 

issues in relation to the order in which they are assigned to a model.  

 If geometric section properties are assigned to a line before any line mesh 

assignment is made for that line a standard “Unable to visualise without a 

mesh” message will appear and no fleshing will be seen until the mesh is 

assigned. 

 If a line mesh is assigned to a line before any geometric section property 

assignment is made for that line an initial attempt at meshing a line will not 



  Chapter 5 : Model Attributes 

    

207 

calculate an automatic rigid zone length because the geometric section 

properties for that line (and from which derived offset distances and 

eccentricities are extracted) cannot be immediately found. In this situation no 

rigid elements will be created, and the line will be initially meshed with only 

non-rigid elements. A subsequent assignment of a geometric section will 

invalidate the mesh on all the assigned lines and connected lines, and cause 

Modeller to recalculate rigid zone lengths for all those assignments.  

 In a multiple analysis model, whilst it is possible to assign different geometric 

properties to each line in each analysis, note that all analyses must share the 

same mesh since only the geometric section assignments made for the base 

analysis are used. 

Visualisation of rigid zones 

Rigid zone lengths are visualised on the Mesh layer as a thicker line and in a darker 

colour of the specified mesh colour. Defining rigid zones changes the fleshed length of 

beam sections. The following image shows what is displayed in each case. 

  

 

  

 

  

 

Mesh layer visualisation of 

connection with rigid zones 
  Fleshed geometry visualisation  

of connection with rigid zones 

(Rigid zone lengths are drawn in 

same colour as the point colour) 

  Fleshed geometry visualisation of 

connection with no rigid 

 zones. (Default fleshing is shown) 

Results processing 

By default, the elements representing rigid ends of beams do not present element-

based results when results are viewed. For instance, a bending moment diagram would 

only be plotted for the non-rigid elements and not for the regions where rigid zones 

were defined. If it is required to view results in rigid zones this can be achieved by 

accessing the Model properties dialog, selecting the Solution tab, pressing the Element 

options button and checking (selecting) the Show results for rigid zone elements 

option. 
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Joint and Interface Elements 

 Joint elements are used to connect two or more nodes with springs having 

translational and rotational stiffness. They may have initial gaps, contact 

properties, an associated mass and damping, and other nonlinear behaviour.  

 Interface elements are used for modelling interface delamination in composite 

materials. 

Both joint and interface elements may be inserted between pairs of corresponding 

nodes and features. Joint elements can be inserted between points, lines and surfaces. 

Interface elements can only be inserted between lines and surfaces. 

Automatic insertion of joints to ends of line beams 

Joint elements can be automatically introduced at the end of lines by choosing to 

include a joint as part of specifying an end condition for a line mesh attribute. See 

Meshing a Model - Beam End Conditions for more details. 

Defining and Assigning Joints / Interface Elements 

A Joint element is defined as a Point, Line or Surface mesh attribute using the 

Attributes > Mesh menu and specifying the structural element type to be used. Once 

defined, it is assigned to the model in one of two ways: 

 To a single pair of features This requires two points (joints only) or two lines 

or surfaces to be selected. The first selected feature becomes the master. The 

second selected feature becomes the slave.  

 To multiple pairs of features This uses selection memory to define a set of 

slave features prior to selecting a set of master features. 

Defining and Assigning a Joint / Interface Element Mesh to a 

Single Pair of Features 

To model a single joint element between a pair of features (two points, two lines or 

two surfaces, when applicable): 

1. Define a Joint mesh attribute with the chosen joint element. 

2. Select the first (master) feature. 

3. Add the second (slave) feature to the selection. 

4. Assign the Joint mesh to the two features. Options exist to allow definition of 

the local axes of the joint element. 

Defining and Assigning a Joint / Interface Element Mesh to 

Multiple Pairs of Features 

To define joint elements between multiple pairs of features (two or more sets of points, 

lines or surfaces, when applicable): 

file:///C:/SVN/Content/ctx_cmds/id_set_secondary.htm
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1. Define a Point, Line or Surface mesh attribute with the chosen joint element. 

2. Select the slave features and add them to selection memory. 

3. Select the master features. 

4. Assign the joint mesh. 

In making multiple selections of points, lines or surfaces it is important to select the 

separate slave and master features in the same order to ensure that the joints / interface 

element mesh created map to the correct features. 

As the same joint mesh attribute is assigned to both master and slave features, a mesh 

pattern is created between the two features, with the mesh definition for the feature 

determining the number of joints generated in the joint interface mesh (see Examples 

of Assigned Joints that follow). When using interface meshing the joint elements are 

automatically created, joining all nodes on the master and slave features, and each 

joint stiffness is automatically computed from the representative length or area of the 

elements on the master/slave features.  

Notes.   

 Joint meshes require Joint material properties to be assigned to them. 

 For joints with rotational degrees of freedom an eccentricity must be specified. 

An eccentricity of zero may be specified. 

 The Joint symbol is drawn at the quarter-point along the joint nearest to the 

first master feature defining the joint element. 

 Joint properties should be defined per unit length when assigned to Lines and 

per unit area when assigned to Surfaces. 

 Master features hold the mesh assignment data. A point can only hold one joint 

assignment so if multiple joints are to be assigned to a single point that point 

must be designated the Slave by ensuring it is the second point in the selection. 

 Joints defining spring supports act relative to the initial, unstressed 

configuration rather than that on any previous loadcase. This means that to 

introduce a stiffness to a support in a loadcase during a staged nonlinear 

analysis, relative to the stressed state on the previous analysis, you will need to 

use joints and activate them on this loadcase. 

file:///C:/SVN/Content/0howto/idh_how_to_visualise_attribute_assignments.htm
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Examples of Assigned Joints/Interface Element 

 

  

 

  

 

Joint between two points 

(Lower point is the master) 

  Joint / Interface mesh  

between two lines 

(Lower line is the master,  

four line mesh divisions  

are assigned to line) 

  Joint / Interface mesh  

between two surfaces 

(Lower surface is the master,  

four line mesh divisions are 

assigned to each line) 

Joint Local Axis Direction 

The joint local axis direction is defined when the mesh is assigned. Three options are 

available: 

 Follow point axes (Default selection) Adopt the axes assigned from the Local 

Coordinate (if any) assigned to the point. Any Local Coordinate that has been 

assigned to a feature can, additionally, be chosen to be ignored as a separate 

option. 

 By point in selection memory A Point previously added to selection memory 

is used together with the points defining the master and slave features to define 

the xy-plane of the local axis direction. 

 By specified local coordinates The element axes are defined using a 

previously defined Local Coordinate. 

 

For Joint element assignments only, the order of the features selected determines the 

Master and Slave. The master assignment of a joint is always the first of the two 

selected features that the joint is assigned to. For assignment to multiple pairs of 

features selected, those features in selection memory will become the slave 

assignments. Joint elements are orientated from the Master to the Slave by default. To 

reverse the joint orientation to be from Slave to Master, deselect the Mesh from Master 

to Slave option. 
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Case Study. Joint/Interface 

Mesh (2D) 

In this example Line 2 is placed in 

selection memory (Slave) and a Line 

joint mesh attribute with 6 divisions is 

assigned to Line 1 (Master). Joints are 

created automatically to tie the Lines together with an interface joint mesh. 

Note. The unmerge facility allows coincident features to be created from a single 

feature and also allows a feature to be set as Unmergable, so it will not be accidentally 

merged back with another coincident feature. See Merging and Unmerging for more 

details. 

  

Case Study. Cylindrical 

Joint/Interface Mesh (3D) 

In this example, a Surface joint mesh is 

assigned to Surfaces between two 

concentric cylinders. Cylindrical axes are 

defined for the joint properties using a 

local coordinate. Joint local x axes will 

then coincide with the cylinder radial 

direction. 

 

Joint Material and Geometric Properties 

Joint material and geometric properties are assigned to the master feature. 

 Joint Material Properties Joint meshes require joint properties to be assigned 

to them. These are defined from the Attributes> Material> Joint menu item.  

 Joint Geometric Properties For joints with rotational degrees of freedom an 

eccentricity must be specified using the Attributes> Geometric> Joint menu 

item. 

 

Non-Structural Mass Elements 

Non-structural mass elements are used to define a lumped mass at a Point, or a 

distributed mass along a Line or over a Surface. Variations may be used to vary the 

mass along the Line or over the Surface.  

file:///C:/SVN/Content/4attrib/idh_geometric_properties.htm
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Defining and Assigning Non-Structural Mass Elements 

A non-structural mass element is defined as a mesh attribute using the Attributes> 

Mesh menu item and specifying the structural element type to be used. Once defined it 

is assigned to selected features using the standard drag and drop technique.  

Non-structural mass elements also require material properties to be assigned to them. 

Use the Attributes> Material menu item to create the required mass for assignment. 

Note. Mass properties should be defined per unit length when assigned to Lines and 

per unit area when assigned to Surfaces. 

Examples of Assigned Non-Structural Mass Elements 

  

  

 

Lumped mass at a point Distributed mass along a line Distributed mass over a surface 

 

Non-Structural Mass Local Axis Direction 

Since the mass can be used to model hydrodynamic effects it is defined in local 

directions. In the case of a line, the direction may need to be normal to the line or in 

the case of a surface, normal to that surface. When carrying out large deformation 

analyses these directions are continually updated as the solution progresses. The 

element axis direction can be defined when the mesh is assigned. Three axis 

orientation options are available: 

 Follow point axes (Default selection) Adopt the axes assigned from the Local 

Coordinate (if any) assigned to the point. Any Local Coordinate that has been 

assigned to a feature can, additionally, be chosen to be ignored as a separate 

option. 

 By point in selection memory - A Point previously added to selection 

memory is used to define the xy-plane.  

 By specified local coordinates The element axes are defined using a 

previously defined Local Coordinate. 
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Delamination Interface Elements 

Interface elements may be used at planes of potential delamination to model inter 

laminar failure, and crack initiation and propagation. 

If the strength exceeds the strength threshold value in the opening or shearing 

directions the material properties of the interface element are reduced linearly as 

defined by the material parameters and complete failure is assumed to have occurred 

when the fracture energy is exceeded. No initial crack is inserted so the interface 

elements can be placed in the model at potential delamination areas where they lie 

dormant until failure occurs. 

Fracture Modes 

Three fracture modes exist: open, shear, and tear (orthogonal shear for 3D models). 

The number of fracture modes corresponds to the number of dimensions of the model. 

The diagram below illustrates the three modes. 

 
 Mode 1 - Open 

   
 Mode 2 - Shear 

  Mode 3 - Tear  
 (orthogonal shear to mode 2) 

 

 

  
 

 

   

 

The interface elements are used to model delamination in an incremental nonlinear 

analysis. These elements have no geometric properties and are assumed to have no 

thickness. 

Interface elements are defined as Line or Surface mesh attributes using the Attribute> 

Mesh menu item.  

Interface Material Properties 

The interface material properties are defined from the Attribute> Material> 

Specialised menu item and then assigned to the same geometry as the interface mesh. 
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Material Parameters 

 Fracture energy Measured values for each fracture mode depending on the 

material being used, e.g. carbon fibre, glass fibre. 

 Initiation Stress The tension threshold /interface strength is the stress at which 

delamination is initiated. This should be a good estimate of the actual 

delamination tensile strength but, for many problems, the precise value has 

little effect on the computed response. If convergence difficulties arise it may 

be necessary to reduce the threshold values to obtain a solution. 

 Relative displacement The maximum relative displacement is used to define 

the stiffness of the interface before failure. Provided it is sufficiently small to 

simulate an initially very stiff interface it will have little effect. 

Coupling Model 

 Coupled/mixed interface damage - Recommended method. 

 Uncoupled /reversible - Unloading is reversible along the loading path. 

 Uncoupled /origin - Unloading is directly towards the origin ignoring the 

loading path. 

Notes 

 It is recommended that automatic nonlinear incrementation is used with the arc 

length procedure option set to root with the lowest residual norm, when 

defining loadcase control. 
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 It is recommended that fine integration is selected for the parent elements from 

the Solution tab of the Model Properties dialog. 

 The nonlinear convergence criteria should be set to converge on the residual 

norm. 

 Choose Continue solution if more than one negative pivot occurs from the 

Model properties, Solution tab, Nonlinear options dialog and set option 252 to 

suppress pivot warning messages from the solution process. 

 The non symmetric solver is run automatically when mixed mode delamination 

is specified. 

 Although the solution is largely independent of the mesh discretisation, to 

avoid convergence difficulties it is recommended that a least two elements are 

placed in the process zone. 

Element Selection 

About LUSAS Elements 

LUSAS elements are classified into groups according to their function. The main 

element groups are listed in the tables that follow.  

See also Joint Element Meshes, and Interface Elements (for composite 

delamination). 

Selecting elements 

Selection of a point, line, surface, or volume mesh element is made on the appropriate 

Mesh dialog accessed from the Attributes> Mesh menu item.  

The setting of an analysis category (2D Grillage/Plate, 2D Inplane, 2D Axisymmetric, 

3D) for a model filters all available elements and lists only those elements on each 

Mesh dialog that will be suitable for use for that type of modelling.  

Selection of an element type and an interpolation order (linear or quadratic), will 

determine the actual element name chosen for use. For advanced users, element names 

may be manually entered, but this should be used with caution since elements chosen 

may not be supported in certain levels of the software, or may be inappropriate for a 

particular type of analysis. 

See Element Types and Availability in the Element Reference Manual for full details 

of all elements. 

See the LUSAS Theory Manual for full details of the element formulations. 

elementreference.chm::/intro/idh_lusas_element_types.htm
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Point Elements 

Non structural mass and Joint elements are defined at or between points. Elements in 

plain text are available in Standard product versions of LUSAS software. Elements in 

bold text are in Plus versions. 

See Element Types and Availability in the Element Reference Manual for full details 

of all elements. 

Generic Element Types 2D 3D 

Non structural mass PM2 PM3 

Joint (no rotational stiffness)  JNT3 JNT4 

Joint (for beams) JPH3 JSH4 

Joint (for grillages) JF3 - 

Joint (for axisymmetric solids) JAX3 - 

Joint (for axisymmetric shells) JXS3 - 

  

Line Elements 

The following table lists selected elements available for Line meshing by type and by 

name. The first column matches the option list in the Line mesh dialog box. Elements 

marked with (LT) are in Lite versions of LUSAS software. Elements in plain text are 

available in Standard product versions. Elements in bold text are in Plus versions. 

See Element Types and Availability in the Element Reference Manual for full details 

of all elements. 

elementreference.chm::/intro/idh_lusas_element_types.htm
file:///C:/SVN/Content/4attrpop/non_structural_mass.htm
elementreference.chm::/intro/idh_lusas_element_types.htm
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Generic  
Element Types 

2D  
2 noded 

2D  
3 noded 

3D  
2 noded 

3D  
3 noded 

’None’   - - - - 

Bar   BAR2 (LT) BAR3 BRS2 (LT) BRS3 

Thin beam - BM3, BMX3 - BS3, BS4 

Thick beam BMI2 (LT) BMI3 BMI21 (LT) BMI21 (LT),  BMI31 

Thick cross-section 
beam 

- - - BMX31 

Thick warping beam - - - BMI21W, BMI22W, BMI31W, 
BMI33W, BMX21W, BMX22W, 
BMX31W, BMX33W 

Plain strain beam - BMI2N, 
BMI3N 

- - 

Engineering grillage GRIL (LT) - - - 

Cross-section beam - BMX3 - BSX4 

Semiloof beam - - - BSL3, BSL4, BXL4 

Axisymmetric 
membrane 

BXM2 BXM3 JNT4 - 

Joint (no rotational 
stiffness) 

JNT3 - JSH4 - 

Joint (for beams) JPH3 - - - 

Joint (for grillages) JF3 - - - 

Joint (for axisymmetric 
solids) 

JAX3 - - - 

Joint (for axisymmetric 
shells) 

JXS3 - - - 

Thermal bar   BFD2 BFD3 BFS2 BFS3 

Axisymmetric 
thermal membrane   

BFX2 BFX3 - - 

Thermal link LFD2 - LFS2 - 

Interface - IPN6 - - 

Non structural mass LM2 LM3 LMS3 LMS4 

Notes 

 Quadratic elements are curved with a mid-side node. 

file:///C:/SVN/Content/4attrpop/interface_elements.htm
file:///C:/SVN/Content/4attrpop/non_structural_mass.htm
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 For some beam elements rotational freedoms at the ends of a Line can be 

made free to rotate by using an element with moment release end conditions. 

 When modelling a 2D frame, if there is any possibility of wanting to develop 

that frame into a fully 3D model it is recommended to use a 3D analysis 

category and use 3D elements. 

 Setting an analysis category will filter the available elements such that only 

those applicable are available. If other elements are used note that no check is 

made in LUSAS Modeller as to whether the element type is valid for the 

analysis being performed, but LUSAS Solver will stop the analysis if the 

element is unsuitable. 

Surface Elements 

The following table lists the elements available for surface meshing by type and by 

name. The first column matches the option list in the Surface mesh dialog box. 

Elements in plain text are available in Standard product versions of LUSAS software. 

Elements in bold text are in Plus versions. 

See Element Types and Availability in the Element Reference Manual for full details 

of all elements. 

Generic  
Element Types 

Triangle 
3 noded  

Quadrilateral 
4 noded 

Triangle 
6 noded 

Quadrilateral 
8 noded 

Plane stress TPM3 QPM4M TPM6 QPM8 

Plane strain TPN3 QPN4M TPN6 QPN8 

Axisymmetric solid TAX3 QAX4M TAX6, TAX6P QAX8, QAX8P 

Thin plate TF3 QF4 - - 

Thick plate - QSC4 TTF6 QTF8 

Thin shell TS3 QSI4 TSL6 QSL8 

Thick shell TTS3 QTS4 TTS6 QTS8 

Membrane TSM3 SMI4 - - 

Fourier TAX3F QAX4F TAX6F QAX8 

Plane field (thermal) TFD3 QFD4 TFD6 QFD8 

Axisymmetric solid field TXF3 QXF4 TXF3 QXF8 

Explicit dynamic - plane 
stress 

TPM3E QPM4E - - 

Explicit dynamic - plane strain TPN3E QPN4E - - 

Explicit dynamic - axisymmetric TAX3E QAX4E - - 

elementreference.chm::/intro/idh_lusas_element_types.htm
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Interface - - - IS16 

Non structural mass TM3 QM4 TM6 QM8 

Notes 

 Setting an analysis category will filter the available elements such that only 

those applicable are available. If other elements are used note that no check is 

made in LUSAS Modeller as to whether the element type is valid for the 

analysis being performed, but LUSAS Solver will stop the analysis if the 

element is unsuitable. 

Volume Elements 

The following table lists the elements available for volume meshing by type and by 

name. The first column matches the option list in the Volume mesh dialog box. 

Elements in plain text are available in Standard product versions of LUSAS software. 

Elements in bold text are in Plus versions. 

See Element Types and Availability in the Element Reference Manual for full details 

of all elements. 

  Tetrahedral Pentahedral 

Generic 
Element Types 

4  
noded 

10  
noded  

6  
noded 

12  
noded 

15  
noded  

Stress - - PN6 - PN15 

Thermal TH4 TH10 PF6 - PF15 

Explicit dynamic TF4 TF10 PN6E - - 

Stress composite TH4E - PN6L PN12L PN15L 

Thermal composite - - PF6C PF12C PN15C 

  

  Hexahedral 

Generic 
Element Types 

8  
noded 

16  
noded  

20  
noded 

Stress HX8M - HX20 

Thermal HF8 - HF20 

Explicit Dynamic HX8E - - 

Stress Composite HX8L HX16L HX20L 

Thermal Composite HF8C HF16C HF20C 

file:///C:/SVN/Content/4attrpop/interface_elements.htm
file:///C:/SVN/Content/4attrpop/non_structural_mass.htm
elementreference.chm::/intro/idh_lusas_element_types.htm
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Notes 

 Setting an analysis category will filter the available elements such that only 

those applicable are available. If other elements are used note that no check is 

made in LUSAS Modeller as to whether the element type is valid for the 

analysis being performed, but LUSAS Solver will stop the analysis if the 

element is unsuitable. 

Geometric Properties 

Any geometric properties that have not already been inherently defined by the feature 

geometry need to be specified using geometric property attributes. Geometric 

properties are element dependent and are defined for an element family such as bars, 

beams, shells, joints etc. Note that geometric attributes are not required for plane 

strain, axisymmetric solid or 3D solid elements. For more details on the properties 

required for a specific elements refer to the Element Reference Manual 

Geometric attributes are defined for each feature type using the Attributes> 

Geometric menu item and then assigned to the required geometric feature (or to an 

appropriate mesh object in a mesh-only model). Geometric properties can be defined 

for: 

 Lines 

 Surfaces 

 Joints 

Geometric Line Properties 

Geometric line section properties such as cross-sectional area, second moments of area 

etc., for bar/link, grillage, axisymmetric membrane etc., and thin/thick beam elements 

can be defined for single constant cross-sections by: 

 Using the Attributes > Geometric > Section Library menu item to access 

supplied and user-created sections in the section library. These stored sections 

can be rotated about the centroid of the section or mirrored to achieve a desired 

orientation when assigned to a feature in a model. For design code checking of 

steel beams a rotation about centroid value of 0 degrees must be used, and if, 

for this use, sections need to be rotated 90 degrees from their otherwise 

orientated position, the setting of a beta angle of 90 degrees either during the 

line mesh assignment, or after line mesh assignment by changing the value on 

the line mesh assignment dialog. After assignment this can be accessed from 

the properties panel. Applying a local coordinate system is an alternative 

method to achieve the same result. 

 Using the Attributes > Geometric > Line menu item to enter section 

properties directly on the Geometric Line dialog for a particular chosen Usage 

file:///C:/SVN/Content/Design/Steel_Frame_Design/steel_frame_design.htm
file:///C:/SVN/Content/Design/Steel_Frame_Design/steel_frame_design.htm


  Chapter 5 : Model Attributes 

    

221 

with an element type, or ASPC Thickness (used to define a thickness for 

arbitrary section property calculation purposes).If the Enter Properties 

option is chosen and you wish to see your section fleshed you will have to 

define your own beam cross-section information if the section was not selected 

from a standard section library or created by using the arbitrary section 

property calculator. Note that the arbitrary section property calculator should 

generally be used to define sections in preference to manually defining 

geometric line property data since cross-sectional values (that are used by the 

fleshing facility) are stored as part of the section property calculation, meaning 

that fleshing of these sections will take place automatically. 

Reinforcement details (for RC frame design checks) 

 Provided an analysis category of 3D is in use, reinforcement details can be 

defined for line beams using the New option from this droplist. See line 

reinforcement for details. Any previously defined line reinforcement utilities 

are also listed for selection. 

Varying sections 

 These can be defined by two methods: 

 Use the Attributes > Geometric > Tapered Section menu item to define a 

tapering section where the section geometry varies linearly for the length of the 

assigned line. The See Tapering Sections below for details 

 Use the Attributes > Geometric > Multiple Varying Section menu item to 

create a geometric line attribute that defines completely varying section built 

from any number of cross-sections that are to be assigned to a line or a whole 

series or path of lines at specified distances. See Multiple Varying Sections 

for details. 

Compound sections 

 Use the Attributes > Geometric > Compound Section menu item to create a 

compound section that is made up from supplied and user-defined library 

sections that are positioned relative to each other, and have differing material 

properties. See Compound Sections for details. 

Bridge deck (grillage) geometric attributes 

 Use the Attributes > Bridge Deck (Grillage) menu item to define the 

geometric properties of specific bridge decks that are modelled using grillage 
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formulae published by Hambly. See Bridge Deck (Grillage) geometric 

attributes for details. 

Infilled or Encased sections 

 Use the Tools > Geometric > Infill/Encased Section menu item to define the 

geometry for a range of infilled or encased section types either with reference 

to sections held in the main section library, or from user-defined values. See 

Infill/Encased Section Property Calculator for details. 

Reinforcement attributes (used in the calculation of particular 

crack width calculations) 

 Use the Attributes > Geometric > Bar Reinforcement menu item to access 

the reinforcement attribute dialog. See Reinforcement Attributes for details. 

Section Property Modification 

Properties affecting the analysis stiffness of geometric line section properties can be 

reduced or otherwise factored, whilst leaving their defined dimensions and section 

properties intact for design calculations, by creating and assigning a section property 

modifier to selected features and for a particular analysis. Section property modifier 

attributes are defined for each feature type using the Attributes> Geometric> Section 

Property Modifier menu item and then assigned to the required geometric feature. 

Notes 

 Assignment of a section property modifier attribute to a beam only affects the 

values tabulated to the Solver data file. The properties shown in the geometric 

attribute dialog, and accessed through the LPI and User Defined Results 

facilities remain as initially defined. 

 Where a section property modifier attribute is assigned to a compound or infill 

section the effects of the two factors (one user, one automatic) will be 

multiplied into a single set of factors. 

Options 

The following options are available when defining geometric line properties: 

 Visualise Cross-sectional shapes for standard library items and for user 

sections (stored in local and server libraries that were created by the standard 

and arbitrary section property calculators) will be automatically visualised. 

General beam sections defined by using the Attributes > Geometric > Line 

menu item, will require cross-section properties to be defined manually in order 

file:///C:/SVN/Content/Bridge/Section_Generators/Infill_Encased_Section_Calculator.htm
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for geometric visualisation to take place. The orientation of the visualised 

section is based upon the vertical axis defined for the model. In LUSAS, 

2D models are assumed to be drawn in the XY plane with the Y axis vertical, 

and 3D models with have the Z axis set to be vertical. The local axes of the 

section are located at its centroid. A circle, of the same pen colour that is 

defined for Lines, represents the location of the nodal line about which the 

section will be positioned when the section is assigned to a line on the model. 

Setting an eccentricity (according to element type) moves the location of the 

nodal line with respect to the centroid. See Eccentricities for more details. 

 Tapering... / Non-Tapering... Tapering beam sections can be defined by 

specifying section properties for each end of the beam. For complex sections 

this would normally be done by drawing selected cross sections for key 

locations along a model and using the arbitrary section property calculator in 

Modeller to calculate and save the properties to a library prior to using this 

dialog. Where both ends of a beam have been defined using either a LUSAS 

supplied standard library item or one of the LUSAS standard section calculators 

an 'exact' calculation can be made to arrive at intermediate section properties 

based upon the known shapes at either end of the beam. As a result, no 

interpolation options can be specified for this situation. In cases where one or 

both ends of a beam section have been defined using the arbitrary section 

calculator (including properties calculated from the precast section range) a 

choice of interpolation method is provided. When the tapering option is chosen, 

the vertical and horizontal alignment of one end of the beam section from the 

other can be specified. Tapered beams would normally use the same section 

shape at either end, but differing sections can be accommodated. Eccentricities 

of beam ends from nodal positions can also be defined. When modelling 

varying cross sections with constant section beam elements care should be 

taken to ensure that sufficient elements have been assigned. More complex 

tapering can be achieved using the Multiple Varying Section facility. 

 Section details of section properties, fibre locations and coordinates defining 

the Cross-sectional geometry of the section can be viewed in tabular format. 

 Properties Provides listings of Standard, Additional (used primarily for 

design checking) and Plastic properties.  
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Standard properties 

 
 

Additional properties for design 
checking 

 
 

 
Plastic properties 

A - Cross-sectional area 

Ixx - Second moment of area 
about x axis 

Iyy- Second moment of area 
about y axis 

Izz - Second moment of area 
about z axis 

Ixy, Iyz, Izx - Product 
moments of area 

J - Torsional constant 

Asx - Effective shear in x 
direction 

Asy - Effective shear in y 
direction 

Asz - Effective shear in z 
direction 

  

 kx - Radius of gyration about x axis 

ky - Radius of gyration about x axis 

kz - Radius of gyration about x axis 

Cw - Warping torsional constant 

xo - Shear centre, distance from 
centroid along x axis 

yo - Shear centre, distance from 
centroid along y axis 

zo - Shear centre, distance from 
centroid along z axis 

  

 Ap - Plastic cross-
sectional area (= elastic 
area) 

Zpy - Plastic section 
modulus about y axis 

Zpz - Plastic section 
modulus about z axis 

Zpt - Plastic torsional 
section modulus 

Yp - Plastic neutral axis, 
distance from centroid 
along y/z axis 

Zp - Plastic neutral axis, 
distance from centroid 
along y/z axis 

Plastic geometric properties are required for beams when using the 

stress resultant material model (model 29). 

The actual parameters required for an analysis depend on the chosen 

beam element. See the Element Reference Manual for further details. 

Eccentricity values can be used to position the top or bottom of a 

section with respect to a nodal line. The use of fibre location values can 

assist here too. 

 Fibre locations drawn as green symbols with an 

identifying reference define positions on the perimeter of 

the beam cross-section at which stresses can be plotted 

when visualising results. Standard sections, precast beam 

sections, and box sections added to a library will have 

their cross-sectional geometry pre-defined. They also 

have default fibre locations stored for each section. 

Sections drawn by users and added to the user and server 

libraries using the arbitrary section property calculator 

have extreme fibre locations calculated automatically - 

these are denoted by 'A1', 'A2', etc. Additional fibre 

locations can also be added manually for points on the 

outer boundary of a section by pressing the Tab key in 

last row and cell of the grid.. Fibre location values can 

also be used for copying and pasting into the eccentricity 

cell of the main dialog if the top or bottom of a section is 

to lie on a nodal line, or for use in calculating an 

eccentricity value to position the section in any other 
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chosen position with respect to a nodal line. 

 Cross-section information is used to define a series of 

quadrilateral shapes that represent the cross-sectional 

shape of the section. These only need to be defined if a 

beam's properties have been defined manually and it is 

required that the beam's shape is visualised when using 

the fleshing  option, otherwise cross-sectional 

information is automatically for sections provided or 

created by LUSAS section property calculators. 

 

 In defining the cross-section shape the 

coordinate of each quadrilateral must be 

defined in local zy cross-section 

coordinate pairs at each node, z1, y1, z2, 

y2, z3, y3, z4, y4. When defining a 

cross-section by this method the centroid 

of the section must reside at 0,0. For 

Cross Section Beam elements (for 

advanced use only) the number of 

integration points (also known as internal 

points) can also be set. 

 

Once defined, the geometric section properties are added to the  Treeview using the 

OK or Apply button. The section is then available for assigning to the appropriate 

Lines on the model. Assigned beam section properties may be fleshed using the 

fleshing button  or from the  Attributes Treeview. 

Eccentricities 

 Beam elements accommodate 

Eccentricities which are 

measured from the bending 

plane to the nodal line in the 

local element direction. Beam 

section properties are always 

input relative to the beam axis. 

 

 

 When sections are defined at either ends of a tapering beam the eccentricity of 

one section to the other to achieve the vertical and horizontal alignment setting 

specified is automatically calculated. Subsequent entering of an eccentricity 
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value for the 'master' end in the Value field will automatically position and 

update the value for the other 'follower' end by an equivalent amount to ensure 

the beam ends are moved equally from their nodal positions. If a vertical or 

horizontal alignment eccentricity is stated in the Alignment panel of the dialog 

that value will only affect the 'follower' end. 

Notes 

 The orientation of the visualised section is based upon the vertical axis that is 

defined for the model. In LUSAS, 2D models are assumed to be drawn in the 

XY plane with the Y axis vertical. 3D models normally have the Z axis set to 

be vertical.  

 For tapering sections defined using the same standard section (rectangular, 

rectangular hollow section, circular, circular hollow section etc) at each beam 

end the standard LUSAS section property calculator is used to accurately 

calculate all section property values. 

 For tapering sections defined using arbitrary sections of the same section shape 

at each beam end the standard LUSAS section property calculator is used to 

calculate the values of A, Iyy, Izz and Iyz. By default the enhanced 

interpolation method is used to calculate the values of J, Asy and Asz, but the 

linear interpolation method is also available. The Enhanced interpolation 

method has been proven to generally produce more accurate section property 

values than the Linear method. 

 For tapering sections defined using arbitrary sections with different section 

shapes at each beam end, by default the Enhanced method is used to calculate 

all values but the linear interpolation method is also available.  

 The visualisation of tapering sections on the Geometric Line dialog is for 

information only. Only by selecting the Visualise button will a correct 

representation of the relative arrangement of both sections be seen, 

incorporating any alignment options specified on the main dialog. 

 When modelling varying cross sections with constant section beam elements 

care should be taken to ensure that sufficient elements have been assigned. 

Greater than 8 elements should be used for small variations in cross section 

along the length of the geometry to which the section has been assigned, and 

considerably more elements should be used for larger variations. 

 Models created prior to version 14.2 will not have any fibre locations data 

stored for each beam. However, the relevant fibre location data can be added 

automatically for these models by double-clicking on each Geometric line 

entry in the  Treeview and re-selecting the same section size from the 

appropriate sections library. 
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 Double-clicking on a geometric line attribute name in the  Treeview allows 

editing of beam section information. 

Geometric Surface Properties 

Geometric attributes are defined for surfaces using the Attributes> Geometric> 

Surface menu item. 

Thicknesses 

 Structures modelled using plate, membrane or shell elements require a 

Thickness to be defined for each surface.  

Eccentricity 

 Optionally an Eccentricity can be specified for certain element types. 

Eccentricity is measured from the bending plane to the nodal line in the local 

element z direction. 

Varying surface properties 

Geometric properties can be varied over a surface by using a variation. See Variations 

for more details. 

  

 

Geometric Joint Properties 

Geometric attributes are defined for joints using the Attributes > Geometric > Joint 

menu item.  

For certain joint elements eccentricity (in the local z direction for 3D, and the local y 

direction for 2D Inplane) can be defined . 

The internal position(s) of the transverse shear spring(s) for joint elements with non-

coincident nodes can be specified. For these, a parametric distance factor (between 0.0 

and 1.0) can be specified from node 1 which defines the position where the transverse 

shear spring is to act. For the local y direction it is measured it is measured from node 

1 (dy=0) along the local x direction to node 2. For the local z direction it is measured 
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from node 1 (dz=0) along the local x direction. See the Element Reference Manual for 

details. 

 

Geometric Properties of Thermal Link 

Geometric properties for a thermal link are defined using the Attributes > Geometric 

> Thermal Link menu item. The following are supported: 

 Points - for which an Area must be specified in model units. 

 Lines - for which a Thickness must be specified in model units. When solved, 

the thickness entered will be multiplied by the length of each portion of the line 

represented by each link, and tabulated as the area of each link. An average 

value is taken if the lengths / thicknesses vary between master and slave lines. 

 Surface - for which nothing is specified. When solved, the area of each surface 

is calculated and tabulated. An average value is taken if the areas vary between 

master and slave surfaces. 

Setting Geometric Attributes for Default Use 

A geometric attribute may be designated as the default assignment using Set Default 

on the context menu. When activated, default attributes are automatically assigned to 

new geometry as it is defined. 

Visualising Geometric Assignments 

Geometric property attributes can be visualised individually by selecting an attribute 

name in the Attributes  Treeview and clicking the right mouse button to choose 

Select Assignments or Visualise Assignments from the context menu. This is the 

easiest way to interrogate the assignment of a single attribute. 

Geometric property visualisation of beams of standard or arbitrary cross-section (that 

are held in section libraries), and surface thicknesses, that are assigned to features of a 

model can be toggled 'on' and 'off' using the fleshing  button.  



  Chapter 5 : Model Attributes 

    

229 

Geometric property dependency across analyses / loadcases 

Geometric properties defined and assigned to features for the first loadcase within a 

base analysis can be optionally inherited by all other analyses. Assigning a different 

geometric property to selected features in a following analysis supercedes any 

inherited geometric properties but for only those assigned features. 

Styles 

The Attributes layer properties define the styles by which geometric properties are 

visualised and also permits visualisation of loadings on an individual basis. The 

attributes layer properties may be edited directly by double clicking the layer name in 

the Layers  Treeview. Geometric attributes can be visualised in three ways: 

 By colouring geometry Colours the geometry according to which attributes are 

assigned to which features. 

 Visualise cross section displays any beam section shape exaggerated by a 

specified %. 

 Show variation of offsets smoothed displays a series of offset beams as a 

smoothed line rather than series of steps. 

 Use solid fill for volumes in model colour fills volumes for visualisation 

purposes. 

 Cross-section end shrinkage options of Automatic (a distance equal to half of 

the height of width of the section, whichever is the larger) or Specified 

distance (in model units) permit the beam sections to be shrunk away from the 

line ends for clarity at connections. Selecting None visualises the geometry 

from point to point with no shrinkage. 

See About Model Attributes for more details. 

Fleshing 

Beams of standard or arbitrary cross-section (that are held in section libraries), and 

surface thicknesses can be visualised on the geometry model using the fleshing  

button, or from the Attributes  Layer properties Geometric tab. Note that only 

elements that are activated in a particular loadcase are fleshed. 

From the geometric settings dialog or from the context menu of the fleshing button the 

cross-section may be exaggerated in size and shrunk in from the ends of the assigned 

Line to aid visualisation at the connections. When processing results the deformed 

cross-section shape may also be visualised by selecting the Deform option on the 

geometric properties dialog. 
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Visualisation of Attributes Without Fleshing Visualisation of Attributes With Fleshing (and end 

shrinkage applied) 

Bridge Deck (Grillage) Geometric Attributes 

Bridge Deck (Grillage) geometric attributes are used to define the geometric properties 

of specific bridge decks that are analysed with reference to, or derived from grillage 

formulae published by Hambly and others.  

When assigned to a model along with a Bridge Deck (Grillage) material attribute, 

which contains separate material definitions for the girders, slab and reinforcement 

(for cracked sections) that are defined in the relevant Bridge Deck (Grillage) 

geometric attribute, in-service or construction stages such as those identified below 

can be modelled: 

1. Deck in-service subject to live loads, with the elastic modulus of concrete 

reflecting short-term behaviour. 

2. Deck in-service subject to permanent loads, with the elastic modulus of 

concrete reflecting long-term behaviour. 

3. Deck during construction with ‘bare beams’, where the weight of wet deck 

concrete is applied but the stiffness is neglected. 

In short, one set of grillage geometric attributes is suitable for the life of a bridge, as 

the sections do not change, whereas several material attributes may be needed to 

represent the in-construction, short term, and long term cases. 

The following 'Bridge Deck (Grillage) Geometric Attributes' are currently supported 

for cracked and uncracked slabs: 

 Slab - this includes Solid, Voided longitudinally, or Voided transversely. 

 Girder with Top Slab - for a composite section only. 
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Bridge Deck (Grillage) Geometric Attribute - Slab 

The 'Bridge Deck (Grillage) Geometric Attribute - Slab' dialog is accessed using the 

Attributes > Geometric > Bridge Deck (Grillage) menu item. 

Analysis category 

Grillage modelling is normally carried out using an analysis category set to 2D 

Grillage/Plate. If the grillage wizard is used to generate a grillage model this analysis 

category will be set by default. An Analysis category of 3D can also be specified prior 

to either manually creating a grillage model, or be set after having generated a grillage 

model using the grillage wizard to make use of 2D and 3D beams. 

Slab type 

Solid and voided (not cellular) slab types are currently supported: 

 Solid Requires breadth and depth of section to be specified. 

 Voided (longitudinal) Requires the diameter and spacing of the longitudinal 

voids to be specified. Appropriate properties for a longitudinal grillage member 

will be calculated.  

 Voided (transverse) Requires the diameter and spacing of the longitudinal 

voids to be specified. Appropriate properties for a transverse grillage member 

will be calculated.  

Voided slab types supported are those where the depth of voids does not exceed 60% 

of the slab depth (Hambly Section 3.2). 

 

Solid 

  

Voided (longitudinally)   Voided (transversely) 

Slab treatment 

Slabs can also be considered to be: 

file:///C:/SVN/Content/Bridge/Grillage_Wizard.htm
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 Uncracked meaning that no reinforcement properties need be defined. 

 Cracked in flexure meaning that one of the 'Cracked properties' options must 

be selected. 

Cracked properties 

Calculation of cracked properties can be: 

 Approximate (ACI318) Calculation is carried out using the approximation of 

ACI 318-08, Building Code Requirements for Structural Concrete American 

Concrete Institute, MI, Jan 2008. Clauses 10,10,4,1(b) and (c). 

 From reinforcement Calculation is carried out from the bar diameter, spacing 

and cover values that are specified. This option is not available for voided 

slabs. 

Specify torsional stiffness  

When unchecked, torsional stiffness is calculated according to Hambly Exp 3.8. A 

user-definable value may be entered. If zero is entered a torsion-less analysis will be 

carried out. 

Notes 

 The solid slab section type may assigned to grillage members that have a 

standard isotropic material or a Bridge Deck (Grillage) material attribute 

assigned to them, unless the Cracked properties – 'From reinforcement details’ 

option is selected, in which case a Bridge Deck (Grillage) material attribute 

that references a reinforcement material must be assigned before the model can 

be solved.  

 The formulae for calculating the section properties of solid slabs are taken 

primarily from CSA S6-14 Canadian Highway Bridge Design Code, CSA 

Group, Ontario, Dec 2014 Table A5.1.1, and supplemented by beam theory 

(for area and transverse bending quantities when utilised with 2D and 3D 

beams). CSA S6-14 agrees with Nambly, O'Brien & Keogh and Bekht & 

Jaegar. 

 The torsional stiffnessof cracked sections is based uipon the approximation in 

Kong & Evans.  

 The formulae for calculating the section properties of voided solid slabs are 

taken primarily from CSA S6-14 Canadian Highway Bridge Design Code, 

CSA Group, Ontario, Dec 2014 Table A5.1.2, and supplemented by beam 

theory (for area and transverse bending quantities when utilised with 2D and 

3D beams 

 For an overview of the procedures involved in modelling grillages see grillage 

analysis. 

 For details of how to define section properties for designing a composite bridge 

deck member see composite bridge deck design   

file:///C:/SVN/Content/6analysi/idh_grillage%20analysis.htm
file:///C:/SVN/Content/6analysi/idh_grillage%20analysis.htm
file:///C:/SVN/Content/Design/Steel_Composite_Bridge_Design/steel_comp_bridge_design.htm
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Bridge Deck (Grillage) Geometric Attribute - Girder with Top 

Slab 

The 'Bridge Deck (Grillage) geometric attribute - girder with top slab' dialog is 

accessed using the Attributes > Geometric > Bridge Deck (Grillage) menu item. 

Geometric attribute data for a grillage girder with a top slab is entered via three tabs 

named: 

 Girder 

 Slab   

 Girder & Slab 

 

See grillage analysis for an overview of the procedures involved in modelling 

grillages, and to see where the use of bridge deck (grillage) geometric attributes fits 

into this procedure. 

Analysis category 

Grillage modelling is normally carried out using an analysis category set to 2D 

Grillage/Plate. If the grillage wizard is used to generate a grillage model this analysis 

category will be set by default. An Analysis category of 3D can also be specified prior 

to either manually creating a grillage model, or be set after having generated a grillage 

model using the grillage wizard to make use of 2D and 3D beams. 

Girder tab 

This enables pre-defined sections to be specified at distances that can be interpolated 

into a single varying section for subsequent assignment to lines in a grillage model. A 

table is built up specifying the section shapes which define the varying section, the 

interpolation method to be used in order to describe the change of section shape 

between sections. 

file:///C:/SVN/Content/6analysi/idh_grillage%20analysis.htm
file:///C:/SVN/Content/Bridge/Grillage_Wizard.htm


Modeller Reference Manual   

    

234 

 

Basic usage and section selection 

A girder of constant or varying section is defined for use with a particular analysis 

category that is stated on the dialog. 

In the section selection table the library section(s) that will be used to generate a 

girder's cross-section along a line or path of lines must each be added, and for a 

varying section an interpolation method and a distance from a starting point must be 

specified for each. Note that user-defined sections need to be saved to the local or 

server libraries prior to using this facility. 

 Clicking on the launch dialog button  in the Section cell allows a pre-

defined section to be chosen from a section library. 

 Clicking on the drop-list button  in the Shape Interpolation cell permits 

the definition of an interpolation setting which defines the shape between 

adjacent pairs of defined sections.  

 Specifying a Distance dictates how the section spacing values entered in the 

Distance column are to be interpreted. 

More detail is provided in the following sections. 

Shape Interpolation 

A shape interpolation setting defines how the shape between adjacent pairs of defined 

sections is calculated. Note that it does not define or calculate the engineering 

properties for those shapes (for that see Multiple Varying Sections - Section 
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Interpolation). Shape interpolation options are only available for second and 

subsequent entries in the table. The following interpolation options are available: 

 Smoothed is available for use with any number of sections. In practice, 

smoothed is linear for two, quadratic for three, and a cubic spline fit for more 

than three. Thus, when the interpolation technique is manually chosen, sections 

are entered in groups. 

 Linear can be used with any number of defined sections (if there are more than 

two, a piecewise linear approach is assumed).  

 Quadratic can be used for sets of sections, that is for 3 sections, 5 sections, 7 

sections etc., where three values can be interpolated (for the first, middle, and 

last section in a set). 

 Function is a function based method where the order (n) for the function that is 

shown on the dialog defines the shape between adjacent pairs of sections. 

Shape interpolation settings are only available for second and subsequent entries in the 

table. 

Table related buttons 

 Edit, Insert and Delete buttons provide the means to select sections from the 

library, create new rows above a selected row, and to delete rows from the 

table.  

 Flip mirrors the contents of the table (and the visualisation of the girder shape). 

Attribute name 

The full name of the geometric line attribute added to the Attributes  Treeview will 

include the Attribute name followed by an automatically created name based upon the 

type of section used, e.g. Bridge Deck - girder with top slab). The automatically 

created part of the name is uneditable. 

Once defined, the geometric section properties are added to the  Treeview using the 

OK or Apply button. The section is then available for assigning to the appropriate 

lines on the model. Assigned beam section properties may be fleshed using the 

fleshing button  or from the  Attributes Treeview. 

Section visualisation 

As the varying section is built-up in the table, a visualisation of the cross-section 

shapes used is displayed on the dialog. Note that longitudinal section visualisation 

only takes place once all required data for a row has been entered. The visualisation 

can be inspected by zooming and panning in the display panel. A changing cursor 

image indicates whether the facility is enabled or not. If necessary, click in the panel to 

activate this facility. Use the mouse wheel to zoom in and out. Click and hold-down 

the left mouse button, or click and hold-down the mouse wheel to pan.  



Modeller Reference Manual   

    

236 

Varying sections would normally be defined to use the same section shape having the 

same set of fibre definitions throughout, but differing sections can be accommodated. 

In situations where the varying sections are too different fleshing of any assigned 

attributes on the model is not possible. 

Slab tab 

This enables slab dimensions and effective widths to be stated, along with slab 

reinforcement details. 

 

Slab dimensions can be stated to be: 

 Constant dimensions All values in row apply to whole length of slab. 

 Dimensions vary linearly between stated distances When selected, this 

activates the Insert and Delete buttons that allow adding extra rows to the table 

to specify values for that vary along the slab. For example, it is possible to 

specify a tapering slab thickness or, if the 'Specify effective widths' option is 

additionally selected, differing effective widths with respect to length along the 

grillage member. 

Slab section data 

The width (b) and thickness (t) of the slab section are specified in the grid, along with 

any offset to web value (ys), which will position the centreline of the slab section the 

stated distance away from the centreline of the girder. Haunches can be defined 

specifying a haunch width (bh) and depth (th). For bridge (grillage) attribute use the 

depth of the haunch is measured from the underside of the slab to the top of the 
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supporting beam or girder. This is particularly helpful for effective widths, which vary 

across the span. 

Other options  

 Specify effective widths If 'Dimensions vary linearly between stated distances' 

is selected, more than one effective width can be manually stated and used for 

stiffness calculations. 

 Include haunch in section properties The stiffness of the haunch concrete 

may optionally be included in the section property calculations. 

 Reinforcement (cracked sections only and design) Define reinforcement in 

top and bottom faces of the slab. The reinforcement specified may be used in 

the determination of section properties for the composite section, according to 

the option selected on the 'Girder & slab' tab - and can also be used for design 

checks, when using the optional Composite Deck Designer, regardless of the 

option selected on the 'Girder & slab' tab. 

Girder & Slab tab 

This relates to data concerning both the girder and slab as whole.  

 

Slab treatment 

The stiffness of the composite section is determined from the stiffness of the girder 

and slab, together with the corresponding girder and slab materials assigned to the 

same line. The contribution of the (reinforced concrete) slab to this composite stiffness 

is calculated according to the options selected as follows: 
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 Uncracked - concrete only The dimensions of the slab ignoring any 

reinforcement specified on the 'Slab' tab, together with the corresponding slab 

material assigned to the same line, is used in the calculation of section 

properties for the composite section. Depending on the Code of Practice in use, 

this option may be suitable for areas where the deck slab is expected to remain 

in overall compression or even for the whole deck. For example AASHTO 

article 4.5.2.2 states: Stiffness characteristics of beam-slab-type bridges may be 

based on full participation of concrete decks", and the commentary C4.5.2.2 

clarifies: “Tests indicate that in the elastic range of structural behavior, 

cracking of concrete seems to have little effect on the global behavior of bridge 

structures. This effect can, therefore, be safely neglected by modeling the 

concrete as uncracked for the purposes of structural analysis". 

 Uncracked - gross section The slab dimensions and reinforcement dimensions 

as specified on the 'Slab' tab, transformed on the basis of 'modular ratio' using 

the slab and reinforcement materials assigned, are used in the calculation of 

section properties for the composite section. This option is typically suitable for 

areas where the deck slab is expected to remain in overall compression. 

 Cracked in tension The stiffness of the composite section is determined on the 

assumption that the concrete in the slab is in overall tension and does not 

contribute to the stiffness at all. Hence the composite stiffness incorporates the 

reinforcement dimensions, in the tributary width of slab, transformed on the 

basis of 'modular ratio' using the reinforcement material assigned. This option 

is typically suitable for areas where the deck is in overall tension i.e. reverse 

bending over intermediate supports. 

Torsion constant 

 Sum slab and girder Sums the torsional stiffness of the slab according to 

Hambly and the torsional constant of the girder. The torsional constant used 

will be either the St. Venant constant, neglecting warping rigidity (as per 

Hambly, Obrien & Keough, and Bakht & Taegar) or may optionally include 

warping rigidity, as recommended in NCHRP Report 725 Section 2.9 

 Girder only  Considers only the torsional stiffness of the girder. 

 User defined A user-definable value may be entered . If zero is entered for all 

sections, a torsion-less analysis will be carried out. 

Warping restraint for girder 

 None (use St Venant) uses either the St. Venant constant, neglecting warping 

rigidity (as per Hambly, Obrien & Keough, and Bakht & Taegar) or may 

optionally include warping rigidity, as recommended in NCHRP Report 725 

Section 2.9 

 NCHRP Report 725 (Both ends) - requires specifying an unbraced length. See 

NCHRP Report 725 Section 3.3.2 
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 NCHRP Report 725 (One end) - requires specifying an unbraced length. See 

NCHRP Report 725 Section 3.3.2 

Alignment 

This is only available for an analysis category of 3D. 

 Include eccentricity from nodal plane to centriod - when selected also 

allows an additional eccentricity to be defined. 

 Ignore eccentricity from nodal plane to centriod 

Notes 

 In LUSAS Modeller, 2D and 3D bridge deck (grillage) sections are always 

treated analytically as having their centroid at the nodal line unless, in a 

3D analysis, an eccentricty is specified. 

 In a bridge deck that comprises steel girders and a concrete slab, the centroid 

of each steel girder / slab section is determined from the centroids of the 

component parts, factored by the modular ratio of the materials assigned to 

each part. As different materials to the component parts of the section may be 

assigned in different analyses, the centroid of a bridge deck may not be 

consistent between the analyses.  

 Visualisation of the nodal line (that is normally done using a magenta filled 

circle to represent the line to which the section would be assigned) is not 

possible on the section drawn on the dialog because the section's centroid is 

not calculated at time of input. 

 Modeller can envelope together results from several analyses at once, and then 

plot contours of these results. To overcome the presence of different centroids 

for the sections in different analyses, Modeller displays bridge deck sections 

as if the centroid is always at the top face of the girder (plus any additional 

eccentricity specified by the user in 3D analysis), or at the bottom face of an 

RC slab grillage. This means the sections are displayed consistently 

irrespective of what material is assigned to them. 

 For analysis purposes, the true centroid is calculated for each individual 

element and loadcase. 

  

Reinforcement Attributes 

Reinforcement bar attributes are used to model the steel reinforcement in reinforced 

concrete. They can be defined by using the by Attributes> Geometric> Bar 

reinforcement menu item. When used with the Smoothed Multi Crack Concrete 

Model and the Crack Widths calculation utility, contours and values of crack widths 

can be plotted in accordance with EN 1992-1-1:2004 Eurocode 2. Crack width 

file:///C:/SVN/Content/Bridge/Crack_Widths/idh_crack_widths.htm
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contours are plotted along the bar elements (actually on the surface of the fleshed bar 

section) corresponding to the steel strains used in the calculation. 

Reinforcement attributes are similar to geometric line attributes but need to be 

assigned to lines meshed with bar elements for a chosen analysis to enable a crack 

width calculation to be carried out.  

Bar attributes may be defined for a single reinforcing bar (the Discrete bar method), as 

would be used in a 3D model, or be defined with suitable properties to represent a 

bundle or simplified arrangement of bars (the Equivalent bar method) as would be 

used typically in a 2D plane strain analysis.  

The input fields on the dialog have different meaning according to the model type and 

reinforcement type specified. 

 Bar area The cross sectional area of an individual reinforcing bar if discrete 

bars are being defined in a 3D model, or the equivalent area of a number of 

reinforcing bars if a bundle or simplified arrangement of bars is being 

considered in a 2D model. 

Parameters for nonlinear concrete crack checking 

This check box must be checked to enable crack width checking to take place. 

 Reinforcement cover - the nominal cover to the reinforcing bar from the 

concrete face in tension. 

 Bar diameter - For both 'Discrete bars' and 'Equivalent bars' reinforcement 

types (see below) this relates to the diameter of a single bar if 

individual reinforcing bars are being considered (as in the examples shown 

below), or the equivalent diameter of a bundle of bars if bundled bars, or a 

simplified arrangement of bars is being considered. The bar diameter is 

described in clause 7.3.4 expression 7.11 of Eurocode EN1992-1-1 and has the 

same meaning in the crack width calculation utility. 

 Reinforcement type - may be defined as Discrete bars or Equivalent bars 

Choosing Discrete bars requires input of properties for an individual bar. 

Choosing Equivalent bars requires input of a bar area that represents the bundle 

or simplified arrangement of bars being considered. For this, the bar diameter 

specified should always be that of a single bar. 

 Breadth of section/Bar spacing - If Equivalent bars are being defined the 

breadth of concrete section (the width of the effective concrete tension area) 

that the bars are occupying would be stated. If Discrete bars are being defined 

the centre to centre distance of the bar from its nearest neighbour would be 

stated.  

 Ratio of bond strength (i) - An adjusted ratio of bond strength that will take 

into account the different diameters of prestressing and reinforcing steel if both 

are used. This has a (default) value of 1 when only reinforcement bars and no 

file:///C:/SVN/Content/Bridge/Crack_Widths/idh_crack_widths.htm
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prestressing tendons are present. Refer to EN 1992-1-1:2004 Table 6.2 for 

suggested values otherwise. 

  

Bar area to be stated for equivalent bars Bar area to be stated for equivalent bars 

Notes 

 Any number of reinforcement attributes can be created and assigned to lines in 

the model for different analyses. 

 The cross-sectional shape is automatically created from the bar diameter. 

 If changing a bar diameter for a Discrete bar, the Bar area will also need 

changing, and vice-versa.  

 If changing the bar diameter for Equivalent bars the Bar area will also need 

changing, and vice-versa. 

 If previously defined reinforcement attribute values are changed the model 

must be re-solved prior to running the Crack Width calculation facility. 

 Reinforcement bar attributes are not used by the RC Slab Designer. 

  

Wood-Armer / Clark-Nielsen Attributes 

Wood-Armer and Clark-Nielsen attributes can be defined using the Attributes> 

Wood-Armer... menu item. These attributes contain details and properties of slab 

reinforcement arrangements. When assigned to relevant features (see below), they 

permit calculation of top and bottom reinforcement moments for plates and grillage 

elements and top and bottom reinforcement forces for shell elements according to 

Wood-Armer / Clark-Nielsen theory. Multiple slab design attributes of these types 

may be defined and assigned to relevant features on a model.  
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 Analysis category Shows the analysis category in use. Wood-Armer / Clark-

Nielsen attributes can only be defined for 2D Grillage / Plate and 3D analysis 

categories. 

 Reinforcement angle sets the angle in degrees between the x direction 

reinforcement and the y' angle reinforcement. Reinforcement angles are 

measured anticlockwise from the x-axis towards the y-axis. To carry out Wood-

Armer calculations on grillage elements an additional equivalent plate width 

parameter must be specified in the geometric properties to convert bending and 

twisting moments into equivalent plate moments. Wood-Armer moments for 

shell elements include both membrane and flexural effects using Clark's 

method.  

 Reinforcement Distances from the centre of the reinforcement bars to the top 

and bottom faces of the concrete section. These values are only required for 

slabs modelled with shell elements. 

Design components 

When carrying out a design based upon Wood-Armer (or Clark-Nielsen) calculations, 

the angle  of the failure cracks can be entered using the k-factor parameter (k=tan . 

In principle, any value for k can be chosen and an infinite number of possible 

combinations capable of resisting a particular set of applied forces exists. For design 

purposes, a value of  (or k) may be established to minimise the resistive forces 

applied, hence minimising the steel area requirement. The minimum k factor for 

orthogonal reinforcement is +/- 1, or for  is +/- 45 degrees. For skew reinforcement, 

the minimum k factor depends upon the direction of the reinforcement. 

 Minimised total weight / area of reinforcement If the k factor is not 

specified, a default of 1.0 is used and the area of reinforcement is minimised. 

 k factor for non-minimised area of reinforcement allows a k factor (tan ) to 

be specified so that Wood-Armer / Clark-Nielsen calculations can be carried 

out without minimisation of the reinforcement areas in order that the load 

capacity of an existing reinforced concrete slab can be assessed. 

Assessment utilisations 

These are based upon known moment resistances. 

 Display assessment utilisations allows input of resistive moments or forces 

(instead of the k factor) for top and bottom surface reinforcements for 

assessment purposes.  

 For Wood-Armer all values of top and bottom rebar moment resistance 

must be greater than zero. 

 For Clark-Nielsen all values of top and bottom rebar force resistance 

must be greater than zero. 
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 If assessment values are specified, utilisation factors are calculated for 

each position on the model. Factors above 1 indicate failure. 

On completion a Wood-Armer attribute with additional slab design data is created in 

the Attributes  Treeview. 

Assignment 

 For models created with plate and shell elements the Wood-Armer / Clark-

Nielsen attribute can be assigned to surfaces. 

 For models created using grillage elements the Wood-Armer / Clark-Nielsen 

attribute must be assigned to the points in the grillage model where grillage 

moments will be determined (that is, at the intersection of longitudinal and 

transverse members). 

Notes 

 See Wood-Armer Reinforcement Calculations for more information. 

 Top and bottom reinforcement moments are calculated for plate and grillage 

elements, and top and bottom reinforcement forces are calculated for shell 

elements. Consult the Element Reference Manual for Wood-Armer results 

column details. 

 Contours of Wood-Armer and Clark-Nielsen components, and equivalent plate 

moments can be plotted. See Visualising the Results for details.  

 Plate equivalent moments are always available for a grillage model whenever 

the equivalent plate width is nonzero, as they do not require any inputs from 

the Wood-Armer attribute. They are listed as a Force/Moment entity, and are 

named “MX(Epw)”, “MY(Epw)” and “MXY(Epw)”. 

 See Online help > Worked Examples > For LUSAS Bridge and LUSAS Civil 

& Structural > 'Wood-Armer bridge slab assessment' for a worked example 

covering Wood-Armer calculation. 

 For details of Wood-Armer reinforcement calculations refer to the Theory 

Manual. 

RC Slab Design Attribute 

Reinforced concrete slab design attributes can be defined using the Attributes> 

Design> RC Slab Design... menu item that is available for use with selected Bridge 

and Civil software products only.   
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Slab design attributes specify the reinforcement arrangement that is to be used for RC 

Slab Design calculations. Top and bottom reinforcement layout, size, spacing, cover 

and skew angle of bars can be defined in accordance with particular country 

requirements. Multiple slab design attributes may be defined and assigned to relevant 

features on a model either before or after a model has been solved, but must be 

assigned before the RC Slab Designer can be used. 

 Reinforcement library This contains selections for Metric bar sizes, Australia 

bar sizes, and Canada and American bar size notations. 

 Bar sizes The sizes and designations that are shown are appropriate to the 

region for the selected Code of Practice. User-defined bar sizes can be added by 

typing over a value in the drop-down list. This option may be used to represent 

equivalent or bundled bars. A positive value greater than zero must be entered.  

 Bar spacing is measured centre-to-centre, perpendicular to the bar direction. 

 Cover is measured from outermost part of the bars laid in the outermost layer 

of reinforcement to the nearest concrete face. It is intended that the value 

entered here is the actual cover, which may include allowance for fixing 

tolerance.  

 Use nominal cover in crack width calculations A nominal cover can be 

entered where different from the actual cover. The nominal cover will be used 

to determine crack widths in the RC slab. Further details are provided in the 

RC Slab Design : Design Code Settings pages for each design code. 

 Skew angle of bars in y' from x Used to arrange bars in a non-orthogonal 

arrangement where the skew angle can lie between 0 and 180 degrees (90 

degrees is perpendicular). The angle entered defines the orientation of the y' 

reinforcement with respect to the x-direction, measured in an anti-clockwise 

direction. The angle specified is used to determine Wood-Armer / Clark-

Nielsen results in the x and y' (skew) directions (for comparison to flexural 

resistance in the two corresponding directions) and in the determination of 

crack widths when chosen. 

On completion a Wood-Armer attribute with additional slab design data is created in 

the Attributes  Treeview.The attribute is distinguished from normal Wood-Armer 

attributes by being held in a RC Slab folder and with a name that contains all bar 

diameter, cover and skew angle information as defined.  

Assignment 

 For models created with plate and shell elements the resulting Wood-Armer 

attribute can be assigned to surfaces. 

 Unlike the general Wood-Armer attribute, this attribute cannot be assigned to 

models created with grillage elements. 

file:///C:/SVN/Content/Design/RC_Slab_Design/idh_rc_slab_designer_design_code_settings.htm
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 Assignment of the RC slab attribute therefore has the same effect as 

assignment of a Wood-Armer attribute. 

See RC Slab Design: Overview for a general overview of the slab design process. 

RC Frame Design Attributes 

Reinforced Concrete frame design attributes are used to specify additional Code of 

Practice specific information about model line features that represent concrete 

members in order to enable RC frame design checks to be carried out. Note that this 

additional information is not required for a structural analysis. 

RC frame design attributes can be defined using the Attributes> Design> RC Frame 

Design... menu item that is available for use with selected Bridge and Civil software 

products for licences that support this facility, and only if a model analysis category 

of 3D is in use.  

The options that are available for selection on the resulting dialog depend upon the 

design code selected from the dialog displayed when using the Design> RC Frame 

Design menu item. 

RC frame design attributes can be defined for the following design codes: 

 AASHTO LRFD 8th Edition 

 AS5100.5-2017 

 CSA S6-14 

 EN1992-1-1 and EN1992-2 

 IRC: 112-2011 

 

Typical information defined in a RC frame design attribute includes:  

 Beam and column minimum reinforcement ratios 

 Calculation methodology 

 Parameters for stress limitation and crack control 

 Creep parameters 

Once defined, a Design attribute entry is created in the Attributes  Treeview ready 

for assignment to selected lines in a model.  

Steel Frame Design Attributes 

Steel Frame Design Attributes are used to specify member design values and in 

particular member lengths and end conditions used in determination of buckling 

file:///C:/SVN/Content/Design/RC_Slab_Design/idh_rc_slab_design_overview.htm
file:///C:/SVN/Content/Design/RC_Frame_Design/rc_frame_design.htm
file:///C:/SVN/Content/4attrib/idh_rc_design_attribute_aashto_8th.htm
file:///C:/SVN/Content/4attrib/idh_rc_design_attribute_as_5100.htm
file:///C:/SVN/Content/4attrib/idh_rc_design_attribute_csa_s6_14.htm
file:///C:/SVN/Content/4attrib/idh_rc_design_attribute_en1992-1-1_and_en1992-2.htm
file:///C:/SVN/Content/4attrib/idh_rc_design_attribute_irc_112.htm
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capacities. They are assigned to line features in a model to specify additional 

information about those features (information that is not required for a structural 

analysis to be carried out) in order to enable steel frame design checks to be carried 

out to a supported design code. 

Steel frame design attributes can be defined using the Attributes> Design> Steel 

Frame Design... menu item that is available for use with selected Bridge and Civil 

software products for licences that support this facility, and only if a model analysis 

category of 3D is in use. The steel product standards that are available for selection on 

the resulting dialog depend upon the steel design code selected from the dialog 

displayed when using the Design> Steel Frame Design menu item. 

The following design codes are currently supported: 

 AASHTO LRFD 7th Edition AASHTO LRFD Bridge Design Specifications, 

7th Edition, American Association of State Highway and Transportation 

Officials, 2014. 

 AASHTO LRFD 8th Edition AASHTO LRFD Bridge Design Specifications, 

8th Edition, American Association of State Highway and Transportation 

Officials, 2017. 

 AS 4100-1998 Steel Structures (Australia) - Australian Standard: AS4100-

1998, Steel structures, Standards Australia International Ltd, Sydney. 

 CSA S6-14 Canadian Highway Bridge Design Code Canadian Highway 

Bridge Design 

 EN1993-1-1: 2005+A1:2014 - EN 1993-1-1:2005 Eurocode 3: Design of steel 

structures – Part 1-1: General rules and rules for buildings. 

 EN1993-2: 2006 - EN1993-2: 2006 Eurocode 3: Design of steel structures - 

Part 2: Steel Bridges.  

 GB50017 - GB50017-2017 Standard for design of steel structures, China 

Architecture & Building Press, China. 

 

Defining member buckling lengths 

It is possible for a member to have unsymmetric restraints leading to different 

buckling lengths about each axis. In LUSAS a member's unrestrained length may be 

taken from either a line or a combined line. This allows a member to be defined by 

more than one line and multiple buckling lengths. The choice of whether to use the 

line length or combined line length for each buckling phenomenon is specified in the 

Steel Frame Design Attribute dialog. Care is required in defining and assigning steel 

frame design attributes in order to ensure that the correct buckling lengths are assigned 

for all valid situations in the model. It is recommended that the concept is understood 

first in a test model as the unbraced length can easily be underestimated.  

file:///C:/SVN/Content/Design/Steel_Frame_Design/steel_frame_design.htm
file:///C:/SVN/Content/4attrib/idh_steel_design_attribute_aashto_lrfd_7th.htm
file:///C:/SVN/Content/4attrib/idh_steel_design_attribute_aashto_lrfd_8th.htm
file:///C:/SVN/Content/4attrib/idh_steel_design_as_4100.htm
file:///C:/SVN/Content/4attrib/idh_steel_design_can_csa_s6_14.htm
file:///C:/SVN/Content/4attrib/idh_steel_design_attribute_en1991_1_1_and_en1993_2.htm
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Examples of member buckling lengths 

Example 1, that follows, shows the invalid use of a combined line to define a member. 

Restraint is provided in the major and minor directions at each end of the member and 

in the minor direction only at the point where member (Line 4) is connected. In the 

steel frame design attribute the buckling length is set in the attribute to use the 

combined line length about the major axis (between end restraints) and to use the 

individual line lengths about the minor axis. The unrestrained length in the minor 

direction will be taken as line length. This would be correct for the first line (Line 1) 

up to the restraint but the unrestrained length of the second and third lines (Line 2 and 

Line 3) will be taken erroneously as their individual lengths, as opposed to a length for 

the sum of these two lines. Members should therefore not be made up of a series of 

lines where there are no intermediate points of restraint at the end points of each line. 

Additionally a member should only ever be defined with a single combined line, 

because overlapping combined lines will cause errors in the determination of buckling 

lengths. 

Examples 2, 3 and 4 show valid uses of combined lines and lines to calculate buckling 

lengths. 

 

  

 

Example 1: Invalid use of a combined line to 

define a member (when the ends of some internal 

lines defining the member have no restraint)  

  Example 2: Valid use of a combined line to define 

a member using multiple lines(when the end of 

each line defining the member is restrained) 
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Example 3: Valid use of a combined line to define 

a member when no internal restraints are 

provided for all lines defining that member. 

  Example 4: Valid use of a line for a single member 

Notes 

 Member lengths for buckling are always taken from the actual line or 

combined line length and will ignore the presence of any rigid end zones. This 

is a conservative assumption. 

 The steel frame design attribute requires the lines that are present in a 

combined line to all be in the same direction. 

 When geometry data is imported from third-party systems, it may be the case 

that individual lines are created inside Modeller instead of a single line 

between two points. In such situations it may be possible to create combined 

lines to define members depending upon restraints used, otherwise, if not 

appropriate, the line geometry should be simplified with a single line 

representing a single member. 

 See specific design codes for details of buckling lengths. 

Section Library 

The section library is available from the Attributes> Geometric> Section Library 

menu item.  

Standard steel section libraries are currently available for the following: 
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 Australian steel sections 

 Canadian steel sections 

 China steel sections 

 EU steel sections 

 Indian steel sections 

 KS steel sections including Korean rail sections 

 New Zealand steel sections 

 UK steel sections 

 US steel sections 

 

The library of precast concrete sections supplied currently includes: 

 UK beams: Y, YE, TY, TYE, SY, M, UM and U beam types 

 US beams: AASHTO Types II to VI, Florida Bulb T72 and T78 beams, NU 

Girders and Texas DoT 'I' Girders', Northeast Bulb 'T' 

 Australia and New Zealand beams: Super-T beams T1 to T5 (open and 

closed) 

 Canada 'I' beams 

 

In addition, user-created sections can be saved in the following libraries: 

 User (local) - for use inside the current project folder only 

 User (server) - for use across all projects 

 

See Library Locations for details about library filenames and locations. 

  

Note. LUSAS Modeller re-computes all section properties from the section 

dimensions that are published in supported codes of practice, rather than use the 

published section property values directly. This is done because published section 

properties do not contain all the section properties that are required for both analysis 

and design use, and additionally, for some codes, some published properties are clearly 

incorrect. Note that, in most cases, LUSAS calculated section properties are within 1% 

of the corresponding published values. 

Usage 

Sections selected from a library are added to the Attributes  Treeview. From there 

they can be assigned to selected line features on a model (or to appropriate elements in 

file:///C:/SVN/Content/dlgsectprop/IDH_LIBRARY_LOCATIONS.htm
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a mesh-only model). For more details on the use of section library items see the 

Geometric Properties section. 

Adding User-defined Sections to the Section Library 

In addition to sections provided in the geometric beam section library, other user-

defined sections can be added to the library by using Section Property Calculator 

facilities. These are accessed from the Tools > Section Property Calculator menu. 

Facilities exist to calculate the properties of standard sections, precast beam sections 

with a top slab, simple and complex box sections, infilled and encased sections and 

user-defined arbitrary sections that are created in LUSAS Modeller.  

Multiple Varying Sections 

The multiple varying section dialog is accessed using the Attributes > Geometric 

> Multiple Varying Section menu item. It enables pre-defined cross-sections to be 

specified at distances that can be interpolated into a single varying section for 

subsequent assignment to a single line, or to a series of lines with reference to a pre-

defined reference path. A table is built up specifying the section shapes which define 

the varying section, the interpolation method to be used in order to describe the change 

of section shape between sections, and the alignment method to be used to set-out each 

section with respect to another.  

Basic usage and section selection 

A multiple varying section is defined for use with a particular analysis category, as 

shown on the multiple varying section dialog. 

 In the section selection table the sections that will be used to generate a varying cross 

section along a line or path of lines must each be added, and for a varying section an 

interpolation method and a distance from a starting point must be specified for each. 

Note that user-defined sections need to be saved to the local or server libraries prior to 

using this facility. 

 Clicking on the launch dialog button  in the Section cell allows a pre-

defined section to be chosen from a section library. 

 Clicking on the drop-list button  in the Shape Interpolation cell permits 

the definition of an interpolation setting which defines the shape between 

adjacent pairs of defined sections.  

 Specifying a Distance interpretation dictates how the section spacing values 

entered in the Distance column are to be interpreted. 

More detail is provided in the following sections. 
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Shape Interpolation 

A shape interpolation setting defines how the shape between adjacent pairs of defined 

sections is calculated. Note that it does not define or calculate the engineering 

properties for those shapes (for that see Section Interpolation below). Shape 

interpolation options are only available for second and subsequent entries in the table. 

The following interpolation options are available: 

 Smoothed is available for use with any number of sections. In practice, 

smoothed is linear for two, quadratic for three, and a cubic spline fit for more 

than three. Thus, when the interpolation technique is manually chosen, sections 

are entered in groups. 

 Linear can be used with any number of defined sections (if there are more than 

two, a piecewise linear approach is assumed).  

 Quadratic can be used for sets of sections, that is for 3 sections, 5 sections, 7 

sections etc., where three values can be interpolated (for the first, middle, and 

last section in a set). 

 Function is a function based method where the order (n) for the function that is 

shown on the dialog defines the shape between adjacent pairs of sections. 

 

Shape interpolation settings are only available for second and subsequent entries in the 

table. If 'Specify interpolation order' is unchecked (off), the ‘shape interpolation’ 

column in the grid is disabled, and a smoothed (spline) interpolation technique is used 

to fit all the given sections at their given distances. 

Distance interpretation 

 Scaled to fit each line individually For this option values entered in the 

Distance column of the table represent the locations along each line that the 

sections will be assigned. Values are entered as proportional distances along a 

line (for example, entering 0, 0.5 and 1 would specify a section at either end 

and at a mid-point of any line that was selected and assigned this geometric line 

attribute). Distance values are normalised to the actual line length and are offset 

by the start distance. For example, a section that varies from defined geometry 

at start, middle and end can be input with distances as 0, 0.5 and 1.0, or 0, 5, 

and 10, or 10; 15, and 20. This flexibility can be used to entire a series of 

definitions along a common parallel chainage.  

 Along reference path For this option values must be entered in the Distance 

cells of the table that specify the actual distance at which each section will be 

positioned along a reference path. Values are entered as absolute and not 

relative distances. Note that a section does not necessarily have to be defined to 

start at a distance of 0. A particular reference path can be specified prior to 

assignment or on assignment. 
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Examples are provided of distance types. See Distance Types and Methods of 

Assignment. 

Table related buttons 

 The Symmetric section check box copies any rows above the last defined entry 

and reverses them to create a symmetric odd-numbered arrangement.  

 Edit, Insert and Delete buttons provide the means to select sections from the 

library, create new rows above a selected row, and to delete rows from the 

table.  

 Flip mirrors the contents of the table (and the visualisation of the varying 

section shape). 

 

Alignment 

 Vertical and horizontal alignments - these govern how tops, centres, bottoms 

and sides of adjacent beam sections are set out relative to the 'master' section 

specified in the adjacent 'Alignment' drop-down list. An option to enter user-

defined individual eccentricities is also provided and enables more advanced 

alignment to be achieved.  

 Align all sections to section (number) - aligns all sections with respect to the 

specified 'master' section number. See Section eccentricities explained. 

 

Section eccentricities explained 

When sections are specified to define a multiple varying section beam it is important 

to remember that the 'master' section is the one to which all 'follower' sections are 

aligned to. The eccentricity of each 'follower' section to achieve the desired vertical 

and horizontal alignment with respect to the 'master' is automatically calculated for 

each section. The eccentricity values for 'follower' sections are made up of a value 

corresponding to the automatically calculated eccentricity required to achieve correct 

alignment to the master section plus any additional user-defined individual eccentricity 

that may have been defined for the 'master' section. These values can be seen by 

clicking the launch dialog button  in the Section cell of the table for the section. 

Maintaining a consistent 'master' section will make it easier to marry multiple varying 

section attribute assignments. Subsequent updating of an eccentricity value for a 

'master' section will automatically update the eccentricity values for all of the 

'follower' sections by an equivalent amount to ensure the sections are moved equally to 

re-align with the master section. Updating of eccentricity values is only possible by 

selecting the 'Individual offsets' option on the Vertical or Horizontal alignment drop-

down lists, and clicking the launch dialog button  in the Section cell of the table for 

a section, and entering an eccentricity value on the 'Enter section' dialog). 
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Note that for beam elements an eccentricity is measured from the bending plane of the 

section to the nodal line in the local element direction. This can result in both positive 

and negative eccentricity values depending upon the size of the 'master' and 'follower' 

sections.  

To move a multiple varying section beam up or down from its nodal line position only 

the eccentricity for the 'master' section need be modified because all other sections will 

have their eccentricity values updated automatically to be moved by the same amount. 

  

 

Whilst not commonly used, user-defined individual eccentricity can be entered for 

selected sections by selecting the Individual eccentricity menu item from either the 

Vertical or Horizontal Alignment drop-down menu, then accessing a section's 

properties by clicking the launch dialog button  in this cell and entering an 

eccentricity value on the Enter section dialog. When an individual eccentricity is 

specified on a 'follower' section any connection with the 'master' section is broken and 

any eccentricity specified for a 'master' section will no longer update the offsets on a 

'follower' section. 

Interpolation of section properties 

Where all sections have been defined using either a LUSAS supplied standard library 

item or one of the LUSAS standard section generators an 'exact' calculation is made to 

arrive at intermediate section properties based upon the defined shape (see Shape 

Interpolation above) between the sections.  

If the shape of the cross-section cannot be interpolated (because one of the sections 

has been defined using the arbitrary section calculator, the precast library, or if 

sections are of completely different shapes) the engineering properties at locations 

along the multiple varying section can be calculated in the following ways: 

 Enhanced interpolation uses proprietary LUSAS equations to calculate best-

estimate cross-section properties for locations along a beam from the cross-
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sectional area (A) and Moment of Inertia (I) values of the sections defined at 

each beam end. See the Theory Manual for more details. 

 Linear interpolation calculates cross-section properties for locations along the 

beam by linearly interpolating the cross-sectional area (A) and Moment of 

Inertia (I) values of the sections defined at each beam end. This method has 

generally known limitations for particular section types. 

 

When modelling varying sections with constant beam elements (such as BMS 

elements) care should be taken to ensure that sufficient elements have been assigned to 

the line(s) representing the tapering beam to achieve sufficient accuracy of results. If 

varying section beam elements are used (the BMI group of elements) only one element 

per line may be required. 

Attribute name 

The full name of the geometric line attribute added to the  Treeview will include 

the Attribute name followed by an automatically created name based upon the number 

of section library items used. The automatically created part of the name is uneditable. 

Once defined, the geometric section properties are added to the  Treeview using the 

OK or Apply button. The section is then available for assigning to the appropriate 

lines on the model (or elements in a mesh-only model). Assigned beam section 

properties may be fleshed using the fleshing button  or from the  Attributes 

Treeview. 

Section visualisation 

As the multiple varying section is built-up in the table, a visualisation of the 

longitudinal and vertical alignment and of the cross-section shapes used is displayed 

on the dialog. Note that longitudinal section visualisation only takes place once all 

required data for a row has been entered, and then only for sections that are 

compatible. The visualisation can be inspected by zooming and panning in the display 

panel. A changing cursor image indicates whether the facility is enabled or not. If 

necessary, click in the panel to activate this facility. Use the mouse wheel to zoom in 

and out. Click and hold-down the left mouse button, or click and hold-down the mouse 

wheel to pan.  

Multiple varying sections would normally be defined to use the same section shape 

having the same set of fibre definitions throughout, but differing sections can be 

accommodated. In situations where the varying sections are too different to be 

connected together section visualisation on the dialog and fleshing of any assigned 

attributes on the model is not possible. 

Incompatible section types 

Checking for incompatible section types can only be carried-out when the OK button 

is pressed. 

file:///C:/SVN/Content/4attrpop/idh_linear_interpolation_limitations.htm
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Multiple Varying Section Distance Types and 

Methods of Assignment 

A multiple varying section geometric line attribute can be defined for assignment to 

either: 

 A single line - where section spacing distances are scaled to fit each line 

individually 

 A series of lines - where section spacing distances are defined for use with a 

pre-defined reference path 

  

 

  

 

Varying section distances defined for assignment 

of the line attribute to a single line. 

  Varying section distances defined for 

assignment to multiple lines with reference to a 

path. 

The values entered in the distance cell of the multiple varying section dialog depend 

upon the intended assignment. Examples of each type follow. 

Scaled to fit each line individually 

Use of the Scaled to fit each line individually option enables a simple prototyping and 

assessment model for a bridge formed of tapered box sections to be created in a very 

straightforward manner. In their simplest form, multiple varying sections can be 

defined for assigning to single selected lines on a model (or appropriate elements on a 

mesh-only model). Distance values are normalised to the actual line length and are 
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offset by the start distance. For example, a section that varies from defined geometry 

at start, middle and end can be input with distances as 0, 0.5 and 1.0, or 0, 5, and 10, or 

10; 15, and 20. This flexibility can be used to entire a series of definitions along a 

common parallel chainage.  

 

  

Single line beam assigned a single multiple varying section line attribute. (For clarity beam line has 

been visualised at top of section.) 

 

 

Three varying section line attributes assigned to three separate lines of a model 

Along reference path 

Use of the multiple varying section with the reference path facility enables beam 

models of bridges formed of tapered box sections to be created for use in a staged 

construction analysis. With this, multiple varying sections are assigned to multiple 

lines. Distance values are entered that define the distances at which a defined section is 

to be positioned along a set of selected lines with reference to a pre-defined reference 

path. Note that a section does not necessarily have to be defined to start at a distance 
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of 0. A path can be specified to start at a particular distance. This method has uses in 

staged construction analyses where, as lines are activated, the appropriate elements 

and geometric properties for those activated features are added to the model. 

 

Multiple line beams assigned a single multiple varying section line attribute with reference to a path. 

(For clarity beam line has been visualised at top of section) 

 

Three varying section line attributes assigned to multiple sets of lines of a model with the use of a 

reference path 

If necessary, one geometric multiple varying section line attribute could be defined for 

a series of multiple varying sections at specified distances that define the complete 

end-to-end run of cross-sections for a bridge. Subsequent assignment of solid or 

diaphragm sections at supports or mid span would then override any previously 

assigned 'temporary' assignments of voided sections that may have been previously 

made.  
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Line mesh density 

 When modelling varying sections with constant beam elements (such as BMS 

elements) care should be taken to ensure that sufficient elements have been assigned to 

the line(s) representing the tapering beam to achieve sufficient accuracy of results. If 

varying section beam elements are used (the BMI group of elements) only one element 

per line may be required. 

When defined section distances do not map exactly 

to lines on a model 

In defining distances at which sections will apply and then assigning geometric line 

attributes containing those sections to lines on a model (with reference to a path) there 

may be occasions where the set of defined sections are too short for the assigned line 

(or lines) or too long. 

 If a set of defined sections are too short for the assigned line (or lines) the 

geometric line attribute will stay assigned to all line (or lines) selected but no 

visualisation (fleshing) will take place on any line in a set of lines that does not 

have a complete line attribute assigned. Any attempt to solve a model 

containing such assignments will also produce tabulation errors. 

  If a set of defined sections are too long for the assigned line (or lines) fleshing 

of the section shape will take place but only for the length of line (or lines) that 

was selected and no tabulation errors will occur as a result when solving the 

model. 

Compound Sections (from library items) 

Compound sections can be defined by using the Attributes > Geometric 

> Compound Section menu item. Compound sections are defined from existing 

library sections that are positioned relative to each other, and can have different 

material properties assigned to them. The compound section attribute created can be 

assigned to lines in the model in the same way as any other geometric attributes. 

Note that the compound section attribute created will not provide a composite section. 

Instead, because the sections are expected to be disconnected, equivalent properties are 

computed on that basis. For composite sections where the sections are expected to be 

connected, the arbitrary section property calculator should be used. 

Basic usage and section selection 

A compound section is defined for use with a particular analysis category. 

 In the section selection table the sections that will be used to generate a compound 

section must each be added, and horizontal and vertical alignment settings for chosen 

points on each section must be specified. Note that user-defined sections need to be 

saved to the local or server libraries prior to using this facility. Sections can be 

assigned different material properties. 
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 Clicking on the launch dialog button  in the Section cell allows a pre-

defined section to be chosen from a section library. Note that sections may be 

rotated or mirrored prior to having their entry being inserted into the compound 

section grid. 

 Clicking on the drop-list button  in the This sect or Align to or Other sect 

cells of the Horizontal or Vertical alignment columns governs how the left, 

right, bottom, top, centroid or fibre positions of sections that are added to the 

grid are set out relative to each other.  

Alignment settings 

 This Section This setting specifies a reference point for the section that is to be 

positioned with respect to another section according to the 'Align to' and 'Other 

section' settings made in that grid row. For Horizontal Alignment ‘Left, 

'Centroid' and 'Bottom', followed by a list of all fibres defined for the section 

are listed. For Vertical Alignment 'Top', 'Centroid', and 'Bottom', followed by a 

list of all fibres defined for the section are listed. See ' Examples of compound 

section definitions' below for representative uses of this setting. 

 Align to This setting specifies how the reference point should be positioned, 

either with respect to another Section (by selecting the Section number from the 

drop-down list of those available), or be positioned by entering a coordinate by 

selecting the 'Coords’ option. 

 Other section When the ‘Align to’ field specifies a section, this field allows 

the selection of a position on the other section, in the same way as the ‘This 

Section’ field. If ‘Align to’ is set to ‘Coords’, the last field changes from a 

drop-down list to an edit field to allow a value to be entered that represents the 

distance that the reference point of the section should be positioned away from 

the other section. 

Section visualisation 

As the compound section is built-up, a visualisation of the longitudinal and vertical 

alignment and of the cross-section shapes used is displayed on the dialog. A magenta 

filled circle represents the location of the nodal line about which the section will be 

positioned when it is assigned to a line on the model. The selected section in the grid is 

shown highlighted in bright yellow, with its fibre locations marked. 

To see the effect of a change of setting the cursor should be clicked again in another 

cell. Consistently with the main section library, the visualisation can be inspected by 

zooming and panning in the display panel. To start zooming and panning, click the 

section image. The cursor will change to indicate that zoom and pan mode is active. 

Use the mouse wheel to zoom in and out. Click and hold-down the left mouse button, 

or click and hold-down the mouse wheel to pan. Click any other control on the dialog 

to leave pan and zoom mode. 
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Examples of compound section definitions 

 

  

 

Two sections are initially added and sit at a 

common centroid awaiting alignment settings to 

be made.  

  The right-hand side of Section 1 is set to be 

aligned with the left-hand side of Section 2. The 

top of both sections is aligned. The new centroid 

position for the combined section is automatically 

calculated. 

  

 

  

 

Fibre location 2 of Section 1 is positioned 0.5 

model units horizontally from the centreline of 

Section 2. The top of both sections is aligned. The 

new centroid position for the combined section is 

automatically calculated. 

  Four angle sections are defined (with three being 

rotated about their centroid during selection).  

The relative positions of fibre location 2 are 

specified for each section. 

Section materials 

 Specify material for each row When un-ticked, the Reference material is 

assumed to be the same material. This is the default option.  

 Reference material When 'Specify material for each row' has been selected a 

reference material can be selected from a drop list of current material attributes 

in the model, or a new material defined. Each section in the grid can then have 

a material attribute assigned to it using the drop-down list in the final column. 
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From the reference material and the material defined for a section in the grid, 

the modular ratio is derived and used to calculate the combined (transformed) 

section properties. 

Table related buttons 

 Edit, Add and Delete buttons provide the means to select sections from the 

library, create new rows above a selected row, and to delete rows from the 

table. Pressing the Add button will, by default, repeat the previous entry as the 

entry. 

 Section details shows the calculated section properties for the compound 

section.  

Attribute name 

The full name of the geometric line attribute added to the  Treeview will include 

the Attribute name followed by an automatically created description based upon the 

number of section library items used. The description appended to the attribute name 

cannot be edited. 

Once defined, the geometric section properties are added to the  Treeview using the 

OK or Apply button. The section is then available for assigning to the appropriate 

lines on the model (or elements in a mesh-only model). Assigned beam section 

properties may be fleshed using the fleshing button  or from the  Attributes 

Treeview. 

Notes 

 This facility is not appropriate for sections which are welded to form a closed 

section. Where sections are in contact no connection will be modelled between 

them in the calculation of the torsion constant and shear stress. The calculated 

torsion constant is the sum of the torsion constants for the component sections. 

 For sections consisting of components that are to act compositely, the Arbitrary 

Section Property Calculator should be used to obtain a more accurate 

calculation of the torsion constant and shear areas. 

 Sections can be defined which overlap but no attempt is made to subtract the 

missing material from one section where it overlaps another. If this condition is 

detected a warning is given. 

 Where materials are defined in the section for the calculation of modular ratios, 

the compound section should only be assigned to lines using the same material 

as the section’s reference material. 
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 Where different materials are specified, the plastic neutral axis and plastic 

section modulus are not calculated because the ratio of yield strengths is not 

available. 

 Where different materials are specified note that the self weight due to gravity 

is calculated based on the original areas and the associated densities of the 

individual components that comprise the compound section. However the 

value for the Area as displayed on the Compound Section dialog is for the 

transformed section that was created with and cannot be used directly for 

simple hand-checking of reactions when carrying out basic checks for a model. 

 Compound sections of arbitrary shapes can be defined using the Arbitrary 

Section Property Calculator. 

Material Properties 

Material attributes are defined from the Attributes> Materials menu item and then 

assigned to the required geometric feature (or to mesh objects in a mesh-only model). 

Every part of a finite element model must be assigned a material property attribute. 

Note that not all elements accept all material property types. Refer to the Element 

Reference Manual for full details of valid element/material combinations. 

Material Library 

 The material library contains a range of elastic material properties for 

commonly used structural materials. For some materials in some regions a user-

defined grade of material can also be specified. 

Composite Library 

 The composite library contains a range of commonly used structural 

composite material properties. 

Linear and Nonlinear 

 Isotropic/Orthotropic Defines linear elastic or nonlinear material properties 

with options for plasticity, hardening, creep, damage (continuum or composite, 

viscosity and two-phase materials. 

 Anisotropic Different material properties are specified in arbitrary (non-

orthotropic) directions by direct specification of the modulus matrix. See 

LUSAS Theory Manual 2 for details. 

 Joint Linear and nonlinear joint material models for contact and impact 

analyses using joint elements. 

 Rigidities Allows direct specification of the material rigidity matrix. In-plane 

and bending rigidities are defined from prior explicit integration through the 

element thickness. 
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 Mass material models for specifying mass in structure using non-structural 

mass elements. 

 Bridge Deck (Grillage) For use with Bridge Deck (Grillage) geometric 

attributes when carrying out a grillage analysis. It requires slab, girder and 

reinforcement material to be defined to create a compound material attribute for 

assigning to the lines representing grillage members in a model.  

 Concrete (Nonlinear) Define material to predict the mean behaviour of a 

concrete section due to creep effects, with optional reference to a design code. 

 Concrete (Reinforced) Define reinforced concrete that references linear elastic 

concrete and steel materials provided in the Material Library. 

Tension / Compression Only 

 Tension / Compression Only (Bar) uses the piecewise linear bar material 

model to define a simple no compression (tension-only) or no tension 

(compression-only) or material behaviour. 

Geotechnical 

 Duncan-Chang A simple soil material model whose parameters are calculated 

by curve fitting triaxial test data over a range of cell pressures. 

 Hoek-Brown An elastic-perfectly-plastic constitutive material model suitable 

for the modelling of rock failure. 

 Modfied Cam-Clay A variant of the classic Cam-clay model used for the 

modelling of clays. It is capable of modelling the strength and deformation 

trends of clay realistically. 

 Mohr-Coulomb A material model used to represent dilettante frictional 

materials that exhibit increasing shear strength with increasing confining stress 

(for example, granular soils or rocks). The model incorporates isotropic 

hardening and dilatancy, and only allows tension if cohesion is included. 

 Modified Mohr-Coulomb A material model that applies a tensile and/or a 

compressive cut-off to the Non Associated Mohr-Coulomb model. 

 Tresca An elasto-plastic Tresca yield surface model that may be used to 

represent ductile behaviour of materials which exhibit little volumetric strain 

(for example, metals). The model incorporates elasto-plastic behaviour with 

isotropic hardening. 

 Drucker-Prager A material model used to represent the ductile behaviour of 

materials which exhibit volumetric plastic strain (for example, granular 

materials such as concrete, rock and soils).  

 Interface materials available include Mohr-Coulomb Friction Interface, 

which permits the modelling of a standard elastic-plastic sliding interface as 

well as strain hardening, softening and dilation, and Elasto-plastic Interface, 

file:///C:/SVN/Content/6analysi/idh_grillage%20analysis.htm
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which is used to represent the friction-contact relationship within planes of 

weakness between two discrete bodies. 

 

Specialised 

 Interface Delamination, which is a material model assigned to interface 

elements to model delamination between elements. Elasto-plastic Interface 

and Mohr-Coulomb Friction Interface material models are available. 

 Rubber Defines materials with hyper-elastic or rubber-like mechanical 

behaviour. 

 Crushing A volumetric crushing model such as would be used for crushable 

foam-filled composite structures. 

 Generic Polymer Defines a model that consists of a set of Maxwell dampers 

which are used to model visco-elasticity, an Eyring dashpot which is used to 

model viscoplasticity and a linear spring. 

 Generic Polymer with Damage Accounts for strain rate behaviour and 

irrecoverable damage in the modelling of polymers and other polymer-like 

materials. 

 Piecewise Linear Bar for no-tension (compression-only) or no-compression 

(tension only) material modelling for bar elements. 

 Resultant User A user-defined constitutive model defining the stress resultants 

from strain. 

 Nonlinear User A user-defined constitutive model defining the stress from 

strain. 

 

Editing of Material Properties 

Editing of pre-defined material data (such as that provided in the material library) 

allows for viewing both the original material definition input data, as well as 

modifying the values used. Editing of user-defined material properties only permits 

viewing and editing of the values used. Context menu entries for materials present in 

the Attributes Treeview include:  

 Edit Definition... displays the original definition dialog with all the original 

input data intact.  

 Edit Attribute... displays values that can be modified. For materials added 

from the material library, these values may be changed but this breaks the link 

to the original definition dialog and a warning message will be displayed. 

 Edit original definition dialog with all the original input data intact. 
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Defining Temperature Dependent Material Properties 

Temperature dependent properties can be defined for each material in the Attributes 

Treeview by selecting the context menu item Edit temperature dependence… This 

option is not available for licences that only support linear analysis. Once defined, the 

attribute name will be appended with the letters (TD) to signify that Temperature 

Dependent properties have been assigned. These additional properties need to be 

removed from a material attribute prior to editing previously defined general material 

property data. 

Care should be taken when using a table of temperature dependent nonlinear material 

properties. For example, a temperature rise which is subsequently followed by cooling 

could result in a step change increase in Young's modulus, yield stress and other 

plastic properties which violates the first law of thermodynamics. If the temperature 

monotonically increases throughout the analysis and sensible properties are defined in 

the table, then reasonable results should be obtained 

Material Dependency across Analyses / Loadcases 

Materials defined and assigned to features for the first loadcase within a base analysis 

can be optionally inherited by all other analyses. Assigning a different material to 

selected features in a following analysis supercedes any inherited material but for only 

those assigned features. 

General notes 

 Once assigned to geometry, material directions can be visualised using the 

Attributes layer in the Layers  Treeview 

 Material property attributes can be formed into a composite lay-up using the 

composite attribute facility. 

 Rubber, crushing, and plastic material attributes cannot be combined. 

Material Library 

The Material Library contains standard elastic properties for common materials, with 

some defined in accordance with national or international Codes Of Practice, and for a 

range of grades. It can be accessed from the Attributes> Material> Material 

Library menu item.  

Other materials can be defined by making an appropriate selection when using the 

Attributes> Material menu item.  

Materials supported 

The following materials are currently available from the library: 
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 Aluminium  Glass  Steel - Prestressing 

wire 

 Aluminium 

Alloy 

 Graphite  Steel - Reinforcing 

bar 

 Cast Iron  Invar  Steel - Structural 

 Concrete  Polyurethane  Timber 

 Epoxy  Steel - Prestressing bar  Titanium 

 Foam  Steel - Prestressing 

strand 

 Wrought iron 

Standard settings 

By selecting the Material type, Region, Standard and, in some cases, Gradeon the 

dialog, a material attribute is created using appropriate values for Young's modulus, 

Poisson's ratio, Mass density and Coefficient of Thermal expansion. 

The values shown in the material library dialog are in model units, as defined on the 

Model Properties dialog, and therefore may have been converted from values in the 

relevant Code of Practice in other unit sets. For example, the units for Elastic modulus 

of Steel may be given as 29,000ksi in a design code, and for models in kips and feet, 

or Newtons and metres, the value would be converted as appropriate. Note that for 

concrete the values of density displayed are for reinforced concrete and not plain 

concrete, because in LUSAS an allowance is made for reinforcement. 

Advanced settings 

For some materials, and for some regions, a user-defined grade can be specified by 

using the Advanced define drop-list item. One example of this is for a selection of 

Concrete, USA, AASHTO LRFD 7th, where a Compressive strength, Weight and 

Aggregate correction factor can be specified. 

Prestress parameters can also be entered for design codes supported by this facility. 

This currently includes AASHTO (3rd to 8th), EN1991-1-1:2014, EN1992-2:2005 and 

IRC:112-2011. 

General notes 

 For concrete, in general, Codes of Practice give a secant modulus of elasticity, 

which is strictly only applicable to transient (short term) loads. Under sustained 

loading, concrete creeps. While this may be handled analytically using the 

Concrete Creep materials in LUSAS, approximations may be made, for which 

many Codes of Practice would require the derivation of an appropriate "long 



  Chapter 5 : Model Attributes 

    

267 

term" elastic modulus based on the age of concrete, length over which load is 

sustained, cement class etc. As such this is not generally covered by the 

Material Library. It is, however, possible to create a material attribute from the 

library and subsequently edit the value of the Elastic Modulus by right-clicking 

on the attribute in the  Treeview and selecting the Edit Attribute option, 

typically dividing the secant modulus by a factor to account for creep (typically 

dividing by a value in the range 2 to 4) as determined from the rules in the 

relevant Code to give a suitable "long-term" value. 

 Some Codes of Practice do not give complete data for elastic material 

properties, most commonly omitting a value for Poisson's ratio e.g. BD21/01 

(UK), RT/CE/C/025 (UK), IRC:21 and IS456 (India). In such cases, a value 

has been obtained from another national Code from the same country or, where 

this is not possible, another suitable reference. 

 Mass density is in units of mass/volume. In some Codes of Practice e.g. 

AASHTO (USA), CAN/CSA-S6-06 (Canada), Eurocodes, and IS456 (India), 

the Code of Practice gives only a Unit Weight (units of force/volume). In such 

cases, the value shown in the dialog and used in the model is converted by 

dividing by the acceleration due to gravity in the appropriate units. As 

described above, the values are in model units, and may have been converted 

from the values in the Code of Practice. 

 The material attribute name that is provided will also automatically include a 

description formed from the selections made, when the material is added to the 

Attributes  Treeview. 

 To define a user-defined linear elastic material model see 

"Isotropic/Orthotropic Material" on page 268 

Usage 

 Pick the material type and options required from the drop -list and click OK or 

Apply to add the material properties to the Attributes  Treeview. Values 

can be modified and other material properties can be defined once the material 

has been added to the Attributes  Treeview. The material properties may 

then be assigned to appropriate features of the model. 

 If material properties held in the materials.csv file have been updated, re-

selecting the material grade on the Material Library dialog for a previously 

defined material will re-load the updated properties into the dialog. 

Composite Library 

The composite library contains a range of structural composite material properties. It 

can be accessed from the Attributes> Material> Composite Library menu item. 
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Composite material units will default to those specified on the Model Properties dialog 

but may be changed if desired.  

Usage 

 Pick the composite material required from the drop down list and click OK or 

Apply to add the properties to the  Treeview. The composite material 

properties may then be used to define a composite stack, or be assigned to 

selected features of the model. 

Isotropic/Orthotropic Material 

Isotropic material (properties are the same in all directions) and orthotropic material 

(properties in the two or three principal directions may differ) attributes can be defined 

using the Attributes > Material menu item. The following material properties can be 

specified. 

For a structural analysis: 

 Elastic is used to specify linear elastic material properties including Young’s 

modulus, Poisson’s ratio, and mass density. Optional thermal expansion and 

dynamic constants can be specified. Orthotropic material orientation is 

specified as global, relative to a local coordinate system or relative to the 

feature local axis system. Orthotropic models are Plane stress, Plane strain, 

Thick, Axisymmetric, Solid. Note that not all elements accept all the 

orthotropic models. Refer to the Element Reference Manual for full details of 

valid element/material combinations. For geotechnical analyses that do not 

include a two phase material definition, the mass density must relate to the total 

mass of the soil, including the mass of any water content in the voids. The soil 

may be saturated, partially saturated or dry. For geotechnical analyses that 

include a two phase material definition, the fully saturated soil density must be 

stated. If, for two-phase material, it is required to define soil grain density 

instead of fully saturated soil density, visit the Attributes tab of the Model 

Properties dialog and select the 'Input soil grain density for two-phase 

materials' option. 

 Plastic is used to model ductile yielding of nonlinear elasto-plastic materials 

such as metals, soils/rocks/sand. See headings below for range of materials 

supported. 

 Hardening Used to model a nonlinear hardening curve data. Hardening is 

defined as part of the plastic properties. Isotropic, Kinematic and Granular sub-

types are available. Isotropic hardening can be input in three ways. 

 Creep is used to model the inelastic behaviour that occurs when the 

relationship between stress and strain is time dependent. 
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 Damage is used to model the initiation and growth of cavities and micro-

cracks. 

 Shrinkage is used to define the shrinkage properties of a material as a 

piecewise linear curve.  

 Viscosity is used to model viscoelastic behaviour. Coupling of the viscoelastic 

with nonlinear elasto-plastic materials enables hysteresis effects to be 

modelled. 

 Two-phase material properties are required when performing a consolidation 

analysis (or a drained / undrained analysis), in which two-phase elements are 

used to define soil in either a fully or partially saturated state. 

 Ko Initialisation is used to define initial stresses in soils. 

Plastic Material Models (Isotropic) 

The following Isotropic material models are available from the Attributes > Material 

> Isotropic menu item by choosing the Plastic check box on the material attribute 

dialog. 

 Stress Resultant (model 29) Applicable to certain beam and shell elements 

 Tresca (model 61) Represents ductile behaviour of materials which exhibit 

little volumetric strain (for example, metals and undrained clays). Incorporates 

isotropic hardening. 

 Stress Potential general nonlinear properties based on von-Mises or modified 

von-Mises criterion including hardening. 

 Optimised implicit von Mises (model 75) Represents ductile behaviour of 

materials which exhibit little volumetric strain (for example, metals). Especially 

for explicit dynamics. 

 Modified Mohr Coulomb This model applies a tensile and/or a compressive 

cut-off to the standard Mohr-Coulomb model. In tension this prevents 

unrealistic tensile stresses developing in materials such as soil or rock. In 

compression the cut-off results in irreversible deformations once the maximum 

compressive stress is exceeded. The cut-off can be applied to either a single 

principal stress component or to the mean pressure. 

 Mohr-Coulomb (model 65) with non-associative flow. Represents materials 

which exhibit volumetric plastic strain but no volumetric strain during shear. 

(for example, granular materials such as rock and soils). Incorporates isotropic 

hardening. 

 Drucker-Prager (model 64) Represents ductile behaviour of materials which 

exhibit volumetric plastic strain (for example, granular materials such as 

concrete and soils). Incorporates isotropic hardening. 
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Plastic Material Models (Orthotropic) 

These material models are available from the Attributes > Material > Orthotropic 

menu item by choosing the Plastic check box on the material attribute dialog. 

 Stress Potential (Hill and Hoffman models)The stress potential model 

defines nonlinear material properties applicable to a general multi-axial stress 

state requiring the specification of yield stresses in each direction of the stress 

space. Incorporates hardening, yield stress and Heat fraction. Hoffman is a 

pressure dependent material model allowing for different properties in tension 

and compression. 

For a thermal analysis: 

 Isotropic Specify properties for general thermal and concrete heat of hydration 

analysis. 

 Orthotropic Specify properties for general thermal and concrete heat of 

hydration analysis. 

 Thermal Link (Linear) Thermal links are used to analyses heat conduction at 

contacting interfaces. 

 Thermal Link (Nonlinear) Thermal links are used to analyses heat conduction 

at contacting interfaces. 

 Thermal (User) For advanced use. Used to enter material parameters for user 

nonlinear thermal material models. 

For a hygro-thermal analysis: 

 Isotropic Specify properties for a hygro-thermal analysis. For concrete heat of 

hydration analysis, where internal heat is generated by the chemical reaction 

between cement and water as concrete hardens, additional thermal options such 

as exotherm type and cement type can be specified. See Concrete Heat of 

Hydration for details. 

Rigidity 

The linear rigidity model is used to define the in-plane and bending rigidities from 

prior explicit integration through the element thickness. 

Notes 

 Angle of orthotropy is relative to the reference axis (degrees). 

 The element reference axes may be local or global (see Local Axes in the 

Element Reference Manual for the proposed element type). If the angle of 

orthotropy is set to zero, the anisotropy coincides with the reference axes. 
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See the Solver Reference Manual for further details. 

Mass 

Mass material models are used in conjunction with non-structural mass elements to 

define mass in a structure. Mass Properties are input for element nodes in the element 

local translational (x, y or z) directions or relative to the local coordinate system 

assigned to the feature. 

See the Element Reference Manual for further information. 

Thermal Material Properties 

Thermal isotropic materials can be defined accessed using the Attributes> Material> 

menu item, providing a thermal analysis entry is present in the Analyses Treeview. 

Isotropic thermal material is applicable to all thermal elements except thermal links 

(see the Element Reference Manual) 

Thermal material properties are used to define the thermal behaviour of a material 

when using Thermal (Field) elements. The thermal properties describe the way in 

which heat flows. Heat may be transferred through conduction, convection or 

radiation. For linear steady state heat transfer problems only the conductivity needs to 

be specified.  

 Use isotropic material for materials in which the conductivity is constant in all 

directions.  

 Use orthotropic material when conductivity varies in different directions. The 

direction of orthotropy is defined relative to any local coordinate systems. 

For transient thermal analysis the material properties require a volumetric heat 

capacity to be entered. This is the product of the density and the Specific Heat 

Capacity (*C) 

If phase change is to be modelled the latent heat (of phase change) must be specified. 

Two phase changes models are available . When carrying out a phase change it is 

recommended that lumped specific heat (OPTION 105) is used. This is specified in the 

Model Properties> Solution> Element Options dialog by choosing the lumped mass 

option.  

For heat of hydration analysis, where internal heat is generated by the chemical 

reaction between cement and water as concrete hardens, additional thermal options 

such as exotherm type, cement type and timescale units can be set.  

LUSAS Solver can model temperature dependent properties but this needs to be 

defined in the Solver datafile. See the Solver Reference Manual for further details. 
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Thermal Material (Isotropic) 

Isotropic thermal material is used to represent thermal properties which are identical in 

each direction. It is applicable to all thermal elements except thermal link elements - 

for which thermal link material properties must be defined.  

 For general thermal analysis: 

 Phase change state is required to be specified if a material changes state, i.e. it 

boils, liquefies or solidifies in the temperature range under consideration. 

Options are None, DelGiudice, and Lemmon. If phase changes are indicated 

then the thermal mass effects of the material will be calculated from the latent 

heat (of phase change) values entered and not from the specific heat capacity 

values. 

 Thermal conductivity is required in all cases 

 Specific heat capacity is only required for transient analysis. 

 Density is required in all cases 

 Latent heat (of phase change) is only listed for phase change analysis. 

Exothermic behaviour 

For the specific case of concrete heat of hydration analysis, where internal heat is 

generated by the chemical reaction between cement and water as concrete hardens, 

exothermic behaviour settings and values can be specified: 

 None No exothermal reaction is to take place. 

 Concrete heat of hydration when selected, provides the means to specify the 

following cement types: I, II, IV, V and General, with each requiring 

additional parameters to be specified. See Concrete Heat of Hydration for 

more details. 

Timescale units used for heat of hydration analysis are those specified for the model 

when first defined, or as specified on the Model properties dialog. 

 If stress in the concrete due to the hydration process is required a coupled analysis 

should be carried out. 

Thermal Material (Orthotropic) 

Thermal orthotropic material is valid for 2D membrane plane field or 3D solid field 

elements. 

 For general thermal analysis: 

 Phase change state is required to be specified if a material changes state, i.e. it 

boils, liquefies or solidifies in the temperature range under consideration. 

Options are None, DelGiudice, and Lemmon. If phase changes are indicated 
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then the thermal mass effects of the material will be calculated from the latent 

heat (of phase change) values entered and not from the specific heat capacity 

values. 

 Thermal conductivity in x, y and z directions can be specified independently. 

 Angle of orthotropy may be specified to rotate the material reference axes 

with respect to the reference axes. 

 Specific heat capacity is only required for transient analysis.  

 Latent (heat of phase change) is only required and listed for phase change 

analysis. 

 Density is required in all cases. 

Exothermic behaviour 

For the specific case of heat of hydration analysis, where internal heat is generated by 

the chemical reaction between cement and water as concrete hardens, additional 

options and values can be set by selecting the Concrete heat of hydration option. 

 Concrete heat of hydration when selected, provides the means to specify the 

following cement types: I, II, IV, V and General, with each requiring 

additional parameters to be specified. See Concrete Heat of Hydration for 

more details. 

Timescale units used for heat of hydration analysis are those specified for the model 

when first defined, or as specified on the Model properties dialog. 

 If stress in the concrete due to the hydration process is required a structural/thermal 

coupled analysis should be carried out. 

Thermal Link Material (Linear) 

Thermal link material is defined from the Attributes > Material menu. 

Thermal links are used to analyses heat conduction at contacting interfaces. 

Specify the thermal link properties that will be used. 

 Gap conductance   

 Convective heat transfer coefficient   

 Radiative heat transfer coefficient 

 Variation of gap conductance with distance   

 Variation of gap convective coefficient with distance   

 Variation of radiative coefficient with distance 
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Thermal link material (Nonlinear) 

Thermal link material is defined from the Attributes > Material menu  

Specify the thermal link properties that will be used. 

 Conductance   

 Convective coefficient   

 Radiative coefficient 

 Total distance   

Thermal User (Nonlinear) 

For advanced use allowing entering of material parameters for user-defined nonlinear 

thermal material models. Required inputs are: 

 User material model number The defined material model number 

 Number of state variables The number of variables required for storing results 

at gauss points 

 Values Input parameters for the user-defined material model listed in the order 

that they are required 

Hygro-thermal Material (Isotropic) 

Hygro-thermal isotropic materials can be defined accessed using the Attributes> 

Material> menu item, providing a hygro-thermal analysis entry is present in the 

Analyses Treeview. If it is not, use the Analyses > Hygro-Thermal Analysis menu 

item to create one. Isotropic hygro-thermal material is applicable to all thermal 

elements except thermal links (see the Element Reference Manual) 

For a hygro-thermal analysis two material types are available: 

 Hygro-thermal concrete (for concrete) 

 Hygro thermal (for general use, and for use with concrete) 

Hygro-thermal material properties are applicable to hygro-thermal elements only. If a 

hygro-thermal element is to represent a non-porous material (e.g. steel) it should be 

assigned thermal isotropic properties. 

Initial values must be specified explicitly; they cannot be computed by a steady state 

analysis as is the case for a transient field problem. To aid in specifying these values 

relevant equations, notes and references are provided. 

Hygro-thermal concrete material 

Density and specific heat capacity can be defined for either Kiln dry concrete or 

Concrete at ambient conditions. 



  Chapter 5 : Model Attributes 

    

275 

Porosity can be Automatically determined or Specify. See the Porosity entry below 

for details. 

General parameters: 

 Thermal 

conductivity   

 

where 

 

Examples, units [J/s.m.K] 

 

See References 

 
 

 Specific heat 

capacity 

and  

 Density   

Specific heat capacity and density are calculated from: 

 

where: 

 

Examples, units [as shown] 
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See References 

Specific heat and density are used to compute the volumetric 

heat capacity . This property is assumed to be either 

experimentally determined for the concrete as a whole (option: 

Concrete at ambient condition) or it is computed via the rule of 

mixtures of the volumetric heat capacities of its constituents. 

 

where 

 

  

 Permeability   

 

 

 

 

Care should be taken not to mix these two permeabilities when 
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data is taken from the literature. 

  

 Entrapped 

air volume 

ratio 

This is only listed if the Exothermic behaviour option 'Concrete 

heat of hydration' is chosen on the same dialog. 

  

 Porosity  
This is only listed if the Porosity option 'Specify' is chosen. 

For cured, old concrete a porosity value must be input and it 

stays constant during the analysis. A typical value would lie 

between 0.08 to 0.17 with lower values being used for concrete 

with higher strength.  

For curing concrete, i.e. one with heat of hydration, initial and 

final porosities are automatically determined. The initial porosity 

will accommodate the amount of liquid water and entrapped air. 

The final porosity is calculated from the degree of hydration on 

the 28th day , the composition of the concrete and empirical 

data. Intermediate values are linearly interpolated as function of 

the degree of hydration .  

  

References 

(*) adapted from 'BS EN 1992-1-2:2004 Eurocode 2. Design of concrete structures. 

General rules. Structural fire design' to best fit given quadratic relation for the 

temperature interval 20 to 90 degrees Celcius. 

(B1) Z. P. Bazant, M. F. Kaplan. Concrete at high temperatures, Longman 1996. 

(E1) 'BS EN 1992-1-2:2004 Eurocode 2. Design of concrete structures. General rules. 

Structural fire design.' 

Exothermic behaviour 

For concrete heat of hydration analysis, where internal heat is generated by the 

chemical reaction between cement and water as concrete hardens, exothermic 

behaviour settings and values can be specified as: 

 None No exothermal reaction is to take place. 

 Concrete heat of hydration when selected, provides the means to specify the 

following cement types: I, II, IV, V and General, with each requiring 

additional parameters to be specified. See Concrete Heat of Hydration for 

more details. 
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Timescale units used for heat of hydration analysis are those specified for the model 

when first defined, or as specified on the Model properties dialog. 

If calculation of stress in the concrete due to the hydration process is required a 

coupled hygro-thermal/structural analysis should be carried out. 

Advanced properties 

Calculation of thermal conductivity 

 Thermal conductivity depends upon water saturation (when checked varies 

conductivity with water saturation. When unchecked is constant) 

General parameters: 

 Tortuosity coeffiecient Diffusion of water vapour in air is governed by the 

mean free path or average distance between collisions for the gas molecules. 

The tortuosity coefficient accounts for the reduced diffusion due to collisions 

with the walls of the concrete twisted pore network. 

 

where 

 

 Latent heat of evaporation The latent heat of water evaporation depends on 

the temperature. An averaged value of H=2.4x10
6
 [J/kg] can be used for the 

usual temperature range of concrete hygro-thermal analyses. When water 

vapour is transferred into the concrete by environmental loading and 

subsequently condenses and increase the water saturation, Sw, heat is released 

proportional to H. When liquid water is transferred to the concrete by a 

prescribed loading with RH=1.0 the increase of saturation should not require 

release of latent heat. For these elements, during the duration of this load, the 

latent heat is set to zero, H=0. 

 Change of thermal conductivity with temperature See note.  

 Change of specific heat capacity with temperature See note.  

 Change of density with temperature See note. 
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Note. Change of thermal / specific heat capacity / density with temperature options 

allow for increase / decrease of parameters according to temperature (linear variation). 

For example, change in thermal conductivity / degree Celcius, the units are J/s.m K/K 

= J/s.m. 

Darcy's equation  

Darcy's equation describes the flow of fluid through a porous medium. Choose either 

Use gravity, Exclude gravity or Specify a value for acceleration. 

Hygro-thermal material 

 Hygro-thermal material properties are assumed to be constant with the exception of 

the relative water permeability, which is a function of the water saturation. 

Darcy's equation  

Darcy's equation describes the flow of fluid through a porous medium. Choose either 

Use gravity, Exclude gravity or Specify a value for acceleration. 

General parameters: 

 Thermal 

conductivity 

is calculated from: 
 

where 

 

Examples, units [J/s.m.K] 

 

See References 
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 Specific heat 

capacity 

and  

 Density 

are calculated from:  

Specific heat capacity and density are calculated from: 

 

where: 

 

Examples, units [as shown] 

 

See References. 

Specific heat and density are used to compute the volumetric 

heat capacity . This property is assumed to be either 

experimentally determined for the concrete as a whole (option: 

Concrete at ambient condition) or it is computed via the rule of 

mixtures of the volumetric heat capacities of its constituents. 

 

where 

 

  

 Latent heat 

(of phase 

The latent heat of water evaporation depends on the temperature. 

An averaged value of H=2.4x10
6
 [J/kg] can be used for the usual 
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change) temperature range of concrete hygro-thermal analyses. When 

water vapour is transferred into the concrete by environmental 

loading and subsequently condenses and increase the water 

saturation, Sw, heat is released proportional to H. When liquid 

water is transferred to the concrete by a prescribed loading with 

RH=1.0 the increase of saturation should not require release of 

latent heat. For these elements, during the duration of this load, 

the latent heat is set to zero, H=0. 

  

 Porosity of 

medium  

 For cured, old concrete a porosity value must be input and it 

stays constant during the analysis. A typical value would lie 

between 0.08 to 0.17 with lower values being used for concrete 

with higher strength.  

 For cured, old concrete a porosity value must be input and it 

stays constant during the analysis. A typical value would lie 

between 0.08 to 0.17 with lower values being used for concrete 

with higher strength.  

  

 Permeability   

 

 

 

 

Care should be taken not to mix these two permeabilities when 

data is taken from the literature. 

  

 Tortuosity 

coefficient 

 Diffusion of water vapour in air is governed by the mean free 

path or average distance between collisions for the gas 

molecules. The tortuosity coefficient accounts for the reduced 

diffusion due to collisions with the walls of the concrete twisted 

pore network. 
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where 

 

  

  

 Acceleration 

X/Y/Z 

component 

This is only listed if the option 'Specify Accelartion' is chosen 

for Darcy's equation. Define acceleration components for X, Y 

and Z. 

  

References 

(*) adapted from 'BS EN 1992-1-2:2004 Eurocode 2. Design of concrete structures. 

General rules. Structural fire design' to best fit given quadratic relation for the 

temperature interval 20 to 90 degrees Celcius. 

(B1) Z. P. Bazant, M. F. Kaplan. Concrete at high temperatures, Longman 1996. 

(E1) 'BS EN 1992-1-2:2004 Eurocode 2. Design of concrete structures. General rules. 

Structural fire design.' 

Bridge Deck (Grillage) Material 

Bridge Deck (Grillage) material is defined by selecting the Attributes > Material > 

Bridge Deck (Grillage) menu item. It is for use with Bridge Deck (Grillage) 

geometric attributes when carrying out a grillage analysis. It requires slab, girder and 

optionally reinforcement (rebar) material to be referenced to create a compound 

material attribute for assigning to the lines representing grillage members in a model. 

Rebar material is only used if cracked section properties are required. 

One material attribute typically requires defining and assigning to appropriate grillage 

members for each loading stage to be considered. For grillage analysis, three such 

material attributes will be required that cover: short-term (for live loads), long term 

(for dead loads) and a ‘bare steel’ condition where the slab material contributes to the 

weight but not the stiffness of the section. 

See grillage analysis for an overview of the procedures involved in modelling 

grillages, and to see where the use of bridge deck (grillage) material attributes may be 

used 

file:///C:/SVN/Content/6analysi/idh_grillage%20analysis.htm
file:///C:/SVN/Content/6analysi/idh_grillage%20analysis.htm


  Chapter 5 : Model Attributes 

    

283 

 

Any materials previously defined in the model will be displayed for selection on the 

Bridge deck (Grillage) material dialog via the drop-list for each entry. 

 By selecting the the New option, pre-defined Slab, Girder or Rebar material in 

the material library can be referenced. 

 For some situations (if modelling and uncracked slab) no girder or no 

reinforcement will be required. For these cases the None option can be chosen. 

 Stiffness and Mass checkboxes for the Slab and Girder entries allow the slab or 

girder to be included as 'stiffness only' or 'mass only', as appropriate. 

When created, up to three material entries appear in the Attributes  Treeview, one 

for each slab, girder and rebar isotropic material defined, together with one compound 

material entry that references those used. Only the compound material attribute should 

be assigned to appropriate lines in the model representing grillage members, prior to 

carrying out a grillage analysis or carrying out any design checks. 
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Validity of assigning material attributes to lines assigned with 

geometric attributes 

 
Geometric assignment 
made to lines 

  Assign Bridge Deck 
(Grillage) material attribute 
to same lines? 

   
Assign Isotropic material 
attribute to same lines? 

Bridge Deck (Grillage) 
geometric attribute 

  Valid   Valid 

Any other geometric attribute    Not valid   Valid 

  

Note. It is possible to assign a Bridge Deck (Grillage) material attribute to an entire 

bridge deck model, regardless of whether that model contains the section types (slab, 

girder and rebar) that are referenced by the material attribute. For example, if assigned 

to a solid slab section type, any girder material specified in the Bridge Deck (grillage) 

material attribute would simply be ignored. 

Concrete Models (Nonlinear) 

Nonlinear concrete material models can be accessed from using the Attributes> 

Material> Concrete (Nonlinear) menu item.  

Concrete models 

Selection of a nonlinear concrete material model provides the means to define concrete 

with or without cracking and crushing. When using the transient smoothed multi-crack 

model (model 105) as used for hygro-thermal/structural coupled analyses, creep and 

shrinkage is obligatory, but for the other models, creep and shrinkage to a Code of 

Practice is optional. 

 Linear with creep/shrinkage (model 86) - This material model uses a 

simplified linear approach (an ageing linear visco-elastic material) to represent 

creep.  

 Transient smoothed multi-crack (model 105) - This concrete model is 

fundamentally the same as concrete model 109, but can only be accessed if a 

hygro-thermal/structural coupled analysis is specified. The material model 

takes into account the effects of heat of hydration, creep and shrinkage, along 

with the hydration dependent evolution of properties E, fc and ft.  

 Smoothed multi-crack (model 109) - This is for modelling cracking and 

crushing behaviour in concrete. It is a plastic-damage-contact model in which 

damage planes form according to a principal stress criterion and then develop 

as embedded rough contact planes. 

The smoothed multi-crack models (models 105 and 109) are for use with 2D and 3D 

continuum elements, 2D and 3D explicit dynamics elements, solid composite elements 

and semiloof or thick shell elements only. The Linear with creep/shinkage model 

(model 86) may additionally be used with 2D and 3D beam elements. 
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Superseded concrete models 

When a pre-version 17 LUSAS model is loaded that uses older versions of concrete 

models such as the Cracking concrete model (model 82), the Cracking with crushing 

concrete model (model 84), or the Multi-crack concrete model (model 94) - those 

models will be listed in the concrete material droplist in addition to the current valid 

concrete models. 

Linear with creep and shrinkage material models 

These material models, based on Linear with creep/shrinkage (model 86), use a 

simplified linear approach (an ageing linear viscoelastic material) to represent creep. 

Since cracking and crushing of concrete are not modelled, this material is appropriate 

for situations where the tensile strength and compressive stress limits (generally 

defined by the Code of Practice) are not exceeded - for example, prestressed concrete 

design. 

Linear creep and shrinkage material models are nonlinear in the time domain. See the 

table for creep and shrinkage support by concrete material model. 

 AASHTO LRFD 5th-7th Edition 

 CEB-FIP Model Code 1990   

 EN1992-1-1:2004 Eurocode 2   

 fib Model Code 2010 

 IRC:112-2011   

 JTG 3362-2018   

 User - Only supported by Transient smoothed multi-crack (model 105). 

Permits user-defined parameters to be specified. 

For linear elastic concrete material models see those provided in the "Material 

Library" on page 265 

Creep only material models 

 Zhu (1999) - Mass concrete (China)- Based upon 'Thermal stresses and 

temperature control of mass concrete' by Zhu Bofang. This allows creep of 

concrete to be computed as concrete ages while subjected to external forces, 

including thermal stresses that may be due to the hydration process. Shrinkage 

is not included. 
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Creep and shrinkage support by concrete material model 

  LUSAS concrete model 

 
Design code 

Linear with creep and 
shrinkage (model 86) 

Transient smoothed 
multi-crack (105) 

Smoothed multi-crack 
(model 109) 

AASHTO LRFD 7th 
Edition 

Creep and shrinkage 
supported 

Not supported Creep and shrinkage 
supported 

CEB-FIP Model Code 
1990 

Creep and shrinkage 
supported 

Creep and shrinkage 
supported 

Creep and shrinkage 
supported 

EN1992-1-1:2004 
Eurocode 2 

Creep and shrinkage 
supported 

Creep and shrinkage 
supported 

Creep and shrinkage 
supported 

fib Model Code 2010 Creep and shrinkage 
supported 

Not supported Creep and shrinkage 
supported 

IRC:112-2011 Creep and shrinkage 
supported 

Not supported Creep and shrinkage 
supported 

JTG 3362-2018 Creep and shrinkage 
supported 

Not supported Creep and shrinkage 
supported 

User Not supported Creep and shrinkage 
supported 

Not supported 

Zhu (1999) - Mass 
concrete (China) 

Creep only supported Not supported Creep only supported 

  

Notes 

 When a Structural analysis is being carried out the Linear with 

creep/shrinkage concrete model (model 86) and the Smoothed multi-crack 

concrete models(105 and 109) are available.  

 When a Coupled Hygro-Thermal/Structural analysis is being carried out, 

the Transient smoothed multi-crack concrete model (Model 105) should be 

used. 

 Refer to the help pages for each design code for more information. 

See the Solver Reference Manual and the Theory Manual for further details of all 

models. 

Concrete Creep and Shrinkage to AASHTO LRFD 5th to 7th 

editions 

Concrete material properties to AASHTO LRFD 5th - 7th edition are defined from the 

Attributes> Material> Concrete (Nonlinear) menu item.  

This material model is based upon the concrete creep and shrinkage rules set out in 

AASHTO LRFD Bridge Design Specifications 7th Edition Article 5.4.2.3. (which are 
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identical to those in 5th and 6th editions). Note that this code and associated 

commentary offer different instructions for calculating creep coefficients. 

LUSAS allows you to choose between them: 

 Creep coefficient can be calculated according to Article 5.4.2.3.2, or to the 

corresponding Commentary, adjusted according to AASHTO LRFD 2nd 

Edition. 

 Shrinkage strain can be determined using the factor for the effect of volume-to-

surface ratio (ks) from equation 5.4.2.3.2-2, or from the Commentary equation 

C5.4.2.3.2-2. 

 Early age elastic modulus and compressive strength can be determined using 

the approximation of article 5.4.2.3.2, or by reference to CEB-FIP Model Code 

1990 clause 2.1.6.1 

As per Article 5.4.2.3.1, the AASHTO provisions may be regarded as applicable for 

specified concrete strengths up to 15.0 ksi, with the caveat that the Commentary 

indicates that “Without specific physical tests or prior experience with the materials, 

the use of the empirical methods... cannot be expected to yield results with errors less 

than ±50 percent”. 

References cited are to AASHTO LRFD Bridge Design Specifications 7th Edition 

unless otherwise stated. It should be noted that AASHTO 8th and 9th edition differ 

from the 7th due to two modifications - the Concrete modulus of elasticity (eqn 

5.4.2.4-1) and the coefficient for time dependency which is used for creep and 

shrinkage (eqn 5.4.2.3.2-5). Whether AASHTO 7th can be deemed acceptable for use 

on projects should be determined by the Project Team on a case-by-case basis. 

Material Properties 

The following material parameters are required depending upon other settings made on 

the dialog. All parameters relate to when 'Elastic modulus from strength and weight 

class' is selected, unless where noted: 

 Young's modulus This value is only required to be entered if the option 'Input 

elastic modulus and density' is used. In other cases, the modulus of elasticity is 

determined from the compressive strength, weight class and aggregate 

correction factor, using equation 5.4.2.4-1. A default value of Ec=4070 ksi is 

given, corresponding to normal weight concrete with f'c = 5.0ksi and an 

aggregate correction factor of K1=1.0. The value entered may either be used 

directly or modified for early age stiffness gain by selecting the option 'Modify 

using CEB-FIP 1990'.  

 Poisson’s Ratio - The default is ν=0.2 as per article 5.4.2.5. 

 Mass density ρ. This value is only required to be entered if the option 'Input 

elastic modulus and density' is used. In other cases, the density is determined 
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from the weight class using Table 3.5.1-1. A default value of ρ =0.145/32.2 

kslug/ft³ is given, corresponding to normal weight concrete with f’c = 5.0ksi. 

 Coefficient of thermal expansion Available when the 'Thermal properties' 

check box is selected. This may be taken as α=6E-6/°F according to Article 

5.4.2.2. 

 Mass Rayleigh damping constant Available when 'Dynamic properties' check 

box is selected. 

 Stiffness Rayleigh damping constant Available when 'Dynamic properties' 

check box is selected. 

Properties for use in creep and shrinkage calculations: 

 Weight class need only be specified if the option 'Elastic modulus from 

strength and weight class' is selected. The droplist options then correspond to 

Table 3.5.1-1 i.e. Lightweight, Sand-Lightweight and Normal Weight (the 

default). The appropriate value unit weight, wc, is determined from Table 3.5.1-

1 and used for calculation of the modulus of elasticity using equation 5.4.2.4-1, 

and also to determine the density, ρ, for structural loading purposes. 

 Uniaxial compressive strength f’c. The value entered is used in the 

determination of the early age compressive strength for the concrete (using the 

approximation of article 5.4.2.3.2 or by reference to CEB-FIP Model Code 

1990 clause 2.1.6.1, depending on the option selected). It is also used in the 

determination of Elastic modulus from equation 5.4.2.4-1 when the option 

“Elastic modulus from strength and weight class” is selected. A default value of 

f'c=5.0ksi is given. 

 Aggregate correction factor This value is only required to be entered if the 

option 'Elastic modulus from strength and weight class' is selected. The value 

of K1 would then be used for calculation of the modulus of elasticity using 

equation 5.4.2.4-1. A default of K1=1.0 is given as per Article 5.4.2.4. 

 Cement type need only be specified if the early age elastic modulus and 

compressive strength is to be determined according to the option “Modify using 

CEB-FIP 1990”. The properties in question are determined from CEB-FIB 

Model Code 1990 clauses 2.1.6.3 and 2.1.6.1 respectively and accordingly the 

droplist options are: SL (slow) (slow hardening cements), N and R (normal 

and rapid)  (normal and rapid hardening cements), or RS (rapid high 

strength)  (rapid hardening high strength cements). Cement type 'N and R 

(normal and rapid) is the default option. 

 Relative humidity - is used in the calculation of both creep coefficient and, 

where required, shrinkage. Typical percentage values would lie in the range 

30≤H≤81 from Figure 5.4.2.3.3-1. The default value is H= 70%. 
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 Internal perimeter factor or Volume to surface ratio appear depending upon 

selections made on the Options dialog. See 'Notional section size' for more 

details. 

Thermal properties 

When specified, requires the coefficient of thermal expansion to be defined. 

Dynamic properties 

When specified, requires Mass Rayleigh and Stiffness Rayleigh damping constants to 

be defined. 

Options 

Creep coefficient 

The creep coefficient is calculated using one of two available methods, described 

below. It may be appropriate to compare the two approaches for structures which have 

a high sensitivity to creep. 

 Using article 5.4.2.3.2 This option calculates the creep coefficient using eqn 

5.4.2.3.2-2 to determine ks (the factor for the effect of the volume-to-surface 

ratio of the component), rather than using the alternative commentary clause. 

This option is fully compliant with AASHTO 7th but is using an approach 

described in the commentary as 'an approximation' for the value of ks. 

 Using commentary and 2nd Edition This option calculates the creep 

coefficient using the commentary clause C5.4.2.3.2-2 to determine kc, which is 

used in place of ks. This approach may lead to values of kc<1.0 for sections 

thicker than 1.5" and, in tests, gave creep effects somewhat lower than the 

expected range. Comparison with the 2nd edition identified the original use of 

kc with a 3.5 multiple in the creep coefficient, rather than 1.9 as in later 

editions. Accordingly this option adopts the 3.5 multiple, also capping the ratio 

V/S at a notional thickness of 6", and has been found to give creep effects 

within the expected range for the tests undertaken; less conservative than those 

arising from the use of article 5.4.2.3.2 above for all sections >1" thick. This 

option is therefore not fully compliant with AASHTO 5th to 7th but may be 

deemed to be a more accurate approach. 

In either case, coefficients kf and ktd for creep may be evaluated using the 

approximation for f'ci of article 5.4.2.3.2 or by reference to CEB-FIP Model Code 1990 

clause 2.1.6.1, depending on the option selected. 

Shrinkage strains 

Shrinkage strains can also be determined by one of two available methods, described 

below. It may be appropriate to compare the two approaches for structures which have 

a high sensitivity to shrinkage. 
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 Using equation 5.4.2.3.2-2 This option calculates the strain due to shrinkage 

using eqn 5.4.2.3.2-2 to determine ks (the factor for the effect of the volume-to-

surface ratio of the component), rather than using the alternative commentary 

clause. Eqn 5.4.2.3.2-2 leads to values of ks≥1.0 and, in tests, gave shrinkage 

effects ranging from those within the expected range to those somewhat larger. 

This option is fully compliant with AASHTO 5th to 7th but is using an 

approach described in the commentary as 'an approximation' for the value of ks. 

 Using commentary This option calculates the strain due to shrinkage using the 

commentary clause C5.4.2.3.2-2 to determine ks, capping the ratio V/S at a 

notional thickness of 6". The commentary may lead to values of ks<1.0 for 

sections thicker than 1.5", and, in tests, gave shrinkage effects ranging from 

those in the expected range to those somewhat lower. This option is fully 

compliant with the commentary approach set out in AASHTO 5th to 7th, and 

therefore may be deemed to be a more accurate approach, however, caution is 

recommended. 

In either case, coefficients kf and ktd for shrinkage are evaluated using the 

approximation f'ci=0.8*f'c as the appropriate age for determining f'ci in the context of 

shrinkage is not properly defined in the Code of Practice. 

Calculation of volume-to-surface section size 

Volume-to-surface ratio can be specified directly, or calculated automatically for beam 

members and shell members, using one of the options below: 

 Calculate using section dimensions or thickness (lines and surfaces) The 

volume-to-surface ratio is calculated as V/S = Ac/u where Ac is the cross-

sectional area and u is the length of the perimeter of the cross section that is in 

contact with the atmosphere - both externally and internally if voids are present. 

For shells, the V/S ratio is half the assigned geometric thickness. The 

computation is carried out for each element, and for varying sections along 

lines, the value will vary along the line. 

 Adjusted using internal perimeter factor for voids (lines only) Available for 

the Linear with creep/shrinkage model (Model 86) only. The calculation for 

V/S is as described above, except that u = uo + ks × ui where ks is the internal 

perimeter factor specified, ui is the internal perimeter of any voids in a beam 

section (e.g. the cell of a box girder), and uo the remaining (outer) perimeter. 

This enables V/S to be calculated in accordance with Article 5.4.2.3.2 i.e. to 

make a suitable allowance for poorly ventilated enclosed cells; the Article 

indicates that an internal parameter factor of 0.5 is generally appropriate. For 

element types other than beams, and for beam sections without voids the value 

of internal perimeter factor is irrelevant. 

 Specified directly (any geometry type) The volume-to-surface ratio stated 

should be appropriate to the model units. 



  Chapter 5 : Model Attributes 

    

291 

Elastic modulus and compressive strength for creep 

calculation for age < 28 days 

 Modify using CEB-FIP 1990 When this option is selected, coefficients kf and 

ktd for creep are calculated using CEB-FIP Model Code 1990 clause 2.1.6.1, 

and the elastic modulus for concrete of less than 28 days age using clause 

2.1.6.3. This option requires definition of 'Cement type' in the main parameters. 

 Use 28 day values When this option is selected, coefficients kf and ktd for creep 

are calculated using the approximation for f'ci of Article 5.4.2.3.2, and the 

elastic modulus for concrete used is not adjusted from that entered in the main 

parameters (or determined from equation 5.4.2.4-1). 

Notes 

 Timescale units, which may be viewed and modified on the Model properties 

dialog, must be set to 'Days'. 

 The time management facility (available in Bridge and Civil software 

products) provides the means to manage a simple construction schedule and 

easily adjust the duration of pre-defined construction stages in a staged 

construction analysis. 

 The age of concrete at the time an element is introduced to the analysis, along 

with the age at onset of drying shrinkage, must be defined using an Age 

attribute. The age attribute offers an option to calculate this age with an 

adjustment for elevated or reduced temperatures during curing (prior to 

loading). The adjustment is not specified in AASHTO, but the same rule 

appears in every Code of Practice which has this rule. 

 If not using the time management facility, this creep and shrinkage material 

can only be used in an analysis where nonlinear and transient controls are 

added, with both nonlinear and time domain options switched on and the time 

domain set to 'Viscous'. 

 An option exists in the advanced time step options to use an exponent to 

increase the time step as the analysis progresses. This is appropriate to the 

development of creep and shrinkage with time - more rapidly when the 

concrete is first cast and more slowly as it matures. 

 When the Solver data file is created, time values are tabulated in seconds 

regardless of the model units specified. 

See the Solver Reference Manual and the Theory Manual for further details. 

file:///C:/SVN/Content/Bridge/Time_Management/time_management.htm
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Concrete Creep and Shrinkage to CEB-FIP Model Code 1990 

Concrete material properties to CEB-FIP Model Code 1990 are defined from the 

Attributes> Material> Concrete (Nonlinear) menu item 

Creep behaviour for compressive stresses ≤0.4*fcm(t0) is according to eqn 2.1-73a, 

with nonlinear behaviour for higher stress levels according to eqn 2.1-73b. Clause 

2.1.6.4.3(d) indicates that the model is not valid for stress levels >0.6*fcm(t0). 

Clause references cited are for 'CEB-FIB Model Code 1990 Comite Euro-International 

du Beton, Thomas Telford, 1991', unless otherwise stated. 

Material Properties 

The following material parameters are required: 

 Young's modulus - the tangent modulus of elasticity of concrete at 28 days, 

Eci. This value is typically determined from equation 2.1-15, adjusted for 

aggregate type according to the commentary to clause 2.1.4.2. Table 2.1.6 gives 

values in the range 27×10³ ≤ Eci ≤ 44×10³ MPa. Taking into account the 

adjustment for aggregate, the expected range of values is therefore 18×10³ ≤ Eci 

≤ 53×10³ MPa. The default value of Eci = 36×10³ MPa corresponds to Grade 

C40 concrete and quartzite aggregate. 

 Poisson’s Ratio - will lie in the range 0.1 ≤ νc ≤ 0.2 according to clause 2.1.4.3. 

A value of νc = 0.2, corresponds to an uncracked section, acknowledging the 

primary use of the creep material in prestressed concrete where cracking is 

intended to be avoided. When using the Smoothed multicrack concrete 

material (model 109), a value of vc=0.2 is also recommended since the 

concrete would be uncracked at the start of the analysis. The use of lower 

values of vc may lead to inaccurate results. 

 Mass density - is in the range 2400 ≤ ρ ≤ 2500kg/m³ for normal weight 

concrete according to clause 2.1.2. Typically it is taken as ρ= 2500kg/m³.  

 Coefficient of thermal expansion Available when the 'Thermal properties' 

check box is selected. This may be taken as 10E-6 per degree K according to 

clause 2.1.8.3. 

 Mass Rayleigh damping constant Available when the 'Dynamic properties' 

check box is selected. 

 Stiffness Rayleigh damping constant Available when the 'Dynamic 

properties' check box is selected. 

 

Properties for use in creep and shrinkage calculations: 

 Uniaxial compressive strength - refers to the mean value of compressive 

strength, fcm, (the cylinder strength) associated with the characteristic 

compressive strength, fck. This value is typically determined from equation 2.1-
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1, that is, fcm = fck + 8MPa. For grades C12 to C80, as per clause 2.1.1.2, this 

would give a likely range 20 ≤ fcm ≤ 88MPa. The default value of fcm = 48MPa, 

corresponds to Grade C40. 

 Cement type - refers to clauses 2.1.6.1 and 2.1.6.4.3(c), and may be Slow 

Hardening, Normal or Rapid Hardening (the default option) or Rapid 

Hardening High Strength.  

 Relative humidity - is used in the calculation of both creep coefficient and, 

where required, shrinkage. Typical percentage values according to Table 

2.1.10. would be 50 for indoor, dry atmospheric conditions, or 80 for outdoor, 

humid atmospheric conditions. 

 Adjust for temperature during service life Ticked by default. If ticked, an 

additional input row is added to the grid for 'Prevailing temperature' and the 

adjustments to compressive strength, elastic modulus, creep and shrinkage 

according to clauses 2.1.8.4, 6 and 7 apply. If using Model 105 or 109, the 

adjustments for tensile strength and fracture energy to clause 2.1.8.5 also apply. 

If unticked, the adjustments of those clauses do not apply - this corresponds to 

a mean concrete temperature (taking into account seasonal variations between 

about −20°C and +40°C) of 20°C. 

 Prevailing temperature This row is available only when selected by ticking 

the option 'Adjust for temperature during service'. The temperature entered will 

be used for the adjustments to concrete properties and creep and shrinkage 

behaviours to clause 2.1.8.4 to 7 as described above. These effects are distinct 

from the effect upon maturity of temperature during curing/prior to loading on 

maturity, which is handled according to clause 2.1.8.2 by entering temperatures 

and corresponding durations, as appropriate, into the Age attribute. 

 Internal perimeter factor or Notional size appear depending upon selections 

made on the Options dialog. See 'Notional section size' for more details. 

 

Creep calculations 

Creep calculations are carried out to CEB-FIP Model Code 1990 clause 2.1.6.4.3 as 

amended for temperature effects as described below: 

 The maturity of the concrete is affected by the temperature during curing and, 

according to clause 2.1.6.1, the age of the concrete should be adjusted using 

equation 2.1-87. This can be included in the LUSAS material behaviour by 

adding information about temperature during curing to the Age attribute.  

 Creep and shrinkage behaviour is adjusted for prevailing temperatures which 

deviate from 20°C in service in accordance with clause 2.1.8.7, as described 

under 'Prevailing temperature' inputs above. 

 The effect of the type of cement on the creep coefficient is taken into account 

in accordance with clause 2.1.6.4.3(c), and equation 2.1-72 
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 Nonlinear effects of high stresses are considered by default. In accordance with 

clause 2.1.6.4.3(d), a nonlinear notional creep coefficient (equation 2.1-73a) is 

used for areas where compressive stress 0.4fcm(t0)<σc<0.6fcm(t0).  

Shrinkage 

 The effects of shrinkage can be included in accordance with clause 2.1.6.4.4. as 

amended for temperature effects (maturity, clause 2.1.8.2 and in-service, clause 

2.1.8.7.2) 

Thermal properties 

When specified, requires the coefficient of thermal expansion to be defined. 

Dynamic properties 

When specified, requires Mass Rayleigh and Stiffness Rayleigh damping constants to 

be defined. 

Damage-based options 

Specification of Fracture energy or Strain at end of softening curve via selection of 

the appropriate radio button on the dialog may also be applicable when using the 

Smoothed multi-crack concrete material (model 109) - for cracking and crushing in 

a structural analysis) or the Transient smoothed multi-crack model (model 105) - 

for cracking and crushing in a hygro-thermal analysis).  

Options 

Notional section size 

Notional section size can be specified directly, or calculated automatically for beam 

members and shell members, using one of the options below: 

 Calculate using section dimensions or thickness (lines and surfaces) The 

notional size is calculated according to eq 2.169 as h = 2Ac/u where Ac is the 

cross-sectional area and u is the length of the perimeter of the cross section that 

is in contact with the atmosphere - both externally and internally if voids are 

present. For shells, the notional size is equal to the assigned geometric 

thickness. The computation is carried out for each element, and for varying 

beam sections, the value will vary along the line as appropriate. 

 Adjusted using internal perimeter factor for voids (lines only) Available for 

Linear with creep/shrinkage (Model 86) only. The calculation for h0 is as 

described above, except that u = uo + ks × ui where ks is the internal perimeter 

factor specified, ui is the internal perimeter of any voids in a beam section (e.g. 

the cell of a box girder), and uo the remaining (outer) perimeter. This enables 

the notional size to be adjusted to allow for poorly ventilated enclosed cells if 

desired; the default value of ks=0.5 is based on AASHTO LRFD 7th Ed, Article 
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5.4.2.3.2. For elements types other than beams, and for beam sections without 

voids, the value of internal perimeter factor is irrelevant and is not used. 

 Specified directly (any geometry type) The notional size stated should be 

appropriate to the model units. 

Notes 

 Timescale units, which may be viewed and modified on the Model properties 

dialog, must be set to 'Days'. 

  The time management facility (available in Bridge and Civil software 

products) provides the means to manage a simple construction schedule and 

easily adjust the duration of pre-defined construction stages in a staged 

construction analysis. 

 The age of concrete at the time an element is introduced to the analysis, along 

with the age at onset of drying shrinkage, must be defined using an Age 

attribute. The age attribute offers an option to calculate this age with an 

adjustment for elevated or reduced temperatures during curing (prior to 

loading). 

 If not using the time management facility, this creep and shrinkage material 

can only be used in an analysis where nonlinear and transient controls are 

added, with both 'Nonlinear' and 'Time domain' options switched on and the 

time domain set to 'Viscous'. 

 An option exists in the advanced time step options to use an exponent to 

increase the time step as the analysis progresses. This is appropriate to the 

development of creep and shrinkage with time - more rapidly when the 

concrete is first cast and more slowly as it matures. 

 When the Solver data file is created, time values are tabulated in seconds 

regardless of the model units specified. 

See the Solver Reference Manual and the Theory Manual for further details. 

Concrete Creep and Shrinkage to EN1992 (2004-2014) 

Concrete material properties to EN1992-1-1:2004 + A1:2014 are defined from the 

Attributes> Material> Concrete (Nonlinear) menu item.  

Creep behaviour for compressive stresses ≤0.45*fck(t0) is according to clause 3.1.4(2), 

with nonlinear behaviour for higher stress levels according to clause 3.1.4(4). The 

Code may not accurately predict behaviour at stress levels beyond >0.65*fck, with the 

stress-strength ratio, k capped at 0.65 for very high stresses. This material model 

includes options for high strength concrete (fck>50MPa) to EN1992-2:2005 Annex B, 

section B.103. 

file:///C:/SVN/Content/Bridge/Time_Management/time_management.htm


Modeller Reference Manual   

    

296 

Clause references cited are to EN1992-1-1:2004+A1:2014 unless otherwise stated. No 

changes introduced in the 2014 amendment affected this facility. 

Material Properties 

The following material parameters are required: 

 Young's modulus - the tangent modulus of elasticity of concrete at 28 days, Ec. 

This value is typically determined from the secant modulus, Ecm, in Table 3.1, 

adjusted for aggregate type according to the commentary to clause 3.1.3(2) and 

using Ec = 1.05Ecm according lause 3.1.4(2). Taking into account the 

adjustment for aggregate and 1.05 factor, the expected range of values is 

therefore 19×10³ ≤ Ec ≤ 56×10³ MPa. The default value of Ec = 36.75×10³ MPa, 

corresponds to concrete with fck = 40MPa and quartzite aggregate. 

 Poisson’s Ratio - may be taken as 0.2 for uncracked concrete and 0 for cracked 

concrete according to clause 3.1.3(4). A value of νc = 0.2, corresponds to an 

uncracked section, acknowledging the primary use of the creep material in 

prestressed concrete where the intention is cracking is avoided. When using the 

Smoothed multi-crack concrete material (model 109), a value of vc=0.2 is 

also recommended since the concrete would be uncracked at the start of the 

analysis and the use of vc= 0 may lead to inaccurate results. 

 Mass density - may be taken as ρ= 25 kN/m³ = 2548.4kg/m³ for normal weight 

concrete according to EN1991-1-1:2002 Table A.1 

 Coefficient of thermal expansion Available when the 'Thermal properties' 

check box is selected. This may be taken as 10E-6 per K according to clause 

3.1.3(5). 

 Mass Rayleigh damping constant Available when the 'Dynamic properties' 

check box is selected. 

 Stiffness Rayleigh damping constant Available when the 'Dynamic 

properties' check box is selected. 

 

Properties for use in creep and shrinkage calculations: 

 Uniaxial compressive strength - refers to the mean value of compressive 

strength, fcm, (the cylinder strength) associated with the characteristic 

compressive strength. This value is typically determined from Table 3.1, i.e. fcm 

= fck + 8MPa. This would give a likely range 20 ≤ fcm ≤ 98MPa. The default 

value of fcm = 48MPa, corresponds to fck =40Mpa. 

 Cement type - refers to cement type in clauses 3.1.2(6), 3.1.4(5) and Annex B, 

clause B.1(2) and may be: Class S (slow hardening cements), Class N (Normal 

or rapid hardening cements) or Class R (Rapid hardening high strength 

cements). Class N is the default option. 
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 Relative humidity - is used in the calculation of both creep coefficient and, 

where required, shrinkage. Typical percentage values would lie in the range 

20≤RH≤80 from Table 3.2, and Figure 3.1 indicates a value of RH=50% may 

represent inside conditions, while RH=80% may represent outside conditions 

 Internal perimeter factor or Notional size appear depending upon selections 

made on the Options dialog. See 'Notional section size' for more details. 

Creep calculations 

Creep calculations are carried out to EN1992-1-1 clause 3.1.4 and Annex B.1. It may 

be helpful to note: 

 The effect upon concrete maturity of elevated or reduced temperatures during 

curing/ prior to loading, may be considered by using the appropriate option in 

the Age attribute, in which case the early age modulus of elasticity (exp. 3.5) 

and the notional creep coefficient (Annex B) are adjusted appropriately (see 

clause B.1(2) and exp B.10). 

 The effect of the type of cement on the creep coefficient is taken into account 

in accordance with clause B.1(2) and exp. B.9. 

 Nonlinear effects of high stresses are considered by default. In accordance with 

clause 3.1.4(4), a nonlinear notional creep coefficient (exp. 3.7) is used for 

areas where compressive stress σc>0.45fck (t0 ). Note that LUSAS caps the 

stress-strength ratio, k, at 0.65 for very high stresses. This is based on a 

similar approach, defined more explicitly in CEB-FIB Model Code 1990 clause 

2.1.6.4.3(d). 

 EN1992-2:2005 Annex B, section B.103 gives expressions for creep in high-

strength concrete (fck>50MPa). Concretes with or without silica fume are 

treated differently as lower creep strains are observed in concrete with silica 

fume. The option may be switched on by the user as required; as well as being 

used for high strength concretes, the methods given in Section B.103 may be 

preferred for thick members, in which the kinetics of basic creep and drying 

creep are quite different, as per EN1992-2 Annex B. On the contrary, they 

would not be applicable when working strictly to EN1992-1-1. 

Thermal properties 

When specified, requires the coefficient of thermal expansion to be defined. See above 

for a suitable reference within this Code of Practice. 

Dynamic properties 

When specified, requires Mass Rayleigh and Stiffness Rayleigh damping constants to 

be defined. 
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Damage-based options 

Specification of Fracture energy or Strain at end of softening curve via selection of 

the appropriate radio button on the dialog may also be applicable when using the 

Smoothed multi-crack concrete material (model 109) (for cracking and crushing in 

a structural analysis) or the Transient smoothed multi-crack model (model 105) (for 

cracking and crushing in a hygro-thermal analysis).  

Options 

Notional section size 

Notional section size can be specified directly, or calculated automatically for beam 

members and shell members, using one of the options below: 

 Calculate using section dimensions or thickness (lines and surfaces) The 

notional size is calculated according to clause 3.1.4(5) as h0 = 2Ac/u where Ac 

is the cross-sectional area and u is the length of the perimeter of the cross 

section that is in contact with the atmosphere - both externally and internally if 

voids are present. For shells, the notional size is equal to the assigned geometric 

thickness. The computation is carried out for each element, and for varying 

beam sections, the value will vary along the line as appropriate. 

 Adjusted using internal perimeter factor for voids (lines only) Available for 

Linear with creep/shrinkage (Model 86) only. The calculation for h0 is as 

described above, except that u = uo + ks × ui where ks is the internal perimeter 

factor specified, ui is the internal perimeter of any voids in a beam section (e.g. 

the cell of a box girder), and uo the remaining (outer) perimeter. This enables 

the notional size to be adjusted to allow for poorly ventilated enclosed cells if 

desired; the default value of ks=0.5 is based on AASHTO LRFD 7th Ed, Article 

5.4.2.3.2. For elements types other than beams, and for beam sections without 

voids the value of internal perimeter factor is irrelevant and is not used. 

 Specified directly (any geometry type) The notional size stated should be 

appropriate to the model units. 

 

High strength concrete 

 Use EN1992-2 equations for high strength concrete (>50MPa) This option 

determines the creep and shrinkage parameters using the alternative expressions 

of EN1992-2:2005 Annex B, section B.103 and may also be of use for thick 

members as described above. 

 Silica Fume ≥5% of cementitious content This option is only available when 

the EN1992-2 equations for high strength concrete are in use. The option 

affects the calculation of drying shrinkage, basic creep and drying creep 

according to EN1992-2 Section B.103 as appropriate. 
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Shrinkage 

 Include / Exclude autogenous shrinkage When code based shrinkage is 

selected, the effects of shrinkage can be included in accordance with clause 

3.1.4(6) and Annex B.2. Clause 3.1.4(6) states: "The total shrinkage strain is 

composed of two components, the drying shrinkage strain and the autogenous 

shrinkage strain. The drying shrinkage strain develops slowly, since it is a 

function of the migration of the water through the hardened concrete. The 

autogenous shrinkage strain develops during hardening of the concrete in the 

early days after casting and should be considered specifically when new 

concrete is cast against hardened concrete". 

Notes 

 Timescale units, which may be viewed and modified on the Model properties 

dialog, must be set to 'Days'. 

  The time management facility (available in Bridge and Civil software 

products) provides the means to manage a simple construction schedule and 

easily adjust the duration of pre-defined construction stages in a staged 

construction analysis. 

 The age of concrete at the time an element is introduced to the analysis, along 

with the age at onset of drying shrinkage, must be defined using an Age 

attribute. The age attribute offers an option to calculate this age with an 

adjustment for elevated or reduced temperatures during curing (prior to 

loading). 

 If not using the time management facility, this creep and shrinkage material 

can only be used in an analysis where nonlinear and transient controls are 

added, with both nonlinear and time domain options switched on and the time 

domain set to 'Viscous'. 

 An option exists in the advanced time step options to use an exponent to 

increase the time step as the analysis progresses. This is appropriate to the 

development of creep and shrinkage with time - more rapidly when the 

concrete is first cast and more slowly as it matures. 

 When the Solver data file is created, time values are tabulated in seconds 

regardless of the model units specified. 

See the Solver Reference Manual and the Theory Manual for further details. 

Concrete Creep and Shrinkage to fib Model Code 2010 

Concrete material properties to fib Model Code 2010 are defined from the Attributes> 

Material> Concrete (Nonlinear) menu item 

file:///C:/SVN/Content/Bridge/Time_Management/time_management.htm
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 Creep behaviour for compressive stresses ≤0.4*fcm(t0) is according to clause 5.1.9.4.3 

with nonlinear behaviour for higher stress levels according to clause 5.1.9.4.3(d), 

which indicates that the model is not valid for stress levels >0.6*fcm(t0). Clause 

5.1.9.4.2 indicates that the fib creep and shrinkage relations are valid for concrete in 

the range 20 MPa ≤ fcm ≤ 130 MPa. 

Clause references cited are for 'fib Model Code for Concrete Structures 2010, 

Fédération Internationale du Béton, Lausanne, Switzerland, 2013', unless otherwise 

stated. 

Material Properties 

The following material parameters are required: 

 Young's modulus - The tangent modulus of elasticity of concrete at 28 days, 

Eci. This value is typically determined from equation 5.1-20, adjusted for 

aggregate type according to Table 5.1-6. Table 5.1.7 gives values in the range 

27.1×10³ ≤ Eci ≤ 50.3×10³ MPa. Taking into account the adjustment for 

aggregate, the expected range of values is therefore 19×10³ ≤ Eci ≤ 60.4×10³ 

MPa. The default value of Eci = 36.3×10³ MPa corresponds to Grade C40 

concrete and quartzite aggregate. 

 Poisson’s Ratio - This will lie in the range 0.14 ≤ νc ≤ 0.26 according to clause 

5.1.7.3. This clause states "Regarding the significance of vc, for the design of 

members, especially the influence of crack formation at the ultimate limit state 

(ULS), the estimation of vc = 0.20 meets the required accuracy." A value of νc 

= 0.2, corresponds to an uncracked section, acknowledging the primary use of 

the creep material in prestressed concrete where cracking is intended to be 

avoided. When using the Smoothed Multicrack concrete material (model 

109), a value of vc=0.2 is also recommended since the concrete would be 

uncracked at the start of the analysis. The use of lower values of vc may lead to 

inaccurate results. 

 Mass density - The insitu density of normal weight concrete may be estimated 

from Table 5.1-1; a typical value being around ρ= 2500kg/m³. 

 Coefficient of thermal expansion - Available when the 'Thermal properties' 

check box is selected. This may vary between approximately 6× 10
-6

 K
−1

 and 

15×10
−6

 K
−1;

; the design value of 10×10
−6

 K
−1

 is valid for normal strength and 

high strength concrete. according to 5.1.10.3. 

 Mass Rayleigh damping constant - Available when the 'Dynamic properties' 

check box is selected.  

 Stiffness Rayleigh damping constant - Available when the 'Dynamic 

properties' check box is selected.  

 

Properties for use in creep and shrinkage calculations: 
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 Uniaxial compressive strength - refers to the mean value of compressive 

strength, fcm, (the cylinder strength) associated with the characteristic 

compressive strength, fck. This value is typically determined from commentary 

eqn. 5.1-1, that is, fcm = fck + 8MPa. For grades C12 to C120, as per Table 5.1-

3, this would give a likely range 20 ≤ fcm ≤ 128MPa. The default value of fcm = 

48MPa, corresponds to Grade C40. 

 Strength class of cement - refers to clauses 5.1.9.1 and 5.1.9.4.3(c), and may 

be '32.5 N', '32.5 R,42.5 N' (the default option), or '42.5 R, 52.5 N, 52.5'. 

 Relative humidity - is used in the calculation of both creep coefficient and, 

where required, shrinkage. Typical percentage values according to Tables 5.1-

10 and 5.1.10.11 would be 50 for indoor, dry atmospheric conditions, or 80 for 

outdoor, humid atmospheric conditions. 

 Aggregate type - Normal, lightweight high strength, lightweight low strength. 

The development of strength with time is determined to eqns. 5.1-50 and 5.1-51 

for normal weight aggregate concrete and using eqn. 5.1-52 for the two 

"lightweight" options. Creep and shrinkage are also affected by the use of 

lightweight aggregates (eqns. 5.1-72 and 5.1-84 respectively) and require the 

additional input of 'Oven dry density' (see below). The aggregate type is also 

used when determining adjustments to compressive strength and elastic 

modulus for temperature during service life according clause 5.1.10.4 and 

5.1.10.6. 

 Oven-dry density - This row is available only if a lightweight aggregate type 

is selected. From Table 5.1-2 a value in the range 800<  <2000 kg/m³ would 

be expected and a default of  =1400kg/m³ corresponds to class D1.4. Entering 

this value allows the creep and shrinkage to be adjusted using eqns. 5.1-72 and 

5.1-84 respectively. 

 Adjust for temperature during service life Ticked by default. If ticked, an 

additional input row is added to the grid for 'Prevailing temperature' and for 

'Moisture content for cryogenic conditions'; and the adjustments to compressive 

strength, elastic modulus, creep and shrinkage according to clauses 5.1.10.4, 6, 

7 and 9 apply. If using the"Transient Smoothed Multi-Crack Concrete Model 

(Model 105)" on page 313 or the Smoothed Multicrack concrete material 

(model 109), the adjustments for tensile strength and fracture energy to clause 

5.1.10.5 and 9 also apply. If unticked, the adjustments of that clause do not 

apply - this corresponds to a mean concrete temperature (taking into account 

seasonal variations between about −20°C and +40°C) of 20°C. 

 Prevailing temperature - This row is available only when selected by ticking 

the option 'Adjust for temperature during service'. The temperature entered will 

be used for the adjustments to concrete properties and creep and shrinkage 

behaviours as described above. In the range 0 to 80°C, these adjustments are to 

clauses 5.1.10.4 to 7; in the range -170 to 0°C, cryogenic temperature effects 

are considered using clause 5.1.10.9. These effects are distinct from the effect 
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upon maturity of temperature during curing/prior to loading, which is handled 

according to clause 5.1.10.2 by entering temperatures and corresponding 

durations, as appropriate, into the Age attribute. 

 Moisture content for cryogenic conditions (% by mass) - This row is 

available only if the 'Adjustment for temperature during service life' tick-box is 

set to 'on'. The value entered here is only used if the prevailing temperature 

entered is in the range -170 to 0°C. the commentary to clause 5.1.10.9 indicates 

that the value ranges from 2% (general indoor) through 4% (general outdoor) to 

6% (exposed to rain). 

 Permanent loads dominate - When subjected to sustained high stresses the 

strength of concrete decreases with time under load due to the formation of 

micro-cracks. This can be considered, according to clause 5.1.9.2, if 

appropriate by switching on this option. 

 Internal perimeter factor or Notional size appear depending upon selections 

made on the Options dialog. See 'Notional section size' for more details. 

 

Creep calculations 

Creep calculations are carried out to fib Model Code 2010 clause 5.1.9.4.3 as 

described below: 

 The maturity of the concrete is affected by the temperature during curing and, 

according to clause 5.1.10.2, the age of the concrete should be adjusted using 

equation 5.1-85. This can be included in the LUSAS material behaviour by 

adding information about temperature during curing to the Age attribute. Creep 

behaviour is adjusted for prevailing temperatures which deviate from 20°C in 

service in accordance with clauses 5.1.10.7.1. Also see 'Adjust for temperature 

during service life', above. 

 The effect of the type of cement on the creep coefficient is taken into account 

in accordance with clause 5.1.9.4.3(c), and equation 5.1-73. 

 Nonlinear effects of high stresses are considered by default. In accordance with 

clause 5.1.9.4.3(d), a nonlinear notional creep coefficient (equation 5.1-74) is 

used for areas where compressive stress 0.4fcm(t0)<σc<0.6fcm(t0) 

Shrinkage 

 The effects of shrinkage can be included in accordance with clause 5.1.9.4.4 as 

amended for temperature effects (maturity, clause 5.1.10.2 and in-service, clause 

5.1.10.7.2) 

Thermal properties 

When specified requires the coefficient of thermal expansion to be defined. 
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Dynamic properties 

When specified requires Mass Rayleigh and Stiffness Rayleigh damping constants to 

be defined. 

Damage-based options 

Specification of Fracture energy or Strain at end of softening curve via selection of 

the appropriate radio button on the dialog may also be applicable when using the 

Smoothed multi-crack concrete material (model 109) (for cracking and crushing in 

a structural analysis).  

Options 

Notional section size 

Notional section size can be specified directly, or calculated automatically for beam 

members and shell members, using one of the options below: 

 Calculate using section dimensions or thickness (lines and surfaces) The 

notional size is calculated according to clause 5.1.9.4.3(d)) as h = 2Ac/u where 

Ac is the cross-sectional area and u is the length of the perimeter of the cross 

section that is in contact with the atmosphere - both externally and internally if 

voids are present. For shells, the notional size is equal to the assigned geometric 

thickness. The computation is carried out for each element, and for varying 

beam sections, the value will vary along the line as appropriate. 

 Adjusted using internal perimeter factor for voids (lines only) Available for 

Linear with creep/shrinkage (Model 86) only. The calculation for h is as 

described above, except that u = uo + ks × ui where ks is the internal perimeter 

factor specified, ui is the internal perimeter of any voids in a beam section (e.g. 

the cell of a box girder), and uo the remaining (outer) perimeter. This enables 

the notional size to be adjusted to allow for poorly ventilated enclosed cells if 

desired; the default value of ks=0.5 is based on AASHTO LRFD 7th Ed, Article 

5.4.2.3.2. For elements types other than beams, and for beam sections without 

voids the value of internal perimeter factor is irrelevant and is not used. 

 Specified directly (any geometry type) The notional size stated should be 

appropriate to the model units. 

Notes 

 Timescale units, which may be viewed and modified on the Model properties 

dialog, must be set to 'Days'. 

  The time management facility (available in Bridge and Civil software 

products) provides the means to manage a simple construction schedule and 

easily adjust the duration of pre-defined construction stages in a staged 

construction analysis. 

file:///C:/SVN/Content/Bridge/Time_Management/time_management.htm
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 The age of concrete at the time an element is introduced to the analysis, along 

with the age at onset of drying shrinkage, must be defined using an Age 

attribute. The age attribute offers an option to calculate this age with an 

adjustment for elevated or reduced temperatures during curing (prior to 

loading). 

 If not using the time management facility, this creep and shrinkage material 

can only be used in an analysis where nonlinear and transient controls are 

added, with both nonlinear and time domain options switched on and the time 

domain set to 'Viscous'. 

 An option exists in the advanced time step options to use an exponent to 

increase the time step as the analysis progresses. This is appropriate to the 

development of creep and shrinkage with time - more rapidly when the 

concrete is first cast and more slowly as it matures. 

 When the Solver data file is created, time values are tabulated in seconds 

regardless of the model units specified. 

See the Solver Reference Manual and the Theory Manual for further details. 

Concrete Creep and Shrinkage to IRC:112-2011 

Concrete material properties to IRC:112-2011 are defined from the Attributes> 

Material> Concrete (Nonlinear) menu item.  

Creep behaviour for compressive stresses ≤0.36*fck is according to clause 6.4.2.7(2). 

The Code may not accurately predict behaviour at greater levels of stress. 

Clause references cited are to 'IRC: 112-2011 (Indian Roads Congress, New Delhi, 

Nov 2011)' unless otherwise stated. 

Material Properties 

The following material parameters are required: 

 Modulus of elasticity of concrete - the secant modulus of elasticity of 

concrete, Ecm. This value is typically determined from Ecm in Table 6.5 or by 

use of the equation in Annexure A2, Eq. A2-5, adjusted for aggregate type by 

Table 6.5 Note (2). The expected range of values is therefore 19×10³ ≤ Ecm ≤ 

49×10³ MPa. The default value of Ecm = 33×10³ MPa, corresponds to concrete 

with fck = 40MPa and quartzite/granite aggregate. 

 Poisson’s Ratio - may be taken as 0.2 for uncracked concrete and 0 for cracked 

concrete according to clause 6.4.2.5(4)(ii). A value of νc = 0.2, corresponds to 

an uncracked section, acknowledging the primary use of the creep material in 

prestressed concrete where cracking is intended to be avoided. When using the 

Smoothed multi-crack concrete material (model 109), a value of vc=0.2 is 
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also recommended since the concrete would be uncracked at the start of the 

analysis and the use of vc=0 may lead to inaccurate results. 

 Mass density - is not specified in IRC:112-2011. A useful reference may be 

IRC:6-2017 clause 203, where a value of ρ= 2.5t/m³ is given for both 

reinforced and prestressed concrete (items 12 and 13 respectively) for normal 

weight concrete is given 

 Coefficient of thermal expansion Available when the 'Thermal properties' 

check box is selected. This is not specified in IRC:112-2011. A useful reference 

may be IRC:6-2017 clause 215.4, where a value of 12E-6 per °C is given. 

 Mass Rayleigh damping constant Available when the 'Dynamic properties' 

check box is selected. 

 Stiffness Rayleigh damping constant Available when the 'Dynamic 

properties' check box is selected. 

 

Properties for use in creep and shrinkage calculations: 

 Uniaxial compressive strength at 28 days - refers to the mean value of 

compressive strength, fcm, (the cylinder strength) associated with the 

characteristic compressive strength. This value is typically determined from 

Annexure A2, Eq. A2-1, i.e. fcm = fck + 10MPa or referring to Table 6.5. This 

would give a likely range 25 ≤ fcm ≤ 100MPa. The default value of fcm = 

50MPa, corresponds to fck =40MPa. 

 Cement type - refers to cement types described in Annexure A2, clauses 

A2.3(1) and A2.5(1) and may be: Rapid hardening, Normal hardening or Slow 

hardening. Normal hardening is the default option. 

 Relative humidity - is used in the calculation of both creep coefficient and, 

where required, shrinkage. Typical percentage values would lie in the range 

20≤RH≤80, from Tables 6.8 and 6.9. The default of RH=50%, would represent 

dry atmospheric conditions. 

 Internal perimeter factor or Notional size appear depending upon selections 

made on the Options dialog. See 'Notional section size' for more details. 

Thermal properties 

When specified, requires the coefficient of thermal expansion to be defined. 

Dynamic properties 

When specified, requires Mass Rayleigh and Stiffness Rayleigh damping constants to 

be defined. 

Damage-based options 

Specification of Fracture energy or Strain at end of softening curve via selection of 

the appropriate radio button on the dialog may also be applicable when using the 
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Smoothed multi-crack concrete material (model 109) (for cracking and crushing in 

a structural analysis). 

Creep calculations 

The effect upon concrete maturity of elevated or reduced temperatures during curing/ 

prior to loading, may be considered by using the appropriate option in the Age 

attribute, in which case the early age strength and elasticity (Eq. 6.3 and 6.10 

respectively) and the notional creep coefficient (Eq. A2-19) are adjusted appropriately 

(see clause A2.4 and Eq. A2-13). 

The effect of the type of cement on the creep coefficient is taken into account in 

accordance with clause A2.5(1) and Eq. A2-25). The creep coefficient calculated is 

deemed by clause 6.4.2.7(2) to be appropriate for a mean prevailing temperature 

environmental temperature (during service life) of between 10 and 20°C, with seasonal 

variation between -20 and 40°C. 

Options 

Notional section size 

Notional section size can be specified directly, or calculated automatically for beam 

members and shell members, using one of the options below: 

 Calculate using section dimensions or thickness (lines and surfaces) The 

notional size is calculated according to clause 6.4.2.6(4) as h0 = 2Ac/u where Ac 

is the cross-sectional area and u is the length of the perimeter of the cross 

section that is in contact with the atmosphere - both externally and internally if 

voids are present. For shells, the notional size is equal to the assigned geometric 

thickness. The computation is carried out for each element, and for varying 

beam sections, the value will vary along the line as appropriate. 

 Adjusted using internal perimeter factor for voids (lines only) Available for 

Linear with creep/shrinkage (Model 86) only. The calculation for h0 is as 

described above, except that u = uo + ks × ui where ks is the internal perimeter 

factor specified, ui is the internal perimeter of any voids in a beam section (e.g. 

the cell of a box girder), and uo the remaining (outer) perimeter. This enables 

the notional size to be adjusted to allow for poorly ventilated enclosed cells if 

desired; the default value of ks=0.5 is based on AASHTO LRFD 7th Ed, Article 

5.4.2.3.2. For elements types other than beams, and for beam sections without 

voids the value of internal perimeter factor is irrelevant and is not used. 

 Specified directly (any geometry type) The notional size stated should be 

appropriate to the model units. 

 

Shrinkage 

 Include / Exclude autogenous shrinkage When code based shrinkage is 

selected, the effects of shrinkage can be included in accordance with clause 
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6.4.2.6 and Annexure A2 clause A2.6. Clause 6.4.2.6 describes that “the total 

shrinkage strain is composed of two components, the drying shrinkage strain 

and the autogenous shrinkage strain... The autogenous shrinkage strain 

develops during hardening of the concrete in the early days after casting and 

should be considered specifically when new concrete is cast against hardened 

concrete... The drying shrinkage strain develops slowly, since it is a function of 

the migration of the water through the hardened concrete” 

Notes 

 Timescale units, which may be viewed and modified on the Model properties 

dialog, must be set to 'Days'. 

  The time management facility (available in Bridge and Civil software 

products) provides the means to manage a simple construction schedule and 

easily adjust the duration of pre-defined construction stages in a staged 

construction analysis. 

 The age of concrete at the time an element is introduced to the analysis, along 

with the age at onset of drying shrinkage, must be defined using an Age 

attribute. The age attribute offers an option to calculate this age with an 

adjustment for elevated or reduced temperatures during curing (prior to 

loading). 

 If not using the time management facility, this creep and shrinkage material 

can only be used in an analysis where nonlinear and transient controls are 

added, with both nonlinear and time domain options switched on and the time 

domain set to 'Viscous'. 

 An option exists in the advanced time step options to use an exponent to 

increase the time step as the analysis progresses. This is appropriate to the 

development of creep and shrinkage with time - more rapidly when the 

concrete is first cast and more slowly as it matures. 

 When the Solver data file is created, time values are tabulated in seconds 

regardless of the model units specified. 

See the Solver Reference Manual and the Theory Manual for further details. 

Concrete Creep and Shrinkage to JTG 3362-2018 

Concrete material properties to JTG 3362-2018 are defined from the Attributes> 

Material> Concrete (Nonlinear) menu item. 

 Creep behaviour for concrete stresses ≤0.4*fcm(t0) is according to C.2.1; there is no 

provision in the Code of Practice for higher stress levels. 

file:///C:/SVN/Content/Bridge/Time_Management/time_management.htm
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Clause references cited are for 'JTG 3362-2018 Specifications for the Design of 

Highway Reinforced Concrete and Prestressed Concrete Bridges and Culverts, 

People’s Transportation Press, Beijing, Nov 2018', unless otherwise stated. 

Material Properties 

The following material parameters are required: 

 Young's modulus - The modulus of elasticity of concrete at 28 days, Ec. This 

value is typically determined from Table 3.1.5, adjusted for air entrainment for 

grades C50-C80 following Note 2 to Table 3.1.5. Table 3.1.5 gives values in 

the range 28×10³ ≤ Eci ≤ 38×10³ MPa.  

 Poisson’s Ratio - A value of νc = 0.2, corresponds to an uncracked section, 

acknowledging the primary use of the creep material in prestressed concrete 

where cracking is intended to be avoided. When using the Smoothed 

multicrack concrete material (model 109), a value of vc=0.2 is is given in 

clause 3.1.6. 

 Mass density - The insitu density of concrete - a typical value might be ρ= 

2550kg/m³ for normal weight concrete. 

 Coefficient of thermal expansion - Available when the 'Thermal properties' 

check box is selected. Typically taken to be alpha = 10× 10
-6

 K
−1

   

 Mass Rayleigh damping constant - Available when the 'Dynamic properties' 

check box is selected.  

 Stiffness Rayleigh damping constant - Available when the 'Dynamic 

properties' check box is selected.  

 

Properties for use in creep and shrinkage calculations: 

 Uniaxial compressive strength - refers to the mean value of compressive 

strength, fcm, (the cylinder strength) associated with the strength class, fck. This 

value is typically determined from Appendix C, clause C1.1, that is, fcm = 0.8 

fcu,k + 8MPa. For grades C25 to C50. 

 Strength class of cement - In the calculation of shrinkage, to Appendix C, 

clause C1.1, a coefficient dependent on cement type, βSc is defined as βSc = 5.0 

for normal (Portland) cement or rapid hardening cement. Since no other values 

are offered in the Code of Practice, reference is made to CEB-FIP Model Code 

1990 clause 2.1.6.4.3(c), and the options here also include Slow Hardening (βSc 

= 4) and Rapid Hardening High Strength (βSc = 8). 

 Percentage fly ash by mass - For the adjustment of creep coefficient to 

Appendix C, clause C2.4. As per Table C2.4, typically alpha < 30%. 

 Relative humidity - is used in the calculation of both creep coefficient and, 

where required, shrinkage. Typical percentage values according to Tables 5.1-
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10 and 5.1.10.11 would be 50 for indoor, dry atmospheric conditions, or 80 for 

outdoor, humid atmospheric conditions. 

 Adjust for temperature during service life Ticked by default. If ticked, an 

additional input row is added to the grid for 'Prevailing temperature' and the 

adjustments to creep and shrinkage according to the Commentary to Appendix 

C (eqns C-1 to C-7) apply, which are applicable for temperatures in the range 0 

to 80°C. If unticked, the adjustments do not apply - this corresponds to a mean 

concrete temperature (taking into account seasonal variations between about 

−20°C and +40°C) in the range 10 to 20°C. 

 Prevailing temperature - This row is available only when selected by ticking 

the option 'Adjust for temperature during service'. The temperature entered will 

be used for the adjustments to creep and shrinkage behaviours as described 

above. These effects are distinct from the effect upon maturity of temperature 

during curing/prior to loading, which may be considered by entering 

temperatures and corresponding durations, as appropriate, into the Age 

attribute. 

 Internal perimeter factor or Notional size appear depending upon selections 

made on the Options dialog. See 'Notional section size' for more details. 

Creep calculations 

Creep calculations are carried out to JTG 3362-2018 Appendix C clause C2 and the 

associated commentary, with particular regard to the adjustments for prevailing 

temperature and fly ash. 

Shrinkage 

 The effects of shrinkage can be included in accordance with Appendix C1 and the 

associated commentary, with particular regard to the adjustment for prevailing 

temperature. 

Thermal properties 

When specified, requires the coefficient of thermal expansion to be defined. 

Dynamic properties 

When specified, requires Mass Rayleigh and Stiffness Rayleigh damping constants to 

be defined. 

Damage-based options 

Specification of Fracture energy or Strain at end of softening curve via selection of 

the appropriate radio button on the dialog may also be applicable when using the 

Smoothed multi-crack concrete material (model 109) (for cracking and crushing in 

a structural analysis).  
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Options 

Notional section size 

Notional section size can be specified directly, or calculated automatically for beam 

members and shell members, using one of the options below: 

 Calculate using section dimensions or thickness (lines and surfaces) The 

notional size is calculated according to Note 5 under Table C-1 and C-2 as h = 

2A/u where A is the cross-sectional area and u is the length of the perimeter of 

the cross section that is in contact with the atmosphere - both externally and 

internally if voids are present. For shells, the notional size is equal to the 

assigned geometric thickness. The computation is carried out for each element, 

and for varying beam sections, the value will vary along the line as appropriate. 

 Adjusted using internal perimeter factor for voids (lines only) Available for 

Linear with creep/shrinkage (Model 86) only. The calculation for h is as 

described above, except that u = uo + ks × ui where ks is the internal perimeter 

factor specified, ui is the internal perimeter of any voids in a beam section (e.g. 

the cell of a box girder), and uo the remaining (outer) perimeter. This enables 

the notional size to be adjusted to allow for poorly ventilated enclosed cells if 

desired; the default value of ks=0.5 is based on AASHTO LRFD 7th Ed, Article 

5.4.2.3.2. For elements types other than beams, and for beam sections without 

voids the value of internal perimeter factor is irrelevant and is not used. 

 Specified directly (any geometry type) The notional size stated should be 

appropriate to the model units. 

Notes 

 Timescale units, which may be viewed and modified on the Model properties 

dialog, must be set to 'Days'. 

  The time management facility (available in Bridge and Civil software 

products) provides the means to manage a simple construction schedule and 

easily adjust the duration of pre-defined construction stages in a staged 

construction analysis. 

 The age of concrete at the time an element is introduced to the analysis, along 

with the age at onset of drying shrinkage, must be defined using an Age 

attribute. The age attribute offers an option to calculate this age with an 

adjustment for elevated or reduced temperatures during curing (prior to 

loading). The adjustment is not specified in JTG 3362-2018, but the same rule 

appears in every Code of Practice which has this rule. 

 If not using the time management facility, this creep and shrinkage material 

can only be used in an analysis where nonlinear and transient controls are 

file:///C:/SVN/Content/Bridge/Time_Management/time_management.htm
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added, with both nonlinear and time domain options switched on and the time 

domain set to 'Viscous'. 

 An option exists in the advanced time step options to use an exponent to 

increase the time step as the analysis progresses. This is appropriate to the 

development of creep and shrinkage with time - more rapidly when the 

concrete is first cast and more slowly as it matures. 

 When the Solver data file is created, time values are tabulated in seconds 

regardless of the model units specified. 

See the Solver Reference Manual and the Theory Manual for further details. 

Concrete Creep: Zhu (1999) - Mass Concrete (China) 

This material model is accessed via the Attributes> Material> Specialised menu. 

It allows the creep of concrete to be computed as concrete ages while subjected to 

external forces including thermal stresses that may be due to the hydration process. 

Thermal stresses due to the heat of hydration can be included in the computation, if 

required, by running a semi-coupled thermo-mechanical analysis. 

The equations used to compute the creep strains are taken from 朱伯芳. 

大体积混凝土温度应力与温度控制. 北京:中国电力出版社,1999, ZHU Bofang. (Thermal 

stresses and temperature control of mass concrete. China Electric Power Press 

(Beijing), 1999.) 

Zhu's book is referenced or is the basis for the determination of Elastic Modulus 

and/or creep behaviour in several Codes of Practice (see for example GB50496 -2018 

"Construction of Mass Concrete", DL/T 5057-2009 or SL 191-2008 "Hydraulic 

Concrete Structures"). The book has been reprinted and re-set in English by 

Butterworth-Heinemann (Oxford), 2014. 

According to experimental data provided by Zhu, about 70-80% of total creep 

deformation is recoverable. Following Zhu's recommendations, this formulation sets 

the parameter m = 3, which infers two recoverable terms (with parameters f1, g1, p1, 

r1 and f2, g2, p2, r2) and one irrecoverable term (with f3=D, r3). Simplified models 

can be obtained by setting some parameters to zero e.g. setting f3=r3=0 will eliminate 

all irrecoverable creep; setting f2=g2=p2= r2=0 will reduce the formulation to a single 

recoverable creep term. 

Thermal stresses due to the heat of hydration can be included in the computation by 

running a semi-coupled thermo-mechanical analysis. Refer to the LUSAS Theory 

Manual for further information on both these facilities. 

Material Properties  

The following material properties are required: 
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 Long term Elastic modulus, E
∞
 - This is typically taken to be 1.2 times of the 

instantaneous modulus at 90 days or 1.05 times of the instantaneous modulus at 

360 days. Therefore it is typically in the range 25×10
3
 ≤ E

∞
 ≤ 75×10

3
 MPa, 

depending on strength class, aggregate type, admixtures etc. A value of E
∞
 = 

50×10
3
 MPa might correspond to a typical Grade C40 concrete with quartzite 

aggregate. 

 Poisson's ratio, v - According to experimental data, the value of Poisson's ratio 

remains nearly constant over long term loading, close to the Poisson ratio of 

instant elastic deformation. It is typically taken as v=0.2 

 Mass density - Typically taken as ρ= 2500kg/m
3
, but may require significant 

adjustment according to the aggregate type in use. 

 Coefficient of thermal expansion Available when the 'Thermal properties' 

check box is selected. Typically taken as  =10E
-6

 per degree K, but again may 

require adjustment depending upon aggregate type. 

 Mass Rayleigh damping constant - Available when the 'Dynamic properties' 

check box is selected.  

 Stiffness Rayleigh damping constant - Available when the 'Dynamic 

properties' check box is selected 

 Parameters for controlling the evolution of Young's modulus with time 

(a,b) in the expression E(t) = E
∞
 (1 - e

-a


^b
), in which  is the age of the 

concrete at loading, and a and b should be fitted from experimental data; for 

initial design of massive hydraulic concrete structures in the absence of such 

data, the following values are recommended by Zhu: 

 Stiffness log exponent, a = 0.40 

 Time exponent, b = 0.34 

 Parameters for controlling the first term for recoverable creep (f1, g1, p1, 

r1) in an expression of the form phi = (f + g.
-p

) x (1 - e-
r(t-


)
) in which t is the 

time since loading. In the absence of experimental values, the following may be 

suitable for design of massive hydraulic concrete values:  

 Constant in recoverable creep, f1 = 0.23/E
∞
 e.g. 4.6E

-6
 m

2
/kN 

 Multiple in recoverable creep, g1 = 9.2 x f1 e.g. 42.3E
-6

 m
2
/kN 

 Exponent in recoverable creep, p1 = 0.45 days
-1

 

 Log exponent in recoverable creep, r1 = 0.30 days
-1

 

 Parameters for controlling the second terms for recoverable creep (f2, g2, 

p2, r2) in an expression of the same form described above. In the absence of 

experimental values, the following may be suitable: 
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 Constant in recoverable creep, f2 = 0.52/E
∞
 e.g. 10.4E

-6
 m

2
/kN 

 Multiple in recoverable creep, g2 = 1.70 x f2 e.g. 17.7E
-6

 m
2
/kN 

 Exponent in recoverable creep, p2 = 0.45 days
-1

 

 Log exponent in recoverable creep, r2 = 0.005 days
-1

 

 Parameters for controlling the irrecoverable creep term (f3, r3) in an 

expression of the form phi = f.e
-r
 x (1 - e

-r(t-


))
. In the absence of experimental 

values, irrecoverable creep may be neglected using: 

 Multiple in irrecoverable creep, f3 = 0 m
2
/kN,  

 Log exponent in irrecoverable creep, r3 = 0 days
-1

 

For full details, and a definitive description of the expressions used and input 

parameters please refer to the LUSAS Solver Manual. 

Notes 

 Timescale units, which may be viewed and modified on the 'Model properties' 

dialog, must be set to 'Days'. 

 The time management facility (available in Bridge and Civil software 

products) provides the means to manage a simple construction schedule and 

easily adjust the duration of pre-defined construction stages in a staged 

construction analysis. 

 The age of concrete at the time an element is introduced to the analysis, along 

with the age at onset of drying shrinkage, must be defined using an Age 

attribute.  

 If not using the time management facility, this creep material can only be used 

in an analysis where nonlinear and transient controls are added, with both 

nonlinear and time domain options switched on and the time domain set to 

'Viscous'. 

 An option exists in the advanced time step options to use an exponent to 

increase the time step as the analysis progresses. This is appropriate to the 

development of creep with time - more rapidly when the concrete is first cast 

and more slowly as it matures. 

 When the Solver data file is created, time values are tabulated in seconds 

regardless of the model units specified. 

Transient Smoothed Multi-Crack Concrete Model (Model 105) 

The transient smoothed multi-crack concrete model is fundamentally the same as the 

Smoothed multi-crack concrete model (Model 109) but it is intended for use in a 

file:///C:/SVN/Content/Bridge/Time_Management/time_management.htm
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hygro-thermal-structural coupled analysis, and takes into account the effects of heat of 

hydration, creep and shrinkage, along with the time (hydration) dependent evolution of 

properties E, fc and ft. Modelling units of N and m are enforced with the use of this 

concrete model. 

The hygro-thermal component considers the mass balance equation of moisture as well 

as the enthalpy balance equation, and uses two primary variables, namely the capillary 

pressure and temperature. The basic mechanical model simulates directional cracking, 

rough crack closure and crushing using a plastic-damage-contact approach which is 

hydration dependent. 

 For this concrete model cracking and crushing results can be plotted for the 

Values layer as component ‘Crack/Crush’ under the Stress entity. Planes 

representing the cracks are displayed in two and three-dimensions. Points of 

crushing are displayed using star symbols.  

 General crack width calculation is possible and can be plotted for the Contour 

and Values layers by selecting component CWMax (Maximum crack width) 

under the Plastic strain - Plane stress entity. Component EFSMax (Maximum 

equivalent fracture strain) is also available. Note that these components are 

only applicable for elements that support the multi-crack concrete model. See 

Appendix K: Results Tables in the Element reference Manual for details. See 

also the general notes relating to crack width calculation at the end of this 

topic. 

 When this concrete model is used in conjunction with reinforcement 

attributes, a linear steel material model, and with the Crack Widths 

calculation utility, crack width calculations in accordance with EN 1992-1-

1:2004 Eurocode 2 can be carried out. See Application Manual (Bridge, Civil 

& Structural) Crack Width Calculation to EN 1992-1-1 for more information. 

Crack width information can be plotted for the Contour and Values layers as 

components of Maximum Crack Width under the Crack Widths EN1991-1 

entity.  

See Online help > Worked Examples > For LUSAS Bridge and LUSAS Civil & 

Structural > 'Staged Construction of a Concrete Dam' for a worked example. 

Specification of Concrete model, Creep Code and Shrinkage 

See Concrete Models (Nonlinear) for concrete model, creep and shrinkage options. 

 Elastic Material Properties 

 Young's modulus It is important that the Young’s modulus, E, is consistent 

with the strain at peak compressive stress, c. A reasonable check is to ensure 

that  E > 1.2 fc/ c 

 Poisson's ratio   

file:///C:/SVN/Content/Bridge/Crack_Widths/idh_crack_widths.htm
file:///C:/SVN/Content/Bridge/Crack_Widths/idh_crack_widths.htm
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 Mass density The mass density of concrete (ρ) is generally taken to be of the 

order of 2400kg/m³ for mass concrete and 2500kg/m³ for reinforced or 

prestressed concrete. Where more accurate determination is required 

information specific to the concrete in question should be obtained or a value 

determined experimentally. 

 Coefficient of thermal expansion Available when the 'Thermal properties' 

check box is selected. 

 Mass Rayleigh damping constant Available when the 'Dynamic properties' 

check box is selected. 

 Stiffness Rayleigh damping constant Available when the 'Dynamic 

properties' check box is selected. 

 

Plastic Material Properties 

These primary material properties apply to both unreinforced (plain concrete) and 

reinforced concrete except where stated. 

 Uniaxial compressive strength (fc) e.g. 40E6 N/m
2
. The generally available 

“characteristic compressive strength” may not be appropriate for use in a finite 

element analysis with a concrete material model. This is because cube strengths 

do not represent a uniaxial compressive strength due to the influence of 

significant boundary restraints caused by friction on the platens of any testing 

machine, so it may be necessary to convert a cube strength to a cylinder 

strength. Note also that, commonly, “characteristic” (5% lower percentile) 

compressive strength is used for engineering purposes, and consideration 

should also be given to whether a mean, characteristic, or other value is most 

appropriate to the analysis in question. The CEB-FIP Model Code 1990 

equation 2.1-1 suggests that a mean cylinder strength (fcm) may be estimated 

from a characteristic cylinder strength (fck).  

 Uniaxial tensile strength (ft) e.g. 3E6 N/m
2
. This is likely to be a principal 

parameter in any analysis where concrete cracking is of significance. Ideally, 

the tensile strength would be available from test results. In the absence of test 

results, a value must be assessed using available data and relationships found in 

literature. Many design codes offer estimates of the value and CEB-FIP Model 

Code 1990 gives minimum, maximum and mean strengths based on an 

available characteristic cylinder strength. 

 Strain at peak uniaxial compression (c) e.g. 2.2E-3. If no data for the strain 

at peak uniaxial compression is available it can be estimated see Solver 

Reference Manual for details. As a guide, a reasonable value for most types of 

concrete is 2.2E-3. It is important that the Young’s modulus, E, (defined on the 

Elastic properties page) is consistent with the strain at peak uniaxial 

compression, ec. A reasonable check is to ensure that E > 1.2 fc/ ec 
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Specification of Fracture energy or Strain at end of softening curve via selection of 

the appropriate radio button on the dialog is required. Specifying fracture energy is 

usually the more convenient option: 

 Fracture energy per unit area (Gf) e.g. 130 N/m. For concrete, Gf is usually 

in the range 60 to 150J/m², varying with aggregate size but not so much with 

concrete strength. Where no data is available then a value of Gf = 130 N/m is 

suggested. Typical values of Gf are: for 16mm aggregate, 100 N/m; for 20 mm 

aggregate, 130 N/m; and for 32 mm aggregate, 160 N/m. 

 Strain at end of softening curve  (o) e.g. 3.5E-3.In some cases it may be 

deemed more suitable to specify the strain at end of softening curve. In such a 

case and where no data is available then a value for 0 of 3.5E-3 is a reasonable 

first estimate for most concrete. If the effective end of the softening curve 

parameter 0 , is set to zero, it will be calculated from 0 ~ 5Gf / Wc ft where Wc 

is a characteristic length for the element. 

 

Stress / strain curve for multi crack concrete model (Model 105) 

 Specify short and long term viscous/elastic coefficients  This option is only 

available if Creep or User-defined creep settings have been chosen and requires 

definition of one or more of the following parameters: 28 day creep factor; 

Proportion short term viscous; Proportion long term elastic. 

 Coefficient drying shrinkage and Coefficient chemical shrinkage Drying 

and autogenous (chemical) shrinkage are computed from changes in the degree 

of saturation and degree of hydration. It has been found experimentally that, 

once hydration is complete, there is a linear relationship between weight loss 

and drying shrinkage for a normal environmental range of humidity. Therefore, 

within this range, the drying shrinkage rate is based on the rate of change of 
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moisture content. See the notes section for the Transient Smoothed Multi-Crack 

Concrete Model in the Solver Manual for more details. 

Note relating to Uniaxial Compresive strength 

 The ‘Uniaxial compressive strength’ parameter in a concrete model is the 

ultimate strength of the material in compression. Since concrete behaves 

linearly only up to around 40% of the ultimate strength, crushing is expected to 

occur before that strength has been reached. As a result, concrete crush 

symbols will be plotted on the model (if requested to do so) when the plastic 

work-hardening parameter (which is calculated internally) is greater than zero. 

The presence of crushing symbols therefore indicates that the point at which 

the material begins to damage (i.e. crush) and behave nonlinearly, has been 

passed.  

Advanced concrete properties 

These more advanced concrete model material properties are related to measurable 

characteristics. Additional information relating to some of the properties and suggested 

values are stated in the notes that follow.  

 Biaxial to uniaxial stress ratio (r) e.g. 1.15. A range of 1.05 to 1.3 is 

suggested and a default of 1.15 is provided. 

 Initial relative position of yield surface (Hzo) e.g. 0.6. This parameter is 

governed by the value of Z0. For most situations in which the degree of triaxial 

confinement is relatively low, a value of between 0.5 and 0.6 is considered 

appropriate for Z0 however, for higher confinements a lower value of 0.25 is 

better 

 Dilatancy factor (giving plastic potential slope relative to that of yield surface) 

 e.g. -0.1The parameter  is used to control the degree of dilatancy. 

Associated plastic flow is achieved if =1, but it has been found that  values 

in the range -0.1 to –0.3 are required to match experimental results. Generally 

 is set to –0.1, but for high degrees of triaxial confinement –0.3 provides a 

better match to experimental data 

 Constant in interlock state function (mg) e.g. 0.425. This constant can be 

obtained from experimental data from tests in which shear is applied to an open 

crack. The default value for mg is taken as 0.425 but it is considered that a 

reasonable range for mg for normal strength concrete is between 0.3 and 0.6. 

However, it was found that a low value of 0.3 could lead to second cracks 

forming at shallow angles to the first, due to the development of relatively large 

shear forces 

 Contact multiplier on o  for the 1st opening stage (mhi) e.g. 0.5. This 

multiplier is used to govern the amount of contact from micro-cracks. 
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Experimental evidence suggests that the shear contact potential drops off more 

quickly for some concretes than for others, mhi governs the early (micro-crack) 

loss of shear contact potential and mful controls the final amount (associated 

with coarse aggregate interlock). To truly calibrate these parameters, tests, 

which open cracks to different degrees and then apply shear, are required; 

however for a wide range of standard concrete mhi = 0.5 and mful = 5.0 give 

reasonable results. A range of 0.25 to 2.0 is suggested and a default of 0.5 is 

provided 

 Final contact multiplier on o (mful) e.g. 5.0. It is assumed that there is a crack 

opening strain beyond which no further contact can take place in shear, eful, 

where eful is a multiple of 0, i.e. eful=mful 0. Trials suggest that when concrete 

contains relatively large coarse aggregate, i.e. 20 to 30mm, a value of mful in 

the range 10-20 is appropriate, whereas for concrete with relatively small 

coarse aggregate, i.e. 5 to 8mm, a lower value is appropriate, in the range 3 to 

5. This variation is necessary because the relative displacement at the end of a 

tension-softening curve (related via the characteristic dimension to 0.) is not in 

direct proportion to the coarse aggregate size, whereas the clearance 

displacement is roughly in proportion to the coarse aggregate size. Thus eful is 

not in a fixed ratio to 0 

 Shear intercept to tensile strength (ratio for local damage surface) (r) e.g. 

1.25. A range of 0.5 to 2.5 is suggested and a default value of 1.25 is provided. 

 Slope of friction asymptote for damage () e.g. 1.0. A range of 0.5 to 1.5 is 

suggested and a default value of 1.0 is provided. 

The use of non-default values for these remaining parameters should only be 

considered with knowledge of the fundamental equations used by the concrete model, 

and experimental data. 

 Crack fixity strain (default 0.05)  

 Fracture process zone width (e.g. about 3 times aggregate size) (default 0.06) 

 Number of iterations after which cracks are fixed (default 2). This is the 

number of iterations beyond which the crack directions are fixed. Increasing the 

number of iterations from the default value of 2 usually makes convergence 

more difficult but can lead to greater accuracy in some cases. If the number of 

iterations is increased , then the Maximum number of iterations on the 

Nonlinear and Transient Control dialog should also be increased 

 Maximum iterations for fracture strain update (default 2) 

 Residual Softening Factor (default 0.001) 

 Material constant Ap (default 0.60) 

 Material constant An (default 0.75) 

 Contact Sharpness Z1 (default 8.00) 
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 Contact Sharpness Z2 (default 8.00) 

 Limit of Contact Transition (default 3.00) 

 Angular limit between crack planes (Radians) e.g.1.0 (legacy support for 

Multi Crack Concrete Model (model 94) only) 

 Relaxation multiplier (default 1.0) 

 Creep factor multiplier (default 1.0) 

 Pickett factor multiplier (default 1.0) 

 Degree of percolation (default 0.05) 

 Degree of hydration first cure (default 0.5) 

 Moisture rate Pickett effect (default 10.0E-12) 

 Saturation start Pickett effect (default 0.85) 

 Short relaxation time (default 844.0E3) 

 First long relaxation time (default 12.96) 

 Second long relaxation time (default 95.04) 

 Temperature when degradation starts (default 40.0) 

 Temperature when degradation finishes (default 80.0) 

 Finishing degradation coefficient for E (default 0.9) 

 Finishing degradation coefficient for fc (default 0.8) 

 Finishing degradation coefficient for ft (default 0.9) 

 

Evolution of properties E, FC, Ft 

 Default When selected, set the 'Finishing degradation coefficient' entries for E, 

Fc and Ft to be 0.9, 0.8 and 0.9 respectively. 

 Define power coefficients When selected, replaces the 'Finishing degradation 

coefficient' entries for E, FC and Ft with 'Logistic model coefficient for E', 

'Power model coefficient for fc', and 'Power model coefficient model ft' entries, 

with deafults of 12.5, 3.0 and 1.0 respectively 

 

Planes of degradation 

A Plane of Degradation (POD) is formed when the principal stress reaches the tensile 

strength (ft); the POD is formed normal to the major principal stress axis. Thereafter, 

further damage can develop due to the combined action of shear and direct (normal) 

strains:  
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  Further normal tensile stress would increase the damage, while both the 

stiffness of the material along the POD normal (i.e. the normal stiffness) and 

the shear stiffness, would decrease  

  Further shear stress does not increase the damage; it causes aggregate 

interlock (i.e. contact) and an increase in both shear and normal stiffness 

  Further normal compressive stress does not increase the damage; normal and 

shear stiffness would increase due to contact. 

 

POD Local and Global Coordinate Systems 

Local damage surface 

 

Local Damage Surface 

The constants r and   are the strain equivalents of the material input parameters r 

and . The relative shear stress intercept to tensile strength ratio r= c / ft  where c is 

the shear stress intercept. Typical plots of the damage surface in stress space (the 

damage surface represents debonding or failure of the cement – aggregate interface) 

have shown the ratio between the shear strength and tensile strength of the interface 

bond to be approximately 1.25. 
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General notes 

 LUSAS nonlinear concrete material model 105 is based on the smeared crack 

concept. This imposes limitations on the maximum size of a mesh element 

based on material properties elastic modulus, tensile strength, and fracture 

energy – which should not exceed the equivalent of approximately 0.35m. If it 

does, the actual value for the fracture energy is increased internally. 

 When the purpose of an analysis is to check if cracking would occur and 

compute the crack widths, mesh refinement using a denser mesh, and time step 

convergence studies using a sufficient number of load steps should be done. 

Start with small load steps as the initial orientation of cracks tends to 

propagate, as in real life.  

 A better estimation of crack widths is likely to be achieved when linear 

elements are used. The use of quadratic elements is likely to result in less 

accurate crack widths. A minimum element length of greater than or equal to 

the reinforcement cover is suitable for linear elements. A minimum element 

length of greater than or equal to twice the reinforcement cover is suitable for 

quadratic elements. 

 Care should be taken when choosing an increment size for analysis with multi-

crack concrete models as inaccurate results can be obtained if the load 

increments are too large. More accurate results are obtained when smaller 

increment sizes are used. 

 If the dilatency factor () and the constant in interlock state function (mg) are 

set to 1.0 a symmetric solution will be carried out, otherwise the non-

symmetric solver will be invoked. 

 It is recommended that fine integration be used with these material models as 

this helps prevent the occurrence of mechanisms when cracking occurs. 

However the use of fine integration is more expensive computationally and can 

degrade the performance of higher order element types. 

 It is recommended that the following LUSAS options are used with these 

concrete models:  

252 Suppress pivot warnings. 

62 Allow negative pivots. 

Please contact LUSAS technical support if these options are required. 

See the Solver Reference Manual and Theory Manual for further detailed information 

relating to this material model and concrete material modelling in general. 
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Smoothed Multi-Crack Concrete Model (Model 109) 

This is a plastic-damage-contact model in which damage planes form according to a 

principal stress criterion and then develop as embedded rough contact planes. The 

softening curve for tensile failure is generally fixed by the specification of a fracture 

energy per unit area. This model can be combined with the creep and shrinkage 

behaviour appropriate to any of the available Codes of Practice, resulting a 

comprehensive time-dependent behaviour including cracking and crushing. 

Capabilities 

 Cracking and crushing results can be plotted for the Values layer as component 

‘Crack/Crush’ under the Stress entity. Planes representing the cracks are 

displayed in two or three-dimensions dependent upon the elements in use. 

Points of crushing are displayed using star symbols.  

 General crack width calculation is possible and can be plotted for the Contour 

and Values layers as component of CWMax (Maximum crack width) available 

from the Plastic strain entity. Component EFSMax (Maximum equivalent 

fracture strain) is also available. Note that these components are only 

applicable for elements that support the multi-crack concrete model. See 

Appendix K: Results Tables in the Element reference Manual for details. See 

also the general notes relating to crack width calculation at the end of this 

topic. 

 When used in conjunction with reinforcement attributes, a linear steel 

material model, and with the Crack Widths calculation utility, crack width 

calculations in accordance with EN 1992-1-1:2004 Eurocode 2 can be carried 

out. See Application Manual (Bridge, Civil & Structural) Crack Width 

Calculation to EN 1992-1-1 for more information. Crack width information 

can be plotted for the Contour and Values layers as components of Maximum 

Crack Width under the Crack Widths EN1991-1 entity.  

 LUSAS models that used previous versions of this concrete model will 

automatically be updated to use this concrete model, and when solved will use 

defaults to ensure that results obtained will be similar to those previously 

obtained. 

See Online help > Worked Examples > For LUSAS Bridge and LUSAS Civil & 

Structural > 'Nonlinear analysis of a concrete beam' for a worked example. 

Specification of Concrete model, Creep Code and Shrinkage 

See Concrete Models (Nonlinear) for concrete model, creep and shrinkage options. 

file:///C:/SVN/Content/Bridge/Crack_Widths/idh_crack_widths.htm
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 Elastic Material Properties 

 Young's modulus It is important that the Young’s modulus, E, is consistent 

with the strain at peak compressive stress, c. A reasonable check is to ensure 

that  E > 1.2 fc/ c 

 Poisson's ratio 

 Mass density The mass density of concrete (ρ) is generally taken to be of the 

order of 2400kg/m³ for mass concrete and 2500kg/m³ for reinforced or 

prestressed concrete. Where more accurate determination is required 

information specific to the concrete in question should be obtained or a value 

determined experimentally. 

 Coefficient of thermal expansion Available when the 'Thermal properties' 

check box is selected. 

 Mass Rayleigh damping constant Available when the 'Dynamic properties' 

check box is selected. 

 Stiffness Rayleigh damping constant Available when the 'Dynamic 

properties' check box is selected. 

 

Plastic Material Properties 

These primary material properties apply to both unreinforced (plain concrete) and 

reinforced concrete except where stated. 

 Uniaxial compressive strength (fc) e.g. 40 N/mm
2
. The generally available 

“characteristic compressive strength” may not be appropriate for use in a finite 

element analysis with a concrete material model. This is because cube strengths 

do not represent a uniaxial compressive strength due to the influence of 

significant boundary restraints caused by friction on the platens of any testing 

machine, so it may be necessary to convert a cube strength to a cylinder 

strength. Note also that, commonly, “characteristic” (5% lower percentile) 

compressive strength is used for engineering purposes, and consideration 

should also be given to whether a mean, characteristic, or other value is most 

appropriate to the analysis in question. Several international Codes of Practice 

offer a correlation between cylinder and cube strengths, such as stated in CEB-

FIP Model Code 1990, equation 2.1-1  

 Uniaxial tensile strength (ft) e.g. 3 N/mm
2
. This is likely to be a principal 

parameter in any analysis where concrete cracking is of significance. Ideally, 

the tensile strength would be available from test results. In the absence of test 

results, a value must be assessed using available data and relationships found in 

literature. Many design codes offer estimates of the value, for example, the 

CEB-FIP Model Code 1990 gives minimum, maximum and mean strengths 

based on an available characteristic cylinder strength. 
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 Strain at peak uniaxial compression (c) e.g. 0.0022. If no data for the strain 

at peak uniaxial compression is available it can be estimated see Solver 

Reference Manual for details. It is important that the Young’s modulus, E, is 

consistent with the strain at peak uniaxial compression, ec. A reasonable check 

is to ensure that E > 1.2 fc/ ec 

Specification of Fracture energy or Strain at end of softening curve via selection of 

the appropriate radio button on the dialog is required. Specifying fracture energy is 

usually the more convenient option: 

 Fracture energy per unit area (Gf) e.g. 0.13N/mm. For concrete, Gf is usually 

in the range 40 to 175J/m², varying with aggregate size and concrete strength. 

In the absence of test data, Codes of Practice offer correlations, for example 

CEB-FIP Model Code 1990 clause 2.1.3.3.2 

 Strain at end of softening curve  (o) e.g. 0.0035.In some cases it may be 

deemed more suitable to specify the strain at end of softening curve. Where the 

'fracture energy' option is selected, the strain at the end of the softening curve 

will be calculated as 0 ~ 5Gf / Wc ft where Wc is a characteristic length for the 

element. 

 

Stress / strain curve for multi crack concrete model (Model 94) 

 Note relating to Uniaxial Compressive strength 

 The ‘Uniaxial compressive strength’ parameter in a concrete model is the 

ultimate strength of the material in compression. Since concrete behaves 

linearly only up to around 40% of the ultimate strength, crushing is expected to 

occur before that strength has been reached. As a result, concrete crush 

symbols will be plotted on the model (if requested to do so) when the plastic 

work-hardening parameter (which is calculated internally) is greater than zero. 
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The presence of crushing symbols therefore indicates that the point at which 

the material begins to damage (i.e. crush) and behave nonlinearly, has been 

passed.  

Advanced concrete properties 

These more advanced concrete model material properties are related to measurable 

characteristics. Additional information relating to some of the properties and suggested 

values are stated in the notes that follow. The use of non-default values for the 

remaining parameters should only be done with a knowledge of the fundamental 

equations used by the concrete model, and experimental data. 

 Biaxial to uniaxial stress ratio (r) e.g. 1.15. A range of 1.05 to 1.3 is 

suggested and a default of 1.15 is provided. 

 Initial relative position of yield surface (Hzo) e.g. 0.6. This parameter is 

governed by the value of Z0. For most situations in which the degree of triaxial 

confinement is relatively low, a value of between 0.5 and 0.6 is considered 

appropriate for Z0 however, for higher confinements a lower value of 0.25 is 

better 

 Dilatancy factor (giving plastic potential slope relative to that of yield surface) 

 e.g. -0.1The parameter  is used to control the degree of dilatancy. 

Associated plastic flow is achieved if =1, but it has been found that  values 

in the range -0.1 to –0.3 are required to match experimental results. Generally 

 is set to –0.1, but for high degrees of triaxial confinement –0.3 provides a 

better match to experimental data 

 Constant in interlock state function (mg) e..g. 0.3. This constant can be 

obtained from experimental data from tests in which shear is applied to an open 

crack. A reasonable range for mg for normal strength concrete is between 0.3 

and 0.6 

 Contact multiplier on o  for the 1st opening stage (mhi) e.g. 0.5. This 

multiplier is used to govern the amount of contact from micro-cracks. 

Experimental evidence suggests that the shear contact potential drops off more 

quickly for some concretes than for others, mhi governs the early (micro-crack) 

loss of shear contact potential and mful controls the final amount (associated 

with coarse aggregate interlock). To truly calibrate these parameters, tests, 

which open cracks to different degrees and then apply shear, are required; 

however for a wide range of standard concrete mhi = 0.5 and mful = 5.0 give 

reasonable results. A range of 0.25 to 2.0 is suggested and a default of 0.5 is 

provided 

 Final contact multiplier on o (mful) e.g. 5.0. It is assumed that there is a crack 

opening strain beyond which no further contact can take place in shear, eful, 

where eful is a multiple of 0, i.e. eful=mful 0. Trials suggest that when concrete 

contains relatively large coarse aggregate, i.e. 20 to 30mm, a value of mful in 
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the range 10-20 is appropriate, whereas for concrete with relatively small 

coarse aggregate, i.e. 5 to 8mm, a lower value is appropriate, in the range 3 to 

5. This variation is necessary because the relative displacement at the end of a 

tension-softening curve (related via the characteristic dimension to 0.) is not in 

direct proportion to the coarse aggregate size, whereas the clearance 

displacement is roughly in proportion to the coarse aggregate size. Thus eful is 

not in a fixed ratio to 0 

 Shear intercept to tensile strength (ratio for local damage surface) (r) e.g. 

1.25. A range of 0.5 to 2.5 is suggested and a default value of 1.25 is provided. 

 Slope of friction asymptote for damage () e.g. 0.8. A range of 0.5 to 1.5 is 

suggested, hence teh default value used. 

 Angular limit between crack planes (Radians) e.g.1.0 (for Multi Crack 

Concrete Model (model 94) only) 

 Crack fixity strain Default value of 0.05.  

 Fracture process zone width Default value of 0.06 (based upon approximately 

3 times aggregate size) 

 Number of iterations after which cracks are fixed (default 2). This is the 

number of iterations beyond which the crack directions are fixed. Increasing the 

number of iterations from the default value of 2 usually makes convergence 

more difficult but can lead to greater accuracy in some cases. If the number of 

iterations is increased, then the value for 'Maximum number of iterations' on 

the Nonlinear and Transient Control dialog should also be increased 

 Maximum iterations for fracture strain update. Default value of 2. 

 Residual Softening Factor Default value of 0.001 

 Material constant Ap Default value of 0.60 

 Material constant An Default value of 0.75 

 Contact Sharpness Z1 Default value of 8.00 

 Contact Sharpness Z2 Default value of 8.00 

 Limit of Contact Transition Default value of 3.00 

 

Planes of degradation 

A Plane of Degradation (POD) is formed when the principal stress reaches the tensile 

strength (ft); the POD is formed normal to the major principal stress axis. Thereafter, 

further damage can develop due to the combined action of shear and direct (normal) 

strains:  
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  Further normal tensile stress would increase the damage, while both the 

stiffness of the material along the POD normal (i.e. the normal stiffness) and 

the shear stiffness, would decrease  

  Further shear stress does not increase the damage; it causes aggregate 

interlock (i.e. contact) and an increase in both shear and normal stiffness 

  Further normal compressive stress does not increase the damage; normal and 

shear stiffness would increase due to contact. 

 

POD Local and Global Coordinate Systems 

Local damage surface 

 

Local Damage Surface 

The constants r and   are the strain equivalents of the material input parameters r 

and . The relative shear stress intercept to tensile strength ratio r= c / ft  where c is 

the shear stress intercept. Typical plots of the damage surface in stress space (the 

damage surface represents debonding or failure of the cement – aggregate interface) 

have shown the ratio between the shear strength and tensile strength of the interface 

bond to be approximately 1.25. 
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General notes 

 LUSAS nonlinear concrete material model 109 is based on the smeared crack 

concept. This imposes limitations on the maximum size of a mesh element 

based on material properties elastic modulus, tensile strength, and fracture 

energy – which should not exceed the equivalent of approximately 0.35m. If it 

does, the actual value for the fracture energy is increased internally. 

 When the purpose of an analysis is to check if cracking would occur and 

compute the crack widths, mesh refinement using a denser mesh, and time step 

convergence studies using a sufficient number of load steps should be done. 

Start with small load steps as the initial orientation of cracks tends to 

propagate, as in real life. It is also recommended to: 

 Turn off "line searches" whenever using this material. This is done in the 

Nonlinear and Transient control dialog: under 'Solution Strategy' click the 

'Advanced' button, and in the sub-dialog, enter the 'Maximum number of 

line searches' as 0. 

 Turn off "arc length control", unless analysis of the structure beyond peak 

load is of particular interest. Arc length control tends to extend the 

analysis needlessly in other cases. This is done in the Nonlinear and 

Transient control dialog: when using 'Automatic' incrementation, click the 

'Advanced' button and in the sub-dialog, enter the 'Stiffness ratio to switch 

to arc-length' as 0. 

 A better estimation of crack widths is likely to be achieved when linear 

elements are used. The use of quadratic elements is likely to result in less 

accurate crack widths. A minimum element length of greater than or equal to 

the reinforcement cover is suitable for linear elements. A minimum element 

length of greater than or equal to twice the reinforcement cover is suitable for 

quadratic elements 

 Care should be taken when choosing an increment size for analysis with multi-

crack concrete models as inaccurate results can be obtained if the load 

increments are too large. More accurate results are obtained when smaller 

increment sizes are used. 

 If the dilatancy factor () and the constant in interlock state function (mg) are 

set to 1.0 a symmetric solution will be carried out, otherwise the non-

symmetric solver will be invoked. 

 It is recommended that fine integration be used with these material models as 

this helps prevent the occurrence of mechanisms when cracking occurs. 

However the use of fine integration is more expensive computationally and can 

degrade the performance of higher order element types. 

 It is recommended that the following LUSAS options are used with these 

concrete models:  
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252 Suppress pivot warnings. 

62 Allow negative pivots. 

Please contact LUSAS technical support if these options are required. 

See the Solver Reference Manual and Theory Manual for further information relating 

to concrete material modelling. 

Concrete (Reinforced) Material Model 

Reinforced concrete material for use with the RC frame design facility is defined by 

selecting the Attributes > Material > Concrete (Reinforced) menu item. This 

material references linear elastic concrete and steel materials provided in the Material 

Library. The entries are filtered to show those that are valid according to the Code of 

Practice selected. 

To carry out reinforced concrete frame design checks, a concrete material and a 

reinforcement material need to be assigned to the lines representing reinforced 

concrete members in the model. This cannot be done by defining and assigning 

separate concrete and steel material attributes (since only one material can be assigned 

to a line feature within Modeller) so the concrete (reinforced) material model, which 

provides a compound material attribute, must be defined and assigned instead.  

When created, three material entries appear in the Attributes  Treeview, one for 

each concrete and steel isotropic material defined, and one compound material entry 

that references them both. To carry out reinforced concrete frame design checks only 

the compound material attribute should be assigned to lines in the model representing 

reinforced concrete members. 

Concrete Heat of Hydration 

Concrete heat of hydration properties can only be defined for a Thermal or Hygro-

Thermal Analysis. Thermal material properties can be entered by using the 

Attributes> Material> Isotropic or Attributes> Material> Orthotropic menu 

items. 

See Isotropic/Orthotropic Material for general details. 

The following heat of hydration parameters can be defined: 

 Cement type Parameters defining the chemical composition of cement types I, 

II, III and V may be chosen, or the chemical composition of any cement can be 

defined explicitly by selecting the General option in the drop down list. Further 

information on this load type can be found in theTheory Manual. 

Modelling units to be used 

Although any set of units can be used for mass and volumes, the temperatures used in 

the analysis are assumed to be, and must be defined in, degrees Celsius.  

file:///C:/SVN/Content/Design/RC_Frame_Design/rc_frame_design.htm
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For all cement types the following data, using the model units, must be defined:  

 Mass of cement per unit volume This should not include the mass of slag or 

the mass of fly ash and must be defined in kg/m
3
) 

 Water/Cementitious ratio =(mass per unit volume of water) / mass per unit 

volume of cement and any slag and any fly ash) 

 Mass of slag per unit volume Mass of ground granulated blast furnace slag 

per unit volume (must be defined in kg/m
3
) 

 Mass of fly ash per unit volume Also known as flue ash (must be defined in 

kg/m
3
) 

 CaO content of fly ash (%) This must be specified if fly ash is to be included. 

Some typical values are Class C fly ash (24%) and Class F fly ash (11%).  

 Delay for heat of hydration A (negative) factor that can be specified to delay 

the onset of heat of hydration to get a best fit of temperature curve data with 

experimental data. 

If the User cement type option is selected then the following also need to be defined: 

 C3S content C3S content (%) of cement 

 C2S content 
C2S content (%) of cement 

 C3A content C3A content (%) of cement 

 C4AF content C4AF content (%) of cement 

 Free CaO 

content 

Free CaO content (%) of cement 

 SO3 content SO3 content (%) of cement 

 MgO content MgO content (%) of cement 

 Blaine value Sometimes referred to as fineness of cement (surface 

area/unit weight) 

Timescale units used for heat of hydration analysis are those specified for the model 

when first defined, or as specified on the Model properties dialog. 

Worked example 

See Online help > Worked Examples > For LUSAS Bridge and LUSAS Civil & 

Structural >  'Staged Construction of a Concrete Dam', for a typical use of this facility. 
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Stress Resultant (Model 29) 

The Stress Resultant model is accessed using the Attributes> Material 

Isotropicmenu item. 

The model is formulated directly with the beam or shell stress resultants plus 

geometric properties, therefore it is computationally cheaper. Consult the Element 

Reference Manual the check which elements are valid for this material model.  

Material Parameters 

 Yield stress The level of stress at which a material is said to start 

unrecoverable or plastic behaviour. 

 Section shape Match the section type to the element being used. 

See the Solver Reference Manual for further details. 

Tresca (Model 61) 

The Tresca model is accessed using the Attributes > Material > Geotechnical... 

menu. 

The elasto-plastic Tresca yield surface model may be used to represent ductile 

behaviour of materials which exhibit little volumetric strain (for example, metals). The 

model incorporates elasto-plastic behaviour with isotropic hardening. 

Material Parameters 

 Yield stress The level of stress at which a material is said to start 

unrecoverable or plastic behaviour. 

 Heat fraction The fraction of plastic work that is converted into heat energy. 

Only applicable to temperature dependent materials and coupled analyses 

where the heat produced due to the rate of generation of plastic work is of 

interest. The value should be between 0 and 1. 

 Slope of Yield Stress The slope of the uniaxial yield stress against equivalent 

plastic strain. 

 Plastic strain The limit of equivalent plastic strain up to which the hardening 

curve is valid. 
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Hardening Curve Definition for the Tresca Yield Model 

Note 

The Modified Mohr-Coulomb model can also model the Tresca yield surface as a 

special case and provides an improved formulation with better convergence 

characteristics. It is applicable to solid, axisymmetric and plane strain applications. 

See theSolver Reference Manual for further details. 

Stress Potential (von-Mises, Hill, Hoffman) 

The Stress Potential model is accessed using the Attributes> Material> 

Isotropicmenu item, and selecting the Plastic option. 

The use of nonlinear material properties applicable to a general multi-axial stress state 

requires the specification of yield stresses in each direction of the stress space when 

defining the yield surface (see the LUSAS Theory Manual).  

Notes 

 The yield surface must be defined in full, irrespective of the type of analysis 

undertaken. This means that none of the stresses defining the yield surface can 

be set to zero. For example, in a plane stress analysis, the out of plane direct 

stress, zz, must be given a value which physically represents the model to be 

analysed. 

 The stresses defining the yield surface in both tension and compression for the 

Hoffman potential must be positive. 

 The stresses specified in each direction are related in defining the yield surface. 

Randomly specified values can lead to convergence difficulties. As a guide, to 
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avoid a concave yield surface, stresses should comply with the following 

relationship: 

 

Material Properties 

 Yield stress The level of stress at which a material is said to start 

unrecoverable or plastic behaviour. 

 Heat fraction The fraction of plastic work that is converted into heat energy. 

Only applicable to temperature dependent materials and coupled analyses 

where the heat produced due to the rate of generation of plastic work is of 

interest. The value should be between 0 and 1. 

Hardening Properties 

There are three methods for defining nonlinear hardening:  

 Total strain Uniaxial yield stress v Total strain 

 Plastic strain Uniaxial yield stress v Effective plastic strain 

 Hardening gradient Hardening gradient (slope) v Effective plastic strain 

 

Hardening curves are defined as follows 

 Uniaxial yield stress vs. Total Strain Requires input of coordinates at the ends 

of straight line approximations to the stress strain curve.  

Linear properties specify the slope of the stress strain curve up to yield in terms 

of a Young's modulus. Plastic properties specify the yield stress (sy) and the 

hardening data is input as a series of coordinates, for example (s1, e1), (s2, e2), 

etc. LUSAS extrapolates the curve past the last specified point. 
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 Uniaxial yield stress vs. Effective plastic strain Requires input of coordinates 

at the ends of straight line approximations to the uniaxial yield stress vs. 

effective plastic strain curve.  

For the curve shown here the plastic properties will contain the yield stress (sy) 

and the hardening data will be input as (s1, ep1), (s2, ep2), etc. LUSAS 

extrapolates the curve past the last specified point. 

 

 Hardening gradient (Slope) vs. Effective plastic strain Requires 

specification of gradient and limiting strain values for successive straight line 

approximations to the stress vs. effective plastic strain curve.  

In this case hardening gradient data will be input as (C1, ep1), (C2, ep2) for 

each straight line segment. LUSAS extrapolates the curve past the last 

specified point. 

 

Optimised von Mises (Model 75) 

The Optimised von Mises model is accessed using the Attributes> Material> 

Isotropicmenu item. 
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This model represents ductile behaviour of materials that exhibit little volumetric 

strain (for example, metals). It is especially suitable for explicit dynamics. 

Material Parameters 

 Initial unixial yield stress The level of stress at which a material is said to start 

unrecoverable or plastic behaviour. 

 Heat fraction coefficient The fraction of plastic work that is converted into 

heat energy. Only applicable to temperature dependent materials and coupled 

analyses where the heat produced due to the rate of generation of plastic work 

is of interest. The value should be between 0 and 1. 

Hardening (von Mises) 

 Kinematic hardening Plasticity hardening formulation associated with 

translation, as opposed to expansion, of the yield surface. 

In the optimised implicit model the direction of plastic flow is evaluated from the 

stress return path. The implicit method allows the proper definition of a tangent 

stiffness matrix which maintains the quadratic convergence of the Newton-Raphson 

iteration scheme otherwise lost with the explicit method. This allows larger load steps 

to be taken with faster convergence. For most applications, the implicit method should 

be preferred to the explicit method. 

The model incorporates linear isotropic and kinematic hardening. 

 

Nonlinear Hardening Curve for the von Mises Yield Model (Model 75) 

See the Solver Reference Manual and the Theory Manual for further details. 

Non Associated Mohr-Coulomb (Model 65) 

The Non Associated Mohr-Coulomb elasto-plastic model is accessed using the 

Attributes> Material> Isotropicmenu item. 

This model may be used to represent dilettante frictional materials that exhibit 

increasing shear strength with increasing confining stress (for example, granular soils 
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or rocks). The model incorporates isotropic hardening and dilatancy, and only allows 

tension if cohesion is included. 

A Modified Mohr Coulomb model is also available which provides tensile and/or a 

compressive cut-off limits to prevent unrealistic stresses from developing and to 

improve solution convergence. 

Material Properties 

 Initial Cohesion [Ci] defining the degree of granular bond and a measure of 

the shear strength. 

 Initial and Final Friction Angle [i and f]defining the angles of shearing 

resistance 

 Dilation Angle defining the magnitude of plastic volume strains. 

 

Hardening input 

 Cohesion hardening parameter [hc] 

 Limiting equivalent plastic strain [f] 

 

Cohesion Definition for the Non-Associated Mohr-Coulomb Model (Model 65) 
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Friction Angle Definition for the Non-Associated Mohr-Coulomb Model (Model 65) 

See the Solver Reference Manual for further details. 

Modified Mohr Coulomb Model  

The Modified Mohr-Coulomb model is accessed using the Attributes> Material > 

Geotechnical... menu item. 

This model applies a tensile and/or a compressive cut-off to the Non Associated Mohr-

Coulomb model. When the standard Mohr-Coulomb model would potentially predict 

tensile stresses beyond the uniaxial tensile limit of the material, the tension cap may be 

used to prevent such stresses occurring.. In compression the cut-off results in 

irreversible deformations once the maximum compressive stress is exceeded. The cut-

off can be applied to either a single principal stress component or to the mean 

pressure. 

The Tresca model is recovered as a special case of the Modified Mohr-Coulomb 

model by setting both the angles of friction and dilation to 0. The cohesion value C is 

equal to half the uniaxial yield stress. 

Notes 

 The model may be used with 3D continuum, plane strain and axi-symmetric 

elements as well as the corresponding two-phase elements. 

 If neither of the Rankine or Pressure options is selected the model will behave 

as the standard Mohr-Coulomb model. 

 The cohesion, tensile and compressive stresses may be specified to be 

functions of the effective plastic strain. Their variations with effective plastic 

strain are input as a series of piecewise linear segments. 
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 The dilation angle must be set to the angle of friction to model associative 

flow. 

 The use of non-symmetric solver is recommended if the dilation angle is not 

equal to the angle of friction, or if strain hardening is defined. 

 The effects of strain hardening on the yield surfaces using a pressure cut-off 

are shown diagramatically in the Solver Reference Manual. 

See the Solver Reference Manual and theTheory Manual for further details. 

Differences between the Non Associated and Modified Mohr 

Coulomb models 

In the Non Associated Mohr-Coulomb model, the yield surface goes to a singularity in 

the tensile direction. As a result, at "very low" confining stresses, convergence 

problems may be met. With the Modified Mohr-Coulomb model the tension cut-off 

removes the singularity with the intention of improving the numerical solution and 

making convergence easier. 

In the Non Associated Mohr-Coulomb model, the yield surface becomes larger 

indefinitely in the compression direction, inferring that for any value of confining 

stress, the soil is getting stronger. With the Modified Mohr-Coulomb model the 

compressive cut-off prevents the strength in compression increasing indefinitely; it 

reaches the specified value and gets no stronger. 

Drucker-Prager (Model 64) 

The Drucker - Prager model is accessed using the Attributes > Material > 

Geotechnical...menu item. 

This model may be used to represent the ductile behaviour of materials which exhibit 

volumetric plastic strain (for example, granular materials such as concrete, rock and 

soils). The model incorporates isotropic hardening. 

Material Properties 

 Initial Cohesion [C0] A material property of granular materials, such as soils or 

rocks, describing the degree of granular bond and a measure of the shear 

strength. Setting the initial cohesion to zero is not recommended as this could 

cause numerical instability under certain loading conditions. 

 Initial Friction angle [f0] A material property of granular materials, such as 

cohesive soils and rocks. 

 Heat fraction cofficient [hf] The fraction of plastic work that is converted into 

heat energy. Only applicable to temperature dependent materials and coupled 

analyses where the heat produced due to the rate of generation of plastic work 

is of interest. The value should be between 0 and 1. 
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Hardening values 

 Slope of cohesion The slope of the cohesion against the equivalent plastic 

strain. 

 Slope of friction angle The slope of the friction against the equivalent plastic 

strain. 

 Plastic strain The limit of equivalent plastic strain up to which the hardening 

curve is valid. 

 

Cohesion Definition for the Drucker-Prager Yield Model (Model 64) 

 

Friction Angle Definition for the Drucker-Prager Yield Model (Model 64) 

See the Solver Reference Manual for further details. 
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Creep 

Creep is the inelastic behaviour that occurs when the relationship between stress and 

strain is time dependent. The creep response is usually a function of the stress, strain, 

time and temperature history. Unlike time independent plasticity where a limited set of 

yield criteria may be applied to many materials, the creep response differs greatly for 

different materials.  

Creep Properties 

Power, exponential and eight parameter uniaxial creep laws are available and a time 

hardening form is available for each. The power creep law is also available in a strain 

hardening form. Fully 3D creep strains are computed using the differential of the von 

Mises or Hill stress potential. A user-definable creep interface is also available which 

allows a programmable uniaxial creep law.  

Stress Potential 

The definition of creep properties requires that the shape of the yield surface is 

defined. The stresses defining the yield surface are specified using the Stress Potential 

material model.  

If a Stress Potential model is used in the Plastic definition then this will override the 

Creep stress potential and will apply to both the plastic properties and the creep 

properties. The Creep stress potential is only required when defining linear materials. 

If a stress potential type is not specified then von Mises is set as default. 

None of the stresses defining the stress potential may be set to zero. For example, in a 

plane stress analysis, the out of plane direct stress must be given a value which 

physically represents the model to be analysed. 

User Supplied Creep Properties 

The user creep facility allows user supplied creep laws to be used. This facility 

provides completely general access to the LUSAS Solver property data input and 

provides controlled access to the pre- and post-solution constitutive processing and 

nonlinear state variable output.  

Notes 

 The user-supplied routine must return the increment in creep strain. Further, if 

implicit integration is to be used then the variation of the creep strain increment 

with respect to the equivalent stress, and also with respect to the creep strain 

increment, must be defined. 

 If the function involves time dependent state variables they must be integrated 

in the user-supplied routine. 
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 If both plasticity and creep are defined for a material, the creep strains will be 

processed during the plastic strain update. Stresses in the user routine may 

therefore exceed the yield stress. 

 User-supplied creep laws may be used as part of a composite element material 

assembly. 

See the Solver Reference Manual and the Theory Manual for further details. 

Damage 

Damage is assumed to occur in a material by the initiation and growth of cavities and 

micro-cracks. The damage models allow parameters to be defined which control the 

initiation of damage and post-damage behaviour. Damage models are available for 

continuum and composite elements. 

Continuum Damage Models 

In LUSAS a scalar damage variable is used in the degradation of the elastic modulus 

matrix. This means that the effect of damage is considered to be non-directional or 

isotropic. Two LUSAS damage models are available (Simo and Oliver) together with a 

facility for a user-supplied model. 

A damage analysis can be carried out using any of the elastic material models and the 

following nonlinear models: 

 von Mises 

 Hill 

 Hoffman 

Note. Creep material properties may be included in a damage analysis. See the 

Solver Reference Manual for further details. 

Composite Matrix Failure Model 

The composite matrix failure model simulates matrix failure using the Hashin damage 

criteria. The model can only be used with composite solid elements. It is defined under 

the Damage tab on the Material Orthotropic attribute dialog.  

Material Properties 

 Ply tensile strength in fibre direction 

 Ply compressive strength in fibre direction 

 Ply shear strength measured from a cross ply laminate 

 Ply transverse tensile strength (normal to fibre direction) 

 Ply transverse compressive strength 
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See the Solver Reference Manual for further details. 

Viscoelastic 

Viscoelasticity can be coupled with the linear elastic and non-linear plasticity, 

(isotropic or orthotropic), creep and damage models available in LUSAS. The model 

restricts the viscoelastic effects to the deviatoric component of the material response. 

This enables the viscoelastic material behaviour to be represented by a shear modulus 

Gv and a decay constant . Viscoelasticity imposed in this way acts like a spring-

damper in parallel with the elastic-plastic, damage and creep response. Coupling of the 

viscoelastic and the existing nonlinear material behaviour enables hysteresis effects to 

be modelled. 

User Supplied Visco Elastic Properties 

The user supplied viscoelastic properties facility enables routines for implementing a 

user supplied viscoelastic model to be invoked. This facility provides completely 

general access to the LUSAS Solver property data input via this data section and 

provides controlled access to the pre- and post-solution constitutive processing and 

nonlinear state variable output via these user supplied routines.  

Notes 

 When viscoelastic properties are coupled with a nonlinear material model it is 

assumed that the resulting viscoelastic stresses play no part in causing the 

material to yield and no part in any damage or creep calculations. 

Consequently the viscoelastic stresses are stored separately and deducted from 

the total stress vector at each iteration prior to any plasticity, creep or damage 

computations. Note that this applies to both implicit and explicit integration of 

the creep equations. 

 Nonlinear Control must always be specified when viscoelastic properties are 

assigned. In addition Dynamic or Viscous Control must also be specified to 

provide a time step increment for use in the viscoelastic constitutive equations. 

If no time control is used the viscoelastic properties will be ignored. 

See Solver Reference Manual for further details. 

Shrinkage Properties  

The cure of concrete and thermoset resins is accompanied by isotropic shrinkage 

which in the case of concrete depends on time, temperature and other environmental 

factors whilst for thermoset resins the shrinkage is normally described with respect to 

the degree of cure.  

The shrinkage implementation in LUSAS allows an irreversible reduction in volume 

with time to be modelled. The shrinkage of concrete is accommodated using the 

equations defined in the design code CEB-FIP90 and also using a more general routine 
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in which shrinkage is defined using a piecewise linear curve. In the general case, 

shrinkage can be defined as a function of time or degree of cure. A user facility is also 

available if required.  

See the Solver Reference Manual for further details. 

Two-Phase Material 

Two-Phase material properties (defining a fully or partially saturated state) can be 

added to material definitions for Isotropic, Orthotropic and Modified Cam-Clay 

materials that are defined using the Attributes> Material> menu item. A Two-phase 

check box along the top of the material dialog adds a new property page to the current 

material definition, and allows Two-phase material data to be specified. 

Usage 

Two-phase material properties are required when performing an analysis in which 

two-phase elements are used to define soil in either a fully or partially saturated state. 

LUSAS can model the deformation of fully or partially saturated porous media during 

the consolidation process, under isothermal conditions and small strain assumptions, 

as well as in the limiting drained and undrained conditions. For both 2D and 3D cases, 

nonlinear material models and large deformations are supported. 

Two-phase material properties can be defined for the following soil types: 

 Fully saturated - In addition to elastic properties, it is necessary to specify the 

Bulk Modulus values for solid and fluid phases, the porosity of the medium, the 

unit weight of fluid, hydraulic conductivity values of the medium in X, Y and Z 

directions, and the fluid density. It is possible to specify the solid phase of the 

material to be "incompressible", by selecting the 'Incompressible solids' option, 

which negates the need to input the corresponding bulk modulus. 

 Partially saturated - requires additional saturation properties, namely 

'Irreducible saturation' and 'Degree of saturation to be considered fully 

saturated' to be specified. It is also required to specify a draining and filling 

(absorption) curve using the "Define curves" button (although it is possible to 

define only the draining curve and have the filling curve assumed identical). 

 Piecewise linear partially saturated - requires the same parameters as for 

partially saturated material, above, with the draining and filling curve defined 

in a piecewise fashion and a 'Curve tolerance' (used to judge whether the point 

to be interpolated is on a segment) needs to be specified. 

 The Define curves button is only enabled for partially saturated materials and 

allows the draining and filling curves to be defined. 

 Incompressible solids Selection of this option excludes the Bulk modulus of 

solid phase entry from the data input table. 

See the Solver Reference Manual for details of all input parameters. 
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Draining and filling curves 

Draining and filling curves must be specified for partially saturated materials. This 

may be by defining the rate of water extraction, weight factor, air entry and 

permeability values or manually by selecting "piecewise linear" and specifying pore 

pressure. Manually-defined (piecewise linear ) draining and filling curves can be 

defined for partially drained materials by specifying pore pressure, relative 

permeability and effective saturation values. For both methods, if a draining and filling 

curve is defined a scanning curve factor is used to specify how a jump should be 

made between the curves if jumping draining/exsorption to filling/insorption or vice-

versa. 

 

Typical draining and filling curve showing jump from draining/exsorption to filling/insorption (left) 

and jump from filling/insorption to draining/exsorption (right) 

Notes 

 For geotechnical analyses that do not include a two phase material definition, 

the mass density (specified as part of the linear elastic properties) must relate to 

the total mass of the soil, including the mass of any water content in the voids. 

The soil may be saturated, partially saturated or dry. For geotechnical analyses 

that include a two phase material definition, the fully saturated soil density 

must be stated. If it is required to define soil grain density instead of fully 

saturated soil density, visit the Attributes tab of the Model Properties dialog 

and select the 'Input soil grain density for two-phase materials' option.  

 A fully saturated soil density value is converted and written to a solver data file 

as a soil grain density value for solving purposes. 

 Hydraulic Conductivity is often referred to as the Coefficient of Permeability. 
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 Usually, the value of Bulk modulus of solid phase is quite large compared to 

Bulk modulus of fluid phase and not readily available to the user. If Bulk 

modulus of solid phase is input as 0, LUSAS assumes an incompressible solid 

phase. The bulk modulus of fluid phase is more obtainable, and for water is 

2200 MPa. 

 Two-phase material properties can only be assigned to two phase elements. 

 When performing a linear consolidation analysis transient control settings must 

be specified specifying Consolidation in the Time domain section of the 

Nonlinear and Transient control dialog. 

 Two-phase material properties may be combined with any other material 

properties and include creep, damage and viscoelastic properties if required. 

 For some flow problems, a final steady state solution may only be required. For 

saturated soils a nonlinear analysis with manual incrementation should be used 

and this will give an exact solution. For unsaturated soils a nonlinear transient 

should be used to get accurate results. A nonlinear static analysis may be used 

but may give less accurate results. For example, the total discharge extracted 

from the reactions may be incorrect. 

 For nonlinear solutions ill-conditioning may occur and a non-symmetric 

solution may be required. This can be specified by accessing the  Nonlinear 

analysis options object. A Fast Parallel Direct Solver is recommended. 

See Solver Reference Manual for further details. 

Usage 

Use of two-phase material and coupled pore fluid diffusion/stress analysis capabilities 

in LUSAS permits: 

 Establishing the initial equilibrium state via a geostatic analysis control step. 

 Modelling partially saturated fluid flow through porous medium, e.g. seepage 

of water through an earth dam, where the position of the phreatic surface (the 

boundary between fully saturated and partially saturated soil) is of interest. 

 Including the influence of the pore fluid weight on the solid skeleton only 

(excess pore pressure solution) or on both the solid skeleton and fluid (total 

pore pressure solution). 

 Using a default analytical capillary pressure relationship or defining a piece-

wise relationship in a tabular form, as the accuracy of simulation depends on 

the use of an accurate relationship. 

 Specifying different filling (or absorption) and draining (or exsorption) 

capillary (or pore water) pressure – effective saturation curves, which can 

exhibit hysteresis behaviour, as well as a scanning curve for transition between 

absorption and exsorption. 
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 In addition to prescribed head (pressure) and impervious (closed) boundary 

conditions, the inflow/outflow over a boundary can be considered. It is also 

possible to control the boundary condition automatically when a phreatic 

surface meets a boundary surface using lift-off supports. 

K
0
 Initialisation properties 

K0 initialisation properties allow initial stresses in soil to be calculated. K0 data can be 

defined for material models used in soil analyses, via dedicated pages on geotechnical 

material properties dialogs. 

K
0
 initialisation for geotechnical models excluding Modified 

Cam-clay 

 Coefficient of lateral earth pressure, K0, relates vertical stresses, σv, in the 

soil to horizontal stresses, σH, via the relationship σH=K0 σv where it is assumed 

that shear stresses are negligible. On element activation, the effective vertical 

stresses in the soil are calculated from the soil weight and any additional loads 

such as overburden. Horizontal stresses are then calculated using the K0 value. 

As long as strict K0 conditions of horizontal soil layers and phreatic surface are 

maintained, the generated stress field will be in balance with the loads. In the 

case that this is not true, further iterations will be required to bring the soil into 

equilibrium. K0 can be greater than 1.0 during the ground initialisation phase at 

the start of the analysis but must be less than 1.0 when applied to elements 

which are activated at later stages. 

K
0
 initialisation of Modified Cam-clay 

The Modified Cam-clay model requires the input of two state variables. The pre-

consolidation pressure, Pc, determines the size of the yield surface and the initial void 

ratio, eo, the amount of compression the soil has undergone. These parameters are 

input in the Cam clay material parameters and, using material spatial variations, may 

be easily varied with depth. 

Alternatively, they can be calculated during the K0 initialisation. For a normally 

consolidated clay, the Coefficient of lateral earth pressure of normally 

consolidated clay, K0, needs to be defined. Once the stresses are calculated, the pre-

consolidation pressure is known as the soil lies on the yield surface. If the Specific 

volume of the soil on the NCL (Normal Consolidation Line), N, at a pressure of 1.0 

is provided, the specific volume on the stable state boundary surface for the stress state 

can be calculated during K0 initialisation and hence the value of the initial void ratio, 

eo. In the absence of N, the value from the material property input will be used. 

For over-consolidated soils the value of K0 can be calculated using the equation: 
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where:ocr is the Over-consolidation ratio (ocr=σvmax⁄σv where σvmax is maximum 

historic vertical stress applied to the soil), Knc the coefficient of lateral earth pressure 

for normal consolidation (i.e. K0 for a normally consolidated soil) and νul is the 

Poisson’s ratio (for the soil) for unloading. 

Material spatial variations can be applied to the K0 parameters and to the ocr in 

particular. Close to the surface the ocr changes very rapidly, going to infinity, when 

the vertical stress goes to zero. In this case a much more reduced value of ocr must be 

input to avoid problems with its interpolation at the element Gauss points. 

Usage 

The initialisation of K0 ground conditions requires a first loading increment in which 

just the soil loads and groundwater conditions are applied. For K0 conditions to be 

valid, both the soil layers and the phreatic surface must be horizontal. Also, the 

vertical boundaries at the edges of the model must allow free movement in the vertical 

direction but be restrained in the horizontal direction. If these conditions are strictly 

met the internal stress field applied to the soil will exactly balance the loads and the 

soil will not displace. 

Duncan-Chang Model 

The Duncan-Chang model is defined using the Attributes> Material> 

Geotechnical... menu. 

Duncan-Chang is a simple soil model whose parameters are calculated by curve fitting 

triaxial test data over a range of cell pressures, σ3. It takes an incremental elastic 

approach in which Young’s modulus and Poisson’s ratio are evaluated from current 

stresses. A predictor step is used to determine whether the soil is loading or unloading, 

following which, corresponding values of Young’s modulus and Poisson’s ratio are 

calculated for use in the incremental elastic modulus matrix. 

The model can be used with standard continuum elements as well as the two-phase 

elements. The modelling parameters required can be evaluated in standard laboratory 

tests. 

Material Properties 

The material properties to be defined vary according to the Poisson's ratio model used. 

The implementation allows for three descriptions of Poisson's ratio, : 

 Constant 

 Direct (E-) method 
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 Indirect (E–b) method 

 

These material properties are listed for a Constant Poisson's ratio model unless 

otherwise noted. 

 Cohesion - the void ratio of the soil at the start of the analysis  

 Friction angle in degrees 

 Change of angle of friction - with respect to cell pressure (in degrees) 

 Failure ratio   

 Density   

 Atmospheric pressure 

 Initial Young's modulus number 

 Young's modulus number 

 Initial Young's modulus exponent 

 Bulk modulus number (Indirect (E-b) method 

 Bulk modulus exponent (Indirect (E-b) method 

 Poisson's ratio 

 Poisson's ratio tangent (Direct (E-v) method 

 Cell pressure moderation component (Direct (E-v) method 

 Poisson's ratio at atmospheric pressure (Direct (E-v) method 

 Young's modulus when soil fails (Indirect (E-b) method 

 Poisson's ratio when soil fails (Indirect (E-b) method 

 

For further information on these parameters. See Solver Reference Manual : Duncan-

Chang model 

Notes 

 The initial stress state can be input by using residual stress load types, by using 

an initial stress with gravity or by defining K0 properties from the K0 tab. 

 If used with two-phase properties, the density property refers to the density of 

the dry soil particles rather than that of the soil mass including water content. 

 This model provides a very simple description of soil behaviour. The 

incremental linear elastic formulation, in the absence of nonlinearities, will 

always provide a solution, but this solution may not be valid. This model is 
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best used in situations for which it has been previously demonstrated as 

providing acceptable answers. 

Dynamic and Thermal Properties 

Dynamic and Thermal expansion properties are optional and are usually only required 

when dynamic or thermal analyses are to be carried out.  

 Mass Rayleigh damping coefficient   

 Stiffness Rayleigh damping constant 

 Coefficient of thermal expansion 

Two-Phase Properties 

Two-phase material properties are required when performing a consolidation 

analysis or groundwater flow problem in which two-phase elements are used to define 

soil in either a fully or partially saturated state. 

K
0
 initialisation Properties 

K0 initialisation properties allow initial stresses in soil to be calculated. 

Varying Attributes 

Material properties varying with depth can be used with this model. Any such varying 

properties may be specified by selecting a previously defined variation. To do this 

press the variation button  when you enter a value in any field. 

See the Solver Reference Manual for further details. 

Hoek-Brown Material Model 

The Hoek-Brown model is defined using the Attributes> Material> Geotechnical... 

menu. 

The Hoek-Brown model is an elastic-perfectly-plastic constitutive model which 

describes the behaviour of intact and fractured rocks, featuring a yield surface which is 

a curved hexagonal cone. It is an empirical model, and its parameters are based on 

both laboratory test data, and visual observation of the rock. The model can be used 

with standard continuum elements as well as the two-phase elements, and can be 

included in Phi-c reduction analyses. 

Material Properties 

Material properties are defined with respect to strength parameters and a choice of 

flow rule. 

Strength parameters 

 Geological Default selection.  
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 Constitutive   

Flow rule 

A flow rule defines the relative magnitudes of the components of plastic strain. From 

the flow rule, a plastic potential surface can be defined (to which plastic strain vectors 

are 'normal'). 

 Constant dilatancy angle 

 Transitional dilatancy. Default selection. 

 Associated flow. The plastic potential and yield function are identical. 

Although a common assumption for metals, it is generally not applicable for 

geomaterials. 

 

These material properties are required according to selections made. 

 Young's modulus- always required. 

 Poisson's ratio- always required. 

 Density - always required.  

 Uniaxial compressive strength - always required. 

 Empirical strength parameter(s) (mi) for Geological use, (mb), (s) and 

(alpha) for Constitutative use. 

 Geological strength index - for Geological use.  

 Damage coefficient -for Geological use. 

 Dilatancy angle- always required unless using 'Associated flow'. 

 Dilatancy transition stress - only required for 'Transitional' flow rule 

selection. 

 Dilatancy transition rate - only required for 'Transitional' dilatancy. 

 Dilatancy transition rate - only required for 'Transitional' flow rule selection. 

 

For further information on these parameters. See Solver Reference Manual : Hoek 

Brown model 

Notes 

 The initial stress state can be input by using residual stress load types, by using 

an initial stress with gravity or by defining K0 properties from the K0 tab. 

 The main limitation of this material model is that it cannot capture the post-

failure softening behaviour typically observed in rock. 
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Dynamic and Coefficient of Thermal Expansion Properties 

Dynamic and Coefficient of thermal expansion properties are optional and are usually 

only required when dynamic analyses are to be carried out.  

 Mass Rayleigh damping coefficient   

 Stiffness Rayleigh damping constant 

 Coefficient of thermal expansion 

Two-Phase Properties 

Two-phase material properties are required when performing a consolidation 

analysis or groundwater flow problem in which two-phase elements are used to define 

soil in either a fully or partially saturated state, or when using drained / undrained 

attributes. 

K
0
 initialisation Properties 

K0 initialisation properties allow initial stresses in soil to be calculated. 

Varying Attributes 

Material properties varying with depth can be used with this model. Any such varying 

properties may be specified by selecting a previously defined variation. To do this 

press the variation button  when you enter a value in any field. 

See the Solver Reference Manual for further details. 

Modified Cam-clay Model 

The Modified Cam-clay model is defined using the Attributes> Material> 

Geotechnical... menu. 

The modified Cam-clay model is a variant of the classic Cam-clay model used for the 

modelling of clays, and is capable of modelling the strength and deformation trends of 

clay realistically. The model can be used with standard continuum elements as well as 

the two-phase elements that include the effects of pore water pressure. The modelling 

parameters required can be evaluated in standard laboratory tests.  

Material Properties 

 Initial void ratio - the void ratio of the soil at the start of the analysis  

 Swelling index - relates to the change in specific volume to a decrease in mean 

pressure 

 Compression index - relates the change in specific volume to an increase in 

mean pressure 

 Gradient critical state line - relates the deviatoric stress to the mean pressure 
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 Pre-consolidation pressure - the maximum pressure the soil was subjected to 

prior to analysis 

 Poisson's ratio 

 Mass density 

Notes 

 The material modulus matrix is non-symmetric. Convergence may be 

improved by using a non-symmetric solution. This can be specified by 

accessing the  Nonlinear analysis options control for a loadcase. 

 The initial stress state can be input by using residual stress load types, or by 

using an initial stress with gravity. 

Dynamic and Thermal Properties 

Dynamic and Thermal expansion properties are optional and are usually only required 

when dynamic or thermal analyses are to be carried out.  

Two-Phase Properties 

Two-phase material properties are required when performing a consolidation 

analysis (or a drained / undrained analysis), in which two-phase elements are used to 

define soil in either a fully or partially saturated state. 

K
0
 initialisation options for Modified Cam-clay 

K0 initialisation properties allow initial stresses in soil to be calculated. 

Three models are supported: 

 Wroth requires the following parameters to be defined: 

 Over-consolidation ratio (if corresponding checkbox is selected)  

 Poisson's ratio for unloading 

 Coefficient of lateral earth pressure of normally consolidated clay 

 OCR sin(phi) requires the following parameters to be defined: 

 Over-consolidation ratio 

 Coefficient of lateral earth pressure of normally consolidated clay 

 Sine angle of friction   

 General requires the following parameters to be defined: 

 Over-consolidation ratio 

 Coefficient of lateral earth pressure of normally consolidated clay 
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 Coefficient of earth pressure at rest for the over consolidated clay 
(unitless) 

In addition: 

 Calculate initial void ratio required  if selected requires Specific volume of 

soil on NCL to be specified. 

See K0 initialisation properties for more details. 

Varying Attributes 

Some properties of the material typically vary with depth, for example, the initial void 

ratio; initial pre-consolidation pressure, and so on. Any such varying properties may 

be specified by selecting a previously defined variation. To do this press the variation 

button  when you enter a value in any field. 

See Solver Reference Manual : Modified Cam-Clay Model 

Results processing 

Once a model containing this material has been solved, Mean pressure, Effective 

stress, Shear modulus, Consolidation pressure, Bulk modulus and Percent change in 

specific volume components are all available within the results entity 'Cam-Clay 

Results'. 

Modified Mohr Coulomb Model  

The Modified Mohr-Coulomb model is accessed using the Attributes> Material > 

Geotechnical... menu item. 

This model applies a tensile and/or a compressive cut-off to the Non Associated Mohr-

Coulomb model. When the standard Mohr-Coulomb model would potentially predict 

tensile stresses beyond the uniaxial tensile limit of the material, the tension cap may be 

used to prevent such stresses occurring.. In compression the cut-off results in 

irreversible deformations once the maximum compressive stress is exceeded. The cut-

off can be applied to either a single principal stress component or to the mean 

pressure. 

The Tresca model is recovered as a special case of the Modified Mohr-Coulomb 

model by setting both the angles of friction and dilation to 0. The cohesion value C is 

equal to half the uniaxial yield stress. 

Notes 

 The model may be used with 3D continuum, plane strain and axi-symmetric 

elements as well as the corresponding two-phase elements. 

 If neither of the Rankine or Pressure options is selected the model will behave 

as the standard Mohr-Coulomb model. 
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 The cohesion, tensile and compressive stresses may be specified to be 

functions of the effective plastic strain. Their variations with effective plastic 

strain are input as a series of piecewise linear segments. 

 The dilation angle must be set to the angle of friction to model associative 

flow. 

 The use of non-symmetric solver is recommended if the dilation angle is not 

equal to the angle of friction, or if strain hardening is defined. 

 The effects of strain hardening on the yield surfaces using a pressure cut-off 

are shown diagramatically in the Solver Reference Manual. 

See the Solver Reference Manual and theTheory Manual for further details. 

Differences between the Non Associated and Modified Mohr 

Coulomb models 

In the Non Associated Mohr-Coulomb model, the yield surface goes to a singularity in 

the tensile direction. As a result, at "very low" confining stresses, convergence 

problems may be met. With the Modified Mohr-Coulomb model the tension cut-off 

removes the singularity with the intention of improving the numerical solution and 

making convergence easier. 

In the Non Associated Mohr-Coulomb model, the yield surface becomes larger 

indefinitely in the compression direction, inferring that for any value of confining 

stress, the soil is getting stronger. With the Modified Mohr-Coulomb model the 

compressive cut-off prevents the strength in compression increasing indefinitely; it 

reaches the specified value and gets no stronger. 

Tresca (Model 61) 

The Tresca model is accessed using the Attributes > Material > Geotechnical... 

menu. 

The elasto-plastic Tresca yield surface model may be used to represent ductile 

behaviour of materials which exhibit little volumetric strain (for example, metals). The 

model incorporates elasto-plastic behaviour with isotropic hardening. 

Material Parameters 

 Yield stress The level of stress at which a material is said to start 

unrecoverable or plastic behaviour. 

 Heat fraction The fraction of plastic work that is converted into heat energy. 

Only applicable to temperature dependent materials and coupled analyses 

where the heat produced due to the rate of generation of plastic work is of 

interest. The value should be between 0 and 1. 
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 Slope of Yield Stress The slope of the uniaxial yield stress against equivalent 

plastic strain. 

 Plastic strain The limit of equivalent plastic strain up to which the hardening 

curve is valid. 

  

 

Hardening Curve Definition for the Tresca Yield Model 

Note 

The Modified Mohr-Coulomb model can also model the Tresca yield surface as a 

special case and provides an improved formulation with better convergence 

characteristics. It is applicable to solid, axisymmetric and plane strain applications. 

See the Solver Reference Manual for further details. 

Drucker-Prager (Model 64) 

The Drucker - Prager model is accessed using the Attributes > Material > 

Geotechnical...menu item. 

This model may be used to represent the ductile behaviour of materials which exhibit 

volumetric plastic strain (for example, granular materials such as concrete, rock and 

soils). The model incorporates isotropic hardening. 

Material Properties 

 Initial Cohesion [C0] A material property of granular materials, such as soils or 

rocks, describing the degree of granular bond and a measure of the shear 

strength. Setting the initial cohesion to zero is not recommended as this could 

cause numerical instability under certain loading conditions. 

 Initial Friction angle [f0] A material property of granular materials, such as 

cohesive soils and rocks. 
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 Heat fraction cofficient [hf] The fraction of plastic work that is converted into 

heat energy. Only applicable to temperature dependent materials and coupled 

analyses where the heat produced due to the rate of generation of plastic work 

is of interest. The value should be between 0 and 1. 

 

Hardening values 

 Slope of cohesion The slope of the cohesion against the equivalent plastic 

strain. 

 Slope of friction angle The slope of the friction against the equivalent plastic 

strain. 

 Plastic strain The limit of equivalent plastic strain up to which the hardening 

curve is valid. 

 

Cohesion Definition for the Drucker-Prager Yield Model (Model 64)  

 

Friction Angle Definition for the Drucker-Prager Yield Model (Model 64) 
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See theSolver Reference Manual for further details. 

Elasto-Plastic Interface (Model 27, 26)  

Elasto-plastic interface models can be specified by selecting the Attributes> 

Material> Specialised> Interface menu item.  

Elasto-plastic interface models are used to represent the friction-contact relationship 

within planes of weakness between two discrete bodies.  

 For a model with a 2D analysis category the 2D Elasto-Plastic Interface Model 

(Model 27) is available in plane stress and plane strain elements. See the 

Element Reference Manual for more details. 

 For a model with a 3D analysis category the 3D Elasto-Plastic Interface Model 

(Model 26) is available in solid continuum elements. See the Element 

Reference Manual for more details 

For both models, a line of appropriate 2D or 3D elements must lie between the two 

bodies in the finite element discretisation. 

Elastic material properties are defined in the local basis, permitting differing values to 

be specified normal and tangential to the plane of the interface. In-plane and out-of-

plane directions are relative to the surface axes, and refer to the contact plane rather 

than the plane of the surface features. 

The nonlinear behaviour is governed by an elasto-plastic constitutive law, which is 

formulated with a limited tension criterion normal to the interface plane, and a Mohr-

Coulomb criterion tangential to the interface plane. See the Theory Manual for further 

details. 

Notes 

 For the 2D Elasto-Plastic Interface Model the tangential (in-plane) direction is 

in the element x direction and the normal (out of plane) is in the element h 

direction. The x direction is defined from the vector between nodes 1 and 3 of 

the element. See the Solver Manual for more details. 

 For the 3D Elasto-Plastic Interface Model the tangential (in-plane) direction 

lies in the element x-h plane and the normal (out of plane) in the element z 

direction. See the Solver Manual for more details. 

 The models cannot be used within a geometrically nonlinear analysis 

Mohr Coulomb Friction Interface Material  

 Mohr-Coulomb friction interface material can be specified by selecting the Attributes 

> Material > Geotechnical menu item.  

Whilst 'elasto-plastic interface material’ (Model 26 for volumes, Model 27 for plane 

stress and plane strain) may be used to model the soil-structure interface, as it has a 
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limited tension criterion normal to the interface plane, and a Mohr-Coulomb criterion 

tangential to the interface plane, and it must be assigned to continuum elements. This 

gives the failure plane an appreciable width, while failure at a soil-structure interface 

is observed to occur in a very localised shear band only a few grains in thickness. 

The Mohr-Coulomb interface material can be used in conjunction with 2D and 3D 

interface elements. It permits the modelling of a standard elastic-plastic sliding 

interface as well as strain hardening, softening and dilation. The classic Mohr-

Coulomb relationship is used to define failure conditions on the interface, and the slip 

at the interface is used to control the rate of dilation as well deterioration in the angle 

of friction. Cohesion can also be linked to the slip. It can also be used in a two-phase 

analysis. 

It is assumed that the resistance of the interface to movement in any direction is a 

function of the amount of slippage which has occurred but that it is not dependent on 

the particular path which may have been taken to get to the current point. 

Constant values 

A friction interface can be defined by specifying constant values for either: 

 Tangential slip This requires the Angle of friction, Dilatancy angle, and 

Cohesion to be specified 

 Tangential displacement This requires Normal compressive pressure, 

Dilatancy angle, and Cohesion to be specified. 

For either option a cut-off tension limit can be specified by selecting Specify cut-off 

tension limit. 

Variation of values using piecewise linear curves 

Alternatively, piecewise linear curves may be defined for each of the parameters 

required by the Tangential slip or Tangential displacement options. Note that defining 

a piecewise line curve for a required parameter removes the corresponding entry from 

the Input grid. 

For Tangential slip: 

 Angle of friction curve Specify values of Tangential slip against stress. 

 Dilatancy angle curve Specify values of Tangential slip against dilatency. 

 Cohesion curve Specify values of Tangential slip against cohesion. 

For Tangential displacement: 

 Stress/strain curve Specify values of Tangential displacement against stress. 

 Dilatancy angle curve Specify values of Tangential displacement against 

dilatency. 

 Cohesion curve Specify values of Tangential displacement against cohesion. 
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Two phase material properties 

 Hydraulic conductivity Once basic material properties have been entered, a 

value for hydraulic conductivity can be entered by pressing the Two phase 

radio button. This option controls the flow of fluid across an interface element. 

A value of zero closes the interface. An interface element separating two two-

phase elements connects the pore-water pressures on opposite nodes. A high 

value of κ compared to the hydraulic conductivity in the elements will limit the 

affect of the interface on the fluid following through it. The hydraulic 

conductivity may be changed at any point in the analysis by assigning new 

properties to the interface element. 

Advanced  

For Tangential slip: 

 Normal stiffness factor The normal stiffness factor specified should be set to 

be between 10 and 100 to reduce penetration normal to the surface. 

For Tangential displacement: 

 Normal stiffness factor The normal stiffness factor specified should be set to 

be between 10 and 100 to reduce penetration normal to the surface. 

 Tangential stiffness factor For soils, values of tangential stiffness should be 

set to be between 0.1 and 0,.8. 

 Update calculated stiffness The calculated stiffness can be updated either 

Never, Iteratively (at the end of every iteration, or Incrementally (at the end of 

every increment or loadstep. 

For more details see Mohr-Coulomb Interface Model in the Solver Reference Manual. 

Delamination Interface Material (Model 25) 

The delamination interface material model can be specified by selecting the 

Attributes> Material> Specialised> Interface menu item.  

Delamination properties are assigned to interface elements to model delamination 

between elements. The model behaves linearly until the threshold strength is exceeded. 

Linear strain softening behaviour then occurs until the fracture energy is exceeded. 

Once the fracture energy is exceeded further straining occurs without resistance. 

Fracture Modes 

 For a model with a 2D analysis category two fracture modes are present 

 For a model with a 3D analysis category three fracture modes are present 

 The fracture modes are: 

 Mode 1 Opening 

 Mode 2 Shearing 
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 Mode 3 Tearing (Shear orthogonal to mode 2) 

Material Parameters 

 Fracture energy Measured values for each fracture mode depending on the 

material being used, i.e. carbon fibre, glass fibre. 

 Initiation Stress The tension threshold /interface strength is the stress at which 

delamination is initiated. This should be a good estimate of the actual 

delamination tensile strength but, for many problems, the precise value has 

little effect on the computed response. If convergence difficulties arise it may 

be necessary to reduce the threshold values to obtain a solution. 

 Relative displacement The maximum relative displacement is used to define 

the stiffness of the interface before failure. Provided it is sufficiently small to 

simulate an initially very stiff interface it will have little effect. 

 Coupled The model used for coupling the failure modes (Coupled, Uncoupled 

Reversible, Uncoupled Origin). 

See the Theory Manual for more details. 

Elasto-Plastic Interface (Model 27, 26)  

Elasto-plastic interface models can be specified by selecting the Attributes> 

Material> Specialised> Interface menu item.  

Elasto-plastic interface models are used to represent the friction-contact relationship 

within planes of weakness between two discrete bodies.  

 For a model with a 2D analysis category the 2D Elasto-Plastic Interface Model 

(Model 27) is available in plane stress and plane strain elements. See the 

Element Reference Manual for more details. 

 For a model with a 3D analysis category the 3D Elasto-Plastic Interface Model 

(Model 26) is available in solid continuum elements. See the Element 

Reference Manual for more details 

For both models, a line of appropriate 2D or 3D elements must lie between the two 

bodies in the finite element discretisation. 

Elastic material properties are defined in the local basis, permitting differing values to 

be specified normal and tangential to the plane of the interface. In-plane and out-of-

plane directions are relative to the surface axes, and refer to the contact plane rather 

than the plane of the surface features. 

The nonlinear behaviour is governed by an elasto-plastic constitutive law, which is 

formulated with a limited tension criterion normal to the interface plane, and a Mohr-

Coulomb criterion tangential to the interface plane. See the Theory Manual for further 

details. 
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Notes 

 For the 2D Elasto-Plastic Interface Model the tangential (in-plane) direction is 

in the element x direction and the normal (out of plane) is in the element h 

direction. The x direction is defined from the vector between nodes 1 and 3 of 

the element. See the Solver Manual for more details. 

 For the 3D Elasto-Plastic Interface Model the tangential (in-plane) direction 

lies in the element x-h plane and the normal (out of plane) in the element z 

direction. See the Solver Manual for more details. 

 The models cannot be used within a geometrically nonlinear analysis 

Mohr Coulomb Friction Interface Material  

 Mohr-Coulomb friction interface material can be specified by selecting the Attributes 

> Material > Geotechnical menu item.  

Whilst 'elasto-plastic interface material’ (Model 26 for volumes, Model 27 for plane 

stress and plane strain) may be used to model the soil-structure interface, as it has a 

limited tension criterion normal to the interface plane, and a Mohr-Coulomb criterion 

tangential to the interface plane, and it must be assigned to continuum elements. This 

gives the failure plane an appreciable width, while failure at a soil-structure interface 

is observed to occur in a very localised shear band only a few grains in thickness. 

The Mohr-Coulomb interface material can be used in conjunction with 2D and 3D 

interface elements. It permits the modelling of a standard elastic-plastic sliding 

interface as well as strain hardening, softening and dilation. The classic Mohr-

Coulomb relationship is used to define failure conditions on the interface, and the slip 

at the interface is used to control the rate of dilation as well deterioration in the angle 

of friction. Cohesion can also be linked to the slip. It can also be used in a two-phase 

analysis. 

It is assumed that the resistance of the interface to movement in any direction is a 

function of the amount of slippage which has occurred but that it is not dependent on 

the particular path which may have been taken to get to the current point. 

Constant values 

A friction interface can be defined by specifying constant values for either: 

 Tangential slip This requires the Angle of friction, Dilatancy angle, and 

Cohesion to be specified 

 Tangential displacement This requires Normal compressive pressure, 

Dilatancy angle, and Cohesion to be specified. 

For either option a cut-off tension limit can be specified by selecting Specify cut-off 

tension limit. 
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Variation of values using piecewise linear curves 

Alternatively, piecewise linear curves may be defined for each of the parameters 

required by the Tangential slip or Tangential displacement options. Note that defining 

a piecewise line curve for a required parameter removes the corresponding entry from 

the Input grid. 

For Tangential slip: 

 Angle of friction curve Specify values of Tangential slip against stress. 

 Dilatancy angle curve Specify values of Tangential slip against dilatency. 

 Cohesion curve Specify values of Tangential slip against cohesion. 

 

For Tangential displacement: 

 Stress/strain curve Specify values of Tangential displacement against stress. 

 Dilatancy angle curve Specify values of Tangential displacement against 

dilatency. 

 Cohesion curve Specify values of Tangential displacement against cohesion. 

 

Two phase material properties 

 Hydraulic conductivity Once basic material properties have been entered, a 

value for hydraulic conductivity can be entered by pressing the Two phase 

radio button. This option controls the flow of fluid across an interface element. 

A value of zero closes the interface. An interface element separating two two-

phase elements connects the pore-water pressures on opposite nodes. A high 

value of κ compared to the hydraulic conductivity in the elements will limit the 

affect of the interface on the fluid following through it. The hydraulic 

conductivity may be changed at any point in the analysis by assigning new 

properties to the interface element. 

 

Advanced  

For Tangential slip: 

 Normal stiffness factor The normal stiffness factor specified should be set to 

be between 10 and 100 to reduce penetration normal to the surface. 

 

For Tangential displacement: 

 Normal stiffness factor The normal stiffness factor specified should be set to 

be between 10 and 100 to reduce penetration normal to the surface. 

 Tangential stiffness factor For soils, values of tangential stiffness should be 

set to be between 0.1 and 0,.8. 
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 Update calculated stiffness The calculated stiffness can be updated either 

Never, Iteratively (at the end of every iteration, or Incrementally (at the end of 

every increment or loadstep. 

For more details see Mohr-Coulomb Interface Model in the Solver Reference Manual. 

Rubber  

Rubber materials maintain a linear 

relationship between stress and strain up 

to very large strains (typically 0.1 - 0.2). 

The behaviour after the proportional limit 

is exceeded depends on the type of rubber 

(see diagram below). Some kinds of soft 

rubber continue to stretch enormously 

without failure. The material eventually 

offers increasing resistance to the load, 

however, and the stress-strain curve turns 

markedly upward prior to failure. Rubber 

is, therefore, an exceptional material in that it remains elastic far beyond the 

proportional limit. 

Rubber materials are also practically incompressible, that is, they retain their original 

volume under deformation. This is equivalent to specifying a Poisson's ratio 

approaching 0.5. 

The strain measure used in LUSAS to model rubber deformation is termed a stretch 

and is measured in general terms as: 

 = dnew/dold 

where: 

dnew is the current length of a fibre. 

dold is the original length of a fibre. 

  
Several representations of the mechanical behaviour for hyper-elastic or rubber-like 

materials can be used for practical applications. Within LUSAS, the usual way of 

defining hyper-elasticity, i.e. to associate the hyper-elastic material to the existence of 

a strain energy function that represents this material, is employed. There are currently 

four rubber material models available: 

 Ogden 

 Mooney-Rivlin 

 Neo-Hookean 

 Hencky 
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The rubber constants (used for Ogden, Mooney-Rivlin and Neo-Hookean) are obtained 

from experimental testing or may be estimated from a stress-strain curve for the 

material together with a subsequent curve fitting exercise. 

The Neo-Hookean and Mooney-Rivlin material models can be regarded as special 

cases of the more general Ogden material model. In LUSAS these models can be 

reformulated in terms of the Ogden model. 

The strain energy functions used in these models includes both the deviatoric and 

volumetric parts and are, therefore, suitable to analyse rubber materials where some 

degree of compressibility is allowed. To enforce strict incompressibility (where the 

volumetric ratio equals unity), the bulk modulus tends to infinity and the resulting 

strain energy function only represents the deviatoric portion. This is particularly useful 

when the material is applied in plane stress problems where full incompressibility is 

assumed. However, such an assumption cannot be used in plane strain or 3D analyses 

because numerical difficulties can occur if a very high bulk modulus is used. In these 

cases, a small compressibility is mandatory but this should not cause concern since 

only near incompressibility needs to be ensured for most of the rubber like materials. 

Using Rubber Material 

Rubber is applicable for use with the following element types currently: 

 2D Continuum QPM4M, QPN4M 

 3D Continuum HX8M 

 2D Membrane BXM2 

Notes 

 For membrane and plane stress analyses, the bulk modulus is ignored because 

the formulation assumes full incompressibility. The bulk modulus has to be 

specified if any other 2D or 3D continuum element is used. 

 Ogden, Mooney-Rivlin and Neo-Hookean material models must be run with 

geometric nonlinearity using either the total Lagrangian formulation (for 

membrane elements) or the co-rotational formulation (for continuum 

elements). The Hencky material model is only available for continuum 

elements and must be run using the co-rotational formulation. The large strain 

formulation is required in order to include the incompressibility constraints 

into the material definition. 

 Option 39 can be specified for smoothing of stresses. This is particularly useful 

when the rubber model is used to analyse highly compressed plane strain or 3D 

continuum problems where oscillatory stresses may result in a "patchwork 

quilt" stress pattern. This option averages the Gauss point stresses to obtain a 

mean value for the element. 
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 When rubber materials are utilised, the value of det F or J (the volume ratio) is 

output at each Gauss point. The closeness of this value to 1.0 indicates the 

degree of incompressibility of the rubber model used. For totally 

incompressible materials J=1.0. However, this is difficult to obtain due to 

numerical problems when a very high bulk modulus is introduced for plane 

strain and 3D analyses. 

 Subsequent selection of state variables for displaying will include the variable 

PL1 which corresponds to the volume ratio. 

 Rubber material models are not applicable for use with the axisymmetric solid 

element QAX4M since this element does not support the co-rotational 

geometric nonlinear formulation. The use of total Lagrangian would not be 

advised as an alternative. 

 There are no associated triangular, tetrahedral or pentahedral elements for use 

with the rubber material models. 

 The rubber material models are inherently nonlinear and, hence, must be used 

in conjunction with nonlinear control command. 

 The rubber material models may be used in conjunction with any of the other 

LUSAS material models. However, it is not possible to combine rubber with 

any other nonlinear material model within the same material attribute. 

Volumetric Crushing (Model 81) 

Material behaviour can generally be described in terms of deviatoric and volumetric 

behaviour which combine to give the overall material response. The crushable foam 

material model accounts for both of these responses. The model defines the volumetric 

behaviour of the material by means of a piece-wise linear curve of pressure versus the 

logarithm of relative volume. An example of such a curve is shown in the diagram 

below, where relative volume is denoted by V/V0. 
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 Pressure - Logarithm of Relative Volume Curve 

From this figure, it can also be seen that the material model permits two different 

unloading characteristics volumetrically. 

 Unloading may be in a nonlinear elastic manner in which loading and 

unloading take place along the same nonlinear curve. 

 Volumetric crushing may be included (by clicking in the volumetric crushing 

check box) in which case unloading takes place along a straight line defined by 

the unloading/tensile bulk modulus K which is, in general, different from the 

initial compressive bulk modulus defined by the initial slope of the curve. 

In both cases, however, there is a maximum (or cut-off) tensile stress, (cut-off 

pressure), that is employed to limit the amount of stress the material may sustain in 

tension. 

The deviatoric behaviour of the material is assumed to be elastic-perfectly plastic. The 

plasticity is governed by a yield criterion that is dependent upon the volumetric 

pressure (compared with the classical von Mises yield stress dependency on equivalent 

plastic strain) and is defined as: 

 

where p is the volumetric pressure,  is the deviatoric stress and a0, a1, a2 are 

pressure dependent yield stress constants. Note that, if a1 = a2 = 0 and a0 = 

(syld2)/3, then classical von Mises yield criterion is obtained. 
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 Yield Surface Representation For Different Pressure Dependent Yield Stress Values 

Notes 

 Bulk modulus used in tension and unloading (see 1st figure). The relationship 

between the elastic bulk (or volumetric) modulus, K, and tensile modulus, E, is 

given by:  

 Shear modulus The relationship between the elastic modulus values in shear, 

G, and tension, E, assuming small strain conditions, is given by:  

 Heat fraction coefficient Represents the fraction of plastic work which is 

converted to heat and takes a value between 0 and 1. 

 Cut-off pressure Should be negative (i.e. a tensile value). 

 Pressure dependent yield stresses (a0, a1, a2) (Should be positive). The 

yield surface defined is quadratic with respect to the pressure variable. 

Therefore it can take on different conical forms (see 2nd figure), either elliptic 

(a2<0), parabolic (a2=0) or hyperbolic (a2>0). The parabolic form is 

comparable to the modified von Mises material model while the elliptic form 

can be considered to be a simplification of critical state soil and clay material 

behaviour. 

 The volumetric crushing indicator effectively defines the unloading behaviour 

of the material. If there is no volumetric crushing, the same pressure-logarithm 

of relative volume curve is used in loading and unloading and if volumetric 

crushing takes place the alternative unloading/reloading curve is used (see 1st 

figure). 
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 Log relative volume Natural logarithm (loge, not log10) of relative volume 

coordinate for ith point on the pressure-logarithm of relative volume curve (see 

1st figure) 

 The pressure-logarithm of relative volume curve is defined in the 

compression regime hence logarithms of relative volume must all be zero or 

negative and the pressure coordinates must all be zero or positive. 

Generic Polymer (Model 87 and 88) 

The Generic Polymer model is accessed from the Attributes> Material>  Specialised 

menu item.  

The model consists of a set of Maxwell dampers which are used to model visco-

elasticity, an Eyring dashpot which is used to model viscoplasticity and a linear spring. 

These components are placed in series. The Properties of the Maxwell elements, 

Eyring dashpot and linear spring can be different in tension and compression.  

Model 87 is defined using an linear spring, an Eyring damper, and a number of parallel 

Maxwell elements. Model 88 is used when behaviour differs in tension and 

compression 

Material Properties 

 Bulk Modulus 

 Mass density 

 Coefficient of thermal expansion 

 Mass Rayleigh damping constant 

 Stiffness Rayleigh damping constant 

 Eyring damper activation energy 

 Eyring damper activation volume 

 External spring stiffness 

 Maxwell element spring constant 

 Maxwell element Newtonian dashpot viscous constant 

See the Solver Reference Manual and theTheory Manual for further details. 

Generic Polymer with Damage (Model 89 and 90) 

The Generic Polymer with Damage model appears under the Attributes> Material> 

Specialised menu item. The model accounts for strain rate behaviour and 

irrecoverable damage in the modelling of polymers and other polymer-like materials.  

 Model 89 consists of a linear spring, a spring that includes damage, an Eyring 

dashpot and a number of parallel Maxwell elements. Different sets of material 
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properties can be defined to model tensile and compressive behaviour, except 

for the Visco-Scram damage model whose properties apply in both tension and 

compression. 

 Model 90 includes two additional features. The first feature is a set of failure 

criteria that are used to remove individual Maxwell elements when the criteria 

are met. The second is a switch between tensile and compressive material 

properties based on the stress state in an individual Maxwell element. 

 

Note that for the Visco-Scram Damage model the expected input units for the 

Threshold Stress Intensity parameter cannot be displayed when the cursor is hovered 

over the input cell. This is because the power value concerned cannot be created with 

this display method. 

Material Properties 

See the Solver Reference Manual and theTheory Manual for further details. 

Piecewise Linear Bar Material (Model 104)  

Piecewise linear bar material is for use with 2-noded bar elements to meet the 

requirements of no compression (tension-only) or no-tension (compression-only) 

members. The nonlinear elastic behaviour is recoverable, and during the analysis the 

stiffness (and stress) will be computed from the strain value using the relationship 

shown in the image below.  

General usage 

For general use the piecewise linear bar material model is accessed via the 

Attributes> Material> Specialised> Piecewise Linear (Bar) menu item. Any 

number of piecewise linear segments can be defined to represent material behaviour. 

The stress-strain curve does not have to pass through the origin. By defining curve 

data that runs along the positive (or negative) strain axis, no compression (tension-

only) or no tension (compression-only) behaviour can be simulated.  
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General piecewise linear definition 

Editing curve data 

Once defined, piecewise linear bar material attributes are held in the Attributes 

Treeview. Selecting the Edit Attribute... context menu for a bar material attribute 

displays the piecewise linear bar material data for editing. 

Tension-only and compression-only usage 

For simplified use, the piecewise linear bar material model is also used by the 

Attributes> Material> Tension / Compression Only (Bar) menu item. For a 

selected or user-defined material, automatically created curve data, that runs along the 

positive (or negative) strain axis, is used to define a simple no compression (tension-

only), or no tension (compression-only) or behaviour.  

  

Tension-only bar material Compression-only bar material 
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Editing curve data 

Once defined, piecewise linear bar material attributes are held in the Attributes 

Treeview, and have context menu entries named Edit Definition... and Edit Attribute.  

 Selecting the Edit Definition... menu entry for a bar material attribute, or 

double clicking the attribute displays the original definition dialog with all the 

original input data intact for modification. 

 Selecting the Edit Attribute... menu entry for a bar material attribute displays 

the equivalent piecewise linear bar material data for the defined data. These 

values may be changed but this breaks the link to the original definition dialog 

and a warning message will be displayed. 

Notes 

 The input data must not contain a curve segment with a negative or vertical 

slope. 

 Loading and unloading is assumed to occur along the same stress/strain path. 

 If strains exceed the bounds of the curve data the first or last curve segment 

will be used to extrapolate the stress. 

 A curve tolerance parameter is used to help prevent chatter (oscillations 

between adjacent segments when a computed stress/strain is very close to an 

apex on the curve). If the point falls within this tolerance an average Young's 

modulus value to form the stiffness is computed from the adjacent segments. 

 Defining a non-zero stress for zero strain has the same affect as applying an 

initial stress. Under these conditions, if an initial stress is also applied, the 

compound effect of both stresses will be applied. In other words, an applied 

initial stress loading will act as an offset on the stress data entered for this 

material model. 

 Tension only /compression only material requires the use of a nonlinear 

material definition and suitable nonlinear controls. 

 Carrying out an eigenvalue analysis following a nonlinear analysis that uses 

this model can lead to unrealistic bar stresses for some modes. If a no-

compression bar element has zero stiffness prior to the eigenvalue analysis, 

then some modes will inevitably see that element put into tension. 

Resultant User 

Used to specify user material parameters for the user- defined nonlinear resultant 

model. 

See the Solver Reference Manual for further details. 
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Nonlinear User 

This is used to specify user material parameters for the user- defined nonlinear 

material model. 

See the Solver Reference Manual for further details. 

Joint Material Models 

Joint material properties can be defined by selecting the Attributes > Material 

> Joint menu item. Joint material models are used in conjunction with joint elements 

to define the material properties for linear and nonlinear joints. The following joint 

models are available: 

Linear Joint Models 

 Spring stiffness only corresponding to each local freedom. These local 

directions are defined for each joint element in the Element Reference Manual. 

 General Properties advanced specification of joint properties of spring 

stiffness, mass, coefficient of linear expansion and damping factor. 

Nonlinear Joint Models 

 Elasto-Plastic (Tension and compression equal) with isotropic hardening and 

equal tension and compression yield conditions. 

 Elasto-Plastic (Tension and compression unequal) with isotropic hardening 

and unequal tension and compression yield conditions. 

 Smooth Contact with an initial gap.  

 Frictional Contact with an initial gap. Friction contact joints can be specified 

to permit lift-off in a user-defined direction.  

 Trilinear Earth Pressure creates a piecewise linear joint material whose 

properties vary with depth, such as those used to represent a layer or stratum in 

a soil-structure interaction or geotechnical analysis. 

 Piecewise Linear, Elastic allows a single force/displacement 

(moment/rotation) curve to be defined for each freedom by defining a number 

of line (curve) segments.  

 Piecewise Linear, Elastic (Axial Force Dependent) Allows any number of 

force/displacement (moment/rotation) curves representing the behaviour under 

different axial forces.  

 Piecewise Linear, Hysteretic A range of inelastic hysteretic joint models for 

basic and complex hysteresis. 

 Nonlinear user-defined A user-defined joint model. This allows user-supplied 

joint property subroutines to be used from within LUSAS. This facility 
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provides controlled access to the pre- and post-solution constitutive processing 

and nonlinear state variable output via these user-supplied subroutines. 

 Matrix properties Definition of symmetrical matrix properties (stiffness, mass 

or damping) to specify a joint representing a pilecap sitting on a group of piles 

in a global (3D) model. 

Seismic Isolator Joint Models 

 Viscous dampers - Kelvin and Four Parameter Solid modules available. 

 Lead Rubber Bearings with plastic yield and biaxial hysteric behaviour. 

 Friction Pendulum System with pressure and velocity dependent friction 

coefficient and biaxial hysteretic behaviour. 

General settings required for joints 

Joint material properties are assigned to model geometry using joint elements to define 

the joint behaviour. Joint input parameters and the number of degrees of freedom will 

vary according to the joint model and element type chosen. Refer to the Solver 

Reference Manualfor a full description of the joint material input parameters required 

for these joint models. 

 Assignment to defines / shows the feature(s) to which the joint material has 

been defined. Options (according to joint type selected_ are 'Points', 'Point and 

line ends', 'Lines', and 'Surfaces'. Once assigned to a feature type, the joint 

cannot be assigned to different feature types. 

 Joint type selection of a joint type adds the properties that need to be defined 

for that joint type to the tabular grid on the dialog.  

 Mass position (when required) options are used to specify that the joint mass 

will be 'Between nodes', or 'At first node', or 'At second node' 

Additional Thermal expansion, Varying friction coefficient, Damping, Coupled, 

and Compound hysteresis options are selectable according to joint type. 

Note that selection of one of the 'Assignment to' options controls the expected units for 

each degree of freedom as displayed in the tool tip when the cursor is hovered over an 

input cell. When defining a new joint material 'Point' or 'Point and line ends' is the 

default, again according to joint type. When pre-version 15 models are being edited no 

selection is automatically made and for these models there is no requirement to make a 

selection. 

Properties for each degree of freedom / common to all 

freedoms 

Properties for each degree of freedom must be specified in the tabular grid. Some joint 

materials have properties that can be entered to be common for all freedoms. 
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Usage 

See Joint and Interface Elements for general information about using joints.  

Notes 

 When defining joint properties for single joint elements the total stiffness or 

yield force should be defined. When using interface joint meshing the stiffness 

and yield force defined in the joint properties should be defined per unit length 

when using interface joints assigned to lines or per unit area when using 

interface joints assigned to surfaces. 

Elasto-plastic joint model force response curves 

  

 

Elasto-plastic 
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Contact joint model force response curves 

   

Smooth contact  Frictional contact 1 

  

 

  

 

Frictional contact 2 Frictional contact 3 

Notes relating to Contact and Frictional Joints 

 Initial gaps are measured in units of length for translational freedoms and in 

radians for rotational freedoms 

 For the Smooth Contact model, if an initial gap is used in a spring, then the 

positive local axis for this spring must go from node 1 to 2. If nodes 1 and 2 are 

coincident the relative displacement of the nodes in a local direction (d2 d1) 

must be negative to close an initial gap in that direction.  
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 Friction contact joints can be specified to permit lift-off in a user-defined 

direction. 

 Both Smooth Contact and Frictional Contact joints can be used for lift-off or 

hook contact by using appropriate stiffnesses, gap and yield force.  

Seismic isolator joint model force response curves 

 

  

  

Visco-elastic damper  

  

Lead Rubber Bearing Friction Pendulum System 

Tri-linear Earth Pressure Joint Material 

 Tri-linear earth pressure joint material simplifies the modelling of a variety of soil-

structure interaction problems. It creates a piecewise linear joint material attribute that 

generates earth pressures in relation to deflections of the structure. Earth pressures 

increase with depth along the vertical axis. Multiple attributes can be defined to 

represent layers of soil or changes in properties due to the presence of water. 

Defining Earth Pressure Joint Material 

Tri-linear earth pressure joint material is defined using the Attributes> Material> 

Joint menu item. The input parameters and the number of degrees of freedom will 

vary according to the selected joint and model geometry. 

 Analysis category Shows the analysis category in use. 

 Joint type The tri-linear soil joint material attribute must be compatible with 

the joint element to which it will be assigned. It is intended for use primarily 
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with JNT3 and JNT4 elements, for 2D and 3D applications respectively. It is 

important that the local axes of the joint elements are orientated correctly for 

the intended use. For both 2D and 3D joint elements the joint element local x 

axis must align with the horizontal and connect the support to the structure. For 

2D applications the joint element local y axis must be aligned to the vertical 

axis. For 3D applications the joint element local z axis must be aligned with the 

vertical axis. Local coordinate systems may be required to achieve correct 

element orientation. 

  

Joint element axes required for 2D modelling 

applications 

Joint element axes required for 3D modelling 

applications 

 Defining geometryJoint material parameters can be defined for assignment to 

either a point, a line or a surface. The defining geometry refers to the 

underlying geometry to which the slave nodes of the joint elements are 

assigned. The defining geometry is used to determine the angle of the structure 

for lines and surfaces. Note that the angle of the structure cannot be determined 

when joint material attributes are applied between points. 

Vertical and lateral pressure parameters 

Parameters relating to vertical and lateral pressures are entered in tabular grids of the 

trilinear Earth Pressure dialog. Diagrams and equations (as shown below) are provided 

also to clarify the meaning of the various material parameters that must be defined.  
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Vertical pressures Lateral pressures 

Modulus of subgrade reaction 

The constant of proportionality, known as the Modulus of Subgrade Reaction, is a 

measure of the soil stiffness as defined in the lateral pressures image on the dialog, 

where it is represented with a single slope labelled kh. It is generally conceded that for 

over-consolidated cohesive soils, kh remains approximately constant with depth. In 

granular soils and also some normally-consolidated clays, kh is usually assumed to 

increase linearly with depth. Whilst a number of methods for obtaining suitable values 

of kh are available, including field and triaxial tests which can provide results which 

may be converted into an appropriate value, in some circumstances it may be 

expressed in polynomial form as kh=A+Bz
κ
 where A, B and κ are empirical constants. 

Usually a safe design may be obtained with a low kh value and a high value of Ko. 

However, as it may be difficult to obtain reliable values for either, it is generally 

recommended that the sensitivity of the design is checked with regard to variations of 

these parameters. 

 

Local axes representations 

Because joint mesh assignments are made using master to slave assignments, and the 

joint element orientation may differ on each side of a line or surface representing a 

retaining structure, it is important to correctly specify what the positive x and y axis of 

each joint material attribute is representing. With reference to an observed element 

axes for an assigned joint element: 

 The positive displacement of the local x axis of the joint element can be set to 

represent (mobilise) Active pressures or Passive pressures. 

 The positive direction of the local y axis of the joint element (for 2D) or local z 

axis (for 3D) can be set to Opposes gravity (points up) or Matches gravity 

(points down). 
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Other options 

 Consider angle of structure The angle of the structure relative to the retained 

soil changes the effective direction of the soil pressures. Selecting this option 

(for lines and surfaces only) considers the orientation of the structure relative to 

the global vertical axis when resolving soil pressures. For lines, the angle of the 

structure is defined from the vector of the line. For surfaces, the angle is 

defined from the normal to the surface. 

 Non recoverable When ticked, displacements which occur while the joint is in 

a fully passive or fully active state will not be recovered. Instead, if 

displacement is reversed, then earth pressures will change according to the 

Franchin model i.e. parallel to the initial stiffness. This (Franchin) model is 

implemented using the 'parallel reversal' hysteresis implementation of the 

piecewise linear joint with the 'Initial stiffness' unloading rule and a flat (zero) 

stiffness beyond the active and passive limits. When unticked, displacements 

which occur while the joint is in a fully passive or fully active state must be 

recovered, and earth pressures are modified according to the initial stiffness, 

passing through the zero displacement/Ko origin, i.e. the joint is effectively 

nonlinear-elastic (recoverable). 

Notes 

 All joints must be supported at the non-structure end by a fully fixed support 

condition. 

 Modelling with tri-linear earth pressure material requires a nonlinear analysis. 

 The pressure generated in the joint elements is interpolated from nodal 

displacement. The direction of the displacements determines from which part 

of the soil lateral response curve the forces are interpolated. The direction 

(either positive or negative) depends on the orientation of the local element 

axis representing the horizontal. 

 By default soil pressures are defined per unit area. Where the material is 

applied to geometry other than surfaces a factor (Weff) may be specified to 

define pressures over a fixed width or area. For example where the material is 

applied to a pile of fixed width, a factor may be specified to define pressures 

acting over a specified width rather than per unit width. 

 When creating soil layers, if a different soil weight is used for each layer the 

overburden pressure from any soil layers above must be calculated manually 

and entered as a surcharge. Where all layers have the same unit weight the 

datum for each layer can be the same (i.e ground level) remembering that any 

additional surcharge (q) at ground level needs to be included in the definition 

of all lower layers. 
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 The material properties are assumed to vary with the vertical axis currently set 

in Modeller. The vertical axis can be set by selecting the Utilities > Vertical 

Axis… menu item. 

 The material definition assumes soil depth and therefore pressure increases in a 

negative direction. 

 The datum used for the calculation of effective overburden or ground level as 

entered into the grid must coincide with the geometry to which it is assigned. 

For example if the top layer of soil is defined by a line between (0, 0, 0) to (0, 

0,-2) (Z is vertical) the datum level must be set to 0. For the layer beneath 

defined by a line between (0, 0,-2) to (0, 0,-8) the datum level must be set to -2, 

and a surcharge representing the above strata applied. If the model geometry is 

altered the soil definition values must also be updated to suit the new 

configuration. 

 For all joint elements negative forces represent compression. Lateral pressures 

are therefore negative; positive forces are prevented by the defining variations 

(tension cut-off). 

Worked example 

 See Online help > Worked Examples > For LUSAS Bridge and LUSAS Civil 

& Structural >  ‘ Embedded Retaining Wall’. 

Editing of Earth Pressure Joint Material data 

Earth pressure joint material attributes are held in the Attributes Treeview. Context 

menu entries named Edit Definition... and Edit Attribute... can be seen by right 

clicking on an attribute. 

 Selecting the Edit Definition... menu entry or double clicking the attribute 

displays the original definition dialog with all the original input data intact.  

 Selecting the Edit Attribute...menu entry displays the stored piecewise linear 

joint material values that are used to define the earth pressure joint material. 

These values may be changed outside of the Earth Pressure Material definition 

dialog but it is not recommended to do so. If edited, the link to the original 

definition dialog will be broken. 

For a description of the piecewise linear joint material parameters that are required for 

this joint model please refer to the Solver Reference Manual.  

Piecewise Linear, Elastic Joint Material 

 Piecewise Linear, Elastic Joint Material is defined using the Attributes> Material> 

Joint menu. 
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This joint material is specified by a single Force/Displacement curve defined in a 

piecewise linear way, either by coordinate input or by spreadsheet import. A stiffness 

factor governs how force/displacement values should be extrapolated when they fall 

outside the range of those defined. A factor of 1 (the default) keeps the same slope as 

the adjacent force/displacement line segment. A factor of 0 keeps the force the same.  

A typical piecewise linear load-deflection curve with N linear segments is shown 

below. 

 

Piecewise linear joint material definition 

General settings 

For details of general settings to be made see Joint Material Models. 

Piecewise linear settings 

 Coupled When selected, defines the force / deformation relationship for all 

degrees of freedom with respect to the deformation in the axial or normal 

direction. When unset, the relationship in each degree of freedom is defined 

independently. 

Properties for each degree of freedom / common to all 

freedoms 

Properties for each degree of freedom must be specified in the tabular grid.  

Note 

 It is possible to define segments with negative stiffness/gradient on the force-

displacement curve to the positive side of the displacement origin. However, 

the curve cannot extend below the force level at this origin as the force-

displacement relationship would then become non-unique because of the curve 
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data defined (or extrapolated) for negative displacements. This is also true for 

forces on the negative side of the displacement origin; in this case the curve 

cannot extend above the force at the displacement origin. 

 Variations can also be used in the definition of curves. 

Piecewise Linear, Elastic (Axial Force Dependent) Joint 

Material 

Piecewise Linear, Elastic (Axial Force Dependent) Joint Material is defined using the 

Attributes> Material> Joint menu. 

This joint material is similar to the generic 'Piecewise Linear, Elastic' joint material 

model, but allows any number of Force/Displacement curves to be optionally specified 

by defining a number of linear curve segments for each curve for a stated axial force. 

It can be used when inelastic material behaviour is chosen to be modelled using an 

elastic material model and an associated force/displacement curve. 

A typical set of piecewise linear, elastic (axial force dependent) load-deflection curves 

with N linear segments is shown below. 

 

  

Piecewise linear, elastic (axial force dependent) load-deflection curves 

If multiple user-defined curves are specified in LUSAS Modeller, these curves are 

automatically interpolated by LUSAS Solver when a solve is requested to arrive at 

suitable force/displacement values for a particular axial force imposed upon a joint to 

which the joint material has been assigned. The bounding piecewise linear curve with 

the lowest or highest axial force will be used respectively if the axial force in the joint 

is smaller or larger than the bounding values. If only one curve for a particular axial 
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force is specified, this curve will be used for all axial forces. A stiffness factor governs 

how force/displacement values on a curve should be extrapolated when they fall 

outside the range of those defined. A factor of 1 (the default) keeps the same slope as 

the adjacent force/displacement line segment. A factor of 0 keeps the force the same. 

  

Notes 

 When defining a set of piecewise linear (axial force dependent) load-deflection 

curves each curve must contain the same number of points (and hence curve 

segments). 

 A force/displacement curve can be defined for an axial component (u) of an 

axial force dependent piecewise linear elastic material. If multiple curves 

defining the behaviour of the axial component are defined for various values of 

axial force, the behaviour curve that matches the axial force in the joint will be 

cross-interpolated between both bounding piecewise linear curves. This 

behaviour is complex, and it is therefore recommended that only a single curve 

is defined for the axial component (u). 

 It is possible to define segments with negative stiffness/gradient on the force-

displacement curve to the positive side of the displacement origin. However, 

the curve cannot extend below the force level at this origin as the force-

displacement relationship would then have non-unique negative sides. This is 

also true for forces on the negative side of the displacement origin; in this case 

the curve cannot extend above the force at the displacement origin. 

Piecewise Linear, Hysteretic Joint Material 

The Piecewise Linear, Hysteresis, and Compound Hysteresis Joint Models are generic 

extensions of the 'Piecewise Linear, Elastic' joint material model within LUSAS, and 

generalisations of well-known named hysteresis models that are in use in industry.  

The primary backbone, or envelope, or skeleton under monotonic loading is a 

piecewise linear curve as used by the Piecewise Linear, Elastic joint material model, 

where the whole loop for all multi-linear hysteresis joint models can be above or 

below the zero force axis, and the origin of the loop may have any displacement and 

force, not necessarily zero displacement and force. 

A typical piecewise linear, hysteretic load-deflection curve with N linear segments is 

shown below. 
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Piecewise linear curve with hysteresis behaviour. 

Hysteretic model types supported 

Hysteretic models commonly used in industry can be defined by specifying a LUSAS 

hysteresis model type and a suitable unloading rule(s).  

Industry models supported include: 

 Degrading bi-

linear 

 Bi-linear with 

slackness 

 Origin-centred bi-

linear 

 Peak oriented 

 Kivell degrading 

stiffness 

 Pivotal plastic model 

 Modified Takeda 

 Muto degrading tri-

linear 

 Fukada degrading tri-

linear 

 Sina degrading 

trilinear 

 Stewart degrading 

stiffness 

 Franchin 

It should be noted that, where industry-named models consist of a fixed number of 

piecewise linear segments to describe the primary backbone of the curve, the 

implementation of the named hystereris models within LUSAS allows for multiple 

segments to be specified (if required) for each required line segment of a named 

model. In addition, various unloading rules can be chosen for a single hysteresis 

model, and any two basic hysteresis models may be combined with different loading 

and unloading rules to create compound hysteresis loops. This provides many 

additional options and permutations for assessing a wide variety of hysteretic joints. 

General joint settings 

The Piecewise Linear, Hysteretic joint dialog is similar to the Piecewise Linear, 

Elastic dialog, but with additional controls to specify the hysteresis loops. For details 

of general settings that can be made see Joint Material Models. 
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Hysteresis settings 

For piecewise linear (hysteretic) joints, by default, basis hysteresis settings and curve 

data for at least one hysteresis loop need to be defined.  

 Compound hysteresis  When selected, allows hysteresis settings and curve 

data for a second hysteresis loop to be defined.  

 Coupled When selected, defines the force / deformation relationship for all 

degrees of freedom with respect to the deformation in the axial or normal 

direction. When unset, the relationship in each degree of freedom is defined 

independently. 

Hystereris models 

The generic hysteresis models implemented in LUSAS are: 

 Parallel reversal loading 

 Kinematic-hardening   

 Kinematic-hardening with slackness   

 Origin centred   

 Peak oriented 

 Kivell 

 Pinching point 

 Modified Takeda   

 Muto outer   

 Fukada outer 

 Sina outer 

 Stewart 

 Franchin - available by selecting Parallel reversal loading with an initial 

stiffness unloading rule. See table below. 

See Hysteretic Joint Model Force Response Curves for loading and unloading 

forms of these models. 

See LUSAS Theory Manual 1 for more details on these models. 

Unloading rules 

For the ‘Origin centred’, ‘Peak oriented’ and ‘Stewart’ hystereris models the 

‘Unloading rule’ drop-down is disabled as these model types only use their inherent 

unloading rules. For the other hysteresis models the following unloading rules may be 

chosen: 
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 Initial stiffness 

 Secant stiffness 

 Scaled stiffness 

 Emori-Schnobrich 

 Drain-2D 

To make hysteresis and unloading rule settings to directly match industry-named 

hysteresis models see the mapping table below. 

Properties for each degree of freedom / common to all 

freedoms 

Force / Displacement curve data to define each linear segment defining the backbone 

of a hysteresis model and hysteresis parameters must be specified for each chosen 

degree of freedom. Selecting the appropriate radio button and the accompanying 

Specify button will launch a separate sub-dialog on which the data can be defined. See 

Joint Material Models for details. 

Note that it is possible to select different unloading rules for each hysteresis loop.  
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Settings required to directly match industry named hysteresis 

models 

 
Hysteresis loop and LUSAS 
Hysteresis Model 

   
 
Unloading rule 

   
Linear 
segments * 

  Equivalent industry 
named  
Hysteresis Model 

H1: Kinematic hardening   Emori and Schnobrich   1   Degrading bi-linear 

H1: Kinematic hardening with 
slackness 

  Initial stiffness   3   Bi-linear with 
slackness 

H1: Origin centred   (inherent)   1   Origin-centred bi-
linear 

H1: Peak oriented   (inherent)   1   Peak oriented 

H1: Kivell   Emori and Schnobrich   1   Kivell degrading 
stiffness 

H1: Pinching point   (Any)   1   Pivotal plastic model 

H1:Modified Takeda   Emori and Schnobrich 
or Drain-2D 

  1   Modified Takeda 

H1: Origin-centered 

H2 :Muto outer 

  (inherent) 

Initial stiffness 

  3   Muto degrading tri-
linear 

H1: Kinematic hardening 

H2: Fukada outer 

  Initial stiffness 

Emori and Schnobrich 

  3   Fukada degrading 
tri-linear 

H1: Peak oriented 

H2: Sina outer 

  (inherent) 

Emori-Schnobrich 

  3   Sina degrading 
trilinear 

H1: Stewart   Scaled stiffness   3   Stewart degrading 
stiffness 

H1: Parallel reversal loading   Initial stiffness   1   Franchin 

  

* Number of linear segments defining backbone of model 

For example, to make settings for a Degrading bi-linear hysteresis model, as generally 

named and used in industry, select LUSAS hysteresis model 'Kinematic hardening' and 

the unloading rule 'Initial stiffness', and define a single line segment for the primary 

backbone of the curve. 



Modeller Reference Manual   

    

388 

Hysteretic joint model force response curves 

   

Parallel reversal loading 
The Franchin model is implemented using a flat (zero) 

stiffness beyond the active and passive limits 

 

Kinematic hardening  
This simplest form is the same as the Degrading bi-

linear model) 

 
 

 Kinematic hardening with slackness 
(This simplest form is the same as the Bi-linear with slackness 

model) 

 

Origin centred 

  

 

 
Peak oriented 

 

Kivell 
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Pinching point 

  

Modified Takeda 

  

 

  

 

Muto outer 

  

Fukada outer 

  

 

 

Sina outer 

 

Stewart 

See LUSAS Theory Manual 1 for more details on these joint models. 
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Matrix properties for joint elements 

 For joints defined by a matrix of properties the following options are available 

according to the analysis category in use. 

 Assignment to Points and Line ends, Lines, or Surfaces 

 Joint type Joints for beams, Joint for semiloof, Joints no rotational stiffness 

 Matrix type options are Stiffness (as typically used to specify a joint 

representing a pilecap sitting on a group of piles in a 3D model), Mass (for use 

with Non-structural mass elements), Mass Rayleigh Damping (for assigning 

damping characteristics to a joint with no stiffness). 

Note that it is only possible to assign one matrix joint property (i.e. stiffness or mass or 

mass rayleigh damping) to a joint. Multiple assignments are not supported, but 

multiple coincident joints may be created to model such behaviour. 

Two input options are provided: 

 First quadrant permits entries in the top-right triangle of the top-left quadrant 

only, and all other entries (greyed out) are reflected automatically. 

 Full matrix permits entries in the top-right triangle of the full matrix and the 

bottom-left triangle (greyed out) is reflected automatically. 

Example input cell layouts for Joint type: Joint no rotational stiffness: 

 

First quadrant 

  

 

Full matrix 

  

Example input for Joint type: Joint for beams (3D) is shown below where values of K1 

to K8 are entered in one quadrant and reflected automatically in other quadrants. K7 

and K8 are coupling terms in this case. 
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Data entry for a symmetrical matrix 

  

For more information please refer to the Solver Reference Manual.  

Support Conditions 

Support conditions describe the way in which the model is supported or restrained and 

are defined from the Attributes > Support menu.  

A support is defined for use with a particular analysis category. 

Structural supports 

A summary of the structural support types is given here: 

 Free For structural analyses the degree of freedom is completely free to move. 

For pore water analyses no flow will occur through the node. For thermal 

supports no heat will flow through the node. 

 Fixed For structural analyses the degree of freedom is completely restrained 

from movement. For pore water analyses flow will occur through the node. For 

thermal supports heat will flow through node to maintain temperature at zero 

(or at a prescribed temperature). 

Spring Stiffness Distribution 

Spring stiffness is applied either uniformly, per unit length or per unit area. Spring 

stiffness values can be applied uniformly to all nodes meshed on the assigned feature, 

or their values may vary over a feature by applying a variation.  

 Stiffness applies the spring stiffness uniformly to all nodes meshed on the 

assigned feature. 

 Stiffness/unit length and Stiffness/unit area distribute the total spring 

stiffness between the nodes on the assigned feature. Nodes will be supported 

based on a lumped stiffness approach considering mesh density. For 

axisymmetric models stiffness/unit length is a stiffness per unit length, per 

radian. 

Simple lift-off supports 

A simple lift-off support can be specified by pressing the Lift-off button and selecting 

the appropriate radio button for the degree of freedom that will control the lift-off 
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condition for the support. For this a single value for the lift-off freedom needs to 

defined, where the lift-off value to be stated is the value that would be required to 

overcome the reaction or restraint at that support. This means that a positive lift-off 

value would be entered to overcome a negative reaction. Entering a negative lift-off 

control value effectively reverses the lift-off behaviour. 

 A Lift-off value is set for either Force, Moment, Hinge rotation, or Flow for 

a chosen degree of freedom. Lift-off will take place once a stated value has 

been exceeded. 

Additional behaviour can be specified for when lift-off has occurred: 

 Release restraint in lift-off direction only releases only the specified restraint 

(controlling freedom), leaving all other restraints applied. 

 Release all restraints releases all restraints. 

Advanced lift-off supports and touchdown (contact) 

More advanced lift-off behaviour can be modelled and specified using the Contact 

button. This provides for both lift-off and touch down and requires setting the 

appropriate contact conditions for the degree of freedom that will control the lift-

off/contact behaviour. 

 For lift-off (whether for all directions or the chosen direction), the support 

fixity part of the dialog describes the behaviour before the lift-off has occurred.  

 For contact/touchdown, the support fixity part of the dialog describes the 

behaviour after the touchdown has occurred. 

Contact control settings for Force, Moments or Flow 

 Contact control can be set for either Force, Moments, or Flow values, and for a 

chosen degree of freedom. Upper and lower limits can be specified at which 

lift-off will occur. Contact will be deemed to be taking place once a stated 

value has been reached. 

 As for simple lift-off, additional behaviour can be specified for when lift-off or 

contact has occurred: 

 Release restraint in lift-off direction only releases only the specified restraint, 

leaving all other restraints applied. 

 Release all restraints releases all restraints. 

Contact control settings for Displacements or Pore Pressure 

 Contact control for a Displacement or a Pore pressure based support condition is set 

using a Gap condition. For this, a supported node is free to move within an upper 

value and lower value. Touch down (contact) will occur when a limiting value is 

exceeded. This option would be used to restrict the movement of a pipe in a pipe 
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support, or the movement of a bridge beam or deck supported by a displacement-

restricted bridge bearing for example. 

Lift-off / Contact examples 

 

 Notes 

 The degrees of freedom which may be restrained for any analysis depend on 

the chosen element type. Those applicable for each element are defined in the 

Element Reference Manual. 

 For structural problems Translation in X, Y, Z and Rotation about X, Y, Z refer 

to freedoms along and about the global axes unless a local coordinate is 

assigned in which cases the axis directions refer to local directions x, y, z. 

 A hinge (loof) rotation is a local freedom which refers to rotation about the 

side of an element. Pore pressure is a special freedom type used in two phase 

elements. 

 For thermal (field) problems there is only one freedom type, temperature (or 

the field variable). 

 A support can only be set to have lift-off or contact properties, not both. 

 If a particular freedom has been chosen as the freedom that controls lift-off / 

touchdown, it must either be either a restrained of spring freedom, it may not 

be ‘free’. 

 When loadcases that contain supports with lift-off or contact behaviour are 

used in load combinations or envelopes, a warning symbol is added to the load 

combination/envelope icon to signify that lift-off/contact supports are defined 

and that the principal of superposition is not true for these results. These 

combinations can be expanded to enable a nonlinear analysis to be carried out. 

See Combinations and Envelopes for details. 
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Additional settings for use with nonlinear analysis 

Two system parameters ICNTCT and MXLFTO may be set to modify how the lift-off 

freedoms are handled in a nonlinear analysis. The parameters only affect lift-off 

freedoms which are lifting-off for the first time, that is, those that may have a bolt or 

anchor to break. After the increment in which lift-off occurred has converged, a 

freedom may lift-off and re-ground without restriction. 

 ICNTCT =0 (Default value) Lift-off freedoms which lifted-off for the first 

time in the increment are not allowed to re-ground until the increment has 

converged. Once converged the initial fixity of the re-grounded freedom is 

restored and the increment is resolved 

 ICNTCT=1 No freedom is allowed to lift-off or re-ground for the first time 

until the increment has converged. On convergence the increment is resolved 

with the application of all pending lift-off/re-grounding conditions. 

 ICNTCT=2 No freedom is allowed to lift-off or re-ground until the increment 

is solved. On solution all pending freedoms may re-ground but only the 

freedom with the largest lift-off force is allowed to lift-off. The increment is 

then resolved. 

 ICNTCT=3 All freedoms are allowed to lift-off and re-ground at any point in 

the increment. 

After a freedom has lifted-off for the first time, possibly breaking a restraining bolt or 

anchor, it is allowed to re-ground and lift-off but the lift-off force is set to zero in 

subsequent increments reflecting the fact that lift-off has in some way damaged the 

restraint. If all nodal freedoms were released on lift-off, these remain free regardless of 

future touch downs. ICNTCT can be set to 3 if there are no restraints to be broken. 

 MXLFTO limits the number of times in an increment that the lift-off variables 

can be released or restored. It is used to prevent an infinite loop developing in 

which a node may repeatedly come into and then lose contact, a process known 

as chatter. 

See Model Properties for details about setting these system parameters. 

Thermal / Hygro-thermal Supports 

Thermal and Hygro-thermal support conditions describe the heat flow at the model 

boundaries. Degrees of freedom can be made Free or Fixed. By default all freedoms 

are Free. For both: 

 Free no heat will flow through the node (insulated) 

 Fixed heat will flow through the node to maintain temperature at zero (or at a 

prescribed temperature). 

 

The following support types are for use with hygro-thermal analysis only: 

file:///C:/SVN/Content/1using/Model_Properties.htm
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 Temperature 

 Capillary pressure 

 

Note that while a structural analysis cannot be carried out without supports, transient 

thermal or hygro-thermal analysis can be done without 'supports'. For instance an 

environmental temperature load could be used instead of a prescribed temperature at a 

boundary node. 

Assigning Support Conditions 

Supports can be assigned to a model in a number of ways: 

 By dragging a support attribute from the Attributes  Treeview onto 

previously selected geometric features (or to mesh objects in a mesh-only 

model).  

 By assigning a support type to all relevant features in a model by use of the 

Assign to All context menu available for the loading type.  

 By copying and pasting a support type between Analysis entries in Analyses 

 Treeview, or between loadcases in a Nonlinear or transient analysis. 

For linear static analyses all support conditions are assigned to the first loadcase, and 

persist for all loadcases in the analysis. For a nonlinear or transient analysis, in which 

the support conditions change, support conditions may be assigned to any loadcase, 

and persist for all subsequent loadcases.  

Features that are supported automatically support common lower-order features. For 

instance,two lines supported in X and Y directions respectively, will automatically 

result in a common point being restrained in those directions also.  
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Support dependency across analyses / loadcases 

 Supports defined for the first loadcase within a base analysis can be optionally 

inherited by all other analyses. 

  For a linear analysis, supports assigned to the first loadcase of the analysis will 

be used by all following loadcases within that analysis. Supports cannot be 

changed for different loadcases within a linear analysis. 

 In an analysis which has supports on certain features inherited from the base 

analysis, assigning further support attributes to the same features supersedes 

those inherited. All inherited supports on other features persist. 

 In a Nonlinear (or transient) analysis, support conditions may be assigned to 

features in any loadcase increment (or time step) - superseding any assignment 

to the same feature in preceding loadcases. Supports assigned persist for all 

subsequent increments/time steps - unless "over written" in a later loadcase. 

 In order to make a support fixity become ineffective from some loadcase 

(increment/ time step) partway through a nonlinear or transient analysis, a 

support attribute with a "free" condition can be assigned. Starting at the 

loadcase where the new assignment has been made, the support conditions will 

overwrite, rather than add to, any supports assigned to the same feature in prior 

loadcases. 

 A branch from a nonlinear or transient analysis has the support conditions 

appropriate to the loadcase (increment/timestep) from which the branch stems. 

If it is a nonlinear and transient branch, then support conditions may be 

assigned to features in any loadcase, following the logic described above. 

 For a floating structure, where supports are not required, an eigenvalue analysis 

may be possible by specifying the 'Shift to be applied' in the eigenvalue 

control dialog. 

Notes 

 Support conditions are assembled at each node, using all the assignments on 

the relevant features in the pertinent loadcase. For example, at the connection 

between two lines there is a point and a node. The supports at that node are the 

sum of any restraints in the support assignments to the point itself and the two 

connected lines. 

 In subsequent loadcases, a support assignment to any relevant feature causes a 

re-assembly of supports at such a node. For example, at the connection 

between two lines there is a point and a node. Translations in the z-direction 

might be restrained ('Fixed') at the node, owing to an assignment to one of the 

lines. To eliminate that fixity in a later loadcase, a support definition with z-

direction set to 'Free' should be assigned to the line in question in the 
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appropriate loadcase. Likewise, if the z-direction fixity arose from an 

assignment to the point feature, it should be eliminated by a support definition 

with z-direction set to 'Free' assigned to the point in question in the appropriate 

loadcase. 

 In the summation of restraints, at a node - for a given degree of freedom - 

'Fixed' is preferred over 'Spring' which is preferred over 'Lift off', which is 

preferred over 'Free' for the same Degree of Freedom. 

 Assigning a local coordinate to a feature changes the freedom directions of the 

underlying element nodal freedoms and will hence also affect any supports and 

"global" loads applied to that feature.  

 Lift-off supports may be defined on the Support Attribute dialog, using the 

'Lift off' button. Other forms of contact, including tension-only behaviour may 

be defined using the 'Contact' button. For more elaborate behaviour at supports, 

using joints or interface meshes may be used. 

Visualising Support Conditions 

Support visualisation can be toggled on and off using the  support visualisation 

button. 

Support attributes can be visualised individually by selecting an attribute name in the 

Attributes  Treeview and clicking the right mouse button to choose Select 

Assignments or Visualise Assignments from the context menu. This is the easiest 

way to interrogate the assignment of a single attribute. 

Viewing support assignments 

Loadcases and analyses to which attributes such as supports have been assigned can be 

viewed in a tabular form by selecting View Assignments from the context menu for 

the attribute. 

Deassigning Supports 

Supports may be deassigned from all or selected features by selecting the support 

attribute in the Attributes  Treeview  with the right hand mouse button and picking 

the Deassign entry from the context menu. The menu item entries From Selection or 

From All may then be chosen to deassign from the items in the current selection or 

from all the features in the model. Unassigned attributes will be denoted with a 

greyed-out bitmap . 

Support attributes may also be defined by selecting View Assignments from the 

context menu for the attribute and unchecking the relevant loadcase. 
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Support Styles 

The Attributes layer properties define the styles by which supports are visualised and 

also permits visualisation of supports on an individual basis. The attributes layer 

properties may be edited directly by double clicking the layer name in the Layers  

Treeview. Loading can be visualised in three ways: 

Support conditions can be visualised in three ways: 

 Arrows Visualises restraints as straight arrows representing translational 

freedoms, and circular arrows for rotational freedoms. Spring supports are 

visualised as spring representations. Hinge freedoms are not visualised. For 

supports defined using lift-off or contact criteria the controlling freedom is, by 

default, coloured orange with other support freedoms remaining the default 

green. 

 Symbols Places a symbol on each supported node. 

 Codes Writes a code next to each supported node representing the type of 

support assigned. The code uses F = Free, R = Restrained (Fixed), S = Spring. 

For example, a code RRSFFF represents a six degree of freedom node that is 

restrained in X and Y directions, supported with a spring in Z direction and free 

in all three rotational freedoms. 

See About Model Attributes for more details. 

Notes 

 For nonlinear and transient problems, by default, supports are visualised for the 

active loadcase by combining the assignment in the loadcase history. To view 

the supports assigned to the active loadcase only, select the Show only 

assignments in the active loadcase option on the support visualisation dialog 

accessed from the attributes layer properties. 

 Support visualisation may be drawn using the parent feature colour by 

selecting the Colour support by geometry option on the  support visualisation 

dialog accessed from the attributes layer properties. This is useful to identify 

which feature type a support attribute is assigned to. 
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Example: Translational Fixed and 
Spring Supports 

This 3D structure is restrained from any 
lateral movement at the base of all legs. 
The same points are also sprung 
vertically to represent a non-rigid base 
support. 

 
  

 

  
Example: Translational Supports 

This 2D structure is restrained horizontally and vertically 
at the left edge with a single restraint in both in-plane 
translational directions. This rigidly fixes the body along 
the edge shown while allowing the rest of the model to 
move. 

 

  

About Loading 

Loading attributes describe the external influences to which the model is subjected. 

Structural, Thermal and Hygro -Thermal loading options are provided on separate 

Attributes > Loading menu items according to the user interface in use. A summary 

of the loading types is given here: 

Structural Load Types 

 Structural Loads are concentrated, body force, distributed, face, temperature, 

stress/strain, and beam loads. 

 Prescribed and Initial Structural Loads are used to specify initial 

displacements, velocity or acceleration at a node.  

 Discrete Structural Loads are used to distribute a given loading pattern (such 

as for a type of vehicle) over full or partial areas of the model, independent of 

the model geometry. Point and Patch loads are discrete loads - also known as 

general loads. Compound discrete loads permit sets of point and patch (and 

compound loads) to be defined. 

 

Thermal Load Types 

 Thermal Loads describe the temperature or heat input to a thermal analysis. 

 Discrete Thermal Loads are used to distribute a given loading pattern over 

full or partial areas of the model, independent of the model geometry. 
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Hygro-Thermal Load Types 

 Hygro-Thermal Loads describe the temperature/heat and moisture input to a 

hygro-thermal analysis. 

 Discrete Hygro-Thermal Loads are used to distribute a given loading pattern 

over full or partial areas of the model, independent of the model geometry. 

 

All Structural, Thermal and Hygro-Thermal loads are feature-based loads that, once 

defined, can be assigned to the model geometry (or to mesh objects in a mesh-only 

model) for a stated analysis and loadcase, and they are effective over the whole of the 

feature to which they are assigned. Discrete loads are feature independent. Further 

control over how discrete loads are applied is available by using a Search area. Once 

defined, loading attributes are added to the Attributes  Treeview.  

Assigning Loading 

Loading can be assigned to a model in a number of ways: 

 By dragging a loading attribute from the Attributes  Treeview onto 

previously selected geometric features (or to mesh objects in a mesh-only 

model).  

 By assigning a loading type to all relevant features in a model by use of the 

Assign to All context menu available for the loading type.  

 By copying and pasting a loading type between Analysis entries in Analyses 

 Treeview. 

When a load is assigned, an analysis and a loadcase must be defined. A load factor 

may also be specified. If a load factor is entered the loadcase name will include this 

load factor. If the load is to be assigned to a new loadcase the new loadcase name may 

be entered into the loadcase combo and the new loadcase may be set active using the 

checkbox provided. 

 Setting the loadcase as the active loadcase ensures that immediate load visualisation 

will take place. Additional options are available when applying discrete loads, see 

Assigning Discrete Loads for more information. 

Some loads act in global directions, others in local element directions. The defined 

loading value will be assigned as a constant value to all of the nodes/elements in the 

feature unless a variation is applied. Variations can be applied to all feature load types 

except for Beam Distributed loads that have a variation built into the definition.  

Tip. If the required loading directions of a global load do not lie in the global axes 

then a local coordinate may be assigned to the feature to transform the loads to local 

coordinate directions. 
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Advanced loading assignment 

The Loading Assignment dialog provides additional options to assign loading to a 

range of loadcases, or to one or more specified loadcases within an analysis. 

 Range of loadcases from specifies the starting loadcase in the Analyses  

Treeview of a range of loadcases to which the loading will be assigned. One of 

the next two settings will also be required. 

 Until specified loadcase Specifies the end of the loadcase range in the 

Analyses  Treeview to which the loading will be assigned. 

 Until end of analysis Assigns the loading to all loadcases that follow the 

specified starting loadcase in the Analyses  Treeview.  

 Specified loadcases permits individual selection of one or more loadcases to 

which the loading will be assigned. 

Notes 

 Load factors of assigned loads can be changed by selecting the Change load 

factor menu item accessed from the loading name context menu.  

 Subsequent editing of a load factor for a loadcase where the load factor was 

initially defined for a range of loadcases will change the factor used on each of 

the loadcases in that range. If this is not what is required, load case factors 

should be assigned on a per-loadcase basis.  

 If a single loadcase, that was defined outside of a range of loadcases, is moved 

in the Analyses  Treeview to a position within a range of loadcases its load 

factor will be retained in addition to any load factor already specified for the 

range of loadcases in which it now sits, and both load factors will be applied 

during an analysis. 

 In nonlinear and transient analysis feature-based loads can be factored using 

load curves.  

 Consult the Element Reference Manual in order to check that the required 

loading is available for a particular element. 

Gravity loading 

Gravity loading can be applied on an analysis or loadcase by loadcase basis. Gravity 

loading is applied as a Body Force load type. 
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Loading dependency across analyses / loadcases 

Unlike supports, loadings defined for one analysis or loadcase are not inherited by 

following analyses or loadcases. Loadings can however be copied and pasted between 

analyses in the Analyses  Treeview. 

Visualising Assigned Loading 

Loading attributes can be visualised individually by selecting an attribute name in the 

Attributes  Treeview and clicking the right mouse button to choose Select 

Assignments or Visualise Assignments from the context menu. This is the easiest 

way to interrogate the assignment of a single attribute. 

Load visualisation can be toggled on and off using the  load visualisation button. 

Viewing loads by definition and by effect on the mesh is also possible via the  

load visualisation button's drop-down menu 

Viewing of assigned loads on a loadcase basis requires each loadcase in the Analyses 

 Treeview to be set active in turn using the Set Active context menu item. 

Viewing loading assignments 

Loadcases and analyses to which attributes such as loading has been assigned can be 

viewed in a tabular form by selecting View Assignments from the context menu for 

the loading entry in the Attributes  Treeview. 

Editing of multiple loading attributes 

For particular structural loading attributes, editing of the properties of multiple load 

attributes of the same loading type is possible. Structural load types supported by this 

facility are: 

 Concentrated load 

 Body force load 

 Global distributed load 

 Face load 

 Local distributed load 

 Temperature load 

 Tendon load 

Note that other load types and other non-load attributes require editing individually. 
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Styles 

The Attributes layer properties define the styles by which loading is visualised and 

also permits visualisation of loadings on an individual basis. The Attributes layer 

properties may be edited directly by double clicking the layer name in the Layers  

Treeview. Loading can be visualised in three ways: 

 By colouring geometry Colours the geometry according to which loading 

attributes are assigned to which features. 

 Using symbols Marks the geometry with symbols according to which loading 

attributes are assigned to which features. 

 Using arrows Visualises the loading attribute using arrows. For discrete loads 

the definition and the effect on the mesh may be different.  

See About Model Attributes for more details. 

Structural Loading 

Structural loading is feature based and hence it is assigned to the model geometry (or 

to mesh objects in a mesh-only model). Variations in loading on a feature can be 

specified using a Variation. For information on which load types can be applied to 

which element types, see the Element Reference Manual. 

Structural loading is accessed via the Attributes > Loading or Attributes > Loading 

> Structural menu items depending upon the type of user interface in use. 

Structural load types available are: 

 Concentrated 

 Body Force 

 Global Distributed 

 Face 

 Local Distributed 

 Distributed to Perimeter 

 Temperature 

 Temperature profile 

 Strain profile 

 Stress and Strain 

 Internal Beam Point 

 Internal Beam Distributed 

 Tendon 

file:///C:/SVN/Content/4attrib/idh_structural_loads.htm


Modeller Reference Manual   

    

404 

In the following headings the LUSAS Solver name for the loading is shown in 

parentheses (when available). 

Concentrated Load (CL) 

A Concentrated Load defines 

concentrated force and moment loads 

in global (or transformed) directions.  

A Concentrated Load is applied per 

node of the underlying feature onto 

which the load attribute is assigned. 

A Concentrated Load is therefore 

normally only used to assign a load 

to a point as the total applied load 

would otherwise be dependent on the 

mesh density of each feature 

assigned to. 

Concentrated loads are defined relative to the nodal coordinate system. If the required 

loading directions of a global load do not lie in the global axes then a local coordinate 

may be assigned to the feature to transform the loads to local coordinate directions. 

Concentrated loads can be applied in cylindrical coordinates for Fourier elements by 

setting the option on the Attributes tab of the Model Properties dialog. 

Body Force (CBF) 

A Body Force defines an 

acceleration or force per unit volume 

loading in global directions. A 

typical example of body force 

loading is self weight, which requires 

the specification of gravitational 

acceleration and mass density (in the 

material properties).  

By default, Body Forces define 

accelerations, but an option on the Attributes tab of the Model Properties dialog, can 

be set so that Body Forces define a force per unit volume.  

Note that gravity loading can be defined either by directly specifying a constant body 

force load or by defining its existence as a property of a structural loadcase. 

In a coupled hygro-thermal analysis, when using concrete model 105 and heat of 

hydration (i.e. modelling the setting of concrete) the gravity load is increased from 

zero to its final value, depending upon the volume solidification ratio, to avoid 

computational difficulties when concrete is not yet fully solid. A full gravity load is 

attained after approximately 24 hours. 
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Global Distributed Load (CL) 

This defines concentrated force or moment loads in global (or transformed nodal) axis 

directions. Concentrated force loads are applied to all nodes underlying the feature 

onto which the load attribute is assigned. Nodal freedoms can be transformed using 

local coordinate sets. The following sub-types are supported: 

 Total applies nodal load values calculated according to contributions from 

surrounding elements and to element nodal weighting values, e.g. loads are 

weighted with ratios 1:4:1 at nodes along the edge of a quadratic shell in such a 

way as to make the shell strain equally. 

 Line (per unit length) applies nodal loads using the specified values per unit 

length loads. Must be assigned to Lines. 

 Surface (per unit area) applies nodal loads using the specified values per unit 

area loads. Must be assigned to Surfaces. 

Face Load (FLD) 

This defines face traction values and 

normal loading applied in local 

element face directions. Face loads 

are applied to the edges of plane 

elements or the faces of solid 

elements. This type of loading is 

applicable to 2D and 3D continuum 

elements, and certain shell, 

membrane and thermal elements.  

In the example shown, a local y 

direction structural face load is 

assigned to the Surface boundary 

Lines. Note the direction of the axes of the local element faces.  

Where a loaded Line or Surface feature is common to two or more higher order 

features, it is possible to specify to which higher order feature elements the load is 

assigned.  

Note that in a structural analysis the direction of the normal face load is not consistent 

between 2D and 3D continuum elements. For 2D continuum elements it is from the 

face towards the interior of the element. For 3D elements it is in the opposite direction 

- from the face of the element outwards. 

See the Element Reference Manual for details of element face directions. 

Local Distributed Load (UDL)  

This defines a load per unit length or area for line or surface elements in the local 

element directions. Typically, local distributed loading is applied to beam elements 

and shell faces. An example of a local distributed load is internal pressure loading. For 
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beam elements, when the element type permits, uniformly Distributed Load will be 

written to the LUSAS data file as Beam Element Loading (ELDS). 

Distributed Perimeter Load 

Distributed to Perimeter loading distributes a uniformly distributed load, that would 

otherwise be applied to a surface, as equivalent loads applied to the lines that form the 

perimeter of the surface. It is primarily of use in loading concrete floor slabs in 

buildings, where the floor slab is not modelled in full in order to reduce the complexity 

of the model. Surfaces representing the extent of each floor slab must be defined but 

no mesh assignment is required. Lines forming the Surface must, however, be assigned 

a suitable line mesh. Sub-beams that may support a floor slab (other than those beams 

that support its perimeter) can be defined without the need to model those beams as 

line features or elements in the model. Loading on sub-beams as a result of distributed 

slab loading and their self weight is represented as equivalent loads at the locations 

where the sub-beams meet the supporting beams at the perimeter of a surface.  

Temperature Load (TEMP, TMPE) 

Nodal and Element temperatures define the LUSAS Solver TEMP and TMPE load 

types respectively. These loads apply temperature differences on a nodal and element 

basis. Temperature gradients in X, Y and Z directions may also be input. This load 

type can be used in conjunction with temperature dependent material properties to 

activate a different set of properties at a specified point in the analysis. The thermal 

expansion coefficient is normally set to zero in this case.  

Notes 

 Nodal temperatures apply to all elements connected to that node, except joints, 

in which temperature loading is invoked using Option 119. 

 Elemental temperature is only applied to the node of the element specified. 

 For step by step problems, the (initial) temperature values need only be 

specified on the first load step. 

 The Temperature load may be used to provide a temperature field for 

computing initial material properties in a nonlinear analysis. To initialise the 

temperature field in a nonlinear field analysis, the temperature loading must be 

applied using a manual loading increment. 
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Case Study. Temperature 

Gradient Through Slab 

Thickness 

Nodal and element temperature values 

accept gradient values for some element 

types. This gradient applies a differential 

thermal load across the top and bottom 

surfaces of a Surface element. The effect 

of this gradient is to cause bending in the 

structure. See the Element Reference 

Manual for temperature load input 

variations on an element basis. 

In this example (which assumes no slab eccentricity) a 0.5m thick concrete slab is at 

20 degrees Celcius. The top surface is subjected to a temperature of 50 degrees Celsius 

and the bottom surface remains at 20 degrees Celsius. 

 To model this enter the following on the structural temperature loading dialog: 

 The final slab mid-surface temperature of (50+20)/2 should be entered in the 

Final temperature field 

 The temperature gradient through the slab of dT/dZ should be entered as (50-

20)/0.5 in the Final Z temperature gradient field 

 The initial slab mid-surface temperature of 20 is entered in the Initial 

temperature field 

When the analysis is run, LUSAS will multiply the temperature gradient by the 

thermal coefficient of expansion specified in the material property attribute to 

calculate the thermal bending strain.  

This method assumes a linear temperature distribution through the depth of the slab. If 

a known nonlinear variation is required, solid elements must be used with a variation 

defining the nonlinear through-thickness behaviour. 

Temperature profiles may also be used to define the variation of temperature or strain 

through the depth of a bridge deck / beam section.  

  

Temperature profile / Strain profile (TMPE) 

Temperature and strain profile loading is used to define the variation of temperature or 

strain through the depth of a bridge deck / beam section.  
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 For general use, profiles are defined using the Attributes > Loading or 

Attributes > Loading > Structural... menu item.  

 For use with composite bridge deck design, profiles for supported Bridge 

design codes can be created by using the Bridge > Temperature Profiles... 

menu item. See Bridge deck temperature profile loading to design codes.  

For general use, a temperature/strain profile is defined by stating the temperature of 

the top of the section followed by defining a series of segment thicknesses and 

corresponding values for the applicable values of ‘s’, the specific height at which the 

expression is being evaluated (which is always measured from the bottom of the 

section). A step change can be defined by defining a segment thickness of zero. 

Segment thicknesses and temperature/strain may be stated as a single value, and in 

such an instance the value is taken to be at the end of the segment. An example of 

defining a simple temperature profile is shown below. Defining a strain profile is 

similar. 

 

Segment thickness and temperature may also be defined using expressions but note 

that variations cannot be used. The expressions are limited to the following variables: 

 H - total section height 

 s - the specific height at which the expression is being evaluated (always 

measured from the bottom of the section). 

The use of ‘H’ and ‘s’ as variables make it possible to replicate expressions in bridge 

industry Codes of Practice and define profiles that are not generated automatically by 

LUSAS to a supported design code.  

An example of defining temperature loading using expressions is shown below. 

Defining a strain profile is similar. 



  Chapter 5 : Model Attributes 

    

409 

 

In the example, the temperature at the top of the section is stated to be 12.5 degrees. 

The change in temperature from the top of the section to 150 units down from the top 

is defined by the expression '12.5 - ((H-s) * 9.50 / 150.0)' . Another expression 

describes the change in temperature from 150 units to 300 units down from the top of 

the section.  

 Axis of temperature variation defines the axis along which the profile is 

defined. This will usually be the same as the model's vertical axis. For a 3D 

analysis category the user has the choice of a local y or z axis, but for a 2D 

Inplane analysis category a local y axis must be used. For 2D Grillage analysis 

category a local z axis must be used. 

 Consider resulting forces allows the selection of Axial or Flexural forces or 

both and is used to control which components of environmental temperature 

loading are tabulated. Note that for a 2D Grillage analysis category no choice is 

possible since grillage elements only support the flexural direction. 

 Visualise... This button, when pressed, will show the defined profile for a 

stated visualisation height. The graph is dynamic and will update if the stated 

visualisation height is updated. It should be noted that the visualisation height 
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is not part of the attribute definition. The same profile may be assigned to 

multiple geometric sections of differing heights. 

 

Temperature profile visualised over a height of 500 model units 

In the temperature profile shown, the red upper profile is hidden by the blue 

‘combined’ profile at the top of the section and similarly for the green lower profile at 

the bottom of the section. It is the ‘combined’ profile that is integrated to calculate the 

forces and moments in the section. If a smaller section height was chosen, the upper 

and lower profiles would overlap in which case the combined profile would be the 

larger of the absolute value of the two profiles. 

Temperature/strain profiles may be assigned to lines or surfaces. A line or surface may 

not be assigned more than one temperature or strain profile attribute in the same 

loadcase but may be assigned both a single temperature and strain profile in the same 

loadcase. 

 

Stress and Strain Loads (TTSIE, SSI, SSR) 

The input values required in order to define stress and strain loading for particular 

elements can be seen by selecting the either the element description or by entering an 

element name in the Stress and Strain loading dialog.  
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 Target is used to define a value for a selected results component for a feature 

that will be obtained when a solve has taken place. This facility is primarily for 

use when a specified jacking force is required to be applied to one end of a line 

representing a cable. To assign a target value a point must be selected in 

addition to any meshed feature (a line for instance) containing that point. If a 

stress component is selected, all strain components are disabled and vice versa. 

Note that target values are only appropriate for linear materials.  

 Initial defines an element initial stress/strain state in local directions. Initial 

stresses and strains are applied as the first loadcase and subsequently included 

into the incremental solution scheme for nonlinear problems. Initial stresses and 

strains are only applicable to numerically integrated elements. Note that 

specifying a value for an initial stress or force will not necessarily result in that 

actual stress or force being obtained when a model is solved. When this is 

required, specify a target value (see above) instead. 

 Residual defines element residual stress levels in local directions. This can 

only be done for elements with a nonlinear capability. Residual stresses (unlike 

initial stresses) are assumed to be in equilibrium with the undeformed geometry 

and are not treated as a loadcase as such. They are considered as a starting 

position for stress for a nonlinear analysis. Failure to ensure that the residual 

stresses are in equilibrium will result in an incorrect solution. There is no 

concept of residual strains and therefore when the residual button is chosen a 

reduced number of components are presented. 

Refer to the individual element descriptions in the Element Reference Manual for full 

details of the initial stress and strain, and residual stress components. 

LUSAS Modeller will automatically write an appropriate target, initial stress and 

strain, or residual stress type to the datafile when a solve is requested. See the Solver 

Manual for more detailed information regarding the tabulation of targets, initial 

stresses and strains, and residual stresses in LUSAS datafiles. 

Internal Beam Point Load (ELDS) 

The Internal Beam Point load is a point 

load applied to lines in the local or global 

direction. The distance to the point load 

from the start of the line may be defined 

as either a parametric distance (0 to 1 

with respect to the line length) or an 

actual distance. Force and/or Moment 

components are defined for each point 

location. Several point loads may be 

defined in one load attribute if required. 

See the Element Reference Manual - Appendix A for examples of internal beam 

loading (ELDS) types. Refer to each element's main listing to see if an element 

supports this loading type. 
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Internal Beam Distributed Load (ELDS)  

The Internal Beam Distributed load is a 

distributed load that can be applied to 

lines in a model in a local, global or 

projected direction. The distance from the 

start of the line to the start of the 

distributed loading, and the distance from 

the start of the line to the end of the 

distributed loading are defined along with the load component and the start and end 

load values. For local and global loading the start and end distance may be defined as 

either an actual distance or a parametric (0 to 1) distance - both measured along the 

line. For projected loading only an actual distance measured along a global axis is 

permissible. Several distributed loads may be defined in one load attribute if required. 

As an example, trapezoidal loading would be defined as 3 separate load sets with a 

load varying from zero to a load value over an initial stated distance, then remaining at 

the same load level up until a second stated distance, and then varying from the same 

load value back to zero over from that point to a distance equal to the length of the 

line.  

Note that for projected loading on a line not sitting in a primary plane the start and end 

points of each load set are based upon projecting the line back into either an XY, YZ, 

or ZX plane (depending upon the load component selected) with the start of the 

internal loading pattern being measured from the start of the line along the shortened 

plane length of line and not along the actual line length itself. 

See the Element Reference Manual - Appendix A for examples of internal beam 

loading (ELDS) types. Refer to each element's main listing to see if an element 

supports this loading type. 

Tendon Loading 

Definition of tendon loading is only available in selected LUSAS Bridge and LUSAS 

Civil & Structural software products. The Tendon load attribute associates previously 

defined tendon properties and tendon profiles with a specified prestress force and 

associated jacking and loss details. Once defined, the tendon loading attribute is stored 

in the Attributes  Treeview and can be directly assigned to selected relevant 

features in a model. Tendon loading is converted into discrete structural loading for 

prestress calculation purposes. 

See Prestress loading in the Application Manual (Bridge, Civil & Structural) for more 

details. 

  

file:///C:/SVN/Content/Bridge/Prestress_Loading/Prestress_Loading.htm
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Prescribed and Initial Structural Loads 

Prescribed Structural loading is accessed via the Attributes > Loading or Attributes 

> Loading > Structural or menu items depending upon the type of user interface in 

use. 

Prescribed Structural load types available are: 

 Displacement 

 Velocity 

 Acceleration 

Prescribed Displacement Loading 

A prescribed Displacement defines a 

nodal movement by either a Total or 

Incremental prescribed distance in 

global (or transformed) axis 

directions. Freedoms which are 

assigned a non-zero prescribed value 

will be restrained.  

The adjacent example shows two 

methods of applying prescribed 

displacement. Incremental loading adds displacements to a previous increment, 

whereas Total requires the full displacement to be specified on each increment.  

Notes 

 For linear analyses with multiple loadcases an automatic restraint is only 

assigned if the prescribed displacement is applied in the first loadcase. If a 

prescribed displacement is not assigned in the first loadcase but is assigned in 

subsequent loadcases a restraint must be assigned manually. 

 Prescribed displacements can be assigned and turned-off on a loadcase basis. 

 Total and incremental prescribed displacements should not be used in the same 

analysis. 

 It is recommended that total prescribed displacements are used with load 

curves. 

 Prescribed rotations should be specified in radians. Large prescribed rotations 

will require a geometrically nonlinear analysis. 

 The assignment of a prescribed displacement of zero to a freedom of a node (in 

order to return it to an original undeformed position) causes a 'hidden' support 

to be created that remains active in all following loadcases, until it is 
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superseded either by another prescribed displacement load, or by another 

support assigned to a following loadcase. A Prescribed Loading entry within an 

analysis loadcase in the Attributes  Treeview effectively represents a 

support condition. 

Prescribed Velocity and Acceleration Loading 

In dynamic analyses, prescribed velocities and accelerations may be defined for any 

nodal variable. These values can be used to specify an initial starting condition or 

prescribed for the whole analysis.  

 A prescribed, or initial Velocity defines a velocity loading in global (or 

transformed) directions. 

 A prescribed, or initial Acceleration defines an acceleration loading in global 

(or transformed) directions. If acceleration loads are required, the density must 

be specified in the material properties. Initial accelerations are only valid for 

implicit dynamic analyses. 

Notes 

 If the values are to be prescribed throughout the analysis load curves must be 

used, see Load Curve Definition. 

 Initial velocities and accelerations should only be applied to the first loadcase. 

 In general, load curves should be used to prescribe velocities and accelerations 

in an analysis. However, initial values may be defined without using load 

curves if no other load type is controlled by a load curve. 

 If velocities and accelerations are prescribed for the same variable at the same 

point in time in an analysis, the acceleration will overwrite the velocity and a 

warning will be output. An exception to this rule occurs for implicit dynamic 

analyses where an initial velocity and acceleration may be used to define an 

initial condition for the same variable. 

 If initial conditions are to be applied, refer to Transient Dynamic Analysis for 

details on how to compute the data input required for the appropriate 

integration scheme. 

Initial Velocity / Initial Acceleration Load (VELO/ACCE) 

In dynamic analyses, velocities or accelerations at a nodal variable can be defined. 

These values can be used to specify an initial starting condition or they may be 

prescribed for the whole analysis. If values are to be prescribed throughout the 

analysis load curves must be used and the appropriate freedoms must be restrained. An 

initial velocity can be input direct. To input an initial acceleration an Advanced setting 

must be specified. Please contact technical support in this instance. 
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Discrete Structural Loads 

Discrete structural loads are used to distribute a given loading pattern (such as for a 

type of vehicle) over full or partial areas of the model, independent of the model 

geometry. Discrete structural loads are defined in relation to their own local coordinate 

system, the origin of which is given by the coordinates of the Point feature to which 

the load is assigned. Note that discrete loads are always assigned to Points. Discrete 

structural loads differ from feature-based loads in that they are not limited to 

application over whole features. Discrete structural loads may be projected over an 

area, onto Lines or into Volumes. Separate discrete loads may be applied to a model as 

a set or load train using the Compound load option. Search areas can be used to control 

load assignment. 

To identify critical vehicle loading patterns on bridges (using discrete point and patch 

loads) vehicle load optimisation is available for selected software products only. See 

Application Manual (Bridge, Civil & Structural) for details.  

Discrete loads are useful for applying 

a load that does not correspond to the 

features underlying the mesh. A 

patch load may be spread or skewed 

across several features. LUSAS 

automatically calculates the nodal 

distribution of forces that is 

equivalent to the total patch load. 

This example shows a typical set of 

point loads assigned to a grillage 

model. A single point, a group of 6 and a group of 16 point loads are shown. 

The coordinates of the vertices defining the patch are relative to the Point to which the 

patch load is assigned, i.e. a load definition is defined in a local coordinate system, the 

origin of which is given by the coordinates of the Point to which the load is assigned. 

The Point does not have to lie on the Surface to which the load will be applied as the 

patch load is projected in a specified direction.  

Using Search Areas with Discrete Loads 

A discrete load is distributed onto the elements over which the load lies. A Search 

Area is a way of controlling the load distribution onto these elements. If no search 

area is specified when assigning the load, then all of the underlying elements will be 

eligible for load distribution. 

Notes 

 While projecting the loads into the search area a check is made for multiple 

intersections of the load and the search area. Multiple intersections indicate an 

file:///C:/SVN/Content/Bridge/Vehicle_Load_Optimisation/Vehicle_Load_Optimisation_Overview.htm
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ambiguity in the location of the load. This ambiguity may be resolved with a 

more specific search area.  

 The distribution of load to the nodes follows the shape functions of the 

particular element. In quadratic elements, this distribution can appear at first 

unlikely. For example, a unit positive load at the centre of an 8-noded quadratic 

element, results in negative 0.25 loads at the corners and positive 0.5 loads at 

the mid-side nodes. 

 Search areas are automatically created and used by the prestress loading 

facility to define the target to be loaded. 

Discrete structural loads generated by LUSAS 

Examples of discrete structural loads that are created automatically by LUSAS include 

patch and point loadings created by vehicle load optimisation software to represent 

vehicle and lane loading,and equivalent nodal loading defined as a result of using the 

prestress loading facility. Manual manipulation of discrete loads generated by these 

facilities is disabled by default, with the intention that they should be edited or deleted 

using the facility that created them. This restriction can however be removed, if 

desired, to allow manual editing and deletion of these loads, by selecting the File> 

Model Properties>Attributes menu item and selecting Allow modification of LUSAS-

generated attributes. 

Discrete Structural Load Types 

A discrete load consists of coordinates defining the local x, y and z position and a load 

intensity. Any Points selected prior to the Discrete loading dialog being displayed are 

entered as coordinates into the grid and are ordered to an expected point order where 

possible. Discrete load types available are: 

 Point load 

 Patch load   

 Compound load 

Point Load  

Point loads provide concentrated loading at specified locations. Point loads can be 

defined singly or as a set of discrete point loads in 3D space. Each individual load can 

have a separate load value. Point loads can be defined via Arbitrary input or by 

specifying a Grid input. 

This example uses 16 distinct load values. The loads are applied to the model as 

distinct loads. 

file:///C:/SVN/Content/Bridge/Vehicle_Load_Optimisation/Vehicle_Load_Optimisation_Overview.htm
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Patch Load  

Patch loads provide a loading per unit length or per unit area. Loads can be defined in 

global or local untransformed load directions. Loading types are: 

 8 node patch - used to define a curved sided quadrilateral 

 4 node patch- used to define a straight sided quadrilateral 

 Multi-node patch - used to define a series of straight sided patches of any 

number of points.  

 Straight line - requires 2 specified coordinates to define a straight line load 

 Curve - requires 3 specified coordinates to define a curved line load 

 Multi-straight line - used to defined a series of straight line loads, requiring 2 

specified coordinates to defined each line. 

The following examples show patch loads assigned to Point 1. Once assigned, the load 

origin is located at Point 1. The discrete load point order (P1, P2 etc) shows the order 

in which the coordinate definitions should be made. 

Example 1.  

A straight line load defined using 2 
coordinates. 

   Example 2.  

A curved line load is defined using 3 
coordinates. 
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Example 3.  

A straight sided quadrilateral defined using 4 
coordinates.  

  Example 4.  

A curved sided quadrilateral defined using 8 
coordinates.  

  

 

  

 

Example 5.  

Multi node patch loading.  

  Example 6.  

Multi straight line loading.  

 

  

 

Notes 

 The mid-side nodes for a curved line load and for a curved sided quadrilateral 

load must lie with +/- 10% of the overall distance between the corner nodes. 

 Multi node patch loading is always straight sided. A minimum of 4 coordinate 

points and an even number of coordinate points overall must be defined. 

Compound load  

Compound loads may be created to simplify the definition and assignment of more 

complex load patterns. A compound load can be formed from a set of previously 

defined discrete loads and be subsequently assigned to a model as one loading. A 

compound load may be defined from any combination of existing point, patch and 

compound discrete loads. For example a discrete patch load representing a vehicle 
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may be included in a compound load twice with the distance between the vehicles 

specified. x, y, z offsets and a translation can be specified to locate the compound 

loading from away from an assigned point. When created, compound discrete loads 

are held in the Loading section of the Attributes Treeview in their own section named 

Compound. 

 

  

Defining Discrete Point and Patch Loads 

 Arbitrary permits the definition of any number of Point loads. If the points are 

defined in an expected grid order (see Grid entry), then the loading components 

can be optionally projected along the columns and rows of the patch load grid 

into a search area (if used), otherwise the loading is applied to the nearest load 

location in the search area. 

 Grid adds the correct number of rows to the point load definition grid for the 

number of x and y values defined and expects the coordinate points to be 

defined in a particular order so that any loads that may overhang a search area 

(if used), can be optionally projected to be included into the search area. For a 

grid of points of x=3, y=2 the expected order of coordinate input is x1,y1, x2, 

y1, x3, y1, x1, y2, x2, y2, x3, y2. 

Coordinates and magnitude 

 For a point load each attribute defines multiple loads, one concentrated load at 

each given vertex. 

 For patch loads the vertices combine to specify the shape of a line or patch 

load. The load is specified at each vertex allowing the load intensity to be 

varied. Patch types include 8 node, 4 node, multi node, straight line and curve. 
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Load direction 

  Load Direction (an 

untransformed load 

direction) defines the 

direction of the loads in the 

patch before any 

transformation is carried out 

at the assignment stage. 

Options are: X, Y, Z, XYZ, 

Patch x, Patch y, or 

Surface normal. The Patch 

x and Patch y load directions 

apply a patch load in the 

local x or local y direction of 

the patch (and not the local 

coordinates of the 

assignment object.) Patch y is not available for the line patch type. 

 

In the example shown, untransformed global loads are projected onto a model 

normal to the patch definition. The projection vector is denoted by a double-

headed arrow on a visualised patch. The direction of the load applied to the 

model is defined using the untransformed load direction. 

Use of a Patch x load direction in conjunction with any of the patch types 

would, for example, permit modelling of train or vehicle braking effects on 

straight or curved paths.  

Projection Vector 

 Projection Vector is used to work out 

which features are actually loaded. The 

vector is followed (in both directions) and 

any features intersected by the assigned 

discrete load vertices projected in the 

direction of the projection vector are 

loaded in the direction specified by the 

untransformed load direction. For patch 

loads defined by 4 or 8 vertices the 

projection vector is always perpendicular 

to the patch. 

 

This example shows a typical 3D patch 

load where the patch is defined in space 

and projected onto the model. 
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Patch load divisions 

 Patch load divisions 
specifies the numbers 

of divisions in the 

local x and y 

directions of the patch 

being assigned. The 

divisions are used to 

split the applied patch 

into individual 

component loads 

before they are in turn 

used to calculate 

equivalent nodal loads 

on the model. By 

default, the patch load 

division are based 

upon the values set in the  Patch divisions object which is created when a 

discrete loading is added to the Attributes Treeview. Again by default,10 patch 

load divisions are used in the local x direction and the aspect ratio of the patch 

is used to calculate the divisions in the y direction. When creating a patch 

ideally at least one division should be used per element division. The more 

individual loads a patch is split into, the more accurate the solution obtained. 

Patch load divisions can also be explicity defined on the main patch loading 

dialog as a number in x and a number in y. In this case if X=0 and Y=10 is 

entered the number in the x direction will be calculated proportionally to the 

patch shape. Equivalent weighting values are used to calculate the portion of 

each discrete load that is applied to each corner of the element that it lies 

within. The load is then applied as Concentrated Loads. These weighting values 

are based on element shape functions and may vary with element type. 

Assigning Discrete Loads 

Discrete loads are independent of features therefore their application can be more 

flexible. The load assignment parameters are explained below: 
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 Patch Transformation Discrete 

load patches can be mirrored, 

rotated, scaled and generally 

translated from their initial defined 

orientation during their 

assignment to a feature on a 

model. For example, a patch load 

may be skewed by applying a 

rotation transformation when 

assigning the load.  

 

In the example shown right the 

Point load defined about local xy 

axes is assigned to Point 1 subject 

to a patch direction transformation using a 30 degree xy rotation about the 

global origin. Note that the local origin of the patch load is rotated and 

repositioned as well as the patch itself.  

 

To rotate a patch about its centre, define the patch with its local origin at its 

centre. Note that static vehicle loadings (as supplied in the vehicle libraries) are 

generally defined with a loading origin at their centre.  

 Load transformation Changes the load orientation from the (untransformed) 

direction given in the load definition. The transformation applies to the 

direction of the individual load components rather that to the patch as a whole. 

For example, it can be used to model braking loads on a 3D model that have 

horizontal and vertical components by specifying a transformation that will 

rotate the loads out of the vertical direction and into an inclined plane in the 

direction of vehicle travel. 

 Search area A search area restricts loading to a specified portion of the 

model. If a search area is not specified, the load is projected onto the whole 

model. For 2D models it is usually acceptable to default to the whole model, 

but for 3D models where multiple intersections of the load projection onto the 

model may occur it is safer to restrict the loading to the required face using a 

search area. In either case the time taken to assemble the loads is significantly 

improved by using a search area to restrict the number of elements tested for 

intersection with the load. Search areas are automatically created and used by 

the prestress loading facility to define the target to be loaded. 

In addition, the discrete load can be specified to: 

 Project onto line (2D line beam and frame models) Discrete loading is 

applied to the beam as corresponding forces and moments along the beam. 

 Ignore projection direction moments When point or patch loads 

are applied at an offset to a line beam and the projection direction 
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is in the same plane as the applied loading, the associated moment 

induced on the line beam can be ignored by checking this option. 

 Project over area (grillages, slabs and 3D space frames) where the area may 

be defined by a grid of beam elements (for grillages and space frames ), a thick 

plate structure (for slabs), or the face of a solid model. 

 Project over area (shell models) where the area may be defined by a shell 

structure (for slabs).  

 Project into volumes (solid models) Primarily for use with tendon loading 

with 3D models. 

Loads that extend beyond a search area can be included or excluded using: 

 Options for loads outside search area Loads that fall outside the search area 

can be moved into the search area or be excluded entirely using a variety of 

options. See  Processing Loads Outside Search Area. 

The analysis in which the loading applies must be stated and general loadcase 

information that can be entered includes: 

 Loadcase specifies in which loadcase the loading is to be applied. Loadcases 

can themselves be manipulated. See Loadcase Management for more details. 

 Load factor specifies a factor by which the loading is multiplied before the 

equivalent nodal loads are calculated. 

Notes 

When a search area is used as part of assigning a discrete load, the search area icon in 

the Attributes  Treeview will change from grey to coloured to show the search area 

is in use. Whilst this looks the same as when a search area is assigned to geometry 

features in a model, for the former no assignment-related context menu options are 

available. The search area is associated with the assigned loading and can only be 

disassociated from it by visiting the discrete loading assignment dialog and choosing a 

different search area, or deassigning the discrete loading from the model. 

Editing of Discrete Loading Data 

User-defined discrete loading 

Each discrete loading attribute in the Attributes Treeview has a context menu item 

named Edit...  

 Selecting the Edit... menu entry or double clicking the attribute displays the 

original definition dialog with all the original input data intact. The user can 

change these inputs that may be either loading parameters such as width, length 

and intensity of patch at any time.  
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Pre-defined discrete loading 

Editing of pre-defined discrete loading data (such as that used for supplied vehicle 

loads) allows users to view both the original vehicle definition input data, as well as 

the actual loading applied (the vehicle load converted into a discrete load format), for 

any and all vehicles within LUSAS. Editing of user-defined discrete loading data only 

permits viewing and editing of the discrete loading data. 

So, for the case of creating a vehicle load from a pre-defined vehicle, the resulting 

attribute in the Attributes  Treeview has context menu entries named Edit 

Definition... and Edit Attribute... These menus can be seen by right clicking on the 

attribute.  

 Selecting the Edit Definition... menu entry or double clicking the attribute 

displays the original definition dialog with all the original input data intact. The 

user can change these inputs that may be either loading parameters such as 

width, length and intensity etc or even the type of vehicle, at any time. For 

each modification, the name of the attribute and the equivalent discrete load 

values are modified. Although the name of the attribute is altered, the attribute 

itself is merely modified and so the assignment links between the bridge 

structure and the load will not be lost.  

 Selecting the Edit Attribute...menu entry displays the equivalent discrete 

loads. These values may be changed but this breaks the link to the original 

definition dialog and a warning message will be displayed. 

Editing of automatically generated discrete loading data (such as that created by the 

use of the prestress loading facility) is not permitted.  

Editing patch load divisions  

 When the first discrete load type is added to the Attributes Treeview, a  

Patch divisions object is also created. Double-clicking on this object displays a 

dialog which allows the type and default number of patch divisions used on 

discrete patch loading to be edited. 
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Case Study. Hydrostatic Loading 

In this example, a discrete patch load will be used to apply a hydrostatic load to the side-wall of 
an underground box culvert. 

1. The box culvert wall is defined using a Surface in the global XZ plane with 

corners at coordinates (0,0,0), (5,0,0), (5,0,3) and (0,0,3). Define a Surface using the 

New Surface button at the specified corner positions. 

2. Rotate the view using the Dynamic Rotate button until the Surface can be 

visualised in 3D. 

3. Using Attributes> Mesh> Surface, define a mesh using Thick Shell, Quadrilateral, 

Linear elements. Specify the spacing as 15 divisions in the local x and 9 divisions in 

the local y directions. Since only one Surface is present in the model, the divisions for 

the mesh can be entered directly onto the Surface mesh dialog. 

4. With the cursor in normal mode, assign the mesh to the Surface by dragging the 

attribute from the Attributes  Treeview onto the selected Surface.  

5. To define a patch load that is coincident with the side-wall Surface, first select the four 

Points defining the Surface in the order they were defined. Choose the Attributes> 

Loading menu item and pick the Discrete Patch option. Note that LUSAS has selected 

a 4 node patch and filled the  Point coordinates into the dialog.  

6. The load direction coincides with the global Y axis direction so select Y from the 

Untransformed Load Direction. Specify patch corner load intensity values of -3, -3, -

1, -1 respectively. 

7. The patch definition uses a coordinate system that is coincident to the global Cartesian 

axis system, so the load can be assigned to the Point at the origin (Point 1). Assign the 

load to Point 1 (0,0,0) leaving all dialog entries as default and press OK to assign the 

load. Note that the patch is drawn as discrete point loads. This is because the patch load 

is automatically split into point loads. 

8. The number of discrete loads in each direction is dependent on the numbers of divisions 

entered in the Assign Loading dialog. In this case, the default number of divisions (10) 

is insufficient as there are insufficient loads to apply at least one load per element along 

the culvert. To improve the load application accuracy, deassign the load from the Point, 

and reassign using 15 divisions in the local X direction. Leave the Y divisions field 

blank. Note that LUSAS has automatically used the aspect ratio of the patch load to 
calculate a suitable number of divisions in local Y. 
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Hydrostatic Patch Load 

Default number of divisions showing insufficient 
discrete point loads. 

 

Hydrostatic Patch Load 

Increased number of divisions on assignment. 
The double arrow vector indicating patch 
orientation. 

 

Thermal Loading 

Thermal loading is feature based and hence it is assigned to the model geometry (or to 

mesh objects in a mesh-only model). Variations in loading on a feature can be 

specified using a Variation or a Load Curve. For information on which load types 

can be applied to which element types, see the Element Reference Manual. 

Thermal loading is accessed via the Attributes > Loading or Attributes > Loading 

> Thermal menu items depending upon the type of user interface in use. 

Thermal Load Types 

Thermal load types available are: 

 Prescribed 

 Environmental conditions 

 Rate of Heat Inflow (Concentrated) 

 Rate of Heat Inflow/Unit Length) 

 Rate of Heat Inflow/Unit Area (Flux) 

 Rate of Heat Inflow/Unit Volume 

 Rate of Heat Input/Unit Volume (user) 

Prescribed 

Defines a prescribed temperature for an element. 

 The Total prescribed load type defines the total temperature at a given node at 

a specified increment. 
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 The Incremental prescribed load type adds to any temperatures present from a 

previous increment. 

Environmental Conditions 

Models external fluid temperature and associated convection and radiation heat 

transfer coefficients. If an element face does not have an environmental temperature 

assigned it is assumed to be perfectly insulated. 

 Environmental temperature is the temperature of the surrounding air/fluid to 

which the object is losing heat to (or gaining heat from). 

 Convection heat transfer coefficient is in units of ‘power per unit area per 

unit temperature’ (e.g. J.s-
1
.m

-2
.K

-1
). 

 Radiation heat transfer coefficient is in units of ‘power per unit area per unit 

temperature to the power four’ (e.g. J.s-
1
.m

-2
.K

-4
) and is determined by 

multiplying the emissivity of the material by the Stefan-Boltzmann constant. If 

a non-zero radiation heat transfer coefficient is specified, the analysis becomes 

nonlinear and Nonlinear Control must be used. 

 Reference temperature (only available when Temperature dependent is 

chosen) refers to the model temperature, not the environmental temperature. It 

is only required if more than one row of data is being entered for temperature-

dependent properties. For example different convective and radiative 

coefficients could be specified at 0, 50 and 100°C. Linear interpolation will be 

used. If only one reference temperature is entered the other properties will be 

constant for all temperatures. 

Defining temperature dependent properties will turn a linear thermal field problem into 

a nonlinear thermal problem. 

Notes 

 If heat transfer coefficients vary on a specified face the values will be 

interpolated using the shape functions to the Gauss points. 

 Load curves can be used to maintain or increment the environmental 

temperature, or the Rate of Heat Inflow as a nonlinear analysis progresses 

 Automatic load incrementation within the Nonlinear Control can be used to 

increment environmental loading. 

 If external air/fluid temperature and associated convection and radiation heat 

transfer coefficients vary in time, pre-defined load curves for the Hygro-

thermal analysis entry can be specified on the Environmental conditions 

assignment dialog at the load assignment stage in order to vary the values 

accordingly. 
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Rate of Heat Inflow (Concentrated) 

 Rate of Heat Inflow (Concentrated) loading produces the LUSAS CL load type, 

which in a field analysis applies a rate of internal heat generation (Q). Positive Q 

defines heat input. 

 A total flux, a flux per unit length or a flux per unit area can be specified. 

 Flux is defined relative to the nodal coordinate system. If the required loading 

directions of a global load do not lie in the global axes then a local coordinate 

may be assigned to the feature to transform the loads to local coordinate 

directions. 

Rate of Heat Inflow/Unit Length 

 Requires single value of heat inflow per unit length to be defined. 

Rate of Heat Inflow/Unit Area (Flux) 

 Requires single value of heat inflow per unit area to be defined.  

Note that for both 2D and 3D continuum elements a positive flux is from the face 

towards the interior, that is, a positive thermal flux raises the temperature of the 

continuum. 

Rate of Heat Inflow/Unit Volume 

Defines the internal heat generation for an element. Positive loading values indicate 

heat generation and negative values indicate heat loss. 

 Rate of Heat Inflow a single value of heat inflow per unit volume.  

 Reference temperature (only available when Temperature dependent is 

chosen). Must be specified for each set of properties.  

Defining temperature dependent properties turns a linear thermal field problem into a 

nonlinear thermal problem. 

Rate of Heat Inflow/Unit Volume (user) 

Allows user-defined input of internal heat generation for an element for use with user-

written software programs. Values can be entered in multi-column format. Positive 

loading values indicate heat generation and negative values indicate heat loss. 

Notes 

 Load curves can be used to maintain or increment the Rate of Heat Inflow as a 

nonlinear analysis progresses 
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 Automatic load incrementation cannot be used with Rate of Heat Inflow 

loading. 

Case Study. Temperature Dependent Loading 

Temperature dependent environmental loading can be useful to model experimentally 

determined correlation for convective coefficients. For example, if the convective 

coefficient, h, may be given by h = C [t]^(1/3), where C is a constant and [t] is the 

temperature difference between the surface and the environment between the surface 

and the environment. To specify this loading in LUSAS you would define the 

convective coefficient at as many reference points as are required to give a good piece-

wise linear approximation of the function. The convective coefficients calculated are 

entered into the grid of the thermal loading attribute, along with the appropriate 

reference and environmental temperatures in each row. This single attribute is then 

assigned to the features as required 

1. Define a row of Surface features. 

2. Use an incremental prescribed loading to fix the temperatures at one end of the 

model. 

3. Define a convective coefficient function using environmental loading 

(temperature dependent). 

4. Assign the loading to the model and solve. 

5. Since the problem is one-dimensional the solution may be checked to ensure 

that the convection coefficient has been correctly interpolated. 

  

Hygro-Thermal Loading 

Hygro-thermal loading is feature based and hence it is assigned to the model geometry 

(or to mesh objects in a mesh-only model). Variations in loading on a feature can be 

specified using a Variation or a Load Curve. For information on which load types 

can be applied to which element types, see the Element Reference Manual. 

Hygro-thermal loading is accessed via the Attributes > Loading or Attributes 

> Loading > Hygro-thermal menu items depending upon the type of user interface in 

use. 

Hygro-Thermal Load Types 

Hygro-thermal load types available are: 

 Initial conditions 
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 Prescribed 

 Environmental conditions 

 Rate of Heat and Moisture Inflow (Concentrated) 

 Rate of Heat and Moisture Inflow/Unit Length) 

 Rate of Heat and Moisture Inflow/Unit Area (Flux) 

 Rate of Heat and Moisture Inflow/Unit Volume 

 

Initial Conditions 

In a hygro-thermal analysis initial conditions are assigned directly to the model (on a 

per element basis) as a ‘load’. This means that neighbouring elements can have 

discontinuous initial conditions. This allows for modelling the staged pouring of mass 

concrete in situations where the previous stage poured has a temperature close to the 

environmental temperature (or higher if there was not enough time for the heat of 

hydration to dissipate), and a newly poured stage has been mechanically cooled to a 

lower temperature. 

Specifying values for old, cured concrete 

 Temperature This can be defined in degree Kelvin (K) or degrees Celsius (C) 

as specified during model startup.  

 Concrete relative humidity For old, cured concrete the value for relative 

humidity should lie between 0 and 1. Note that it is not given as a percentage. 

A concrete relative humidity of, say, 0.7, defines a moisture content in the 

concrete for the given initial temperature when the concrete is in a state of 

equilibrium with the environment that has the same temperature and relative 

humidity. In other words, concrete has a given relative humidity if it has stayed 

for a sufficiently long time in the environment with the same relative humidity. 

The entered value for relative humidity is used to compute the initial value for 

the 2nd degree of freedom (capillary pressure Pc from Kelvin's equation: 

 

where: 

 

The explicit input of RH is required for old, already cured concrete. 

 Cured concrete Check this box to allow input of values for cured concrete. 
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Specifiying values for new concrete 

 Temperature is the only input required. Relative humidity cannot be defined 

for a liquid state of concrete 

New concrete starts in a liquid state. This condition is set automatically when Concrete 

Heat of Hydration is specified in the material properties. For new concrete, initial, 

final porosities and initial water saturation are computed automatically. The initial 

porosity is computed from the relative volume required to contain the liquid water of 

the concrete mix plus the volume ratio of the entrapped air. The required initial 

capillary pressure is computed by solving the Sorption curve equation: 

 

Prescribed  

Prescribed loading is not used often in hygro-thermal analysis because it is rarely the 

case that the temperature or the relative humidity at a point or surface or volume 

remain constant, with a known value for some period of time covered by the analysis. 

Prescribed loading is equivalent to environmental temperature loading with a very 

high convection coefficient. Even when concrete is in contact with a body with a fixed 

temperature it might be more accurate to model it as an environmental load which can 

account for the thermal and hygro barrier imposed by the rough contact between them.  

Hygro-thermal prescribed loading requires the following to be specified: 

 Temperature This can be defined in degree Kelvin (K) or degrees Celsius (C) 

as specified during model startup. 

 Concrete relative humidity This can be defined for concrete having: 

 Contact with water For this, a value of 1.0 is used for concrete relative 

humidity. Water saturation = 1, and from Kelvin's equation the capillary 

pressure = 0. 

 Contact with air A typical use would be when concrete is subjected to 

steam curing. If a value of 1.0 is specified for concrete relative humidity, 

water saturation = 1, and capillary pressure = 0. If a value of <1 is 

specified, from Kelvin's equation, a prescribed capillary pressure >0 is 

obtained. Such as prescribed loading would only be used for academic 

reasons. Better engineering results would be achieved if environmental 

temperature loading is used. 

The capillary pressure is the same for both cases because the preservation of mass (or 

mass transfer) equation considers the moisture in concrete which is the sum of liquid 
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water and water vapour. The result is that, in both cases, the water saturation in the 

concrete will increase.  

 For the 'Contact with water' situation there is no condensation and the increase 

of water saturation in the concrete does not bring about a release of latent heat.  

 For the 'Contact with air' situation the increase of the water saturation in the 

concrete is due to condensation. Condensation releases the latent heat of phase 

change and it raises the concrete temperature. 

Note that prescribed relative humidity is converted to capillary pressures at element 

nodes. When solved, all concrete results are computed at element Gauss Points. In 

Modeller, these values are extrapolated to the element nodes. Because of this 

extrapolation the nodal value reported by the Modeller can differ from the prescribed 

value. 

Note 

 When a Prescribed loading is assigned to a load curve, the load curve is 

applied to both specified components of the load (unlike the Environmental 

Conditions loading types where each component can be assigned its own load 

curve). If both components of the prescribed load are non-zero, each 

component should be applied in a separate load case. 

Environmental Conditions 

Environmental Conditions load types model external air/fluid temperature and 

associated convection and radiation heat transfer coefficients. If an element face does 

not have an environmental temperature assigned it is assumed to be perfectly 

insulated. 

 Environmental temperature is the temperature of the surrounding air/fluid to 

which the object is losing heat to, or gaining heat from. 

 Convection heat transfer coefficient (e.g. J.s-
1
.m

-2
.K

-1
). For early age 

concrete its value depends upon the curing conditions, environmental 

temperature and wind velocity. 

 Radiation heat transfer coefficient (e.g. J.s-
1
.m

-2
.K

-4
) It is determined by 

multiplying the emissivity of the material by the Stefan-Boltzmann constant. If 

a non-zero radiation heat transfer coefficient is specified, the analysis becomes 

nonlinear and Nonlinear Control must be used. 

 Relative humidity is the relative humidity of the environment. Enter a value 

between 0 and 1. Note that it is not given as a percentage. 

 Vapour mass coefficient can be calculated by means of the Chilton-Colburn 

analogy if there is no reliable experimental data. The calculation is invoked by 
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a negative value for the coefficient, after a load curve, if present, is applied. 

The Chilton-Colburn analogy applies for a solid, smooth surface: 

 

where 

 

and 0.913 is the ratio of the mass and thermal diffusivities for air–water vapour 

mixture at 298 K. 

For a porous surface heat is still convected through the whole surface while water 

vapour is convected via the pores exposed to the environment. 

 

 

Notes 

 If heat transfer coefficients vary on a specified face the values will be 

interpolated using the shape functions to the Gauss points. 

 Load curves can be used to maintain or increment the environmental 

temperature as a nonlinear analysis progresses.  

 If environmental air/fluid temperature and associated convection and radiation 

heat transfer coefficients vary in time, pre-defined load curves for the Hygro-

thermal analysis entry can be specified on the Environmental conditions 

assignment dialog at the load assignment stage in order to vary the values 

accordingly. 

 For concrete, as it dries out because of a decrease of water saturation due to 

self desiccation (that is the liquid water becomes chemically bonded in the 

hydrated product), the drying out is included in the Heat of Hydration ‘load’ 

that is defined via the material property dialog. Curing at higher relative 

humidity can be used to reduce and prevent cracking. However, it should be 

noted that if the environmental relative humidity is higher than the concrete 

relative humidity this does not guarantee transfer of moisture from the 

environment to the concrete. If the concrete temperature is higher than the 

environmental temperature, the water vapour content in the concrete pores 
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would be higher than the environmental water vapour content, for the same and 

even lower relative humidity of concrete. 

Rate of Heat and Moisture Inflow (Concentrated) 

 Rate of Heat Inflow a single value of heat inflow.  

 Rate of Moisture Inflow a single value of moisture inflow.  

Example use: 2D model with heating wire running along Z 

Rate of Heat and Moisture Inflow/Unit Length 

 Rate of Heat Inflow a single value of heat inflow per unit length.  

 Rate of Moisture Inflow a single value of moisture inflow per unit length.  

Rate of Heat and Moisture Inflow/Unit Area (Flux) 

 Rate of Heat Inflow a single value of heat inflow per unit area. 

 Rate of Moisture Inflow a single value of moisture inflow per unit area.  

Note that for both 2D and 3D continuum elements the positive flux is from the face 

towards the interior, that is, a positive thermal flux raises the temperature of the 

continuum. 

Rate of Heat and Moisture Inflow/Unit Volume 

 Rate of Heat Inflow a single value of heat inflow per unit volume.  

 Rate of Moisture Inflow a single value of moisture inflow per unit volume.  

 Reference temperature (only available when Temperature dependent is 

chosen). Must be specified for each set of properties.  

Defining temperature dependent properties turns a linear thermal field problem into a 

nonlinear thermal problem. 
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Example Applications of Rate of Heat and Moisture Inflow 

Prescribed loading type   Rate of heat inflow   Rate of moisture inflow 

Rate of heat and 
moisture inflow at a node 
(concentrated) 

   Heating wire running along Z axis in a 2D 
model 

  None 

Rate of heat and 
moisture inflow per unit 
length 

  Heating wire.   None 

Rate of heat and 
moisture inflow per unit 
area 

   Heating blanket, or cooling from surface 
water evaporation, or sun radiation flux. 

  None 

Rate of heat and 
moisture inflow per unit 
volume 

  LUSAS heat of hydration (applied via the 
hygro-thermal material dialog for several 
types of cements). 

  Concrete self 
desiccation(*). 

Rate of heat and 
moisture inflow per unit 
volume 

  Manually computed heat inflow rate from an 
experimental temperature evolution in an 
adiabatic test. 

  Interaction of hydrating 
cement with dry or wet 
aggregate. 

 Notes: 

 To model pipe cooling where the pipe water temperature is assumed to stay 

constant, use a Prescribed temperature on the lines representing the cooling 

pipes. 

 Load curves can be used to maintain or increment the Rate of Heat and 

Moisture Inflow as a nonlinear analysis progresses.  

 When a Rate of Heat and Moisture loading is assigned to a load curve, the 

load curve is applied to both specified components of the load (unlike the 

Environmental Conditions loadtypes where each component can be assigned its 

own load curve). If both components of the Rate of Heat and Moisture loading 

are non-zero, each component should be applied in a separate load case. 

 There is no time restriction on thermal rate of heat inflow. Temperature can 

increase /decrease indefinitely. For moisture rate of inflow there can be inflow 

only until full water saturation (1.0) is reached; similarly, rate of moisture 

outflow can be applied only up to saturations when the liquid network becomes 

disconnected (usually when water saturation <0.2). 

 Flux load (rate of heat inflow per unit area) can model only the radiation heat 

received from the sun. The radiation heat lost to the environment cannot be 

modelled accurately. 

 Rate of Heat and Moisture Inflow loading can be applied at a point 

(concentrated load), line, surface or volume. A positive value represents heat 

generation or moisture inflow; a negative value represents a heat sink or 

moisture outflow. 
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 Automatic load incrementation cannot be used with Rate of Heat Inflow 

loading. 

Discrete Thermal / Hygro-Thermal Loads 

Discrete thermal / hygro-thermal loads are used to distribute a given loading pattern 

over full or partial areas of the model, independent of the model geometry. Discrete 

loads are defined in relation to their own local coordinate system, the origin of which 

is given by the coordinates of the Point feature to which the load is assigned. Note that 

discrete loads are always assigned to Points. Discrete loads differ from feature - based 

loads in that they are not limited to application over whole features. Discrete loads 

may be projected over an area, onto Lines or into Volumes. Separate discrete loads 

may be applied to a model as a set or load train using the Compound load option. 

Search areas can be used to control load assignment. 

Discrete point or patch loads are defined in relation to their own local coordinate 

system and are always assigned to points. Discrete loads differ from feature based 

loads in that they are not limited to application over whole features and may be 

effective over full or partial areas of the model. Search areas may be used to restrict 

the area of application of a discrete load. 

Discrete loads are useful for applying 

a load that does not correspond to the 

features underlying the mesh. A 

patch load may be spread or skewed 

across several features. When 

applied, LUSAS automatically 

calculates the nodal distribution of 

forces that is equivalent to the total 

patch load. This example shows a 

typical set of point loads assigned to 

a grillage model. A single point, a group of 6 and a group of 16 point loads are shown. 

The coordinates of the vertices defining the patch are relative to the Point to which the 

patch load is assigned, i.e. a load definition is defined in a local coordinate system, the 

origin of which is given by the coordinates of the Point to which the load is assigned. 

The Point does not have to lie on the Surface to which the load will be applied as the 

patch load is projected in a specified direction.  

Using Search Areas with Discrete Loads 

A discrete load is distributed onto the elements over which the load lies. A Search 

Area is a way of controlling the load distribution onto these elements. If no search 

area is specified when assigning the load, then all of the underlying elements will be 

eligible for load distribution. 
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Notes 

 While projecting the loads into the search area a check is made for multiple 

intersections of the load and the search area. Multiple intersections indicate an 

ambiguity in the location of the load. This ambiguity may be resolved with a 

more specific search area.  

 The distribution of load to the nodes follows the shape functions of the 

particular element. In quadratic elements, this distribution can appear at first 

unlikely. For example, a unit positive load at the centre of an 8-noded quadratic 

element, results in negative 0.25 loads at the corners and positive 0.5 loads at 

the mid-side nodes. 

Discrete Thermal / Hygro-Thermal Load Types 

A discrete thermal / hygro-thermal load consists of coordinates defining the local x, y 

and z position and a load intensity. Any Points selected prior to the discrete loading 

dialog being displayed are entered as coordinates into the grid and are ordered to an 

expected point order where possible. Discrete load types available are: 

 Rate of Heat (and Moisture) Inflow (Point) 

 Flux (Patch) 

Rate of Heat (and Moisture) Inflow (Point) Load  

Rate of Heat (and Moisture) Inflow (Point) loads provide concentrated loading at 

specified locations. These Point loads can be defined singly or as a set of discrete point 

loads in 3D space. Each individual load can have a separate load value. Point loads can 

be defined via Arbitrary input or by specifying a Grid input. Each discrete point 

requires a flux load to be specified (in Watts if SI units are being used). 

This example uses 16 distinct load values. The loads are applied to the model as 

distinct loads. 

 

Flux (Patch) Load  

Flux (Patch) loads provide a loading per unit length or per unit area. Each point of a 

discrete patch flux loading needs to be specified (in Watts/m
2
 if SI units are being 

used). Flux Patch loading types are: 
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 8 node patch - used to define a curved sided quadrilateral 

 4 node patch- used to define a straight sided quadrilateral 

 Multi node patch - used to define a straight sided patch of any number of 

points  

 Straight line - requires 2 specified coordinates to define a straight line load 

 Curve - requires 3 specified coordinates to define a curved line load 

 Multi-straight line - used to defined a series of straight line loads, requiring 2 

specified coordinates to defined each line. 

Note that for both 2D and 3D continuum elements a positive flux is from the face 

towards the interior, that is, a positive thermal flux raises the temperature of the 

continuum. 

The following examples show patch loads assigned to Point 1. Once assigned, the load 

origin is located at Point 1. The discrete load point order (P1, P2 etc) shows the order 

in which the coordinate definitions should be made. 

Example 1.  

A straight line load defined using 2 
coordinates. 

 
  

Example 2.  

A curved line load is defined using 3 
coordinates. 
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Example 3.  

A straight sided quadrilateral defined using 4 
coordinates.  

  Example 4.  

A curved sided quadrilateral defined using 8 
coordinates.  

  

 

  

 

Example 5.  

Multi node patch loading.  

  Example 6.  

Multi straight line loading.  

 

  

 

Notes 

 The mid-side nodes for a curved line load and for a curved sided quadrilateral 

load must lie with +/- 10% of the overall distance between the corner nodes. 

 Multi node patch loading is always straight sided. A minimum of 4 coordinate 

points and an even number of coordinate points overall must be defined. 

 For both 2D and 3D continuum elements the positive flux is from the face 

towards the interior, that is, a positive thermal flux raises the temperature of the 

continuum. 
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Defining Discrete Thermal / Hygro-Thermal Point and 

Patch Loads 

 Arbitrary permits the definition of any number of Point loads. If the points are 

defined in an expected grid order (see Grid entry), then the loading components 

can be optionally projected along the columns and rows of the patch load grid 

into a search area (if used), otherwise the loading is applied to the nearest load 

location in the search area. 

 Grid adds the correct number of rows to the point load definition grid for the 

number of x and y values defined and expects the coordinate points to be 

defined in a particular order so that any loads that may overhang a search area 

(if used), can be optionally projected to be included into the search area. For a 

grid of points of x=3, y=2 the expected order of coordinate input is x1,y1, x2, 

y1, x3, y1, x1, y2, x2, y2, x3, y2. 

Coordinates and magnitude 

 For a Rate of Heat Inflow (Point) load each attribute defines multiple loads, 

one concentrated load at each given vertex. 

 For Flux (Patch) loads the vertices combine to specify the shape of a line or 

patch load. The load is specified at each vertex allowing the load intensity to be 

varied. Patch types include 8 node, 4 node, multi node, straight line and curve. 

Projection Vector 

 Projection Vector is used to work out 

which features are actually loaded. The 

vector is followed (in both directions) and 

any features intersected by the assigned 

discrete load vertices projected in the 

direction of the projection vector are 

loaded accordingly. For patch loads 

defined by 4 or 8 vertices the projection 

vector is always perpendicular to the 

patch. 

 

This example shows a typical 3D patch 

load where the patch is defined in space 

and projected onto the model. 
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 Patch load divisions specify the 

numbers of divisions in the local x 

and y directions of the patch being 

assigned. The divisions are used to 

split the applied patch into 

individual component loads before 

they are in turn used to calculate 

equivalent nodal loads on the 

model. By default, the patch load 

division are based upon the values 

set in the  Patch divisions 

object which is created when a 

discrete loading is added to the Attributes Treeview. Again by default,10 patch 

load divisions are used in the local x direction and the aspect ratio of the patch 

is used to calculate the divisions in the y direction. When creating a patch 

ideally at least one division should be used per element division. The more 

individual loads a patch is split into, the more accurate the solution obtained. 

Patch load divisions can also be explicity defined on the main patch loading 

dialog as a number in x and a number in y. In this case if X=0 and Y=10 is 

entered the number in the x direction will be calculated proportionally to the 

patch shape. Equivalent weighting values are used to calculate the portion of 

each discrete load that is applied to each corner of the element that it lies 

within. The load is then applied as Concentrated Loads. These weighting values 

are based on element shape functions and may vary with element type. 

Assigning Discrete Thermal / Hygro-Thermal Loads 

Discrete loads are independent of features therefore their application is quite flexible. 

The load assignment parameters are explained below: 

 Patch Transformation Changes 

the patch orientation. For example, 

a flux patch load may be skewed 

by applying a rotation 

transformation when assigning the 

load.  

 

In the example shown right the 

Flux Patch load defined about 

local xy axes is assigned to Point 1 

subject to a patch direction 

transformation using a 30 degree 

xy rotation about the global origin. 

Note that the local origin of the 

patch load is rotated and repositioned as well as the patch itself.  
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To rotate a patch about its centre, define the patch with its local origin at its 

centre 

 Search area A search area restricts loading to a specified portion of the 

model. If a search area is not specified, the load is projected onto the whole 

model. For 2D models it is usually acceptable to default to the whole model, 

but for 3D models where multiple intersections of the load projection onto the 

model may occur it is safer to restrict the loading to the required face using a 

search area. In either case the time taken to assemble the loads is significantly 

improved by using a search area to restrict the number of elements tested for 

intersection with the load.  

In addition, a discrete patch load can be specified to: 

 Project over surface of volume This option is used to project discrete loads 

over the surface of a volume. 

 Project into volume (solid models) This option is used to project discrete 

loads into volumes (solid models). 

Loads that extend beyond a search area can be included or excluded using: 

 Options for loads outside search area Loads that fall outside the search area 

can be moved into the search area or be excluded entirely using a variety of 

options. See  Processing Loads Outside Search Area. 

The analysis in which the loading applies must be stated and general loadcase 

information that can be entered includes: 

 Loadcase specifies in which loadcase the loading is to be applied. Loadcases 

can themselves be manipulated. See Loadcase Management for more details. 

 Load factor specifies a factor by which the loading is multiplied before the 

equivalent nodal loads are calculated. 

Editing of Discrete Thermal / Hygro-Thermal Loading 

Data 

Each discrete loading attribute in the Attributes Treeview has a context menu item 

named 'Edit'. 

 Selecting the Edit... menu entry or double clicking the attribute displays the 

original definition dialog with all the original input data intact. The user can 

change these inputs that may be either loading parameters such as width, length 

and intensity of patch at any time.  
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Editing patch load divisions  

 When the first discrete load type is added to the Attributes Treeview, a  

Patch divisions object is also created. Double-clicking on this object displays a 

dialog which allows the type and default number of patch divisions used on 

discrete patch loading to be edited. 

Search Areas 

Search areas may be used to restrict the area of application of discrete loads (point 

and patch) on both 2D and 3D models. This is useful for several reasons: 

 Improved Control of Load Application. For 2D models the search area will 

effectively limit the area over which the load is applied so that the effect of 

loads on certain features may be removed from the analysis. For 3D models it is 

possible that a chosen projected direction will cross a model in several 

locations. A search area is therefore used to limit the application of load to one 

of these multiple intersections. Restricting the area of application of discrete 

loads allows the same load attributes to be used to apply loads to different parts 

of the model. 

 Speed Improvement the speed of calculation of equivalent nodal loads will be 

increased by cutting down the number of features considered in the calculation. 

Search areas are automatically created and used by the prestress loading facility to 

define the target to be loaded. 

  

In the 2D example shown, a multiple span 

grillage structure is defined with Span 1 as 

the search area. A discrete Patch load, 

indicated by the grey shaded region in the 

upper diagram, is applied across the whole 

structure, Span 1 and 2. The area of the 

structure coinciding with both the Search 

Area and the patch load will take the load 

as shown in the lower diagram. 

  

Tip. Search areas should normally always 

be used if the model is three-dimensional 

as, for example, for box-section or cellular 

construction decks, and discrete loads are 

applied. 
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Defining and Assigning Search Areas 

Search areas are defined from the Attributes menu then assigned to the required 

Lines or Surfaces. Control of loads lying outside the search area is available when the 

load is assigned, see Assigning Discrete Loads. If a search area is not specified when 

the load is assigned, all of the highest order features, excluding volumes, in the model 

will be used as a default search area. Valid search area configurations are shown 

below. 

Note: The default maximum number of elements that can be used with search areas 

per grillage bay (each four-sided framing of a section of slab) is 30. In the unlikely 

event that a higher number is required this can be changed by setting a user-defined 

option in Modeller. Contact LUSAS technical support if you wish to do this. 

Rules for Creating Search Areas for Grillages 

Grillage members, represented by a line meshed with a single line mesh division, and 

forming a 4-sided 'cell' are automatically included in a search area. Overhanging 

grillage members, such as those seen on 3-sided or 2-sided 'bays' within a grillage 

model, and multi-edged cells and multiple overhanging line members affect how a 

search area is calculated, and in different ways. The differences can be explained as 

follows: 

3-sided bays 

Overhanging grillage members, such as those seen on 3-

sided 'bays' of a grillage, where the outer side of a 'cell' is 

missing, and where the opposite side of the cell is 

represented by a line meshed with a single line mesh 

division, are included in the search area. In these cases, to 

save you from having to connect many point pairs together 

with dummy lines to form a closed 'cell', LUSAS 

automatically 'closes' the cell for the purposes of calculating 

the search areas, but does not create any additional features 

or assignments to the model in order to do so.  

In cases where the outer side of a 'cell' is missing, and the 

opposite side of the cell is represented by more than one 

line a dummy Line needs to be added manually between the 

2 overhanging points to close the bay to make the search 

area valid. When closing the bay in this way note that a 

single "Null" line mesh should be used having one mesh 

division (1 DIV).  
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2-sided bays 

Overhanging grillage members, such as those seen on 2-

sided 'bays' of a grillage, are not included in the search 

area by default. For these, LUSAS does not automatically 

'close' the cell for the purposes of calculating the search 

areas. Instead, a dummy Line needs to be added manually 

between the 2 overhanging points to close the bay to 

make the search area valid. When closing the bay in this 

way note that a single "Null" line mesh should be used 

having one mesh division (1 DIV).  
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Multi-edged cells 

Grillage 'cells' of more than four edges (line members) are 

automatically subdivided into triangles, but overhanging 

elements are only included if divided by no more than one 

edge.  

For the invalid region shown, a dummy Line can be added 

manually between the 2 overhanging points to close the 

bay to make the search area valid. When closing the bay 

in this way, note that a single "Null" line mesh should be 

used having one mesh division (1 DIV). If done, the 

resulting cell of five edges will be subdivided into 4 

triangles. 

 

Multiple overhanging line members 

There is no limit to the number of edges (or line 

members) that may hang over the main body if the 

overhanging members are only separated by one 

edge (see right). 

In this case, LUSAS automatically 'closes' the cell 

for the purposes of calculating the search areas, 

(and does not create any additional assignments to 

the model in order to do so) and either sub-divides 

the resulting cells into triangles or uses a 

quadrilateral as appropriate. 

 

Processing Loads Outside a Search Area 

For point and patch loads any load outside a search area can either be excluded from 

the search area, or be projected to be included into the search area.  
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Discrete loads on lines 

When discrete loads of patch or point loading are assigned onto Lines with an assigned 

Search Area the individual load components are projected onto the line, normal to the 

local x axis of the Line, and their effective loading is calculated and applied to the line 

as forces and moments along the line.   

Options available when assigning onto Lines are:  

 Exclude All Load beyond the end of the Line (default)patch load 

components beyond the end of line will be disregarded and all load components 

within the search area will be applied to the line with an appropriate force and 

moment to represent the positions of the loads. 

 Include Full Load all load components within the search area will be applied 

to theline with an appropriate force and moment to represent the positions of 

the loads. Patch load components beyond the end of line will be applied to the 

point at the end of the line with an appropriate force and moment to represent 

the actual position of the loads. 

Note that when a search area is assigned to a line the search area extends for the length 

of the line and for an infinite distance perpendicular to the line direction. See the 

diagram that follows or details. 

  

 

Patch Load onto Line 

Patch loads not lying on a line but within an 
assigned search area will be applied to the line as 
effective forces and moments. Loads outside the 
search area can be either included or excluded. If 
included, the applied moments will be computed 
by using the actual location of the defined loads 

 

Discrete loads over areas 

When discrete patch loads are assigned over an area the projection path(s) is/are 

defined by the local x and y axes of the loading patch. Each patch load component is 

'moved' along a specified local x or y direction and added to the first loading positions 
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found inside the patch in that projected direction. See the diagram that follows which 

illustrate the various options. 

Options available when assigning onto areas are:  

 Exclude All Load (default) 

 Include Local X Projected Load 

 Include Local Y Projected Load 

 Include Local X and Y Projected Loads 

 Include Non-Projected Load 

 Include Full Local X Load 

 Include Full Local Y Load 

 Include Full Load 

Notes 

 Loads will not be moved to the edge of the search area if the entire patch load 

lies outside the search area.  

 Loads inside the search area are not moved. 

 Discrete patch loads assigned over areas are not work equivalent as the discrete 

points are simply lumped at the nearest node. 

 Patch loads outside the search area are lumped onto the nearest edge of the 

search area. 
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Patch Load Divisions 

The number of patch load divisions in local x (div 
x) and y (div y) are specified at load assignment. 
The load intensity is then split into individual load 
components with an associated area of 
application. 

   Patch Load Local Coordinates 

The local coordinate set is dependent on the 
order in which the coordinates of the patch 
vertices are defined. 

 

  

 

Local X Projected Load 

Loads in the local y projected region (dark area) 
are lumped at nearest loading positions within the 
search area (light area). 

  Local Y Projected Load 

Loads in the local y projected region (dark 
area) are lumped at nearest loading positions 
within the search area (light area). 
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Local X and Y Projected Loads 

Loads in the local x and y projected regions (dark 
area) are lumped at nearest loading positions 
within the search area (light area). 

  Non-Projected Load 

Loads not in the local x and y projected 
regions (dark area) are lumped at nearest 
loading positions within the search area (light 
area). 

 

  

 

Full Local X Load 

Loads in the full local x region of the patch (dark 
area) are lumped at nearest loading positions 
within the search area (light area). 

  Full Local Y Load 

Loads in the full local y region of the patch 
(dark area) are lumped at nearest loading 
positions within the search area (light area). 
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Full Load 

All patch loads lying outside the search area (dark 
area) are lumped at nearest loading positions 
within the search area (light area). 

    

 

    

Discrete point loads over areas (grillages, slabs and 3D space 

frames) 

When discrete point loads are defined by specifying a Grid of points they can either be 

excluded from the search area, or be projected to be included into the search area in 

exactly the same way as for discrete patch loads. The expected coordinate input for a 

grid of points defined in this way for a grid of x=3, y=2 is x1,y1, x2, y1, x3, y1, x1, 

y2, x2, y2, x3, y2. If discrete point loads are defined by the Arbitrary option, and if the 

points are defined the expected grid format, then the loading is applied as per the patch 

loading (that is, the loading components can be projected along the columns and rows 

of the patch load grid into the search area), otherwise the loading is applied to the 

nearest load location in the search area. No moment loads are created with this 

method. 

Discrete point loads over areas (shell models) 

When discrete point loads are projected over areas comprising shell elements, the 

offset distance from the load definition position to the load position in the search area 

is used to calculate a moment. A moment is also calculated when using the Bridge 

software product's moving load option to move loads into the search area. 

Discrete point loads into volumes 

When discrete point loads are projected into volumes (by being assigned to a particular 

point on, or within the volume) the applied discrete loads are extrapolated within the 

elements to create equivalent concentrated nodal loads. When search areas are 

assigned to volumes the following options are available: 



Modeller Reference Manual   

    

452 

 Exclude All Load (default) Patch load components outside the volume will be 

disregarded and all load components within the search area will be extrapolated 

within the elements to create equivalent concentrated nodal loads 

 Include Full Load Patch load components outside the search area will be 

applied to the nearest elements in the volume.  

Local Coordinates 

Local Coordinates define coordinate systems that differ from the default global 

Cartesian system. They have several uses: 

 Geometry Definition Geometry features may be defined in a local coordinate 

system by setting a pre-defined local coordinate active. When a local 

coordinate is active, all dialog entries relating to global X, Y and Z coordinate 

input use the transformed axis set as a basis for input. 

 

 Transforming Nodal Freedoms When assigned to features the effect is to 

transform the degrees of freedom of the underlying element nodes. This has the 

effect of transforming the directions of applied global load and support 

conditions. In the example below, global freedoms are transformed to radial 

directions by assigning a cylindrical coordinate to the Lines around the hole. 

This method of transforming nodal freedoms is only valid for small deflections, 

since the freedom directions are not updated during analysis. Note that this 

affects Concentrated and Global distributed loads (both tabulating CL loads), 

does not affect 'Body Force' and 'Stress and Strain' loads, and is not applicable 

for Face loads. 
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 Materials A local coordinate may be used to align orthotropic and anisotropic 

materials. 

 Variations Variations may be defined using functions in terms of a local 

coordinate. 

 Composites A local coordinate may be used to align composite attributes when 

they are assigned to the model. 

 Element orientation A local coordinate may be used at the mesh assignment 

stage to orient beam and joint elements. 

 Results Transformation Results can be output relative to a local coordinate. 

For example, this is useful when looking at results on elements when the axes 

are not consistent. 

Defining Local Coordinates 

Local coordinates are defined from the Attributes> Local Coordinate menu item by 

specifying the local coordinate type and, for Cartesian, cylindrical and spherical types 

an origin and either a rotation about a global plane or a rotation matrix.  

 Rotation about a global plane specifying angular rotations about the global 

planes, XY, YZ or XZ. When defining coordinate systems using this method, 

the local x axis is oriented parallel to the global X axis and rotated into position 

using the specified angle in the specified plane. 

 Rotation matrix specifying a direction cosine matrix. A Rotation matrix may 

be defined from selected Points by first selecting 3 Points (1st Point defines the 

origin, 2nd Point defines the positive direction of the local x axis, 3rd Point 

defines the local xy plane) and clicking the Use button. 

Notes 

 Defining a new coordinate set does not automatically make it the active set, see 

Visualising Local Coordinates below. 

 Local coordinate set types cannot be modified so, for example, a Cartesian set 

cannot be changed to a cylindrical or spherical set. 

 Local cylindrical coordinates defined by matrix are always defined with the 

local z axis along the cylinder. 

 Local coordinates can be assigned to features, changing the orientation of the 

element where possible; the x-direction of a line element cannot be modified; 

the z-direction of a surface element cannot be modified. 

 When local coordinates have been assigned to features and nodal directions are 

modified, the support freedoms and "global" loading directions are modified. 
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 There can be only one local coordinate system at any given node, which may 

be assumed from an assignment to any relevant feature, with assignment to a 

Lower Order Feature being preferred over any assignment to a Higher Order 

Feature. For example, at the connection between two lines there is a point and 

a node. The local coordinate system at that node might be from an assignment 

to either line, or both, unless they conflict. If there is a conflict, this is an error 

and an assignment to the point (the Lower Order Feature) must be used to 

determine the local coordinate system for the node in question. 

Local Coordinate Types 

Cartesian, cylindrical and spherical local coordinates are defined by indicating three 

positions in space defining a local xy plane (origin, x axis, xy plane). The type of 

coordinate chosen will dictate how the axes are defined. A surface local coordinate 

system is also available. 

Symbol Local coordinate type 

 

 Cartesian   - Based on standard x, y and z coordinates arbitrarily 

oriented in space. 

 

 Cylindrical  - Based on the axes of a cylinder defined by a radius, 

angle and distance along the cylinder axis.  

  
 For a local cylindrical 

coordinate defined along 

the z axis a point is 

specified as (r, theta, z), 

where: 

r is the radius 

perpendicular to the local z 

axis 

theta (t) is the angle in degrees measured from the positive 

x direction of the local xy plane, clockwise about the local 

z axis when looking in the positive z direction 

z is the distance along the z axis. 

 

 Spherical  Based on the axes of a sphere defined by a radius, 

tangential angle and angle around a meridian.  

Coordinates of a point are specified as (r, t, phi), where: 

r is the radius of the sphere on which the point lies from 
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the local origin 

theta (t) is the angle in degrees 

measured from the positive x 

direction of the local xz plane, 

clockwise about the local z axis 

when looking in the positive z 

direction  

phi is the angle in degrees measured from the positive z 

axis to the radius line 

Warning. There is no equivalent spherical coordinate set in Solver, 

therefore freedoms cannot be transformed using this type of local 

coordinate system. 

 
 Surface local coordinate systems define a local axes which has the 

x and y axes in the plane of the surface and a local z axis normal to 

the surface. This is useful for extruding a volume normal to a 

surface and assigning supports normal to a surface. Surface local 

coordinates cannot be set active. 

Visualising Local Coordinates 

The active local coordinate system is defined from the Model Properties Geometry tab 

or from the local coordinate attribute context menu using the Set Active menu item. A 

black dot is shown next to a local coordinate attribute to indicate it is active. 

By default the active coordinate is visualised on the graphics area, this can be switched 

off from the View properties. Click on the View Axes tab to change the view axes 

settings. 

Local coordinates assigned to features may be visualised in the same way that other 

attributes are visualised. 

Composites 

Composite attributes allow previously defined materials to be collected together to 

define a laminate or composite lay-up. Layup definition methods allow for properties 

to be defined manually for use on solid and shell models and optionally include 

additional specific values for draping over model surfaces. Layup data can also be 

imported from a FiberSIM XML file, also for draping over selected model surfaces. 

Composite Layup Methods  

The following methods are available as a result of selecting the Attributes > 

Composite menu item: 

 Solids and Shells 



Modeller Reference Manual   

    

456 

 Draped Solids and Shells 

 FiberSIM Solids and Shells 

 Simulayt Solids and Shells 

 

Solids and Shells 

This method allows a manual definition of the composite lay-up where orientations 

and thicknesses for the plies can be specified by stacking layers of differing materials 

at various angles and thickness. The orientation angles can be applied with respect to 

the local element x-axis (in the x-y plane) or with respect to the x-axis of a predefined 

Cartesian set. The z-axis defines the direction of the lay-up with ply 1 located at the 

bottom of the stack. The lamina thickness specified depends upon the element types 

used. 

Notes 

 Only orthotropic plane stress (for semi-loof shell) or orthotropic solid (for thick 

shell) materials can be used for structural shell composite lay-ups. Structural 

solid composites models must use the orthotropic solid material model and 

thermal solid composites models must use the orthotropic solid field material 

model. Isotropic materials may be used within any composite lay-up. 

 For shell elements an appropriate plane stress nonlinear material model may be 

used whilst for solid elements a 3D nonlinear continuum model may be used 

(see the Element Reference Manual). 

 The lay-up sequence is from bottom to top. In the case of a shell this will be in 

the direction of the Surface normal. In the case of a solid this will be in the 

direction of the local z. 

 In cases where surface normals need correcting good use can be made of the 

cycling facility, where feature local axes can be cycled relative to a reference 

feature to ensure a consistent set of composite material axes. 

 Composite attributes may not include materials that contain variations. 

Draped Solids and Shells 

This method makes use of the native draping functionality in LUSAS. A start point 

(which should lie inside or on the boundary of the surface to be draped) can be defined 

for each ply and the start direction is defined by the x-axis of a predefined Cartesian 

set. Prior to assigning a composite attribute of this type to a model a draping surface 

must be selected or specified. 

The orientations of fibres following the drape are computed by LUSAS and are 

tabulated with respect to the x-axis of the local element axes. As with the Solids and 

file:///C:/SVN/Content/0howto/how_to_define_a_draping_surface.htm
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Shells option, it is essential that the z-axis of the volumes to which the composite is to 

be assigned are consistently oriented. See Draping below. 

FiberSIM Solids and Shells and Simulayt Solids and Shells 

Composite stack details can be read in from an external FiberSIM XMLfile or 

Simulayt LAYUP file. A default fibre volume fraction can be specified and by default 

it is assumed that all plies are of the same thickness but this can be modified. It is not 

necessary to select a draping surface or to define a start point when using this option.  

Notes 

 The coordinates of the ply data in the FiberSIM or Simulayt file must coincide 

with the coordinates of the drape surface. 

 Any XML file should only contain lay-up data relating to a single drape 

surface. For example, if a non-composite core is sandwiched between two 

composite skins then at least two XML files will be required. The volumes 

defining each skin must be selected in turn and the appropriate XML file 

assigned to it. 

 A draping grid can be extended by one grid row to ensure the edges of the 

component are fully enclosed. See Extending the draping grid. 

Draping in General 

Composite attributes may be orientated 

on a solid or shell model by specifying a 

start point and a local coordinate 

defining the drape direction of each 

lamina   

Draping assumes the thickness remains 

constant and hence the volume fraction 

(the proportion of the volume in a lamina 

that is fibre with the remaining portion 

being the resin) is adjusted when the 

fabric is distorted. After assignment of a 

composite attribute that contains draping data to a model, the skew angle and fibre 

volume fraction may be contoured and the fibre orientations may be visualised. 

  

Notes 

 The native draping functionality in LUSAS is controlled by Draping 

options.accessed via the File > Model Properties menu item (Solution tab). 

FibreSIM and Simulayt draping options can be specified at the xml file import 

stage (accessed via the Attributes > Composite menu item). 

file:///C:/SVN/Content/1using/Model_Properties.htm
file:///C:/SVN/Content/1using/Model_Properties.htm
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 The Volume xy axes control the local element axes which must lie in the plane 

of the composite lamina. The local element axes may be visualised from the 

Mesh properties dialog. 

 The local coordinate defining the drape direction must lie in the xy plane of the 

drape Surface at the start point. 

Defining Composite Layups 

Composite attributes require composite materials to be defined prior to defining 

composite layups. Composite attributes consist of a number of named layers where 

each layer contains specified material properties, and for certain element types, the 

angle of fibres and layer thickness. Composite layers can be defined using a Normal or 

a Grid method. Once composite attributes have been defined, they are assigned to the 

model on a feature basis. 

For Solids and Shells and Draped Solids and Shells composites definition the 

procedure described below can be used to define a layup. For FiberSim Draped Solids 

and Shells definition the composite stack will already have been created using a 

default material and volume fraction for all laminae. If required, for this case, the 

Normal and Grid Tabs can be used to modify details for selected laminae. 

Procedure 

The procedure to define a composite layup using the Normal Tab is described, ending 

with details of how the Grid Tab can also be used to check or add layer data. 

1. Define the Layup 

Click on the New button to define a new layer. Enter a unique lamina name, select a 

composite material,and enter thickness and layup angle values. Note that a lay-up 

sequence is defined from bottom to top. The name may given a suitable prefix in the 

box provided. Click the OK button. 

2. Enter details for the next lamina. 

3. Repeat this process for each layer as required.  

If a symmetric layup sequence is to be defined check the Symmetric button. This 

duplicates and reverses the layup sequence previously entered. The Reverse button is 

used to upturn the defined stack so the uppermost layer becomes the bottom layer. The 

Insert button can be used to add layers between existing layers. 

4. Check the Layup sequence 

There are two ways to check the composite layup sequence: 

i) Select the Visualise button to display a representation of the defined 

composite layup. If desired this image can be annotated to the screen by 

clicking on the Create Annotation button from the visualise dialog. 



  Chapter 5 : Model Attributes 

    

459 

ii) Select the Grid tab to display the layer properties in grid format. Data may 

also be created or edited using this option. Pressing the Tab key with the cursor 

sitting in the last row and cell of the grid creates a new row populated with the 

same data as the previous row. A right mouse click in a row opens a context 

menu that allows rows to be inserted or deleted. 

Defining Lamina Thicknesses   

The definition of lamina thickness depends upon the element types and model type 

used. 

 The lamina thicknesses for shell models that have been assigned a geometric 

thickness are relative, not absolute, and represent the proportion of the total 

thickness (as specified by geometric surface properties) apportioned to each 

lamina. 

 When assigning a draped layup to a shell model the assignment of geometric 

thickness properties to the shell is not always of use. In these cases, if a 

geometric property is not assigned to the model then the thickness of the 

assigned laminates is used to calculate the corresponding element (and hence 

geometric) thickness at any point. So, in this case the lamina thicknesses would 

be absolute values. 

 The lamina thicknesses for solid models comprised of pentahedral and 

hexahedral composite elements are relative, not absolute, and represent the 

proportion of the total space that the elements of the volume represent 

apportioned to each lamina. For these models the number of laminate layers 

must correspond to, or exceed, the number of elements through the Volume. 

Element nodal positions will be moved to correspond with laminate boundary 

positions if the node/laminate layer positions do not coincide. 

 The lamina thicknesses for solid models comprised of tetrahedral composite 

elements are absolute values and represent the actual thickness of each lamina. 

For these models the total of all lamina thicknesses as measured from a tooling 

surface must exceed the space occupied by the tetrahedral elements. 

 For a 'mesh-only' model (a model that has been created by importing a LUSAS 

datafile) the actual thickness of each lamina would be entered, so in this case 

the lamina thickness is absolute. 

Visualisation of Composite Layup 

The orientations and thicknesses for each lamina can be viewed by clicking on the 

Visualise button of the Composites dialog for a particular chosen entry method. This 

will display a layered representation of the composite stack with annotations. This 

representation may be used to create a bitmap annotation by clicking on the Create 

Annotation button. 
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Assigning Composite Properties  

The method of assigning composite properties to a model differs according to the type 

of composite definition method used: 

For the Solids and Shells definition method: 

 The composite attribute created by this method is assigned to selected surfaces 

or volumes of a model by specifying the overall composite orientation. Options 

for orientation are: Local Coordinate, Local Element Axes, Axes From 

Surface. An angle of zero degrees aligns the laminate axis with the x axis from 

the orientation axes. 

For the Draped Solids and Shells definition method: 

 For solid and shell models the composite attribute needs to be assigned to a 

draping surface. This is done by selecting and placing the Surfaces defining the 

drape surface into selection memory and assigning the composite attribute to 

the model. 

For the FiberSIM Solids and Shells and Simulayt Solids and Shells definition 

methods: 

 No assignment to a draping surface is required because the layup data is 

already included and correctly positioned in the FibreSim or Simulayt XML 

files. However, the composite attribute must be assigned to the model to enable 

visualisation of other composite model data. 

Visualisation of Composites Properties 

To visualise assigned composites properties the surface or volume must be meshed. 

The following composite properties can be visualised: 

 Fibre (ply) directions 
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 Draping grid 

 Lamina thickness, Skew angle, Offset layer, Fibre volume fraction 

Visualisation of Fibre (Ply) Directions 

Once assigned to features which have a mesh assigned, the fibre directions of assigned 

composite data can be examined graphically as follows: 

1. Right-click on the Attributes entry in the  Treeview and select Properties.  

2. On the Composite tab, click on Settings and select Visualise ply directions. 

The x and y axes define the warp and weft directions respectively; the item 

x&y displays both directions at the same time.  

Lamina directions can be plotted as an x, y, z or x&y axes at any layer. For solids the 

axes may be placed at the top/bottom or middle of the chosen layer, for shells the axes 

are placed on the mid surface of the shell element. For details of how to choose a 

composite layer see Setting The Active Composite Layer. 

 Visualisation of Draping Grid  

The draping grid for individual lamina can be examined graphically as follows: 

1. Right-click on the Attributes entry in the  Treeview and select Properties.  

2. On the Composite tab, click on Settings and select Visualise ply directions. 

Then select Draping grid.  

If no mesh has been assigned to a model prior to selecting this option only the draping 

grid (and not the ply directions) will be visualised.  

For details of how to choose a composite layer see Setting The Active Composite 

Layer. 

Extending the draping grid 

LUSAS Draped Solids and Shells grids are automatically trimmed at Surface 

boundaries. FiberSIM and Simulayt generated grids are not. If required, the draping 

grid can be extended by one grid row to ensure the edges of the component are fully 

enclosed by the draping grid. For FiberSIM and Simulayt grids this is specified at the 

file import stage (accessed via the Attributes > Composite menu item). For LUSAS 

Draped Solids and Shells grids, this is done via the Draping options on the Model 

Properties dialog. 

file:///C:/SVN/Content/7results/idh_composite_layers.htm
file:///C:/SVN/Content/7results/idh_composite_layers.htm
file:///C:/SVN/Content/7results/idh_composite_layers.htm
file:///C:/SVN/Content/1using/Model_Properties.htm
file:///C:/SVN/Content/1using/Model_Properties.htm
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Example of draping grid being extended by one row Example of draping grid being trimmed to a surface 

boundary 

Visualisation of Other Composite Model Data 

To view other composite model data such as lamina thickness, skew angles, offset 

layers and fibre volume fractions: 

1. With a Contours layer in the  Treeview right-click on Contours.  

2. On the Contour  Results tab select the Composites (model) entity and select 

the composite attribute name in the right-hand panel. The fibre volume fraction 

and skew angle (and any other composite modelling options relevant for the 

model) will appear for selection in the Component combo box. 

Setting the Active Composite Layer  

Composite shell and solid elements 

have multiple layers (laminae) of 

different materials though their 

thickness. The lamina or lamina name 

on which results or orientation axes 

are to be viewed is chosen by setting 

that lamina active. A lamina is set 

active by selecting the lamina with 

the right-hand mouse button from the 

 Treeview and picking Set 

Lamina Active or Set Name Active 

from the context menu. A black dot next to a lamina indicates the active lamina.. 

If a lamina is set active only results or orientation axes for that lamina in that 

composite attribute will be displayed. If the lamina name is set active, results or 

orientation axes will be displayed for all laminae with that name across all composite 

attributes. 
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When viewing results the material transformation should be used to display stresses on 

or off axis. 

Slidelines 

Slidelines are attributes which can be used to model contact and impact problems, or 

to tie dissimilar meshes together. They can be used as an alternative to joint elements 

or constraint equations, and have advantages when there is no prior knowledge of the 

contact point. Slideline applications range from projectile impact, vehicle crash 

worthiness, the containment of failed components such as turbine blades, to 

interference fits, rock joints and bolt/plate connections. Slidelines can be defined to 

apply to all analyses that are present in the Analysis treeview, or be applied on a 

loadcase by loadcase basis for individual analyses. 

Slideline properties are defined from the Attributes> Slideline menu item. 

The properties of a slideline are used to model the contact interaction between master 

and slave features, such as the contact stiffness, friction coefficient, temperature 

dependency etc. The figure below shows a contact application in which a frictional 

slideline is defined between two bodies and where tied slidelines are used to join 

dissimilar meshes. The latter avoids the need for stepped mesh refinements between 

different mesh densities. 

 

Slidelines are assigned to pairs or groups of features in a model, with one pair/group 

termed master and the second pair/group termed slave. An element face that lies on a 

slideline is called a slideline segment. 

When one slideline surface is much stiffer than the other it can be defined as a rigid 

slideline surface. This approximation can improve the convergence rate and hence 

reduce the solution time. If the rigid surface is not part of the model, rigid elements 

should be assigned to the features. 

Note. To use any type of slideline a nonlinear licence is required. However, tied-

slidelines may be used in a linear loadcase. 
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Table of Elements for use with Slidelines 

The following table gives a list of elements valid for use with slidelines: 

Element type    LUSAS elements 

Thick shells   TTS3, QTS4 

Plane stress 
continuum 

  TPM3, TPM3E, TPK6, TPM6, QPM4, QPM4E, QPM4M, QPK8, QPM8 

Plane strain 
continuum 

  TNK6, TPN3, TPN3E, TPN6, QNK8, QPN4, QPN4E, QPN4L, QPN4M, 
QPN8 

Axisymmetric solid 
continuum 

  TAX3, TAX3E, TAX6, TXK6, QAX4, QAX4E, QAX4L, QAX4M, QAX8, 
QXK8, 

Solid continuum    TH4, TH4E, TH10, TH10K, PN6, PN6E, PN6L, PN12, PN12L, PN15, 
PN15K, PN15L, HX8, HX8E, HX8L, HX8M, HX16, HX16L, HX20, 
HX20K, HX20L 

Continuum two-phase   TH10P, TPN6P, PN12P, PN15P, HX16P, HX20P, QPN8P 

2D rigid surface   R2D2 

3D rigid surface   R3D3, R3D4 

 

Slideline Types 

There are several different types of slideline: 

 Null The slideline attribute is ignored. Useful for performing a preliminary 

check on the model.  

 No Friction  Used to model contact without friction.  

 Friction Used to model contact with friction. 

 Tied Used to tie different meshes together. 

 Sliding Used for problems where surfaces are kept in contact but which are free 

to slide relative to each other. The sliding behaviour is frictionless. 

 

The friction/no-friction slideline types model the finite relative deformation of 

contacting bodies in two or three dimensions where the contact is stationary or sliding, 

constant or intermittent. The sliding only option is similar but does not permit 

intermittent contact, i.e. the surfaces are kept in contact, allowing frictionless sliding 

contact without lift-off to be modelled. The tied slideline option allows meshes of 

differing degrees of refinement to be connected without the need of a transition zone 

between the meshes. 
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Slideline Properties 

 Master/slave stiffness scale Controls the amount of inter penetration between 

the two surfaces. Increasing the scale factor will decrease the amount of 

penetration but may cause  ill-conditioning. Recommended values are: 

 Implicit/static solution 1.0 

 Explicit solution 0.1 

 Tied slidelines 100 to 1000 

Slideline stiffnesses are automatically scaled at the beginning of an analysis if 

the average master/slave stiffnesses differ by a factor greater than 100. This is 

to account for contact between bodies that have significantly different material 

properties. This facility can be suppressed via File > Model properties > 

Attributes and selecting ‘Suppress initial slide-surface stiffness check’. 

 Coulomb friction coefficient  Defines the coefficient of friction between 

contacting bodies for Coulomb’s law. Only applicable for friction slidelines.. 

 Zonal contact detection parameter This defines the region around a node 

within which a search for contact is conducted. The size of the region is a factor 

of the size of the overall model – the model is projected onto the global x, y and 

z axes and the largest projection is used as a reference. For further information 

refer to the Theory Manual.  

 The default value of the zonal contact detection parameter is 0.01, i.e. 

1% of the model size. A smaller value may result in undetected inter-

penetration. The value should be set to 1.0 if the contact search should 

consider the entire model (though only points on the adjacent slideline 

surface will be considered valid contacts). 

 Slideline extension A boundary of a slideline segment can be expanded by 

specifying a slideline extension. Points outside the segment but within the 

extended boundary are considered valid for contact. This is particularly useful 

near the edges of a slideline surface, where a node could be on a segment in one 

nonlinear iteration and off the segment in the next iteration – a form of chatter 

that can cause nonlinear convergence difficulties.  

 The extension parameter is an absolute number. 

 Close contact This defines a region above a slideline surface within which a 

soft spring is applied, but with no force. The stiffness of this spring is applied 

to all nodes that are above a surface but within the close-contact region. This 

softens the transition between in-contact and out-of-contact states. 

 The close contact facility helps stabilise solutions suffering from chatter 

in which nodes oscillate between in-contact and out-of-contact states. 

glossary.chm::/Glossaryillconditioning.htm
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Chatter can cause a nonlinear analysis to experience convergence 

difficulties. 

 The size of the close contact region is a factor of the segment size. The 

stiffness of the close contact spring is 10-3 that of the slideline stiffness. 

It’s stiffness is controlled by the Solver system parameter SLSTCC. 

 For analyses that continue to suffer from chatter, the size of the close 

contact region should be increased and the value for SLSTCC reduced 

accordingly. SLSTCC can be changed via File > Model properties > 

Solver system variables. 

 The close contact facility is not available for explicit dynamics. 

Temperature Dependency 

Choosing the Temperature dependent check box allows different sets of slideline 

properties to be specified at different temperatures, thus providing temperature 

dependence. With temperature dependency, the stiffness scale factors and the 

coefficient of friction are linearly interpolated across the reference temperatures. All 

other properties remain unchanged. 

Pre-contact 

Pre-contact is used to overcome problems encountered when applying an initial load 

(other than Prescribed Displacement) to a discrete body that, without the slideline, 

would undergo unrestrained rigid body motion. This is particularly the case when an 

initial gap exists between the contacting surfaces and a load is applied to bring them 

into contact. Pre-contact is only applicable to static analyses. 

 

Pre-contact brings two bodies into initial contact by using interface forces that act 

between the slideline surfaces in order to avoid unrestrained rigid body motion. These 

forces act in a direction normal to each surface. One of the surfaces must be free to 

move as a rigid body and the direction of movement is dictated by the interface forces, 

applied loading and support conditions. The facility allows a gap to exist between the 

surfaces. In the example above pre-contact is defined for slideline 1 but not for 

slideline 2. 

glossary.chm::/Glossaryprescribed_variable.htm
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Warning. Incorrect use of this procedure could lead to initial straining in the bodies or 

to an undesirable starting configuration. By selecting specific slidelines for the pre-

contact process (i.e. slidelines where initial contact is expected) minimum initial 

straining will occur and more control over the direction of rigid body movement can 

be exercised. 

Contact Cushioning 

Contact cushioning can be used when convergence difficulties related to in-

contact/out-of-contact chatter are experienced. The formulation applies a contact force 

and stiffness above a surface that increases exponentially as a node moves closer to the 

surface. This cushions the impact of a node with the surface and softens the transition 

between in-contact and out-of-contact states. Contact cushioning can therefore help 

improve nonlinear convergence when chatter is encountered and the set of active 

contact nodes is continually changing. See Theory Manual for details. 

Initial slideline type 

The slideline type at the start of the analysis (as described earlier) 

Change slideline type during a single analysis 

Select this option if the slideline type is to change with respect to a loadcase during a 

particular analysis. If the option is not specified, the slideline defined will apply to all 

analyses. Note that for the vast majority of analyses it will not be necessary to select 

this option. 

The slideline type can be changed from one type to another at any loadcase stage 

within a particular analysis. For example, the slideline can be set to be a Friction 

slideline in loadcase 1, and will apply by default to loadcases 2 and 3, and then be 

stated to be a No Friction slideline in loadcase 4. 

If a loadcase is specified at which a slideline type is to change, the slideline only 

affects the one analysis that contains that loadcase. If the slideline type is also required 

in another analysis, a duplicate slideline attribute will need to be specified for that 

analysis and assigned to the same model geometry. 

Type after change 

The slideline type after change (e.g. Friction). 

Changes at loadcase 

The loadcase at which the slideline type should change from the initial setting to the 

changed setting. (e.g. Tied to Friction). 

Rigid type 

To model contact with rigid bodies, rigid slideline surfaces are available. Rigid 

surfaces can be assigned to valid structural elements as well as to special rigid surface 

elements R2D2, R3D3 and R3D4. The latter are recommended for modelling rigid 
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bodies, since they remove the need for defining structural elements and hence speed 

up the solution. All nodes on a rigid surface need to be completely restrained. Since 

rigid surfaces cannot contact each other only one slideline surface can be defined as 

rigid – master or slave. 

Number of passes 

Slidelines involve a two pass procedure in general, in which contact on both slideline 

surfaces is processed. With rigid surfaces, however, a one pass procedure is available 

that only checks the penetration of the deformable surface into the rigid surface. If the 

one pass procedure is selected, it is recommended that the deformable body should 

have the finer mesh.  

Geometric definition 

Slideline surfaces can be modelled using linear/bi-linear segments, or as curved 

contact surfaces using quadratic patches.  

 With quadratic patches the curved contact geometry is constructed from a 

patch of slideline segments. The contact forces are then distributed to the 

closest segment. 

 The quadratic patches and the curved geometry are set-up automatically within 

LUSAS Solver and no additional specification is required. The standard patch 

configuration consists of two linear segments in 2D and four bi-linear segments 

(quadrilateral or triangular) in 3D. Where a patch definition is not possible the 

standard linear/bi-linear definition is used instead.  

 The quadratic patch contact formulation has a non-symmetric tangent stiffness 

matrix. The non-symmetric solver is therefore set automatically. 

Assigning Slidelines 

Slideline surface pairs are created by assigning a slideline attribute to selected Lines or 

Surfaces (or to edges and faces in a mesh-only model).  

To assign a slideline: 

1. Select features that will form the master surface 

2. Assign the slideline attribute to these features 

3. In the Assign Slideline dialog that appears, specify Master and the set of 

features to which it applies. The orientation is computed automatically but 

needs to be specified for shells (Top or Bottom) 

4. Select features that will form the slave surface 

5. Assign the slideline attribute to these features 

6. In the Assign Slideline dialog that appears, specify Slave and the set of features 

to which it applies. The orientation is computed automatically but needs to be 

specified for shells (Top or Bottom) 
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Slideline Modelling Considerations 

 Except for tied slidelines, the slideline contact facility is inherently nonlinear 

and must be used in a nonlinear analysis 

 Only the expected region of contact should be defined as a slideline surface for 

tied slideline analyses. 

 Coarse mesh discretisation in the region of contact should be avoided. 

 Slidelines must be continuous and should not subtend an angle greater than 90 

degrees. Sharp corners are best described by two separate slidelines. 

 Large mesh bias should be avoided when using quadratic patches, to ensure a 

reasonable curved geometry is generated 

 The stiffness scale factors should be increased for rigid wall contact 

 The nodal constraint slideline (explicit tied slideline) treatment is more robust if 

the mesh with the greatest contact node density is designated the slave surface 

 The use of tied slidelines to eliminate transition meshes is recommended for 

areas removed from the point of interest in the structure 

 The use of a larger value for Young's modulus to simulate a rigid surface in a 

dynamic contact analysis is not advisable since this will increase the wave 

speed in that part of the model and give rise to a reduced time step. This 

practice significantly increases the computing time required. 

 Slidelines may be utilised with higher order elements (quadratic variation of 

displacements) but it is necessary to constrain the displacements of the slideline 

nodes so that they behave in a linear manner (LUSAS Modeller will do this 

automatically). The deformation of the slideline surface will therefore be 

compatible with the slideline algorithm. This may, however, lead to a stiffer 

solution 

 When defining slidelines for use in implicit dynamics or static analyses, low 

order continuum elements are recommended 

 Explicit dynamics elements only may be utilised to define a slideline surface in 

an explicit dynamics analysis 

 Do not converge on the residual norm with PDSP loading in a nonlinear 

analysis. This norm uses external forces to normalise which do not exist with 

PDSP loading. 

 Slidelines may be used with automatic solution procedures (e.g. arc-length 

methods). The line search and the step reduction algorithms are also applicable. 

Slideline Options 

Options relating to slidelines are set from the Attributes tab of the Model Properties 

dialog. 
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Slideline Example: Metal Forming Analysis 

 

Initial configuration. Deformed configuration. 

  

 

 

  

  

Constraint Equations 

A constraint can be defined to constrain the movement of a geometric or nodal 

freedom. Constraint equations allow linear relationships between nodal freedoms to be 

set up. Constraint equations can be used to allow plane surfaces to remain plane while 

they may translate and/or rotate in space. Similarly, straight lines can be constrained to 

remain straight, and different parts of a model can be connected so as to behave as if 

connected by rigid links. These geometric constraints are only valid for small 

displacements. Constraint equations can also be used to model cyclic symmetry, for 

example a single blade from a complete rotor may be modelled and then constrained to 

behave as if it were part of the complete model. As constraint equations refer to 

transformed nodal freedoms, any local coordinate assigned to the features are taken 

into account during tabulation when the constraint equations are assembled. 

Several different types of Constraint Equations can be defined from the Attributes> 

Constraint Equation menu item. Constraints are grouped under the following types: 

glossary.chm::/Glossarytabulation.htm


  Chapter 5 : Model Attributes 

    

471 

Displacement Control 

 Specified Variable a nodal freedom takes a 

specified value across all the nodes in the 

assigned features, In this example, a 

specified variable constraint of 

Displacement in the X direction with value 

1.0 is assigned to Point 1. The underlying 

node is then allowed to displace only by the 

specified distance in the specified X 

direction. 

 Constant Variable used where a nodal 

freedom value is constant but unknown 

across all the nodes in the assigned features. 

In this example, a constant variable 

constraint of displacement in the X 

direction is assigned to Line 1. The 

underlying nodes move a constant amount 

in that direction. 

 Vector Path The nodes in the assigned 

features may be constrained to move along 

a specified vector defined by 2 Points or by 

2 sets of X, Y and Z coordinates. 

 

In this example, vertical and horizontal 

vectors are used to restrict movement in 

those directions. Note that the vectors are 

used purely to define a direction. Nodes can 

travel along a vector in either direction. 
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Geometric 

 Rigid Displacements Rigid displacements 

will make the features to which they are 

assigned behave rigidly.The nodes in the 

assigned features may be constrained to be 

rigid, the group of nodes may translate 

and/or rotate but their positions relative to 

one another remain constant. Only 

translational displacements can be 

constrained using this type of constraint. 

This type of constraint is only valid for small displacements. Assigning a 

constraint of this type to Lines on either side of a gap, as in the example shown, 

maintains the underlying undeformed node positions relative to each other as if 

a rigid block were in place between the structures.  

  

 Rigid Links Rigid links will make the 

features to which they are assigned behave 

rigidly. Each rigid link attribute can be used 

at one location, to create a rigid fixity 

between features that it is assigned to. It is 

similar to the Rigid Displacements 

constraint type, except that rotational 

freedoms are also constrained to be rigid. In 

the example shown here, the end of a beam 

is rigidly linked to the shell edges around a 

cylinder. The plane containing beam and 

cylinder end will remain plane throughout the analysis. 

 Planar Surface A surface may be 

constrained to remain plane, the surface 

may translate and/or rotate but remains 

plane. Nodal positions may vary relative to 

other nodes on the surface. This type of 

constraint is only valid for small 

displacements. In this example, a planar 

Surface constraint is assigned to the top 

Surface to force the underlying nodes to 

remain planar during loading. Constrained 

nodes may move relative to each other as 

long as they remain in plane. 
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 Straight Line A straight line may be 

constrained to remain straight, the line may 

translate and/or rotate but will remain 

straight. Nodal positions may vary relative 

to other nodes along the line. This 

constraint type is only valid for small 

displacements. In the example shown, a 

straight Line constraint is assigned to Line 3 

to force underlying nodes to remain in a 

straight line relative to each other during 

loading. Constrained nodes may move relative to each other as long as they 

remain in a straight line. 

Cyclic 

 Cyclic Rotation Cyclic rotational 

symmetry may be used to model a section 

from a continuous ring. The mesh on the 

two planes of symmetry may be different. 

In the example shown, the radial Lines are 

defined as a Master and Slave pair 

maintaining cyclic symmetry around the 

structure. Meshes on the Master and Slave Lines need not match. 

 Cyclic Translation 
Cyclic translational 

symmetry may be 

used to model a 

section from a 

continuous strip. 

The mesh on the two 

planes of symmetry 

may be different. In the example shown here, Master and Slave Surfaces define 

start and finish positions of repeating sections. Meshes on Master and Slave 

need not match. 
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Tied Mesh 

 Normal Constraint Meshes are tied along 

Master and Slave Lines to restrict relative 

movement. The underlying nodes maintain 

their original relative positions under 

loading. Meshes on Master/Slave need not 

match. This form of tied mesh constraint 

uses a search direction normal to the 

Master/Slave surfaces to detect the mesh to which it is tied. The use of rigid 

constraints ensures that the two sets of assigned features will both rotate with 

respect to their initial defined positions. 

 Specified Constraint Tied meshes may be 

used to force two sets of assigned features 

to move together in a similar manner to tied 

slidelines. The meshes are tied along Master 

and Slave Lines to restrict relative 

movement. The mesh on the two sets of 

features need not match. A search direction 

vector is defined to limit the mesh to which 

it is tied. The vector defines the direction in which the constraint is applied. The 

use of rigid constraints ensures that the two sets of assigned features will both 

rotate with respect to their initial defined positions. 

Constraint equation dependency across analyses / loadcases 

Constraint equations defined for the first loadcase within a base analysis can be 

optionally inherited by all other analyses. Assigning a different constraint equation to 

selected features in a following analysis supercedes any inherited constraint equations 

but for only those assigned features. 
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Case Study. Using Constraint Equations 

Differing meshes may be constrained to displace together in a similar way to a tied 

slideline. 

1. Define two Surfaces separated by a small gap using Geometry> Surface> 

Coordinates. 

2. Mesh the Surfaces with Linear Plane Strain elements using different mesh 

spacing on each Surface using the Attributes> Mesh> Surface menu item. 

3. Define and assign a valid Material to the Surfaces and define and assign 

Supports and Load attributes so that the Surfaces are being forced towards 

each other. 

4. Define a normal tied mesh Constraint using the Attributes> Constraint 

Equation> Tied Mesh menu item. Assign it to the Lines on either side of 

the gap. One Line must be selected as a master and the opposing Surface as 

a slave. If meshes on tied Lines have different spacing, choose the Line 

containing the finer mesh as the master. 

5. Run Solver  and view the deformed mesh. The constraint equations 

will have prevented one surface from passing through the other. 

  

Retained Freedoms 

Retained freedoms are used to manually define the master freedoms for use in the 

following analyses: 

 Guyan reduction eigenvalue analysis 

 Superelement analysis 

Retained freedoms are defined from the Attributes menu. They contain the definition 

of the master (retained) and slave (condensed) degrees of freedom and are assigned to 

the features designated as the master nodes. 
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Full Subspace Iteration    20 Masters 

 

  

 

15 Masters   10 Masters 

 

  

 

5 Masters     

 

    

Damping 

Damping is used to define the frequency dependent Rayleigh  damping  parameters 

for elements which contribute to the damping of the structure.  

Viscous (modal) and structural (hysteretic) damping can be specified. If no damping 

attributes are specified the properties are taken from the material properties (click on 

dynamic properties on the elastic page of the material attribute dialog. See 

Isotropic/Orthotropic for more information). If any damping attributes are specified, 

all damping must be defined and assigned using damping attributes; damping 

properties in material attributes will be ignored. 

Damping is usually specified when distributed viscous and/or structural damping 

factors are required for modal damping control. A modal damping analysis is 

performed as part of an eigenvalue analysis.  
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Damping attributes affect the responses calculated from model shapes using the graph 

wizard or IMD loadcases. Note that damping attributes are not used in the calculation 

of responses by Solver in transient (step-by-step) dynamic analyses, in which case 

material damping must be used.   

Defining Damping 

Structural or viscous damping is defined from the Attributes> Damping menu item 

and assigned to features in the usual way. Mass and stiffness Rayleigh damping 

parameters are linked with the corresponding reference circular frequency value at 

which they apply in a damping attribute. If more than one set of damping values is 

defined linear interpolation is used to calculate damping values at intervening 

frequencies. 

Activation and Deactivation of Elements 

The activation and deactivation of elements enables the modelling of a staged 

construction or demolition process, generally as part of a nonlinear analysis. For this, 

selected elements are activated and/or deactivated as the features to which they are 

assigned are activated and/or deactivated. Activate and deactivate attributes are 

defined from the Attributes> Activate and Deactivate menu item and are assigned to 

features (or elements in a mesh only model) and manipulated in the same way as other 

attributes. Deactivation of elements is also permitted in the first loadcase of a linear 

analysis without the need for a nonlinear licence or nonlinear control. 

Activate 

To model the creation or addition of a previously de-activated part of a model, an 

activate attribute is assigned to those features that are to be added. 

  In a structural analysis, an unmodified stiffness matrix is computed for the 

underlying elements and these activated elements are introduced in a 

stress/strain free state (uninfluenced by previous stages), except for any initial 

stresses or strains that have been defined. Strains are incremented from the 

point of activation and the deformed mesh is used to define the activated 

element’s initial position.  

 In a thermal/field analysis activation works in the same manner as for a 

structural analysis, except that the quantities affected are the conductivity 

matrix (or other analogous quantity), the fluxes and the gradients. 

Deactivate 

To model the absence or removal of a part of a model, a deactivate attribute is 

assigned to those features that are to be removed. In a structural analysis, the 

underlying elements (that are still retained in the model) have their stiffness matrix 

reduced in magnitude, while for field analysis the conductivity matrix (or other 

analogous quantity) is reduced. This ensures the deactivated elements have a 
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negligible effect on the behaviour of the remaining model. The element stresses and 

strains, fluxes and gradients and other analogous quantities are all set to zero. 

Stiffness reduction factor 

This provides control over the amount that the stiffness matrix is reduced in magnitude 

when elements are deactivated. 

Percentage to Redistribute 

In a deconstruction situation a deactivate attribute controls the way in which internal 

forces in an loaded structure are processed by specifying how much of the internal 

forces should be redistributed to the remaining elements. 

 Zero Redistribution 0% of the internal forces in a deactivated element are 

redistributed in the remaining elements (if this is prescribed in a static analysis, 

and the load remains constant, the stress, displacements etc. in the other 

elements will remain unchanged). 

 Full Redistribution 100% of the internal forces in a deactivated element are 

redistributed in the remaining elements (this has the same effect as re-assigning 

very weak material properties to the element). 

 Fractional Redistribution A percentage of the internal force to be 

redistributed is specified. Provides a solution which is part way between the 

two extremes. 

Any remaining internal equilibrating force associated with a deactivated element is 

maintained in the system until the element is subsequently activated. When an element 

is activated it is assumed that the element has just been introduced to the model 

(although all elements must be defined at the outset). The current (deformed) geometry 

for that element is taken as the initial geometry and the element is assumed to be in a 

stress/strain free state (unless initial stresses or strains are defined). All internal forces 

that exist in the element are redistributed and the computed strains are incremented 

from the time at which the element becomes active. 

Note that a member introduced into a structure may be a closing part e.g. a cast in-situ 

stitch; cables cut-to-length; parts with slotted holes to fit between two or more 

connections, or a prefabricated part such as a steel box girder or beam, or a precast 

segment. 

 ‘Closing parts’ have no shape or stiffness before they are introduced into the 

structure. In real life these parts fill the gap between and connect together two 

or more parts of a pre-existing structure. When they are added to a structure, 

end compatibility does not apply. Model features representing these members 

should be assigned a deactivate attribute with 'Percentage to redistribute' set to 

100% and 'Stiffness reduction factor' set to 1E-15. 

 Prefabricated parts have shape and stiffness before they are introduced into a 

structure. In real life these parts are created in isolation from the structure to 
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which they will be added. When they are added to a structure, end 

compatibility applies. Model features representing these members should be 

assigned a deactivate attribute with 'Percentage to redistribute' set to 100% and 

'Stiffness reduction factor' set to 1E-6. 

In fully prefabricated structures, such as the erection of steel girders (not considering 

any subsequently cast concrete slab), at the end of the construction process they are as 

if they are “wished in place”, although some members may have been through more 

onerous states of stress before reaching that final condition. To analyse this situation 

such members should not be supported until they have been introduce otherwise 

correct moments and deformations may not be obtained. 

In most situations the specification of a 'Percentage to redistribute' value of 100% and 

a different 'Stiffness reduction factor' according to whether the member is a 'closing 

part' or a 'prefabricated part' should suffice. But in situations where additional control 

is required, and for lines only, inactive line control options may be of use. 

Maintain relative position of inactive nodes 

Specifying Maintain relative position of internal nodes ensures that all internal 

nodes within an inactive feature are constrained such that, for example, a straight line 

will remain straight and move as a rigid body. This option is currently only for use 

with meshed line features. 

 Inactive line control This controls how the deactivated elements will be 

rotated or aligned with respect to existing or previously activated adjoining 

lines in a model. There are four options: 

 Fixed restrains the position of the inactive end(s) of an inactive member 

 Horizontal ensures the inactive member remains horizontal 

 None allows rotation between the active and inactive members. This 

would be used for a key section as, for example, when a section is 

positioned between two existing sections. 

 Tangent forces the rotation of the inactive members to match that of the 

active feature at their connection 

 Notes  

 The Horizontal, Tangential and Fixed options are only available for line 

features. 

 Use of the tangent option may additionally require the use of a jacking load or 

a prescribed displacement if it is required to return the end of a beam to its 

original undeformed position. For more information see Prescribed 

Structural Loads. 
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 If a deactivation attribute is inadvertently assigned to a surface any inactive 

line control setting will be ignored. 

Inactive line control examples 

  

Fixed line control Horizontal line control 

    

  

 

Tangential line control 

Using Activate and Deactivate Attributes 

All features (and hence elements) to be used in the model need to be defined at the 

start of the analysis. Activate and Deactivate attributes are assigned on a feature basis 

and control the history of the underlying elements throughout the analysis. An analysis 

and a loadcase are specified during assignment to indicate at what point the elements 

are added or removed. 

Dependency across analyses / loadcases 

Activate and deactivate attributes and loadcases are not inherited between analyses, 

but they can be copied and pasted between analyses in the Analyses  Treeview. 
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Notes 

 Deactivation and activation can take place over several increments if 

convergence difficulties are encountered.  

 Elements cannot be activated and deactivated in the following circumstances: 

 Explicit dynamics analyses. 

 Fourier analyses. 

 When they are adjacent to slidelines. 

 Deactivated elements remain in the solution but with a scaled down stiffness so 

that they have little effect on the residual structure. The stiffness is scaled 

down by a parameter which can be user-defined. In an implicit dynamic 

analysis the mass and damping matrices are also scaled down by the same 

factor. 

 When an element is deactivated, by default, all loads associated with that 

element are removed from the system and will not be re-applied if an element 

is subsequently re-activated. This includes concentrated nodal loads unless the 

load is applied at a boundary with an active element. The only exception to this 

rule is a prescribed displacement which may be applied to a node on 

deactivated elements. Accelerations and velocities may also be prescribed in a 

dynamic analysis but this is not recommended. By setting LUSAS Solver 

option 385, the default behaviour can be overridden and loads applied to 

deactivated elements can be preserved to enable re-application if and when the 

elements are re-activated. 

 If required, initial stresses/strains and residual stresses may be defined for an 

element at the re-activation stage. 

 The activation of an element which is currently active results in an 

initialisation of stresses/strains to zero, an update of the initial geometry to the 

current geometry and the element is considered to have just become active. The 

internal equilibrating forces which currently exist in the element will 

immediately be redistributed throughout the mesh. This provides a simplified 

approach in some cases.  

 With a forward construction method, supports should only be added when the 

activated members of a structure "land" on them, not before. Assigning all 

supports at the start of the analysis will result in incorrect deformations being 

achieved . When introduced into the model, the supports need to be in the right 

location. If this is the "as drawn" location, a 'Prescribed displacement' of zero 

should be used otherwise the supports will be introduced at the deformed node 

location. There may be occasions where the latter is required - it just depends 

upon the situation being modelled.  
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 The direction of local element axes can change during an analysis when 

elements are deactivated and reactivated. In particular, 3-noded beam elements 

that use the central node to define the local axes should be avoided as this can 

lead to confusion. For such elements the sign convention for bending moments 

for a particular element may change after re-activation (e.g. it is recommended 

that BSL4 should be preferred to BSL3 so that the 4th node is used to define 

the local axes and not the initial element curvature). 

 Care should be taken when deactivating elements in a geometrically nonlinear 

analysis, especially if large displacements are present. It may be necessary to 

apply prescribed displacements to deactivated elements in order to attain a 

required configuration for reactivation. 

 It should be noted that the internal forces in the elements will not balance the 

applied loading until all residual forces in activated/deactivated elements have 

been redistributed. 

 For solving analyses involving constraint equations, such as those used by this 

facility, it is recommended that the Fast Parallel Iterative Solver solver is used. 

General example 

Excavation Stage 1 

Top layer of soil deactivated and lining activated. 
Lining and soil elements duplicated in the model. 

Tunnel Excavation Stage 2 

Second layer deactivated as soil 
excavated. Surrounding lining elements 
activated 
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Tunnel Excavation Stage 3 

Remaining second layer soil elements deactivated. 

Tunnel Excavation Stage 4 

Supporting soil pillar removed and top 
lining activated. 

 

 

Tunnel Excavation Stage 5 

Final central soil column removed. 

  

 

  

  

Phi-c Reduction 

Phi-c reduction attributes are defined using the Attributes > Phi-c Reduction menu 

item. 

Phi-c reduction analysis is used to assess soil stability and safety factors for soil that is 

represented by Mohr-Coulomb or Hoek-Brown material models. 

The following parameters need to be specified: 

 Starting value for safety factor, Default = 1.1 

 Minimum change in safety factor, Default = 0.1 

 Maximum number of steps to use, Default = 25 
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Usage 

Create an analysis model which models some soil that is represented by 2D or 3D 

isoparametric continuum and two-phase elements, along with nonlinear soil materials 

with appropriate material properties. Other types of element and material may be 

present in the analysis but only Mohr-Coulomb or Hoek Brown materials may have 

strength reduced. 

Once defined, a ‘Phi-c reduction’ attribute can be assigned to all or just some of the 

relevant features in a model, for a specified analysis or analysis branch, allowing the 

safety of a particular slope (for example) in a large analysis to be evaluated without 

other parts of the model being affected. Assignment is made to a particular loadcase or 

analysis stage, which defines the applicable loading, boundary conditions and 

activation status.  

By its very nature a phi-c reduction analysis will always run until solution failure, so it 

is best used in branched analyses where it can be used to study safety factors at 

several stages of construction without terminating the solution. Note that only one Phi-

c reduction attribute can be assigned in each analysis. 

Note that the use of phi-c reduction with linear elements can potentially lead to an 

overestimation of the safety factor. 

Worked Example 

 See LUSAS Online help > Worked Examples > For LUSAS Bridge and 

LUSAS Civil & Structural >  ‘Slope stability modelling using Phi-C reduction', 

which shows the use of this facility. 

Drained and Undrained 

Drained and Undrained attributes can be defined from the Attributes > Pore Water 

Pressures... menu item. They are used to define regions of a model where the soil is 

drained or undrained.  

 Drained conditions occur in granular (free-draining) soils and also clays 

subject to long-term changes in load. The soil mass experiences a 

corresponding change in volume, with full dissipation of excess pore pressures. 

This means that the particles in the soil (the ‘soil skeleton’) experience a 

change in ‘effective stress’. Under increased load, there’s an increase in 

effective stress, and therefore in shear strength of the soil. Conversely, when 

load on soil is being relieved, this can lead to a decrease in shear strength. 

Therefore drained conditions are typically critical where load on soil is being 

relieved e.g. cuttings, retaining walls, excavations. 

 Undrained conditions occur in clay-type soils subject to short-term changes in 

load. In such cases, the increase in stress is carried by the pore water alone and 
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the stress carried through the soil skeleton – the effective stress is unchanged. 

Therefore undrained conditions are typically critical, in the short term, where 

load on such soil is being increased e.g. embankments and foundations. 

Drained and undrained attributes can be assigned to features representing soil that are 

meshed with two phase elements and modelled with two-phase materials in both 2D or 

3D models. The use of such attributes is a conceptual shortcut from the beginning to 

the end of a consolidation analysis, representing the extreme undrained and drained 

conditions. 

Notes  

The drained and undrained status of soils can be changed at any stage of a nonlinear 

construction analysis. In some cases this may eliminate the need to use time domain 

controls since an analysis can simply step between the undrained (short term clay) and 

drained (long term clay) states. It is possible to: 

 Solve several nonlinear loadcases which have no time domain control, 

followed by nonlinear loadcases where a time domain control is included. This 

enables obtaining an initial equilibrium in two-phase materials over one or 

more nonlinear stages, then add a load, and perform a consolidation analysis. 

 Solve one or more nonlinear loadcases where a time domain control is 

switched on, and then specify one or more loadcases where the time domain 

control is switched off. The later loadcases will be solved without time-

dependent effects. This enables an analysis “jump to the drained state” without 

performing a consolidation analysis of many steps. 

This functionality is very useful for construction sequences which involve time, but 

where delays could occur at any stage. In these cases the drained state can be 

considered as branched analyses of one or more stages.  

Equivalencing 

The equivalence facility is used to merge coincident nodes on otherwise unconnected 

features. If an equivalence attribute is assigned to any features the nodes will 

automatically be equivalenced after meshing has been carried out. 

There are several ways equivalencing can be set up to work:  

 By assigning equivalence tolerances to certain features - only these features 

will be equivalenced, all others are ignored. 

 By switching on the automatic tolerancing, and accepting the default tolerance - 

all features are equivalenced according to the default tolerance. 
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 By switching on the automatic tolerancing, and assigning other equivalence 

tolerances to certain features - all features are equivalenced according to either 

an assigned tolerance or the default tolerance. 

  

Example  

In this example, Surfaces 1 and 2 do not share a 
common boundary Line, therefore the nodes created 
on their common boundaries will not be joined and 
must be equivalenced. Node 2 will merge with node 1 
if it lies within the equivalence tolerance.  

  

 

Using Equivalencing 

Equivalence attributes are defined from the Attributes menu. They are defined as a 

tolerance, which is used to determine whether nodes are considered to be coincident.  

The equivalence attribute is assigned to the features that are to be checked for 

coincident nodes. When an equivalence dataset is assigned to a lower order feature it 

will search through all higher order features for nodes to be checked. For example, in 

order to equivalence two Volumes at their boundaries, it is more efficient to assign the 

equivalence to the Surfaces on the boundaries, as a smaller number of nodes need to 

be checked. 

Automatic Equivalencing 

Automatic equivalencing can be activated from the Meshing tab of the Model 

Properties dialog. This will equivalence all features in the model on meshing if they 

are within the default equivalence tolerance, or within an assigned tolerance. Note. 

Remeshing occurs each time a relevant command is issued, but a forced remesh is 

possible using the Tools> Mesh> Mesh Reset menu item. Automatic equivalencing 

can be time consuming for models with a large number of nodes. 
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Visualising Equivalences 

Displays the features which have a specified equivalence 

assigned to them in a chosen colour and line style. 

In this example different equivalence tolerances are assigned 

to different parts of a model to merge more coarsely or finely 

as required. Using visualisation, the lines to which the 

equivalence is assigned can be highlighted. Equivalenced 

nodes can also be visualised as they are removed. In this 

diagram they are shown using the square symbol. 

 

Summary 

 More than one equivalence attribute may be defined in order to rationalise 

more than one section of the model independently. 

 More than one equivalence attribute can be assigned to a feature to equivalence 

it within a different subset of the model. 

 A check for unconnected elements and nodes can be performed using an 

outline mesh plot (Mesh layer properties), or by checking for duplicate node 

numbers using the View > Browse selection menu item and box-selecting 

around selected points to see if more than one point appears in the list shown. 

 The equivalence tolerance must be less than the smallest distance between two 

nodes on the same feature, otherwise the equivalencing operation will fail.  

 Equivalencing may be used to position a point load or support at a node (which 

is not at a defining feature Point). A Point must be created, the load or support 

assigned, and the Point and meshed feature equivalenced. 

 Equivalencing may be used to merge nodes on the constituent Lines of 

combined Lines i.e. the nodes on an entire combined Line may be 

equivalenced, including the Lines forming it. 

Influence Attributes 

Influence attributes define the result component and methodology that, when assigned 

to a part of the structure, and in combination with an influence analysis, will be used 

to create an influence surface. They can be defined for use with the following 

methods: 

 Reciprocal Theorem - also known as the Muller-Breslau Theorem, or 

Maxwell's Theorem, is a means of calculating an influence by the use of an 
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auxillary structure, to which a deformation corresponding to a load effect of 

interest is applied.  

 Direct Method - is a more general and powerful way of calculating an 

influence where the effect of a specified point load is assessed at each node or 

grid location on a loadable area of a structure. The value of the load effect of 

interest at each specified location is then used to construct an influence line or 

surface for that location. 

Both methods create influence attributes that need to be assigned to a model prior to an 

influence analysis being carried out. For details on how to define and assign influence 

attributes see Influence Analysis. 

Reciprocal Theorem Influence Attributes 

Reciprocal Theorem influence attributes are defined from the Attributes > 

Influence> Reciprocal Theorem menu item.  

Specifying an influence attribute 

The influence attribute may be set by defining an Influence type of either Shear force, 

a Reaction, a Moment or a Displacement, an Influence direction of either 

Longitudinal or Transverse, and a Displacement directionof either Positive or 

Negative.  

Note that a shear or moment influence type is mesh dependent. The Influence direction 

defines the axis about which the component of interest will be evaluated. Once 

created, an influence attribute is held in the Attributes  Treeview for assignment to 

selected mesh nodes or Points on a model. A Direction definition object containing 

information relating to setting the vertical, longitudinal and transverse axes for a 

model is added to the Influence entry in the Attributes  Treeview once the first 

influence attribute has been defined. 

A short influence name is recommended since this is used to create filenames that also 

include coordinates of assigned influence attributes and element details, and if 

collectively this is too long, the Windows path limit of 260 characters may be 

exceeded. For more details see File and folder naming in LUSAS. 

Assigning Reciprocal Theorem Influence Attributes 

One or more nodes or Points on the model may be selected to make a reciprocal 

theorem influence attribute assignment. Assigned attributes are stored within an 

Reciprocal Influence analysis entry in the Analyses  Treeview. Influence loadcase 

naming is based upon node coordinates. When assigned to the model LUSAS 

automatically determines the break-away elements required by the Reciprocal 

Theorem method in each case. Influence type symbols are drawn at each influence 

location to show the type of mesh break that is being used.  
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Note that Reciprocal influence attributes can be assigned to as many nodes or points 

on the model as necessary, but should only be assigned to those nodes or points for 

which they are applicable. For example, a Reciprocal influence attribute (defined for a 

negative displacement direction) should only be assigned to those nodes in a model for 

which a negative influence shape applies. For nodes where a positive influence shape 

exists a Reciprocal influence attribute with a positive displacement direction should be 

assigned. In general, when using Reciprocal influence attributes the influence shapes 

for nodes of interest should be viewed prior to any influence attribute assignments 

being made.  

Visualisation of Assigned Influence Attributes 

Reciprocal Influence surfaces can be visualised if attributes are assigned to a model 

and solved. The type of visualisation that takes place to help identify the influence 

type and the participating elements at each node or point of interest depends upon the 

type of influence and whether any manual selection of participating elements was 

done.  

Visualisation settings are accessed using the context menu for an influence attribute. If 

influence assignments are visualised the whole model may be re-displayed after 

viewing selected influences by right-clicking in the View window and selecting the 

All Visible option. 

Note that if a solve (to visualise influence surfaces) is not carried out prior to a Vehicle 

Load Optimisation analysis being run (with the generate Influence Surfaces check-box 

checked), influence loadcases are added to the Analysis Treeview but no visualisation 

of these influence shapes can be done. 

Identifying Assigned Attributes 

The location of an assigned influence attribute can be found on the model by using its 

context menu and choosing Select Assignments to list it in the Selected items 

window. Any objects listed in this window can be located on the model by using the 

Find menu item on the context menu for the object. The location of the assigned 

attribute will be identified by a temporary indicator. 

file:///C:/SVN/Content/1using/idh_an_introduction_to_lusas_modeller.htm
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Changes to Mesh after Attribute Assignment  

If a model is re-meshed or has its geometry edited the influence points will remain 

visualised with those influence points still overlying a node or Point remaining marked 

with an appropriate 'break' symbol. Influence points that no longer lie on nodes or 

Points as a result of any modifications remain visualised on screen but with a 'not 

assigned'  symbol alongside their name in the Analyses  Treeview. Models can 

be solved with unassigned influences present in the Analyses  Treeview. 

Direct Method Influence Attributes 

Direct Method influence attributes are defined from the Attributes > 

Influence> Direct Method menu item.  

Defining an influence attribute 

An Influence attribute is defined by stating an Entity of interest (such as a Reaction, 

or a Force/Moment, or a Stress for example), an influence Direction (such as a local 

axis of a member, or a path along a structure etc.) and a Component of interest (such 

as My etc).  

The Entity drop-down list is populated according to the elements that are present in the 

model, and if any beam / shell slicing utilities have been defined a Beam/Shell Slice 

Resultants entry will also be present. The Direction drop-down list presented depends 

upon the type of entity selected. The Component drop-down list shows the influence 

components available for the chosen entity. Note that components that use absolute 

values are not valid since the principal of superposition cannot be applied to these 

components. As a result these components are not provided for selection. 

Using paths 

Specification of an influence direction using the Path facility is recommended for 

grillage models, curved beam models, and for curved decks modelled with plates or 

shells where longitudinal and transverse effects are of interest. A default path of  

longitudinal = global X is provided to allow influences to be assigned to models 

where element axes lie in this direction without having to actually define a path. This 

default path does not appear in the Utilities treeview and is not editable. Otherwise for 

most models, the specification of a path will require a reference path to have been 

previously defined prior to selection. If a reference path has been defined 

incorporating a skew angle then selecting the Skew check-box will ensure that for 

grillage or beam models all elements lying at that skew angle will be considered to be 

the transverse elements. Otherwise, by default, transverse elements are assumed to be 

those elements perpendicular to the longitudinal elements. A path cannot be selected 

for 2D line beam elements; for these, all components are calculated using the element 

local x-axis. 

The Component drop-down list shows the influence components available for the 

chosen entity. Note that when a Path has been specified, in addition to the standard 
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choices of Component, an Entity selection of Force/Moment will show component 

values of: 

 FV (longitudinal members) (Force in the Vertical direction for longitudinal 

members) 

 FV (transverse members) (Force in the Vertical direction for transverse 

members) 

 MF (longitudinal members) (Flexural Moment in longitudinal members) 

 MF (transverse members) (Flexural Moment in transverse members) 

 Name A short influence name is recommended since this is used to create 

filenames that also include coordinates of assigned influence attributes and 

element details, and if collectively this is too long, the Windows path limit of 

260 characters may be exceeded. For more details see File and folder naming 

in LUSAS. 

Once defined and created, an influence attribute is held in the Attributes  Treeview 

for assignment to selected mesh nodes, points or locations on a model Subsequent 

assignment of the same attribute to other nodes or points of interest will use the same 

settings.  

Assigning Direct Method Influence Attributes 

Influence attributes are assigned in a Direct Method Influence analysis and if one has 

not been created at the time of assignment a prompt will be given to create one.  

Influence attributes can be assigned to one or more selected nodes or points on the 

model using either a drag and drop technique or the 'Assign' context menu options for 

an attribute in the  Treeview. They can also be assigned to pre-defined Inspection 

locations,or to Beam/Shell Slice locations using the 'Assign to' context menu item for 

the DMI attribute, and then selecting the inspection points or the beam/shell slice 

utility to which the assignment should be made on the Influence Assignment dialog 

that subsequently appears. When the DMI attribute is assigned to an inspection 

location attribute, assignments are created only at inspection locations that are not 

pending and their underlying element is compatible with the result entity chosen in the 

DMI attribute. Once assigned, DMI attribute-named loadcases are added to the 

Analyses  treeview. 

When an influence attribute is assigned to a node, point, or inspection or slice location, 

it may be acceptable to average the results from the adjacent elements (e.g. being at 

midspan of a beam) or unacceptable (e.g. shear force at an intermediate support of a 

continuous multi-span beam). Where averaging is deemed unacceptable according to 

averaging rules (see Results averaging), then the assignment will result in two or 

more items appearing in the Analysis  treeview, corresponding to the connected 

elements. Any items which are not required can be deleted from the Analysis  

treeview, or alternatively greater control over the assignment can be obtained by use of 
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visibility and/or selected items. Assignment to a node or point will only generate 

influences for connected elements or features if they are visible. Assignment to a node, 

point or inspection location when connected elements or features are also selected will 

only generate influences for the selected items. 

Assigning influence attributes to points as opposed to nodes of the mesh (as may be 

preferred, perhaps, for reaction influences) has the benefit that, if changes are made to 

the geometry and the location of the point is moved, the attribute assignment will 

continue to remain valid. An assignment to a node that has a coincident point will 

assign the attribute to that point instead. Attributes assigned to mesh nodes only, 

remain valid only if the influence location overlays a mesh node and the elements are 

compatible with the results entity specified in the Influence attribute. See Changes to 

Mesh after Attribute Assignment. 

Notes 

 If a shear influence type is assigned to a node or point that is supported , a 

shear influence assignment is made to the end of each connected element or 

line at that assignment location. 

  Beam / Shell Slice DMI attribute assignments are grouped by Beam/Shell 

Slice utilities and by influence attribute, with an entry created for each slice 

location. The suffix '@ <slice location>' is appended to the loadcase name in 

each case. When two slices are created at the same location by the beam shell 

slice facility, the suffix ‘(-X)’ and ‘(+X)’ is added to the names respectively. 

 Influence assignments to inspection locations are not saved in the model; they 

are created when the inspection location attribute is evaluated. Therefore, if 

such assignments are used in a Vehicle Load Optimisation analysis and the 

model is saved, those assignments will not be present in the VLO analysis after 

the model is loaded. 

 If a DMI beam/shell slice assignment is used in a Vehicle Load Optimisation 

analysis, and is subsequently deleted as a result of changing the Beam/Shell 

Slice utility, then the influence design loadcase for that assignment in the 

VLO/RLO run will be marked as invalid. 

file:///C:/SVN/Content/Bridge/Vehicle_Load_Optimisation/Vehicle_Load_Optimisation_Overview.htm
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Case Study: Defining and assigning Direct Method Influence 

attributes to a grillage model 

The basic procedure to define and assign Direct Method influence attributes to a 

grillage defined using the LUSAS grillage wizard is as follows: 

1. Define an influence attribute for Flexural Moment (Longitudinal members). 

2. Using the point selection tool, select all points in the model. 

3. In the Groups  Treeview, right-click on the Longitudinal group name and 

choose Add to Group. 

4. Assign the influence attribute to the selected points creating every possible 

longitudinal influence. 

5. Define an influence attribute for Flexural Moment (Transverse members). 

6. In the Groups  Treeview, right-click on the Transverse group name and 

choose Add to Group. 

7. Assign the influence attribute to the selected points creating every possible 

transverse influence. 

8. Solve the model to generate the influences and view them by adding the 

Influence shape layer to the Layers Treeview. 

 

For grillages created outside of the grillage wizard a similar process would apply using 

repeated box selections to select all longitudinal members (and their lower order 

points) prior to assignment of an influence attribute to create every possible 

longitudinal influence, followed by repeated box selections of all transverse members 

(and their lower order points) prior to assignment of an influence attribute to create 

every possible transverse influence. 
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Using a Loading Grid 

For line beam analysis, where a geometric beam section represents a loadable top slab, 

loading grids would normally always be used. A loading grid provides the means to 

define a loadable grid of points that can be used by an influence analysis as an 

alternative to using the loadable nodes or points inherently present in a beam, shell or 

plate model. The use of a reference path defining the centreline of a loadable 

carriageway and a search area to restrict the loading to selected nodes of the model is 

recommended whenever a loading grid is used. 

The use of a loading grid will require the following to be specified: 

 Centreline - the centreline of the grid can be defined with reference to a 

previously defined Path or the X, Y or Z global axes. The use of a reference 

path is recommended for most situations. 

 Transverse width - the width of the grid to be loaded (must be greater than 

0.1).  

 Grid settings - these control whether the loadable grid of points is based upon 

the nodes defined in a search area, or whether it should be based upon a grid of 

points that can be set to match the nodes in a search area (line beam models 

only). or be user-defined according to longitudinal and transverse values 

specified. If one of the global axes has been selected as the centreline of the 

grid, then the extents of the model will be calculated. 

 Loading settings The magnitude of the influence load (in terms of a positive or 

negative direction) and its actual direction of loading (in terms of the X, Y, or Z 

global axes, or the Vertical axis of the model can be defined. A default load 

magnitude of 1e3 is used if the model units are metric, with an equivalent 

rounded value used if the model units are imperial. This default value is used in 

preference to a unit load so that any factoring or scaling of the loading 

(depending on the unit system in use) does not cause the order of magnitude of 

displacement to fall below tolerances used in vehicle load optimisation 

software. 

Note that manually-defined loading grids are not supported by the Rail Load 

Optimisation facility. Instead, for this option, 'grid' points are automatically created 

where the rails for each track layout intersect the elements representing the deck, and 

only those 'grid' points are loaded when carrying out an influence analysis. 
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Loading grid examples for line beam models 

 

Line beam loading grid created by matching nodes in the search area. 

  

 

Line beam loading grid created from either minimum or maximum number or spacing values 

Loading grid notes 

 When using a loading grid to represent a generally loadable region of 

carriageway on a bridge deck, lines representing the extent of the carriageway 

will still need to be defined and selected prior to carrying out a Vehicle Load 

Optimisation analysis. 

 For a model with a very fine mesh, loading a grid having fewer points will 

reduce the solution time. But note that coarse mesh refinement or coarse 

loading grid settings can lead to inaccurate influence shapes being created, 

especially near any cusps. 

file:///C:/SVN/Content/Bridge/Vehicle_Load_Optimisation/Vehicle_Load_Optimisation_Overview.htm
file:///C:/SVN/Content/Bridge/Vehicle_Load_Optimisation/Vehicle_Load_Optimisation_Overview.htm
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 Certain Vehicle Load Optimisation design codes will not work if the 

DMI analysis is defined with a grid option (unless the model is a line beam 

model where the geometric section represents a beam with a loadable top slab) 

in which the 'Nodes in the search area' option must be selected instead. 

Loading Grid Visualisation 

The visualisation of the loading grid is controlled for each direct method influence 

analysis entry in the Analyses  Treeview by deselecting / selecting the Show grid 

context menu item. The default is to always show a loading grid. It is not possible to 

delete a loading grid. 

Examples of Loading Grid Use 

Loading grids are used in the following situations: 

 On a line beam model where the geometric section represents a beam with a 

loadable top slab. 

 When a different set of loadable points is required in preference to nodes on a 

finely meshed shell or plate model. 

 When a general grid is required to encompass a whole model. (Note that this 

cannot be used for carriageways that divide into two or more branches). 

Case Study: Defining and assigning Direct Method influence 

attributes to a 3D line beam model using a loading grid 

The basic procedure to carry out a Direct Method Influence analysis of a 3D line beam 

model where the geometric section represents a beam with a loadable top slab is as 

follows: 

1. Define an influence attribute that uses a pre-defined reference path along the 

beams that represent the deck and loadable slab. 

2. Using the node selection tool, select all the nodes in the beams along the path. 

3. Assign the influence attribute to all the selected nodes using a loading grid with 

a centreline along the reference path and specify a width appropriate to the 

loadable carriageway. 

4. Solve the model to generate the influences and view them by adding the 

Influence shape layer to the Layers Treeview. 

file:///C:/SVN/Content/Bridge/Vehicle_Load_Optimisation/Vehicle_Load_Optimisation_Overview.htm
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Note that to carry out vehicle load optimisation analysis, lines defining the width of 

the carriageway must also be defined and selected. 

Naming and Visualisation of Assigned Influence Attributes 

(prior to Version 16) 

Assigned influence attributes create influence loadcases within a Direct Method 

Influence analysis entry in the Analyses  Treeview. The naming of these influence 

loadcases and the type of visualisation that takes place (or not) depends three things: 

the type of influence Entity chosen; any element participation settings made when the 

attribute was first defined (for pre-Version 16 models only); and whether any manual 

(or automatic) selection of participating elements was done (pre-Version 16 models 

only). 

The following notes generally apply to influence attributes defined and assigned to a 

model prior to a model prior to Version 16: 

 Nodes assigned an influence attribute where a direction is associated with a 

component are denoted by an assignment  symbol.  

 Nodes assigned an influence attribute where a direction cannot be associated 

with a component are denoted by a blue  symbol. 

 If Unaveraged influence for each connected element was chosen when the 

attribute was first defined, the assigned attribute is drawn, by default, in orange 

and all elements participating in the calculation for that influence point are 

identified in the View window by a participating element  symbol . In the 

Analyses  Treeview a separate assignment is created for each node/point and 

participating element/line.  

 If Average influence of all connected elements was chosen when the attribute 

was first defined, the assigned attribute is drawn, by default, in blue and no 

visualisation of participating elements take place. By implication all elements 

seen to be connected to the node or point of interest are being used in the 
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calculation for that influence location. If any elements or features were 

explicitly defined as participating, these will be identified by a participating 

element  symbol. 

 Initially assigned influence attributes that no longer overlay a node (perhaps 

because of a revised mesh arrangement) are denoted by a red  symbol. These 

influences are termed 'pending' and appear in red text in any list of influences to 

be analysed. Assigned influence attributes can also be denoted as 'pending' if 

some participating features are not meshed at the time of assignment, or if those 

features are not compatible with the results entity defined for the influence 

attribute. 

 Assigned moment or reaction influence types are denoted by arrows in the 

plane in which the calculation of averaging of values is taking place. Orange 

arrows signify un-averaged results will be calculated. Blue arrows signify 

averaged results will be calculated. 

 Additional visualisation settings are accessed using the context menu for an influence 

attribute. 

Element Visualisation Symbols (that are defined and assigned 

in LUSAS Version and later releases) 

Influence attributes defined in and assigned to a model in Version 16 and above are 

visualised the same on all analysis model types. No element participation symbols are 

visualised because all averaging of element results is done automatically according to 

settings made on the Model Properties - Options (Averaging)  dialog. 

Plate/shell model Grillage Model 2D/3D Frame Model 

      

  

 

 A blue arrow signifies 
averaged results will be 

calculated 

Blue arrows signify averaged 
results will be calculated. 

Blue arrows signify averaged 
results will be calculated. 

Element Participation and Visualisation Symbols (that were 

defined and assigned in LUSAS Version 15) 

Influence attributes defined in and assigned to a model in Version 15 are visualised as 

they would have been when they were initially created (if the model is opened in a 

file:///C:/SVN/Content/dlg0prop/idd_props_document_solution_averaging.htm
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later version) because of the type of results averaging method that was specified at the 

time the influence attribute was generated. See the images that follow. 

In addition, if influence attributes defined in a pre-version 16 model are re-assigned to 

nodes in a model created in later version the element participation and visualisation 

symbols will also be as shown on the following images. Note that even though the 

influence assignments have been made in version 16 or above, because the method of 

results averaging was defined as part of the attribute definition, settings made on the 

Model Properties - Options (Averaging) dialog will not override any averaging 

settings defined for these influence attributes. 

Plate/shell model 

Symbols used for an influence attribute defined to investigate Flexural Moment in 

longitudinal members with reference to a path. 

Version 15: "Separate 
influence  

for each connected element" 

  Version 15: "Average 
influence  

of all connected elements" 

   
Version 15: "Selected 

elements only" 

          

 

  

 

  

 

Elements identified by square 
symbols are participating at the 
node. An orange arrow signifies 

un-averaged results will be 
calculated. 

  No elements identified by 
square symbols signify that all 

connected elements to the 
node are participating at the 
node. A blue arrow signifies 

averaged results will be 
calculated 

  Only those selected elements 
identified by square symbols 

are participating at the node. A 
blue arrow signifies averaged 

results will be calculated. 

Grillage Model 

Symbols used for an influence attribute defined to investigate Flexural Moment in 

longitudinal members with reference to a path. 

Version 15: "Separate 
influence  

for each connected element" 

  Version 15: "Average 
influence  

of all connected elements" 

  Version 15: "Automatically 
choose  

elements for averaging" 

          

file:///C:/SVN/Content/dlg0prop/idd_props_document_solution_averaging.htm
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Elements identified by square 
symbols are participating at the 

node. Orange arrows signify 
un-averaged results will be 

calculated. 

  No elements identified by 
square symbols signify that all 

connected elements to the 
node are participating at the 

node. Blue arrows signify 
averaged results will be 

calculated. (This option is not 
normally applicable to grillages) 

  Only the longitudinal elements 
identified by square symbols 

are participating at the node. A 
blue arrow signifies averaged 

results will be calculated. 

2D/3D Frame Model 

Symbols used for an influence attribute defined to investigate axial forces or moments 

in members of a 2D/3D frame with reference to a path. 

Version 15: "Separate 
influence  

for each connected element" 

  Version 15: "Average 
influence  

of all connected elements" 

   
Version 15: "Selected 

elements only" 

          

 

  

 

  

 

Elements identified by square 
symbols are participating at the 

node. Orange arrows signify 
un-averaged results will be 

calculated. 

  No elements identified by 
square symbols signify that all 

connected elements to the 
node are being averaged. Blue 
arrows signify averaged results 

will be calculated. 

  Only the elements identified by 
square symbols are 

participating at the nodes. 
Orange arrows signify un-
averaged results will be 

calculated. 

Identifying Influence Locations on the Model 

The location on the model of an assigned influence attribute entry in the Attributes  

Treeview can be seen by using the Select Assignments context menu for that entry. 

The location on the model of an influence analysis entry in the Analyses  Treeview 

can be found by using the Find context menu for that entry. The location will be 

identified by a temporary indicator of animating concentric shrinking squares. 
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Changes to Mesh after Influence 

Attribute Assignment  

If a model is re-meshed or has its geometry 

edited affecting the mesh, assigned influence 

attributes will remain visualised with those 

influence types still overlying a node 

remaining marked with an appropriate 

influence type symbol. These marked 

locations will be included in an influence 

analysis. Influence points that no longer lie 

on nodes as a result of any modifications remain visualised on screen and are denoted 

by a red  symbol, but they will have a 'not valid'  symbol alongside their name in 

the Analyses  Treeview. These influences are effectively 'pending' (requiring 

correction or removal) and appear in red text in any list of influences to be analysed. 

These will not be included in an influence analysis. Note that models can still be 

solved with influences marked as 'not valid' and with unassigned influences present in 

the Analyses  Treeview. 

Solving an Influence Analysis 

See Influence Analysis 

Age 

Age attributes are defined from the Attributes> Age menu item. Age attributes are 

used to define the age of an element at the response time in timescale units at which it 

first becomes active in an analysis. When using the concrete creep and shrinkage 

models the age from casting to activation can be defined, and the age after casting that 

shrinkage begins can also be specified. Note that it is assumed that the age that the 

element first becomes loaded coincides with the element age at activation. 

Age at activation time 

This can be specified directly or be calculated by selecting one of the following: 

 Specified directly (Age at placement) The number of days/hours etc.between 

concrete being cast and the elements to which that concrete has been assigned 

being activated in the model (see activate and deactivate). For example, an 

element could be 40 days old but activated in the analysis on day 28. If no 

activate and deactivate attributes have been assigned then the age activation 

time will be at the beginning of loadcase 1. 

 Calculated with adjustment for temperature during curing When selected 

in conjunction with the Set... button, a table of values of temperature against 

duration can be specified and used to calculate a temperature adjusted time 

(age) based upon an equation that appears in CEB-FIP Model Code as eq 2.1-

87, EN1992 as exp B.10, fib Model Code 2010 as eq 5.1-85, and IRC:112 as 
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Eq A2-13. The value calculated is then displayed in the read-only cell for this 

option. This allows, for example, specifying an elevated temperature for a 

curing time of 5 days followed by a lower temperature for 3 weeks of storage of 

a component before transfer and use on site. Whilst there is no similar equation 

in AASHTO LRFD 7th Edition or JTG 3362-2018 this option may still be used 

to derive a potentially suitable age value. 

Age at which shrinkage begins 

 Age at which shrinkage begins The number of days/hours etc. between the 

concrete being cast and shrinkage being considered to have started. For Codes 

of Practice where autogenous shrinkage and drying shrinkage are handled 

separately, such as EN1992-1-1, this input refers to the age at which drying 

shrinkage begins; autogenous shrinkage is always taken as occurring from 

when the component is cast. For Codes of Practice where there is no such 

distinction, this value is used to define the commencement age for all 

shrinkage. 

Once defined and assigned to a feature all elements created by that feature are 

assigned the specified ages that apply.  

Note that Modeller will always convert ages defined in timescale units to seconds 

when tabulating the Solver data file. 

See Solver Reference Manual for further details. 

Crack tip attributes 

A crack tip attribute allows a crack tip location to be defined at a point in a surface 

model and at either a point or line in a volume model. Crack tip attributes are defined 

from the Attributes  > Crack tip menu item and are only for use with 2D and 3D 

quadratic continuum elements. After assignment the mid-point nodes of elements 

adjacent to the crack tip assignment are automatically moved to the nearest quarter 

point position within the element and the continuum elements adjacent to the crack tip 

assignment are automatically replaced with an equivalent crack tip element. When 

assigned to a point, the crack tip always occurs at a corner node of an element. When 

assigned to a line (volume models only), the crack tip occurs all along the line. 

Assigned crack tip attributes can be visualised using symbols displayed on the nodes 

of the assigned feature and at the mid-side nodes of the adjacent elements that have 

been moved towards the assigned feature. 
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Crack tip attribute assigned to a point in a 

2D model 

Crack tip attribute assigned to a line in a 

3D model 

Thermal Surfaces and Heat Transfer 

The thermal surface facility allows thermal gaps, contact and diffuse radiation to be 

modelled. Thermal surfaces are used to model the thermal interaction of two distinct 

bodies, or two different parts of the same body through a fluid medium.  

 Thermal Gaps are used to model gaps between structures that are relatively 

close together. 

 Contact is used in a thermo-mechanical coupled analysis where contact takes 

place and the contact pressure effects are then included in the analysis. 

 Diffuse Radiation is the process of heat transfer from a radiation surface to the 

environment or to another thermal surface defining the same radiation surface. 

Radiation is modelled by specifying radiative properties for thermal surfaces. 

Thermal surfaces 

Thermal Surfaces are the thermal equivalent of structural slidelines. They are defined 

from the Attributes> Thermal Surface menu item and are assigned to features of the 

model and manipulated in the same way as all other attributes. A thermal surface must 

be defined before thermal gap or radiation properties can be specified. 

 Radiation properties are required when defining a radiation surface for heat 

transfer by radiation exchange.  

 Environment properties are required when thermal environment properties 

exist. Used for heat transfer to the environment (convection and conduction).  

Thermal Surfaces work in conjunction with Thermal Gaps and Radiation Surfaces 

See below for details. 

Heat Transfer 

Thermal gap and radiation surface properties are used to dictate the type of heat 

transfer that can take place between Thermal Surfaces. They are defined from the 

Utilities> Heat Transfer...  menu item. As utilities they cannot be assigned directly to 
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features of the model as Thermal Surfaces can. A thermal surface must have been 

defined prior to specifying any thermal gap or radiation properties. The process of 

thermal surface / heat transfer definition is summarised in the following diagram. 

 Thermal Gaps Thermal gaps are used 

to model heat transfer across a gap and 

heat transfer by contact when a gap is 

deemed to have closed. If these effects 

are required, the thermal surfaces 

defining the gap must be specified on 

the Thermal Gap properties dialog. 

 Radiation Surfaces Diffuse radiation 

exchange may be modelled with a 

radiation surface that is defined by any 

number of thermal surfaces. Planes of 

symmetry that cut through the radiation 

enclosures may be defined so that it is 

not necessary to model the whole 

structure. Radiation surfaces allow for 

the calculation of diffuse view factors. 

These view factors may be output to a 

print file  

Specifying thermal surfaces defining a gap 

Pre-defined thermal surfaces can be selected on the Thermal Gap properties dialog in 

order to define a gap. The gap can be defined as active or inactive initially and be set 

to change according to loadcase. 

Choosing Thermal Properties 

The following flowchart guides the decision making process for choosing thermal 

properties. The process is simplified if the analysis only considers a single body, when 

only environmental thermal properties are required. For analyses where discrete 

(multiple) bodies are considered, factors such as body proximity and whether the 

bodies are touching, or are likely to touch during the analysis, become important and 

the choice of thermal properties changes. Follow a route through the flowchart below 

and define your thermal surfaces using the properties given in the shaded box. 
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Environmental Nodes (LUSAS Solver data file only) 

Environmental nodes may be used to represent the medium which separates the 

thermal surfaces between which heat is flowing. As the length of a link directly 

connecting two surfaces increases, the validity of the assumed flow becomes more 

tenuous. Alternatively, instead of forming a link, heat could flow directly to the 

surroundings, but in this case, the heat is lost from the solution. This, in some cases, is 

a poor approximation to reality, particularly when the thermal surfaces form an 

enclosure. In this instance an environmental node can be used to model the intervening 

medium, with all nodal areas which are not directly linked to other areas linked to the 

environmental node. The environmental node then re-distributes heat from the hotter 

surfaces of the enclosure to the cooler ones without defining the exact process of the 

transfer. 

Note. Environmental nodes cannot be defined in LUSAS Modeller, and must be edited 

directly into the LUSAS Solver data file if required. See the Solver Reference Manual 

for further information. 

Radiation Options 

Radiation options are set from the  Coupled analysis options object in the Analyses 

 Treeview. 
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 Suppress Recalculation of View Factors in Coupled Analysis   Turns on/off 

the view factor recalculation. The option should be turned on when the 

radiation surface geometry is unchanged by the structural analysis. This stops 

recalculation of the view factors. LUSAS Solver option 256. 

Overriding of thermal surface attributes between analyses 

The default state for a second or subsequent thermal analysis is to inherit the attribute 

assignments from the first one, but the additional analysis can 'override' some or all of 

those assignments. However the overriding of thermal surfaces relies on no overlaps 

between defining lines/surfaces so is only meaningful if they are assigned in exactly 

the same pattern. For example, in analysis 1, Thermal Surface 1 can be assigned to 

Surface 1 and 2, and Thermal Surface 2 can be assigned to Surface 3 and 4. In analysis 

2 it is valid to assign Thermal Surface 3 to Surface 3 and 4, 'overriding' the assignment 

of the first analysis. But to assign Thermal Surface 3 to Surface 4 and 5 would cause 

an overlap because the state of Surface 4 is undefined - it cannot be a part of two 

different thermal surfaces. To overcome this, the inheritance of the thermal surfaces 

would need to be switched off on the analysis definition so that the two analyses are 

independent. 

Results Transformation Attributes 

Results transformation attributes can be defined using the Attributes> Results 

Transformation... menu item. 

If the elements in a model are orientated such that their local axes vary from one 

another (and note that for surfaces they may also vary from the surface orientation), or 

if an alternative coordinate system is required, the results may be transformed to a 

consistent direction by assigning a results transformation attribute to all or selected 

features of a model. Multiple results transformation attributes may be defined and 

assigned to relevant features on a model. 

Results may be transformed to the following directions: 

 Local axes of element/node Transforms nodal results (displacements, reactions 

etc.) according to the local transformed freedoms, or element results (stresses, 

strains etc.) to element local directions. 

 Local coordinate of parent feature Transforms element results according to 

the local axes of the line, surface or volume feature. 

 Global axes Transforms nodal or element results to the global axes. 

 Specified local coordinate Transforms results to a consistent direction using a 

local coordinate.  

 Shell plane for resultants enables the plane for shell moments and shear 

forces to be defined when using cylindrical or spherical coordinates. See Shell 

plane for resultants. 

file:///C:/SVN/Content/4attrib/idh_results_transformation_attribute.htm
file:///C:/SVN/Content/4attrib/idh_results_transformation_attribute.htm
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 Reference path Transforms nodal or element results relative to the angle or 

route of a reference path. 

Once created a Results Transformation attribute is added to the Attributes  

Treeview, in readiness for assignment to features of the model. Once solved, element 

results can be transformed by any of the above methods, or by assigned results 

transformation attributes, by pressing the Transform Set button on the relevant results 

properties dialogs. 

Notes 

 Different model drawing layers can each have different Results Transformation 

settings. 

 Beam and bar elements always have their local x direction along the length of 

the element. 

 Beam element results can only be transformed rotationally about their axis. 

 For plates and shells the normal direction is defined by the local element z axis 

and this cannot be transformed. A results transformation only applies to the 

orientation of the local element x and y directions in the plane of the shell 

element. Top/Middle/Bottom, Wood-Armer top and bottom, and sign 

conventions rely on the element z axis. 

 When viewing Wood-Armer results a transformation is used to set the direction 

of the X reinforcement. A skew angle may then be set independently to define 

the Y reinforcement direction. The default skew angle is 90 degrees. 

 When viewing shell moments and shear stresses using a cylindrical or spherical 

local coordinate the shell plane for resultants needs to be defined as theta/z, 

r/theta or r/z. 

 Using the transformation options for joint elements has no effect. 

 With the exception of the No transformation applied option the type of 

transformation used is written to the Contour key when viewing results 

contours, when it has been explicitly chosen on the contour properties dialog. 

Inspection locations 

An inspection location is a user-defined position of interest on a model for results 

extraction / viewing purposes. Inspection locations can be defined and assigned to 

features in a model either before or after a model has been solved, and are saved when 

a model is saved. Model features can have multiple inspection locations assigned to 

them. Inspection locations can report results on elements that belong to the assigned 

feature, and also for those elements that belong to topologically connected features.  
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Appropriate results can be viewed for any defined inspection locations by selecting 

Inspection Locations from drop-lists on a relevant results layer properties dialog, or for 

individual chosen locations. See viewing results at inspection locations for more 

details. 

Inspection locations can be created in three ways: 

 By definition and assignment - by creating an inspection attribute for a point, 

line, surface or volume by using the Attributes > Inspection Locations... 

menu item. 

 By cursor - by defining an inspection position 'freehand' at a point, along a 

line, or in the plane of a surface by using theTools > Inspection Locations 

> By cursor menu item. 

 By selection of nodes or points (only) prior to using the Tools > Inspection 

Locations > By selection menu item. This facility defines a new inspection 

location for each mouse click, with actual distances calculated, and assigns it to 

the feature that was clicked on. 

Inspection location attribute names are created automatically according to the method 

used, but these can be renamed to more location-specific names (such as 'mid-span 

edge beam') to aid in their identification if assignments of other attributes (such as 

DMI attributes) are to be made to particular inspection locations. 

By definition and assignment of an inspection attribute 

An inspection location attribute can be defined for assignment to a Point, Line, 

Surface or Volume 

 Point No additional input is required. 

 Line For assignment to a line a distance type of Parametric from start, 

Parametric from end, Actual from start, or Actual from end can be stated. 

These options create an inspection location at a specified parametric distance 

between 0 (start of line) and 1 (end of line), or actual distance (in model units 

from the start of a line) along a line in the local coordinate system of any line to 

which the attribute is assigned. For lines multiple inspection locations can be 

defined either as one distance per grid row, or several distances can be entered 

together in a convenient shorthand format. For example, entering "0.5, 2@0.25, 

3@0.1" is equivalent to entering "0.5, 0.75, 1.0, 1.1, 1.2, 1.3".  

 Surface or Volume For assignment to a surface or a volume a distance type of 

Parametric, or Actual can be stated. These options create an inspection 

location at a specified parametric or actual (in-plane) distance in a simple 

planar triangular or quadrilateral surface, or within a volume with respect to the 

local coordinate system of the feature. 

When a line mesh containing one or two rigid end zones has been assigned to a line it 

is possible to specify whether the parametric or actual distance specified to an 

inspection location from (say) the start of a line, starts from the start of the line itself, 
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in which case Exclude rigid end zones would be unchecked, or starts from the end of 

the rigid zone furthest from the start of the line, in which case Exclude rigid end 

zones would be checked. 

      

 

  

 

Examples of inspection location attribute defined 

for lines 

  Example of inspection location attributes defined 

for a surface 

On completion, an inspection location attribute is automatically created in the 

Attributes  Treeview, comprising a user-defined name with the addition an 

automatically generated description to indicate for which feature the inspection 

location applies.  

Assignment 

Inspection location attributes can be assigned to one or more selected points, lines, 

surfaces or volumes within a model using either a drag and drop technique or the 

context menu options present for each attribute, that are available by right-clicking on 

an attribute name. Assigned inspection location attributes will move and copy with 

their assigned geometry, just like other assigned attributes. 

Note that it is possible to assign valid inspection locations in such a way that the 

assignment is invalid. For example, to define a line inspection location, using an actual 

length of 10 units, and assign it to several lines, one of which is less than 10 units in 

length. Similar issues are possible with irregular surfaces, or surfaces with holes – the 

inspection location can be outside the boundary of the surface. Such inspection 

locations simply show an ‘invalid’ symbol and do not display any results.  
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Inspection locations by cursor 

These can be defined by using the Tools > Inspection Locations > By cursor menu 

item. This facility is useful for defining or investigating a small number of inspection 

points. 

An inspection location may be defined 'freehand' at a position along a line, or in the 

plane of a surface by use of the cursor, provided the indicated feature is within the 

search tolerance in use.  

 For points, if the cursor position when the mouse is clicked is within search 

tolerance of a point, that point will be used for the search location.  

 For lines, an inspection location will be created at the nearest position on the 

line to the cursor position.  

 For surfaces, an inspection location will be created at the coordinates of the 

cursor position when the surface was selected. 

In all cases an inspection location is automatically created and assigned to the feature 

found under the cursor click, and the appropriate local coordinates that are calculated 

are used in the Inspection location attribute's name as held in the Attributes  

Treeview. Renaming of inspection location attribute names may be beneficial in some 

situations to aid with identification / selection when assigning other attributes. 

Inspection locations by selection 

These can be defined by using the Tools > Inspection Locations > By selection menu 

item.  

Following selection of suitable points and /or nodes: 

 A single inspection location attribute is created and assigned to all points in the 

selection (they all share the same attribute). 

 An inspection location attribute is created for each and every selected node that 

is found. The type of the attribute, and the coordinates used within its name, 

reflects the type of the feature on which the node appears – e.g. for surface 

elements, the attribute will be of type surface, and local x,y coordinates will be 

automatically calculated and used to define the attribute and its name.  

Visualisation of assigned inspection locations 

Once defined, inspection location attributes are added to the Attributes  Treeview. 

Inspection locations can be deleted from this treeview singly or as part of a multiple 

selection. 
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By default, correctly assigned inspection locations are identified in the view window 

by this symbol: . Invalid assignments or assignments requiring attention are 

identified with this symbol: . Note that the symbols are drawn by the Attributes 

layer, which has to be drawn last (bottom of the list) in Layers  Treeview for the 

symbols to be seen in certain modelling situations. 

Inspection location symbols can all be turned on and off from the Inspections locations 

tab of the Attributes drawing layer properties dialog. Inspection location symbols can 

all be turned on and off individually by using the context menu for the Inspection 

location entry in the Attributes  Treeview and choosing Visualise assignments 

menu item.  

The feature on the model to which an inspection location attribute has been assigned 

can be found by using the context menu for the inspection location entry and choosing 

Select assignments menu item (to highlight the feature(s) to which it has been 

assigned. 

Changes to mesh after assigning inspection location attributes 

If a model is re-meshed or has its geometry edited affecting the mesh, assigned 

inspection location attributes will remain at the same location and be marked with an 

appropriate assignment symbol. Inspection locations assignments that are no longer 

valid following a change to model geometry, perhaps, will have a 'not valid'  

symbol alongside their name in the Attributes  Treeview. These locations are 

effectively 'pending' (requiring correction or removal) and no results extraction will be 

possible for these locations. Note that models can still be solved with inspection 

locations marked as 'not valid'. 

Viewing results at inspection locations 

Results can be viewed for any defined inspection locations by selecting the Inspection 

Locations option from the relevant drop-list for a chosen results entity and component 

on a Values or Contours layer properties dialog, or Print Results Wizard. For 

inspection locations element averaging is always attempted. Where averaging is 

inappropriate, multiple values will be displayed. Averaging settings can be modified 

on the Options tab of the Model Properties dialog. 

Values reported 

Inspection locations can report on results for elements that belong to the assigned 

feature, and also those elements that belong to topologically connected features. For 

example at a corner junction between two surfaces, such as at P2 on the image that 

follows, (at least) six different inspection locations could, in practice, be defined at 

that location - one assigned to the point itself, one assigned to each end of the three 

lines meeting at that point, and one assigned the corner of each of the two adjoining 

surfaces. These inspection locations are all at the same coordinates in space, and can 

all report upon values for the same elements. These values include displacement, 
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reactions, and other intrinsically nodal quantities at the node underlying the common 

point. Additionally, assuming the lines are meshed, the results of the three different 

beams will also be available – one for each line. Note that, in this particular example, 

these are not averaged, because the beams form a junction. Additionally, assuming that 

the surfaces are meshed, and no averaging rules are broken, then a single shell result 

will also be available – the average of contributions of the corner elements of the two 

surfaces.  

 

When viewing values at inspection locations, only unique values for each nodal result 

will be displayed from the multiple values that may be present. For beam stresses, 

values for specified fibre locations will be displayed, but these are drawn at nodal 

locations and not at fibre locations.  

  

 

    

 

Inspection location results displayed for a single 

point in a model, showing a unique value for each 

highlighted line (representing a beam) connecting 

to that point. 

  Inspection location results displayed for a line,  

showing a value for each inspection position 

defined on the highlighted line. 

So, in summary, unique results are displayed at defined inspection locations for all 

continuous (nodal) results. Additionally, element results are displayed for elements 
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meshed on to the assigned feature. Additionally results are displayed for elements 

meshed on topologically connected higher-order (parent) features. However, results 

are not displayed for elements meshed on topologically connected features of the same 

order (siblings). 

Contours 

When viewing contours, coloured blobs are drawn at those inspection locations that 

have only a single value (that is for continuous results, or where averaging has been 

successful). At inspection locations that resolve to multiple values (because averaging 

is inappropriate), no coloured blob is shown, and instead an ‘invalid’ symbol appears. 

 

Influence 

Influence locations are treated by Modeller as "additional" inspection locations, so, 

when examining influence results at inspection locations, results will be consistently 

presented at all locations to which influence has been assigned. Where the influence 

definition indicates the element(s) of interest, other elements are not considered in the 

computation of such results. 

Graph wizard 

When plotting graphs an inspection location assignment can be chosen from a list, 

rather than typing in a node number. This means that only those inspection locations 

that are located exactly over a node are available for graphing. 

Report wizard and Print Results Wizard 

When inspection location results are output to a model report or listed by the Print 

Results Wizard the inspection locations are referred to by both their attribute name 

and the global coordinate that their assignment resolves to. Where the inspection 

location is at a point, the point name is given instead.  

  

Loadcases 

A loadcase is a collection of loading types such as a point load, a body force, or a face 

load etc., that have been assigned to a particular analysis in a model using the same 
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loadcase name. Each loadcase name and its loadcase dependent assignments (such as 

supports and loading) is held within an analysis entry the Analyses  Treeview.  

A typical model may have many loadcases 

assigned to potentially more than one 

analysis. When each analysis is run each 

loadcase is solved and the results for each 

loadcase are provided separately. Note that 

nonlinear analyses produce results loadcases 

for each iteration used to achieve a 

convergent solution. Combinations and 

envelopes of loadcase results can be created 

to look at combined or maximum / 

minimum effects.  

Analysis control parameters for eigenvalue, 

fourier and nonlinear and transient analyses 

are defined as properties of a loadcase using 

its context menu. In a nonlinear analysis, 

LUSAS loadcases may be modelling 

individual analysis stages and within this 

type of analysis the loading or supports can be modified between loadcases. 

Loadcase dependent attributes and results for a loadcase can only be visualised by 

setting that loadcase active. This is done by choosing the Set Active menu item from 

its context menu.  

Loadcases can be copied, pasted, renamed, and deleted within the Analyses  

Treeview.  

Loadcases may be re-ordered using drag and drop within each analysis entry - but only 

when no results files are loaded. Moving of loadcases should be done with care 

because if a single loadcase, that was defined outside of a range of loadcases, is moved 

in the Analyses  Treeview to a position within a range of loadcases its load factor 

will be retained in addition to any load factor already specified for the range of 

loadcases in which it now sits, and both load factors will be applied during an analysis. 

For any loadcase in the Analyses  Treeview that has (or inherits) a nonlinear or 

transient control, an analysis branch may be defined in order to carry out a sub-

analysis based upon parameters currently in use for that loadcase. Examples of use 

include carrying out a linear moving load analysis of construction equipment during 

each stage of the construction of a segmental bridge deck, or performing an eigen 

analysis at the end of each construction stage. Any number of sub-analyses may be 

defined for a single parent loadcase. For more details see Branched Analysis. 
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Loading variation with time 

For analyses in which the load varies with time (or increment number in the case of 

nonlinear analysis) load curves may be used. When using load curves all loads must 

be assigned to a load curve instead of a loadcase, but all other loadcase dependent 

attributes (support, slidelines etc.) and analysis control are assigned to loadcases in the 

usual way. For more information see Load Curves. 

Creating Loadcases / Loadcurves 

New loadcases/loadcurves may be added to the Analyses  Treeview in the 

following ways: 

 By selecting the Analyses> Loadcase menu item. 

 By right-clicking on the Structural analyses (or Thermal Analyses) folder or 

the analysis entry and selecting the New > Loadcase... menu item. 

 By entering a loadcase name when a load attribute is assigned to a feature on a 

model.  

 By copying and pasting existing loadcases in the Analyses  Treeview. 

Attribute dependency across loadcases 

 Within a linear analysis, and with the exception of loading, all attributes 

assigned to the first loadcase of an analysis will apply to any additional 

loadcases that follow in that analysis. 

 For nonlinear and transient analysis many attributes may be modified on a 

loadcase by loadcase basis as the analysis progresses. An attribute assigned in a 

loadcase will remain active until it is changed. This means a support assigned 

in the first loadcase will apply to all loadcases unless it is set free in a 

subsequent loadcase. 

Loadcases and supports 

 Supports defined for the first loadcase within a base analysis can be optionally 

inherited by all other analyses. 

  For a linear analysis, supports assigned to the first loadcase of the analysis will 

be used by all following loadcases within that analysis. Supports cannot be 

changed for different loadcases within a linear analysis. 

 For a nonlinear analysis, or a new time step of a transient problem, supports 

may only be reassigned on a new loadcase increment. All support assignments 

from previous increments or time steps which are not reassigned will remain 

unchanged. 
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Adding Gravity Loading to a Structural Loadcase 

Gravity loading can be defined automatically either as a property of an analysis or 

loadcase, or manually by use of a menu item on the Bridge menu, or by specifying a 

constant body force load. The latter two require assignment of the gravity attribute to 

the model 

 For an analysis entry in the Analyses  Treeview select Add Gravity from its 

context menu. This effectively sets gravity loading to be 'on' for all structural 

loadcases within that Analysis regardless of whether they previously had 

gravity loading added or not. For the special case of loadcases having nonlinear 

controls, gravity loading is only added to those loadcases defined with Manual 

incrementation and not to loadcases defined with Automatic incrementation 

because the latter inherit the properties of the preceding defined Manual 

increment.  

 By selecting the Automatically add gravity to this loadcase option on the 

dialog that is displayed when defining a new loadcase or when editing the 

properties of an existing loadcase. 

 By selecting the Gravity menu item from the context menu for an individual 

loadcase. 

No visualisation of gravity loading on the model is provided for gravity defined as a 

property of an analysis or a loadcase. However, the general loadcase icon will change 

to include a loading arrow symbol  to show that gravity is included for a particular 

loadcase.  

Gravity loading, like other loadings, cannot be inherited from a base or other analysis. 

Gravity loading is defined in accordance with the vertical axis direction that was 

specified either initially on the New Model dialog or subsequently on the Vertical Axis 

dialog accessed using the Utilities > Vertical Axis menu item.  

Analysis Control Parameters 

Analysis control parameters for certain analysis types are set as properties of a 

loadcase. If no control properties are defined, a linear elastic analysis is performed. 

Analysis control parameters can be set to change throughout an analysis by specifying 

separate loadcases using different control parameters. Note that settings made on 

loadcases prior to solving will not necessarily correspond to post-processing load 

increments/time steps due to the use of automatic load incrementation. Analysis 

controls can be set for the following analysis types:  

 Nonlinear and Transient Used to define control parameters for nonlinear, 

and/or transient (dynamic, thermal or consolidation) analyses. Settings must be 

specified on the first loadcase if they are to be respecified on a subsequent 
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loadcase. It is not possible to change between thermal and dynamic during the 

course of an analysis. 

 Eigenvalue Used to define natural frequency, eigenvalue buckling and stiffness 

analyses. Can be specified on any loadcase, but only once. 

 Fourier Used to define Fourier analyses. Must be used if Fourier elements have 

been used. Can only be specified on loadcase 1. 

Manipulating Loadcases 

General loadcase editing commands are available from the context menu that is 

activated by right-clicking on a loadcase the Analyses  Treeview. The following 

commands are available: 

 Set active Sets a loadcase active for viewing attributes assignments and results 

for the current window. 

 Loadcases to solve Select which loadcases to solve (if more than one are 

present) 

 Edit View and edit the defined loadcase information 

 Copy Copies the selected loadcase (including all defined loadcase controls for 

eigenvalue, fourier or nonlinear and transient analysis) in readiness for a paste. 

 Paste Duplicates the copied loadcase and adds it to the bottom of the relevant 

section in the Analyses  Treeview. 

 Rename Allow the loadcase title to be modified. Note that loadcases are 

tabulated and solved in the order listed within each analysis entry in the 

Analyses  Treeview. 

 Delete Attribute assignments must be deassigned before a loadcase can be 

deleted. At least one loadcase will always exist in the Treeview. 

 Close Results File closes the open results file for that loadcase. 

 Controls Set analysis control parameters for eigenvalue, fourier, and nonlinear 

and transient analyses.  

 Deassign Deassigns attributes from the loadcase, by choosing from a list of 

attribute types. Permits activation and deactivation of the loadcase. 

 Gravity Apply gravity as a property of the loadcase. See Adding Gravity to a 

Structural Loadcase for more information. 

Viewing the Assignments in a Loadcase 

Loadcase dependent attribute assignments such as supports or loading are displayed in 

the Analyses  Treeview under the loadcase to which they have been assigned. The 

geometry to which an attribute has been assigned may be selected by picking Select 

Assignments from the context menu for each attribute in the Analyses  Treeview. 
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The location or extent of an assigned attribute assignment may be visualised for an 

active loadcase by picking the Visualise Assignments from the context menu for that 

attribute in the Analyses  Treeview. 

Load Combinations or Envelopes  

Combinations and envelopes can be defined as part of the modelling process prior to 

carrying out an analysis, or as part of the post processing after carrying out an analysis. 

For more details see Combinations and Envelopes in the Viewing the Results 

section. 

Solving loadcases 

Loadcases are solved in the order in which they are listed within each analysis entry in 

the Analyses  Treeview.  

Setting and Changing the Active Loadcase 

Loadcase dependent attributes and results for a loadcase can only be visualised by 

setting that loadcase active. Each view window can have a different active loadcase 

specified. 

 The active loadcase is set within the Analyses  Treeview by selecting Set Active 

from the context menu for that loadcase. The active loadcase can also be changed by 

dragging and dropping a loadcase name into a view window. 

A loadcase icon changes from grey to coloured when the loadcase is set active.  

 When modelling, the active loadcase is denoted by a coloured loading icon .  

 When results are loaded the active loadcase is denoted by a coloured contoured 

results icon . 

Viewing Results for loadcases 

Results can be viewed for the active loadcase for the current window. See Visualising 

the Results for more details.  

Loadcases results may be manipulated using combinations and envelopes, fatigue 

loadcases and IMD loadcases 

Load Curves 

Load curves can be used to describe the variation of the loading in nonlinear, transient 

and Fourier analyses. For example, in a transient problem the loading changes with 

time, in a nonlinear problem the loading level varies with load increment and in a 

Fourier analysis the loading varies with angle. 
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Load curves are used to simplify the input of load data in situations where the 

variation of load is known with respect to a certain parameter. For example, to 

evaluate the dynamic response of a pipe to an increase of pressure over a given period, 

the load curve factor would consist of the variation of pressure with time. Or, in a 

transient thermal analysis, the environmental temperature loading on specific surfaces 

(say) of a dam may change with time. 

Creating Load Curve Entries 

New load curve entries can be added to an existing analysis entry in the Analyses  

Treeview in the following ways: 

 By creating a load curve from the Analyses> Load Curvemenu item. 

 By right-clicking on an analysis entry in the Analyses  Treeview and 

selecting the New Load Curve menu item. 

 By copying and pasting an existing load curve in the Analyses  Treeview. 

Defining Load Curves for Structural and Thermal analysis 

A load curve is defined either using a user-defined time vs factor curve, a standard 

sine, cosine or square wave curve, or a variation. 

 Time versus Factor Specify values for both in a table on the load curve dialog. 

 Sine, cosine, square wave  Input values for amplitude, frequency and phase 

angle must be defined along with activation and termination points. 

 Variation  A line interpolation variation may be defined from the Utilities> 

Variation> Line menu item. The dependent variable in the variation will 

represent time (or increment number) depending on the type of analysis. The 

value of the variation will be the factor by which to scale the values in the 

assigned loading attribute. Specifying a Termination time cuts-off the 

variation-generated load curve loading at that time. Specifying a Sampling 

increment samples along the time axis, and uses those values and the 

corresponding load curve factors to define the load curve output written to the 

Solver data file.  

For each of the above options: 

 Activation time Specify at what time along the defined load curve the 

corresponding value of loading for that time will be applied. 

 Scaling factor This scales the loading that is assigned using the defined load 

curve by factor specified. 

Load curves scale all loads assigned to them. Therefore, if loads have a different 

variation of load factor with time, several load curves should be used. 
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Load curve parameters 

Load curve parameters are illustrated in the following image. Note that in a transient 

or time based analysis the x-axis represents time. In a nonlinear analysis, the x-axis 

represents load increment. In a fourier analysis, the x-axis represents angle. Note that, 

for a standard curve, specifying a mean amplitude shifts the defined load curve in the 

y-axis direction. 

 

Defining Load Curves for Hygro-thermal analysis 

For a structural analysis, the value of the load curve at the end of the current load step 

is used to determine the magnitude of the load. For a transient hygro-thermal analysis 

this is not suitable and an energy equivalent load curve with a constant value during 

each time step should be used instead so that any step reduction would not decrease 

the accuracy of the equivalent heat. Similar considerations are valid for a load curve 

applied to environmental temperature, relative humidity and water vapour mass 

transfer coefficients. 
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For time steps t1 and t2 the heat provided by the experimental curve is equal to the area 

under the curve for the time interval considered. LUSAS assumes that the load has a 

constant magnitude during the time step, so the load curve that should be used in 

LUSAS needs to provide the same heat energy during the time step: 

 

Manipulating Load Curves 

General load curve editing commands are available from the context menu that is 

activated by right-clicking on a  load curve entry in the Analyses  Treeview. The 

following commands are available: 

 Copy Copies the selected load curve (including all defined load curve data) in 

readiness for a paste. 

 Paste Duplicates the copied load curve and adds it beneath any current load 

curves in the Analyses  Treeview. 

 Delete Deletes a load curve. Attribute assignments must be deassigned before a 

loadcase can be deleted. At least one loadcase will always exist in the 

Treeview. 

 Rename modifies the load curve name. 

 Edit changes previously entered load curve data. 

 

Assigning Loading to a Loadcurve 

After defining a load curve for an analysis, a load is assigned to a load curve instead of 

to a loadcase. All other loadcase dependent attributes (support, slidelines etc.) and 

analysis control are assigned to a loadcase. The analysis control assigned to each 

loadcase determines the time over which the load is applied. The magnitude of the 

applied load is computed from the time dependent function defined within each load 

curve. Any number of loadcases and load curves may be specified within a single 

analysis. Each load curve is assumed to begin at the start of the analysis (t=0). If the 

input values start from t=n the load curve is assumed to be zero when t<n. 

For selected hygro-thermal load types, if more both components of the specified load 

are non-zero, each component should be applied in a separate load case. See Hygro-

Thermal loads for more details. 

General Load Curve Notes 

 Load curves are only applicable to nonlinear, transient and Fourier analyses. 
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 When defining load curves for transient (or nonlinear) analyses the time in all 

load curves must be defined from the start of the analysis. 

 For Fourier analysis the load must only be applied over an angular range of 0 

to 360 degrees. 

 If the interpolation variable doesn't lie within that specified within the load 

curve a zero load factor will be applied. 

 Only line variations with distance type Actual can be used for defining load 

curves. 

 Time-based values are based upon currently set timescale units. 

Evaluating a Load Curve 

Load curves (and variations) may be viewed using the Graph Wizard. 

  

Case Study. Pressurisation of Two Tanks with Multiple Load 

Curves 

Two tanks are to be pressurised at different stages of a nonlinear dynamic analysis. 

This will be achieved using two different loadcases and two load curves to vary the 

loads individually. The following procedure outlines the steps required: 

1. Use the Analyses> Load Curve menu item to define two user-defined load 

curves which give the correct pressure variation with time. Note that the time is 

always from the start of the analysis. 

2. Use the Attributes> Loading> 

Structural menu item to define a face 

load attribute containing a unit 

pressure load. Note that the pressure 

value in the load definition will be 

multiplied by the load factor used on 

the load curve associated with it. 

3. Assign the face load to the features in 

the model, selecting the appropriate 

load curves for each tank. The 

accompanying diagram shows a 

schematic of the tanks under internal 

pressure with their corresponding force versus time graphs. 

4. To set the size and number of time steps right click on Loadcase 1 and choose 

Controls> from the context menu. Pick Nonlinear and Transient and on the 

dialog switch on the Time Domain option and choose Implicit Dynamics 
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from the combo. Set the initial time step and response time as required.  

Notes 

Supports should be assigned to the loadcase. If the support conditions are to be 

modified part way through the analysis the response time in the Nonlinear and 

Transient control should be set to terminate at the time the supports are to be modified 

and a second loadcase should be created to which the modified supports are assigned. 

A Nonlinear and Transient control should be then set on this loadcase which 

terminates at the end of the analysis or when a future support is to be modified. 
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Chapter 6 : 

Utilities 

  

Model Utilities 

Model utilities differ from model attributes in that they are not intended for assignment 

to the model geometry or mesh objects. A utility, however, may be used in the 

definition of model geometry or attributes, or to provide a particular functionality, 

such as to produce a graph or model report for example. Defining a utility generally 

creates an appropriate entry in the Utilities  Treeview. 

Utilities are added to the Utilities  Treeview in creation order, but can be re-ordered 

by using the Sort by name context menu item accessed from the Utilities tab. 

Details of the features and use of many of the utilities listed below are provided in 

other relevant chapters of the manual. Transformation utilities, for example, are 

described in Chapter 3: Geometry in the Moving, Copying and Sweeping Geometry 

section. The remainder are described in this chapter. 

The complete list of LUSAS utilities (accessed from the Utilities menu) is shown 

below. 

 Transformation - used in the process of moving, sweeping and copying of 

geometry. 

 Heat transfer - specification of thermal gap properties and radiation surfaces. 

 Variation- ways of varying attributes over features. 

 Reinforcement - defining line reinforcement and section reinforcement 

details for line beams 

 Reference Path - defines a route through the model that provides a concept of 

distance for positioning multiple varying sections or applying vehicle load 

patterns. 
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 Response Spectrum - defines either a user-defined or a codified response 

spectrum for use with an IMD loadcase. 

 Background Grids - grade the mesh pattern locally when irregular surface 

meshing. 

 Objects to drape - for use with modelling laminated composites. 

 Design Factors - assess the reserve strength capacity of a component or 

structure. 

 Graph Wizard - plot results on x,y graphs. 

 Graph Through 2D - slice a model and plot a graph based upon the 

intersection of the elements sliced.  

 Slice Resultants Beams/Shells (Analysis type 3D only) - creates beam 

equivalent forces and moments along a beam from a slice section. 

 Print  Results Wizard - printing of selected results to a tabular listing format 

or a file, or for inclusion in a model report. 

 User Defined Results - create results components from user-defined 

expressions. 

 Bridge Design - define girder material, composite design member details, or 

transverse stiffener properties for bridge design use. 

 Prestress - define tendon properties and tendon profiles for prestress 

loading. This option is only present for LUSAS Bridge and LUSAS Civil & 

Structural software only. 

 Layout Grid - used to define a regular or specified set of construction grid 

lines to aid with defining geometric model features. 

 Notes - Plain text notes relating to a model can be written and saved for 

inclusion in a report. 

 Reporting - view a one-click report summary, or build a new model report 

containing chapters of model and results data. 

 

The 'Heat transfer' and 'Objects to drape' menu items are only listed if an appropriate 

license is in use. 

Copying utilities between models 

Utilities can be transferred between models. See Transferring Data Between 

Models. 

file:///C:/SVN/Content/Design/Steel_Composite_Bridge_Design/scbd_girder_material.htm
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file:///C:/SVN/Content/Design/Steel_Composite_Bridge_Design/scbd_transverse_stiffener.htm
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file:///C:/SVN/Content/dlgbrgprestress/Defining_tendon_profiles.htm
file:///C:/SVN/Content/Bridge/Prestress_Loading/Prestress_Loading.htm
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Utilities symbols explained 

See "Treeview Panels and Icons" on page 22 for details of all symbols used in the 

Utilities  Treeview. 

Variations 

Variations allow parameters in attributes to be varied over the assigned geometry by 

defining the manner in which the parameter will vary. They are defined using the 

Utilities > Variations menu item, and are saved in the Utilities  Treeview. Once 

defined, a variation is used by clicking on the additional input button  in the 

appropriate edit box on the attribute dialogs. This allows each parameter within a 

single attribute to be varied independently. 

Variations can also be defined from inside dialogs that support the use of the 

variations facility by selecting the New... entry on the drop-down list displayed for the 

Select a Variation Attribute dialog. 

Note that geometric section property variations along a beam are best defined using 

tapering or multiple varying section facilities. See Geometric Properties and 

Multiple Varying Sections - Types and methods of assignment for more details. 

Load curves can be used to describe the variation of loading in nonlinear, transient 

and Fourier analyses. For example, in a transient problem the loading changes with 

time, in a nonlinear problem the loading level varies with load increment and in a 

Fourier analysis the loading varies with angle. 

Variation types 

 General Field variations are defined in terms of the global Cartesian 

coordinate system variables. This form of variation can be used for hydrostatic 

and wind loading and is applicable to all feature types including Points (if 

global coordinates are used). Variations on volumes are limited to field 

variations. 

 Line variations take two forms: interpolation variations and function variations. 

The former are defined by interpolating between values at specified local 

distances. The order of the interpolation may be specified as constant, linear, 

quadratic and smoothed (cubic) in either actual (local) or parametric distance. 

Function variations are expressed as symbolic functions in terms of the 

parametric coordinates of a feature. Line variations can be applied to any Lines 

including lines forming the boundaries of Surfaces. 

 Surface Function variations are expressed as symbolic functions in terms of 

the parametric coordinates of a feature. The distances to be specified are the 

local parametric u and v coordinates. 

 Surface Boundary defines values by specifying variations around the Surface 

boundary Lines.  

file:///C:/SVN/Content/5utils/idh_varying_attributes_over_features.htm
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 Surface Grid defines a grid of values in Surface local x and y directions.  

 Profile defines variations that allow modelling of the variation of (typically) 

material properties at any location in a model. Normally used with soil 

modelling. 

 

General Field Variations 

Field variations allow a variation according to a mathematical expression in terms of 

coordinate variables in either the global Cartesian or a specified local coordinate. 

Coordinates may be Cartesian, cylindrical or spherical. The expression may be cutoff 

if desired. 

Field variations are applicable to all Lines, Surfaces and Volumes. The value of the 

variation at any position on the structure will be calculated by substituting the values 

of the coordinate variables at that position. 

A field variation is defined by specifying a field expression and an optional local 

coordinate which will be used to specify a coordinate system other than the global 

Cartesian set. 

These examples show field variations 

expressed in terms of the global X 

coordinate displayed along a Line 

parallel to the global X axis. The typical 

field expressions used are shown in the 

boxes next to each diagram. 

For example, a field expression in 

Cartesian coordinates would typically 

be: 

-9.81*y 

and in cylindrical coordinates: 

10+r*tan(thetaz) 
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Coordinate Systems in Field Variations 

The functions available in the 

definition of field expressions are 

listed below. The variables used in 

field expressions are limited to those 

used in the LPI language plus the 

Cartesian, cylindrical and spherical 

coordinate variable names. The 

coordinate variable names that 

should be used in a field expression 

are dependent on the type of 

coordinate systems in use. 

Definitions are given in the tables 

below.  

In this example, a field expression referring to the global axis coordinates (XY), is also 

used with a local coordinate axis set (indicated by xy) to create a variation relative to a 

rotated system. Cylindrical and spherical axis sets can also be used. 

Variables 

Cartesian (global/local) Z Cylindrical (local) Z Spherical (local) 

x X ordinate r Radial distance r Radial 
distance 

y Y ordinate thetaz Angle about axis of 
cylinder 

thetaz Angle about z 
axis 

z Z ordinate z Distance along 
cylinder 
longitudinal axis 

thetac Second angle 

Operators 

+  -  *  /  ^ 
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Functions 

Trigonometric functions Radians Degrees 

Sine of angle sin(angle) sind(angle) 

Cosine of angle cos(angle) cosd(angle) 

Tangent of angle tan(angle) tand(angle) 

Arcsine of a asin(a) asind(a) 

Arccosine of a acos(a) acosd(a) 

Arctangent of a atan(a) atand(a) 

Arctangent of the specified x- 
and y-coordinates. 

atan2(x,y)   

hyperbolic sine of a sinh(a)   

hyperbolic cosine of a cosh(a)   

hyperbolic tangent of a tanh(a)   

  

Function return value   

e raised to the power of a. The constant e equals 2.71828182845904, the base of 
the natural logarithm. 

exp(a) 

natural logarithm of a  log(a) 

logarithm of a to base 10 log10(a) 

square root of a sqrt(a) 

a rounded up, away from zero, to the nearest integer ceil(a) 

a rounded down, towards zero, to the nearest integer floor(a) 

absolute value of a  abs(a) 

maximum value of a and b max(a,b) 

minimum value of a and b min(a,b) 

x to power y pow(x,y) 

remainder of a/b mod(a,b) 

  

Cylindrical and spherical field variation expressions can use radians (default) or 

degrees to specify angles. If trigonometric functions are used in a field expression, 

they will dictate what angular measure is used. For example, a function will use 

degrees if degree-based trigonometric functions, such as sind, cosd and tand are used.  

Notes 

 An expression may not mix radian and degree functions.  
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 Any angle cut-off values will use the same units as the expression. 

Maximum and Minimum Cut-Off Values 

Maximum and minimum cut-off values may be specified for the chosen coordinate 

system. This allows the range of application of load to be limited, such as would be 

necessary to model a structure not wholly submerged in water. These examples (right) 

show field variations in terms of the global X ordinate displayed along a Line parallel 

to the global X axis. The typical field expressions used are shown in the boxes next to 

each diagram. All expressions are subject to a cut-off in minimum and maximum X at 

parametric distances of 0.25 and 0.75 respectively. 

This example shows a variation in 

terms of the global Z axis ordinate 

with minimum and maximum cut-

offs at specified Z ordinate values. 
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Case Study. Applying Hydrostatic Loading 

A hydrostatic loading may be modelled using a combination of a field variation and a 

Structural Face Loading. The loading can be considered to be dependent on the depth 

varying as: water density*g*(h-y) where g is the acceleration due to gravity, h is the 

height of the water above the structure origin and y is the height of the structure. Use 

the following procedure: 

1. Define a simple 100 unit square Surface 

using the Geometry> Surface> By 

Coordinates menu item and entering the 

following coordinates (0,0,0), (100,0,0), 

(100,100,0) and (0,100,0).  

2. Define a simple thin shell mesh using the 

Attributes> Mesh> Surface menu item 

and Assign the mesh to the Surface. 

3. Define a field variation using the Utilities> 

Variation> Field menu item and specify a 

function of density*g*(h-y), where density 

is the water density (1000), g is 

acceleration due to gravity (9.81), h is the maximum height of the water above 

the structure origin (80) and y is the global Cartesian y ordinate. This will 

apply a hydrostatic loading down the depth of the Surface (global y axis). Enter 

1000*9.81*(80-y) on the dialog.  

4. To model a water depth of 80 (and to avoid negative loading above the surface 

of the water), select a Cut-off in Maximum y at 80. Click on the Advanced 

button and set the maximum second coordinate to 80. Click the OK button. 

5. Name the variation Hydrostatic variation. Click the OK button. 

6. Using Attributes> Loading> Structural menu item, define a Local 

Distributed load entering the Z component as 1, notice that in doing so the 

additional input button  appears. Click on the button and select the variation 

Hydrostatic variation. This will factor a negative unit load using the variation 

defined in 1. Type Water load as the attribute title. Click the OK button. 

Assign the loading to the Surface. 

7. The applied loading with the variation is visualised as arrows on the model. 

Use dynamic rotate  to get a 3D view of the surface. If the load is not 

visualised, select the load attribute in the Treeview , right-click and choose 

Visualise from the context menu. Note. Visualising attribute assignment 

requires that the model is meshed. 
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Line Variations 

Line Interpolation options 

Line interpolation variations allow values to be varied along a line at any number of 

distances. The distances may be equally or unequally spaced and the interpolation 

order may be constant, line, quadratic or smoothed (cubic). Line interpolation 

variations are defined from the Utilities> Variations> Line menu item and selecting 

Type Interpolation. 

 By Equal Distances defines values at equal distances along a Line. The actual 

value used will be interpolated at the appropriate distance between these values 

using the interpolation method specified. 

 

 By Unequal Distances defines values at specified distances along a Line. The 

distances can be entered as actual or parametric values. The actual value used 

will be interpolated at the appropriate distance between these values using the 

interpolation method specified. 

The unequal distance examples below show user distances specified by actual 

or parametric values (indicated in square brackets) with a corresponding 

interpolation value at each position. Repeating a distance and specifying an 

additional associated interpolation value will allow a discontinuity in the 

variation to be defined.  
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Linear variations require a minimum of two values. Quadratic variations 

require a minimum of three values and Smoothed (cubic) variations require a 

minimum of four values to be specified. Where more values are specified 

multiple interpolation functions are used. i.e. if three values are specified for a 

linear variation, two straight line interpolations are used. 

Line Function Variations 

A Line function variation defines a variation by a series of functions specified at 

distances along a Line. The function is specified in terms of the parametric or actual 

coordinate along the Line. The interpolated value of the variation at any position along 

the Line is calculated by finding the interval in which the position occurs and then 

substituting the parametric or local distance into the function. Line function variations 

are defined from the Utilities> Variations> Line menu item and selecting Type 

Function. 

  

 By Equal Distances [in u] 
defines functions in terms of 

u, the parametric distance 

along the Line. In this 

example, the Line is split into a specified number of distances, each with an 

associated function. 

 By Unequal Distances [in u] 
defines a series of parametric 

or actual distances, and a set 

of functions. The distance specified is the starting position for the function 
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associated with it. Each distance must have an associated function specified. 

To enter a maximum cut-off position, associate a zero function with it. In this 

example, a parametric distance of 0 is associated with the value 0.0, a 

parametric distance of 0.33 is associated with u**2 and a parametric distance 

of 0.92 is associated with the value 2.0 

Surface Function Variations 

A Surface function variation consists of a 

single function in terms of the parametric 

coordinates of the Surface u and v. The 

value of the variation at any point on the 

Surface is given by finding the parametric 

coordinates of the point within the 

Surface and substituting them into the 

specified function. Surface function 

variations are only allowed for 3 and 4 

sided Surfaces. 

The example shown here defines a 

variation using the function max(4,10*u) in terms of the local Surface x direction 

parametric distance. The max function takes two arguments and returns the maximum 

of both arguments. In this case, 4 is the maximum value until u exceeds 0.4. 

Surface Boundary Variations 

These define values by specifying variations around the Surface boundary Lines. A 

variation must be specified for each Line in the Surface definition. If no variation is 

required along a Line, a constant order variation must be specified. Care must be taken 

to ensure that values at common points are common to both variations meeting at that 

point otherwise an error will occur. Surface boundary variations are affected by 

individual Line directions, so care should be taken to ensure line direction are 

appropriate. See example that follows. 

A discontinuous Line interpolation (1) is 

specified for first and third Lines using a 

Line by unequal distance variation. 

 

Note that the Line axes drawn here 

dictate the variation directions and the 

line directions on opposite sides of a 

surface must match as shown. Variations 

are applied in a positive surface normal 

direction. 

The second and fourth Lines in the Surface definition use constant interpolation 

variations. The variation sense is denoted by double and single arrows shown on 

boundary Lines. The variation along the local x axis (signified by the double arrow) is 
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specified first. The Surface variation in this case is 1;3;1;2. 

Surface Grid Variations 

These define a grid of values in Surface local x and y directions. For interpolation by 

grid the interpolation order may be constant, linear, quadratic or smoothed (cubic). 

Surface grid interpolation can only be used on 3 and 4 sided Surfaces.  

 Quadratic vs Constant Surface 

variation 

The quadratic variation in the 

local x direction is specified with 

three interpolation points. The 

constant variation in the local y 

direction requires no additional 

points. A total of three values are 

required. 

 Smoothed (Cubic) vs. Linear 

Surface grid variation 

The local x direction takes a 

smoothed (cubic) variation 

defined with four interpolation 

points and the local y direction 

takes a linear variation using three 

interpolation points. A total of 

twelve values are required. 

Profile Variations 

Profile variations allows modelling of the variation of (primarily, but not exclusively) 

material properties at any location in a model. A single profile variation is defined by 

distance against value, however, any number of profiles in-plane or out-of-plane may 

be grouped to form a profile set variation. When used to define particular material 

properties in a supported material model, material properties for elements in any 

region of a model can be calculated by LUSAS Modeller by interpolating between the 

distance and values defined for each element between each profile variation location. 

A typical use is modelling the variation of soil properties with depth, as obtained by 

borehole data. 

A profile variation is defined by entering value against distance data that describes the 

profile. 
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 For a 2D analysis category any number of profiles can be specified together 

with the x,y coordinates for each profile origin, the z coordinate is not shown 

and defaults to zero.  

 For a 3D analysis category x,y, and z coordinates must be specified for each 

profile origin. The same profile variation may be used any number of times in 

the profile set definition but no profiles can have the same origin. 

Once referenced by an assigned material, profile variations may be visualised. 

Contouring of materials using profile set variations is done on an element node basis. 

Materials not using profile set variations are contoured on an element basis. 

Note that profile variations cannot be used with temperature dependent materials. 

Profile variation types and calculations made 

When used to define particular material properties in a supported material model, 

material properties for elements in any region of a model are calculated by LUSAS 

Modeller by interpolating between the distance and values defined for each element 

between each profile variation location. The following images show how properties 

are calculated with respect to the profile variation types shown. 

  

Single profile variation  
(Variation with depth only) 

  

In-plane set of two (or more) profile variations 
 (Variation with depth interpolated in-plane only) 
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In-plane set of profile variations in a 3D model  
(Variation with depth is only interpolated in the plane 

of the profile set) 

Additional profiles are automatically generated out-

of-plane to edge of model. (Variation with depth is 

constant in this out-of-plane direction.) 

Out-of-plane set of profile variations in a 

3D model  
(Variation with depth is interpolated in 3 dimensions) 

Plotting Graphs of Line & Field Variations 

Line and Field variations can be 

evaluated along a specified Line and 

displayed using the Graph Wizard from 

the Utilities menu and Line variations 

can be evaluated alone. The number of 

points at which to sample the variation 

can be specified. A factor may be applied 

to the variation values before the 

ordinates are calculated. This example 

demonstrates the graphical visualisation 

of a discontinuous Line interpolation 

variation. 

Variation Notes 

 If a variation is not specified, the parameters within an attribute will be constant 

over the geometry to which the attribute is assigned.  

 Global coordinates can be used for any LUSAS feature/object (points, lines, 

nodes etc). Local coordinates can be used for all LUSAS features/objects 

except points. 

 It is possible to vary all load types except General Point and Patch loads and 

Internal Beam Point and Internal Beam Distributed loads, which incorporate 

variable loading implicitly in their definition. Values of loads which are applied 

to elements will be evaluated at the element centroid.  
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 Geometric attributes containing a variation are tabulated as multiple geometric 

properties. An additional parameter is added to the assignment to relate to the 

original defining attribute number for use in post-processing. 

 To vary geometric properties along bar or beam elements use the geometric 

beam tapering facility.  

 Variations in materials are limited to elastic material values and certain joint 

properties. Attributes containing a variation are tabulated as multiple material 

properties containing the material value calculated at the element centroid. An 

additional parameter is tabulated to the assignment data chapter in the data file 

to relate to the original defining attribute number for use in post-processing.  

 When defining supports the spring stiffness values can be varied but the spring 

stiffness values are not scaled when drawn in post-processing . 

 Checking of the assigned variations can be carried out by contouring the 

assigned data using an unsmoothed contour display. 

 Variations of the Rayleigh parameters cannot be contoured as they are 

calculated at element centroid positions. 

 On Surfaces, interpolation may be defined using a grid of values or a set of line 

variations applied to the boundary Lines. For interpolation by grid the 

interpolation order may be constant, linear, quadratic or smoothed (cubic). 

Section reinforcement 

Section reinforcement defines the bar arrangements to be provided in a member's 

cross-section. Section reinforcement is a utility object stored as an entry in the Utilities 

 Treeview and cannot be assigned to lines in the model directly. Section 

reinforcement utilities are referenced by line reinforcement utilities (that define the 

length over which each section reinforcement utility acts along a line representing a 

reinforced concrete member.) 

The section reinforcement dialog can be accessed from a reinforcement line dialog (by 

selecting the 'New' option in the reinforcement section droplist) or by using the 

Utilities > Reinforcement > Section menu item. Section reinforcement can be defined 

for any standard or arbitrary shape, with or without voids. Tapering members are also 

supported. 

Section reinforcement is available for use with selected Bridge and Civil software 

products only, and for licences that support RC frame design. A model analysis 

category of 3D must also be in use. 

file:///C:/SVN/Content/Design/RC_Frame_Design/rc_frame_design.htm
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Defining section reinforcement 

The section reinforcement dialog comprises three tabbed pages that are used to define 

the reinforcement arrangements for a concrete member's cross-section. This requires 

stating the concrete faces to be reinforced, the cover and allowance for links, and the 

layers and positions of reinforcing bars.  

 Shape outline from A predefined geometric line attribute can be selected to 

assist in the definition of section reinforcement. The coordinates of the lines 

defining the section shape of the geometric line attribute are used to 

automatically determine and number the faces of the beam cross-section. Faces 

are always numbered anti-clockwise on the visualised section. Layers of 

reinforcement are defined with reference to each numbered face. Additional 

bars are defined with respect to the beam axis. 

  

 

The section shape that is referenced as a shape outline for section 

reinforcement arrangement purposes must always be available from the 

server or local section library in which it was saved.  



  Chapter 5 : Model Attributes 

    

541 

Notes 

 In specifying a shape outline, the chosen geometric line attribute is not 

explicitly connected to the reinforcement section, it merely provides a visual 

reference for the face numbering in use and reinforcement arrangement being 

defined for that section type. This means that a section reinforcement 

arrangement for one section shape may also be applied to other geometric 

attributes of a similar shape. For example, section reinforcement could be 

defined for a beam that is 400mm x 400mm and also be used to reinforce other 

sections of a similar shape, such as 400mm x 600mm, or 300mm x 600mm, by 

including the appropriate line reinforcement utility in unique geometric line 

attributes. This also makes the system effective / efficient for tapering sections. 

 Deleting a geometric line attribute from the Attributes Treeview that is 

referenced by the section reinforcement utility will not make the section utility 

invalid. However, no visualisation of the section type on the dialog is possible 

until a geometric line attribute is selected again from the 'Shape outline from' 

droplist.  

 In all cases covers, distances, bar diameters, and spacings are to be stated in 

model units. 

Visualising section reinforcement 

A section formed from the shape outline selected and the reinforcement as it is defined 

is shown on the dialog. Section reinforcement can be inspected by zooming and 

panning the visualised section. A changing cursor image indicates whether the facility 

is enabled or not. If necessary, click in the panel to activate this facility. Use the mouse 

wheel to zoom in and out. Click and hold-down the left mouse button, or click and 

hold-down the mouse wheel to pan. 

Reinforcement terms used 

The following image explains the main terms used on the section reinforcement 

dialog: 
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Reinforcement terms used 

Face data 

 

Defining face, cover and link data for a member 

For all, or individual faces of the section, the actual and nominal covers, and 

allowance for links must be stated. 
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 Face When a shape outline has been specified, the default entry for Face is 

'All', meaning that all faces will be assigned the settings made on the row. 

However, additional rows may be added and by entering a face number 

different covers on different faces can be stated. Cover and link allowance 

settings on those referenced faces will override the settings made for 'All' on 

those faces. 

 Actual cover to link Define the distance from the face to the outside fibre of 

the link. 

 Nominal cover to bars If 'Actual' is entered, the nominal cover will be 

calculated automatically from 'Actual cover to link' + 'Allowance for link'. 

Alternatively, a user-defined value may be entered. The value entered is used in  

 Allowance for link Define the bar diameter of the link for positioning of 

longitudinal reinforcement. Shear and torsion checks are not included. 

The leg(s) of a link in a selected row is drawn in blue in the section visualisation on 

the dialog, otherwise all legs of a links are drawn in black. Layers of reinforcement 

bars are not drawn in this page. 

Table related buttons 

 Add and Delete buttons add or remove rows from the table.  

 

Layers of rebar 

 

Defining main section reinforcement for four faces of a member 
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Overview 

Layers of reinforcement are defined by entering a row of data for a numbered face. 

Faces forming the perimeter of a solid section are numbered anti-clockwise. Faces 

forming the perimeter of voids within a section are numbered clockwise. References to 

'Start' and 'End' with regard to bar diameters and distances stated in the grid relate to 

the start and end of a face. For example face 2 starts at the end of face 1, and ends at 

the start of face 3.Note that bar diameters and distances must be defined in model 

units. 

Bars are spaced equally in a layer with respect to a specified face. Where end bars in 

layers in different faces clash (as in the preceding example), the end bars from selected 

faces (the side faces in the preceding example) may be omitted by making the 

appropriate selection on the dialog. 

Multiple rows of data in the table can be used to position bars in a specified face, 

enabling the definition of more dense or sparse reinforcement within a layer for a face, 

as shown on the following image. 

 

Defining additional reinforcement in a specified region of a face for a box section 

F a c e  d ire c t io n

S ta rt  d is ta n c e

0 .7 6

E n d  d is ta n c e

3 .0 2

4  N o .

3 2  d ia  b a rs
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 Layers of rebar terms 

See Reinforcement terms used for further explanation of the following options. 

 Face The number of the face for which the layer reinforcement is being 

defined. 

 Layer The layer number for the reinforcement. Layer 1 is the layer nearest the 

face. Multiple layers can be defined for a face with layers separated by a Gap 

(see below).  

 No. of Bars The number of bars to be included in this layer / row. 

 Gap The distance between the outermost fibre of this layer of rebar and the 

innermost fibre of the previous layer on the same face 

 Bar diameter The diameter of bars in this layer / row of data entered in model 

units. 

 Alternate bars The diameter of every alternate bar in this layer / row. If the 

option Same dia is selected all bars are the size defined by ‘Bar diameter’. A 

user-defined bar diameter may be input instead.  

 End bars Defines the diameter of the outermost (end) bars in this layer / row. 

If the option Same dia is selected the end bars are the size defined by ‘Bar 

diameter’. A user-defined bar diameter may be input instead. Defining bars in a 

layer for one face typically results in the corner bars at each end of a set or run 

of bars coinciding with the corner bars in a layer in another face. In such cases 

select Omit both from the droplist to remove the unwanted bars at both ends of 

one layer / row (as shown in for Faces 2 and 4 in the preceding image), or Omit 

start to remove one bar at the start of a run, or Omit end to remove one bar at 

the end of run of bars for the layer / row, as appropriate. The previously 

calculated and visualised spacing of the other bars in the face being edited will 

not change. 

 Start distance Defines the location of the outermost (starting) bar in this layer / 

row. If 'Auto' is selected the starting bar of the layer / row will be placed 

automatically to sit tight to the adjacent leg(s) of the link. If a value is entered 

by over-typing in this cell, for orthogonal faces the centreline of the bar will be 

placed at the stated distance from the adjacent face. In non-orthogonal faces the 

centreline of the bar will be placed at the stated distance from the intersection 

of the two adjacent faces. 

 End distance Defines the location of the outermost (ending) bar in a layer. If 

'Auto' is selected the ending bar of the layer will be placed automatically to sit 

tight to the adjacent leg(s) of the link. If a value is entered by over-typing in 

this cell, for orthogonal faces the centreline of the bar will be placed at the 

stated distance from the adjacent face. In non-orthogonal faces the centreline of 

the bar will be placed at the stated distance from the intersection of the two 

adjacent faces. 
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The leg of a link in a selected row is drawn in blue in the section visualisation on the 

dialog, otherwise all legs of a links are drawn in black. Any additional bars are drawn 

in grey. Bars that clash with other bars, or that are positioned outside the section are 

drawn in red. 

Note that whilst bars may be omitted at one end, the remaining bar at the other end 

cannot currently be specified with a different diameter and will inherit the bar diameter 

from the Bar diameter column. 

Table related buttons 

 Convert row to additional bars Deletes the currently selected row in the grid, 

inserting new rows in the grid of the 'Additional bars' page for each bar 

containing the appropriate data. 

 Sort Sorts the grid rows by face and then layer 

 Add and Delete buttons add or remove rows from the table. 

 

Additional bars 

 

Defining additional bars in a face/layer 

Additional bars may be added to a reinforcement arrangement. They are defined by a 

coordinate defining the centre of the bar with respect to the beam axis. Unlike bars 

defined on the 'Layers of rebar' tab, additional bars are not defined with respect to a 

specified face. 

The local axes of the section are shown at its centroid. The magenta filled circle 

represents the location of the nodal line about which the section will be positioned 

when the section is assigned to a line on the model. 
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 y Defines the y location of the bar relative to the axis shown in the visualisation 

of the section shape. 

 z Defines the z location of the bar relative to the axis shown in the visualisation 

of the section shape. 

 Diameter The diameter of the additional bar. 

 Nominal cover to bars If 'Actual' is entered, the nominal cover will be 

calculated automatically from 'Actual cover to link' + 'Allowance for link' (as 

stated on the 'Face Data' page.) Alternatively, a user-defined value may be 

entered.  

 Spacing Selecting 'Auto' will cause bar spacings for crack width calculation 

checks to be based on the nearest bar. A user-defined value may optionally be 

entered, and if done, is used for the crack width calculation for that bar location 

only. 

For a selected row, a bar is drawn in blue in the section visualisation on the dialog, 

otherwise all other bars are drawn in black. Bars that clash with other bars, or that are 

placed outside the section, are drawn in red. Other reinforcement (defined on Faces 

data and Layers of rebar tabs) is drawn in grey. 

Table related buttons 

 Add and Delete buttons add or remove rows from the table. 

 

Bar positioning, spacing and crack width calculation 

By default the positioning of end bars in a layer assumes a zero internal radius for a 

link, with the bars being fitted tight to the link. For many purposes, the effect of a 

difference in actual to modelled end bar position will be negligible in comparison to 

other assumptions inherent in the analysis and design process,. However, manual 

positioning of end bars can be done by omitting the end bars on the 'Layers of rebar' 

tab, and using the 'Additional bars' tab to manually place end bars in a desired 

location.  

Bar spacing used for determination of crack widths is calculated by considering each 

bar in the section. The presence of any bundled bars is identified initially, with an 

appropriate equivalent diameter and location based upon the centre of area of the 

bundle being calculated. Then, for each bar in the section, the spacing used for crack 

width calculation is arrived at by considering the distance to the closest bar measured 

parallel to the concrete face, discounting bars in a 45 degree cone 'behind' the bar in 

question. Two nearest faces are considered in order to evaluate values for corner bars 

reasonably. If more control over the spacing assumed for the determination of crack 

widths is required, the 'Additional bars' tab allows user input of the value, bar by bar. 

Individual layers of rebar may be converted to 'Additional bars'. 
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Editing section reinforcement details 

Changes can be made to section (and line) reinforcement details without requiring a 

model to be re-solved. However, for each change made, design checks are 

automatically re-computed to show the effects of making the change. If this is not 

required, turn-off the display of any results-based layers (contours, values, diagrams or 

deformed mesh) in the Layers Treeview prior to making any changes. 

Copying reinforcement details between models 

Section reinforcement details can be transferred between models. See Transferring 

Data Between Models. 

Line reinforcement 

Line reinforcement is referenced by geometric line beam attributes (that define the 

concrete section size/shape and properties for a member). Line reinforcement is used 

to specify how individual section reinforcement arrangements apply over a length of 

a line or lines representing a concrete member. Line reinforcement is a utility object 

stored as an entry in the Utilities  Treeview and cannot be assigned to lines in the 

model directly.  

The line reinforcement dialog can be accessed from a geometric line attribute dialog 

(by selecting the 'New' option in the reinforcement panel), or by using the Utilities > 

Reinforcement > Line menu item.  

Line reinforcement is available for use with selected Bridge and Civil software 

products only, and for licences that support RC frame design. A model analysis 

category of 3D must also be in use. 

file:///C:/SVN/Content/Design/RC_Frame_Design/rc_frame_design.htm
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Defining line reinforcement 

 In the line reinforcement table the reinforcement sections and the length over which 

each reinforcement section applies are stated. 

 Reinforcement section Clicking on the launch dialog button  in the this cell 

lists any previously define section reinforcement utilities for selection. A New 

button allows new section reinforcement arrangements to be defined. 

 Allowed to stretch/ Length When more than one reinforcement section is 

included, the length over which each section applies must be stated in the 

Length column. The remaining section will be defined as Allowed to stretch 

to signify that this reinforcement section arrangement will apply over the 

remaining length of line to which it is assigned. 

As each row is added or edited, a schematic diagram beneath the table will update to 

show the revised arrangement. Any number of section reinforcement arrangements 

may be included to form a line reinforcement utility. 
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Table related buttons 

 Edit, Insert and Delete buttons provide the means to edit reinforcement 

sections, create new rows above a selected row, and to delete rows from the 

table.  

 Move up and Move down buttons allows re-ordering of a selected row within 

the table. 

Usage 

Once defined, line reinforcement utilities are added to the Utilities  Treeview. They 

cannot be directly assigned to lines in a model. They are assigned to the model as a 

function of assigning the geometric line beam attribute in which they are referenced. 

When assigning to single or multiple selected lines the following options are provided: 

 Consider selection as a single assignment The line reinforcement details will 

start and end at the start and end of the line or set of lines selected. For a set of 

lines the line direction of each line must be the same. 

 Consider each selected item individually The line reinforcement details will 

start at the start of each selected line, and end at the end of each selected line. as 

dictated by the line directions. 

 

Editing line reinforcement details 

Changes can be made to line (and section) reinforcement details without requiring a 

model to be re-solved. However, for each change made, design checks are 

automatically re-computed to show the effects of making the change. If this is not 

required, turn-off the display of any results-based layers (contours, values, diagrams or 

deformed mesh) in the Layers Treeview prior to making any changes. 

Examples of line reinforcement assignments 
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Note that it also possible to select separate sets of continuous lines (for example three 

sets of lines with three lines in each set) and assign a line reinforcement attribute to all 

at the same time using the 'Consider as a single assignment' option.  

Example of 'Consider selection as a single assignment' 

Three section reinforcement utilities are defined, assembled and assigned to a set of 

lines representing a bridge deck. 
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Copying between models 

Line reinforcement details can be transferred between models. See Transferring Data 

Between Models. 

Response Spectrum Types (for IMD loadcase use) 

 User-defined response spectrum data 

 Design code response spectrum data 

Response Spectrum - User-defined (for IMD loadcase use) 

Response spectrum data for use with IMD loadcases is defined by selecting the 

Utilities > Response Spectrum menu item. 

Response Spectrum datasets are referenced from IMD loadcases when calculating 

spectral response. 

 Frequency / Period versus Displacement / Velocity / Acceleration / Gravity 

The value of the frequency used in spectral calculations is interpolated from the 

frequency-amplitude or period-amplitude values defined. The type of values 

entered, i.e. displacement, velocity, acceleration or acceleration/gravity should 

match the type of support motion which is used to excite the structure. 

 Spectral curve damping Defines the damping inherent in the response 

spectrum. A default value is 0% is initially set. 

Notes 

 More copious Response Spectrum tables are more easily defined using a 

command file, or by copying and pasting the data from a text file or 

spreadsheet. Command files can be used to store a library of frequently used 

Response Spectrum datasets. 

 Defined Response Spectrum datasets are stored in, and may be edited from, the 

Utilities treeview. 

Response Spectrum - Code Based (for IMD loadcase use) 

Design code response spectrum data for use with IMD loadcases is defined by 

selecting the general Utilities > Response Spectra menu item. The following codes of 

practice are currently supported: 

 ASCE 7-10 (2010) 

 ATC-40 (1996) 

 China GB 50011-2010 

 EN1998-1:2004 Design (Horizontal) 

file:///C:/SVN/Content/dlg7res/idd_response_spectra_asce_7_10_2010.htm
file:///C:/SVN/Content/dlg7res/idd_response_spectra_atc_40.htm
file:///C:/SVN/Content/dlg7res/idd_response_spectra_china_GB_50011_2010%20.htm
file:///C:/SVN/Content/dlg7res/idd_response_spectra_en_1998_1_2004_design.htm
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 EN1998-1:2004 Elastic (Horizontal) 

 FEMA 356 (2000) 

 

Click a design code to view dialog help for that code. 

  

Note: When defining a design code-based response spectrum for an IMD loadcase the 

following options (not documented in the above links) are additionally available on the 

dialog shown. 

Curve definition 

 Incremental period Enter the increment in period of vibration, in seconds, 

used in the creation of the response spectrum curve (Default = 0.2s). The 

incremental period cannot be greater than the maximum period. 

 Maximum period Enter the maximum period of vibration, in seconds, used in 

the creation of the response spectrum curve (Default = 6.0s). 

Show graph 

Displays a graph based upon the defined design code data. 

  

Reference paths 

A reference path defines the direction of a single line, or route that a series of lines 

take in a model that can be used to provide a concept of distance to other points in a 

model. Reference paths are currently used for the following aspects of modelling, 

analysis and results processing: 

 Modelling of multiple varying sections For line beam models, and grid or 

grillage models where longitudinal and transverse beams are modelled with 

individual grillage or line beam elements a reference path can be used in the 

definition of a varying section, such that when the section is assigned to a set or 

series of lines, the path is used to interpret which part of the defined varying 

section is appropriate to each line. 

 Direct Method Influence Attributes Reference paths can be optionally used 

in the definition of a direct method influence attribute (where for grillages they 

aid in the calculation of influences for longitudinal and transverse members), 

and also in the definition of a loading grid that can be used as an alternative to 

using the nodes or points present in the model for an influence analysis.  

 Results Transformation Specification of a reference path provides an easy 

way of transforming results relative to the angle or route of the defined path. 

file:///C:/SVN/Content/dlg7res/idd_response_spectra_en_1998_1_2004_elastic.htm
file:///C:/SVN/Content/dlg7res/idd_response_spectra_fema_356.htm
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 Any number of reference paths can be created within a model. Once created, the data 

that defines each path can be viewed in the Utilities  Treeview. Like other utilities, 

paths are not directly assignable to geometry and can only be edited by editing their 

properties via their context menu. 

Defining paths 

Paths are created by using the Utilities> Reference Path menu item. They can be 

defined by 

 By defining and selecting lines, arcs and splines in LUSAS Modeller (the most 

commonly used method). 

 Specifying the coordinates of each point defining a line/arc in a table 

 Importing geometry and line segment information from a spreadsheet. 

A reference path can be defined as a line between two points (if a straight path is to be 

considered), an arc between three points (if a simple curved path is to be considered), 

or be created from as many consecutive lines and/or arcs as necessary. Paths can be 

created either separate from model geometry, or make use of it in the definition by 

selecting the line (or lines) defining a path prior to selecting the menu item. It is 

important to remember that whilst model geometry may be used to arrive at the points 

required to generate a reference path, no connection between the model geometry and 

reference path data exists. 

Reference paths are usually defined to be along and coincident with beam lines. For 

clarity it is also possible to define reference paths away from beam lines but if the 

beam lines are not straight (perhaps they curve on plan) the path should be defined 

above the beam lines rather than be defined in the same horizontal plane. 

The way that two adjacent and intersecting reference path lines will be shaped can be 

controlled by smoothing which involves adding a radius transition between two lines 

inside of their defined intersection point or adding a radius transition between two 

lines through their defined intersection point. 

Transverse direction settings control how line attributes containing multiple varying 

sections are assigned to more than one set of lines when using the same common 

reference path. One example of use is for straight or skewed grid or grillage line beam 

models. For this type of modelling a single reference path can be used in conjunction 

with a transition setting to offset multiple tapering section line attributes appropriately 

for each longitudinal beam member.  

A 'Value of distance at start of path' can be used specify the local x value at which the 

path should begin. For bridge engineering this would equate to specifying a chainage 

value for a known point at the 'start' of the structure. This value is added to the 

distance value that can be displayed for each of the points defining the path. 
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Deleting paths 

Defined reference paths can be viewed in the Utilities  Treeview. A reference path 

can be deleted from this location by using the Delete option on its context menu, but 

only if the path is not used in the definition of any other modelling attributes that are 

present in the Attributes  Treeview, or in the definition of a Direct Method 

Influence Analysis. 

Reference paths for use in modelling multiple varying sections 

3D line beam models 

For 3D line beam models consisting of multiple longitudinal lines a reference path can 

be used. This allows one multiple varying section geometric line attribute to be 

assigned to multiple lines. The number of line beams required to model the changing 

section depends upon whether a staged construction analysis will be carried out. For 

the creation of simple models it is possible to assign a multiple varying section line 

attribute to a single line beam without the use of a reference path but for staged 

construction analysis (where individual lines need to be activated and deactivated) the 

multiple varying section line attribute can be assigned to multiple lines with reference 

to an associated path. See Distance types and methods of assignment for more 

information. 

 

Reference path showing multiple line beams assigned a single multiple varying section 

 (for clarity beam lines have been visualised at top of section) 

3D grid/grillage-type models 

For grid/grillage models, longitudinal beams are comprised of separate line beams 

often grouped together (for ease of manipulation and assignment of properties etc). 

Because the actual profile of the set of grouped members as a whole may vary along 

the longitudinal beam's length a reference path is used to control the assignment of a 

multiple varying section line attribute to the set of lines. When assigning a geometric 

line attribute, the following transverse direction settings are available: 
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 Perpendicular to path - the plane of constant distance is normal to the path 

tangent in both local y and z directions 

 Skew angle - is defined as the horizontal angle between the orthogonal plane 

and the plane of equal distance. 

 Local coordinate - as skew angle, but where the skew angle is read from an 

existing local coordinate system. 

 

  

Perpendicular Skew angle to path  

  

 

Local coordinate 

Reference paths for Direct Method Influence Analysis 

See Direct Method Influence Attributes 

Reference paths for Results Transformation 

See Results Transformation 

Visualisation of reference paths 

By default, reference paths are drawn in red and direction arrows at mid-points along 

each line segment, show the direction of the path. Each path entry in the Utilities  

Treeview has a context menu enabling the following selections: 

 Rename changes the path name 
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 Delete removes the path entry from the Utilities treeview but the menu item is 

only available if a path has not been associated with a geometric line 

assignment. 

 Edit Path displays the path definition dialog to enable changes to be made 

 Create geometry converts the path into points, lines, arcs and splines in the 

Geometry layer. 

 Visible turns the display of the reference path on, if off. 

 Invisible turns the display of the reference path off, if on. 

 Visualise at points labels the points defining the path with absolute distances 

along the path. This also labels other lines in the model to show what would 

happen if the path were associated with those lines. See below for examples. 

 

Visualisation of reference path at points on the model 

The reference path context menu option Visualise at points shows the value of the 

reference path distance for other points in the model. It helps to show the validity of 

using the reference path for other lines in the model and in cases where path labels 

drawn on these other points did not match those of the reference path it would, for 

some situations, draw attention to an invalid transverse direction settings being used.  

  

Perpendicular (orthogonal) grid/grillage Skewed grid/grillage 

Examples of valid reference path points visualised on the model 

Library Files 

Library files are used to store geometric section property, material, and composite data 

for use when building a model. Some library files contain data supplied by LUSAS 

and are read-only, whilst others contain data that can be saved by users. The full range 

of library files are summarised here. 

Section property libraries 

 Section library is a LUSAS supplied library of a range of steel section sizes 

for various countries. 
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 User (local) library stores user-created section properties for use inside the 

current project only. 

 User (global) library stores user-created section properties for use across all 

projects. 

Material property libraries 

 Material library is a LUSAS supplied library of commonly used structural 

materials. 

 Composite library is a LUSAS supplied library of materials for use in the 

composites industry. 

One-click reports 

The one-click report facility creates a one-page modelling and results summary for 

each selected feature showing a graphical representation of primary load effects on 

that feature or object for the active loadcase. In its simplest form a one-click report is 

created by first selecting a line or surface in the model (or element) and then selecting 

the context menu item One-click report... for that feature. Multiple features (but only 

of the same type) can also be selected and be reported upon, and in this situation a 

multi-page report summary would be created instead.  

One-click reports can be printed off individually or be added to as individual chapters 

to main reports. Each time a main report is generated the contents of an included one-

click report are updated to reflect the current state of the model and any corresponding 

results. 

The one-click report facility can also be accessed from the Utilities > Reporting 

> One-click report menu item, or from the One-click report  toolbar button. 

Report contents 

A one-click report contains a multi-celled table filled with modelling data, and 

unaveraged results plots and diagrams that differ according to the element type that is 

assigned to the line or surface feature, or element that was selected. The layout of a 

one-click report is pre-defined by a supplied template. A separate template is provided 

for each element type that is supported by the one-click reporting facility. By default 

no page margins are initially applied, but they can be added by using the Edit page 

margins button. 
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Example reports 

  

One-click report for a line beam member  

(2D thick beam template) 

One-click report for a surface 

(2D thick plate template) 

Typical report contents for a beam element 

A 2D thick beam element the template plots the following model and results data and 

images on a single one-click report page: 

Feature type and ID 

Modelling units in use 

Mesh attribute ID and name 

Mesh type name 

Geometry attribute ID and 

name 

Material attribute ID and 

name 

Length of feature 

Points (or nodes) defining 

feature 

Cross-sectional view of 

shape with respect  

to its assigned line 

showing any defined fibre 

locations 

  

Section dimensions and 

fibre locations 
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Loadcase ID and name 

  

Diagram of Force / 

Moment results of Fx 

along the feature 

  

  

Diagram of Force / 

Moment results of Fy 

along the feature 

  

  

Diagram of Force / 

Moment results of Mx 

along the feature 

  

  

Diagram of Stress results 

at fibre location 1 (if 

defined) 

  

  

Diagram of Stress results 

at fibre location 2 (if 

defined) 

  

  

Diagram of Stress results 

at fibre location 3 (if 

defined) 

  

  

 Diagram of Stress results 

at fibre location 4  

(if defined) 

  

  

Section properties of 

feature as used in analysis 

  

  

Additional section 

properties 

  

  

Typical report contents for a plate element 

A 2D thick plate element the template plots the following model and results data and 

images on a single one-click report page: 

Feature type and ID 

Modelling units in use 

Mesh attribute ID and name 

Mesh type name 

Geometry attribute ID and 

name 

Material attribute ID and 

name 

Plan area of feature 

Lines and Points (or nodes) 

 Plan view of shape of 

selected surface or element 

showing surface axes (for 

surface) and mesh 

Geometric properties 
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defining feature 

Loadcase ID and name 

  

Contour plot of Force / 

Moment results of MX  

for the selected feature 

  

  

Contour plot of Force / 

Moment results of MY  

for the selected feature 

  

  

Contour plot of Force / 

Moment results of MXY  

for the selected feature 

  

  

Contour plot of Force / 

Moment results of Stress 

Sx for the selected feature 

  

  

Contour plot of Force / 

Moment results of Stress 

Sy for the selected feature 

  

  

(empty cell) 

  

  

Contour plot of Stress 

results of Stress SE (top) 

for the selected feature 

  

  

Contour plot of Stress 

results of Stress SE 

(bottom) for the selected 

feature 

  

(empty cell) 

 

Printing / previewing 

With a One-click report displayed and in the One-click report window: 

 Press the Print button  to print the report page(s). 

 Use the Print preview button  to view how the page will print. Zoom and 

unzoom options are provided. Note that the page orientation is pre-set to be 

Portrait and is not governed by any settings made on the Page Setup dialog that 

would be accessed via File > Page setup.  

 Use the Edit page margins button  to set left, right, top and bottom 

margins to the report cells. If margins are applied, use the Print preview button 

to see a true representation of what will be printed. 

Adding to main reports 

With a One-click report displayed and in the One-click report window: 
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 Press the Add to report  button. Select the pages to be inserted, identify 

the position within a report where the page is to be added, and click the 

OK button.  

Each time a main report is generated the contents of an included one-click report are 

updated to reflect the current state of the model and any corresponding results. 

One-click report templates 

One-click report templates are supplied for the following element group types: 

 Bars (2D and 3D) 

 Beams (2D, 3D, Thick, Thin, Cross-section and Grillage 

 Plates and shells (Thick and Thin) 

 2D continuum (Plane stress, plane strain, axisymmetric) and 3D membrane 

 Axisymmetric shell 

 Axisymmetric membranes 

Customisation  

For further details regarding the location and potential user customisation of one-click 

report templates, please contact LUSAS technical support. 

Tools 

Tools differ from model utilities in that they do not generally create entries in the 

Utilities  Treeview.  

Details of the features and use of many of the tools listed below are provided in other 

relevant chapters of the manual. The remainder are described in this chapter. 

The complete list of LUSAS tools (accessed from the Tools menu) is shown below. 

Clicking on a hyperlink will take you to the appropriate location. 

 Mesh - mesh node measurement, and controlling of automatic remeshing. 

 Annotation - adding of text, line, bitmap, window summary and border 

annotation to the view window. 

 Inspection Locations - define points of interest on the model for results 

extraction / viewing purposes,either by cursor or by pre-selection. 

 Set Fourier Angle - specify the angle around the circumference at which 

Fourier results are required 

 Set Harmonic component  
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 Animation Wizard - animate the mode shapes or load history of a structure 

 Section Through 3D (Analysis type 3D only) - slice a solid model and plot 

results on the section defined 

 Vertical Axis - sets the model X, Y,or Z direction to be the vertical axis. 

 Direction Definition - sets the vertical, longitudinal and transverse axes for a 

model to assist with model orientation and calculation of particular effects 

 Renumber All - renumbers Nodes and Elements, and Point, Line, Surface and 

Volume geometry features for all of a model.  

 Renumber Selection - renumbers Nodes and Elements, and Point, Line, 

Surface and Volume geometry features for selected parts of a model.  

 Library Management - specify library locations and add and delete basic 

section data from a library 

 Section Property Calculator - calculates cross-sectional geometric properties 

for a range of sections 

 

Direction Definition 

Specifying a direction definition sets the vertical, longitudinal and transverse axes for 

a model to assist with model orientation and the calculation of particular effects. The 

Direction definition dialog is accessed from the Tools > Direction Definition menu 

item. The options are: 

Vertical 

 Global axis  This determines the direction that gravity loading will be applied 

if added using the Bridge > or Civil >  Gravity menu item. It also defines the 

initial vertical axis and orientation of element types and library items as 

displayed on the Geometric Line dialog prior to them being added to a model. It 

also defines the model orientation viewed when using the isometric, dimetric 

and trimetric views.  

Note that setting the vertical axis on the Direction definition dialog will supercede any 

vertical axis setting defined on the Vertical Axis dialog. 

Longitudinal  

 Global axis For the majority of models this will simply be the global X-axis. 

However LUSAS allows generic input of any direction which may even be a 

complex path through or along a structure, such as that defined by a set of lines 

forming a continuous path. 

 Local axis Use a local coordinate set to define the direction. An example of use 

is for aligning influence attributes along a singly curved bridge deck. 
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 Follow line path If a path of lines is to be used, selecting the lines to be used 

prior to selecting Tools > Direction  definition will cause the correct line path 

definition to be automatically inserted into the line path field. An example of 

use is for ensuring correct alignment of influence attributes along all spans of a 

bridge deck when those spans are formed of multiple straight lines, arcs or any 

combined sequence of these two feature types in order to describe the 

carriageway shape. 

Note that a longitudinal direction definition must always be correctly defined for an 

influence analysis. 

Transverse  

This is assumed to be orthogonal to both longitudinal and vertical directions. This is 

currently only used for an influence analysis.  

Vertical axis 

Vertical axis settings on the Model Properties dialog can be accessed from the Tools > 

Vertical Axis menu item. The vertical axis setting specifies whether the model X, 

Y,or Z direction is to be used as the vertical axis. It: 

 Defines the initial vertical axis and orientation of element types and section 

library items as visualised on the Geometric Line dialog prior to them being 

added to a model. 

 Defines the model orientation that is viewed when using the isometric, dimetric 

and trimetric views.  

 Determines the direction that gravity loading will be applied if it has been 

specified as a property of a loadcase. 

 Determines the direction that gravity loading will be applied if added using the 

Bridge > Bridge Loading > Gravity or theCivil > Gravity menu item.  

 Determines the direction in which construction table values are reported. 

Note that setting the vertical axis on the Model Properties dialog will supercede any 

vertical axis setting defined on the Direction definition dialog. 

Library Management 

The location of the section and material libraries is defined from the Tools> Library 

Management> Library Locations menu item. The local section library is always 

located in the current working (project) directory while the server library may be 

located anywhere on a computer network. The server library allows common sections 

to be stored and made available across an organisation. 
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Add Section to Library 

Basic geometric section properties may be manually added to either the local or server 

section library from the Tools> Library Management> Section Library> Add 

Propertiesmenu item. This facility is intended primarily for entering section data of an 

unspecified cross-sectional shape.  

Geometric section properties for standard cross sections or arbitrary cross sections can 

be added to either the local or server section library by choosing the appropriate button 

on the dialog where they are defined. 

Delete Section from Library 

Section properties may be deleted from either the local or server section library from 

the Tools> Library Management> Section Librray> Delete Properties menu item. 

Renumbering 

By using Tools > Renumber All... or Tools > Renumber Selection... renumbering of 

Nodes and Elements, and Point, Line, Surface and Volume geometry features (referred 

to collectively as 'objects' in this topic) can be carried out for all, or selected parts of a 

model. Renumbering can be done by specifying numerical increments with respect to 

either global axis directions or reference paths.  

To visualise node, element and geometry numbers/names add the Labels layer to the 

Layers  Treeview, choosing the object names to be displayed. 

Renumbering options 

When Renumber All is chosen the following two options are seen: 

 Auto renumber using these settings when re-meshing If checked, 

renumbering of all nodes and/or elements in a model will take place according 

to the settings made on the dialog after remeshing is requested. If not checked, 

renumbering of all nodes and/or elements in a model will take place according 

to the default Global direction settings after remeshing. Autorenumbering is 

always checked 'on' by default when a new model is created. This status is 

shown by a tick on the Renumber All menu item. 

 Renumber now applies the renumbering straightway once the Apply or 

OK buttons are pressed. 

The ability to check (turn-on) or not check (turn-off) either of these two options results 

in either one, both, or neither being applied. When both are checked, both actions that 

are described above take place. When both a re unchecked, auto-renumbering is 

turned-off, as subsequently shown by a greyed-out tick on Renumber All menu item. 

When Renumber Selection is chosen only the following option is seen: 

 Preserve numbering in other parts of the model (for Renumber Selection 

menu item) If checked, renumbering of only selected objects will take place 
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according to the settings chosen on the Renumber Selection dialog with all 

other objects retaining their current number. If not checked, numbers used in 

the re-numbering of the selected objects may use numbers from other parts of 

the model, and these in turn will then also be re-numbered with previously 

unused numbers. 

 

Global direction method 

Renumbering of objects using the global direction method is carried out with respect 

to the three model view axes. Positive and negative numbering directions can be 

stated. The incremental value defines the interval between the numbers assigned to 

each object within each specified direction. 

To help understand the effect of choosing certain renumbering settings note how 

Modeller evaluates a model prior to carrying out a renumbering operation for selected 

objects.  

1. For the first global axis direction specified, (a positive Z-axis by default), 

Modeller sweeps through the model in that direction locating all and any 

objects of equal distance along that axis.  

2. For those objects that it finds, Modeller then sweeps along the second global 

axis specified, (a positive Y-axis by default) locating all and any objects of 

equal distance along that axis.  

3. For the objects that it finds Modeller then sweeps along the third global axis 

specified, (a positive X-axis by default) locating all and any objects of equal 

distance along that axis. 

Once a set of objects has been assembled, renumbering of objects then takes place 

using the starting values and specified increments for each axis, but in the reverse 

order to the axis order chosen. So, for the default settings stated above, renumbering 

would start and increment along the X axis first, then along the Y axis, and then along 

the Z axis. 

Reference path method 

Renumbering of objects using reference paths uses longitudinal, transverse and 

vertical reference axes in place of the named model axes of the Global direction 

method. Positive and negative renumbering directions can be stated for each direction 

considered. The incremental value defines the interval between the numbers assigned 

to each object within each specified direction. 

The reference path method requires specifying longitudinal, transverse and vertical 

directions and requires specifying positive and negative renumbering directions that 

may not be initially obvious: 

1. For a defined and selected reference path, the positive longitudinal direction is 

measured along the path, in the direction that the path was defined.  
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2. The transverse direction is measured orthogonally to the longitudinal direction 

and the vertical direction. 

3. The vertical direction is orthogonal to the longitudinal direction and the plane 

described by the longitudinal direction and the global vertical direction. 

Once a set of objects has been assembled renumbering of objects then takes place 

using the starting values and specified increments for each axis, but in the reverse 

order to the axis order chosen. 

Notes 

 Points and Nodes are located by their coordinates 

 2D Elements and Lines are located by the coordinates of their mid-points. 

 2D Surfaces, 3D Elements and Volumes are located by the coordinates of their 

centroids. 

 The renumbering facility can renumber all or just selected objects but the 

renumbering strategy defined is applied separately to each object type. For 

instance, renumbering a selection of nodes and elements with a starting value 

of 1 and an increment of 2 will result in a renumbering sequence of node 1, 

element 1, node 3, element 3 etc. If different renumbering patterns are required 

these should be carried out by restricting the type of object selected and 

carrying out successive individual renumbering passes through the model. 

 Auto renumbering is only applied to nodes and elements. If the model has no 

mesh, the auto renumbering option is disabled. 

 Use of the Tools> Mesh Reset menu item and other remeshing events will 

cause any nodes and elements to revert to their initial numbering, or to a re-

numbering scheme as specified on the Renumber dialog if the 'Auto renumber 

using these settings when re-meshing' check box has been checked. 

 For models created prior to Version 15 auto renumbering is turned off by 

default.  

Renumbering examples 

In these examples note that for 2D models created in the XY plane, the Z axis 

direction is redundant and no incrementation settings in the Z axis are applied. The 

same would be true for models drawn in other planes with other redundant axes. 

Similarly, when selecting a single row of objects for renumbering (as in the case of the 

Simple line beam bridge example that is shown) the second and third global directions 

are effectively redundant. 

Simple node and element renumbering 

Nodes and element numbers in a 2D surface mesh are renumbered using 

Tools> Renumber All 
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Before: All nodes and elements numbered using 

global directions.  

Start value=1, Positive Z-axis, increment 1, Positive 

Y-axis, increment 1, Positive X axis, increment 1 

(Default numbering method) 

 After: All nodes and elements renumbered using 

global directions.  

Start value=1, Positive Y-axis, increment 10, 

Positive X axis, increment 1, Positive Z axis, 

increment 1 - is not used. 

Simple multi-storey building frame 

Surfaces are re-numbered in a 3D model using Tools> Renumber All 

 

 

 

Before: All surfaces numbered using global 

directions.  

Start value=1, First: Positive Z-axis, increment 1, 

Second: Positive Y-axis, increment 1, Third: Positive 

X axis, increment 1 (Default numbering method) 

 After: All surfaces renumbered using global 

directions.  

Start value=1 , First: Positive Z-axis, increment 

100, Second: Positive Y-axis, increment 10, Third: 

Positive X axis, increment 1 

Simple line beam bridge 

Lines are renumbered in a 2D line model using Tools> Renumber Selection. 
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Before: All lines numbered as drawn. Three separate renumbering selections shown. 

  

 
After: Renumbered using three steps as follows: 

Step 1: Lines 3 and 4 selected (on Before model) and renumbered using Global direction, Start value=1 , 

Positive Y-axis.  

Step 2: Line 9 and 10 selected (on Before model) and renumbered Global direction, Start value=3 , Positive Y-

axis, preserving numbering in other parts of model.  

Step 3: Remaining lines (Lines 1 to 14 on Before model) selected and renumbered using Global direction, 

Start value=5 , Positive X-axis, preserving numbering in other parts of model. 

Skewed slab 

Lines are renumbered in a 2D line model with respect to a reference path and a skew 

angle using Tools> Renumber All. 

 

Before: All lines numbered as drawn. Reference path defined along lines L2, L5 and L13 
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After: All lines renumbered along and transverse to reference path.  

Start value=1 , First: Positive vertical axis, increment 1, Second: Positive transverse axis, increment 10, Third: 

Positive longitudinal axis, increment 1 

Curved path 

Lines are renumbered in a 2D line model with respect to a reference path using Tools> 

Renumber All. 

 

Before: All lines numbered as drawn. Reference path defined along lines L10, L5, L8, L7 and L6 

 

After: All lines renumbered along and transverse to reference path.  

Start value=1 , First: Positive transverse axis, increment 10, Second: Positive longitudinal axis, increment 1, 

Third: Positive vertical axis, increment 1 - is not used. 
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Section Property Calculation 

Cross-sectional geometric properties (for use with line beam models) can be calculated 

for: 

 Standard sections - a range of commonly used section shapes. 

 Arbitrary sections - any user-defined cross-sections, with and without internal 

voids, that are drawn in LUSAS Modeller 

 Precast beam sections with and without a concrete slab. 

 Box sections for both simple and complex box sections, with and without an 

internal void.  

 Infill/encased sections for a selection of commonly used section shapes. 

 Plate sections for a range of riveted or welded sections, with some sections 

having an option to incorporate library sections. 

Standard Section Property Calculator 

Standard section property calculators are accessed from the Tools> Section Property 

Calculator menu item. The following sections are supported: 

 Rectangular - solid, hollow, equal and unequal flange/web thickness, stiffened 

box. 

 Circular - solid, hollow, elliptical hollow, stiffened pipe. 

 I section - equal and unequal flanges, lipped, haunch, cross I, combined T. 

 T section - of standard shape. 

 L section - single, single with external radius, double (back-to-back). 

 C section - lipped, unlipped, with external radius, with unequal external radius, 

double (back-to-back), double (front-to-front), top hat 

 Z section - lipped right-angle, lipped inclined, unlipped 

 More sections - Hexagonal (both solid and hollow), Octagonal solid, 

Trapezoidal hollow. 

file:///C:/SVN/Content/Bridge/Section_Generators/Precast_Beam_Section_Generator.htm
file:///C:/SVN/Content/Bridge/Section_Generators/Box_Section_Property_Calculator.htm
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Typical standard section property calculator dialog  Section visualisation showing fibre locations 

Section properties for standard cross-sections are computed instantaneously once valid 

user-defined dimensional data has been entered. The resulting section can be 

optionally visualised to verify the section shape created, and to view the automatically 

defined fibre locations (used when plotting stresses on fleshed beams). The section can 

also be optionally converted into model geometry and used as a base for further 

modification in some way inside LUSAS Modeller before re-calculating the new 

section properties of the edited section using an Arbitrary Section Property Calculator. 

Sections can be added to a local library (model folder specific) or a server library (a 

user-defined location that can be shared with other users of the same computer or 

network) for use on the current project or for re-use across other projects respectively. 

Notes 

 Standard section property calculators for standard sections (such as 

rectangular, circular, L-sections, T-sections etc) and for box sections (both 

simple and complex), do not currently calculate the additional section 

properties required for use with design calculations. Instead, after defining a 

section shape, the Create geometry button should be used to draw the section 

prior to using the arbitrary section property calculator to calculate the full set of 

section properties for the shape. Note that the additional properties required for 

design calculations are not required for a general analysis to be carried out. 

 The shear areas for thin sections in the LUSAS library, and those calculated by 

the LUSAS section property calculators are appropriate for analysis purposes 

but are smaller than those in standard tables for design because they take into 

account also the self-equilibrating shear stress that is perpendicular to the shear 

resultant. For design checks, such as those carried out by the Steel Frame 

Design software option and the Composite Bridge Deck Design software 

option, a shear area for design is calculated for each section which would 

correspond to those given in design tables. 

file:///C:/SVN/Content/Design/Steel_Frame_Design/steel_frame_design.htm
file:///C:/SVN/Content/Design/Steel_Frame_Design/steel_frame_design.htm
file:///C:/SVN/Content/Design/Steel_Composite_Bridge_Design/steel_comp_bridge_design.htm
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Back-to-back or front-to-front sections 

Note that in the case of back-to-back sections (for L-sections and C-sections) or face-

to-face sections (for C-sections only) the pair of sections are treated as separate 

sections and not as rigidly connected sections. As such, setting the distance between 

the sections 's' to zero, or changing it to be a positive number does not have any effect 

on the calculated torsion constant J. The two back-to-back or front-to-front sections 

are assumed to twist independently about their own shear centres and hence the 

torsional constant calculated will be twice the torsional constant of a single C-section/ 

L-section. More accurate calculation of the torsion constant J can be achieved using 

the Arbitrary Section Property Calculator, and this can also be used to calculate J for 

the case where the back-to-back / front-to-front section is to be considered as rigidly 

connected. 

Using standard sections 

To use the computed section properties in a model the section must be saved to a local 

or server library. Once saved, to add a library item to the Attributes  Treeview 

select the Attributes> Geometric> Section Library menu item, then select User 

Sections, then select Local or Server before choosing the section required from the 

list available. On completion, prossing OK creates an attribute, which can be 

subsequently assigned to the required Line(s) in the model. 

Arbitrary Section Property Calculator 

The arbitrary section property calculator is accessed from the Tools> Section 

Property Calculator> Arbitrary Section menu item. It computes section properties 

(area, moments of inertia and torsion constant etc.) for any open or closed section of 

similar (homogenous) material, or for a compound section made of two or more 

materials, and calculates extreme fibre positions for use when plotting stresses on 

fleshed beams. Note that the Arbitrary section calculator cannot be used to calculate 

properties of a cross section comprised of two or more shapes that are not connected. 

The arbitrary section property calculator should generally be used in preference to 

manually defining geometric line property data since cross-sectional shapes (as used 

by the fleshing facility), and fibre locations (as used in results viewing) are 

automatically calculated and stored as part of the section property calculation. 

Defining cross-sections 

Cross-sections must be defined in the View window in the XY plane. Whilst cross-

sections can be created initially using points and lines, ultimately they must contain 

surfaces that define a single continuous shape. For solid sections or solid sections with 

holes this will need to be done by manually creating the surfaces required.  

For thin walled box sections surfaces can be extruded automatically from lines drawn 

to represent the centrelines of the plated members.  
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Individual surfaces separated by gaps do not form a valid cross-sectional shape for 

section property calculation purposes. See Creating Holes in Surfaces for details of 

how to create cross-sections with voids.  

 

Section properties calculated 

 
Standard properties 

  Additional properties for 
design checking 

   
Plastic properties 

A - Cross-sectional area 

Ixx - Second moment of 
area about x axis 

Iyy- Second moment of 
area about y axis 

Izz - Second moment of 
area about z axis 

Ixy, Iyz, Izx - Product 
moments of area 

J - Torsional constant 

Asx - Effective shear in x 
direction 

Asy - Effective shear in y 
direction 

Asz - Effective shear in z 
direction 

  

  kx - Radius of gyration about x 
axis 

ky - Radius of gyration about x 
axis 

kz - Radius of gyration about x 
axis 

Cw - Warping torsional constant 

xo - Shear centre, distance from 
centroid along x axis 

yo - Shear centre, distance from 
centroid along y axis 

zo - Shear centre, distance from 
centroid along z axis 

  

  Ap - Plastic cross-sectional area (= 
elastic area) 

Zpy - Plastic section modulus about y 
axis 

Zpz - Plastic section modulus about z 
axis 

Zpt - Plastic torsional section 
modulus 

Yp - Plastic neutral axis, distance 
from centroid along y/z axis 

Zp - Plastic neutral axis, distance 
from centroid along y/z axis 

Plastic geometric properties are required for beams when using the stress resultant 

material model (model 29) 
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Thin walled box sections 

For thin walled box sections, only the points and lines that define the centrelines of the 

plated members and the geometric thickness of each line needs to be initially defined. 

The thickness of each line is specified by assigning a geometric line ASPC Thickness 

attribute. LUSAS will automatically extrude the lines to create surfaces in order to 

compute the section properties. Note that a mesh does not need to be assigned to the 

lines defining the section if automatic meshing will be used when calculating section 

properties. This functionality is only available for models defined with an analysis 

category of 2D Inplane. Surfaces of a width equal to half of the assigned thickness are 

automatically extruded either side of each line during the section property calculation 

process to determine the correct section properties, unless a line is also attached to a 

surface in which case the extruded surface is generated away from the existing surface 

and does not overlap with that surface. The extruded surfaces are automatically 

meshed QFD8 elements; one to each side of the centreline and a number of elements 

along the length to achieve a sensible aspect ratio. These surfaces can be optionally 

retained after the section property values have been calculated. To enable the model to 

be returned to the original line model a new group named “Extruded” is created to 

allow the geometry that was used to define the surfaces to be easily identified and 

deleted.  

 

Note that a cross-section representing the shape of a single (homogenous) material 

does not need to have a material assigned to it for section property calculation to take 

place, but if a material is assigned it must have a unit Thermal conductivity defined. 

 A thin walled box section constructed of two or more materials can be accommodated 

using the modular ratio approach. For this different materials should be assigned to the 

lines as appropriate. If specified, the material properties on the line will be transferred 

to the extruded surfaces.  

The section properties calculated for thin walled box sections modelled using the 

'extruded surfaces' method very closely match those of cross-sections defined using 

solely surfaces, but very slightly over-estimate the values due to the localised 

overlapping of extruded surfaces at junctions. 

Compound sections 

Compound sections can be defined from existing library sections that are positioned 

relative to each other - see Compound Sections (from library items), or by being 

file:///C:/SVN/Content/dlg4attr/idd_general_beam.htm
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drawn in the view window. Compound sections constructed of two or more materials 

can be accommodated using the modular ratio approach. For this an isotropic thermal 

material property attribute is created with the thermal conductivity set to the Ei / Ebase 

value of the material and then assigned to surfaces made from that material. Ei is the 

Young's Modulus of the material the surface represents and Ebase is the Young's 

Modulus of the material to be used in the structural analysis. When defining a modular 

ratio, using thermal material properties of less than 1% of the structural material 

properties is recommended. See Case study: Arbitrary Section Property 

Calculation of a Compound Section for a basic procedure.  

A thin box section constructed of two or more materials can also be accommodated 

using the modular ratio approach. For this, different material properties should be 

assigned to the relevant lines. If specified, the material properties on the line will be 

transferred to the extruded surfaces.  

Options/Settings 

On the Arbitrary Section Property Calculator dialog: 

 Annotate properties displays the calculated section properties and section 

location data to the Annotation layer. 

 Automatic meshing allows LUSAS to mesh the cross-section based upon the 

Max element/line setting. 

 Max element/line specifies the maximum elements to be assigned to any one 

line, when automatically meshing. 

 Recompute section properties Recalculates properties if mesh setting or 

geometry has been modified. 

 Add to local library Adds the calculated values to the local library when the 

Apply button is selected. 

 Add to server library Adds the calculated values to the server library when the 

Apply button is selected. 

 Retain extruded surfaces For use with cross-sections defined by points and 

lines only, when lines have been assigned with a geometric line ASPC 

Thickness attribute. This option retains the surfaces that are generated as part 

of the section property calculation. 

 Name is used to identify the section when saved as a library item. 

Notes 

 The mesh used to compute arbitrary section properties determines the accuracy 

of the section properties but also affects the computation time. It has been 

found that a reasonable result is achieved if at least two elements are used 

through thin sections of the model. If a finer mesh is required the maximum 

number of elements per line should be increased. If the mesh still requires 

file:///C:/SVN/Content/dlg4attr/idd_general_beam.htm
file:///C:/SVN/Content/dlg4attr/idd_general_beam.htm
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adjustment it is recommended that the problem is initially set up using the 

default mesh and then the Automatic Meshing option is switched off to allow 

the mesh to be manually adjusted. 

 Calculation of arbitrary section properties is done using thermal/field equations 

and, as a result, a Thermal Analysis entry will appear in the Analyses  

Treeview. This is not intended for use or for manipulation by users. 

Using arbitrary sections 

To use the computed section properties in a model the section must have been saved to 

a local or server library. To add a library item to the Attributes  treeview select the 

Attributes> Geometric> Section Library menu item, then select User Sections, then 

select Local or Server before choosing the section required from the list available. 

The section can then be assigned to the required Line(s) in the model. 

Note that the section properties created by the arbitrary section property calculator 

follow beam theory with the x-axis of a beam sitting along the beam's length, and with 

the y-axis to the left and the z-axis vertical.  

Worked example 

See Online help > Worked Examples > For LUSAS Bridge and LUSAS Civil & 

Structural >  'Arbitrary Section Property Calculation and Use', for a typical use of this 

facility. 

Precast Beam Section Generator 

The Precast Beam Section Generator (for beams with a top slab) is available for 

Bridge and Civil & Structural software products only. See Application Manual 

(Bridge, Civil & Structural) for details. 

Box Section Property Calculator 

The Box Section Property Calculator is available for Bridge and Civil & Structural 

software products only. See Application Manual (Bridge, Civil & Structural) for 

details. 

Infill / Encased Section Calculator 

The Infill / Encased Section Calculator is available for Bridge and Civil & Structural 

software products only. See Application Manual (Bridge, Civil & Structural) for 

details. 

Plate Section Calculator 

The Plate Section Calculator is available for Bridge and Civil & Structural software 

products only. See Application Manual (Bridge, Civil & Structural) for details. 

file:///C:/SVN/Content/Bridge/Section_Generators/Precast_Beam_Section_Generator.htm
file:///C:/SVN/Content/Bridge/Section_Generators/Box_Section_Property_Calculator.htm
file:///C:/SVN/Content/Bridge/Section_Generators/Infill_Encased_Section_Calculator.htm
file:///C:/SVN/Content/Bridge/Section_Generators/Plate_Section_Calculator.htm
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Section properties for unspecified cross-sections 

Section properties of an unspecified cross-sectional shape may be defined using the 

Attributes> Geometric> Line menu item to enter section properties directly prior to 

saving in a user or server library. See Library Locations for more details. 

Case Study: Arbitrary Section Property Calculation of a 

Compound Section 

The basic procedure to carry out section property 

calculation of a compound section such as that 

typically encountered with a steel beam and 

concrete slab is as follows: 

1. Create a new model for a thermal 

analysis (required so that a thermal 

material attribute can be defined) 

2. Draw the section and run the Arbitrary 

Section Property Calculator 

(ASPC) from the Tools> Section 

Property Calculator> Arbitrary 

Section menu item to calculate 

homogeneous section properties, saving 

the section to a user library with the 

name 'homogeneous section'. This will set the model up and assign a unit 

thermal conductivity to all surfaces. 

3. Use the Attributes > Material > Isotropic menu item to define a new 

material, select the Thermal tab and set the Thermal Conductivity, K, to be 

the modular ratio E2/E1 where E2 is the Young's Modulus of the material to 

be represented, and E1 is the Young's Modulus of the material to be used in 

the structural analysis. The calculated section properties will take into account 

the modular ratios. 

4.  Note that if the structural analysis is to be based upon steel material 

properties then the modular ratio assigned to the surfaces representing the 

concrete would be Econcrete/Esteel. 

5. Assign the newly defined material property to the surface representing the 

concrete slab. 

6. Re-run the ASPC to calculate the compound section properties, saving the 

section to a user library with the name 'compound section'. 

Note that compound sections can also be defined from library items using the 

Attributes > Geometric > Compound Section menu item. See Compound Sections 

for details. 

file:///C:/SVN/Content/dlgsectprop/IDH_LIBRARY_LOCATIONS.htm
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Chapter 7 : 

Analyses 

  

The Analyses Menu 

The Analyses menu entries listed here all add entries to the Analyses  Treeview by 

using a similarly named Analyses> menu item. 

Analysis types 

 Structural Analysis - used to carry out all kinds of linear static, eigenvalue, 

fourier, nonlinear, or transient dynamic analysis. 

 Thermal Analysis - used to assess conduction, convection or radiation effects. 

 Hygro-Thermal Analysis - used to model the evolution of temperature, water 

saturation and degree of hydration.  

 Direct Method Influence Analysis - used to create an influence line or surface 

by way of a unit load placed at each node or grid location on the loadable area 

of a structure.  

 Vehicle Load Optimisation - used to identify critical vehicle loading patterns 

on bridges and apply these loading patterns to LUSAS analysis models. 

 Railway Load Optimisation - used to identify critical train loading patterns on 

bridges and apply these loading patterns to LUSAS analysis models 

 Linear Cable Tuning Analysis - calculates load factors for selected lines in a 

model that represent cables in order to achieve defined target values set for 

various components or features. 

The use of some analyses menu items, such as Vehicle Load Optimisation, Rail Load 

Optimisation or Cable Tuning Analysis is dependent upon the software licence key in 

use. Note also that some analysis menu permutations are not allowed - for example 

Cable Tuning analysis and General Thermal Analysis. 

file:///C:/SVN/Content/Bridge/Vehicle_Load_Optimisation/Vehicle_Load_Optimisation_Overview.htm
file:///C:/SVN/Content/Bridge/Rail_Load_Optimisation/Rail_Load_Optimisation_Overview.htm
file:///C:/SVN/Content/6analysi/idh_linear_cable_tuning_analysis.htm
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Coupled analysis 

Whilst not accessed via the Analyses menu, a Coupled Analysis can be created by 

choosing analysis type 'Coupled' when a new model is created, or by adding a 

structural analysis entry to an Analyses  Treeview containing a single Thermal or 

Hygro-thermal analysis entry or vice-versa. 

 Coupled Thermal /Structural Analysis - performs a thermal and structural 

analysis simultaneously, or one after the other, by transferring data between 

them via an additional data transfer file. Use to model used to assess 

conduction, convection or radiation effects and resulting stresses due to the 

thermal effects 

 Coupled Hygro-thermal/Structural Analysis performs a hygro-thermal and 

structural analysis simultaneously, or one after the other, by transferring data 

between them via an additional data transfer file. Use to model the thermo-

mechanical behaviour of concrete at early age and the prediction of cracks due 

to shrinkage. 

Load cases and load types 

 Loadcase adds a new empty loadcase to the Analyses  Treeview. Control 

settings for eigenvalue, fourier and nonlinear and transient analyses can be set 

using the loadcase context menu. 

 Load Curve is used to describe the variation of the loading with time in 

nonlinear, transient and Fourier analyses. 

 Nonlinear Cable Tuning Loadcase for use with nonlinear analysis or staged 

construction modelling, where a nonlinear cable tuning loadcase could be 

created to follow each loadcase representing a construction stage, or follow any 

chosen loadcase or series of loadcases. 

These facilities can also be accessed using the context menu of an analysis entry. 

Dynamic response analysis 

 IMDPlus - the investigation of various dynamic responses using the results 

from an eigenvalue analysis 

Other entries 

 Envelope - create an envelope of maximum and minimum effects. 

 Basic Combination - combine results from different loadcases applying load 

factors to each. 

 Smart Combination - combine results from different loadcases taking into 

account beneficial and adverse load factors to get max and min effects. 

file:///C:/SVN/Content/6analysi/idh_nonlinear_cable_tuning_loadcase.htm
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 Design Combination - used to assign LUSAS loadcases, envelopes or basic 

combinations to predefined load types for a supported design code.  

 Fatigue - calculate fatigue life and number of cycles to failure. 

 IMD Loadcase - create a loadcase for use with interactive modal dynamics. 

 Target Values - specify a target values loadset of chosen components for 

selected features in the model. 

Each of these facilities can also be accessed using the context menu of the Post 

processing entry (once it has been created by defining one of the above) 

The Analyses Treeview 

The Analyses  Treeview provides access to all analysis, loadcase / load curve and 

post-processing information related to a model. From this panel new analyses can be 

defined, new loadcases added, solving of selected analyses carried out, and results 

loadcases can be set active for viewing results. 

 

By default, a base analysis  entry is automatically created in the Analyses  

Treeview by LUSAS Modeller when a new model is defined.  

Additional analysis entries can be added to the Analyses  Treeview from the using 

the Analysis> menu items. New analysis entries, copies of analysis entries, and other 

entries can also be added to the Analyses  Treeview using context menus.  

Analysis entries in the Analyses  Treeview are listed alphabetically for ease of 

location but the order has no relevance to the order in which solving of the various 

analyses takes place. Any analyses that are dependent upon others are automatically 

solved after those analyses. Analyses entries can be copied and pasted within the 

Analyses  Treeview, and when done all loadcases and loading assigned to a model 

is copied with the analysis. Analysis entries cannot be re-ordered. 

An analysis entry cannot itself be made active in order to display loading arrangements 

or to view results. Instead, individual loadcases or load curves within an analysis are 

set active for a given view window. To identify which analysis contains an active 

file:///C:/SVN/Content/Design/idh_design_combinations.htm
file:///C:/SVN/Content/dlg7res/idd_props_imd_load_case.htm
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loadcase a black dot is added to the analysis icon . See Visualising the Results for 

more details.  

Analysis entries are held within folders according to analysis type. Folder names are 

Structural Analyses, Thermal Analyses, Hygro Analyses. 

Main folder 

Context menus for the main model folder  provide the means to view model 

properties and define new analysis types such as Structural, Thermal, Hygro-Thermal, 

Direct Method Influence, Railway Load Optimisation, Vehicle Load Optimisation and 

Linear Cable Tuning. 

Analysis folders 

Context menus for the analysis folders provide the means to define new loadcase 

related entries such as envelopes, basic and smart combinations, and fatigue, IMD and 

target values loadcases as well as new analysis types. The option to 'Close All Results 

Files' does exactly that. The option to 'Sort by Name' lists loadcase and loadcurve 

names alphabetically for all analyses entries. 

Analysis entries 

Within each analysis folder the context menu for each analysis entry provides general 

editing facilities allowing analysis entries to be copied and pasted within the Analyses 

 Treeview, renamed or deleted. Other entries permit selection of which loadcases to 

solve, output options, time management capabilities, the means to add new loadcases, 

the adding of gravity as a property of an analysis, and various Solver related options. 

Loadcase entries 

Loadcases and loadcase dependent assignments (such as loading and supports) are 

displayed within each analysis entry. When solved the results for each loadcase are 

provided separately and can be accessed by using context menus on each loadcase. See 

Loadcases for more details. 

Loadcase names are added to the Analyses treeview in creation order, but can be re-

ordered by using the Sort by Loadcase Name context menu item accessed from the 

Analyses tab. 

Analysis branches (sub-analyses) 

Analysis branches may be added to the Analyses  Treeview by selecting the New > 

Branch context menu item for any loadcase in the Analyses  Treeview that has (or 

inherits) a nonlinear or transient control. These analysis entries carry out a sub-

analysis based upon parameters currently in use by that loadcase. One such example 

would be to carry out a linear moving load analysis of construction equipment during 



  Chapter 6 : Utilities 

    

583 

each stage of the construction of a segmental bridge deck. See Branched analysis for 

more details. 

Copying and pasting analysis, loadcase and other 

attribute data 

 Analysis entries can be copied and pasted within the Analyses  Treeview. 

 Copying an analysis entry in the Analyses  Treeview will copy all Support 

and Loading data for the selected analysis into the newly created analysis 

entry. Note that Geometric and Material attribute data, if defined for an 

analysis, is also copied, otherwise this data is inherited from the Base analysis. 

 Geometric, Material, Support and Loadcase data can also be copied and pasted 

individually between analysis entries by the use of their own context menus. 

 Loadcases may be moved within an analysis with respect to other loadcases, 

and if done so, the numeric identifiers will be updated. 

Post-processing folder 

The  Post processing folder (which only appears when one of the entries on its 

context menu is created) contains entries that may reference loadcase results data from 

more than one Analysis. Its context menu provides the means to create envelopes, 

basic and smart combinations, and fatique, IMD and target values loadcases, delete all 

post-processing entries, or create loadcases from selected combinations. 

The  Combination and envelope results options object provides optional and 

advanced settings. 

Analyses symbols explained 

See "Treeview Panels and Icons" on page 22 for details of all symbols used in the 

Analyses  Treeview. 

Expanding and Contracting Analyses treeview 

entries 

Geometric, Material, Support, and Loading folders in the Analyses  Treeview can 

be expanded or contracted by use of the options list and the 'Specify' button located at 

the bottom of the Analyses treeview panel. Making a selection of one of these folder 

names opens that folder in the treeview. Selecting more than one folder name enables 

a Custom entry. Selecting All or None opens and closes all folders. The Results Only 

option displays only results loadcases. 
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Creating a new analysis 

New analysis entries can be added to the Analyses  Treeview by using the 

Analysis menu item, or by using the context menu for an analysis entry in the 

Analyses  Treeview. The analysis types available for selection will depend upon the 

existing analysis entry in the Analyses  Treeview.  

General settings 

 Set this analysis as the base structural analysis By default this is not checked 

(selected). As a result a new analysis will inherit most of the attribute 

assignments, options and settings etc. of the base analysis. 

 Inherit from base analysis Deselecting the All option provides the means to 

individually select which attribute assignments, options and settings should be 

inherited from a base analysis and, by their non-selection, which should not.  

Initial state 

Specifying an initial state for a new analysis can be set-up with respect to the state of 

the model at any point in another relevant analysis, or by selecting the Edit context 

menu item for an analysis in the Analyses treeview. See "Specifying an initial state for 

an analysis" on page 585 

Advanced output options 

Advanced output options determine what is optionally output to the Solver output file 

or to a History file for an analysis, each time a solve is carried out. See Advanced 

Output Options for an Analysis 

Name 

A name for the new analysis is also required. 

Notes 

 For a summary of how attributes assigned in a base analysis are inherited in 

other dependent analyses see Assignment behaviour of each attribute type 

for more details. 

 The check box for Material also controls whether Composite, Age and 

Damping attributes are inherited or not inherited from a base analysis.  

 For any loadcase in the Analyses  Treeview that has (or inherits) a nonlinear 

or transient control, a branched analysis) may be defined in order to carry out a 

sub-analysis based upon parameters currently in use for that loadcase. See 

Branched analysis for details. 

file:///C:/SVN/Content/6analysi/idh_base_analyses.htm
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Specifying an initial state for an analysis 

Specifying an initial state for a new analysis can be set-up with respect to the state of 

the model at any point in another relevant analysis, or by selecting the Edit context 

menu item for an analysis in the Analyses treeview.  

Deformation 

A deformed mesh of a chosen loadcase from one analysis can be used as the starting 

point for the 'undeformed' mesh in a new analysis. All the coordinates of all nodes in 

the mesh are adjusted based upon a specified deformed mesh factor. 

 Start with undeformed mesh uses the undeformed mesh of the model. This is 

the default. 

 Start with deformed mesh from uses the deformed mesh from a chosen 

Analysis and Loadcase.  

Increment / timestep / eigenvalue 

Where a loadcase consists of multiple loadcase increments: 

 Last (also use this for linear analysis) uses the last increment, time step or 

eigenvalue as the starting point. 

 Specified In the case of a nonlinear, dynamic or eigenvalue analysis a 

particular increment, timestep or eigenvalue can be specified for which the 

deformed mesh data will be used in this analysis. 

 Scale factor adjusts all the coordinates of all nodes in the mesh by scaling them 

by a factor. A scale factor of 0.015 will scale a 1 metre maximum deflection 

down to an initial deformation of 15mm. 

Restart options (for a new analysis) 

When an incremental analysis has failed for some reason and a re-solve is required 

from that point, or if a solution is to be deliberately continued by branching from a 

specified stage reached in a previous solution, two restart options are provided for use 

when a new analysis is created in the Analyses treeview: 

 Continue from failed analysis (restart) For this, the left-hand droplist is filled 

with all the analyses that contain at least one nonlinear / transient control, and 

for which a restart file already exists on disk. Once an analysis is chosen, the 

right-hand droplist is filled with the increments/time-steps found in that restart 

file. For a chosen increment, the new analysis created in the Analyses treeview 

is given an automatic description identifying it as being one that continues from 

a restart. Any modification to the original analysis (change of geometry, 

supports, material, loading, etc) will require that original analysis to be solved 

again, and users should be aware that the new solution may contain differently 
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named / numbered increments, potentially making any continuation from a 

specific increment invalid, requiring the continuation analysis to be re-stated. 

 Continue from specified loadcase (restart) For this, the left-hand droplist is 

filled with all analyses that contain at least one nonlinear / transient control, and 

for which a restart file already exists on disk. Once an analysis is chosen, the 

right hand droplist is filled with the loadcases from that analysis. For as chosen 

loadcase, the new analysis created in the Analyses treeview is given an 

automatic description identifying it as being one that continues from a restart. 

Any modification to the original analysis (change of geometry, supports, 

material, loading, etc) will not require that original analysis to be solved again. 

This is because by choosing an existing loadcase (rather than an increment), 

LUSAS Modeller can automatically detect which increment this corresponds 

to, each time the model is solved.  

 

A restart file must have been written to disk to continue a solution with a new analysis 

as described above. This is done by setting the 'Save a restart at the end of this 

control' option within the nonlinear / transient control dialog. 

Some practical uses of continuing a solution from a specified loadcase include: 

 Evaluating four alternative ways of completing the last 40 stages in a 120 step 

construction sequence. The first 80 steps – identical for all sequences in this 

example – can be solved only once, and the four alternative ‘endings’ stored 

one after the other in the Analyses treeview. 

 Considering three alternative ways of completing the last 3 seconds of a 

transient dynamic analysis or a structure, which share the first 9 seconds. 

 Nonlinear buckling of a partially complete structure – from a particular stage – 

with six independent wind directions, while leaving the whole staged 

construction analysis intact from end to end. 

 Carrying out a trial considering several alternative ways of obtaining 

convergence to the end of an analysis (for example, with different loading 

scenarios, convergence criteria, options etc.) without having to solve all the 

stages from the beginning each time. 

Advanced Output Options for an Analysis 

Advanced output options can be specified as part of initially defining an analysis and 

can be also accessed from the Advanced button on the Export Solver datafile dialog. 

These options determine what is optionally output to the Solver output file or to a 

History file for an analysis, each time a solve is carried out. 

Following results calculation for the whole model, the results written to a results file 

output can be stated to be for all elements in a model (full model), or for only a subset 

file:///C:/SVN/Content/dlg6anal/idd_control_nonlinear_page.htm
file:///C:/SVN/Content/dlg6anal/idd_control_nonlinear_page.htm
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of elements (those part of a group) within a model. Choosing the latter produces 

smaller results files more quickly than would be created for a whole model. 

Results file scope 

 Full model calculates and output results to a results file for all elements in a 

model. 

 <Group> (if groups are present) Choosing a group calculates results for the 

whole model but only outputs results to a results file for those elements within 

the chosen group. The choice of Group also restricts the output options (nodal 

reactions and similar). 

 New... provides the means to create and specify a new group based on selected 

items, or visible items, or just a new empty group to be referenced and added to 

later.. 

Solver output file - Element output 

 Element results such as stress and strain (as controlled by the LUSAS Solver 

options set from the File> Model Properties menu item) can be written to the 

Solver output file at Gauss and/or Nodal positions. 

 History when checked outputs the named variables, and selected node and 

element results from LUSAS Solver to a History file. 

 Scope This has the same options as the results file scope but here the scope is 

defined for element output to the solver output file and history file. 

Solver output file - Node output 

 Node Displacements and Reactions can be written to the Solver output file, 

and also be written to a History file if required. 

 Scope This has the same options as the results file scope but here the scope is 

defined for node output to the Solver output file and history file. 

Solver restart file 

 Generate (if selected) configures the LUSAS Solver data file to create a 

Solver restart file (.rst), which enables a nonlinear, dynamic, transient or 

viscous problem to be restarted after it has been chosen to stop an analysis 

during a solve. 

Base Analysis 

A base analysis is used a reference for other analyses defined in a single model file 

and it is identified by a green solve  icon alongside its Analysis name in the 

Analyses  Treeview. Other analyses present in the Analyses  Treeview that 
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inherit assignments, options and settings from the base analysis are identified by a 

cyan solve  icon.  

 The base analysis should generally be a linear analysis. 

 For models containing both structural and thermal analyses, there are two base 

analyses – one of each analysis type. If a number of analysis types (that may 

include a nonlinear analysis) are to be added to the Analyses  Treeview it is 

sensible and normally suggested, that the base analysis is set to be a simple 

linear static analysis.  

 For influence analysis, the influence results (and therefore the Vehicle Load 

Optimisation results) are based on the properties of the base analysis. 

 Where multiple analyses may have been defined within the model, only the 

geometric properties defined for the base analysis are used in the calculations 

carried out to derive the lengths of any rigid zones present. 

Creating a base analysis 

By default, a base analysis entry is automatically created by LUSAS Modeller when a 

new model is defined, or when a model is read from a previous version. When a new 

general structural or general thermal model is created a base analysis will be the only 

analysis listed in the Analyses  Treeview. A Coupled analysis creates two base 

analysis entries - one for each analysis type. 

When additional analyses are defined in the same model, by default they will inherit 

most of the attribute assignments, options and settings etc. of the base analysis - but it 

is possible to override this default and individually select which attribute assignments, 

options and settings should be inherited from the base analysis and, by their non-

selection, any which should not.  

Attribute dependency across analyses / loadcases 

The following table summarises how attributes assigned in a base analysis are 

inherited in other dependent analyses. 
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Attribute type Behaviour 

Mesh, Local 
coordinates, 
Equivalence, Search 
Area, Crack Tip, 
Retained Freedom, 
Results Transformation, 
Inspection Locations, 
Wood-Armer, Steel 
Frame Design, RC Slab 
Design 

Assignments apply to all analyses 

Damping, Geometric, 
Material (Composites, 
Age, Damping) 
Radiation Surface, 
Section Property 
Modifier, Thermal 
Surface, User Attributes  

Assigned per-analysis. Optionally inherited from a base analysis. 
Appear in their own folder in the Analyses Treeview.  

Note that the Geometric entry also controls whether Section Property 
Modifier attributes are inherited or not. 

Note that Material entry also controls whether Composite, Age and 
Damping attributes are inherited or not. 

Note that radiation surfaces and thermal surfaces, unlike slidelines, 
cannot change type during an analysis. 

The User setting only appears if a User attribute has been defined 
(advanced use only) 

Supports, Constraints Optionally inherited from the first loadcase of a base analysis.  

Supports and constraints can be assigned to any loadcase (in a 
nonlinear model) but note that only supports and constraints from the 
first loadcase of a base analysis can be inherited between analyses. 
Supports and constraints in other loadcases are not inherited. 

Loading, Activate, 
Deactivate 

Not inherited between analyses. 

Transformation Not an attribute that is used on a per-analysis basis. 

Thermal gap Not an attribute that is used on a per-analysis basis, but note that 
thermal gap definitions contain a ‘change’ loadset. The definition 
dialog checks that all referenced thermal surfaces are assigned in 
the same analysis, and that this is the same analysis as the change 
loadset. An error message is generated if this is not the case. 

Reciprocal Influence Assigning a reciprocal influence creates an analysis to contain it. 

Direct Method Influence Can only be assigned with a Direct Method Influence Analysis 

Making changes to analyses referencing a base 

analysis 

If any changes are made to attribute assignments, options and settings in an analysis 

that is linked to a base analysis those specific changes will then override any 

behaviour it was previously inheriting from the base analysis. For example, consider a 

model having two analyses with Analysis 1 defined as the base analysis with a "steel 

material" assigned to all surfaces. By default, Analysis 2 will inherit those material 

assignments, and "steel material" would appear to be assigned in Analysis 2 as well. 

But if a different material, say "aluminium", were to be assigned to a single surface in 
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Analysis 2 that single assignment would override the previous "steel material" 

assignment, but only for that assigned surface. When solving the model all surfaces 

would be solved with "steel material" properties in both analyses with the exception of 

the surface that had "aluminium" assigned to it in Analysis 2. This surface would be 

solved using "steel material" in Analysis 1 and "aluminium" in Analysis 2. 

Setting an existing analysis to be a base analysis 

Only an existing general structural, thermal or hygro-thermal analysis entry (as 

marked by a cyan solve  icon in the Analyses  Treeview) can be set to be a base 

analysis. This is done by selecting its context menu and choosing Edit... to access the 

Analysis definition dialog. Note that setting a different analysis as a base analysis can 

have a significant impact on all other analyses because all inherited attribute 

assignments will be affected.  

Multiple Analyses within a Single Model 

Within a single model file multiple analyses may be defined. Each analysis will inherit 

most of the assignments, options and settings of the base analysis for the model. The 

base analysis should generally be a linear analysis. Analyses that inherit from a base 

analysis are identified by a cyan coloured 'Analysis'  icon. 

Use of the multiple analyses facility does away with the need to create separate 

models, or maintain “clone” copies of a model, in order to switch between and create 

results from linear static analysis and other analysis types. It also overcomes the need 

to load results files from a variety of different models on top of one model in order to 

carry out combinations of loadcases from those different models. 

Examples of use 

There are many situations where multiple analyses within the one model file should be 

employed. A few examples are stated here: 

 Where static analysis and dynamic analyses are both of significance as, for 

example, in footbridge design. Multiple analyses would be stored in the same 

model with typically the same attribute assignments but with different analysis 

controls and loadcases appropriate to the analysis in question. 

 Where static analysis and influence analysis are both of significance, as in 

bridge design. 

 Where it is required to combine load effects derived from models that are 

identical in terms of mesh, but have some attributes changed, such as the use of 

long term concrete modulus for some loadcases and short term concrete 

modulus for others.  

 Where superposition of effects with different material properties needs to be 

considered as, for example, with linear analyses of any beam and slab deck 
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structure where effects arising over long term and short term need to adopt 

appropriate Young’s Modulii of concrete. 

 For buckling analysis of symmetrical structures, where the unstressed 

deformed mesh derived from an eigenvalue buckling analysis (with a 

magnitude multiplier) is typically required as the starting point for a 

subsequent nonlinear analysis.  

 For sensitivity analyses, such as soil-structure interaction analyses where a 

range of analyses could represent clone models with differing material 

properties, support stiffnesses etc. Results from those analyses could be 

enveloped to ensure that design makes adequate allowance for uncertainties.  

 For a static-nonlinear analysis method where a structure is subjected to gravity 

loading and a monotonic displacement-controlled lateral load pattern which 

continuously increases through elastic and inelastic behavior until an ultimate 

condition is reached) may require several analyses to achieve the analysis goal.  

Branched analyses 

As well as defining multiple analyses, branched analysis entries may be added to the 

Analyses  Treeview by selecting the New > Branch context menu item for any 

loadcase in the Analyses  Treeview that has (or inherits) a nonlinear or transient 

control. These analysis entries carry out a sub-analysis based upon parameters 

currently in use by that loadcase. One such example would be to carry out a linear 

moving load analysis of construction equipment during each stage of the construction 

of a segmental bridge deck. See Branched analysis for more details. 

Branched Analyses 

Analysis branches may be added to the Analyses  Treeview by selecting the New > 

Branch context menu item for any loadcase in the Analyses  Treeview that has (or 

inherits) a nonlinear or transient control. They allow the creation and solution of one 

or more sub-analyses to investigate the response of the model at a particular loadcase 

or "stage". Any number of sub-analyses may be defined for a single parent loadcase.  

Examples of use include: 

 Performing a linear moving load analysis of construction equipment during 

each stage of the construction of a segmental bridge deck,  

 Performing an eigenvalue natural frequency analysis or a buckling analysis 

during construction. 

 Performing a phi-c reduction analysis to derive safety factors for a geotechnical 

model from each stage in an excavation process. 
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 Performing an earthquake analysis where gravity is applied in a static nonlinear 

step, then the earthquake is run as a transient branch. Several sample 

earthquakes may be run in each branch. 

Each loadcase representing a construction stage in the main analysis will have its own 

loading which is governed by the nonlinear / transient control for the loadcase. This 

loading will change the stiffness matrix in order to meet the termination criteria 

specified in the control. Once the nonlinear control is satisfied, and the stiffness matrix 

is known, each analysis branch then uses that stiffness matrix as its starting point. 

Once each sub-analysis has completed, any subsequent stage starts again at the end of 

the previous nonlinear control – it does not follow on from any of its sibling sub-

analysis branches. So, each analysis branch is therefore an independent sub-analysis, 

and if more than one is defined for a single loadcase, all occur 'simultaneously', not 

'sequentially'. 



  Chapter 6 : Utilities 

    

593 

 

Branched analysis schematic 

Branch types 

An analysis branch is denoted by this icon  in the Analyses  Treeview. Four 

branch types are available: 

Analysis Types 

LUSAS may be used to numerically model a wide range of engineering problems. The 

following section briefly explains the analysis types available. 
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Structural analysis 

 Linear Analysis is the most common analysis carried out by engineers and 

unless specified otherwise, By default, LUSAS will perform a linear elastic, 

static structural analysis or a steady state thermal/field analysis (according to 

the user interface in use). In these types of analysis multiple loadcases can be 

accommodated but the model geometry and other boundary conditions cannot 

be altered. Linear analysis assumes that: 

 The loads are applied instantaneously and transient effects are ignored.  

 The loaded body instantaneously develops a state of internal stress so as 

to equilibrate the total applied loads.  

 The structural response is linear, i.e. both the geometric and material 

response are assumed to be linear. 

General settings 

An analysis can be optionally set as a base analysis analysis, or to optionally inherit a 

number of attribute assignments, options and settings etc. of the base analysis. 

Specifying an initial state for an analysis 

When defining an analysis, an undeformed or deformed mesh of a chosen loadcase or 

load increment, time step, or eigenvalue from one analysis can be used as the starting 

point for the 'undeformed' mesh of another structural or thermal analysis. The 

coordinates of all nodes in the mesh can be adjusted based upon a specified deformed 

mesh factor. Initial deformations are specified as a property of an analysis. See 

Specifying an Initial State for an Analysis. 

Restarting an analysis 

Where an incremental analysis has failed for some reason and a re-solve is required 

from that point, or if a solution is to be deliberately continued by branching from a 

specified stage reached in a previous solution, restart options are provided for use 

when a new analysis is created in the Analyses treeview. See the heading 'Restart 

Options' in Specifying an Initial State for an Analysis. 

Advanced options 

Advanced output options can be specified as part of initially defining a Structural 

Analysis (or Thermal or Hygro-Thermal Analysis) and can be also accessed from the 

Advanced button on the Export Solver datafile dialog. These options determine what 

is optionally output to the Solver output file or to a History file for an analysis, each 

time a solve is carried out. Following results calculation for the whole model, the 

results written to a results file output can be stated to be for all elements in a model 

(full model), or for only a subset of elements (those part of a defined group) within a 

model. Choosing the latter produces smaller results files more quickly than would be 

created for a whole model. 
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A Solver restart file (.rst) can be created which enables a failed or terminated 

nonlinear, dynamic, transient or viscous analyses to be restarted from the last saved or 

chosen increment or loadcase. 

Analyses defined as a property of a loadcase 

The solving of analyses other than a linear analysis or a steady state thermal/field 

analysis requires an analysis control to be specified. Analysis controls are specified as 

a property of a loadcase. Loadcases can be seen and are accessed within each analysis 

entry in the Analyses  Treeview. 

The control parameters for the following analysis types are specified as properties of a 

loadcase.  

 Nonlinear Analysis is used to model significant changes in geometry, material 

or boundary conditions. Significant geometry deformation may occur due to the 

applied loading. Changes in material may occur due to material yield. Changes 

in boundary conditions may occur due to the lift-off of supports or from 

changes in contact or frictional behaviour. Examples of nonlinear analyses 

include P-Delta Analysis, Creep Analysis and Impact Dynamics. 

 Transient analysis is used to carried out analyses over a period of time and is 

progressed in a step-by-step manner, giving results at each time-step. Both 

Transient Dynamic Analysis and Transient Thermal Analysis are available. 

 Eigenvalue Analysis is available to compute the Natural Frequencies of a 

structure or to carry out an Eigenvalue Buckling Analysis in order to estimate 

the maximum load that can be supported by a stiff structure prior to structural 

instability. Eigenvalue Stiffness may also be performed on the stiffness matrix 

at a selected stage of an analysis. This facility can be used in conjunction with a 

nonlinear analysis to predict structural instability or bifurcation points during a 

geometrically nonlinear analysis. 

 Fourier Analysis provides an extended form of axisymmetric analysis where 

applied loading can be considered to be non-axisymmetric when applied using 

a Fourier distribution around the circumference. 

 Coupled Analysis performs a thermal/structural analysis or a hygro-

thermal/structural analysis either one after the other, or simultaneously, with 

a continuous transfer of information between the two analyses. 

Other analyses 

Other generally available or software product-restricted analyses (that do not require 

analysis controls to be specified) include: 

 Direct Method Influence Analysis - used to create an influence line or surface 

by way of a unit load placed at each node or grid location on the loadable area 

of a structure.  
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 Vehicle Load Optimisation - used to identify critical vehicle loading patterns 

on bridges and apply these loading patterns to LUSAS analysis models. 

 Railway Load Optimisation - used to identify critical train loading patterns on 

bridges and apply these loading patterns to LUSAS analysis models 

 Linear Cable Tuning Analysis - calculates load factors for selected lines in a 

model that represent cables in order to achieve defined target values set for 

various components or features. 

Solver-based analyses 

The following analysis types are also possible in Solver but the tabulation of the 

harmonic analysis control is not fully supported by LUSAS Modeller: 

 Harmonic Response Analysis The behaviour of a structure subjected to 

vibrating loads can be analysed without the need for a full dynamic step-by-

step analysis. See also Modal Response analysis. 

 Temperature dependent materials The definition of temperature dependent 

materials in a tabular form are supported by LUSAS Solver. See Solver 

Reference Manual for details. 

Nonlinear Analysis 

Nonlinear analysis controls are defined as properties of a loadcase. To do so, in the 

Analyses  Treeview access the context menu for a loadcase and from the Controls 

menu item select the Nonlinear and Transient option to define the required controls. 

The Nonlinear and Transient object  created stores and provides the means to 

modify the control settings. Nonlinear analysis options can be specified separately for 

each loadcase and each analysis present. See Nonlinear solution procedures for more 

information. 

What is Nonlinear Analysis? 

Linear finite element analysis assumes that all materials are linear elastic in behaviour 

and that deformations are small enough to not significantly affect the overall 

behaviour of the structure. Obviously, this description applies to very few situations in 

the real world, but with a few restrictions and assumptions linear analysis will suffice 

for the majority of engineering applications.  

The following indicate that a nonlinear finite element analysis is required: 

 Gross changes in geometry 

 Permanent deformations 

 Structural cracks 

 Buckling 

 Stresses greater than the yield stress 

file:///C:/SVN/Content/Bridge/Vehicle_Load_Optimisation/Vehicle_Load_Optimisation_Overview.htm
file:///C:/SVN/Content/Bridge/Rail_Load_Optimisation/Rail_Load_Optimisation_Overview.htm
file:///C:/SVN/Content/6analysi/idh_linear_cable_tuning_analysis.htm
file:///C:/SVN/Content/6analysi/idh_harmonic_response_analysis.htm
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 Contact between component parts 

Good practice when carrying out nonlinear analysis 

It is good practice to perform a linear static analysis prior to carrying out a nonlinear 

analysis. This eliminates the added complexities of the nonlinear variables and will 

enable a check on the basic performance of the structure for the applied loadings. Any 

warning or error messages in the LUSAS output file should be investigated.  

It is advisable when progressing a model to add-in nonlinear behaviour in stages. For 

example in a material and geometrically nonlinear run containing slidelines it would 

probably be advisable to start with only slidelines, then add the geometric nonlinearity 

and finally add the nonlinear material effects. By proceeding in this manner will 

ensure that each nonlinear procedure is stable before progressing to the next. 

Nonlinear Analysis Types 

Three types of nonlinear analysis may be modelled using LUSAS: 

 Geometric Nonlinearity e.g. large deflection or rotation, large strain, non-

conservative loading. 

 Boundary Nonlinearity e.g. lift-off supports, general contact, compressional 

load transfer, dynamic impact. 

 Material Nonlinearity e.g. plasticity, fracture/cracking, damage, creep, 

volumetric crushing, rubber material. 

The LUSAS analysis types within which nonlinear geometric and material effects may 

be incorporated are shown in the following table: 
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Analysis Type    Geometric Nonlinearity     Material Nonlinearity  

Static   yes   yes 

Dynamic   yes   yes 

Thermo mechanical   yes   yes 

Creep   yes   yes 

Natural Frequency   yes   yes 

Eigenvalue Buckling   -   - 

Spectral Response   -   - 

Harmonic Response   -   - 

Fourier Analysis   -   - 

Field or Thermal   -   yes 
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Geometrically Nonlinear Analysis 

Geometric nonlinearities arise from significant changes in 

the structural configuration during loading. Common 

examples of geometric nonlinearity are plate structures 

which develop membrane behaviour, or the geometric 

bifurcation of truss or shell structures. The changing 

application of loads or boundary conditions are also 

geometrically nonlinear effects. The figure below shows 

two simple structural examples which serve as good 

illustrations of geometrically nonlinear behaviour. 

 For the simply supported beam (top image) the 

linear solution would predict the familiar simply 

supported bending moment and zero axial force. In 

reality as the beam deforms its length increases and 

an axial component of force is introduced.  

 For the loaded strut (bottom image) the linear 

solution would fail to consider the progressive eccentricity of the vertical load 

on the bending moment diagram.  

In both these cases depending on how large the deflections were, serious errors could 

be introduced if the effects of nonlinear geometry were neglected. 

In LUSAS geometric nonlinearity can be accounted for using these formulations / 

analysis methods: 

 Total Lagrangian 

 Updated Lagrangian 

 Eulerian 

 Co-rotational 

 P-Delta 

 Nonlinear analysis control options for these methods are accessed via the Nonlinear 

analysis options control object  in the Analyses  Treeview.  

Total / Updated Lagrangian, Eulerian and Co-Rotational 

formulations 

These formulations are valid for arbitrary large deformations. In general, if rotational 

degrees of freedom are present, rotations must be small for Total Lagrangian. An 

exception to this rule is the Total Lagrangian formulation for thick shell elements 

where large rotations may be applied. Large rotations are allowed for Updated 

Lagrangian (provided that they are small within each load increment) or Eulerian. The 

glossary.chm::/Glossarybifurcation_point.htm
glossary.chm::/Glossaryboundary_conditions.htm
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co-rotational formulation is unconditionally valid for large rotations and results are 

generally independent of load step size. 

For most elements these formulations are valid for small strains. For some elements 

the Updated Lagrangian and Co-rotational formulations are valid for moderately large 

strains. The Eulerian formulation is also generally valid for moderate strains. In 

general, the Total Lagrangian is a more robust formulation, which is usually able to 

cope with substantial load increments. The Updated Lagrangian, and particularly 

Eulerian, formulations generally require smaller load increments in order to avoid a 

divergent solution. 

Standard geometrically nonlinear formulations account for the change in position of 

the loading, but not the change in direction relative to the deformed configuration. 

Loading is always conservative for the Total Lagrangian geometrically nonlinear 

formulations (that is, the load is always applied in the same direction as was initially 

prescribed). Using an Updated Lagrangian formulation, the geometry is updated at the 

end of each increment and the applied loads may maintain the same relative 

orientation as to the original surface (depending on element and load types). Therefore 

non-conservative loading can be increment size dependent. True non-conservative 

loading may only be achieved by using the Eulerian and co-rotational formulations. 

The choice of a particular formulation is both problem and element dependent (the 

element formulation determining which strain formulations are available). The 

availability of each formulation is given for each element in the Element Reference 

Manual. For further details regarding the geometrically nonlinear formulations refer to 

the Theory Manual. 

P-Delta analysis method 

P-Delta analyses are approximate geometrically nonlinear analyses, and are typically 

used to take account of the interaction between vertical and horizontal (sway) loading 

on tall, slender structures.The use of P-Delta analysis is limited to a certain type of 

problem, that is, where axial (or membrane) stiffening/softening is important within a 

small displacement analysis. It is therefore not as generally applicable as a full 

geometric nonlinear analysis.  



  Chapter 6 : Utilities 

    

601 

Nonlinear Boundary Conditions 

Deformation dependent boundary condition models 

account for the modifications to the external restraints 

resulting from support lift-off, or smooth or frictional 

contact within an analysis. Within LUSAS node on 

node contact may be accounted for using joint 

elements and arbitrary contact may be accounted for 

using slidelines. 

Consider the simple example shown in the figure right 

in which the structure and its supporting surface can 

resist being pushed together, but not being pulled apart. 

The required contact condition may be imposed by 

using joint elements to connect between the structure 

and the rigid support, and specifying a nonlinear 

contact joint model incorporating large and zero local 

stiffness in compression and tension respectively. Note 

that it is possible to use a simplified linear lift-off 

support via support attributes also. 

 

Materially Nonlinear Analysis 

Materially nonlinear effects arise from a nonlinear constitutive model (that is, 

progressively disproportionate stresses and strains). Common examples of nonlinear 

material behaviour are the plastic yielding of metals, the sudden fracture of granular 

composites such as concrete, or time-dependent behaviour such as creep. 

LUSAS incorporates a variety of nonlinear constitutive models, covering the 

behaviour of the more common engineering materials. Details of these material 

models and their applicability to each LUSAS element are described in About 

Material Properties which should be read in conjunction with the Element Reference 

Manual. 

glossary.chm::/Glossaryconstitutive_relationship.htm
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Nonlinear Solution Procedures 

For nonlinear analysis, 

since it is no longer 

possible to directly obtain a 

stress distribution which 

equilibrates a given set of 

external loads, a solution 

procedure is usually 

adopted in which the total 

required load is applied in a 

number of increments. 

Within each increment a 

linear prediction of the 

nonlinear response is made, 

and subsequent iterative 

corrections are performed in order to restore equilibrium by the elimination of the 

residual or out of balance forces. 

The iterative corrections are referred to some form of convergence criteria which 

indicates to what extent an equilibrium state has been achieved. Such a solution 

procedure is therefore commonly referred to as an incremental-iterative (or 

predictor-corrector) method shown in the figure above. In LUSAS, the nonlinear 

solution is based on the Newton-Raphson procedure. The details of the solution 

procedure are controlled using the nonlinear control properties assigned to loadcase. 

For the analysis of nonlinear problems, the solution procedure adopted may be of 

significance to the results obtained. In order to reduce this dependence, wherever 

possible, nonlinear control properties incorporate a series of generally applicable 

default settings, and automatically activated facilities. 

Iterative Procedures 

In LUSAS the incremental-iterative solution is based on Newton-Raphson iterations. 

In the Newton-Raphson procedure an initial prediction of the incremental solution is 

based on the tangent stiffness from which incremental displacements, and their 

iterative corrections may be derived. 

Standard Newton-Raphson Procedure 

In the standard Newton-Raphson procedure each iterative calculation is always based 

upon the current tangent stiffness. For finite element analysis, this involves the 

formation (and factorisation) of the tangent stiffness matrix at the start of each 

iteration. 

Although the standard Newton-Raphson method generally converges rapidly, the 

continual manipulation of the stiffness matrix is often expensive. The need for a robust 
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yet inexpensive procedure therefore leads to the development of the family of 

modified Newton-Raphson methods. 

Iterative Acceleration (Line Searches) 

A slow convergence rate may be significantly improved by employing an iterative 

acceleration technique. In cases of severe and often localised nonlinearity, 

encountered typically in materially nonlinear or contact problems, some form of 

acceleration may be a prerequisite to convergence. 

In LUSAS, iterative acceleration may be performed by applying line searches. In 

essence, the line search procedure involves extra optimisation iterations in which the 

potential energy associated with the residual forces at each iterative step are 

minimised. Line search application is controlled via parameters on the Iteration section 

of the Nonlinear Control properties. 

The selection of line search parameters is problem dependent and largely a matter of 

experience. However, a maximum of 3 to 5 line search iterations with a tolerance of 

0.3 to 0.8 is usually sufficient (the closer the tolerance is to unity, the more slack the 

minimum energy requirement). 

Separate Iterative Loops 

In problems where both material and contact nonlinearities are present, convergence 

difficulties can arise when evaluating material nonlinearities in configurations where 

the contact conditions are invalid because the solution is not in equilibrium. To avoid 

this situation contact equilibrium can be established using elastic properties from the 

previous load increment before the material nonlinearity is resolved. The option to 

define separate iterative loops is defined on advanced solution strategy dialog which 

can be found on the nonlinear control dialog. 

See the LUSAS Theory Manual for further details. 

Incremental Procedures 

For the Newton-Raphson solution procedures it is assumed that a displacement 

solution may be found for a given load increment and that, within each load increment, 

the load level remains constant. Such methods are therefore often referred to as 

constant load level incrementation procedures. 

However, where limit points in the structural response are encountered (for example 

in the geometrically nonlinear case of snap-through failure) constant load level 

methods will, at best, fail to identify the load shedding portion of the curve and, at 

worst, fail to converge at all past the limit point. The solution of limit point problems 

therefore leads to the development of alternative methods, including displacement 

incrementation and constrained solution methods. 
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Constrained Solution Methods (Arc-Length) 

Constrained methods differ from constant level methods in that the load level is not 

required to be constant within an increment. In fact the load and displacement levels 

are constrained to follow some pre-defined path. 

In LUSAS two forms of arc-length method have been implemented: 

 Crisfields modified arc-length procedure in which the solution is constrained to 

lie on a spherical surface defined in displacement space. For the one degree of 

freedom case this becomes a circular arc. 

 Rheinboldts arc-length algorithm which constrains the largest displacement 

increment (as defined by the predictor) to remain constant for that particular 

increment. 

The use of the arc-length method has the following advantages over constant load 

level methods 

 Improved convergence characteristics 

 Ability to detect and negotiate limit points 

In LUSAS, control of arc-length solution procedures is via the Incrementation section 

of the Nonlinear Control properties. If required, the solution may be started under 

constant load control, and automatically switched to arc-length control based on a 

specified value of the current stiffness parameter (defined as the scaled inner product 

of displacements and loads). The required stiffness parameter for automatic conversion 

to arc-length control is input in the Incrementation section of Nonlinear Control 

properties. 

Where limit points are encountered, LUSAS will automatically determine the sign of 

the next load increment by the sign of the determinant of the stiffness matrix. This is 

a reliable method in most cases, however, it will often fail in the vicinity of bifurcation 

points when negative eigenvalues may cause premature unloading. In such cases the 

load reversal criteria may be optionally changed to be dependent on the sign of the 

current stiffness parameter. This method is better at coping with bifurcation points, 

but will always fail when a snap-back situation is encountered. 

Note. In certain circumstances, notably in the presence of strain-softening, the arc-

length method may converge on alternative, unstable equilibrium paths. 

Bracketing Critical Points and Branch Switching 

Bracketing can be used to locate a limit or bifurcation point during a geometrically 

nonlinear analysis. The nonlinear analysis is executed and one of three methods is 

used to isolate the first critical point. 

 Bi-section 
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 Interpolation 

 Riks semi-direct approach 

 

Two further options for the bracketing procedure exist depending on whether the 

material response is elastic (reversible) or plastic/path dependent (irreversible). Only 

the first critical point can be processed and a subsequent eigenvalue analysis must be 

invoked to determine whether the critical point encountered is a limit or bifurcation 

point. A limit point may be defined as the point at which load starts to decrease as 

displacements increase (e.g. the snap through of a shallow arch). In this instance the 

structure may not have failed completely and could subsequently still be capable of 

carrying more load. A bifurcation point indicates that the solution of the nonlinear 

differential equations has encountered an alternative unstable solution path or paths 

which may be followed instead of the stable equilibrium path. The branch switching 

procedure must then be undertaken if an unstable equilibrium path is to be followed. 

The branch switching procedure should only be carried out within a restart analysis 

after bracketing has been successfully completed. Two options exist for guiding the 

solution onto a secondary path. 

 Eigenmode injection 

 Artificial force and Rheinboldts arc 

Incremental Loading 

Incrementation for nonlinear problems may be specified in four ways: 

 Manual Incrementation where the loading data in each load increment is 

specified separately.  

 Automatic incrementation where a specified loadcase is factored using fixed 

or variable increments.  

 Mixed Incrementation Mixed manual and automatic incrementation. 

 Load Curves where the variation of one or more sets of loading data is 

specified as a graph of load factor vs. load increment or time step. 

 

The choice and level of incrementation will depend on the problem to be solved. See 

the flowchart Specifying Manual or Automatic nonlinear loadcase controls later in 

this topic for more information. 

Automatic Load Incrementation 

Two methods of automatic incrementation are available: 

 Uniform Incrementation By default, uniform incrementation will be applied. 

That is, for each increment the current load factor will be multiplied by the 

specified load components to generate the applied load.  
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 Variable Incrementation Alternatively, variable incrementation may be 

requested. In this case the current load factor will be automatically varied 

according to the iterative performance of the solution. The variation is a 

function of the required number of iterations and a specified desired iterative 

performance. Thus, where the number of iterations taken is less than the desired 

value the incremented load factor will subsequently be increased, and 

conversely, if the number of iterations is greater than the desired value, it will 

be decreased. Variable incrementation may be used in conjunction with either 

constant load level or arc-length solution methods and is an effective way of 

automatically adapting the performance of the solution procedure to the degree 

of nonlinearity encountered. The overall effect is therefore to increase and 

decrease the numerical effort in the areas of most and least nonlinearity 

respectively. 

Mixing Manual And Automatic Incrementation 

If required, manual and automatic incrementation procedures may be mixed freely. 

When mixing manual and automatic incrementation the following rules apply: 

 Loadcases may be respecified as often as required. 

 If the automatic procedure is specified, it will continue until one of the 

termination criteria is satisfied. 

 In switching from manual to automatic control, any loading input under the 

manual control is remembered and held constant, while the automatic 

procedure is operating. 

 In switching from automatic back to manual control, any loading accumulated 

under automatic control is forgotten and must be input as a manual loadcase if 

required. 

 If prescribed displacements are being used, then in any switching from one 

type of control to another, the effect of prescribed displacements will be 

remembered and will not need to be input again. 

Essentially: 

 Defining Manual incrementation requires the total loading within the loadcase 

for which the nonlinear control has been specified, to be defined. 

 Defining Automatic incrementation requires only the extra loading within the 

loadcase to be defined, because other loading that was specified in a previous 

loadcase with Manual incrementation will be inherited. 
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Automatic Increment Reduction 

Where an increment has failed to converge within the specified maximum number of 

iterations it will be automatically reduced and re-applied. This will be repeated 

according to values specified in the step reduction section (Advanced Nonlinear 

Incrementation Parameters dialog) until the maximum number of reductions has been 

tried. In a final attempt to achieve a solution the load increment is then increased to try 

and step over a difficult point in the analysis. If after this the solution has still failed to 

converge the solution is terminated. 

Solution Termination 

When using manual incrementation, the solution will automatically terminate 

following execution of one increment. With automatic incrementation, the solution 

progresses one Nonlinear Control chapter at a time. The finish of each Nonlinear 

Control chapter is controlled by its Termination parameters. 

Termination may be specified in 3 ways: 

 Limiting the maximum applied load factor. 

 Limiting the maximum number of applied increments. 

 Limiting the maximum value of a named freedom. 

Where more than one criteria is specified, termination will occur on the first criteria to 

be satisfied. 

Failure to converge within the specified maximum number of iterations will either 

result in a diagnostic message and termination of the solution or, if automatic 

incrementation is being used, a reduction of the applied load increment. If required the 

solution may be continued from an unconverged increment (Option 16, 17), although 

the consequences of such an action should be appreciated. 

In addition, the solution will be terminated if, at the beginning of an increment, more 

than two negative pivots are encountered during the frontal elimination phase. 

Use of Load Curves 

Load curves are used to simplify the input of load data in situations where the 

variation of load is known with respect to a certain parameter. An example of this 

could be the dynamic response of a pipe to an increase of pressure over a given period. 

The load curve would consist of the definition of the load and its variation with time. 

Specifying Manual or Automatic nonlinear loadcase controls  

The following flow chart can be used to decide if Manual or Automatic controls need 

to be defined for a nonlinear loadcase. Use total loads in each nonlinear step. 
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Flow chart to determine whether to use Manual or Automatic nonlinear loadcase control  

(This chart is not applicable to time domain problems or those using load curves, where 'Manual' 

incrementation should generally be used.) 

Nonlinear Solution Convergence Criteria 

The convergence criteria specifies to what extent the numerical iterative procedure has 

reached the true equilibrium state. The specification of convergence therefore involves 

two considerations: 

 Type of convergence criterion. 

 Convergence tolerance. 

The types of convergence criteria incorporated in LUSAS are as follows: 

 Absolute residual norm 

 Root mean square residual norm 

 Displacement norm 

 Residual force norm 

 External work norm 

 Incremental displacement norm 
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The convergence tolerance for each criteria is specified in the Solution parameters and 

advanced solution parameters section of the Nonlinear Control properties. The 

selection of a convergence criteria, and the associated tolerance, is problem dependent. 

However, the following points should be considered: 

Clearly, the convergence criteria must not be too slack so as to yield an inaccurate 

solution, nor too tight so as to waste computer time performing unnecessary iterations. 

In general, sensitive geometrically nonlinear problems require a tight convergence 

criteria, whereas with predominantly materially nonlinear problems, larger local 

residuals may be tolerated. 

Where more than one criteria has been specified, convergence will be assumed only on 

the satisfaction of all specified tolerances. 

The following considerations apply to individual convergence parameters: 

 Absolute Residual Norm is of limited use owing to its dependence upon the 

units being used. It is a strict criteria and for some problems, especially those 

involving plasticity, it may be very difficult to reduce locally large residuals. 

However, in sensitive geometrically nonlinear problems near bifurcation points, 

it can sometimes be necessary to ensure that large residuals are completely 

eliminated. 

 Root Mean Square Residual Norm is the square root of the average of the 

squares of the residual forces and is generally more applicable than the above, 

but is still dependent upon the units being used. 

 Displacement Norm is the sum of the squares of all the iterative displacements 

as a percentage of the sum of the squares of the total displacements and is a 

useful measure of how much the structure has moved during an iteration. Being 

a scaled norm it is not affected by units but convergence is not guaranteed. 

Typical values of slack and tight norms are (5.0 - 1.0) and (0.1 - 0.001) 

respectively. 

 Residual Force Norm is the sum of the squares of all the residual forces as a 

percentage of the sum of the squares of all the external forces. This is the most 

versatile of the five criteria. Typical slack and tight values lie between (10.0 

and 5.0) and (0.1 and 0.00001) respectively. 

 External Work Norm is the work done by all the residuals acting through the 

iterative displacements, as a percentage of the work done by the loads on 

iteration zero of the increment. Since all freedoms are considered it is very 

versatile (the default displacement and force norms consider only the 

translational freedoms). However, it should be noted that a minimum detected 

potential energy need not necessarily coincide with the equilibrate state. 

Typical values of slack and tight norms are (0.1 - 0.001) and (10-E6 - 10-E9) 

respectively. 
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 Incremental Displacement Norm is the sum of the squares of all the iterative 

displacements as a percentage of the sum of the squares of the total 

displacements for the increment. This norm is an incremental form of the total 

displacement norm previously described and the same comments regarding 

usage apply. 

Nonlinear Output Control 

Nonlinear analyses may generate a vast amount of output. In addition to the normal 

nodal and element output controls, the frequency of nonlinear solution output may be 

restricted via the Output section in the Nonlinear Control properties. 

The restart output facility enables failed or terminated analyses to be restarted from the 

last saved restart output dump. This is particularly useful where the termination of the 

analysis was due to a failure of the solution process rather than that of the structure. In 

this way, the solution may be restarted from the last converged increment with a 

different or modified solution strategy. For example, a failed increment may be 

restarted under either constant load or arc-length control. Restarts are not supported by 

LUSAS Modeller and hence must be defined directly in a LUSAS Solver data file. 

The Nonlinear Logfile 

During the course of a nonlinear analysis, various information is output to the screen 

or logfile, so that you may assess the performance of the solution. For more 

information refer to the Solver Reference Manual. 

Creep/Viscoelastic Analysis  

Nonlinear viscous behaviour occurs when the relationship between stress and strain is 

time dependent. The viscous response is usually a function of the material properties, 

stress, strain and temperature history. Unlike time independent plasticity where a 

limited set of yield criteria may be applied to many materials, the viscous response 

differs greatly for different materials. 

A creep/viscoelastic analysis may be carried out using a linear or nonlinear material 

model within a nonlinear, transient dynamic or thermo-mechanically coupled analysis. 

When carried out in a nonlinear analysis inertia effects are neglected and the time 

component is introduced using viscous control. To do so, in the Analyses  

Treeview access the loadcase context menu and choose the Controls menu item. The 

Nonlinear and Transient object  created provides the means to modify the control 

settings.   

When using viscous control, automatic time step calculations are only available when 

creep is included in the analysis. 

 Creep material properties are defined using the Attributes> Material> 

Isotropic / Orthotropic menu item. 
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 Viscoelastic material properties are defined using the Attributes> Material> 

Isotropic / Orthotropic menu item. 

 

Consolidation Analysis 

Consolidation is the process in which reduction in soil volume takes place by 

expulsion of water under long term static loads. It is a typical diffusion process in 

which the field changes rapidly at the start of the process before settling down to a 

steady state condition a considerable time after the initial load is applied. As a result, 

time step parameters must be defined, and these are based upon currently set timescale 

units.  

A consolidation analysis is controlled using nonlinear and transient loadcase control 

properties which are defined as properties of a loadcase. To do so, in the Analyses  

Treeview access the loadcase context menu and choose the Controls menu item. The 

Nonlinear and Transient object  created provides the means to modify the control 

settings. Nonlinear analysis options can be specified separately for each analysis 

present.  

Specifying an automatic time stepping procedure enables the time step to be modified 

so that the small time steps required at the start of the problem can be increased as the 

analysis progresses. In some cases the overall response time can be orders of 

magnitude larger than the initial time step. The value of the initial time step is 

important since the early variations in pore pressure must be accurately accounted for. 

Vermeer and Verruijt suggest the following criteria for determining the initial time 

step:  

 

where 'delta h' is the minimum distance between mesh nodes, which can be determined 

by selecting the two nodes and picking the Tools> Mesh> Distance between Nodes 

menu entry. 

Additionally, for a consolidation analysis, both the elastic and two-phase soil 

properties need to be defined.  

Worked example 

 See Online help > Worked Examples > For LUSAS Bridge and LUSAS Civil 

& Structural >  ‘ 2D consolidation under a strip footing'. 

Geostatic control 

Most geotechnical problems begin from a geostatic state. This represents the initial 

stress distribution where the undisturbed soil or rock body remains in equilibrium with 
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the prescribed boundary conditions and geostatic loads, including self-weight, or 

overburden, producing zero deformations. This stress state is then used as the initial 

stress field in a subsequent static or coupled pore fluid diffusion/stress analysis. 

Geostatic control can be set by selecting the Displacement reset option on the 

Nonlinear and Transient control settings dialog for a loadcase, which can be accessed 

from the Nonlinear and Transient analysis control object  in the Analyses  

Treeview.  

Note that when performing a displacement reset a combination of stresses and strains 

may be saved depending both on the individual element formulation as well as the 

particular material model to allow the correct calculation of the forces in the element 

when the displacements are set to zero. In the case of joints the displacements prior to 

the displacement reset are saved and are added to the displacements measured from the 

reset shape to allow the correct calculation of the nodal stiffness and hence force. 

Eigenvalue Analysis 

Eigenvalue analysis controls are defined as properties of a loadcase. To do so, in the 

Analyses  Treeview access the context menu for a loadcase and from the Controls 

menu item select the Eigenvalue option to define the required controls. The 

Eigenvalue object  created stores and provides the means to modify the control 

settings.  

Nonlinear analysis options can be specified separately for each analysis present. In a 

linear analysis eigenvalue control should be specified as part of the first loadcase. 

Applications 

 Frequency analysis  extracts the natural modes of vibration of a structure. 

 Frequency (complex) is used when joint or material damping has been 

specified for a model. For this, resultant displacement results of the real and 

imaginary components are displayed within Modeller. 

 Buckling load analysis A linear analysis which may be applied to relatively 

‘stiff’ structures to estimate the maximum load that can be supported prior to 

structural instability or collapse. 

 Stiffness analysis Used to perform an eigenvalue analysis of the stiffness 

matrix at a selected stage of an analysis. This facility may be used in 

conjunction with a nonlinear analysis to predict structural instability or 

bifurcation points during a geometrically nonlinear analysis. 

 By including Modal Damping, the overall damping factors for each mode can 

also be printed as a table in the LUSAS Solver output file. These values may 

then be used in a modal dynamic or spectral (harmonic/IMD) analysis if 

desired. 
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It is possible to convert any assigned loading that acts on the model to mass. By 

default the mass will be applied on all directions. This can be changed by changing the 

parameter LDTOMA in the Model Properties : Solver System Variables tab. The 

following options are available: 

 1 = assume mass acts in all directions (default) 

 2 = assume mass acts in lateral directions only (the "vertical" direction is taken 

to coincide with the largest load component) 

 3 = assume mass acts in the load direction only 

Good practice when carrying out eigenvalue analysis 

It is good practice to perform a linear static analysis prior to carrying out an eigenvalue 

analysis. This eliminates the added complexities of the dynamic variables and will 

enable a check on the basic stiffness matrix for the structure. Any warning or error 

messages in the LUSAS output file (such as zero, negative or small pivots) should be 

investigated. In the event of problems occurring after completing the linear static and 

the eigenvalue analysis refer to When An Eigenvalue Analysis Goes Wrong 

Solving an Eigenvalue Problem 

Solving an Eigenvalue problem requires setting the Eigenvalue control properties for a 

particular loadcase.  

In LUSAS, the following methods for eigenvalue extraction are available (described 

below): 

 Subspace Iteration (Jacobi and QL solvers) The objective of the subspace 

iteration algorithm is to solve for a specified number of the lowest or highest 

eigenvalues and corresponding eigenvectors.  

 A Guyan Reduction eigenvalue analysis may also be performed in conjunction 

with the subspace iteration method. 

 Inverse Iteration (only available if a range of eigenvalues is specified) 

Computes the eigenvalues and corresponding eigenvectors within the range of 

interest.  

 Lanczos Derived from the same principles as the subspace iteration method, 

but significantly faster, although convergence is not guaranteed. As well as 

calculating an eigenvalue range, as with the inverse iteration method, it is also 

able to calculate the minimal and maximal eigenvalues.  

Having calculated all the required eigenpairs, the solution is completed by calculating 

error estimates on the precision with which the eigenvalues and eigenvectors have 

been evaluated, and normalising the eigenvectors according to a user-specified 

criterion.  
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For further details regarding the operation of the eigenvalue extraction facility, refer to 

the Theory Manual. 

Subspace Iteration 

The first step in the subspace iteration procedure is to establish the number of starting 

iteration vectors. This should be greater than the number of required eigenvalues to 

increase the rate of convergence. It is important to remember that the number of 

starting iteration vectors cannot exceed the number of degrees of freedom of the 

system. The default is the lowest of: 

 2 * number of Eigenvalues 

 8 + number of Eigenvalues  

 The number of structural degrees of freedom 

Note that entering zero (0) will force LUSAS to use the default value. 

Occasionally insufficient eigensolutions are computed in the initial eigenvalue 

analysis. The number of eigensolutions can be increased by specifying an eigenvalue 

range. 

Convergence Of Subspace Iteration 

As the procedure iterates it is necessary to refer the numerical solution to a criterion 

with which to measure its convergence. It is assumed that the eigensolution has 

converged on iteration k when: 

 

for all eigenvalues i. 

Using Eigenvalue Shifts 

An important procedure that may be used in eigenvalue extraction is shifting. If rigid 

body modes are present in the system, the stiffness matrix will be singular, hence 

causing numerical problems in the subspace iteration and the Guyan reduction 

algorithms. To overcome this a shift may be applied to form a modified stiffness 

matrix, of which the associated eigenvalues will all be positive. To obtain the actual 

eigenvalues the shift is automatically subtracted from the calculated eigenvalues. The 

eigenvectors for both systems are the same. 

The frequency shift enables the eigenvalues of unrestrained structures to be computed 

by removing the zero diagonal terms from the stiffness matrix. The convergence rate 

of the iterative eigenvalue solution procedure will increase with a smaller shift 

provided the shift is large enough to avoid numerical problems.  
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A frequency shift value can be estimated between 10% to 50% of the lowest expected 

fundamental eigenvalue. 

Guyan-Reduced Eigenvalue Extraction 

Good finite element approximations to low frequency natural vibrations may often be 

obtained by considering only those freedoms whose contribution is of most 

significance to the oscillatory structural behaviour. This characteristic may be utilised 

in the condensation of the full discrete model to a reduced system, in which the 

remaining equations adequately encompass the required vibration modes. Such a 

procedure is often termed Guyan reduction, and may be used to significantly reduce 

the overall problem size. 

In a Guyan-reduced eigenvalue extraction, the stiffness contribution of those freedoms 

whose inertia effect is considered insignificant (designated the slave freedoms), are 

condensed from the system. The reduced equation system is therefore dependent on 

those freedoms remaining (designated the master freedoms). The resulting 

eigenvectors of the reduced problem are linear approximations to the true 

eigenvectors. 

Guyan-reduced eigenvalue extraction is specified from the advanced dialog of the 

eigenvalue control properties. 

Selecting The Master Freedoms for Guyan-Reduction 

Master freedoms may be specified in one of three ways: 

 Manually Using the attribute Retained Freedoms. 

 Automatically Alternatively, a specified number of master freedoms may be 

automatically generated by setting the Eigenvalue properties (Advanced 

button). The generated master freedoms will be automatically selected such that 

the highest stiffness to mass ratios of the associated structural freedoms are 

used. 

 Mixed manual and automatic Where manual and automatic master selection 

is combined, the specified number of automatic masters will be automatically 

selected from the available free equations. 

The effective selection of the master freedoms is central to the accuracy of the 

simulated structural response. In the selection of the master freedoms, the following 

points should be considered: 

 The master freedoms must accurately represent all the significant modes of 

vibration. 

 Master freedoms should exhibit high mass to stiffness ratios. Hence rotational 

freedoms are usually inappropriate masters. 
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 Master freedoms should, where appropriate, be as evenly spaced throughout 

the structure as is appropriate. 

 The ratio of master to slave freedoms should generally be within the range 1:2 

to 1:10. 

 Poor selection of the master freedoms will have a detrimental effect on the 

accuracy of the Guyan reduction solution especially at higher frequencies. 

Sturm Sequence Check 

When extracting eigenvalues it is important to verify that the computed eigenvalues 

constitute a continuous set, and that intermediate eigenvalues are not missed. To do 

this the Sturm sequence check is invoked; this may be switched off by setting the 

appropriate parameter on the eigenvalue control properties. All eigensolutions present 

are searched for, unless you request a smaller number of solutions by specifying the 

number of eigenvalues (note that in this case, the eigenvalues returned will not 

necessarily be the lowest in the range, unless the Fast Lanczos solver is used). A 

number of shift points are set up from which the eigensolutions are computed. These 

are determined by the maximum number of eigensolutions (system parameter 

MEIGSH) that can be located from each shift point. Shift points may be altered 

automatically in order to improve the rate of convergence. Eigensolutions are 

computed from each shift point in turn until all eigensolutions have been located. 

Modal damping 

By including Modal Damping, the overall damping factors at the eigenmodes can also 

be output as a table in the LUSAS Solver output file. These values may then be used in 

an Interactive Modal Dynamic analysis if desired. Modal damping is only applicable 

to a Frequency analysis. 

Inverse Iteration With Shifts 

Eigenvalue extraction by inverse iteration may be utilised when calculating an 

eigenvalue range or frequency range. 

This method uses a series of shift points from which to extract the eigensolutions 

using the inverse iteration method. The convergence to each eigensolution is governed 

by the closeness of the eigenvalue to the shift point and the method is thus efficient for 

locating the eigensolutions within narrow bands. 

Convergence Of Inverse Iteration 

As the procedure iterates it is necessary to refer the numerical solution to a criterion 

with which to measure its convergence. For inverse iteration it is important that the 

eigenvectors as well as the eigenvalues are computed to some degree of accuracy. The 

convergence criteria for the inverse iteration scheme is therefore based upon the mass 

orthogonality tolerance: 
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 ij  

for all eigenvectors i and global mass matrix M. 

Lanczos 

When convergence is achieved, the Lanczos eigenvalue solver is usually faster than 

the subspace or inverse iteration solvers, and can use significantly less physical 

memory and hard disk than subspace methods. For these reasons it is ideal for large 

numbers of requested eigenvalues, and for large problems, although convergence 

cannot be guaranteed.  

Fast Lanczos 

The Fast Lanczos solver is both faster and much more robust than the original Lanczos 

solver, and is the recommended solver of choice for all eigenvalue analyses. When a 

software licence includes a fast Solver option this is used by default when the Default 

solver option is selected. 

Centripetal Stiffening Effects 

In rotating machinery, load correction terms that arise from the effects of rotation may 

significantly influence the natural frequencies of vibration. Within LUSAS the load 

correction terms due to centripetal acceleration can be considered. 

The load correction terms, due to Coriolis forces and angular acceleration, are 

currently ignored because they result in non-symmetric damping and stiffness matrices 

respectively. 

An eigenvalue analysis in LUSAS will include the gyroscopic effects in the stiffness 

matrix (for certain elements; see Element Reference Manual) if you use a CBF load to 

simulate the angular velocities of the shafts (note that this requires a nonlinear 

analysis). Such a natural frequency analysis would give the frequencies of the lateral 

modes of vibration. The physical effect modelled by the centripetal stiffening facility 

for eigenvalue analyses is the stiffening that a rotating be as a result of radial 

expansion and the corresponding increase in hoop stresses. These stresses effectively 

stiffen the structure and can significantly increase the eigenvalues. See the Theory 

Manual for further information. 

Notes 

 The relationship between the eigenvalue, , and the angular frequency, , is: 
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 An eigenvalue analysis of the stiffness matrix has no physical meaning except 

that a zero magnitude implies a critical point of some description. 

 Ensure that mass normalisation is chosen for the eigenvalue analysis if it is to 

be followed by a spectral or IMD analysis. 

 It is possible to use constraint equations in both an eigenvalue and a harmonic 

response analysis in LUSAS. However, the Sturm sequence check may prove 

unreliable, unless the fast Lanczos solver is used. 

 Non-zero rigid body eigenvalues may be experienced when using QSI4 

elements. This is due to the method used to obtain the lumped mass matrix for 

this element (a consistent mass matrix not being available). QSL8 and QTS4 

elements give correct eigenvalues for both lumped and consistent mass 

matrices, forming the mass matrix using a shape function array. QSI4, 

however, forms the rotation terms explicitly without the use of these functions. 

Small inaccuracies in the lumping of the mass to the rotational degrees of 

freedom may thus be possible for certain mesh definitions. If these eigenvalues 

are significant, the analysis should be continued using another shell element 

type, such as QSL8 or QTS4 elemnts. 

 The error norm for a given mode provides a relative measure of the accuracy of 

the computed modes. A high error norm will provoke a warning message, and 

signifies inaccuracy in either the eigenvalue or the eigenvector, or both. 

Warnings are not issued for computed modes which are close to zero, since 

they may approximate rigid body modes which are exactly zero, and are thus 

prone to incurring a large relative error. 

 For eigenvectors which are normalised to unity, the largest translational 

component will be set to one. Thus analyses containing rotational degrees of 

freedom, for example, may have eigenvectors normalised to unity that contain 

rotational components greater than one in magnitude. 

 If it is required to use the 1/1-buckling load option to try and obtain all 

positive eigenvalues the specified load must be close to the collapse load in 

order to obtain an accurate load factor. It should be noted that this procedure is 

not without its problems. Depending on the structure and the load level 

considered the eigenvalues can be very closely spaced, causing convergence 

problems in the iterative solution. 

 When specifying the range within which Eigen solutions will be located Sturm 

sequence checks are carried out on the range limits in order to determine the 

number of eigen solutions that exist within the range. All solutions are then 

searched for. 

Eigenvalue Buckling Analysis 

A linear buckling analysis is a useful technique that can be applied to relatively stiff 

structures to estimate the maximum load that can be supported prior to structural 
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instability or collapse. It is possible to define loads that remain constant and those that 

can vary for the computation of a load factor to cause buckling. The assumptions used 

in linear buckling analysis are that the stiffness matrix does not change prior to 

buckling, and that the stress stiffness matrix is simply a multiple of its initial value. 

Accordingly, the technique can only be used to predict the load level at which a 

structure becomes unstable if the pre-buckling displacements and their effects are 

negligible. As this procedure involves assembly of the stress stiffness matrix, only 

elements with a geometric nonlinear capability can be used in a linear buckling 

analysis. 

The main objective of an eigenvalue buckling analysis is to obtain the critical buckling 

load factor, which is achieved by solving the associated eigenvalue problem. 

For buckling analyses involving constraint equations, the Fast Lanczos solver will 

only find eigenvalues either side of zero, i.e. in the range (-, 0) or (0, ). If a range 

of eigenvalues is required in an interval which contains zero, two separate analyses 

must be carried out, where the interval is divided into two sub-intervals either side of 

zero. 

When carrying out a linear buckling analysis, two load cases can be defined. The first 

contains any loading that is not to be factored in the buckling analysis (for example, 

the dead load), while the second contains the load that is to be factored during the 

buckling analysis (for example, the live load). 

Eigenvalue buckling of stressed structures  

Linear buckling analysis can be carried out after a static nonlinear analysis, but after 

the linear buckling analysis the analysis must terminate. Care needs to be taken when 

using the eigenvalue buckling facility at the end of a nonlinear incremental analysis. In 

a linear buckling analysis linearisation of the stress stiffness matrix leads to a linear 

relationship between load and load factor, but for the geometric nonlinear analysis 

(GNL) this is not the case if the live load specified is too large. As long as the live load 

specified is reasonably small, the buckling load computed should be consistent. Note 

that for some types of flexible models carrying out a buckling analysis at the end of a 

GNL analysis may not always yield useful results, and may lead to large numbers of 

local modes. 

Alternative Eigenvalue Buckling 

Occasionally the initial stress stiffness matrix may not be positive-definite, causing the 

eigensolution method to fail. To overcome this problem the original buckling problem 

may be recast into a form where all eigenvalues are positive except when the buckling 

load factor is less than unity. When using this technique the load level must be 

adjusted to ensure that all the load factors are greater than unity, but close to it. In 

other words, the load applied should be below the lowest expected buckling mode of 

the structure. An accurate load factor will however only be obtained if the specified 

load is close to the collapse load. That is, the buckling load factor is greater than one, 

but close to it. 
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It should be noted that this procedure is not without its problems. Depending on the 

structure and the load level considered the eigenvalues can be very closely spaced, 

causing convergence problems in the iterative solution. 

Output from Buckling Analyses 

For a linear eigenvalue buckling analysis, the buckling load is obtained from the print 

results wizard. This buckling load is directly related to the eigenvalues extracted and 

will be in the following format 

MODE    EIGENVALUE    LOAD FACTOR    ERROR NORM 

1   33.0456   33.0456   0.190087E-10 

2   64.3432   64.3432   0.179595E-07 

3   130.903   130.903   0.202128E-11 

The buckling load for a mode is obtained by multiplying the actual magnitude of the 

applied loading by the load factor (for example by 33.0456 in the case of the 1st 

mode). 

Absolute displacement output is not available from any eigenvalue analysis. It is 

available, however in a normalised state. For buckling analyses the eigenvectors 

(mode shapes) are normalised to unity, where the maximum translational degree of 

freedom is set to one (mass normalisation is not applicable to buckling analyses. Note 

that the mode shapes are accurate representations of the buckling deformation but do 

not quantitatively define the displacements of the structure at the buckling load. 

Reactions, stresses and strains represent the distribution at the buckling load, again 

their magnitude is not quantitative. 

Spectral Response Analysis 

To study the effects of ground motion excitation on structures it is necessary to input 

the intensity of the motion. One practical measure can be obtained from a knowledge 

of the response spectra. Spectral response analysis seeks to determine the response of a 

structure subjected to a specified support excitation using modal superposition. This 

can be achieved without recourse to direct integration of the model over the complete 

duration of an event. 

A spectral response analysis is available using the IMD loadcase. 

Starting Procedure 

Before specifying the spectral response data the eigenvalues and eigenvectors of the 

system are computed using an eigenvalue extraction analysis (note that the computed 

eigenvectors must have been normalised to the global mass). 
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Spectral Response Data Input 

The spectral curve, spectral curve type and percentage damping are specified in the 

spectral curve which is part of the IMD loadcase definition. 

The spectral curve may be defined as: 

 Frequency or period vs displacement 

 Frequency or period vs velocity 

 Frequency or period vs acceleration 

 Frequency or period vs acceleration/gravity 

 

To compute the participation factors it is necessary to specify the direction of 

excitation. The excitation may be specified simultaneously in three directions. The 

factor specified in each direction is used to scale the spectrum intensity in that 

direction.  

For each mode the spectral displacement is determined from the frequency and this is 

multiplied by the participation factor and the excitation vector to determine the 

response.  

Damping may be specified for each mode of the structure or at known frequencies of 

vibration. If damping is only specified for the first Eigen mode this value is applied to 

all modes. When the percentage damping specified on the spectral curve differs from 

that specified in the viscous damping a correction is made to the spectral displacement 

based on the formula chosen when defining the spectral combination. Damping may 

also be described in terms of the Rayleigh damping parameters and transferred from 

LUSAS Solver.  

Normally the number of modes included should ensure the sum of the mass 

participation is not less than 90% in all significant excitation directions.  

To obtain the design values some form of combination may be used. Within LUSAS 

the following methods of combination are available: 

 Square root of the sum of the squares (SRSS) 

 Complete quadratic combination (CQC) 

 Absolute Sum 

 

Note: When zero damping is specified the CQC gives exactly the same results as the 

SRSS technique. 

Transient Dynamic Analysis 

A dynamic analysis is controlled using nonlinear and transient loadcase control 

properties which are defined as properties of a loadcase. To do so, in the Analyses  
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Treeview access the context menu for a loadcase and from the Controls menu item 

select the Nonlinear and Transient option to define the required controls. The 

Nonlinear and Transient object  created stores and provides the means to modify 

the control settings. 

Additional Nonlinear analysis control options are accessed via the Nonlinear analysis 

options control object  in the Analyses  Treeview. Nonlinear analysis options 

can be specified separately for each analysis present. Time-based values are based 

upon currently set timescale units.  

Application 

A transient dynamic analysis (sometimes referred to as step-by-step) will be required 

when loading may not reasonably be considered to be instantaneous, or where inertia 

or damping forces are to be considered. 

Solution methods 

Dynamic solution methods generally numerically integrate in the time domain. The 

solution is progressed through time in a step-by-step manner by assuming some 

variation of the displacements and velocities over small intervals of time. Within each 

time step the solution yields the displacements at the discrete time points representing 

the end of the current time step. For known initial conditions, successive application of 

this procedure furnishes the dynamic response of the structure.  

The following numerical integration schemes are available: 

 Central Difference 

 Hilber-Hughes-Taylor 

Implicit and Explicit Dynamics 

Dynamic analysis may be performed using two methods: 

 Implicit Dynamics Implicit methods require the inversion of the stiffness 

matrix at every time step, and are therefore relatively expensive, but 

unconditionally stable. By default the Hilber-Hughes-Taylor is used. 

 Explicit Dynamics In contrast, explicit methods de-couple the equilibrium 

equations, hence removing the necessity for stiffness matrix inversion. Explicit 

methods are only stable for a range of time steps, determined by the problem 

being analysed, and the discretisation adopted. Explicit methods are 

automatically invoked by specifying explicit dynamic elements. In this instance 

the central difference scheme is mandatory and chosen by default. For explicit 

analysis lumped masses must be used. 
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Starting procedure 

To start a dynamic analysis a knowledge of the initial conditions is required. The 

initial conditions for the Hilber-Hughes-Taylor integration scheme are: 

 

where: 

 are the velocities at time steps 0,1 

 are the accelerations at time steps 0,1 

 is the time step 

 is the Hilber-Hughes-Taylor integration constant gamma 

The initial velocity, , and initial acceleration, , can be defined in an implicit 

dynamics analysis. 

The starting conditions in explicit dynamics must be consistent with the central 

difference integration scheme: 

 

where: 

 are the velocities at times -t/2, t/2 

 is the acceleration at time 0 

Only the initial velocity, V, (actually relating to time -Dt/2) can be defined in an 

explicit dynamics analysis. The displacements, d, (relating to time zero) and 

accelerations, A, (relating to time -Dt) are assumed to be zero. Because of the nature 

of the central difference integration scheme, an initial velocity will generate 

accelerations at time zero. Accelerations relating to time zero are used to compute 

displacements at time Dt and will in fact be output at time t.  

In general, the values output at any time t will be: 

, ,  

This means that in the output for any time step, the displacements will relate to the 

current response time while the accelerations effectively lag one time step behind the 

displacements. 
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Impact Dynamics 

In addition to using nonlinear joint models to represent contact and impact, slidelines 

may be used for modelling impact in dynamic analysis. These permit the surfaces of 

2D, axisymmetric, and 3D structures to register and react to contact with one another. 

See Slidelines for more information. 

Thermal (Field) Analysis 

A thermal (or field) analysis can be defined initially when creating a new model by 

specifying a Thermal analysis type. It can also be created by adding a thermal analysis 

to an existing structural base analysis. 

Two types of thermal (field) analysis may be performed: 

 Steady State thermal (field) analysis 

 Transient thermal (field) analysis 

 

It is also possible to carry out a thermo-mechanically coupled analysis . 

Applications 

The quasi-harmonic equation defines the behaviour of a variety of field problems.  

Some of the more common quasi-harmonic applications, and the associated field 

variables, are shown in the following table.  

Application   Field Variable 

Thermal 
conduction 

Seepage flow 

Incompressible flow 

Soap film 

Elastic torsion 

Electric conduction 

Electrostatics 

Magnetostatics 

  Temperature 

Hydraulic head 

Stream function 

Deflection 

Warping function 

Stress function 

Electric potential 

Magnetic 
potential 

Carrying out a thermal (field) analysis 

The modelling and solving of a thermal (field) analysis follows an identical process to 

that of modelling and solving a general structural analysis.  

 Discretise the model using a series of field elements. 

 Specify thermal material properties. 

 Specify thermal loads 
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 Specify thermal link elements (assigning thermal link material and thermal 

link geometric properties) or thermal surfaces to define how heat is 

conducted, convected or radiated across gaps and spaces between different 

domains.  

 Solve to determine the values of the field variable at each nodal point.  

Steady State Thermal / Field Analysis 

In a manner similar to static structural analysis, steady state thermal/field analysis 

assumes that the loaded body instantaneously develops an internal field variable 

distribution so as to equilibrate the applied loads. Note that the use of temperature 

dependent material properties or loads renders the problem nonlinear. 

Transient Thermal Analysis 

A transient thermal (field) analysis should be performed when time effects are 

significant in a thermal/field problem. In a similar manner to structural dynamics, 

transient field analysis involves the evolution of a new field variable distribution from 

a set of initial conditions via a set of transition states evolving through time. The initial 

conditions of the body must firstly be prescribed. This may be done by performing the 

appropriate linear or nonlinear steady state analysis. 

Defining a transient thermal analysis 

A transient thermal/field analysis can be defined initially when creating a new model 

or by adding a general thermal analysis to an existing structural base analysis.  

Transient thermal/field analysis controls are defined as nonlinear and transient 

properties of a loadcase. To do so, in the Analyses  Treeview access the loadcase 

context menu and from the Controls menu item select the Nonlinear and Transient 

option to define the required controls. The Nonlinear and Transient object  

created stores and provides the means to modify the control settings.  

The default state for additional thermal analyses added to an existing one is to inherit 

the assignments from the first, but the additional thermal analyses can 'override' some 

or all of those assignments. 

Linear transient analysis 

Integration Scheme    beta  

Crank-Nicholson   1/2 

Euler   0 

Galerkin   2/3 (default) 

file:///C:/SVN/Content/dlg4attr/idd_geometry_thermal_link.htm
file:///C:/SVN/Content/dlg4attr/idd_geometry_thermal_link.htm
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The transient problem is integrated through time using a 2-point integration scheme. 

The type of integration scheme maybe changed on Advanced Time step parameters 

dialog accessed from the nonlinear and transient control dialog by specifying the 

parameter beta. Some of the more common 2-point integration schemes and their 

associated beta values are shown in the table above. 

Notes 

 In the limit the final solution should be the same as the steady state analysis 

subject to the new loading and boundary conditions; the transient analysis 

merely models the thermal inertia in moving from the initial to the final 

conditions. The body property which is used to describe this inertia is the 

effective heat capacity. 

 When choosing an increment of time, the stability of the incrementation 

scheme must be examined. When beta is greater than or equal to 0.5 the 

solution is unconditionally stable (the Crank-Nicholson, Galerkin and 

Backward difference schemes are of this form). 

 When beta is between the limits 0 and 0.5 the solution is stable provided that: 

 

where  is the input parameter beta and max is the maximum eigenvalue of 

the system. 

 The time step used for implicit algorithms is dependent upon the number of 

modes that influence the response of the system. Generally, the major part of 

the response is governed by the lower modes so that: 

 

where  is the minimum eigenvalue of the system. 

 The Galerkin scheme is recommended since it generally provides good 

accuracy and is the least susceptible to oscillations. 

Backward difference   1 
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Nonlinear Transient Analysis 

For nonlinear transient analysis the backwards difference algorithm must be used 

(beta = 1.0). The backward difference algorithm is unconditionally stable, and the 

time step length considerations are the same as for linear analyses. 

For analyses including a phase change, there is either an absorption or release of 

energy in order to create or break the molecular bonds. This is modelled by varying 

the effective heat capacity in the transient analysis. To do this the material property of 

latent heat (of phase change) is introduced. 

Latent heat (of phase change), H, is defined as: 

 

where C is the effective heat capacity including the effects of the latent heat of 

evolution due to phase changes and  is the temperature. In the material data input 

both H and C may be specified. For analyses where phase changes are not represented, 

the effective heat capacity value C is used in the calculations. 

For analyses where phase changes are represented, tabular input should be used to 

define the variation of H with temperature, together with an initial value of C. 

Providing a variation in temperature exists at a point, the effective specific heat is then 

interpolated from the latent heat (of phase change) values. If no variation exists, for 

example, in an area of the problem that has experienced no change in temperature 

from the initial temperature, then the initial value of C is used. 

For nonlinear analysis the nonlinear control parameters are used to define the iterative 

strategy. The convergence section is utilised to provide tolerances for defining steady 

state, and either a field norm (temperature equivalent to the displacement norm), or a 

residual flow norm (equivalent to the residual force norm) may be used. 

Notes relating to oscillations in transient field analyses 

 The default value of the beta constant for a linear transient analysis provides 

the best accuracy but is susceptible to oscillation. Changing to beta=1, gives 

a more stable algorithm which eliminates the oscillations but potentially at the 

expense of accuracy. See Theory Manual for more details. 

 The use of lumped specific heat (LUSAS option 105) in preference for 

consistent specific heat is essential, particularly in nonlinear analyses. 

 Mesh refinement also has a significant effect in reducing spurious oscillatory 

response. 

 The application of a step load to a structure will cause a thermal shock which 

will excite transient oscillations. Where possible, the use of the Load Curve 
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facility to ramp the loading in a realistic manner would be recommended to 

reduce these initial transient effects. 

 Any warnings (particularly those relating to pivots) in the LUSAS output file 

should be investigated closely for modelling errors. 

Coupled Analysis 

A coupled analysis can be defined initially when creating a new model by specifying 

a Coupled Thermal/ Structural analysis type or a Coupled Hygro-thermal/Structural 

analysis type. 

A coupled analysis can also be created by adding a general thermal or hygro-thermal 

analysis to an existing structural base analysis, or adding a structural analysis to an 

existing thermal or hygro-thermal base analysis. 

Coupled analysis options can be accessed via the Coupled analysis options object  

in the Analyses  Treeview.  

Coupled analysis 

The flow of heat through a body and the corresponding distribution of temperature is 

described by the quasi-harmonic equation; the body geometry is assumed to remain 

constant. The displacements of the same body subjected to various forces, is described 

by equations of static or dynamic equilibrium; the temperature distribution is assumed 

not to vary with displacement. To include the effect of the change in geometry in the 

thermal analysis, and the change of temperature in the static analysis, requires that this 

information is separately calculated by the appropriate analysis and then transferred. 

This process is known as thermo-mechanical coupling. Thermo-mechanical coupling 

may be sub-divided into two classes depending on the nature of the problem. 

 Semi-coupled analysis 

 Fully coupled analysis 

Semi-coupled analysis 

In a semi coupled analysis, for instance, the structural response is influenced by the 

temperature field, but the thermal response is independent of the structural response, 

or vice-versa. In such a case, the thermal analysis is performed prior to the structural 

analysis and either a single or series of nodal temperature tables are created. These are 

read during the structural analysis at the required loadcase or time step. 

Fully coupled analysis 

In a fully coupled analysis, the thermal and structural analyses must be performed 

simultaneously with a continuous transfer of information between the two analyses. 

For instance, in addition to modelling the influence of the thermal field on the 

structural response, the effect of the structural response on the thermal field is 

represented. Temperatures are transferred from the thermal to the structural analysis, 
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and the updated geometry is transferred from the structural to the thermal analysis. 

The analyses may be coupled on the incremental or iterative levels (iterative coupling 

is machine dependent). 

For true full coupling of two nonlinear fields, information transfer has to occur on an 

iteration level within each increment, so that in addition to preserving equilibrium of 

the local thermal and structural fields, equilibrium of the combined system is 

maintained. Iterative coupling is essential for strongly coupled systems, e.g. structure 

to structure contact. For weaker thermo-mechanical coupling, information transfer at 

an increment level should provide an adequate solution. 

Heat dissipated due to plastic work 

The heat flux produced due to plastic work can be considered in a coupled analysis. In 

this type of problem the structural analysis is started first and the heat dissipated 

through elasto-plastic deformation is transferred to a thermal analysis. The nodal 

temperatures may then be returned to the structural analysis where they can be used to 

produce thermal strains and compute temperature dependent properties. The following 

points should be considered when using this facility: 

 The heat flux generated due to plastic work is a function of the time increment 

over which the work is done. For a meaningful solution to this type of problem 

a dynamic structural and/or a transient thermal analysis should be undertaken. 

 In general, it is recommended that reading and writing to the data transfer file 

is carried out at the same point in the analysis. This avoids any inconsistency 

occurring between the time of generation of plastic work and the time of 

diffusion in the thermal analysis. 

 The thermal softening facility is only valid for nonlinear material models 

which allow input of a heat fraction. The heat fraction takes a value between 0 

and 1 and represents the fraction of plastic work converted into heat. 

Initialisation of Structural Temperatures 

LUSAS structural elements allow you to input both an initial temperature field and a 

current temperature field. The structure is not strained if its current temperature field is 

the same as the initial temperature field; variations in temperature, defined by the 

current temperature field, from this initial temperature field, cause thermal straining. 

The nodal temperatures transferred from the thermal to the structural analyses are read 

directly into the current temperature field and the thermal strains are then calculated 

from the difference between the current and initial fields. The initial field in this case 

is zero everywhere unless it is directly input using the structural temperature loads. It 

is possible to initialise the initial temperature field to the current temperature field 

which is read from the data transfer file. Further data transfers will be read into the 

current temperature field only. 
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Initialisation of Reading And Writing Commands 

To maintain consistency between reading and writing on a specific increment both 

data reads and writes are performed at the end of the current increment, i.e. if data is 

required for use in the 100th step then it must be read in the 99th step. Similarly, if 

data is required to initialise the structural temperature or geometry field, it must be 

read on step zero. 

Data Transfer Between Joints And Links 

The physical nature of the joint and link elements is essentially different. Heat flow 

can occur between two unconnected bodies via convection and radiation across the 

intervening medium. On the other hand, joint elements introduce stiffness against 

displacement, implying a physical connection between two bodies. Whilst both may be 

true simultaneously, more usually, only one condition will apply. In these 

circumstances it is necessary to introduce dummy joints with springs of zero stiffness 

or links with zero conductivity to ensure that the appropriate element data is correctly 

transferred. 

Coupled Hygro-thermal/Structural Analysis 

A coupled hygro-thermal/structural analysis can be defined initially when creating a 

new model by specifying a Coupled Hygro-thermal/Structural analysis type. It can 

also be created by adding a hygro-thermal analysis to an existing structural base 

analysis, or adding a structural analysis to an existing hygro-thermal base analysis. 

A coupled hygro-thermal/structural analysis models the time (hydration) dependent 

behaviour of concrete from time of casting to old age. It can: 

 Take into account the time dependent environmental conditions when the 

concrete cures, such as daily cycles of temperature and humidity, to the desired 

degree of detail. 

 Model the effect the formwork (and environment) has on the heat and moisture 

transfer to and from the concrete 

 Predict the internal heat generated as the concrete cures so that any excessive 

temperature gradients that might cause the concrete to crack can be identified. 

 Compute the amount of shrinkage in the concrete as it cures via the migration 

of moisture and the degree of saturation.  

 Take into account the creep strains that occur during cure as the concrete is 

stressed. 

 Model the evolution of properties E, fc, and ft. 

 Predict failure when the concrete is fully (or partially) cured, and if a suitable 

mesh is used, obtain reasonable estimates of crack widths. See notes below for 

element  



  Chapter 6 : Utilities 

    

631 

It assumes that the pore pressure remains constant (i.e. the rate of pore water 

evaporation is low in comparison to the rate of water vapour migration in the porous 

network). As a result it can only be used when concrete temperatures are under 100 

degrees Celsius. 

Carrying out a Coupled Hygro-thermal/Structural analysis 

In LUSAS the procedure to carry out a coupled hygro-thermal/structural analysis is 

similar to running a coupled thermal/structural analysis. A hygro-thermal analysis is 

always nonlinear and transient, run over the time span of interest. The hygro-thermal 

analysis is run first and creates a data transfer file that is used by the subsequent 

structural analysis. 

For a hygro-thermal analysis 

 Define hygro-thermal material properties, including cement type and 

concrete mix proportions to represent the concrete (default values are 

provided). During the analysis these are used in the computation of heat 

generated as the concrete cures. 

 Define time dependent boundary conditions to represent the environmental 

conditions (temperature and humidity) and the formwork material (convection 

heat transfer coefficient) 

 

The temperature, degree of water saturation and degree of hydration are computed in 

the hygro-thermal analysis at each time step, and these are written to a data transfer 

file that is read by the subsequent structural analysis. 

For a structural analysis 

All material properties must be defined with respect to a concrete age of 28 days. At 

earlier times, reduced structural properties are computed to account for the fact that the 

concrete has not fully cured. 

When using the transient, smoothed, multi-crack nonlinear concrete model 105, the 

structural analysis reads the temperature, degree of water saturation and degree of 

hydration data at each time step and uses the temperature to compute thermal strains, 

the degree of saturation to compute shrinkage, and the degree of hydration to compute 

the mechanical properties of the concrete. The creep strain in the concrete is also 

computed, using either a User defined creep coefficient or that defined by the CEB-

FIP (1990) or EN1992-1-1:2004 design codes. 

During the step-by-step structural analysis the effects of thermal, shrinkage and creep 

strains, along with time (hydration) dependent structural material properties can be 

combined with any further structural loading that may be applied. At each time step 

the transient smoothed multi-crack nonlinear concrete model 105 is used to predict if 

cracking will occur. 
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If cracking is not of interest, but creep and shrinkage are to be considered, use concrete 

model 86, or a very high tensile strength or a linear material. 

Notes 

 2D plane, 2D axisymmetric solid, and 3D solid hygro-thermal elements are 

available. These can have either ‘hygro’ material properties or isotropic 

thermal properties. In the latter case, to model non concrete material (e.g. 

steel), the hygro ‘stiffness’ is computed with a permeability of about six orders 

of magnitude less that the concrete permeability. There are no thermal or 

hygro-thermal shell elements. 

 Coupled thermal/structural bar elements can be used. Steel shell elements can 

be used in the structural analysis but these will only read in temperatures at 

nodes that are shared with the concrete (any unshared nodes receive zero 

temperatures). Note that such bar and shell elements occupy space already 

occupied by the concrete. This would introduce an error in the effective values 

of the material properties. To avoid this, the material properties of the 

embedded bars and shells can be recalculated, e.g. density of steel 

reinforcement equals steel density minus concrete density. 

 When the purpose of the analysis is to check if cracking would occur and 

compute the crack widths mesh refinement using a denser mesh, and time step 

convergence studies using a sufficient number of load steps should be done. 

Start with small load steps as the initial orientation of cracks tends to 

propagate, as in real life. Linear order elements are recommended for crack 

width results. An element length of greater than or equal to the reinforcement 

cover is suitable for linear elements. An element length of greater than or equal 

to twice the reinforcement cover is suitable for quadratic elements. 

Benefits of a Coupled Hygro-Thermal/Structural analysis over a 

Coupled Thermal/Structural analysis 

The benefits of running a coupled hygro-thermal/structural analysis over a coupled 

thermal/structural analysis in which heat of hydration, codified creep and shrinkage, 

and a suitable nonlinear concrete model are combined. are: 

 Shrinkage is computed more accurately in a coupled hygro-thermal/structural 

analysis. Codified creep and shrinkage models are aimed at beam and shell like 

structures, and require the input of a cross-section area/perimeter ratio, and the 

shrinkage for any given member would be constant throughout that member. 

This is clearly inappropriate for a stocky (dam like) structure. 

 The coupling effect of the degree of saturation (or capillary pressure) and 

temperature is not accounted for in a thermal analysis. 
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 The environmental boundary conditions used in a thermal analysis are less 

accurate, for instance no account is taken of the effect of humidity 

 The evolution of the mechanical properties used in the coupled hjygro-

thermal/structural analysis is a function of the degree of hydration of the 

concrete, which will vary throughout a member. The codified creep and 

shrinkage mechanical properties are a function of time only; they will be 

constant throughout a member and are therefore likely to be less accurate. 

 The rate at which the concrete cures affects the long term strength of the 

concrete (a faster cure rate produces higher temperature in the early stages and 

leads to a lower long term strength). A coupled hygro-thermal/structural 

analysis will take this “cross-over effect” into account whereas the use of 

design code equations will not pick it up. 

Fourier Analysis 

Fourier analysis controls are defined as properties of a loadcase. To do so, in the 

Analyses  Treeview access the loadcase context menu and choose the Controls 

menu item. Fourier analysis options can be specified separately for each analysis 

present. 

Fourier elements 

Fourier elements offer an efficient method to solve problems in which axisymmetric 

structures are subjected to non axisymmetric loading, provided that the displacements 

are small and linear theory applies. The circumferential displacements and variations 

of load are expressed as the sum of the components of a Fourier series, whilst the axial 

and radial variations are described by the standard finite element formulation. Each 

term of the Fourier series is analysed individually and the results are then combined to 

provide the overall solution.  

Fourier elements can be used to model both solid and thin walled structures; in 

particular they offer an ideal method to obtain an initial estimate of the eigenvalues of 

thin walled structures without the expense of performing a full shell analysis on the 

complete structure. The choice between a full structural discretisation using solid or 

shell elements and the use of the Fourier element depends upon the number of Fourier 

terms that are required to accurately describe the load; if only a few terms are required 

then the Fourier element should be considered. 

Attributes and settings 

A Fourier analysis can be considered as a generalisation of the standard axisymmetric 

analysis. The finite element mesh is defined in the XY-plane and may be axisymmetric 

about either the X or the Y axis. Loading is applied to the mesh in the standard 

manner using the loadcase properties, with its circumferential variation defined using 

the curve definition. Finally the Fourier components to be computed are input using 

the Fourier control as part of the loadcase properties. 

file:///C:/SVN/Content/dlg6anal/idd_control_fourier_page.htm
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Supports are defined in the usual manner, with the declaration free, restrained or 

spring supports. For the n=0 harmonic the spring stiffness per unit radian must include 

a factor of 2p for the implicit integration around the surface. For harmonics other than 

n=0 the factor should be p. Certain restrictions are applied to the freedoms of nodes 

lying on the axis of symmetry. These conditions, shown in the followng table, are 

automatically imposed on the centre line nodes. 

Axisymmetric about X axis 

n=0 v, w=0 

n=1 u=0 

n>1 u, v, w=0 

   Axisymmetric about Y axis 

n=0 u, w=0 

n=1 v=0 

n>1 u, v, w=0 

Dynamic, Eigenvalue And Harmonic Response Analyses 

A Fourier analysis processes each harmonic individually as they possess their own 

unique stiffness, mass and damping matrices and load vector. By selecting just one 

harmonic a dynamic, eigenvalue or harmonic response analysis can be executed for 

that particular harmonic. The complete structural response can be obtained by 

superimposing the different results from the selected harmonics. 

The Fourier control should specify just one harmonic of a series. The automatic 

calculation of the load coefficients from a given load input is suspended and you must 

input the appropriate load coefficient; if this is not known it may be obtained from a 

static analysis. Note that to represent a global load, the applied load will have 

components in both the tangential and the radial directions (see the Theory Manual for 

details of the loading calculations). Only one loadcase may be processed. 

Inertial Loading 

The operation of the inertial loading, input using the load type body force, is slightly 

different to the other standard loads. Inertial loads are calculated from element 

volumes and applied accelerations. The specification of linear accelerations, angular 

velocities and angular accelerations is enough to define the forces acting on the 

structures since the element volume and density from which the mass is calculated are 

element properties. Depending on the input data, loads are applied for the n=0,1,2 

harmonic components. However, the body force data must still be associated with a 

dummy load curve and must be declared in the first loadcase. 

In addition to the input accelerations, angular velocities and angular accelerations you 

can input an offset origin about which the rotations are applied. The local rotation 

about the finite element axis of symmetry should not be confused with the global 

rotation about the global axes. The local rotation implies that the body is rotating with 

respect to the finite element axes, while the global rotation is a rigid body rotation of 

the complete finite element model. For further details see the Theory Manual. 

Centripetal Load Stiffening 

Centripetal load stiffening has been applied to the n=0 harmonic, but there is no 

nonlinear stress stiffening contribution. 
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Special Application to Non-Axisymmetric Structures 

In some instances, the structure may not be truly axisymmetric but it may be desirable 

to obtain an approximate response from an axisymmetric analysis. An example of this 

is a turbine where the turbine axis is axisymmetric but the fan blades are not. The use 

of the standard Fourier material properties is inappropriate for the fan blades since the 

hoop stresses introduced by the element material model provide significant artificial 

stiffening. To alleviate this problem the use of the plane stress material model input 

using the orthotropic materials properties is permissible provided that the element is 

given adequate torsional restraint. The use of this material model can be thought of as 

smearing the individual stiffness of the fan blades into an equivalent axisymmetric 

structure. 

For Fourier elements using orthotropic properties, body forces are applied using the 

associated load curve.  

If the load curve is input as a series 

of 1s and 0s this is equivalent to 

selectively integrating the internal 

forces for each fan blade. The 

scheme is illustrated in the diagram. 

Thermal Problems 

If temperature dependent material properties are used the temperature field must be 

axisymmetric. For non-temperature dependent materials, a general temperature field 

can be input in the same manner as the other element loads. Temperature loads cannot 

be used in dynamic or harmonic response analyses. 

Post-Processing 

Fourier results may be expanded using the Graph Wizard. 

Influence Analysis 

An influence analysis allows the visualisation of the variation of a load effect such as 

reaction, shear, moment, or deflection at a specific location in a structure due to a unit 

concentrated load moving over the structure. This makes it possible to identify regions 

within a "loadable area" where application of this unit load leads to effects which 

might be regarded as "adverse" or "beneficial" at the location of interest which may be 

close to, or remote from, the loadable area. This is useful to help determine the most 

onerous patterns of transient (live) loads in structural analysis and design, and is used 

by the LUSAS Vehicle Load Optimisation facility and the LUSAS Rail Load 

Optimisation facility for that purpose. Additionally, for some design codes, traffic or 

train load intensities are a function of the length of lane which is loaded and where this 

is this case an influence analysis is key to determining where, and to what intensity, 

loading should be applied. 
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With influence analysis, the influence results (and therefore the Vehicle Load 

Optimisation and Rail Load Optimisation results) are based on the properties of the 

base analysis. Because of this it is a requirement that the base analysis is a simple 

linear static analysis. 

Influence Analysis Methods 

 Influence analysis can be carried out using the following methods: 

 Reciprocal Theorem - also known as the Muller-Breslau Theorem, or 

Maxwell's Theorem, is a means of calculating an influence by the use of an 

auxillary structure, to which a deformation corresponding to a load effect of 

interest is applied. The Reciprocal Method provides options to solve 

influences for grillage, slab and deck models, for shear, moment, reaction and 

displacement influence types. Solving a Reciprocal influence will take an 

increasing amount of time as more influence locations are solved. 

 Direct Method - is a more general and powerful way of calculating an 

influence where the effect of a specified point load is assessed at each node or 

grid location on a loadable area of a structure. The value of the load effect of 

interest at each specified location is then used to construct an influence line or 

surface for that location. Unlike the Reciprocal Method (where influence types 

are limited to Shear, Moment, Reaction and Displacement) the list of available 

results entity / components available for influence calculation is only limited by 

the elements used within the model. Solving an influence analysis using the 

Direct Method will take the same time regardless of the number of influence 

locations solved, and the solution time will depend upon the grid or mesh 

density used. 

 A Direct Method Influence Analysis for General use can calculate 

influences for shell/plate/grillage models; for 3D beam models including 

torsional effects; calculate influence for user-defined results components; 

calculate influence for derived results, as a post-processing facility; and 

can calculate influence for many locations and quantities with a single 

analysis. 

 A Direct Method Influence Analysis for Rail use can calculate 

influences for shell or plate models; calculate influence for user-defined 

results components; calculate influence for derived results, as a post-

processing facility; and can calculate influence for many locations and 

quantities with a single analysis. 

In summary, the reciprocal theorem method provides less functionality than the Direct 

Method, but it is much faster when only a limited number of influences are required at 

strategic locations. It is also useful when a load direction is not known as, for example, 

to identify where to apply wind to a tower in order to produce a certain effect within 

the internal structure members. The Direct Method provides more general 
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functionality, and must be used if either 3D line beam modelling or Rail Load 

Optimisation analysis is to be carried out. 

Both methods require influence attributes to be defined and assigned to a model prior 

to an influence analysis being carried out. Note that Vehicle Load Optimisation and 

Rail Load Optimisation analysis requires influence attributes to be assigned to a 

model in order to generate influence surfaces and calculate the most adverse vehicle 

and train load patterns on bridge structures. 

Notes 

 Only one Reciprocal Theorem analysis entry is added to the Analyses  

Treeview. 

 Multiple Direct Method influence analysis entries can be added to the Analyses 

 Treeview. 

Influence Analysis Attributes 

 Reciprocal Theorem influence attributes are defined from the Attributes > 

Influence> Reciprocal Theorem menu item. The influence type may be a 

Shear force, a Reaction, a Moment or a Displacement only. For each influence 

type the influence direction and either a positive or negative displacement 

direction needs to be specified. For more information see Reciprocal Theorem 

Influence Attributes 

 Direct Method influence attributes are defined from the Attributes > 

Influence> Direct Method menu item. The influence type may be set by 

defining any Entity of interest (such as a Reaction, or a Force/Moment, or a 

Stress, or a Beam/Shell Slice Resultant location), an influence direction (such 

as an axis of a member, or a path along a structure, or a material direction) and 

a Component of interest (such as My). For more information see Direct 

Method Influence Attributes 

 

Solving an Influence Analysis 

The presence of assigned influence attributes on a model determines that an influence 

analysis will automatically be carried out when a model is solved. 

To solve an influence analysis  choose the Solve Now menu item on its context 

menu or press the Solve button  on the main toolbar menu. Influence Analysis for 

the Reciprocal Method and for the Direct Method influence attribute assignments can 

be solved in isolation from any other analyses. Influences for the Reciprocal Method 

can also be solved selectively by choosing the Influences to Solve context menu for 

an influence entry in the Analyses  Treeview.  

file:///C:/SVN/Content/Bridge/Vehicle_Load_Optimisation/Vehicle_Load_Optimisation_Overview.htm
file:///C:/SVN/Content/Bridge/Rail_Load_Optimisation/Rail_Load_Optimisation_Overview.htm
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A successful solve will add influence loadcase results to the Analyses  Treeview.  

Writing a Datafile with Influence Attributes 

Once all influence attributes have been assigned to a model they can, if desired, be 

exported to a data file using the menu option Files> Export Solver datafile.... LUSAS 

will automatically identify the datafile to be one that will require an Influence 

analysis as opposed to a general analysis, and as such, data file names will be 

generated from the specified file name and the influence number. For example, if the 

specified file name is bridge, then files bridge1.dat and bridge2.dat will be created 

for influence lines 1 and 2 respectively.  

Viewing results of an Influence Analysis 

After solving a model with assigned influence attributes the influence shape for each 

influence point of interest can be viewed on the Influence shape layer in the Layers 

 Treeview. This layer name is a renaming of the Deformed mesh layer and cannot 

be added manually. 

The influence shape for each influence can be seen by setting each influence loadcase 

active, in turn, in the Analyses  Treeview. For Rail Load Optimisation uses, the 

influence shape for a particular track layout can only be displayed if that track layout 

is set to be visible. 

By adding a Contours layer to the Layers  Treeview contours of Influence result 

can be displayed. By referring to the contour key regions of the model where positive 

or negative loading effects take place can be seen. 

Notes 

 When a Direct Method influence analysis has been solved for one assigned 

attribute the effect of a unit load on any part of the structure can be seen 

immediately for any subsequently assigned influence attributes. Additional 

solving is not necessary. 

Accuracy of influence solutions 

The accuracy of influence solutions, as with all finite element analyses, improves with 

increased mesh refinement. 

Reciprocal Method 

When using the Reciprocal Method, the influence ordinate at any location is generally 

obtained to the accuracy of the element shape function and mesh refinement. A 

specific issue arises where a discontinuity occurs in an influence surface - such as 

where the influence of shear "jumps" at the central support in a two-span structure. At 

such a discontinuity, the peak value given will be that associated with the node 

adjacent to the discontinuity. Therefore in order to minimise inaccuracy, small element 
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sizes should be used adjacent to the discontinuity meaning, for this example, a short 

element adjacent to the support. 

Direct Method 

When using the Direct Method, the influence ordinate is affected not only by the 

element shape function and mesh refinement but also by the density of the grid of 

points in the loading grid (if such a grid is used, or permitted). With a coarse mesh or 

coarse loading grid, faceting could lead to significant inaccuracy, especially near cusps 

or discontinuities. In all such cases, increased accuracy is gained with closer spacing 

of grid points. Having a grid density finer than the actual mesh, does not improve the 

accuracy of the DMI results and may miss the peak values.  

In order to accurately decide if the influence profile for an adverse area meets any 

codified cusping rule, a Direct Method Influence analysis must be defined as follows:  

 For shell/plate/grillage models the influence node (the location where cusping 

occurs) and the DMI grid node must have the same coordinates for so that the 

supported nodes are loaded with the unit load to correctly identify the start/end 

of adverse areas and to combine them to get the most onerous effect. For these 

models the most accurate results are obtained when the Direct Method 

Influence Analysis setting 'Nodes in search area' option is chosen.  

 For beam models the influence node (the location where cusping occurs) and 

the DMI grid node need to have the same longitudinal position. For these 

models the most accurate results are obtained when the Grid Settings option 

'Match nodes in search area' is chosen. 

Direct Method Influence Analysis - General 

A Direct Method Influence Analysis for general use requires Direct Method 

influence attributes to be defined and assigned to a line beam, frame, grillage, or 

shell/plate model. They can also be assigned to a surface of a solid model provided the 

surface of the solid is defined as a search area. The locations at which a prescribed 

load will be applied to nodes or points on the model also need to be specified. 

Influence attributes are defined and assigned from the Attributes> Influence menu. 

Load locations are defined on the Direct Method Influence dialog, which is displayed 

either when a Direct Method Influence attribute is first assigned to a node or point on 

the model, or when the Analyses> Direct Method Influence Analysis menu item is 

selected or edited. 

Previously defined settings can be accessed and edited from the context menu for each 

Direct Method Influence entry in the Analyses  Treeview.  

Materials, sections, supports and other attributes for a DMI analysis are taken from the 

base analysis. Because of this, it is a requirement of a DMI analysis that the base 

analysis is a simple linear static analysis. 
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For railway loading see "Direct Method Influence Analysis - Rail" on page 641 

Load locations 

 Search area - A search area can be used to limit the features over which the 

prescribed load is applied so that the effect of the load on other features in the 

model may be prevented. If a search area is not specified the default loading 

area is Whole model. 

 Nodes in search area - restricts the application of the applied load to just those 

mesh nodes within the search area, or to the whole model, as appropriate.  

 For shell/plate/grillage models, it is recommended that the DMI analysis 

should be defined with the ‘Nodes in the search area’ selected.  

 For line beam models where the geometric beam section represents a 

loadable top slab, it is recommended that the Grid option be used instead, 

specifying Grid settings to automatically create grid points to match the 

longitudinal positions of the nodes in the search area. 

 Grid - predominantly used with line beam models where the geometric beam 

section represents a loadable top slab. For this, a defined grid of points is used 

to represent the loadable region of the slab. The Grid method also provides the 

means to define a grid of points that can be used as an alternative to the nodes 

or points present in a shell or plate model that are used in an influence analysis. 

For a model with a very fine mesh, loading a grid having fewer points will 

reduce the solution time. For line beam models the use of a reference path 

using lines representing the centreline of a loaded region of a structure is 

recommended if the grid loading method is used. For plate and shell models a 

reference path may represent the centreline of a carriageway on which a 

loading grid would be positioned. See the worked example 'Vehicle Load 

Optimisation of a Box Beam Bridge', which provides more details on the use of 

a loading grid. 

 Centreline - the centreline of the grid can be defined with reference to a 

previously defined Path or the X, Y or Z global axes. For most types of 

modelling the use of a reference path is recommended. Specifying X, Y or Z 

causes the grid to be created along each of those axes at X=0, Y=0 or Z=0. 

 Transverse width - the width of the loadable grid to be generated (must be 

greater than 0.1). Grid settings control the number of load locations within this 

defined width. 

 Grid settings - These control the density of the grid of points that will be 

loaded. Longitudinal and transverse values can be specified. If one of the global 

axes has been selected as the centreline of the grid, then the overall extent of 

the model will be calculated and a suitable grid generated to encompass the 

whole model. See Direct Method Influence Attributes for more details. 

file:///C:/SVN/Content/dlg6anal/idd_direct_method_grid_settings.htm
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Note that the visibility of a DMI loading grid is controlled from the context menu of 

the Direct Method Influence analysis entry in the Analyses  Treeview.  

Loading settings  

Loading settings provide the means to specify the magnitude and direction of the 

loading applied to a grid of points used for an influence analysis. 

Results file scope 

Following results calculation for the whole model, the results that are written to a 

results output file can be restricted to be those only for any assigned influences 

(loadcases), or for those assigned influences (loadcases) and a subset of elements 

(those part of a group) within a model. Restricting the results output produces smaller 

results files more quickly than would be created for a whole model, but note that if 

subsequent influence assignments are made to the model a Direct Method Influence 

analysis would have to be run again because results for those influence locations 

would not be present in the previously calculated results file. 

 Assignments only calculates and writes results to a results file for only the 

assigned influences (loadcases) in the model. 

 Assignments and additional group calculates and writes results to a results 

file for only the assigned influences (loadcases) in the model, and for those 

elements within the chosen group, and automatically includes the elements 

needed to provide results for assigned influences.  

 

Direct Method Influence Analysis - Rail 

A Direct Method Influence Analysis for use with the Rail Load Optimisation facility 

requires Direct Method influence attributes to be defined and assigned to a shell or 

plate model. Note that line beam models are not currently supported by the 

RLO facility. The locations at which a concentrated load will be applied to nodes or 

points on the model also need to be specified. Influence attributes are defined and 

assigned from the Attributes> Influence menu. Load locations are defined on the 

Direct Method Influence dialog, which is displayed either when a Direct Method 

Influence attribute is first assigned to a node or point on the model, or when the 

Analyses> Direct Method Influence Analysis menu item is selected or edited. 

Previously defined settings can be accessed and edited from the context menu for each 

Direct Method Influence entry in the Analyses  Treeview.  

Materials, sections, supports and other attributes for a DMI analysis are taken from the 

base analysis. Because of this, it is a requirement of a Rail DMI analysis that the base 

analysis is a simple linear static analysis. 

file:///C:/SVN/Content/dlg6anal/idd_direct_method_loading_settings.htm
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Load locations 

 Track layout - Previously defined track layouts can be selected for inclusion 

in the influence analysis. 

 Search area - A search area can be used to limit the features over which the 

concentrated load is applied so that the effect of the load on other features in 

the model may be prevented. If a search area is not specified the default loading 

area is Whole model. 

Advanced settings  

The magnitude of the loading applied for an influence analysis can be modified. Note 

that for a Rail DMI analysis there is no requirement to specify a loading direction. 

Notes 

 Unlike Vehicle Load Optimisation (where the traffic loads can be placed 

anywhere between the selected kerbs defining a width of carriageway) Rail 

Load Optimisation loading can only follow the track definitions defined for 

each track layout. Instead of the grid of virtual points that is used by the 

Vehicle Load Optimisation facility to represent the loadable region of the slab 

that is to be loaded with a unit point load as part of an influence analysis, for a 

Rail Direct Method Influence analysis, nodes are created automatically where 

each rail intersects with an element in the search area. In this way, the number 

of locations where a unit load can be applied is minimised, and ensures that the 

influence shapes are drawn following the alignment of each rail track. 

 Modifying a rail track layout that is used in a Rail DMI analysis will invalidate 

the results of that analysis resulting in an invalid results symbol (a red circle 

with a line through it)  appearing alongside any influence results loadcases 

in the Analyses treeview, requiring a re-solve to be done. 

Vehicle Load Optimisation 

Vehicle load optimisation analysis is available in Bridge software products only. It is 

accessed from the Analyses > Vehicle Load Optimisation menu item.  

Vehicle load optimisation is used to identify the most onerous vehicle loading patterns 

on bridges for a chosen design code and to apply these loading patterns to LUSAS 

models. It reduces the amount of time spent generating models and leads to more 

efficient and economic design, assessment or load rating of bridge structures.  

See Vehicle Load Optimisation in Application Manual (Bridge, Civil & Structural) 

for more details. 

file:///C:/SVN/Content/Bridge/Rail_Load_Optimisation/railway_track_layout.htm
file:///C:/SVN/Content/Bridge/Vehicle_Load_Optimisation/Vehicle_Load_Optimisation_Wizard.htm
file:///C:/SVN/Content/Bridge/Rail_Load_Optimisation/Rail_Load_Optimisation_Overview.htm
file:///C:/SVN/Content/Bridge/Rail_Load_Optimisation/Rail_Load_Optimisation_Overview.htm
file:///C:/SVN/Content/Bridge/Rail_Load_Optimisation/railway_track_layout.htm
file:///C:/SVN/Content/Bridge/Vehicle_Load_Optimisation/Vehicle_Load_Optimisation_Overview.htm
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Rail Load Optimisation 

Rail load optimisation analysis is available in Bridge software products only. It is 

accessed from the Analyses > Rail Load Optimisation menu item.  

Rail load optimisation is used to identify the most onerous rail loading patterns for 

specified track layouts on bridges for a chosen design code, and to apply these loading 

patterns to LUSAS models. It reduces the amount of time spent generating models and 

leads to more efficient and economic design, assessment or load rating of rail bridge 

structures.  

See Rail Load Optimisation in Application Manual (Bridge, Civil & Structural) for 

more details. 

Cable Tuning Analysis 

 Linear and nonlinear cable tuning analysis is available in selected Bridge and Civil & 

Structural software products only. 

 Linear cable tuning analysis can be set-up by use of the Analyses > Linear 

Cable Tuning Analysis menu item.  

 Nonlinear cable tuning loadcases can be set-up by use of the Analyses 

> Nonlinear Cable Tuning Loadcase menu item. 

See Cable Tuning Analysis in the Application Manual (Bridge, Civil & Structural) 

for more details. 

LUSAS Solver Types and Options 

Choosing a Solver 

The Solver type and associated options can be specified by selecting the File > Model 

Properties menu item, selecting the Options tab of the Model Properties dialog, and 

choosing the 'Specified on Solve Now dialog' droplist option. The Model Properties 

dialog can also be accessed from the Model Properties control object in the Analyses 

 Treeview. The main solver types are: 

 Frontal (direct) solvers are more robust than iterative solvers and are 

applicable to all types of analysis. Frontal solvers should always be used for 

very ill-conditioned problems since the time taken to obtain a solution is 

independent of the problem conditioning. 

 Parallel solvers high-performance, robust, memory efficient solvers for 

solving large sparse symmetric and non-symmetric linear systems of equations 

(only) on shared memory multiprocessors 

 Iterative solvers require far less storage (memory + disk space) than direct 

solvers. This means that iterative solvers sometimes have the advantage of 

file:///C:/SVN/Content/Bridge/Rail_Load_Optimisation/Rail_Load_Optimisation_Overview.htm
file:///C:/SVN/Content/Bridge/Cable_Tuning_Analysis/Cable%20tuning%20analysis.htm
glossary.chm::/Glossaryillconditioning.htm
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remaining in memory where a direct solver would have to run "out of 

memory". Iterative (e.g. conjugate gradient) solvers are usually only applicable 

to static, linear analyses, and will perform best on large, well conditioned 

problems, since the time taken for solution is less dependent on the size of the 

problem than for direct solvers. Iterative solvers are only applicable for a single 

loadcase   

Solvers supported 

The current solver options supported are: 

 Default The default solver is the standard Frontal solver. If the Fast Solvers 

software option has been licensed the Fast Multi Frontal solver is used by 

default instead. 

 Frontal An element-by-element frontal solver which does not require assembly 

of the global stiffness matrix. It uses a direct, sparse solution technique based 

on Gaussian elimination. Stiffness and load arrays are read into memory and 

assembled into the structural stiffness matrix and load vector. This solver is 

applicable to all types of analysis present in LUSAS Solver. The frontwidth of 

the problem may be reduced by optimising the order in which the elements are 

presented. See Frontal Optimisation for details. 

 Iterative (Conjugate Gradient) - Selects an iterative, sparse solution 

technique for solving static, linear analyses. The global stiffness matrix and 

load vector(s) are assembled, and is designed to run entirely in-memory. Three 

preconditioning techniques are available to assist the convergence rate of the 

conjugate gradient method: 

 Standard The incomplete Cholesky preconditioning technique is the 

most robust (provided an appropriate drop tolerance is chosen), and is 

applicable to all analyses for which the conjugate gradient solver may 

be used. 

 Decoupled The decoupled incomplete Cholesky preconditioning 

technique may be used for all analyses except those involving tied 

slidelines, thermal surfaces and Fourier elements. It generally leads to 

faster overall solution times than Incomplete Cholesky preconditioning, 

although more iterations are required for convergence. For less well 

conditioned problems, the conjugate gradient algorithm may not 

converge using this technique, so care should be taken. 

 Hierarchical The hierarchical decoupled incomplete Cholesky 

preconditioning technique is only available for models consisting 

entirely of two - and three-dimensional, solid continuum, quadratic 

elements, and offers excellent convergence properties. It is by far the 

most effective technique for models of this type, and when used in 

conjunction with fine integration allows solutions to be obtained for 
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relatively ill-conditioned problems. For very ill-conditioned problems 

of this type (e.g. where the average element aspect ratio is high), an 

extra preconditioning option exists which will often yield a solution 

faster than using a direct solver. 

 Assembly Assembles a stiffness matrix only and is primarily intended for 

research use. 

 Fast Multi Frontal A global frontal solver which assembles global stiffness 

and load data. It uses a direct, sparse solution technique based on Gaussian 

elimination. Stiffness and load arrays are read into memory and assembled into 

the structural stiffness matrix and load vector. This solver is applicable to all 

analysis types except for superelements, Guyan reduction, and nonlinear 

problems involving branching and bracketing. 

 Fast Parallel Direct Solver A high-performance, robust, memory efficient 

solver for solving large sparse symmetric and non-symmetric linear systems of 

equations on shared memory multiprocessors. This solver cannot currently be 

used for any form of eigenvalue analysis, or for superelement or Fourier 

analyses, or for nonlinear problems using branching and bracketing. 

 Fast Parallel Iterative Solver A high-performance, robust, memory efficient 

solver for solving large sparse symmetric and non-symmetric linear systems of 

equations on shared memory multiprocessors. This solver cannot currently be 

used for any form of eigenvalue analysis, or for superelement or Fourier 

analyses, or for nonlinear problems using branching and bracketing. 

In general, care should be taken when solving problems with high aspect ratios (thin or 

elongated), or excessively curved or distorted elements, or extreme or widely disparate 

material properties, since all of these can lead to ill-conditioning. Note also the 

convergence of the Iterative (Conjugate Gradient) solver is related to the condition 

number of the stiffness matrix which becomes worse for ill-conditioned problems. 

Fast Parallel Solver settings 

The Fast Parallel Solvers can be configured using the following parameters: 

 In Memory Solution When selected produces a solution within memory. 

When not selected solves out-of-memory. 

 Message Level options are None, which provides no output; or Statistics, 

which prints data to the Solver window. 

 Pivot Tolerance (Parallel Direct Solver Only) Default value is 1e-12 

 Pivoting Method (Parallel Direct Solver Only) options are Diagonal pivoting 

(the default) or Bunch and Kaufman pivoting. 

 Maximum number of iterative refinement steps (Parallel Direct Solver 

Only) The default is 10. 

glossary.chm::/Glossaryaspect_ratio.htm
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 Stopping criteria tolerance (Parallel Direct Iterative Solver Only) The 

stopping criteria in Krylow-Subspace iteration. The default is 1e-6. 

 

If a model with constraint equations fails to solve using a Fast Parallel Direct Solver, 

modifying some of the Fast parallel Solver parameters will enable the analysis to 

complete successfully, If necessary, contact LUSAS Technical Support for assistance. 

Iterative (Conjugate Gradient) solver settings 

The Iterative (Conjugate Gradient) solver can be configured using the following 

parameters: 

 Drop tolerance This is a value between 0.0 and 1.0 which measures the 

amount of new non-zero entries (known as fill-in) allowed to remain in the 

preconditioning matrix during the incomplete Cholesky factorisation of the 

stiffness matrix. The default value is 1.0, leading to a very sparse 

preconditioning matrix suitable for well conditioned problems. For more ill-

conditioned problems, however, this value should be decreased exponentially, 

and values in the range [1.0e-3, 1.0e-6] are recommended. The lower this 

parameter becomes, the larger the preconditioning matrix will be, giving rise to 

fewer iterations during the conjugate gradient solution, although each iteration 

will take longer to process. This parameter affects all preconditioning 

techniques, although the effect is less pronounced for the decoupled techniques. 

 Maximum number of iterations This is an upper limit on the number of 

conjugate gradient iterations to be processed; the default value is 5000. If the 

convergence criterion has not been satisfied when the iteration limit is reached, 

LUSAS Solver will issue a warning and then continue the analysis. 

 

The following additional check box options are also available: 

 Output iterative solution information   

 Extra preconditioning with a hierarchical basis 

 Keep global matrix assembly in-core 

 Minimise memory usage forces the Fast Solver to use the minimum amount of 

memory possible. 

 

The following points need to be taken into account: 

 Conjugate gradient methods can only be used for problems having symmetric 

positive-definite matrices. By definition, standard linear, static analyses yield 

positive-definite matrices in general, but mixed-formulation problems (such as 

pore pressure models) do not. 

 Problems involving constraint equations cannot currently be solved with the 

iterative solver, since the resulting stiffness matrix is non-positive-definite. 
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 For problems with multiple loadcases, iterative solvers are less efficient since a 

separate iterative process is required for each loadcase, and the total time taken 

will increase in proportion to the number of load cases. By contrast, direct 

solvers incur very little extra cost when solving for multiple loadcases. 

 Guyan reduction and superelement analyses cannot be solved iteratively, 

since matrix reduction does not take place. 

 When using hierarchical basis preconditioning, if any midside degrees of 

freedom are supported or prescribed, their corresponding vertex neighbours 

must also be supported or prescribed. For example, if a midside node is fixed 

in the x-direction, all nodes on the same edge of that element must also be 

fixed (or prescribed) in the x-direction. 

 The iterative solver will perform very poorly if there is not enough physical 

memory for the solution to proceed in-memory. To guard against this, a data 

check (OPTION 51) may be performed (as with the direct solvers), which will 

estimate the amount of memory the iterative solver would use with the 

specified drop tolerance and choice of preconditioning technique.  

 The iterative solver has limited error diagnostics to warn against ill-defined or 

incompletely specified models. If this is suspected, the analysis should be run 

through the standard frontal solver for more comprehensive error diagnostics. 

For further information see the Solver Reference Manual 

Frontal Optimisation Options 

The frontal optimisation options are set from the Solver Options dialog which is 

accessed via the Model Properties or Solver option control objects in the Analyses  

Treeview.  

Frontal optimisation is only required when using the standard Frontal solver. It is not 

required for the Fast Multi Frontal solver. When no optimiser is specified the Sloan 

optimiser will be used to optimise the front width for the standard frontal solver. The 

frontwidth of the problem may be reduced by optimising the order in which the 

elements are presented.  

Optimising methods supported are: 

 Standard uses the standard LUSAS optimiser. 

 Akhras-Dhatt uses the Akhras-Dhatt optimiser. A number of iterations must 

be specified for this optimiser. The iterations are used to find the best starting 

point in the structure for the optimisation. The higher the number of iterations, 

the better the chance of locating the optimal starting point, but the longer the 

optimisation process takes. 

glossary.chm::/GlossaryGuyan_reduction.htm
glossary.chm::/Glossarysuperelements.htm
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 Cuthill-McKee optimises the solution based on the Cutill-McKee optimiser. 

This algorithm bases its optimisation on a specified parameter. Options are: 

maximum bandwidth, RMS wavefront, bandwidth and profile. This optimiser 

was originally written by E.H. Cuthill and J.M. McKee, and was improved by 

G.C. Everstine. 

 Sloan uses the Sloan optimiser (default). 

 

If no optimiser is specified then the Sloan optimiser is used by default. 

Solver platform selection 

If 32 and 64 bit versions of LUSAS Solver have been installed, you can specify which 

version of LUSAS Solver should be used with your current instance of 

LUSAS Modeller: 

 Follow Modeller - use the same version of LUSAS Solver as being used by 

LUSAS Modeller 

 32 Bit - use the 32 bit version of Solver 

 64 bit - use the 64 bit version of Solver 

Solver Licence Selection 

When running an analysis, LUSAS Modeller passes all details of the licence it is 

running with to LUSAS Solver. It includes the minimum set of licence options 

required to solve the job, and a teaching and training identifier if Modeller is running 

in teaching and training mode.  

To find a suitable Solver licence with which to run an analysis Solver does the 

following: 

 By default a Solver licence with the same licence key number or 25 character 

key as the Modeller licence is sought and if available and valid is used. 

 If the Solver licence that matches the Modeller licence is in use, or is invalid or 

unavailable, Solver will re-order all suitable Solver licences and internally list 

them such that the least functional Solver licence that is still able to solve the 

job is listed first.  

 Once listed, Solver will tumble through the licences in the list until one is 

found that is both valid and available. This is then used for the duration of the 

analysis. 

Creating shortcuts 

Shortcuts can be created to tie a licence type to a shortcut used to run LUSAS Solver. 

For more information see the LUSAS Configuration Utility. 

file:///C:/SVN/Content/dlg0config/Introduction.htm
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Pre-Analysis Checks 

Prior to running an analysis it is prudent carry out a few basic checks: 

1. Check the consistency of your coordinate systems between the finite element 

model and any engineering drawing(s) that you have worked from. 

2. Check key drawing dimensions against coordinates of respective points in the 

model. 

3. Check the mesh for cracks and voids. Checks for cracks must be made to 

ensure that the features form a continuous structure.  

4. Check for correct material properties and assignments. 

5. Check for consistent units. 

6. Check for correct orientation of beam properties. 

7. Check for correct boundary conditions (loads/supports). 

8. Check element thickness against original model data (plates/shells). 

9. Check reversed normals for plates/shells/2D. 

10. Check element shapes for aspect ratio, skew, warp, taper, curvature and 

centrality of mid-side nodes. Warning messages will be present in the output 

file for all of the above. 

11. From the LUSAS datafile dialog, File> Export Solver datafile... menu item, 

click on the Output button to check that the output provides sufficient 

checking information in the LUSAS Solver output file (e.g. reactions).  

Notes 

 It is often a good idea to carry out a ‘pilot’ analysis on a crude model to check 

load paths and equilibrium. 

 In order to ensure that an adequate mesh density is used a mesh sensitivity 

study should be carried out.  

 It is good practice to keep an up to date log book with adequate plots 

(including hidden line views) to cover all parts of the model. It is also useful to 

set-up a reference system to select individual regions of the model using the 

Groups facility. 

 Keep a log of analysis runs for future reference. Note information such as 

element types, numbers of loadcases, frontwidth, file sizes, run-times, etc. 

 Keep regular backups of model. This is done automatically by LUSAS 

Modeller. See Model Files for more details. 

elementreference.chm::/appendix/idh_excessive_aspect_ratios.htm
elementreference.chm::/appendix/idh_excessive_warping.htm
elementreference.chm::/appendix/idh_excessive_element_curvature.htm
elementreference.chm::/appendix/idh_midside_node_centrality.htm
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Running an Analysis 

There are various ways in which an analysis can be run from within LUSAS Modeller.  

The Solve now toolbar button  allows particular analyses to be selected for 

solving.  

A context menu for each analysis name in Analyses  Treeview provides additional 

Solving options: 

 Solve now allows individual analyses to be solved in isolation from others that 

are present in the Analyses  Treeview, and solves all loadcases defined 

within that analysis. 

 Loadcases to solve allows selection of loadcases to be solved (the checkbox is 

ticked) when the Solve now toolbar button or context menu option are chosen. 

Loadcases where the check box are unticked will not be solved and these 

loadcases are denoted in the Analyses treeview with a red cross    to show 

that they have been turned off for solving. 

 

When using the Solve now toolbar button, the initial state of the checkbox alongside 

each analysis name on the Solve Now dialog shows whether an analysis needs to be 

solved (because results for that analysis do not exist or are out-of-date due to changes 

being made to the model after an initial solve had been done). Descriptive text 

alongside each analysis name shows the reason why an analysis needs to be solved or 

not. Analyses needing to be solved will be shown checked; those not requiring to be 

solved will be shown unchecked. An analysis will be solved (whether it needs to be or 

not) if the checkbox is ticked on. No solving will take place if a checkbox is off when 

the OK button is pressed.  

Note that solving a model automatically creates a Solver data file, an output file and, if 

successful, a solver results file for each analysis. 

If an Analysis is Successful 

Results loadcases for each analysis are loaded into the relevant analysis entry in the 

Analyses  Treeview in readiness for optional processing and viewing of results. For 

nonlinear analyses the loadcase of the last solved increment will be set active by 

default. For eigenvalue analysis the first eigenvalue will be set active. 

Using a 32 bit or 64 bit Solver 

The default behaviour when the Solve Now button is selected within 32 bit Modeller, 

is to run the 32 bit Solver. See the Installation Guide for details of how to run the 64 

bit Solver when using the 32 bit Modeller. 
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If an Analysis Fails 

If an analysis fails, information relating to the nature of the error encountered is 

written to the text output window and, depending upon the nature of the error, also to 

an output file. Any errors listed in the text output window should be corrected in 

LUSAS Modeller before saving the model and re-running the analysis. 

 Errors and warnings reported in the Text Output window can be double-clicked to 

open the Identify Object facility which can be used to locate the referenced items. For 

an explanation of the errors which may occur see Appendix B - LUSAS Solver 

Trouble Shooting 

When the termination of an analysis is due to a failure of the solution process rather 

than a problem with the modelling of the structure, if solver restart files were being 

written as the model was being solved, the solution may be restarted from the last 

converged increment with a different or modified solution strategy. See Solver 

Restart Files for details. 

Identifying objects causing errors during a solve 

Command confirmation and error messages are displayed in the Text Output window.  

Double-clicking on an error or a warning reported in the Text Output window opens 

the Identify Object facility which can be used to locate the referenced geometric 

feature or mesh object. Options are provided to select the offending item in the View 

window, move it to the centre of the view, scale it to fit the screen, have its properties 

displayed, or be identified by an annotation arrow or a temporary indicator.  

Post-Analysis Checks 

All Analysis Types 

1. Check the deformed mesh for each loadcase to ensure the model has deformed 

as expected. 

2. Compare your finite element results with estimates of stress and deflection 

from hand calculations. This may not always be possible to do very accurately, 

but an estimated should be obtainable. 

3. Check reactions for equilibrium. 

4. Check magnitudes of displacements and stresses. If possible compare to hand 

calculation. 

5. Check for matrix conditioning messages. Small pivot and diagonal decay 

warning messages are invoked when the stiffness matrix is poorly conditioned. 

Diagonal decay means that round-off error during the solution has become 

significant which could lead to inaccurate results. A poorly conditioned 

stiffness matrix is the result of a large variation in magnitude of the diagonal 
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terms. This could be caused by large stiff elements being connected to small 

less stiff elements or elements with highly disparate values of stiffness (e.g. a 

beam may have a bending stiffness that is orders of magnitude less than it's 

axial stiffness).  

 

A negative pivot in a non-linear analysis usually means that a limit or 

bifurcation point has been encountered. However, negative pivots sometimes 

occur during the iterative solution (which sometimes means that the load step 

is too big) but disappear when the solution has converged. If negative pivots 

occur and the solution will not converge then first try reducing the load step. 

 

If the solution still does not converge a limit or bifurcation point may have 

been encountered in which case the solution procedure may need to be 

changed. Running the problem under arc length control gives the best chance 

of negotiating a limit or bifurcation point. A load limit point can also be 

overcome by using prescribed displacement loading. 

6. Check the LUSAS Solver output file for other warning or error messages. 

7. Check adequate mesh density. 

8. Check average nodal stress calculations are not carried out across 

discontinuities. 

9. Check the model summary information available in the LUSAS Solver output 

file. This gives the total length, area, volume and mass for the structure 

together with the centre of gravity, moments of inertia and resultant applied 

load at the origin. 

Dynamic Analysis Types 

1. Check the first natural frequency against hand calculation. 

2. Check of convergence of the eigenvalue extraction algorithm. 

Non-linear Analysis Types 

1. Check convergence of the non-linear analysis. 

Technical Support 

Assistance with Modelling, Analysis and Results 

Engineers in LUSAS Technical Support are available to help all clients with a current 

support and maintenance contract and assist with any modelling or analysis problems 
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that may be encountered. Support may be requested by telephone or by email. Email is 

the preferred contact method. All relevant files must be sent. See below for details. 

Please note that if LUSAS was supplied to you by a LUSAS distributor then they 

should be your first point of contact for support.  Your local distributor will have 

access to the main LUSAS Technical Support Centre for assistance if required. 

What information should be provided? 

As a guide, providing some or all of the following information will help the support 

engineers get to the bottom of your problem more quickly: 

 The exact text of any warning or error message(s). 

 Machine specification operating system, memory and available disk space. 

 A copy of the model file data that is causing a problem (along with all 

associated model files - see below for details) 

 A list of the last commands used in LUSAS Modeller or a copy of the session 

file. 

 The contents of the last LUSAS Modeller error log LUSASM_x.ERR 

 Full details of the LUSAS Modeller/LUSAS Solver version numbers in use, 

the LUSAS Solver version number is written to the header section of the output 

file and the LUSAS Modeller version number is obtained from the Help> 

About LUSAS Modeller menu item.. 

 For telephone support with complex or difficult to describe problems, emailing 

or faxing a simple diagrammatic representation before telephoning can aid in 

the understanding of a problem. 

Sending files to LUSAS Technical Support 

Small files may be emailed in isolation but note that LUSAS model files normally 

refer to many other associated files. For these models, use the LUSAS Support Tool 

to create a compressed file of all relevant data to send to LUSAS Technical Support.  

If within sending and receivable email limits, files may be emailed, but if larger, files 

can be uploaded to a LUSAS Support Area using FTP.  

LUSAS Technical Support can be contacted at support@lusas.com 

Web Resources 

A number of resources are also available via the main LUSAS website.    
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Main LUSAS website 

http://www.lusas.com 

General support services  

http://www.lusas.com/support 

LUSAS User Area  

http://www.lusas.com/usrcheck.html 

Note that the LUSAS User Area requires a username and password for access. This 

will be provided initially to the named LUSAS contact within your organization who 

should be consulted if necessary. It can also be requested by and sent to registered 

users of LUSAS. The User Area contains: 

 Answers to the most frequently encountered problems when using LUSAS 

  Detailed instructions for carrying out various tasks with LUSAS 

 Theory on many aspects of LUSAS and finite element analysis in general 

  Explanations and remedies for specific LUSAS error/warning messages 

  Technical and 'How to notes 

  Knowledge base of recently fixed software errors and outstanding issues 

  Link to online copies of LUSAS manuals for recent versions (PDF format) 

 Details of recent LUSAS software releases, LUSAS scripts and other useful 

files. 

 And more... 

LUSAS Support Tool 

The LUSAS Support Tool ensures that if a support query is raised all relevant files can 

be submitted to LUSAS Technical Support to aid with the resolution of the query. It is 

accessed using the Help > Support Tool menu item. The following data can be 

optionally included in the archive: 

 Vehicle Load Optimisation settings and input files 

 Model and session files 

 Results file (.mys) 

 

A single file is created in a compressed file format containing selected data relating to 

the current model. The file is created in the current working directory with a .zip file 

extension, using the model name and date and time of creation as the filename. 

http://www.lusas.com/
http://www.lusas.com/support
http://www.lusas.com/usrcheck.html
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Automated Error Reporting 

LUSAS Modeller makes use of a third party crash reporting facility (CrashRpt) to 

allow users to optionally submit crash reports to LUSAS for investigation. If a crash 

occurs a crash dump is also assembled.  

The automatically assembled error report contains useful information relating to the 

operating system in use, the amount of memory in use by Modeller at the time, where 

in LUSAS the error occurred, and the state of the program when the error occurred. No 

personal information whatsoever is obtained.  

It is requested that crash report information be sent to LUSAS for the benefit of other 

users, and to aid in the continual improvement of the software. Additional information, 

such as an email address, and a brief description of what was been carried out at the 

time of a crash can be optionally given.  

An option to Restart LUSAS Modeller after submitting the error report is also 

provided. This enables a model recovery to be carried out. 

Recovering from a crash 

If a crash has occurred, and if the option to restart LUSAS Modeller after submitting 

the automated error report was chosen LUSAS will automatically be re-started, and 

display startup dialogs culminating in the ModelRecovery dialog where options for 

recovering the previous session are presented. See Model Recovery for more details. 

Not-automated Error Reporting 

For a fully documented investigation of a problem a Support Query should be raised 

by email or telephone with LUSAS Technical Support. This will normally require a 

model and all associated files to be provided. 

Model Recovery 

The model recovery dialog will appear if a model selected for opening had, in a 

previous LUSAS session, been interrupted unexpectedly before it could be saved, 

resulting in a recovery file being created. This may have been because of a power 

failure, a program error, or from a deliberate interruption. The last command carried 

out prior to the interruption is reported in the dialog. There is a choice in how the 

model should be recovered from this point: 

 Recover whole session Choose this option to recover the whole session 

(carrying out all the commands you made) including the last command shown. 

This would generally be chosen unless the last command consistently caused 

similar problems that prevented a recovery from taking place.  

 Recover all except last command above Choose this to carry out all 

commands except the one shown. This would be chosen if it was known, or 
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subsequently found, that the last command shown caused the interruption or 

prevented a model recovery from being made. 

 Open last saved model Ignores all commands and changes made to the model 

since the last save. The last saved model file of the same name is opened. 

 Preserve a backup copy of the model and recovery file  This option is 

selected by default and is used to save all files related to an interrupted session 

for sending to LUSAS Technical Support. 



  Chapter 8 : Viewing and Processing 
Results 

    

657 

Chapter 8 : 

Viewing and 

Processing the 

Results 

  

Introduction to Results 

This section deals with procedures for results processing. It covers manipulation of 

results files, selection of the correct results type and loadcase, and differences between 

results viewing coordinate systems. 

 Results Processing provides an overview of results processing. 

 Results Files covers manipulation of results files. 

 Results Selection covers selection of the active loadcase, and setting of fibre 

location and a composite lamina. It provide a basic overview of results 

components, results entities and results display capabilities. 

 Results Transformation provides options for transforming results to a 

consistent or alternative coordinate system 

Results Processing 

Results processing is the manipulation and visualisation of the results produced from 

an analysis. Prior to visualising and extracting results, further calculations may be 

carried out to create or assemble results, or the results can be manipulated to create 

results at particular model locations for a particular results viewing use. 
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Further Calculations 

 Combinations and envelopes 

 Design combinations 

 Fatigue analysis of a linear model 

 IMDPlus analysis 

 Modal analysis 

 Design factors 

 Target values 

 Steel frame design 

 RC frame design 

 Wood - Armer reinforcement 

 Beam stress resultant from beam 

and shells 

 RC Slab Design 

 Crack width calculation to 

EN1992-1-1 

 Expansion of Fourier analysis 

results 

 Composite failure criteria 

 User defined results 

Manipulating the Model 

 Results transformation 

 Plotting results for groups 

 Results on a section through the 

model 

 Slideline results processing  

 Thermal surface results processing 

Visualising and Extracting Results 

 Deformed mesh 

 Peak values 

 Bending moment and force 

diagrams 

 Contour plots 

 Inspection locations 

 Results as vectors 

 Concrete crack patterns 

 Yield of nonlinear material 

 Plotting beam stresses 

 Plotting results for assigned 

attributes 

 Graphing of results 

 Animation sequences 

 Printing results to the screen or a 

file 

 Reporting on individual features 

(one-click reporting) 

 Generating a Main Report 

 Generating a Design Report 

file:///C:/SVN/Content/Design/RC_Frame_Design/rc_frame_design.htm
file:///C:/SVN/Content/Design/RC_Slab_Design/idh_rc_slab_designer_viewing_results.htm
file:///C:/SVN/Content/Bridge/Crack_Widths/idh_crack_widths.htm
file:///C:/SVN/Content/Bridge/Crack_Widths/idh_crack_widths.htm
file:///C:/SVN/Content/Design/Steel_Frame_Design/steel_frame_design.htm
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Results Files 

When an analysis is performed by LUSAS Solver a results file will be created. For 

historical reasons this has a .mys extension. By default the results file is automatically 

loaded into LUSAS Modeller after LUSAS Solver has been run. 

The information in the Solver results file is stored in a binary form and may only be 

accessed using LUSAS Modeller. The results file will contain the results of the 

analysis and sufficient model information to process the results. Full details of the 

finite element mesh (nodes and elements), material and geometric property numbers, 

support positions and equivalent nodal loads are stored in the results file. 

Opening available results files for a model  

When a model is opened, Modeller will 

attempt to open all available associated 

results files for that model. The File 

> Open Available Results Files menu item 

also exists for the same purpose. Results 

files are loaded on top of the current model 

and results loadcases are added to the 

relevant Analysis entries in the Analyses 

 Treeview. For each view window, the 

last used loadcase is set active by default.  

 Multiple results files may be loaded to 

allow accessing of results from a number of 

analyses at the same time. See Manage 

Results Files for details. 

The Analyses  Treeview (right) shows a 

typical listing obtained when a results file is loaded for a model. 
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Opening a results file without a model being open 

A results file can be opened in isolation from 

a model by using the File> Open menu 

item. By changing the Files of type drop-

down list, results files (.mys) can be 

selected.  

Opening a results file in isolation from a 

model does not provide access to any 

generated post processing loadcases such as 

envelopes, combinations etc that were saved 

with the model file. 

When a results file is opened in isolation from the model from which it was created the 

results data and stored mesh data is loaded from the .mys file. This method is used 

when access to model information, such as feature definitions or group names, is not 

required or is not available for results-processing. 

The Analyses  Treeview (right) shows the listing obtained for the same analysis 

when only the result file is loaded . 
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Closing Results Files 

All results files for all analyses can be closed by selecting the File> Close all Results 

Files menu item. 

Results files for an individual analysis can be closed by using the context menu item 

Close Results File that is provided on each loadcase. Note that if the results file 

selected was the first results file loaded, all results files will be closed. 

Results Selection  

Setting the Active Loadcase 

The active loadcase is the loadcase that 

provides the results for the current window. 

To set a loadcase active either: 

 Right-click on the loadcase in the 

Analyses  Treeview, and choose 

Set Active from the context menu, 

or: 

 Drag and drop a loadcase from the 

Analyses  Treeview into a view 

window to set that loadcase active in 

that view. 

In this way a single window is used to plot 

results from a single loadcase, and multiple windows can be used to compare results 

from different loadcases. 
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Setting the Active Fibre Location  

For plotting values and /or diagram results 

of stress (this step is not required for forces 

and moments) on bars and beams only, the 

active fibre location for which results will 

be plotted must be chosen. It is set by 

choosing the Set Fibre Active menu item 

from the context menu of a fibre entry held 

within a geometric line attribute in the 

Attributes  Treeview. Fibre locations 

can be visualised by double-clicking on the 

Geometric Line name and selecting the 

Visualise button on the dialog presented. 

Choosing the Set Fibre Active option 

shows results for that fibre in just that attribute. Setting the Name Active shows results 

for all similarly named fibres in other attributes throughout the model. 

  

Setting the Active Composite Lamina  

With composites analysis, in order to plot 

results on composite laminae a particular 

lamina must be made active. It is set by 

choosing the Set Lamina Active menu item 

from the context menu of a lamina entry 

held within a Laminate stack attribute in the 

Attributes  Treeview. Setting a Lamina 

active, shows results for just that lamina. 

Composites lamina information can be seen 

and visualised by double-clicking on the 

Laminate stack name and selecting the 

Visualise button on the dialog presented.  

  

Results Entities (Types) 

There are several different types of results entities available in each results file. Full 

details of the results available for each element type may be found in the Results 

Tables of the Element Reference Manual.  

To view results a chosen results entity must be specified. Only results entities that are 

actually contained in the loaded results file are presented for selection. The following 

is a summary of all the results types: 
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Structural Analysis    Thermal Analysis 

 Displacement 

 Force/Moment 

 Stress 

 Strain 

 Loading 

 Reaction 

 Reaction Stress 

 Residual 

 Velocity 

 Acceleration 

 Plastic Strain 

 Creep Strain 

 Rubber Stretch  

 Strain energy 

 Plastic work 

 Slideline 

 Named variables 

 State variables 

 Slab Design (RC) 

   Potentials  

 Fluxes  

 Gradients  

 Thermal Surface 

Results Components 

For each results entity a results component (Fx, My etc) will also need to be chosen. 

See the Results Tables in the Element Reference Manual for component definitions. 

User-defined results components will appear within the entity within which they were 

placed. 

Results Display options 

By default, results are averaged respecting discontinuities formed by geometry 

orientation, geometric assignments and material assignments. Default averaging 

settings can be changed on the Model Properties - Options (Averaging Options) 

dialog. Unaveraged nodal results are displayed on an element-by-element basis, and 

will show inter-element discontinuities. This is useful for checking possible mesh 

discretisation errors and for displaying results across geometry, material or other 

discontinuities (if averaging for these situations has been otherwise allowed).  

 Results visualisation is performed using results layers in the Layers  

Treeview. Viewing results requires the relevant layer to be present for the 

active current window. The properties of the results layers may then be set to 

display the required entity and component in a specified style.  

 Inspection locations can report on results for elements that belong to the 

assigned feature, and also for those elements that belong to topologically 

connected features. 

 Feature maximum, Feature minimum, and Feature extreme values can be 

reported. 

 When section slices have been created through a solid model, results can be 

displayed on those slices 

file:///C:/SVN/Content/7results/idh_treeview_layers.htm
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 When an envelope or a smart combination is set active, options to view 

maximum, minimum or extreme results are available.  

 Sometimes it may be necessary to transform the results, for example if the 

elements in a model are orientated such that their local axes vary from one 

another. Numerous options are available. See Results Transformation for 

details. 

Notes 

 Stresses are stress resultants for beams, plates and shells 

 For plates and shells top, middle and bottom stress and strain are available. 

 When applicable, composite failure values, design factors and beam stresses 

are available from the Stress results type. 

 The results calculation and display may be controlled independently using the 

Result Plots dialog activated from many context menus, including those for 

groups, attributes, and selection details. 

 See Results Transformation for general notes regarding the orientation of 

results. 

Results Averaging 

Finite element results are calculated for each element individually. With a sufficiently 

fine mesh, the results of adjacent elements are usually sufficiently similar that the eye 

sees no visible difference at the boundary between adjacent elements. But when a 

mesh is coarse, the results of adjacent elements can be quite different. Where an 

engineer is satisfied that such differences can be safely ignored, it can sometimes be 

desirable to show a smoothed result, averaging the contributions from adjacent 

elements at their common nodes. However, there are times when averaging is not 

appropriate. For example, it is generally considered invalid to average across a 

boundary between elements that have different materials, or different thicknesses, or at 

a junction where elements lie in different axes or planes. 

LUSAS employs rules to spot situations where averaging of results is not appropriate. 

For each pair of elements that is considered, if all the averaging rules "pass" then 

averaging of results across those elements is permitted. If any averaging rule "fails" 

then a discontinuity is said to exist between those elements, and averaging will not be 

permitted. The user may choose to switch rules on or off for finer control. 

Averaging rules 

The following rules exist, where each rule considers the common boundary between 

exactly two elements.  
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 Any elements that are meshed in the same feature are assumed to be suitable 

for averaging. This is a fundamental rule and as such does not appear in the 

user interface. The presence of this implicit rule means that all the rules below 

can assume that the elements are from different features. 

 The Feature rule is a very conservative strategy. It assumes that averaging 

should only be permitted where elements reside in the same feature (line, 

surface or volume). This rule is not on by default. Switching this rule on makes 

all the other rules below irrelevant. 

 The Different assignments rule dictates that a discontinuity exists wherever 

the two parent features have any difference in their attribute assignments, such 

as material assignment, age, and loading to name a few. For example, if 

element 1 belongs to surface 1 and element 2 belongs to surface 2 and a load is 

applied to element 1 in loadcase 1, and that same load is applied to surface 2 in 

loadcase 2, the assignments are therefore different, and a discontinuity is 

assumed to exist between element 1 and element 2 in all loadcases. 

 The Common LOF assignments rule dictates that a discontinuity exists 

wherever there is any attribute assignment to the feature (the lower order 

feature) that forms the common boundary between the two features being 

considered. For example, if both elements are surface elements, then they each 

belong to a surface. Since they belong to different surfaces (see the first rule), 

and they are adjacent, then there is a common line separating them. If that line 

has any attribute assignment whatsoever, then averaging is not permitted 

between those two elements. Note there are three specific exceptions:  NULL 

mesh assignments, "assign to all" assignments, and "Default" assignments. 

Note also that no check is made to see if the assignment(s) apply in the active 

loadcase. 

 The Visibility rule is not applied (turned 'on') by default. It is provided for 

those users who wish to emulate the old V15.2 behaviour that averaging was 

carried out on all visible elements. When this rule is on, and one element is 

visible and the other is invisible, a discontinuity is assumed to exist. Thus, 

averaging will not include invisible elements. Making elements visible and 

invisible will change the displayed results. 

 The Junction rule dictates that a discontinuity exists wherever three or more 

features meet at the same common feature. For example three lines meeting at 

a point, or three surfaces meeting at a line. 

 The Angle exceeds rule dictates that a discontinuity exists wherever element 

axes differ by an angle greater than the threshold input. 

Results averaging options are accessed via the Model Properties dialog or the Model 

Properties control object  in the Analyses  Treeview. Averaging options are 

specified to be common for all analyses. 
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Results Transformation 

Viewing Results in a Consistent Direction 

 

When viewing results in LUSAS Modeller it is important to note that: 

 By default, displacements, loads, reactions, residuals, velocities and 

accelerations are output relative to the global Cartesian axis system. 

 By default, stress/strain and creep/plastic strain results (except for 

beam/bar elements and interface elements) are output relative to 

the global axes. Forces and moments (stress resultants) for beams, 

shells and joints are output relative to the element local axes. 

 For shell and plate elements, and in accordance with established 

theory, moments are given along the chosen axis. For beams, results 

moments are given about the chosen axis. 

If the elements in a model are orientated such that their local axes vary from 

one another (and note for surfaces they may also vary from the surface 

orientation), or if an alternative coordinate system is required, the results may 

need to be transformed to a consistent direction.  

  

 

Transforming results 

 Results displayed on contour, values or vector layers in a particular view 

window can be transformed using the Transform Set... button on the layer 

properties dialog for each layer.  

 Results plotted using the graph wizard, or obtained using the print results 

wizard, or the report writer can be transformed using the Transform Set... 

button on their respective dialogs. 

Results may be transformed to the following directions: 

 No transformation applied (consult Solver Manual) Results may be in 

global and/or element local axes according to element formulation. Depending 

upon the type of model and elements used a results transformation may be 

required. 

 Local axes of element/node Transforms nodal results (displacements, reactions 

etc.) according to the local transformed freedoms or element results (stresses, 

strains etc.) to element local directions. 

 Local coordinate of parent feature Transforms element results according to 

the local axes of the line, surface or volume feature. 

 Global axes Transforms nodal or element results to the global axes. 

 Assigned results transformation attribute Transforms element results to the 

local element material directions, or to directions specified by any assigned 

results transformation attributes. 
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 Specified local coordinate Transforms results to a consistent direction using a 

local coordinate.  

 Shell plane for resultants enables the plane for shell moments and shear 

forces to be defined when using cylindrical or spherical coordinates. See Shell 

plane for resultants below. 

 Reference path Transforms nodal or element results relative to the angle or 

route of a reference path. 

Notes 

 Different model view windows can each have different Results Transformation 

settings. 

 Beam and bar elements always have their local x direction along the length of 

the element. 

 For plates and shells the normal direction is defined by the local element z axis 

and this cannot be transformed. A results transformation only applies to the 

orientation of the local element x and y directions in the plane of the shell 

element. Top/Middle/Bottom, Wood Armer top and bottom, and sign 

conventions rely on the element z axis. 

 When viewing Wood Armer results a transformation is used to set the direction 

of the X reinforcement. A skew angle may then be set independently to define 

the Y reinforcement direction. The default skew angle is 90 degrees. 

 When viewing shell moments and shear stresses using a cylindrical or spherical 

local coordinate the shell plane for resultants needs to be defined as theta/z, 

r/theta or r/z, or theta/phi, r/theta or r/phi. 

 Using the transformation options for joint elements has no effect. 

 For nodal results (displacements and reactions) only Global and Local element 

/ node (transformed freedoms created by local coordinates assigned to the 

feature) options are available. 

 With the exception of the No transformation applied option the type of 

transformation used is written to the Contour key. 

Sign conventions 

Sign conventions in LUSAS are based on established theory and historical precedent, 

which means different conventions are often adopted for different contexts. 

 For beam element results, moments are taken about the axis i.e. Mx is the 

moment about the x axis.  
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 For shell elements, moments are taken in the direction of the axis i.e. My is the 

moment about the x axis. 

 For results on slices through a model, the sign convention differs depending on 

whether the‘Slice Beam/Shell resultants’ or ‘Section through a 3D model’ 

facilities are used. 

 For Slice Beam/Shell resultants, the orientation of the slice local axes 

follows the selected lines and is in accordance with beam theory where the 

beam local x axis is orientated along the beam. The slice local x axis will 

be defined perpendicular to both the slice local y and z axes.  

 For Section through a 3D model slice local x and y axes lie in the plane 

of the slice. The slice local z axis is perpendicular to both the slice local x 

and y axes. Reversing the local axes of the slice will re-orientate the z axis 

as well as the x and y local axes. 

For information on sign conventions for all element types see Element Reference 

Manual Appendix D. 

Shell plane for resultants 

The following diagram illustrates the shell planes (shaded) that are available for a 

cylindrical coordinate system. 

 

The following diagram illustrates the shell planes (shaded) that are available for a 

spherical coordinate system.  
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Raw and Derived components 

When selecting a primary component of interest for investigating results for a 

particular effect, either ‘Raw solver components’ or ‘Derived components’ may be 

chosen. 

 Raw solver components are those that are calculated for each element type by 

LUSAS Solver. For example, for a 2D Thick beam, they are Fx, Fy, Mz. 

 Derived components are created by LUSAS Modeller by mathematically 

manipulating the raw components, and include components such as absolutes, 

equivalents, principals, Wood-Armer, User Defined Results, Steel frame and 

RC frame design calculations, and others. 

In LUSAS Modeller raw components are always listed for selection according to the 

elements in use. Wherever there is no ambiguity of use, derived components will also 

appear alongside raw components in results drop-down menu listings, and can be 

selected without any further user-involvement.  

By default, LUSAS will automatically suppress the listing of derived components 

where the definition of such may be misunderstood. This issue affects all smart 

combinations, and also when a combination includes envelopes within its definition. 

The issue only occurs when using a derived component as a primary component, or 

inspecting a derived component individually. Such derived components can be made 

available for selection by using the corresponding checkbox, once the program 

behaviour has been understood.  

The following table shows when derived components are made available for selection 

with particular combination and envelopes scenarios.. 
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Derived components are made available for   Derived components are suppressed for 

Envelope of loadcases   Envelope of Smart Combinations 

Envelope of envelope(s)   Basic Combination of Envelope(s) 

Envelope of Basic Combination(s)   Basic Combination of Smart Combination(s) 

 

Viewing results for suppressed derived components 

Viewing, graphing, printing or reporting on results of any derived components that 

have been suppressed is possible by choosing the ‘Allow derived components’ check 

box on the respective dialogs on which it appears. The results obtained will be 

reasonable in many circumstances; however, as described below, this is not always the 

case and so the ability to access results from derived components in the situations 

stated must be used with caution. When suppressed derived components are accessed, 

it is the user’s responsibility to judge whether or not the approach used by LUSAS 

Modeller is appropriate to the structure and analysis in question. 

For a Smart Combination, or any basic combination or envelope 

that containes one or more smart combinations 

A smart combination uses an adverse (or variable) factor for a constituent loadcase if 

the effect of that constituent loadcase is onerous; where “onerous” means the 

constituent loadcase gives an effect of the primary component of the same sign as is 

being optimised for. 

It may be expected that a smart combination will give you the most onerous possible 

permutation for the primary component. If the primary component is a linear solver 

component, then this is what will happen. However, if the primary component is a 

derived component, then this is not necessarily the case, particularly where different 

constituent loadcases have values of differing sign. This is because the derived 

component will be recomputed by the combination, from the raw solver components, 

after all the loadcases have been factored and combined. 

Consider the following example: 

 Loadcase 1 at node 1 has displacement DX = 10 and DZ = 10, giving RSLT = 

14.14 

 Loadcase 2 at node 1 has displacement DX = -10 and DZ = -10, giving RSLT 

= 14.14 

 Smart Combination 1 has a beneficial load factor of 1 and an adverse load 

factor of 1.5 for Loadcase 1; and a beneficial load factor of 0 and an adverse 

load factor of 1 for Loadcase 2 

 LUSAS computes RSLT for each constituent loadcase, in order to work out 

which are onerous. In this case, for a maximum smart combination, both 
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loadcases are onerous, because they have positive values of RSLT, therefore 

they will both be given their adverse factors. 

 LUSAS then computes the “raw” values DX, DY and DZ for the smart 

combination, using the factors as computed in the previous step. This gives DX 

= (10 * 1.5) - (10 * 1) = 5 and DZ = (10 * 1.5) - (10 * 1) = 5. 

 Finally, LUSAS computes the requested derived component, RSLT, using the 

usual formula, in this case RSLT = 7.07. 

 But, in this case, the most onerous permutation would have been for Loadcase 

1 to receive its adverse factor, but Loadcase 2 to not, i.e. DX = (10 *1.5) - (10 

* 0) = 15 and DZ = (10 * 1.5) - (10 * 0) = 15. Together these give RSLT = 

21.21. 

Hence the most onerous permutation may be missed. 

For a basic combination that contains one or more envelopes 

When a basic combination contains an envelope, the primary component to be used in 

the envelope must be set. It may be expected that the combination will give the most 

onerous possible permutation (which contains any one loadcase from each envelope) 

for the primary component. If the primary component is a linear solver component, 

then this is what will happen. However, if the primary component is a derived 

component, then this is not guaranteed to be the case. This is because each envelope is 

regarded as a ‘self-contained’ unit that provides an answer to the combination above it. 

As a result, the envelope computes the “worst” loadcase for the primary component 

(irrespective of any other constituents of the combination), and the combination uses 

the associated values from that loadcase, factors them, and combines them with the 

results from other loadcases / envelopes in the combination. 

For derived components, it is possible that the effect of the “worst” loadcase from one 

envelope reduces that from another constituent, meaning that the worst permutation is 

missed. 

Consider the following example: 

 Loadcase 1 at node 1 has displacement DX = 10 and DZ = 10, giving RSLT = 

14.14 

 Loadcase 2 at node 1 has displacement DX = -10 and DZ = -10, giving RSLT 

= 14.14 

 Loadcase 3 at node 1 has displacement DX = 1 and DZ = 1, giving RSLT = 

1.414 

 Envelope 1 contains Loadcases 2 and 3 

 Combination 1 contains Loadcase 1 and Envelope 1 (both with a factor of 1) 
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 With RSLT as the primary component, Envelope 1 (max) will pick Loadcase 2, 

as it gives the biggest RSLT. This gives us a value for Combination 1 DX = 10 

- 10 = 0 and DZ = 10 - 10 = 0. Together this DX and DZ gives RSLT = 0. 

 But the most onerous permutation would have been for Envelope 1 (max) to 

pick Loadcase 3. This gives in Combination 1 DX = 10 +1 = 11 and DZ = 10 + 

= 11. Together these give RSLT = 15.56. 

Basic and Smart Combinations, and Envelopes 

Basic and Smart Combinations, and Envelopes enable the results from several 

loadcases to be presented as a single set of results.  

Use the Design Combination wizard to assign LUSAS loadcases, envelopes or basic 

combinations to predefined load types for a supported design code. Based on the 

assignments and settings made, load combinations for those load types are 

automatically generated by LUSAS Modeller, rather than having to be user-defined 

one-by one. Only loadcases suitable for combining or enveloping will be made 

available for inclusion in a combination or envelope. 

Basic combinations 

Basic combinations are defined by selecting the Analyses > Basic Combination menu 

item. These enable results from individual loadcases (possibly from more than one 

analysis), other basic combinations, smart combinations or envelopes to be factored 

and added together. 

Options 

 Method provides the means to specify a combination method  

 Factored (the default option) - The sum of all included loadcases, where 

each loadcase is multiplied by its specified load factor. For example: 

(Loadcase 1 x Factor 1 + Loadcase 2 x Factor 2...) etc. 

 Average Combination - The average of the sum of all included loadcases, 

where each loadcase is multiplied by its specified load factor. For 

example: (Loadcase 1 x Factor 1 + Loadcase 2 x Factor 2...) etc. / number 

of included loadcases 

 SRSS Combination A combination of the square root of the sum of the 

squares of all included loadcases, where each loadcase is multiplied by its 

specified load factor. For example: The square root of {(Loadcase 1 x 

Factor 1)
2
 + (Loadcase 2 x Factor 2)

2
... } etc. 

 Absolute Combination The absolute sum of all included loadcases where 

each loadcase is multiplied by its specified load factor. For example: The 

absolute value of (Loadcase 1 x Factor 1) +  The absolute value of 

(Loadcase 2 x Factor 2) + etc. 

file:///C:/SVN/Content/Design/idh_design_combinations.htm
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Smart combinations 

Smart combinations are defined by selecting the Analysis > Smart Combination 

menu item. These enable results from individual loadcases (possibly from more than 

one analysis), basic combinations, other smart combinations or envelopes to be 

factored with an adverse or relieving factor and added together.  

Beneficial / Adverse and Permanent / Variable load factors 

For new models, by default, the smart combinations dialog is presented to allow input 

in terms of Beneficial/Adverse factors rather than Permanent/Variable factors. 

However if the 'Display beneficial/adverse factors' check box on the  Combination 

and envelope options dialog is unchecked, the Beneficial load factor and Adverse 

load factor names may be optionally displayed as Permanent load factor and 

Variable load factorand appropriate factors input. 

Note that in LUSAS, when inputting permanent and variable load factors: 

  Permanent load factor = Beneficial load factor. 

 Variable load factor = Adverse load factor - Permanent load factor.  

For example, if a design code requires permanent actions to be factored by 1.35 where 

adverse and 1.0 where beneficial, and unfavourable variable actions to be factored by 

1.5 where adverse, and omitted where beneficial: 

 For permanent actions this is equivalent to a Permanent load factor of 1.0 and a 

Variable load factor of 0.35 since 1.0 will always be applied and 0.35 will only 

be applied if it creates an unfavourable effect. 

 For variable actions this is equivalent to a Permanent load factor of 0.0 and a 

Variable load factor of 1.5 since the loading will only be applied if it creates an 

unfavourable effect. 

Note also that for permanent and variable load factors: 

 A permanent load factor is always applied 

 A variable load factor is only applied if the effect is adverse. This means a 

maximum smart combination (Max) will assemble results from the loadcases 

selected using just the permanent factors for negative load effects, and using a 

summary of permanent and variable factors for positive load effects, and a 

minimum smart combination (Min) will assemble results from the loadcases 

selected using just the permanent factors for positive load effects, and using a 

summary of permanent and variable factors for negative load effects. 

Saved models retain the input type and values specified. 
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Other options 

To support combinations for design codes, check box options can be used to limit the 

total number of loadcases and the number of variable loadcases to be included in the 

smart combination: 

 If the Loadcases to consider option is chosen and an appropriate number 

entered, the smart combinations will be assembled in the manner described 

above, but the number of loadcases considered will be restricted to the number 

of loadcases specified. The loadcases used will be the most adverse for each 

combination i.e. the most positive for maximum combinations and the most 

negative for minimum combinations. All other load effects will be discarded. 

 If the Variable loadcases option is chosen and an appropriate number entered, 

the smart combinations will be assembled in the manner described above, but 

two further criteria will be invoked. The number of variable load factors used 

will be restricted to the number specified. The most adverse variable factors 

will be used in each combination and the remaining loadcases, which produce 

load effects of the correct sign, will be included with their permanent factors 

only. 

 
  

Basic combination Smart Combination 
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Envelopes 

Envelopes enable the maximum and minimum results from individual loadcases 

(possibly from more than one analysis) or from other combinations or envelopes to be 

determined. 

Defining a Basic or Smart Combination, or Envelope 

A basic combination, smart combination or 

envelope may be defined at either the 

modelling stage prior to analysis, or at the 

results processing stage. Once defined, 

combinations and envelopes are treated as 

loadcases and are listed in  Post 

processing folder in the Analyses  

Treeview. Their properties may be edited by 

double-clicking on the relevant  Basic or 

Smart combination, or  Envelope entry. 

Combinations and envelopes definitions are 

saved in the model file. 

Superposition 

Combinations are only generally applicable 

to linear elastic analyses. This is because the 

principle of linear superposition is used 

where, if Load A produces Effect A and Load B produces Effect B, then Load A and 

Load B applied together produce an effect equal to Effect A + Effect B.  

Manipulating Basic, Smart Combination, or Envelope 

Loadcases 

Basic or smart combination or envelope editing commands are available from the 

context menu that is activated by right-clicking on a one of those loadcases in the 

Analyses  Treeview. The following commands are available: 

 Set active Sets a loadcase active for viewing attributes assignments and results 

for the current window. 

 Edit View and edit the defined loadcase information. 

 Examine definition... View, in a treeview form, the nested combinations and 

envelopes that make up the definition, together with the corresponding factors 

for each included loadcase. 

 Copy Copies the selected loadcase (including all defined loadcase controls for 

eigenvalue, fourier or nonlinear and transient analysis) in readiness for a paste. 

 Paste Duplicates the copied loadcase and adds it to the bottom of the relevant 

section in the Analyses  Treeview. 
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 Rename Allow the loadcase title to be modified. Note that loadcases are 

tabulated and solved in the order listed within each analysis entry in the 

Analyses  Treeview. 

 Delete Attribute assignments must be deassigned before a loadcase can be 

deleted. At least one loadcase will always exist in the Treeview. 

 Create loadcase... (for basic combinations only) LUSAS assumes 

superposition is valid when combinations are assembled. In situations when 

superposition may not hold true (as when lift-off supports are present) a 

nonlinear solution may be required. The factored loadcases from a basic 

combination may be created as a new loadcase from the basic combination 

definition provided the basic combination does not include any smart 

combinations or envelopes. A basic combination can be expanded to create a 

new loadcase for single or multiple combinations by using the context menu for 

a combination or for the post processing folder. 

 Controls Set analysis control parameters for eigenvalue, fourier, and nonlinear 

and transient analyses.  

 Deassign Deassigns attributes from the loadcase, by choosing from a list of 

attribute types. Permits activation and deactivation of the loadcase. 

 Gravity Apply gravity as a property of the loadcase. See Adding Gravity to a 

Structural Loadcase for more information. 

Combination and envelope options 

When the first load combination or envelope is added to the Analyses  Treeview, a 

 Combination and envelope options object is also created. Double-clicking on this 

object displays a dialog on which advanced settings may be made. See "Combination 

and Envelope Options" on page 681 for more details. 

Visualising the results from Combinations and Envelopes 

Once defined, combinations and envelopes may be manipulated in the same way as 

other loadcases.  

 In the Analyses  Treeview, right-click on a combination or envelope and 

select Set Active to view results, or, 

 Drag and drop a loadcase entry from the Analyses  Treeview into a view 

window to set that loadcase active. 

When using smart combinations or envelopes the Set Active menu item will prompt 

for an Entity and the primary component on which to base the combination or 

envelope. For an envelope this component will be used to decide which is the 

maximum or minimum loadcase, and for a smart combination, which factor to apply to 

each loadcase. When displaying or printing results the values shown for other 
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components will be the coincident effects. Choosing the 'Max/min each component 

individually' option performs the calculation independently for each displayed 

component. Thus, different components are not coincident. 

An active loadcase is identified by a coloured icon in the Analyses  Treeview. Non-

active loadcases are greyed-out. For envelopes and smart combinations either the 

maximum or minimum loadcase can be set active. 

Contour, Diagram or Values plots can be displayed to show maximum, minimum or 

extreme results for an envelope or smart combination. The maximum and minimum 

sections of the diagrams for these plots are drawn in different (user-definable) colours 

from the default orange colour used for standard diagram plots. By default red is used 

for maximum values, and blue for minimum values. The use of colours to differentiate 

between maximum and minimum values is also applicable for the Values layer. See 

Smart Combination and Envelope Examples below. 

Viewing derived components 

When a derived component is used as a primary component, or when a derived 

component is inspected when choosing the 'Max/min each component individually' 

option for particular situations involving smart combinations and envelopes, LUSAS 

Modeller will automatically suppress the listing of particular derived components in 

the Component drop-down list that could produce misleading results as the unwary 

could get an answer that could be misunderstood or misinterpreted when reporting on 

results involving those components. This can be overridden. See Raw and Derived 

Components for details. 

General notes relating to viewing results from Combinations 

and Envelopes 

 When an envelope or smart combination includes another envelope or smart 

combination both the (Max) and (Min) loadsets should be included in the 

definition. The envelope or smart combination (Max) will ignore the envelope 

(Min) or smart combination (Min) loadsets and the envelope or smart 

combination (Min) will ignore the envelope (Max) or smart combination (Max) 

loadsets. 

 Sometimes it may be convenient to split the loadcases into more than one 

analysis. The loadcases from the separate analyses may then be subsequently 

enveloped or combined. 

 When combining or enveloping results from multiple models the mesh must be 

identical across all models. 

 Spectral (IMD) loadcases can be combined with other loadcases such as those 

defining dead and live loads. Since spectral loadcases are computed from an 

eigenvalue analysis the sign of the displacements are always positive but the 

most adverse effects can be obtained by creating a combination including 
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dead/live load and a spectral loadcase both with load factors of 1 and then 

creating a combination including a dead/live load with a load factor of 1 and a 

spectral loadcase with a load factor of -1. 

 When multiple envelopes are included inside a single basic combination, and a 

derived component is set as the primary component, note that it is not possible 

to "find” the “worst” permutation of a loadcase from each envelope, when 

factored as specified. This is because each envelope is computed in isolation 

prior to combining the results, and the effect of one envelope can cancel out 

some or all of the effect from another envelope. 

 For a smart combination, when a derived component is set as the primary 

component, or when viewing a derived component and choosing 'Max/min 

each component individually' option, note that it is not possible to "find" the 

“worst” permutation of factored loadcases because the calculation is not 

associative. 

 When considering the activation and deactivation of elements in relation to 

enveloping results note that if an envelope is set-up containing loadcase 1, 

loadcase 2, and loadcase 3, where the elements being viewed are 'born' in 

loadcase 2, this is, by definition, the same as an envelope of loadcase 2 and 

loadcase 3 because loadcase 1 is ignored if the elements providing results for 

the envelope have yet to be activated. 

Basic Combination Examples 

Loadcase 1 + Loadcase 2 = Basic combination 

 Loadcase 1 

 

 Loadcase 2 
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 Basic combination 

 

Smart Combination Example 

Smart Combination = Loadcase 1 (Dead load) * 1.0 (Permanent factor) and 0.0 

(Variable factor) and Loadcase 2 (Live load) * 0.0 (Permanent factor) and 1.0 

(Variable factor). 

For loadcase 1 and loadcase 2 as shown in the basic combination example: 

For a Smart Combination (Max) loadcase: 

 Show maximum only 

 

 Show minimum too 

 

 Show extreme 
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For details of Smart combination calculations see Appendix A 

Envelope examples 

For loadcase 1 and loadcase 2 as shown in the basic combination example: 

For an Envelope (Min) loadcase: 

 Show minimum only 

 

 Show maximum too 

 

For an Envelope (Max) or (Min) loadcase: 

 Show extreme 
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Combination and Envelope Options 

The combinations and envelope options dialog can be accessed from the  

Combinations and envelope options object in the Analyses Treeview. 

Smart combinations 

 Display beneficial/adverse factors (when checked) sets the smart combination 

labels on the smart combination dialog and associated grid dialog to be 

Beneficial/Adverse as opposed to Permanent/Variable. 

Storing of results 

Results for Modeller-calculated results components (such as those calculated for 

combinations and envelopes, and also for other derived components such as design 

code-based utilisations, Wood-Amer, user-defined results etc.) can be stored in order 

to speed-up the initial and subsequent display of those results. This can be done either 

by setting options to store calculated results in LUSAS Modeller interactively, or by 

specifying that all or selected results components should always be stored each time a 

model is solved. For either case, only those results not currently stored will be added 

to those that are. 

Store calculated results for full model in interactive use 

 Never This option disables all storing of results. All results are recomputed as 

and when needed, regardless of element visibility. 

 Only when viewing full model Calculated results are stored provided the 

whole model is being viewed. 

 Always, even when viewing partial model - Calculated results are stored for 

all elements, even if only a few are visible. Setting this option overrides and 

switches off any threshold settings (see below).  

 Whenever both the following thresholds are reached - These two options 

provide a degree of refinement as to when calculated results are stored. Both 

threshold values must be met for storing of results to take place. 

 Proportion of contributing elements Calculated results are stored for all 

elements when the number of elements being viewed is greater than the 

stated percentage of the total number. 

 Number of contributing loadcases - Calculated results are stored for all 

elements when the number of loadcases that are returned by LUSAS 

Solver, and that are used to compute a combination or envelope, exceeds 

the stated number. 
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 Show warning to visit this dialog when calculation times reaches - Here a 

specified time can be stated. This option is checked 'on' by default, and is set to 

30 seconds.  

Calculate and store results for full model for specified PRW 

utilities 

As well as, or independently from, storing calculated results for the full model in 

interactive use, results components for chosen entities, loadcases and locations 

(specified as part of creating a Print Results Wizard utility) can be calculated and be 

automatically stored straight after a model is solved, or at any time thereafter if this 

section of the Combinations and Envelope options dialog is visited. Any previously-

defined Print Results Wizard utilities will be listed in the selection panel on this 

dialog. Additional Print Results Wizard utilities entries can be added by use of the 

'New' button. Print Results Wizard utilities must be 'checked' in the selection panel in 

order for storing of those results to take place. Results can be specified to be stored: 

 After each solve Calculates and automatically stores the specified results for a 

Print Results Wizard utility straight after a model is solved. 

 Now Calculates and stores the specified results immediately, based upon the 

currently loaded results file. 

Note that for both these options, storing of results takes place for the whole model 

ignoring any 'Extent' setting. 

 Additional Print Results Wizard utilities can be defined by pressing the New... 

button at the bottom of the Combination and Envelope Options dialog. Pressing 

the 'New' button shows the normal Print Results Wizard dialog, but with 

inappropriate controls for caching purposes shown disabled.  

 Selecting a Print Results Wizard entry in the selection panel, and pressing the 

Edit... button permits editing of the results requested. 

 Deleting all stored results 

 Delete all stored results Deletes all stored results. 

Design Combinations 

The Design Load Combination wizard is available in Bridge and Civil software 

products only. It is accessed from the Analyses > Design Combinations... or Design 

> Design Combinations... menu items. 

Design combinations are used to assign LUSAS loadcases, envelopes or basic 

combinations to predefined load types for a supported design code. Based on the 

assignments and settings made, the required set of load combinations for those load 

types are automatically generated by LUSAS Modeller.  

See Design Combinations in Application Manual (Bridge, Civil & Structural) for 

more details. 

file:///C:/SVN/Content/Design/idh_design_combinations.htm
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Progress Bar 

A progress bar is displayed at the bottom of the user interface to show the approximate 

progress being made by LUSAS Modeller in calculating results for a particular task 

such as creating a design envelope, or combination. Each progress step represents one 

results component being calculated for one constituent loadcase. 

For small models with only a few loadcases the progress bar may not even be seen, but 

for larger models with a large number of loadcases, where numerous loadcases need to 

be combined and enveloped, or otherwise processed, the progress bar provides a 

reassurance that calculations are continuing.  

For some tasks, such as creating a model report, several results chapters may have 

been requested, each containing several components requested for several envelopes, 

each made of several hundred constituent loadcases. In this situation the progress bar 

may move smoothly throughout the calculation of results. But for a single envelope 

calculation, such as when drawing contours or plotting values in the view window, or 

printing results using the print results wizard there may be a noticeable pause at the 

penultimate step when those results are combined together to make a single result. 

Note that depending upon the complexity of the task Windows may mark Modeller as 

'not responding' during that time, but in fact the calculations will still be continuing. 

Allowance should be made for the results calculation to finish in such situations. 

Fatigue Calculations 

Fatigue calculations can be performed on the results of a linear finite element stress 

analysis using the total life approach. This can be done for continuum elements only. 

The fatigue life may be expressed in terms of the damage that is done to the structure 

by a prescribed loading sequence or as the number of repeats of the sequence that will 

cause failure of the structure. Contour plots illustrating the fatigue life of the entire 

structure can be generated. The results from fatigue calculations may be viewed using 

any of the standard plotting techniques. 

Fatigue calculations of the life of a structure are defined from the Analyses> Fatigue 

menu item. 

S-N Curves 

S-N curves contain the variation in stress/strain values with the number of cycles to 

failure and are defined on a Log Log scale. An S-N curve is used to calculate the 

number of cycles to failure for each loadcase. Miner's rule is then used to combine the 

damage for each loadcase to give the total damage to the structure for the specified 

loading sequence. 
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Notes 

 Log values are used because of the large variation in magnitude of the input 

data. 

 If plotting the number of cycles to failure, then the number of cycles entered in 

the fatigue spectrum should sum to unity. 

 For information on standard S-N curves refer to BS5400. 

Fatigue loadcase  

Fatigue loadcases contain the loading 

spectrum defining the loading sequence 

in terms of a series of loadcases, each of 

which has an associated load factor, the 

number of cycles, and the component to 

be used in the fatigue calculation. 

Once defined fatigue loadcases are saved 

in the Analyses  Treeview. Their 

properties may be edited by double-

clicking on the fatigue loadcase. 

Viewing results 

Results from the fatigue calculations may be viewed using any of the standard 

methods, once the loadcase is set active. Fatigue results come from a component of 

stress, which is specified in the Fatigue loadcase. Two results are obtained from the 

calculations: 
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 Loglife is the life expectancy of the structure based on the applied load. Results 

are presented as log10 of the number of cycles to failure. 

 Damage is a factor representing the damage the material has sustained due to 

the applied loading and number of cycles. A value greater than 1 indicates 

failure. 

Notes 

 Fatigue calculations are only applicable to linear elastic analyses and for 

continuum elements only. 

 Fatigue loadcases may be saved in the model file or in a new model file when a 

results file only is opened. 

Interactive Modal Dynamics 

The Interactive Modal Dynamics (IMD) facility within Modeller calculates the modal 

response of a system to a given input using the eigen modes and eigenvectors from an 

eigen analysis. (Note that the eigen analysis must have been performed with mass 

normalised eigen modes). An IMDPlus software option extends this capability to 

solve 2D and 3D seismic, moving load, and moving mass analyses using modal 

superposition techniques in the time domain. For details see the IMDPlus User 

Manual. 

Interactive Modal Dynamics calculations within Modeller may be performed on single 

or multiple eigen modes, and at a single node or over the whole structure: 

 Response at a node Use the Graph Wizard to produce a graph of a specified 

results type against sample frequency range or series of time steps. 

 Response for all nodes Use an IMD loadcase to calculate the modal response 

of the whole structure to a specific frequency or at a particular response time. 

The results from the IMD calculation are then viewed using any of the standard 

plotting techniques such as contouring. 

Assumptions 

The working assumptions for the modal dynamics facility are as follows: 

 Linear The system is linear in terms of geometry, material properties and 

boundary conditions. 

 No Cross-Coupling There is no cross-coupling of modes caused by damping. 

This is reasonable as long as the damping of the structure does not exceed 10% 

of critical damping. 

 Low Modes Dominant The response is dominated by the lowest few modes. 
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Performing Modal Response Calculations 

 The basic steps are as follows: 

1. Decide whether to perform a response analysis on a single node (using the 

Graph Wizard), or the whole structure (by defining an IMD loadcase). 

2. Select Eigen Modes Specify which modes to include in the analysis. 

3. Damping Specify the amount of modal damping. 

4. Excitation Apply a form of dynamic excitation to a specific node or at the 

supports. 

5. Results Type Choose the IMD calculation required, then set the required 

parameters. 

Modal Damping 

Modal damping is the damping associated with the displacements defined by the 

eigenvectors. Its value has no physical significance since the eigenvector contains an 

arbitrary normalising factor. 

Damping values can be specified explicitly or alternatively can be extracted from the 

results file. LUSAS Solver will only provide modal damping estimates if the relevant 

damping control data has been included in the eigenvalue analysis. By default, LUSAS 

Solver values will be zero. Damping is specified using percentage viscous and 

structural damping values. 

Notes 

 Structural damping is not used in modal response calculations in the time 

domain. 

 Structural damping is not applicable in spectral response calculations. 

 All damping ratios are expressed as percentages of critical damping. 

 Modal superposition techniques are not usually appropriate for structures with 

damping ratios higher than 10%, due to coupling between modes. Step-by-step 

dynamic analysis should be considered in such cases. 

Dynamic Excitation 

Eigenvalue analyses do not consider any applied load. Therefore, to carry out a 

dynamic structural analysis a load must be applied to the structure. These loads are 

specified either in terms of forces, or as motion by use of the large mass method: 

 Point Force To set the modal excitation to point force via a node number and a 

nodal freedom. This is equivalent to applying a unit concentrated force at the 
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selected nodal degree of freedom. The value of the unit force depends on the 

chosen system of units. In the case of SI units, a force of 1 Newton or a 

moment of 1 Newton metre will be applied. The amplitude of the load may be 

specified. 

 Point Displacement (Large mass method) Sets the modal excitation to point 

displacement via a node number and a nodal freedom. A force equal to the 

large mass is applied at the support point, thereby inducing a unit acceleration 

response, see note on large mass. Displacement control is effected by 

integrating the response twice in the frequency domain. Time domain 

displacement excitation is not currently supported. 

 Point Velocity (Large mass method) Sets the modal excitation to point velocity 

via a node number and a nodal freedom. A force equal to the large mass is 

applied at the 'support' point, thereby inducing a unit acceleration response, see 

note on large mass. Velocity control is effected by integrating the response 

once in the frequency domain. Time domain velocity excitation is not currently 

supported. 

 Point Acceleration (Large mass method) Sets the modal excitation to point 

acceleration via a node number and a nodal freedom. A force equal to the large 

mass is applied at the 'support' point, thereby inducing a unit acceleration 

response, see note on large mass. 

 Real/Imaginary/Real & Imaginary Loading A load vector is extracted from 

specified eigenvalues (loadcases). In this case the modal forces are complex 

and therefore the modal forces are stored in two arrays - one for the real 

component and one for the imaginary. (For excitation types other than these the 

imaginary components will always be zero). Note that it is assumed that all 

applied forces are in phase. The chosen load vector need not be in the same 

results file as the eigenvectors used for the response calculation - typically only 

one load vector will be stored with the modes. 

 Support Motion To set the modal excitation to support motion. This is used 

when all the supports move together, for example in the analysis of an 

earthquake or when a small component attached to an airframe or vehicle 

chassis has a known vibration level. The calculations are based on participation 

factors calculated by LUSAS Solver. A participation factor defines the modal 

force resulting from a unit acceleration loading applied to the whole model in a 

specified direction. The participation factors for each mode in each of the 

global directions are stored in the results file and are used as modal forces in 

the support motion calculations. X, Y, Z direction motion or motion in any 

vector direction can be represented. General support motion can be modelled 

by applying a unit acceleration field to the model using body force loading, and 

selecting the resulting equivalent nodal forces as modal excitation. In the 

frequency domain absolute or relative support motion may be selected, the 

default being relative. 
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Notes 

 Displacement and velocity excitations are not allowed for modal response 

calculations in the time domain. 

 Support Motion excitation may be the most appropriate if all the supports 

move together. 

 Large Mass point displacement, velocity or acceleration excitation may be the 

most appropriate if the supports do not move together. 

 For Point Displacement, Velocity and Acceleration excitation, the 

displacement response is absolute and not relative to supports. 

 When using Support Motion excitation in the frequency domain, the 

displacement response may be specified as relative or absolute. If absolute is 

chosen then the motion of the support is added to the structural motion to give 

motion with respect to ground. This is useful for comparison with measured 

data. 

 When using the IMD Impulse excitation option, the magnitude of input will be 

the Impulse value (not strictly a force). The Impulse unit will be [force x time]. 

The Large Mass Method 

Interactive Modal Dynamics frequently employs an analysis technique referred to as 

the Large Mass Method. The reason for this is to earth the structure via a ‘moveable’ 

object rather than a strict support to ground. This allows subsequent application of a 

force to the mass, in effect applying an acceleration to the structure. The size of this 

mass should be sufficient to ensure mass dominated local response, so that the motion 

of the point is described by Newton's Second Law (i.e. F = ma). A mass of 1E6 kg 

works well for most structures. Unduly large values may cause ill-conditioning 

problems. A force equal to the large mass is applied at the support point, thereby 

inducing a unit acceleration response. 
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Modal Dynamics Results Types 

 Frequency domain response Harmonic, or forced, response analysis is used to 

investigate the effects of structural resonance (where structures are forced to 

vibrate harmonically at or near their own natural frequencies). Solution of the 

harmonic response problem as a modal analysis avoids the need to perform a 

full transient dynamic analysis. Simultaneously applied excitations may contain 

phase differences. 

 Time domain response (impulse or step-by-step dynamics) to dynamic 

excitation. The forcing function and the consequent response of a structure are 

defined in terms of time histories. The Fourier transform of the time domain 

gives the corresponding quantity in the frequency domain. 

 Spectral response analysis An analysis in which a defined response spectra 

for a generic earthquake ground motion is used to estimate the maximum 

displacement or pseudo-velocity or acceleration during the earthquake, without 

the need for direct integration of the model over the complete duration of the 

event. Dynamic excitation is applied to all the supports simultaneously. A 

response spectrum curve defines the magnitude of excitation. If the damping in 

the response spectrum curve differs from that defined for the model a damping 

correction may be applied using one of formula provided. The maximum 

displacements, forces and stresses are computed throughout the structure for 

each eigenmode. These values may then combined to produce a single positive 

result using a spectral combinations. The spectral combinations available are 

CQC (default), SRSS and Absolute Sum. For further details see the LUSAS 

Theory Manual. 

 Power Spectral Density (PSD) Analyses the frequency response to a random 

modal vibration, such as aerodynamic loads acting on an aircraft component. A 

frequency PSD defines the frequency content of the random loading. Dynamic 

excitation should be applied to all the supports via support motion excitation. 

Frequency and Time Domain Response 

Frequency and time domain response calculations are the most commonly used. 

Usually, a node is excited across a frequency (or time) range to generate a graph for 

the frequency or time response (using the Utilities> Graph Wizard menu item). From 

the response across a range, a single frequency may be selected to perform an IMD 

calculation on the whole structure (using an IMD loadcase). The following diagrams 

illustrate this procedure: 
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Results across a frequency range, or time history 

Response at a node calculated across a  
specified frequency range 

Response at a node calculated across a 
specified time history 

 
 

 

Results at a specific frequency, or time step 

Response calculated at a specified frequency  
for the whole structure 

Response calculated at a specified time for the 
whole structure 

  

Frequency Power Spectral Density 

A Power Spectral Density (PSD) defines the frequency content of a random loading, 

such as turbulent pressure acting on an aircraft component, and are for use in modal 

random vibration response analysis. At present, random modal vibration calculations 

are restricted to single-input systems, where the loading at all points is fully correlated. 

The value of PSD used in response calculations will be interpolated from a table of 

frequency/PSD values. A range of linear and logarithmic interpolation schemes are 

provided, in accordance with typical PSD specifications. Dialog input requires: 

Interpolation type, options are: Linear/Linear, Log/Linear, Linear/Log, Log/Log; 
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Frequency; Amplitude. More copious PSD tables may more easily be defined by 

copying and pasting the data from a text file or spreadsheet. 

Response Spectrum 

Response spectrums for use in spectral analyses are defined from the IMD loadcase 

dialog. 

The value of the frequency used in spectral calculations will be interpolated from a 

table of frequency-amplitude or period-amplitude values. More copious Response 

Spectrum tables may more easily be defined by copying and pasting the data from a 

text file or spreadsheet. 

 Frequency/Period/Displacement/Velocity/Acceleration The value of the 

frequency used in spectral calculations is interpolated from the values defined. 

The type of values entered, i.e. displacement, velocity, or acceleration should 

match the type of support motion which is used to excite the structure. For 

earthquake analyses it is usual to specify Acceleration, and to later specify a 

support motion using acceleration. 

 Spectral curve damping This value defines the percentage damping inherent 

in the response spectrum curve itself. If the Eurocode or Kapra damping 

correction formula are specified, the spectral response curve is adjusted to the 

viscous modal damping value specified in the IMD loadcase. When using other 

damping correction formulae the spectral curve is adjusted using only the 

viscous damping. For more details see Theory Manual. 

 

Case Study. Forced Vibration of a Simply Supported Cantilever 

Consider the forced vibration of a simply supported cantilever beam. The beam is 

supported at one end and subjected to a uniformly distributed load. An eigenvalue 

analysis is carried out for 9 modes. Normalisation with respect to Global mass must be 

selected when defining the eigen control. 

Calculation of the modal results in the frequency domain is required for Displacement 

type response for the end node for the Y-direction displacement. Results are to be 

calculated over a suitable frequency range using a specified frequency step. The results 

type required will be Amplitude. 

Modal response calculations are carried out as follows: 

1. Read in the results file from the eigenvalue analysis. Select the File> Open 

menu item and specify the results file name. 

2. Select the Utilities> Graph Wizardmenu item. Choose Modal Expansion 

then click on the Next button. 

3. Click on Frequency to specify the frequency domain. 
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4. Choose a Point force excitation, then click on the Set button to define the 

parameters. Excite the structure at the unsupported end node in the Y-direction. 

Enter the node number or, if the node is selected, choose the number from the 

drop-down list. Click on the OK button, then click on the Next button. 

5. Specify the results entity as Displacement, component DY and the results type 

as Amplitude. Take care to specify a realistic start, end and frequency step. 

Specify which node to calculate the response at, then click on the Next button. 

6. Specify a Title and X and Y axis labels, then click on the Finish button. This 

will create a standard frequency vs. amplitude plot for the response from the 

specified excitation. Two graph datasets will be created, the first containing the 

frequency range in the steps specified and the second containing the required 

amplitude values. 

IMDPlus Analysis 

The IMDPlus software option solves 2D and 3D seismic, moving load and moving 

mass analysis problems using modal superposition techniques in the time domain. In 

order to use IMDPlus, as for dynamic analysis in general, a consistent set of units 

should be used, as for example Force = N, Mass = kg, Length = m, and Time = s if 

SI units were being used. 

The various stages of an IMDPlus analysis are initiated from the Analyses> IMDPlus 

menu or from the IMDPlus Toolbar, which can be activated from the View> 

Toolbars... menu. 

The basic steps that need to be undertaken for each of the three available analysis 

types are as follows: 

Seismic Analysis 

A seismic analysis obtains the dynamic response of a structure to acceleration time 

histories of support motion. 

In order to perform an IMDPlus seismic analysis, a mass normalised eigenvalue 

analysis first needs to be undertaken to describe the frequency behaviour of the 

structure. Once completed, the response of the structure associated with up to seven 

earthquake acceleration time histories can be calculated and node / element results 

interrogated. 

Procedure 

Select the Analyses > IMDPlus> Seismic menu item and carry out the following 

steps: 

1. Select the acceleration time histories 

file:///C:/SVN/Content/dlgimdplus/IDH_IMDPLUS_TOOLBAR_BUTTONS.htm
file:///C:/SVN/Content/dlgimdplus/IDH_IMDPLUS_SEISMIC_ANALYSIS.htm
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2. Select the eigenmodes to include in the solution 

3. Specify the damping for the eigenmodes 

4. If required, modify the advanced solution options 

5. Specify the frequency interpolation technique and if required, the time step 

6. Specify the nodes or elements to process along with the output requirements 

Moving Load Analysis 

A moving load analysis obtains the dynamic response of a structure to moving loads. 

In a moving load analysis the load can either be explicitly defined or a vehicle 

configuration (composite axle definition) can be used. In both cases the magnitude and 

configuration of the load remains constant throughout the analysis. 

 Explicit definition The complete load configuration is defined through a 

discrete load definition in Modeller. This can be used for analysing the passage 

of a single load configuration across the structure 

 Composite axle definition The complete load configuration consists of a unit 

load single axle configuration, defined as a discrete load definition in Modeller, 

and a vehicle configuration is that is defined separately. The vehicle 

configuration (composite axle definition) method is the recommended 

approach, as it allows multiple load configurations (such as multiple train 

rolling stock configurations) to be analysed rapidly without having to repeat 

initial steps for the IMDPlus solution. 

In order to perform an IMDPlus moving load analysis, the path of the load first needs 

to be defined in addition to the frequency behaviour of the structure. Once the mass 

normalised eigenvalue analysis has been undertaken, the response of the structure to 

moving loads can be calculated and node / element results interrogated. 

Procedure 

Select the Analyses> IMDPlus> Moving Load menu item and and carry out the 

following steps: 

1. Vehicle Configuration 

If the loading is not explicitly defined in step 2, define moving load vehicle 

configuration(s) using the positions of the axles/bogies that form a vehicle 

together with the moving load factors to be applied at each position 

2. Moving Load Generation 

Generate the movement of a discrete load across the structure by using a number 

of distinct locations along the moving load path 

3. Modal Force Calculator 

file:///C:/SVN/Content/dlgimdplus/IDH_IMDPLUS_MOVING_LOAD_ANALYSIS.htm
file:///C:/SVN/Content/dlgimdplus/IDH_IMDPLUS_MOVING_LOAD_VEHICLE_CONFIG.htm
file:///C:/SVN/Content/dlgimdplus/IDH_IMDPLUS_MOVING_LOAD_GENERATION.htm
file:///C:/SVN/Content/dlgimdplus/IDH_IMDPLUS_MODAL_FORCE_CALCULATOR.htm
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Calculate the equivalent modal forces for each of these distinct locations 

4. Moving Load Analysis 

a. If required, select the moving load vehicle configuration to be used in the 

analysis 

b. Select the eigenmodes to include in the solution 

c. Specify the damping for the eigenmodes 

d. If required, modify the advanced solution options 

e. Specify the speed ranges to analyse along with time stepping parameters 

f. Specify the nodes or elements to process along with the output requirements 

Moving Mass Analysis 

A moving mass analysis obtains the dynamic response of a structure to moving 

masses. In a moving mass analysis spring-mass systems are used in a vehicle 

configuration. Each spring-mass system includes an unsprung mass and up to two 

sprung masses connected by springs and viscous dashpots. The configuration of the 

systems remains constant throughout the analysis but as they move across the 

structure, the dynamic response of the unsprung and sprung masses affects the forces 

acting on the underlying structure due to inertia effects. 

The working assumptions for the particular case of an IMDPlus moving mass analysis 

are as follows: 

 No Loss of Contact There is no loss of contact between the unsprung masses 

(wheels) of the spring–mass systems and the structure at any time during a 

moving mass analysis. 

 Vertical Motion of Spring-Mass Systems Only Only vertical motion of the 

spring-mass systems is considered in a moving mass analysis. 

 Mass of Spring-Mass Systems Not Included in Eigenvalue Solution The 

mass of the spring-mass systems have no effect on the natural frequencies of 

the structure 

 Recommended Limit on Total Mass of Spring-Mass Systems The accuracy 

of the moving mass solution reduces for light-weight structures or structures 

where the magnitude of the moving mass is similar to the magnitude of the 

structure mass. A literature search recommends that for most solutions of this 

type, the total mass of all the spring-mass systems that are actively interacting 

with the structure at any given time should not exceed 10% of the total mass of 

the underlying structure. 

In order to perform an IMDPlus moving mass analysis, the path of a unit load first 

needs to be defined in addition to the frequency behaviour of the structure. Once the 

file:///C:/SVN/Content/dlgimdplus/IDH_IMDPLUS_MOVING_LOAD_ANALYSIS.htm
file:///C:/SVN/Content/dlgimdplus/IDH_IMDPLUS_MOVING_MASS_ANALYSIS.htm
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mass normalised eigenvalue analysis has been performed, the response of the structure 

to moving masses can be calculated and node / element / spring-mass system results 

interrogated. 

Procedure 

Select the Analyses> IMDPlus> Moving Mass menu and carry out the following 

steps:: 

1. Spring Mass Properties 

Define spring-mass system property attribute(s) for use in the moving mass 

vehicle configuration 

2. Vehicle Configuration 

Define moving mass vehicle configuration(s) using the positions of the 

axles/bogies that form a vehicle together with the spring-mass system property 

attribute that is to be used at each position 

3. Moving Load Generation 

Generate the movement of a discrete unit load across the structure by using a 

number of distinct locations along the moving load path 

4. Modal Force Calculator 

Calculate the equivalent unit modal forces for each of these distinct locations 

5. Moving Mass Analysis 

a. Select the moving mass vehicle configuration to be used in the analysis 

b. If required, include a path surface profile that defines the surface irregularities 

along the length of the moving load path 

c. Select the eigenmodes to include in the solution 

d. Specify the damping for the eigenmodes 

e. If required, modify the advanced solution options 

f. If required, modify the path surface profile options 

g. Specify the speed ranges to analyse along with time stepping parameters 

h. Specify the nodes, elements or spring-mass systems to process along with the 

output requirements 

General IMDPlus Assumptions Applicable to All Analysis Types 

The working assumptions for the IMDPlus modal dynamics facility are as follows: 

file:///C:/SVN/Content/dlgimdplus/IDH_IMDPLUS_SPRING_MASS_SYSTEM_PROPS.htm
file:///C:/SVN/Content/dlgimdplus/IDH_IMDPLUS_MOVING_MASS_VEHICLE_CONFIG.htm
file:///C:/SVN/Content/dlgimdplus/IDH_IMDPLUS_MOVING_LOAD_GENERATION.htm
file:///C:/SVN/Content/dlgimdplus/IDH_IMDPLUS_MODAL_FORCE_CALCULATOR.htm
file:///C:/SVN/Content/dlgimdplus/IDH_IMDPLUS_MOVING_MASS_ANALYSIS.htm
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 Linear The system is linear in terms of geometry, material properties and 

boundary conditions. Therefore geometrically nonlinear eigenvalue results are 

not applicable. Nor are nonlinear joint and slideline analyses suitable for this 

type of post-processing treatment 

 No Cross-Coupling There is no cross-coupling of modes caused by the 

damping matrix. This is reasonable for all but the most highly damped 

structures or applications 

 Low Modes Dominant The response is dominated by the lowest few modes. 

 Damping Ratios Are Below Critical Damping ratios of 100% or more are not 

permitted due to the solution of the time domain response of the structure using 

either the Hilber–Hughes-Taylor (HHT) method or Duhamel’s Integral. 

See the IMDPlus User Manual for full details on IMDPlus analysis. 

Worked examples 

See Online help > Worked Examples > For IMD Plus Option 

Target Values Analysis 

Target values analysis is a post-processing facility that provides a general method of 

varying load factors in a linear analysis to try and achieve target values defined for 

particular feature types or results components. Target values can be set by use of the 

Analyses > Target Values menu item.  

On the Target Values dialog a solution method is selected, and model or results 

loadcases specified to try and achieve any target values defined. An 'exact' method, an 

optimisation facility and two best-fit solution methods are provided. The target values 

loadset created is similar to a combination, but the load factors are calculated 

automatically by the facility in response to the defined targets.  

Cable tuning analysis 

Whilst cable tuning analysis is possible using this general target values method it is 

greatly simplified by using the dedicated Cable tuning analysis facility, which 

automatically assigns an initial axial stress of unity to all lines representing cables and 

automates the definition and assignment of the various loadcases required.  

Defining a target values analysis 

Setting up a target values analysis requires you to: 

1. Choose a solution type An 'exact' method, an optimisation facility and two 

best-fit solution methods are available 

2. Define the loadcases that will be used in the target values analysis 

file:///C:/SVN/Content/Bridge/Cable_Tuning_Analysis/Cable%20tuning%20analysis.htm
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The Target Values dialog contains tabbed pages to allow these tasks to be completed. 

Note that the Target Values dialog is functionally similar to the Cable Tuning dialog, 

with the exception that a no Cables page is included to allow the selection and 

inclusion of lines representing cable stays. Instead, lines of interest are set target 

values 

The target values dialog pages Solution types, Loadcases, Targets and Optimisation 

criteria should be visited to specify all data required for a target values calculation. 

Validating target values parameters 

 Validate input The Validate Input button should be used to check if the 

number of equality conditions and the number of loadcases marked as having a 

calculated factor are valid for the chosen Solution method. Three different 

outcomes exist. 

 Input is valid - the analysis can proceed. 

 An error message regarding an imbalance in the equality conditions and 

the number of loadcases marked as having a calculated factor will be 

displayed, requiring correction. 

 The message "Exact solution type required" will appear indicating that, 

because the number of equality conditions and number of lines 

representing cables is the same, an optimised or best fit solution cannot be 

obtained. An Exact solution should be used instead. 

Identifying a feature in the grid 

 Identify selection locates a selected feature (a point or a line) in a model. 

When the row for a feature is selected in the grid on the dialog, and this 

checkbox is ‘on’, the corresponding feature (point/line) is located in the View 

window by animating concentric shrinking squares. 

Saving target values parameters 

When the OK or Apply button is pressed on the Target Values dialog all input is 

saved, even if it contains errors or inconsistencies.  

If the input was valid a Target values entry  will be added to a Post processing 

folder in the Analyses  Treeview. A Target values entry  will also be added. If 

the input is invalid the invalid data sign  will appear instead and corrective 

measures will be needed. 

Double-clicking a target values entry (or selecting Edit from its context menu) will 

show the settings used to create it.  
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Solving a target values loadset 

To solve a target values loadset press the Solve button  on the main toolbar menu.  

When solved, target values loadcase results  are held in a Post processing folder in 

the Analyses  Treeview.  

Viewing results of a target values analysis 

 Right-click on the target values results entry  and select Set Active to view 

results.  

 Double-click on the target values results entry  to display the forces 

calculated for each loadcase in order to achieve the target values. 

Target values results options 

When a model containing target value data has been solved the context menu for each 

target values loadset  will contain the following menu items: 

 Calculated Factors - displays the load factors calculated to achieve the target 

values. All entries in the grid are read-only. 

 Create Combination - creates a load combination using the load factors as 

calculated by the target values analysis. The menu item is greyed out unless the 

loadset has been solved. 

 Create Loadcase - creates a loadcase (that could be used in a nonlinear 

analysis) of all the separate variable loadcases with each factored by the load 

factor that was calculated by the target values analysis. The menu item is 

greyed out unless the loadset has been solved. 

 Factor loadcases - similar to Create Combination but modifies the original 

input loadcases via their assignment factors. The menu item is greyed out 

unless the loadset has been solved. 

Target Values: Solution types 

For an overview of the steps required to carry out a target values analysis see Target 

Values Analysis. 

Solution types 

The choice of solution type is made on the main page of the Target Values dialog.  
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The type of solution that can be chosen is dependent upon the number of lines selected 

and the number of equality conditions as seen in the Condition column on the Targets 

grid. The solution type can be set to be: 

 Exact This requires the number of equality conditions (as seen in the 

Condition column on the Targets grid) to be the same as the number of 

loadcases that are defined as requiring a Calculated factor on the Loadcases 

tab. No inequality conditions can be defined for the exact method. Using this 

option, only one solution is possible. 

Note that the exact solution for a given set of target values may produce negative 

factors for some loading arrangements. If this occurs an optimised solution should be 

investigated where all of the points of interest are permitted to move a small distance 

to try and achieve a better solution. In the case of Points being used to restrict 

displacement in a bridge deck this would amount to specifying a distance that would 

slacken the cables. 

  

  

  

 Optimised (an under-determined solution) requires the number of equality 

conditions (as seen in the Condition column on the Targets grid) to be less than 

the number of number of loadcases that are defined as requiring a Calculated 

factor on the Loadcases tab. Any number of targets specifying inequality 

conditions can be defined. For this option a range of solutions is possible 

provided that they are not mutually exclusive. For this option a range of 

solutions is possible. 

Options to minimise or maximise the calculated factors for a variety of in-built or 

specified criteria are provided on the optimisation criteria page. 

  

 Best fit (discrete least squares) and Best fit (Chebyshev)(both over-

determined solutions) require the number of equality conditions (as seen in the 

Condition column on the Targets grid) to be greater than or equal to the 

number of loadcases number of loadcases that are defined as requiring a 

Calculated factor on the Loadcases tab. Any number of targets specifying 

equality or inequality conditions can be defined. For this approach no unique 

solution is guaranteed. 
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 Discrete least squares provides positive and negative load factors. No 

inequality conditions can be stated for this option. 

 Chebyshev will always produce positive load factors. Inequality 

conditions can be stated for this option. 

Related pages 

The target values dialog pages Solution type, Loadcases, Targets and Optimisation 

criteria should be visited to specify all data required for a target values calculation. 

Validating target values parameters 

 Validate input The Validate Input button should be used to check if the 

number of equality conditions and the number of loadcases marked as having a 

calculated factor are valid for the chosen Solution method. Three different 

outcomes exist. 

 Input is valid - the analysis can proceed. 

 An error message regarding an imbalance in the equality conditions and 

the number of loadcases marked as having a calculated factor will be 

displayed, requiring correction. 

 The message "Exact solution type required" will appear indicating that, 

because the number of equality conditions and number of lines 

representing cables is the same, an optimised or best fit solution cannot be 

obtained. An Exact solution should be used instead. 

Identifying a feature in the grid 

 Identify selection locates a selected feature (a point or a line) in a model. 

When the row for a feature is selected in the grid on the dialog, and this 

checkbox is ‘on’, the corresponding feature (point/line) is located in the View 

window by animating concentric shrinking squares. 

Target values: Defining the loadcases 

This page of the target values dialog is similar in operation to the basic and smart 

combination dialogs. 

Previously defined loadcases need to be selected for inclusion in the calculations to 

achieve specified target values. Each can also have a factor applied. 

For an overview of the steps required to carry out a target values analysis see Target 

Values Analysis. 

file:///C:/SVN/Content/dlg6anal/idd_target_values_solution_type.htm
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 Results can be combined from different results files if those files are open. 

Click in the drop-down list to select the results file. To include a results 

loadcase select in the left-hand panel and click the Add to  button to add it 

to the Included panel. Use the Shift key to select multiple results cases.  

 Combination and Envelope loadcases are saved with the model data; click in 

the drop-down list to see and select the model entry.  

 Combinations may include results, other combinations or envelopes as 

necessary (but see note regarding superposition below) 

 Included loadcases can be factored by selecting the loadcase and modifying the 

value in the Factor field 

 The Grid button enables the combination data to be visualised in a table. This 

table can be modified directly, or by use the standard windows cut and paste 

options. 

Loadcase settings 

In the calculation of target values each included loadcase can be marked as having a 

Constant factor meaning that the loadcase is used by the optimisation algorithm with 

a constant load factor, or marked as having a Calculated factor meaning that the 

loadcase will be factored by the optimisation algorithm to try to achieve the defined 

target values. 

For a loadcase marked as having a calculated factor this must be set as either Positive, 

or Allow negative. For loadcases marked as having a constant factor this choice is not 

available.  
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Loadcases marked as having a calculated factor may have an Importance level 

assigned to them (a weighting) but only in an optimised solution. A default value of 

1.0 is applied for each if an importance level is not specified. 

Notes 

 Loadcases marked as having a Constant factor are considered in the 

optimisation, but not modified by it. There may also be other loadcases in the 

model which form no part of the optimisation. 

 Loadcases marked as having a Calculated factor may be factored, for both 

exact and non-exact solutions.  

  There is no restriction on multiple combinations and envelopes that reference 

the same loadcase, or indeed that reference loadcases that are included in their 

own right. As a result there may be some permutations of loadcases for which a 

particular analysis solution cannot be found. Detecting a potential problem in 

advance of solving is not practical, so if this should occur any error is reported 

after a solution has been attempted. 

 When a target values analysis is carried out LUSAS cannot verify that 

superposition holds when combinations contain loadcases from different 

analyses or when nonlinear behaviour is being considered. This may occur if 

lift-off supports are present, or when geometric or material changes take place 

between analyses.  

Target values: Defining target values 

This page of the Target Values dialog provides the means to add rows of feature type, 

entity and component data to a grid for comparison, row-by-row, against target values. 

The equality or inequality conditions available are governed by the solution type. An 

equality condition can be set for either a point, or the start or end of a line. 

For an overview of the steps required to carry out a target values analysis see Target 

Values Analysis. 

Use 

Model features of interest (points or lines in a geometry model, or nodes in a mesh-

only model) should be selected prior to selecting the Add Selected button. Note that 

the selection of features, and of general Modeller menu items, is also possible whilst 

the main Cable tuning dialog is displayed. 

When the Add Selected button is pressed the Add Targets From Selection dialog 

assists in the population of the grid by allowing feature type, entity and component 

selections to be made for the chosen selection of features. 

 When added singly the feature name, entity and component should be chosen 

from the combos on the Add Selection dialog for each.  

file:///C:/SVN/Content/dlg6anal/idd_target_add_selection.htm
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 When added for a multiple selection of features common target data can be set 

on the Add Selection dialog for all the similar features in the selection. 

When data is already in the grid the Add button will duplicate the last row. When the 

Add button is used without data in the grid the feature name must be specified 

manually but thereafter selections can be made in the combo boxes for each column. 

Typical target values settings are shown: 

 

Checking input 

 The Validate input button is used to check if the number of equality conditions 

and the number of lines representing cables are valid for the chosen Solution 

method. 

 The Identify selection checkbox locates a selected feature (a point or a line) in 

a model. When the row for a feature is selected in the grid on the dialog, and 

this checkbox is ‘on’, the corresponding feature (point/line) is located in the 

View window by animating concentric shrinking squares. 

Notes  

 Nodes can only be selected in mesh-only models. 

 If Solution type is set to Exact only the ‘=’ condition is available.  

 If Solution type is set to Optimised or Best Fit the entries in the Condition 

column can be set to ‘=’, ‘>=’ and ‘<=’. 

 Type, Entity and Component settings in the grid can be modified using the 

drop-down menu for each cell. 

 Types Line start and Line end are similar to specifying a Point, but clarify 

which element is to be examined, for example where multiple lines meet at a 

point. 

 The user defined results facility may be used to construct components that are 

more complex than the standard provided components. This allows targets to 

be given in terms of potentially complex expressions involving components 

from more than one results entity. 
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 Points and Lines cannot be deleted from the model if they are present in a 

target values loadset. 

Target values: Optimisation criteria 

This page of the Target values dialog provides the means to define optimisation 

criteria based upon solution type. 

For an overview of the steps required to carry out a target values analysis see Target 

Values Analysis. 

The following are shown only for the Optimised Solution type: 

 Minimise the largest calculated factor The calculated factor for the cable stay 

with the largest factor is minimised. 

 Minimise sum of the calculated factors The sum of the calculated factors for 

all cable stays is minimised. 

 Minimise the sum of the criteria specified below Minimises the sum of 

additional values (at given locations) as specified in the grid to optimise the 

solution.  

 Maximise the sum of the calculated factors The sum of the calculated factors 

for all cable stays is maximised 

 Maximise the sum of the criteria specified below Maximises the sum of 

additional values (at given locations) as specified in the grid to optimise the 

solution. 

Notes 

Specified criteria may refer to any results component and can be completely 

independent of the targets, or may duplicate one of them. The user defined results 

facility may also be used to construct components that are more complex than the 

standard provided components so the optimisation criteria can be given in terms of 

potentially complex expressions involving components from more than one results 

entity. 

Steel Frame Design 

Steel frame design code checking facilities are available in Bridge and Civil software 

products only. See Steel Frame Design - Code Checking in the Application Manual 

(Bridge, Civil & Structural) for more details. 

Wood-Armer Reinforcement Calculations 

Wood-Armer attributes, when defined and assigned to features in a model, permit 

calculation of top and bottom reinforcement moments for plate, shell and grillage 

file:///C:/SVN/Content/Design/Steel_Frame_Design/steel_frame_design.htm
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elements, and additionally top and bottom reinforcement forces for shell elements 

according to Wood-Armer / Clark-Nielsen theory. 

Wood-Armer theory allows reinforced concrete slabs to be designed to resist a 

combination of moments [Mx, My] and a twisting moment [Mxy] using orthogonal (or 

skew) reinforcement.  Following a linear elastic analysis Wood-Armer design 

moments [Mx(T), My(T), Mx(B), My(B)] may be obtained. The procedure was 

originally developed for a moment field obtained from a plate analysis but may also be 

applied to shell or grillage analyses. 

For a slab modelled as a shell, subject to a moment field [Mx, My, Mxy] and a stress 

field [Nx, Ny, Nxy] the Wood Armer principles are extended using the Clark-Nielsen 

calculation. The final output [Nx(T), Nx(B), Ny(T), Ny(B), Fc(T) and Fc(B)] 

incorporates both bending and in-plane load effects. In order to obtain equivalent in-

plane forces from the applied moments, it is necessary to establish the distances 

between the centroid of the reinforcement layers and the middle surface of the slab. 

This is calculated using the thickness of the shell elements entered in the geometric 

properties and the distance to the reinforcement centroid from the outer faces of the 

slab, entered in the Wood-Armer dialog. 

An approximate approach is also available for grillage elements whereby bending and 

twisting moments are converted into ‘equivalent’ plate moments so that the Wood-

Armer equations can then be used. An extra geometric property, 'equivalent plate 

width', has to be defined for the grillage to compute these equivalent moments. The 

'equivalent plate width' is defined in the grillage geometric attribute. 

Wood Armer reinforcement properties can be specified by selecting the Attributes 

> Wood Armer menu item. See Wood-Armer / Clark-Nielsen Attributes for more 

details. 

Wood-Armer Assessment 

The Wood-Armer calculation is generally based on a rationalised set of equations 

intended to enable efficient design. However, it is sometimes necessary to consider 

arrangements of reinforcement which have design strengths based on a different 

rationale. A typical application is the assessment of an existing structure. 

If the capacity of the section in the direction of the reinforcement is known the 

'utilisation factor' based on optimal use of the available capacity can be computed. A 

utilisation factor greater than 1 signifies the slab is under-reinforced and extra 

reinforcement is required.  

Alternatively, the Wood-Armer 'K factor' may be entered to proportion the applied 

twisting moment between the reinforcement directions. This allows any spare capacity 

that exists in either direction to be utilised. 



Modeller Reference Manual   

    

706 

Notes 

 Grillage Wood-Armer results are only valid for small skew angles.  

 Wood-Armer skew angles are measured anticlockwise from the x-axis towards 

the y-axis. 

 Wood-Armer results for grillage models are only valid if they are relative to 

the grillage member directions. 

 For grillage models where members are not in either the global X or Y 

directions, Wood Armer components (given in global directions) must be 

transformed such that they are given relative to the local grillage member 

directions. An angle between the global axes and the local axes in the XY 

plane can be set. 

 

 

 

Wood-Armer moment (MXB) in global X axis for a 

grillage model 

 Wood-Armer moment (MXB in global X axis ) for 

the equivalent plate model  
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Wood-Armer moment (MXB) in transformed angle 

direction for a grillage model 

 Wood-Armer moment (MXB) in transformed angle 

direction for the equivalent plate model 

Comparison of untransformed and transformed values for grillage and plate models 

See the Theory Manual for further information on Wood-Armer calculations. 

Reinforced concrete slab design facilities are available in Bridge and Civil software 

products only. They can be accessed using the Design> RC Slab Design  menu item. 

See RC Slab Design : Overview for more details 

Crack Width Calculation Methods 

Crack width calculations and plotting of crack width contours and values can be 

carried out: 

 For plane strain and solid models, when using the Smoothed Multi Crack 

Concrete Model or the "Transient Smoothed Multi-Crack Concrete Model 

(Model 105)" on page 313 

 For slabs modelled by shell or plate elements, and for design codes that support 

crack width calculation. See RC Slab Designer: Overview. 

 In accordance with EN 1992-1-1:2004 Eurocode 2 when using the Crack 

Widths calculation utility with the Smoothed Multi Crack Concrete Model. See 

Crack Width Calculation to EN 1992-1-1. 

Fourier Results 

Before the results for the Fourier can be established, it is necessary to define a 

combination in which the Fourier harmonics are combined to provide an overall result. 

The combination is created using Analyses>  Basic Combination… menu item. 

file:///C:/SVN/Content/Design/RC_Slab_Design/idh_rc_slab_design_overview.htm
file:///C:/SVN/Content/Design/RC_Slab_Design/idh_rc_slab_design_overview.htm
file:///C:/SVN/Content/Bridge/Crack_Widths/idh_crack_widths.htm
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Once the combination has been generated for all the harmonics required and the 

analysis run to create a results file, the combination loadcase should be set active. 

There are then two ways to view results from a Fourier analysis: 

 By manually specifying the angle around the circumference at which the results 

are required and using contours, values and vectors to view the results at that 

position in the model. 

 By using the graph wizard to display the variation of results around the 

circumference for a specified node. 

Design Factor Plots 

Design factor plots are available for use with the Analyst software product only. They 

provide a means of assessing the reserve strength capacity of a component or structure. 

To use this facility the results file must be loaded with the model file. The material 

strength and design factor are defined from the Attributes> Design> Design Strength 

menu item and assigned to the model. The reserve strength can then be visualised over 

the entire model using the Utilities> Design Factors menu item. The following 

criteria are available: 

One of the following failure theories incorporated into LUSAS Modeller must be 

chosen: 

 Maximum Stress Theory (Rankine) 

 Maximum Shear Theory (Coulomb, Tresca) 

 Maximum Strain Energy Theory (Beltrami) 

 Maximum Distortion Energy Theory (Huber, von Mises, Hencky) 

 Maximum Strain Theory (St Venant) 

 

Note: In the case of the Maximum Stress Theory, the component on which to test - 

either the maximum principal stress component S1 or the minimum principal stress 

component S3 must be defined. 

Contours may be displayed of the following: 

 Failure/Yield Index 

 Factored Failure/Yield Index 

 Factor of Safety 

 Reserve Factor  

 Margin of Safety 

 

The calculation and failure limit value for the above options are: 
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Design Factor  Calculation  Failure 

Failure/Yield Index actual/allowable >1 

Factored Failure/Yield Index (DF*actual)/allowable >1 

Factor of Safety allowable/actual <DF 

Reserve Factor (RF) allowable/(DF*actual) <1 

Margin of Safety RF-1 <0 

  

where:  

DF = Design factor defined with material strength 

allowable = allowable stress 

actual = actual stress 

See the Theory Manual for further information. 

Note that only plane strain, plane stress and 3D continuum elements are supported. 

Composite Layers 

When viewing composite results it is often useful to change the results orientation to 

material directions to view the results in fibre and off fibre directions. See Local and 

Global Results for more details. A layer of a solid composite element is treated like a 

shell. Thus top, middle or bottom stresses can be obtained. 

Composite Failure Criteria 

Composite failure criteria is defined as an attribute from the Composite> Composite 

Failure menu item. It provides a means of assessing the reserve strength capacity of 

composite components without carrying out a full nonlinear analysis. To use this 

facility the results file must be loaded on top of the model file. 

 Longitudinal and transverse tensile and compressive strengths must be defined 

along with a shear strength (which cannot be zero) 

 Interaction type can be set to use Default, User, or Cowin values 

 

Once created the Composite Failure attribute should be assigned to the model 

geometry so that the reserve strength can be visualised over the entire model. Once 

assigned to the model the following stress components are available for display via 

selections made on the Contours properties dialog: 

 Tsai Hill 

 Hoffman 
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 Tsai Wu 

 Hashin Fibre 

 Hashin Matrix 

 

Results may be printed or displayed using standard results processing facilities. Note 

that a failure criteria greater than 1 indicates failures. See the Theory Manual for 

further information. 

Composite Failure Contours 

When using the Hashin failure material model the failure indicator (IFFLR) can be 

contoured. The indicator has the following values: 

Indicator (IFFLR)  Description 

0-1  No failure 

1-2  Matrix failure 

2-3  Fibre failure 

3+  Matrix and fibre failure 

 

Results may be printed or displayed using standard results processing facilities. 

User Defined Results 

Defining expressions 

The User Defined Results dialog is accessed from the Utilities> User Defined Results 

menu item. It allows results components to be defined by creating arithmetic 

expressions based upon LUSAS results entities, components, model data and other 

user-defined results component calculations.A component name must be given. It is 

this name that will be used in other dialogs (e.g. contour properties) to refer to the 

expression. The name must comply with strict naming rules (no spaces, no 

punctuation) and must be unique. A description can be added if required. The 

description is not used by Modeller. 

User-defined results expressions are normally created after a solve has been done and 

with results loaded, but they can also be defined as part of the modelling process after 

all relevant features have been assigned an element mesh. 
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 Clicking on the drop-list button  in the Entity cell lists all entities available 

for the elements in the model.  

 Clicking on the launch dialog button  in the Expression cell displays a dialog 

populated with valid variables for the selection made in the Entity field. By use 

of these variables and usual arithmetic syntax a user defined results expression 

can be built and assigned a name and a description. 

See Expressions and Functions Supported in Appendix D for more details. 

Name scoping 

Name scoping (an association of a name to an entity, such as a component or variable 

for reference purposes) can be used within the User Defined Results facility to help 

avoid ambiguity of an included component or variable. Name scoping is optional as 

long as there is no ambiguity. 

A User Defined Results expression such as “DX * 2 + Iyy * 3 + LDNUMB” is valid. 

However, some named variables could be ambiguous - for example more than one 

attribute type defines the variable T. To resolve this ambiguity, name scoping can be 

used. A scope is a prefix to the variable name that identifies where Modeller should 

search for the variable that follows. Adding name scoping to the previous example 

woul d give "entity.DX * 2 + geometric.Iyy * 3 + loadcase.LDNUMB". 

Currently only uniquely assigned attribute types (those attributes where one 

assignment replaces another) have been added as name scopes. One example is design 

attributes. 

A double name-scope is needed for User Defined Results components and scripted 

results components. As well as the main scope “UDR” (or “scripted”), an additional 

scope is used which is the name of the named set of expressions. So, for example, a 

typical component name might appear as “UDR.set_1.C_1” when used as a variable 
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within the definition of another component. Note that where spaces or dots occur 

within the name of a set, these are replaced with underscore characters. 

Variable that can be added to a UDR expression Name scope 

LUSAS results component  “entity” 

UDR component  “UDR” 

Material properties  “material” 

Geometric properties  “geometric” 

Loadcase constant “loadcase” 

    

For a list of User Defined Results scopes see Input and Output of Real Numbers in 

LUSAS in Appendix D. 

Using named expressions 

After definition, the User Defined Results components created can be selected by 

name from the Component drop-down list on the Contours, Values, and Diagrams 

layers properties dialogs. All standard LUSAS results processing, viewing, animating, 

graphing, printing and report capabilities can be used with any user-defined results 

components. 

 

Visualising the Results 

Results visualisation is performed using results layers in the Layers  Treeview. 

Each method of viewing results, described below, requires the relevant layer to be 

present in the Layers  Treeview for the active current window. The properties of 

the results layers may then be set to display the required results in the specified style.  

 Deformed Mesh Draws the deformed mesh shape of a structure when 

subjected to applied load or due to mode of vibration. Note that when a direct 

method influence analysis loadcase is active the deformed mesh layer is 

renamed 'Influence shape'. 

 Influence shape Draws the influence shape for an active influence analysis. 

file:///C:/SVN/Content/7results/idh_treeview_layers.htm
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 Contours Display the results on the model as colour fringes or lines of equal 

value.  

 Vectors Displays vector results quantities as an arrow (or sets of arrows) on the 

model. 

 Diagrams Displays beam element shear force and bending moment diagrams. 

 Values Marks result values on the model as symbols and/or values. 

 Annotation This layer is used to display contour key and other annotation data 

that may be added to the results viewing window. 

Isolated results can be viewed on contour and values layers for any defined location by 

using Inspection Locations. 

For design checks, results for line beams can be obtained at nodal or internal points. 

Results Orientation 

 

When viewing results in LUSAS Modeller it is important to note that: 

 By default, displacements, loads, reactions, residuals, velocities 

and accelerations are output relative to the global Cartesian axis 

system. 

 By default, stress/strain and creep/plastic strain results (except for 

beam/bar elements and interface elements) are output relative to 

the global axes. Forces and moments (stress resultants) for beams, 

shells and joints are output relative to the element local axes. 

 For shell and plate elements, and in accordance with established 

theory, moments are given along the chosen axis. For beams 

results moments are given about the chosen axis. 

If the elements in a model are orientated such that their local axes vary from 

one another (and note for surfaces they may also vary from the surface 

orientation), or if an alternative coordinate system is required, the results may 

need to be transformed to a consistent direction. See Results 

Transformation. 

  

 

Active loadcases 

Visualisation of results uses the results from the active loadcase for the current 

window. The active loadcase is shown with a coloured icon in the Analyses  

Treeview, and may be changed using the Set Active menu item from the loadcase 

context menu, or by dragging and dropping a loadcase name into the View window. 

Non-active loadcases are shown with a greyed-out icon. An analysis that contains an 

active loadcase is identified by the addition of a black dot to its analysis icon .  

Depending upon the elements used it may be necessary to transform the results to 

make them consistent. See Results Transformation for details. 
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Inserting a Results Visualisation Layer into the Current Window 

 Layers can be added (or removed) from the current window using the View> 

Drawing Layers menu item. A tick is displayed on the menu next to each layer being 

displayed in the current window. Alternatively, with nothing selected, right-click in 

the model view window to display a context menu and choose the appropriate layer. 

Another alternative is to select a layer name from the context menu of the Window 

name in the  Treeview. 

The display of layers in the current window can be turned on or off by right-clicking 

on the layer name in the  Treeview and selecting / deselecting the On/Off option. 

See Using Layers for more information 

Tips 

 Use the Annotation tools to label the display. The annotation toolbar may be 

displayed using the View> Toolbars menu item. 

 When comparing different loadcases for the same results type using multiple 

windows, use a global scale (and a global contour range) so that scaling and 

contouring in each window is relative to the first window. 

 For animations, fix the scale instead of using an auto calculated scale. 

  

Layer names for results layers 

Contours, Diagrams, Vectors and Values results layer names as added to and seen in 

the Layers  Treeview have the results component (such as Mx, My or Fz, for 

example), appended to the layer name followed by the entity type such as 

(Force/Moment - Thick 3D Beam). 

 If different component and entities are selected at a later time the layer name in the 

Layers  Treeview is updated to reflect the chosen selection. 
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Deformed Mesh Plots 

The deformed mesh may be displayed at 

any time for a single loadcase. For a 

structural analysis this is the shape under 

load, whereas for an eigenvalue analysis 

this is the shape corresponding to the 

selected eigen mode. 

 Mesh Scaling is specified as either a 

deformation factor or a deformation 

magnitude. The deformation 

magnitude specifies the maximum 

deformation to be displayed on the 

page in millimetres. 

 Mesh Style The deformed mesh 

style may be altered as required 

using wireframe, solid colour, 

hidden mesh, and element effects.   

Contours 

Contours display the results of the active loadcase on the model as colour fringes or 

lines of equal results value.  

Contour Display Features 

 Contours may be plotted using colour fill and/or contour lines. Fill and line 

contours displayed together are useful for emphasising the contour levels. 

Contour labels can be added if required. 

 Contours may be plotted on the deformed (loaded) shape or the undeformed 

shape. 

 Contours may be plotted using Averaged nodal results (smoothed) to give a 

smoothed plot, or use Unaveraged nodal (unsmoothed) results. At 

discontinuities in the model such as those formed by geometry orientation, 

geometric assignments, and material assignments, for instance, a discontinuity 

in the contours drawn will be seen. 

 Contours may be plotted at Inspection locations. For these, a single filled 

circle of a colour representing the value of the result is drawn at each location. 

For line beam models, when plotting these 'spot' contours for stresses for fibre 

location results, the circle is drawn at the assigned location on the nodal line 

and not at the true fibre position. 
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 For grillages 'spot' contours can be shown of Wood-Armer and Clark-Nielsen 

components, as well as for equivalent plate moments. 

 For line beam design checks at nodes 'spot' contours are used. For clarity, 

contours for coincident nodes are shown drawn slightly offset from their true 

positions. 

 Contours may be plotted to show Feature maximum, Feature minimum, or 

Feature extreme. For these options, the whole of each feature will be drawn in 

the same contour colour, in a colour that relates to the single highest value 

found in any node / element on that feature. See Feature based results below. 

 Contours can be plotted on shells, solids, bar and beam elements, on fleshed 

members, on layers of composite elements, on slidelines, thermal surfaces, 

slices and influence shapes (for the Direct Method Influence only) 

 The maximum or minimum results value and location can be annotated. 

 The appearance of the contour key can be adjusted to specify the number of 

significant figures, draw an outline around each colour in the key and draw red 

or blue uppermost. 

 

 

Colour filled contour plot Filled circle 'spot' contour plot 

Setting the Contour Range 

By default the values at which contours are plotted are calculated automatically but 

they can also be set explicitly. A contour level corresponds to the boundary between 

adjacent colour fringes, or the line of equal value. Contour range settings can be 

controlled from the Contours properties dialog, accessed from the Contour layer entry 

in the  Treeview. 

 Setting the range automatically can be done by specifying either the number of 

contours or the interval value between contours.  

 Automatic contours levels can be set to pass through a certain value. The 

maximum and minimum contours may also be specified. 

 A global range can be used to fix the contour levels between different contour 

windows. It is useful to fix the contour levels manually when comparing results 
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from different loadcases. In both these cases the loadcase containing the 

maximum value of interest would normally be used to set the contour range. 

 For animations use a manual range to ensure all frames use the same range 

Tip. Contours use the colour map to define the colours used. It is often useful to adjust 

the colour map so that low stress contours are set to white. This makes contour plots 

easier to understand, and also avoids excessive use colour when printing.  

See "Concrete Models (Nonlinear)" on page 284 for material models that model both 

cracking and crushing behaviour of concrete and permit plotting of contours and 

values of crack widths. 

Feature-based results 

Feature-based results can be displayed on results contour plots, or be printed in results 

tables created by the Printed Results Wizard, or be selected to be included in Reports 

when adding a results chapter. 

 Feature maximum uses, prints or displays on a contour plot the 'maximum' 

value for a feature where the maximum may be a positive or negative number. 

For instance, for values of -8 and +3, +3 would be the feature maximum. For 

values of -8 and -3, -3 would be the feature maximum 

 Feature minimum uses, prints or displays on a contour plot the 'minimum' 

value for a feature where the minimum may be a positive or negative number. 

For instance, for values of -8 and +3, -8 would be the feature minimum. For 

values of -8 and -3, -8 would be the minimum. 

 Feature extreme uses, prints or displays on a contour plot the value with the 

largest magnitude for a feature, but (unlike an absolute value) preserves its 

sign, so for example a value of -8 is considered more extreme than +6. 
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Feature-based results examples 

  

Unaveraged nodal results Contours of Feature maximum 

 

  
 

Contours of Feature minimum Contours of Feature extreme 

Vectors 

Vectors are used to visualise both the magnitude and direction of specified results 

components. Vectors may be displayed at either nodes or Gauss points. At 

discontinuities in the model such as those formed by geometry orientation, geometric 
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assignments, and material assignments, for instance, vectors are not drawn at the 

discontinuity.  

Scale 

By default, vectors will be scaled such that a vector length of 6mm represents the 

maximum displayed results component. Alternatively, a scale factor can be specified.  

Style 

Vectors may be drawn as lines or arrows. By default the colours used for drawing 

vectors in tension and compression are red and blue but the pens can be altered as 

required. 

Deformed Shape 

This image shows displacement vectors displayed on the deformed shape. 

 

Values 

Values are used to identify the location and value of results for both averaged nodal 

(smoothed), element nodal (unaveraged) and Gauss point values. Either maximum 

and/or minimum values may be visualised, and a percentage may be specified to 

determine whether values lying within a maximum/minimum range are displayed. 

Values may also be displayed on the selection and at inspection locations. 

The Values layer is also used to display symbols showing locations of yield, concrete 

cracking planes, and symbols denoting regions of localised crushing. See Nonlinear 

Material Plots for details. 

At discontinuities in the model such as those formed by geometry orientation, 

geometric assignments, and material assignments, for instance, multiple values will 

appear at nodes on the discontinuity in a multi-line list. 
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Maximum and minimum values marked Values plotted for selected (shrunk) elements 

 

 

Visualisation of yielded material Visualisation of concrete crack patterns on a 2D model 

Tips: 

 The percentage range sets the range of values to display, starting from the 

maximum and/or maximum values. Setting this value to 100% displays all 

values, this is useful for displaying results on the screen for a subset of a 

model. Setting this value to 0% shows only the extreme maximum and/or 

minimum value. 

 To prevent text labels from overlapping each other the elements on which 

values are drawn may be shrunk by specifying a percentage of element's length 

remaining on the Mesh layer properties dialog. The same facility may be useful 

(e.g. at an averaging discontinuity) to identify to which element each value 

belongs. Additionally text may be given a rotation angle on the Values layer 

properties dialog to prevent text labels from overlapping each other. 

 Use the Show values of selection option to isolate only selected values of 

interest, or to restrict labelling on complex models to selected nodes and 

elements only. 

 Gauss point values display the computed values from the analysis. These 

values may be particularly useful when examining results for nonlinear 

materials. 

 Unaveraged values display the computed values after they have been 

extrapolated to the element nodes but before they have been averaged. These 

values may be of particular interest when examining results around 

discontinuities in geometry of materials. A significant difference between 

values at the same node, coming from adjacent elements, indicates either an 

averaging discontinuity or a mesh refinement issue. 
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Diagrams 

Bending moment, stress and force diagrams may be drawn for any 2 or 3 dimensional 

frame structure comprised of bar or beam elements. Diagrams can also be drawn to 

show beam/shell slicing results, and any surface quantity at any given graph location. 

The results components available depend upon the element type (see Element 

ReferenceManual). The diagrams may be drawn using the element axes or screen axes. 

Diagram values can be displayed for the whole model, or for selected elements. 

Diagrams can be orientated by element axes or made to lie flat on the screen, 

regardless of model or element orientation. Peak values (as opposed to all values) may 

be optionally plotted. All diagrams can be plotted on the undeformed or deformed 

shape, and drawn either to match the element length, or to a percentage of that length 

to help clarify the display. 

 

Viewing results at inspection locations 

An inspection location is a defined position of interest on a model for results 

extraction / viewing purposes. Inspection locations can be defined and assigned to a 

model either before or after a model has been solved, and are saved when a model is 

saved. Model features can have multiple inspection locations assigned to them. 

Appropriate results can be viewed for all defined inspection locations by selecting the 

Inspection Locations option from a relevant results dialog. Inspection location results 

can be displayed/inspected for: 
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 Graphs 

 Values layer 

 Contours layer 

 Print results wizard 

 Reports 

See Inspection locations for more details. 

Displaying Results for Groups 

By default results are computed and displayed on the visible model. When appropriate 

layers are present in Layers  Treeview, results can be displayed for groups held in 

the  Treeview by choosing the following Results Plots context menu items for each 

named group: 

 Show Results   

 Do Not Show Results   

 Show Results Only On This Group / Attribute 

When combined with group visibility options (that can also be accessed via the context 

menu for each group name) parts of the model can be isolated and have results 

displayed just for those regions.  

Symbols adjacent to each group name in the  Treeview show the status of model 

visibility and results display. 

When viewing results 

 This is the default group icon. 

When 'Show visibility feedback in treeview' is selected and a results file is loaded the 

following icons are provided: 

 (green tick) All of the objects in this group are visible, but no results are being 

shown. 

 (blue tick) Some of the objects in this group are visible, but no results are being 

shown. 

 (red cross) None of the objects in this group are visible and no results are being 

shown. 

 (green tick, green border) All of the objects in this group are visible and showing 

results. 
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 (blue tick, blue border) Some of the objects in this group are visible and some are 

showing results. 

 (green tick, blue border) All of the objects in this group are visible but only some 

are showing results 

Notes 

 When choosing to show results for a material, geometric property or element 

mesh type that does not support (for example) the same Contour entity as that 

used for the previously plotted item, no results will be shown until a valid 

Entity and Component for the new selection is picked on the Contours property 

dialog accessed via the Layers  Treeview. 

 A black dot next to a group symbol  denotes the current group into which 

all new geometry will be added when created and hence has no relevance when 

viewing results.  

Displaying Results for Assigned Attributes 

By default results are computed and displayed on the visible model. With appropriate 

layers present in Layers  Treeview, results can be selectively displayed for 

attributes held in the Attributes  Treeview by right-clicking on the attribute name 

and then choosing Results Plots. The following context menu commands are available 

for Results Plots: 

 Show Results 

 Do Not Show Results 

 Show Results Only On This Attribute 

 

When combined with visibility options that can also be accessed via the context menu 

for each attribute selected features of the model can be isolated and have results 

plotted just for those features. This provides a means of producing isolated results for 

particular material types, geometry, or element mesh types without having to define 

individual groups for each of these items. But, if required, groups of features or 

elements may be defined and the Results Plots entry may be used to display selected 

results for a chosen group. 

Notes 

 When choosing to show results for a material, geometric property or element 

mesh type that does not support (for example) the same Contour entity as that 

used for the previously plotted item, no results will be shown until a valid 
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Entity and Component for the new attribute selection is picked on the Contours 

property dialog accessed via the Layers  Treeview. 

Nonlinear Material Results Display 

Two types of nonlinear material results may be displayed. Yield flags and crack/crush 

patterns. The availability of each depends on the material model assigned to the 

elements during the modelling stage. Crack and crush patterns are available for 

concrete models and yield flags are available for all nonlinear materials. 

  

 Yielded material 

Available from the Values 

layer, specify the results 

entity as Stress, and the 

type as Yield. Yield flags 

show the extent of the 

yielded material within a 

structure and are plotted at 

Gauss points. The 

nonlinear example here 

demonstrates how the 

spread of yielded material 

is visualised using a 

symbol at element Gauss points.  

This display is especially useful when used in conjunction with contours or an 

animated sequence when the onset and spread of yield can be highlighted.  

 Crack patterns and CrushingCrack patterns and crushing symbols can be 

displayed for smoothed multi-crack concrete material models. These are 

visualised using the Values layer by specifying the Results Entity as Stress 

and the Type as Crack/Crush. Three types of display are possible:  

 Localised crushing is shown by black star symbols  

 For the Multi-crack concrete model regions of cracking are shown by 

crack planes drawn in red full lines, and closed cracks are shown by 

crack planes drawn in red dashed lines. 

 For the Smoothed Multi Crack Concrete Model crack planes are drawn 

in a common line style and pen colour whether open or closed in 

nature. 

  

file:///C:/SVN/Content/dlg7post/idd_props_value_overlay_component.htm
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Open and closed crack planes and crush symbols resulting from the loading and unloading of a 2D 

concrete shell model 

Notes 

 When a model includes a nonlinear material model the Plastic strain entity is 

available for all elements (even though some elements are not valid) 

 See "Smoothed Multi-Crack Concrete Model (Model 109)" on page 322 for 

details of plotting contours and values of crack widths following a structural 

analysis. 

 See "Transient Smoothed Multi-Crack Concrete Model (Model 105)" on 

page 313 for details of plotting contours and values of crack widths following 

a hygro-thermal coupled analysis. 

Results on Sections / Slices through a Model 

Results can be plotted on sections or slices through a model that has results available 

by choosing the following menu commands available from the Utilities menu: 

 Section through 3D Cross-sections may be taken through a three-dimensional 

solid model to display results on a slice. Results are calculated at pseudo-nodes 

formed at the intersections of the slice with the element edges by linear 

interpolation of the nodal results. 

 Graph through 2D Graphs of results may be created along a line section cut 

through a 2D continuum model, or on a shell, or a plate, or on a slice section 

which, in turn, was cut through a solid model. Results are calculated at the 

intersections of the line section and the element edges hence a finer mesh will 

produce more sampling points. Any results values along the slice may also be 

computed. 
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Section through a 3D Model 

Slice sections may be cut at arbitrary 

positions through a solid model using 

the cursor to define either a 

horizontal or vertical slice in the 

View window. Slices may be 

generated in any plane by rotating 

the model to the desired orientation 

before a section is cut. 

The location of an arbitrary slice 

section through a model is not saved with the model. However, when cutting a slice 

section through the model an option to create an annotation polygon is provided. This 

annotation polygon effectively defines the location and orientation of the cutting plane 

and does get saved with the model. Annotation polygons may be re-selected if a model 

is reloaded at a later date in order to create a slice at the same location.  

Slice sections can also be created using surfaces that are created at slice section 

locations. These surfaces do not have to surround a model, they must simply be 

defined in the orientation of the cutting plane required. 

To use a saved cutting plane or a surface defining in cutting plane instead of indicating 

the cut using the cursor, the annotation polygon or surface should be selected before 

choosing the Utilities> Slice Through 3D menu item, followed by the By selected 

polygon / surface option. 

Notes 

 No results visualisation or printed results for slices are available unless the 

Display on slice(s) option has been selected on the Contours and Values 

properties dialogs or on the Print Results wizard dialog. 

 3D sectioning/slicing is only available for solid models. For surface models 

refer to Graph Through 2D below. 

 Slice local x and y axes lie in the plane of the slice. The slice local z axis is 

perpendicular to both the slice local x and y axes. Reversing the local axes of 

the slice will re-orientate the z axis as well as the x and y local axes. For 

information on sign conventions for all element types see Element Reference 

Manual. 

 A slice can form the basis for a line section using Graph Through 2D to graph 

results along a line through the centre of a solid model. 



  Chapter 8 : Viewing and Processing Results 

    

727 

Manipulating the Slice 

Once a 3D slice section has been defined, a 

slice exists as a group in the  Treeview, 

and may be manipulated using the View> 

Group menu item or from the group's 

context menu. For more details on viewing 

results on groups see Plotting Results for 

Groups.  

Notes 

 The mesh and nodes on the slice are 

displayed by the mesh layer 

properties. 

 The slice local axes and origin are 

displayed by selecting the Draw axes menu item from the slice context menu. 

 The properties of the slice may be printed by selecting the Print Properties 

context menu item for the slice. 

 The resultant local forces on the slice may be printed by selecting the Print 

Local Forces context menu item for the slice. 

 Groups created from slice sectioning a 3D model are not currently retained 

when a model is saved. 

 The orientation of the slice local axes is based upon [describe]. Slice local x 

and y axes lie in the plane of the slice. The slice local z axis is perpendicular to 

both the slice local x and y axes. Reversing the local axes of the slice by 

selecting the Print Properties context menu item for the slice will re-orientate 

the z axis as well as the x and y local axes. 

Graph through 2D 

Arbitrary line sections may be taken through any surface model, or on a slice cut 

through a solid model. Line sections may be cut at arbitrary positions through the 

model using the cursor, with or without reference to an underlying grid. A slice section 

can also be created with reference to a selected line, arc or combined line, optionally 

when a line is given, the program needs to "map" the line onto the surface to be sliced. 

This is a trivial operation for a planar surface with a co-planar line. However, when the 

surface is complex, and/or the line is elevated away from the plane of the surface, a 

projection direction is used to map the line onto the surface. Slice section lines can 

also be created from intersecting surfaces (advanced use) or at the location of an 

existing graphed location.  
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When defining the line section by cursor, or for lines generated by projection, the 

section line created will, by default, be drawn in the Utilities layer. This may be used 

later for repeating the cut if a graph along the same line is required. The visibility of 

these lines is controlled by the Utilities layer properties dialog, as well as by each 

graph entry in the Utilities treeview.. It should be noted that the order of the layers in 

the Layers treeview may hide line sections drawn in the Utilities layer, and require that 

layer to be drawn on top of a contours layer in order for the line sections to be seen. 

To use an existing line (or annotation line) instead of indicating the cut using the 

cursor, the line (or annotation line) should be selected before choosing the Utilities > 

Graph through 2D menu item. Values for graphing are obtained for each location 

where the slice section line intersects with the mesh. When a slice section line passes 

through a hole no values are calculated or plotted for the extent of the hole.  

A width for corridor averaging value can optionally be specified to increase the 

number of results used when creating a graph of slice results in order to avoid 

localised results concentrations. When defined, results are obtained along three lines - 

the defined slice line and two parallel lines each offset perpendicularly from it by half 

the corridor width value. For each location distance along the slice three values are 

obtained. These are then weighted according to whether a value lies on the corridor 

centreline (x0.5) or at its edge (x0.25) before being averaged to form a single value for 

each slice line location for graphing purposes. When a slice section line corridor width 

has been specified and the edge of either side of the corridor overlays a hole, no values 

are averaged or plotted for the extent that the corridor overlays the hole. If a 

continuous unbroken graph is required in this situation either a narrower corridor 

width or no corridor width should be specified. 

The process of cutting a slice and making appropriate loadcase and extent selections 

ultimately creates a graph utility in the Utilities  Treeview. This utility contains two 

graph datasets; the first containing the distance along the line section, and the second 

containing the specified results along the line. The graph can be drawn at any time by 

right-clicking on the graph utility and selecting the 'Show graph' option. A context 

menu option 'Visualise' displays the slice section location for a graph on the model. 

Once a graph has been defined, its location can be used to draw contours, values or 

diagrams of any results quantity on the model by visiting the appropriate layer 

properties dialog, and choosing the option 'Graph locations' from the relevant droplist. 

Notes 

 The Graph Through 2D option is not available when a model is being viewed 

using the perspective facility. 
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Loadcases and Extent 

Loadcases 

The loadcases that the slice/graph is to report on can be specified by selecting either:  

 <Current active loadcase name> - reports for this loadcase name only. See 

note. 

 Active - reports for the Active loadcase only. See note. 

 All - reports for all loadcases. 

 Specified - reports for a specified named loadcase. 

 Create new window for each loadcase - when checked, displays each graph in 

a separate window. Unchecked, all graphs are displayed within one window. 

Notes 

 Graphing of data for <Current active loadcase name> will graph only that 

loadcase.  

 By setting the Active loadcase option will allow multiple graphs to be created 

or included in separate reports, simply by changing the Active loadcase in the 

Analyses Treeview, before each graph or report is created. 

Extent 

The extent of data that the slice/graph is to report on can be specified by selecting 

either: 

 Full model - default option which reports for all elements of the model 

regardless of whether the elements are visible or displaying results in the 

Modeller view window. 

 Visible model - reports for all elements that are visible in the Modeller view 

window at the time the graph is created 

 Elements showing results - reports for those elements that are displaying 

results in the Modeller view window at the time the graph is created. 

 Selection - reports for only those elements that are selected at the time that the 

graph is created. 

 <Group name(s)> - (if present) lists available group names. 

 New... - allows creating a group name of visible items, or an empty group, as 

part of the graphing process 
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Notes 

 Sometimes, due to the zoom setting, grid points are too close together to be 

usable for slicing purposes. In these cases simply increase the grid size so that 

individual grid points can be selected. 

 Graphing of slice section data cannot take place on multiple stacked surfaces. 

Graph Wizard 

Two types of graphs may be plotted: 

 Results quantities Any available result entity may be plotted against distance 

along the slice. 

 Axial force and bending moment This generates three datasets of distance, 

axial and bending stress along a line through a section: the axial force per unit 

width, moment per unit width and distance of the neutral axis to the midpoint 

of this line. For axisymmetric solids the moment per unit radian is printed as 

well. From these datasets, graphs of axial and bending stress versus depth of 

section are plotted. 

For more details on viewing results on graphs see Plotting Results on a Graph 

Displaying Beam Stresses 

Beam stresses can be displayed on the fleshed section or at selected fibre locations. 

These stresses are computed using engineering beam theory which assumes that the 

normal stress is constant across the width of the beam cross section. This assumption 

can introduces significant errors due to shear lag when wide flanged sections are being 

used so these stresses should be used with caution. 

Beam stresses can be displayed as contours on the fleshed section or as values, 

diagrams or beam contours at fibre locations using the standard layer controls. When 

viewing stresses at fibre locations the value, diagram or contour is drawn at the actual 

position of the fibre on the cross section. 

Beam stress results 

 When displaying results of beam stress for results components that contain a 

moment term such as Sx (Fx,My,Mz) or Sx(My) the results contours displayed 

on a fleshed model are accurately represented by the colours shown in the 

contour key. However, because the contours are being drawn for all locations 

on the section (an infinite number of y/z locations) at the same time, the 

maximum and minimum values cannot be stated on the contour key because 

they are based upon estimated values. 

 Contours displayed on an unfleshed model for beam stress results are precise 

and are drawn for a specified active fibre location. 
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 Values, diagrams and Print Results Wizard tabulated values for beam stress 

results are precise and are plotted for a specified fibre location 

Examples follow: 

 
Filled contours plotted on fleshed beam sections 
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Line contours plotted on fleshed beam sections 

  

 
Line contours plotted at top beam fibre location 
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Line contours and diagram stress results plotted at bottom beam fibre location 

  

Fibre locations 

When viewing selected contour or diagram results for beams, or tabulating values 

using the Print Results Wizard, a fibre location must be used to specify the place(s) 

on the beam section at which the results should be calculated. Results for individual 

fibres are plotted by setting that fibre location active for a particular geometric line 

attribute in the  Treeview. The active fibre is denoted with a black dot next to the 

fibre name.  

Right-clicking on a fibre name in the  

Treeview and choosing Set Fibre 

Active will display results for just that 

fibre. 

 Right-clicking on a fibre name in 

the  Treeview and choosing 

Set Fibre Name will display 

results on all members with that 

fibre name. 
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Notes 

 Standard sections extracted from the section library include extreme fibre 

locations for all sections.  

 The standard section property calculator automatically includes extreme fibre 

locations for all cross- sections that it supports. 

 Models created prior to version 14.2 will not have any fibre locations data 

stored for each beam. However, the relevant fibre location data can be added 

automatically by double-clicking on each Geometric line entry in the  

Treeview and re-selecting the same section size from the appropriate sections 

library. 

 User-defined beam cross-sections require fibre locations to be defined 

manually in order for stresses to be displayed on the diagrams and values 

layers. 

Obtaining Beam Stress Slice Resultants from Beam 

and Shell Models 

Equivalent beam stress resultants can be calculated for flat or curved thin and thick 

shell models comprising linear isotropic or orthotropic materials by use of the 

Utilities> Slice Resultants Beams/Shells menu item. This facility is only available for 

models that have an analysis category set to 3D.  

This facility allows the conversion of the results from a complex shell model into an 

equivalent beam analogy, which for some applications enables checks to be made 

against design codes.  

Overview 

To obtain results, a slice path along which results will be calculated is defined with 

respect to lines and arcs in the model, and the spacing of the locations at which results 

are to be calculated are specified. Additional options control the extent of the model to 

be used in order to calculate results. After making appropriate selections, slice sections 

for the locations defined will be visualised on the model and a Beam/Shell Slicing 

entry added to the Utilities  Treeview. Once solved, results for the defined slice 

locations can be viewed by selecting the Beam/Shell Slice Resultants entity from the 

layer properties dialogs for results layers (Contours, Diagrams etc.) and from other 

results outputs.  

Note that Direct Method Influence attributes can be defined with reference to a 

Beam/Shell Slice Resultants entity, and be assigned to selected beam/shell slice 

locations using the 'Assign to' context menu item for the DMI attribute. This allows 

use of Vehicle and Rail Load optimisation on bridge decks idealised using mixed 

beam and shell elements. 

file:///C:/SVN/Content/Bridge/Vehicle_Load_Optimisation/Vehicle_Load_Optimisation_Overview.htm
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Fleshed beam and shell model showing selection of slice path 

  

Slice path 

Slice locations are defined using a slice 

path which can consist of straight lines 

and arcs or combined lines that contain 

straight lines and arcs in the selection. 

The path must be continuous without 

any branching characteristics. The slice 

path orientation is defined by either the 

order of selection when more than one 

line/arc is selected or the orientation of 

the line/arc if only a single line/arc has 

been selected.  
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Slice locations 

The locations of slices along the path can be defined by entering values using any of 

the following methods: 

 Incremental distances from start of path (for example, entering '1@10;2@5' 

will set slice locations at distances of 10, 15, and 20 from the start of the path). 

Distances can be both positive and negative but the running total distance 

should remain within the length of the path.  

 Absolute distances from start of path (for example, entering '10;15;20' will 

set slice locations at distances of 10, 15, and 20 from the start of the path). 

Distances must be positive and within the length of the path. 

 Parametric distances from start of path (for example, entering '0.1;0.2' will 

set slice locations at distances of 10% and 20% of the distance along the path)  

 Constant spacing (for example, entering 1.25 will set repeated slice locations 

at that distance along the path)  

 Include additional slices along path if selected will create additional slices for 

each point on the line defining a path. For instance, for a single line 

representing a slice path, two additional slices will be created. For a combined 

line comprising three lines, four additional slices will be created. 

 Distance from reference origin to start of path (chainage) can be also be 

entered. If this value is non-zero, the value is added to the distances along the 

path. 

The orientation of the slice local axes follows the selected lines and is in accordance 

with beam theory where the beam local x axis is orientated along the beam. The slice 

local x axis will be defined perpendicular to both the slice local y and z axes. 

Slice options 

 The calculation of moments can be about either the Neutral axis or the Slice 

path. Where 'Slice path' is selected, moments will be computed about the 

location along the path which defines the slice plane. This can be used when a 

model contains orthotropic materials. 

 

Note: For the calculation of beam stress resultants it has to be assumed that plane 

sections remain plane under the action of the loading. The strain distribution over the 

whole section also is assumed to remain linear. The location of the neutral axis can 

therefore be calculated directly from the areas and stiffness of the contributing 

materials in the composite cross-section (see Gere & Timoshenko, Mechanics of 

Materials, 3rd SI Ed., pg 301). For the calculation of the neutral axis location, the 

Transformed-Section Method is used which incorporates Modular Ratio techniques. 

Additional options available to control the slicing include: 
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 Slice width If selected, an overall width (centred on, and perpendicular to the 

slicing path) of elements to include in the calculations can be specified. If a 

slice width is not stated, all valid elements (in the specified extent) will be 

included in this direction. For both options, the slice is infinitely deep in the 

slice local z axis. 

 Include whole elements only If the slice width option is selected, the option to 

include whole elements only is available. If selected, partial elements 

intersected by the current slice will be ignored in the calculations. 

 Smooth corners on path If selected, the average tangent of the path at a 

connection between two lines/arcs will be used for the slicing if the distance 

along the slice path exactly matches this path connection. If the smooth corners 

on path option is not selected, two slices will be taken at the connection using 

the tangents for both of the lines/arcs connecting at this location 

 Extent The extent of the model that will be considered to contribute to the slice 

can be specified by selecting either:  

 Full model - default option which includes all elements of the model 

regardless of whether the elements are visible or displaying results in the 

Modeller view window. 

 <Group name(s)> - (if present) lists available group names. Note that 

restricting the extent for each slice utility by specifying a group improves 

the calculation speed. 

 New... - allows creating a group name of visible items, or an empty group, 

as part of the results/graph generation process. 

 Rotation about x - Rotates the slice plane about the x-axis of the path. See 

'Notes' that follow if skewing of slice plane along beam is required. 

 Name A name given to identify this slice data when an entry is added to the 

Utilities  Treeview. 

 

Visualisation of slice locations 

After making appropriate selections, section slices for the locations defined will be 

visualised and a Beam/Shell Slicing entry added to the Utilities  Treeview. A 

context menu for this entry provides the means to Rename, Delete or Edit the slicing 

data, and to turn off or turn on the Visualisation of the slice planes and their related 

information through any of the drawing layers. The size of the drawn slice plane 

depends upon the elements that are sliced. By default, slice planes and local slice axes 

are drawn in red, but these and other visualisation settings relating to slice axes, slice 

planes and slice labels can be specified from the Utilities layer properties dialog, 

which is accessed from the Utilities  Treeview. 
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Isometric view of beam and shell model showing locations of slice planes, slice local axes, and slice 

labels. Inset image shows beam local axis. 

Viewing and printing results for defined slice locations 

 When slice locations are defined and results are available, results for the slice 

locations can be viewed by selecting the Beam/Shell Slice Resultants entity 

from the layer properties dialogs for results layers (Contours, Diagrams etc.) 

that support this. 

 Use the Print Results Wizard to select Beam/Shell Slice Resultants of interest 

for viewing in tabular form or adding to a model report 

Notes 

 For use with linear isotropic and orthotropic models. 

 An assumption that plane sections remain plane is required for the calculations 

to take place. 

 Linear variation of stress is assumed for this calculation method and therefore 

low order flat shells are supported (3 or 4 noded thin and thick shells) and high 

order flat shells are calculated ignoring the mid-side nodes if they are coplanar 

with collinear edges. For curved high order shells the element is subdivided 

into constituent pseudo elements and each pseudo element interrogated using 

linear interpolation. If nonlinear material is present care should be taken to 

ensure the results obtained are suitable. 



  Chapter 8 : Viewing and Processing Results 

    

739 

 The slicing path must be defined using straight lines, arcs or combined lines 

containing only these two line types. 

 Slice forces can only be computed relative to the intersection of the slicing path 

with the slice plane or the neutral axis based on the sliced section. No facilities 

are available for the transformation of slices without defining a separate path 

and recalculating the slices. 

 The slice z-axis is taken from the line that represents the slice path. It cannot be 

changed. 

 Taking slices at the free end of a structure can lead to overestimation of the 

forces and moments on the section. This occurs due to the stresses in the 

section not returning to zero at a free and unloaded end. 

 Taking slices at a supported end of a structure can lead to discrepancies in the 

forces and moments when compared to a beam model due to the end effects 

taken into account by the full 3D shell modelling. 

 Where a slice passes through a node in the structure, results are presented for 

the contributions of the elements on both sides of the slice. This is presented as 

results for the negative and positive local x sides of the slice. 

 Engineering thick beam elements are supported. 

 When using 3 or 4-noded shell elements the mesh density should be 

sufficiently fine to capture the behaviour of the structure. 

 When modelling curved structures it is recommended that regular quadrilateral 

elements are used wherever possible. 

 Beam / shell slice results are not available for eigenvalue results as these are 

potentially misleading. 

 If skewing of a slice plane along a beam is required, create a line at an 

appropriate skew angle from a point at one end of the beam and of sufficient 

length to extend beyond the extent of the model. This line can then be selected 

as a path line from which orthogonal slice sections will be generated according 

to the extent stated. 

Worked Example 

 See Online help > Worked Examples > For LUSAS Bridge and LUSAS Civil 

& Structural >  'Section Slicing of 3D Shell Structure' , which shows the use of 

this facility. 
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Slideline Results Processing 

When a results file is read into Modeller from 

an analysis that involves slidelines, a group is 

created for each slideline surface in the model. 

These groups can be accessed from the Group 

Treeview.  

A context menu for each group name provides 

options for making the members of a group 

visible or invisible and for selecting and 

deslecting the members of a group.  

Limited results for a selected slideline group 

can be printed by using the Print Results menu 

item on the context menu for that group. Full 

slideline results for the model as a whole can 

be printed using the Print Results Wizard. 

Printing Slideline Results 

The print results wizard is accessed from the Utilities menu. When Slideline results are 

selected the following six types of results can be chosen for printing: 

 Summary 

 System forces 

 Gap Forces 

 Contact forces 

 Contact Stresses 

 Section Results 

 

 Each type of result is described below. 

Summary 

The summary presents a list of the maximum and minimum values of each slideline 

results in a table. 

System, Contact and Gap Forces 

There are three categories of force results: 

 System forces The normal and tangential gap forces at each slideline node are 

distributed across both slideline surfaces. These forces are assembled together 

and transformed into the global system directions to give the System Forces. 
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 Gap forces Gap forces are computed from the normal penetration and the 

tangential movement of a node. They are the basic quantities used in the 

contact formulation. For example, with the penalty method the normal gap 

force at a node is obtained by multiplying the normal penetration with the 

contact stiffness. Coulomb’s law of friction also uses gap forces. To check the 

application of the law, the normal and tangential gap forces should be 

compared. 

 Contact forces The normal and tangential gap forces at each slideline node are 

distributed across both slideline surfaces. These forces are assembled together 

and kept in the local directions, normal and tangential to the contact surfaces, to 

give the Contact Forces. The contact pressures and stresses are based on these 

forces. 

Contact Stresses 

This category contains results for the contact pressure normal to the surface and the 

contact stresses tangential to the surface at each node. 

Section Results 

This category contains generic contact results. It includes the status of each node as to 

whether it is in contact or out of contact, the normal penetration for each contacted 

node, the contact stiffness, the nodal contact area and the zonal contact distance. 

Graphing Slideline Results 

To graph slideline results, the slideline group of interest must be set visible from the 

group context menu in the Group Treeview . 

For two-dimensional analyses the graph wizard can be used to generate the variation 

of a particular slideline result along the slideline surface. The variation along the 

surface can either be graphed against distance or angle. 

For three-dimensional analyses the slideline results are graphed in the same manner as 

other results. 

Plotting Contours, Values and Vectors for Slidelines 

For three-dimensional analyses, contours of contact results can be displayed by 

selecting Slideline Results as the entity on the Contours dialog. The full list of 

slideline results will then be available in the Component combo. 

Slideline values and vectors can be displayed for both two and three-dimensional 

analyses by selecting Slideline Results on the Values or Vectors dialog. With values 

the full list of slideline results components is available, whilst with vectors only 

Contact and System Forces are available. 

Note. When looking at the deformed mesh from a contact analysis, the exaggeration 

factor should be set to 1.0 to avoid a misleading visualisation. 
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Table of Slideline Results Availability 

Slideline Results components Label Contours Values Vectors Printing Graphing 

System forces             

Contact force in system x direction ForceX  Yes Yes Yes Yes Yes 

Contact force in system y direction ForceY  Yes Yes Yes Yes Yes 

Contact force in system z direction ForceZ  Yes Yes Yes Yes Yes 

Resultant contact force RsltForce  Yes Yes Yes Yes Yes 

Gap forces              

Tangential gap force in local x 
direction 

TanGapFrcX  Yes Yes   Yes Yes 

Tangential gap force in local y 
direction 

TanGapFrcY  Yes Yes   Yes Yes 

Resultant tangential gap force RsltTanFrc  Yes Yes   Yes Yes 

Gap force normal to contact surface NrmGapForc  Yes Yes   Yes Yes 

Contact forces             

Tangential contact force in local x 
direction 

TanForcex  Yes Yes Yes Yes Yes 

Tangential contact force in local y 
direction 

TanForcey  Yes Yes Yes Yes Yes 

Resultant Tangential contact force RsltTanFrc  Yes Yes Yes Yes Yes 

Contact force normal to contact 
surface 

NrmForce  Yes Yes Yes Yes Yes 

Contact stresses             

Contact stress in local x direction  ContStresx  Yes Yes   Yes Yes 

Contact stress in local y direction  ContStresy  Yes Yes   Yes Yes 

Contact pressure normal to contact 
surface 

ContPress  Yes Yes   Yes Yes 

Section Results             

Contact stiffness ContStiff  Yes Yes   Yes Yes 

Penetration normal to contact surface NrmPen  Yes Yes   Yes Yes 

In-contact/out-of-contact status ContStatus  Yes Yes   Yes Yes 

Nodal contact area  ContacArea  Yes Yes   Yes Yes 

Zonal contact parameter Zone Yes Yes   Yes Yes 

Zonal contact detection distance ZnCnDetDst  Yes Yes   Yes Yes 

Contact stiffness coefficient IntStfCoef Yes Yes   Yes Yes 
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Thermal Surface Results 

The results from analyses involving thermal surfaces may be processed in a similar 

manner as other results. Extra result types are available for thermal surfaces.  

When reading a results file a group is automatically created for every thermal surface 

used in the analysis. These are accessed from the Group Treeview .  

For 2D slidelines the graph wizard can be used to generate the variation of the thermal 

surface variables along the surface or as a history though the analysis. When multiple 

thermal surfaces are present results for specific thermal surface are viewed by setting 

the appropriate surface as only visible from the group context menu.  

For 3D problems contours of the thermal surface results may be displayed on the 

thermal surface. Values and vectors can be displayed for both 2D and 3D problems. 

The results on a thermal surface are displayed by selecting the Thermal Surface 

Results entity on the appropriate property dialog.  

Thermal surface results may be printed using the print results wizard. 

Thermal surface flow results Label 

Gap and environmental flow GapEnvFlw 

Radiation flow between segment RadFlwSeg 

Radiation flow to environment RadFlwEnv 

Total nodal flow TotalFlw 

  

Plotting Results on a Graph 

The Graph Wizard Utility provides the means to draw XY graphs of model or results 

data, edit an existing graph wizard utility-created graph, or simply create graph 

datasets for later use. It is accessed from the Utilities > Graph Wizard menu item. 

Graph datasets exported or copied to spreadsheets, graphs can be printed or included 

in reports. 

Graphs of results can also be created along a line through a 2D continuum model or on 

a line through a section from a 3D model. See Results on Sections Through a Model. 

The following results graphs may be plotted using the Utilities > Graph Wizard menu 

item if the results are available:  

 Time history A history for a specified results type throughout an analysis with 

respect to time or increment. Graphs may be plotted for a named variable such 

as Total Load Factor or Response Time verses a specified results quantity such 

as displacement in X, equivalent stress or sum of reaction over a set of 

specified nodes. The following history datasets are available: 
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 Nodal Averaged or summed. 

 Gauss Point results for a selected element and Gauss point (Element 

Gauss numbers may be determined using the labels layer). 

 Named Named result variables for a linear analysis such as loadcase 

ID, a transient analysis such as response time, or a nonlinear analysis 

such as total load factor. 

 Element results for all or selected elements. 

 Strain energy and plastic work Total strain energy or total plastic 

energy for the elements showing results. 

 Previously defined Use a previously defined graph dataset. 

 Fourier expansion The displacements, stresses and strains output from a 

Fourier analysis are coefficients of corresponding sine and cosine functions. 

The evaluation of these functions around the circumference of the model is 

achieved graphically using the Graph Wizard. 

 Modal expansion Graphs the modal response of a structure to dynamic 

excitation using the results from an eigenvalue analysis. Various results entities 

may be plotted against a frequency range or sampling time for selected 

eigenmodes. 

 Load curve Graphs a defined load curve. 

 Variation Graphs a variation function. 

 Reuse values from existing graphs Graphs two previously defined datasets. 

 Thermal surfaces Graphs results along a thermal surface. 

 Slideline (assigned to line)Graphs results along a slideline 

 Prestress Graphs prestress losses in tendons 

 

Graph Properties 

The Graph Wizard Utility takes you through each step of creating the X and Y graph 

datasets and placing them into a graph.  

When the graph wizard has been successfully completed (and 'Save in treeview' has 

been selected), the defined graph wizard utility name  and its associated graph 

datasets  are added to the Utilities  Treeview, and if 'Display now' was chosen 

the chosen graph data is displayed. A context menu for the named graph wizard utility 

 provides the following menu items: 

 Find highlights the line section that was used to define the graph on the model. 

See also Visualise below. 

file:///C:/SVN/Content/dlg7wizd/idd_graph_wizard_prestress.htm
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 Edit Attributeprovides access to the settings made in defining the graph.  

 Copy, Paste, Rename and Delete options are self-explanatory. 

 Auto-Update provides a switch to turn on / turn off automatic updating of the 

graph if the model has changed since its graph datasets were last displayed. 

Graphs set to not auto-update are shown by a locked graph icon  in the 

Utilities  Treeview. 

 Print prints the values for all graph datasets associated with the graph entry in 

a separate view window. 

 Export writes the graph data to a comma separated file (.csv) 

 Visualise provides a switch to turn on or turn off the visualisation of the line 

section used to define the x-axis of the graph. Making the Utilities layer teh 

top-most layer in the Layers  Treeview will enable the visualisation to be 

seen. 

 Show Graph allows predefined graphs to re-displayed at any time - without the 

wizard having to be re-accessed. Double-clicking on the named Graph wizard 

utility does the same. 

 Add to Report adds the graph to a chosen location within a report. 

 

On the Graph view window, toolbar buttons provide the means to print, print preview, 

add a graph to a report , or edit the graph data  or its general properties and 

style . 

A context menu for each named graph dataset  entry in the Utilities  Treeview 

provides the following optios: 

 Rename Self-explanatory 

 Print prints the values of just that dataset to the view window. 

 Export exports the graph dataset values to a comma separated file (.csv). For 

graph datasets created for models prior to LUSAS version 15.1 it is also 

possible to export all graph datasets to a .csv file by using the Export all 

context menu for the Graph entry or graph dataset name in the Utilities 

treeview. Columns of data are created with graph dataset names being written 

to row one of each column. 

 

Graph datasets 

Graph datasets contain the data that is graphed and cannot be deleted in isolation from 

the graph for which they are defined. Deleting a graph will delete associated graph 

datasets. Pressing the Undo button immediately after deleting a Graph Wizard-created 

graph entry will re-create the graph entry, but not the graph datasets. Reaccessing the 
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graph entry and creating a graph from its saved values will re-create the graph datasets 

for that graph. Graphs that are set to not auto-update are shown with a locked graph 

icon . 

Graph visualisation 

 

The graph window is split into the graph data table on the left and the graph area on 

the right. 

Plotted graph data can be enlarged by zooming in on a part of the graph by boxing 

with the mouse. To unzoom right-click on graph area to display the context menu and 

select unzoom. 

Toolbar buttons on the Graph window provide printing, adding to report, and editing 

options. 

Plotting Families of Curve Data On The Same Graph 

If a graph already exists, then further curves may be added to the graph being created 

by choosing the Include existing graphs option of the final page of the Graph Wizard. 

In this way families of curves may be drawn on the same graph using a different 

colour for each one.  

Note. These changes are made to the graph only and are not stored in the 

corresponding graph dataset. 
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Pasting Graph Data to Spreadsheets 

 

To paste graph data to a spreadsheet, use Copy from the Edit menu when the 

data has been highlighted in the graph data table, then paste into the 

spreadsheet. Graph dataset values can also be exported to a spreadsheet. See 

Context menus above. 

Printing Graphs 

 

Graphs may be printed using the File> Print command. Because graphs are 

created as separate windows a single graph will be printed on each page. 

  

  

To print multiple graphs together use Copy from the Edit menu when the 

graph area is active, then paste into a suitable word processor. 

Adding Graphs to a Report 

 
Graph entries present in the Utilities  Treeview may be added to a report 

using the Add to report button. Each time a report is generated the graph data 

will be updated to match the current state of the model unless the graph is set 

to not auto-update. 

Editing Graph Data and Properties 

Once a graph has been plotted, the data that is graphed and the appearance of the graph 

may be modified. 

 
A graph definition can be changed by using the Edit Graph Definition button 

or selecting the Edit > Edit Graph Definition main menu item. This allows 

total re-definition of a graph using the Graph Wizard. 

Editing Graph Properties 

 
To change the style or appearance of a graph, or to edit individual data points 

on the graph (for example to add an origin to a curve), select the Edit Graph 

Properties button, or select Edit > Edit Graph Properties from the main 

menu item or from the graph's own context menu. Grid details, X and Y Axis 

styles, and curve styles can be modified from respective tabs. By checking 

(ticking) the Editable graph table box on the General Graph Properties page. 

The following facilities are also available: 

 New data points may be added by adding new rows to the grid either by 

using Insert Row from the Edit menu or by pressing the Tab key 

when the cursor is in the final cell. 

 Data points may be deleted by deleting the data in the grid. 
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 Blocks of data from a spreadsheet may be pasted. New rows will be 

added to the grid as necessary. 

 

Case Study. Plotting Families Of Curves 

To compare results at different nodes, a graph could be plotted of the stress throughout 

an analysis at three nodes, say 6, 25, and 60. With a suitable results file, the nodes of 

interest would first be selected with the cursor,before proceeding as follows: 

1. Start the Graph Wizard from the Utilities menu.  

2. Choose Time History, click Next. 

3. For the X axis choose Named variable, click Next, choose Response Time, 

click Next. 

4. For the Y axis choose Nodal, click Next, specify the results entity as Stress, 

specify node number 6, click Next. 

5. Either type suitable graph and axes titles, or leave them blank to use default 

names, click Finish. The graph is displayed. 

6. Repeat steps 1 and 2.  

7. For the X axis choose Named variable, click Next, but this time choose 

Previously defined, click Next. Select Response Time from the drop-down 

list, click Next. 

8. For the Y axis choose Nodal, click Next, specify the results entity as Stress, 

specify node number 25, click Next. 

9. Choose Include existing graph, make sure to specify the correct graph from 

the list if there is more than one, click Finish. The new data will be added to 

the first graph. 

10. Repeat steps 1, 2 and 7. 

11. For the Y axis choose Nodal, click Next, specify the results entity as Stress, 

specify node number 60, click Next. 

12. Repeat step 9.  

Creating Animation Sequences 

A LUSAS animation displays a sequence of pictures showing the status of the model 

or results type for selected loadcases. Animations are useful for viewing the effects on 

a structure of a moving load, checking that a staged construction modelling process 

has been defined correctly, or visualising the changing results of a nonlinear, dynamic 

or transient analysis. Sometimes the manner in which a structure deforms is not always 
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obvious when comparing its undeformed and deformed shapes, and it may be better 

understood using animation.  

The structure may be animated in two ways. Both types of animation are created from 

the Tools> Animation Wizard menu item. 

Animating an active loadcase 

 Active Loadcase (for results loadcases only) The results from a single 

loadcase, or eigenvector mode shape, may be animated according to a 

deformation function (sine, square, saw tooth, or ramp). A full sine wave (-1 

to 1) is useful for animating mode shapes obtained from an Eigen analysis. 

 

Animating Load History 

 Load History animates chosen model or results loadcases producing a 

animation frame for each.  

The load history can be animated for both model or results loadcases. 

 All loadcases animates all available results loadcases. 

 Final increment animates all available results loadcases, using only the last 

increment of each nonlinear results loadcase. 

 Specified allows a user-defined selection of model or results loadcases for 

animation. 

 

Resolution 

The resolution and aspect ratio of an animation can be set by specifying the number of 

pixels in the horizontal and vertical directions. Initial default values are related to the 

model view window size and set to be either 800 pixels horizontally or 600 pixels 

vertically according the view window aspect ratio.  

The content of the animation sequence is defined by the contents of the current 

window when the Animation Wizard is started. For example, to animate contours on a 

deformed mesh, a contour and deformed mesh layer need to have been added to the 

current view window prior to running the animation wizard. 

file:///C:/SVN/Content/dlg7wizd/idd_animation_wizard_2.htm
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Notes 

 If contours are to be included in an animation, it is useful to fix the contour 

range across multiple loadcases using a global or manual scale before creating 

the animation sequence. Setting the contour range will fix contour colours on 

each frame of the animation sequence relative to the others. The spread of 

stress, or other entity, can then be seen more readily. It is often useful to set an 

upper and lower value based upon the maximum and minimum values 

achieved across a range of loadcases. 

 When animating deformed models it is recommend that the auto resize button 

 is switched off before creating the animation to prevent re-scaling during 

the animated sequence. 

 Animation is carried out by capturing an entire set of pixels for each frame of 

the animation for the full view window and not just the extent of the model. As 

a result, for some models, any 'blank space' around a model will be also 

captured with each animation frame saved. To reduce the amount of unwanted 

area captured the view window can be re-sized to the proportions of the model 

width and height.  
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 The only model loadcases (that is, those loadcases that are saved with a model) 

available for inclusion in an animation are basic modelling loadcases and basic 

load combinations. Envelope and Smart Combination loadcases that are saved 

with a model cannot be animated. 

 Increasing the number of included loadcases will require a proportionately 

longer amount of time to create an animation. 

 When animating staged construction models the mesh layer display should be 

set to Show activated elements only in order to see the model building 

sequence. 

Controlling the Animation 

The buttons at the bottom of the animation window allow the animation to be speeded 

up or slowed down, stepped frame by frame, looped, and saved.  

Saving Animation Files 

Animation files are saved as Windows standard .avi files using the File> Save As AVI 

menu item. or by pressing the Save As AVI button on the Animation window. The 

“Microsoft Video 1” compression method is used by default with a 75% compression 

setting to reduce the file size. This produces a good reduction in file size without 

noticeable loss in quality and should be compatible with the majority of PCs.  

Using the Animation Builder Toolbar 

The animation tool builder tool bar can be found using the View> Toolbars menu 

item. 

Animation sequences may be edited, or can be 

created frame by frame, using the animation 

builder toolbar.  

Playing Animation Files (AVI format) 

Windows media player is required to play AVI files. 

Print Results Wizard 

The Print Results Wizard allows selected results values, from one or more loadcases, 

to be assembled, ordered and displayed in a tabular listing format. By default, a Print 

Results Wizard entry is added to the Utilities  Treeview, which, if Show results is 

chosen from its context menu, will display the selected results. An option to 

additionally or only display the results to the screen is available. To assemble results 

use the Utilities > Print Results Wizard menu item or select the Print Results Wizard 

 toolbar button.  
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The Print Results Wizard dialog can also be accessed from the Add Chapter or Edit 

context menu items for a report that is present in Reports  Treeview. Selecting the 

results tab on the Chapters dialog, followed by pressing the New button, displays the 

Print Results Wizard dialog to enable the results that will be saved in that results 

chapter of the report to be specified. 

When selecting a loadcase and a results entity, results components of interest can be 

chosen. When the loadcase selected is a smart combination or an envelope, the 

reported results can be either coincident to a chosen primary entity and component, or 

individually computed (in which case they are not coincident). The location and extent 

of results can be specified, and the output type and order that the results are arranged 

can be chosen. Results precision settings can also be defined. 

The results for each primary component for each loadcase are displayed within 

separate tabs in the print results window that is ultimately displayed, with tab names 

based upon the loadcase name and any selections made. Once listed the results can be 

printed, saved to a spreadsheet or text document, or be added to a model report by 

using the Add to Report  button. Contributing envelopes, combinations or 

loadcases, and the values from each, along with the relevant factors applied can be 

identified for a single results value, along with a summary of loadcases and factors in 

use. 

To stop the creation of printed results at any time, press the Ctrl + Break keys.  

Results Types 

 Components Default, always enabled.  

 Eigenvalues Only enabled if eigenvalue results are present. 

The dialog options described below cover both results types, where applicable. 

Results Loadcases 

When more than one results loadcase is present a choice can be made:  

 <Current active loadcase name> - reports on results for this loadcase name 

only, when the results listing is created. This option creates a utility that is 

always tied to this named loadcase, and ignores the loadcase that is active when 

the results are subsequently viewed. 

 Active - reports on results for the loadcase that is active at the time the results 

are being viewed. This may be different from the loadcase that was active when 

the utility was defined. Setting the Active loadcase option will allow results for 

different loadcases to be created or included in separate reports, simply by 

changing the Active loadcase in the Analyses Treeview, after each report has 

been created. 

 All - reports on results for all loadcases. 
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 Selected - reports on results for a specified named loadcase or loadcases. 

Loadcases can be selected for inclusion in a results listing by selecting a 

loadcase in the lower 'Available' panel of the dialog and pressing the 'Send to' 

button to add it to the 'Included' panel. Loadcases can be removed from the 

'Included' panel by selecting the row (by its left-most cell) and clicking the 

'Send back' button. Entering a Step value of 'n' in the Loadcases panel of the 

dialog for a selected analysis will add the first and then every 'n'th loadcase of 

that analysis to the 'Included' panel. Only loadcases that are suitable for 

combining or enveloping will be listed in the 'Available' panel.  

 Final increment - reports on results for the final results increment from a 

nonlinear analysis. 

 

Viewing primary and coincident effects 

When either a smart combination or an envelope is chosen to display results, one or 

more primary components can be chosen in the Primary panel of the dialog. Selections 

then made in the 'Reported component' panel of the dialog are reported as coincident 

effects. In summary: 

 If the Primary checkbox is not checked the results reported on will not be 

coincident to each other. Instead each will be computed independently. 

 If the Primary checkbox is checked only the primary component(s) selected 

is/are enveloped and all other reported components selected will be coincident 

effects. 

Entity 

For results components (not including eigenvalue results) the selection of a results 

Entity displays all available components that can be reported on in the adjacent 

'Reported components' panel. Only those components applicable for the elements used 

in the model will be displayed. The results entities and results types available (when 

applicable) are: 

Eigenvalues 

 Eigenvalues (Frequency) - eigenvalue, frequency and error norm. 

 Participation Factors - participation factors in X, Y and Z directions. 

 Mass participation factors- mass participation factors in X, Y and Z 

directions. 

 Sum mass participation factors - sum the mass participation factors in X, Y 

and Z directions. (This enables the % of active mass in each direction to be 

determined, as the sum of the mass participation factors in each direction 

should be unity). 
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Displacement, Residual, Reaction, Reaction Stress, Loading, 

Potential, Flux, Gradient 

 Component -  component results in tabular format. 

 Summary - maximum and minimum visible values and their position on the 

model. 

 

Stress/Strain, Force/Moment 

 Component - component results in tabular format. 

 Summary - maximum and minimum visible values and their position on the 

model. 

 Principal - principal values in tabular format. 

 Fatigue or Damage Results - fatigue (Log Life) and damage results in tabular 

format. 

 Energy - strain energy and plastic work results. 

 State variables - extra nonlinear material parameters. 

 

Slideline results 

 Component - component results in tabular format. 

 Summary - maximum and minimum visible values and their position on the 

model. 

 System forces - forces in global or current transformed directions. 

 Gap forces - forces required to reverse nodal penetration. 

 Contact forces -forces generated across contact surfaces. 

 Contact stresses - contact stresses computed as contact force/contact area in 

normal and tangential directions. 

 Section results - generic contact results e.g. contact state, normal penetration 

etc. 

For more details see slideline results processing. 

Thermal surfaces results 

 Component - underlying nodal results. 

 Summary - maximum and minimum values (according to the extent specified) 

and their position on the model. 

 Flows  - flow components. 
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 View factors - summary of view factor sums across segments. 

 

Location 

When applicable, printed results can be obtained for the following locations: 

 Nodal prints nodal results for those nodes chosen in the Extent droplist. 

 Averaged nodal  prints average nodal (smoothed) results for those elements 

chosen in the Extent droplist. Averaged nodal values are computed from 

element nodal values (see below). Averages are computed as long as adjacent 

elements are suitable for averaging (reference to averaging options). Where 

averaging is not appropriate, multiple values will be presented for each node. 

 Gauss Point or Internal Point prints the Gauss point values (for surfaces and 

volumes) or the internal point values (for line elements) that are internal to 

those elements chosen in the Extent droplist. 

 Inspection Locations are defined positions of interest on a model for results 

extraction / viewing purposes.  

 Element Nodal  prints unaveraged nodal results for those elements chosen in 

the Extent droplist.. Nodal results are extrapolated from the Gauss point values 

within each element. 

 Feature maximum prints the 'maximum' value where the maximum may be a 

positive or negative number. For instance, for values of -8 and +3, +3 would be 

the feature maximum. For values of -8 and -3, -3 would be the feature 

maximum 

 Feature minimum prints the 'minimum' value where the minimum may be a 

positive or negative number. For instance, for values of -8 and +3, -8 would be 

the feature minimum. For values of -8 and -3, -3 would be the minimum. 

 Feature extreme prints the value with the largest magnitude, but (unlike an 

absolute value) preserves its sign, so for example a value of -8 is considered 

more extreme than +6. 

 

Note that no results summary information can be obtained for feature maximum, 

feature minimum or feature extreme results, as they results are already considered to 

be summaries. Note also that feature results will be based on nodal results for 

continuous results like displacement, and on gauss point results for element results like 

forces and moments. 

Extent 

The printed results for selected loadcases are governed by the following extent 

options:  
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 Full model - prints results for all elements of the model regardless of whether 

the elements are visible or displaying results in the Modeller view window. 

 Visible model - prints results all elements that are visible in the Modeller view 

window. 

 Elements showing results - (default option) prints results only for those 

elements that are displaying them in the Modeller view window. 

 Selection - prints results for all selected elements that are visible in the 

Modeller view window. 

 <Group name> - prints results for all elements in a chosen group regardless of 

whether the elements are visible or displaying results in the Modeller view 

window. Only active if group names have been defined. 

 New... - permits creation of a new group of selected or visible items on an 

empty group. 

 

Output 

 Tabular provides a table of values for all elements / nodes in the extent 

specified. 

 Summary provides a table of only those nodes / elements in the extent that 

have the most extreme values 

 Tabular and Summary(the default) provides both of the above. 

 

Order 

This specifies the table layout and the tab name to be used on the results listing. The 

results are grouped into pages (shown as tabs) for the first named item. Each tab then 

shows a table of all the second named item. For example, selection of 'Loadcase / 

Feature' creates one page (tab) for each loadcase. Within each page is a table of 

features, showing values from that loadcase. Selection of 'Feature / Loadcase' shows 

the same values organised as one page per feature, with each page showing a table of 

loadcases. 

 Loadcase/Feature (default option) 

 Feature/Loadcase 

 Loadcase/Mesh 

 

Transformation of results 

 Transform Printed results may be transformed to be relative to a specified 

local coordinate, according to element local directions for stresses, or relative to 
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the local element material directions. Numerous options are available by 

pressing the Set... button. See Results Transformation for details. 

 

Additional results options 

Displaying extreme envelope / smart combination results  

 Display extreme envelope / smart combination results (Only available if an 

envelope or a smart combination 'Maximum' or 'Minimum' loadcase has been 

set active prior to selecting the Print Results Wizard, or selected as a specified 

loadcase during its use). Includes extreme values obtained by considering both 

the maximum and minimum value at each location, taking the larger absolute 

numerical value in each case, and preserving the sign of whichever value is 

used. 

 Display for slice(s) When section slices have been defined on a 3D model 

(with corresponding groups being automatically created in the Groups 

treeview) the results for just the automatically-defined groups/slices can be 

printed to the print results window by this check box. Note that the 

automatically created group name 'Slices' is a collective name for the 

automatically created slice group names and does not contain results. 

 Coordinates when enabled, includes the global X, Y and Z positions of the 

nodes or gauss points, or inspection locations (as appropriate) as separate 

columns in the printed output. If a column heading is double-clicked the results 

will be sorted in ascending or descending order based upon coordinates. This 

enables sorting of nodal and gauss results data by coordinate. 

 Display now When checked, this generates and displays the results data 

immediately. No printed results utility is saved unless 'Save in treeview' is 

checked. See below. 

 Save in treeview When checked, creates a Print Results Wizard  entry in 

the Utilities  Treeview. These entries can be added to a model report. 

 Allow derived components When a derived component is used as a primary 

component, or when a derived component is inspected for particular situations 

involving smart combinations and envelopes, LUSAS Modeller will 

automatically suppress the listing of derived components in the Components 

panel list as the unwary could get an erroneous answer when reporting on 

results. This can be overridden by making this selection. The ability to access 

derived components must be used with caution because results may be 

misinterpreted in some situations.See Raw and Derived Components for 

details. 

 Defaults resets the dialog to default values. Otherwise, when re-accessed, 

previous settings are retained. 
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Precision 

 The number of Significant figures or Decimal places can be specified for 

values written to the results listing. 

 Show trailing zeros - includes the required number of zeros for a chosen 

number of significant figures. 

 Threshold value This is an absolute value, up to which, all values between 

zero and the threshold value will be written as zero. For example, setting a 

threshold value of 1E-6 would ensure that any values, which are effectively 

zero, but would otherwise be written in full in a results listing, would be written 

as zero (0.0). Once set, a threshold value is retained but the Threshold value 

check-box is un-set to prevent potentially inappropriate or unnoticed uses of 

that value on further visits to the dialog. 

 Name A name given to identify this table data when an entry is added to the 

Utilities  Treeview. 

 

On completion 

After making appropriate selections in the Print Results Wizard a table of selected 

results will be displayed, and a Print Results Wizard  table entry is added to the 

Utilities  Treeview.  

A context menu for Print Results Wizard  table entry in the Utilities  Treeview 

entry provides the following menu items: 

 Edit provides access to the settings made in defining the results data listing.  

 Copy, Paste, Rename and Delete options are self-explanatory. 

 Show Results allows predefined tables of results data to be re-displayed at any 

time - without the wizard having to be re-accessed. Double-clicking on the 

named Print Results Wizard  table entry in the Utilities  Treeview does 

the same. 

 Add to Report adds the results generated by this print results wizard dataset to 

a chapter in a model report. 

 

Display, manipulation and interrogation of printed 

results table data 

The results for each selected loadcase, or feature (as chosen using the Order control) 

are displayed on a separate tab in the print results window. A model info tab also 

appears in all output windows and provides basic information about the model. At 

discontinuities in the model such as those formed by geometry orientation, geometric 
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assignments, and material assignments, for instance, multiple values will appear for 

those nodes lying on the discontinuity. These values are denoted by (A), (B), (C) etc 

within the data.  

Table related buttons 

On the Printed Results table view window, toolbar buttons provide the means to save, 

print, preview, add the data to a report, edit its general definition, or  

 Press the Save button to save the report in a spreadsheet format 

 Press the Print button  to print the results. 

 Use the Print preview button  to view how the page will print. Zoom and 

unzoom options are provided. Note that the page orientation is pre-set to be 

Portrait and is not governed by any settings made on the Page Setup dialog that 

would be accessed via File > Page setup.  

 Use the Add to Report button  to add the results listings as a results 

chapter in a model report. 

 Use the Edit definition button  to revisit the Print Results Wizard dialogs. 

 Use the Examine calculations button  to show how a selected value in the 

print results wizard output has been calculated by listing the envelopes, 

combinations or loadcases, and the values from each, along with the relevant 

factors applied, that produce the selected result.  

 Use the Total Contributions button  for a selected results value to reduce 

the contributing envelopes and combinations to a single table of loadcases and 

factors in use. Where it is notionally valid to sum the contributing unfactored 

load effects, these values are also listed in the table. A loadcase may also be 

created for a result from a smart combination, which includes all the loading 

assignments and factors which gave that particular result (at a particular node). 

Context menu options 

When the Printed Results window is displayed a context menu can be invoked (by 

right-clicking within the window), which allows for the printed results data to be 

manipulated or interrogated: 

 Save as Microsoft Excel The contents of the current tab or all tabs can be 

saved to a spreadsheet or to a text file.  

 Sort Ascending / Sort Descending Results data can be sorted in ascending or 

descending order. In addition, data sorting can be achieved by double-clicking 
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on a header to sort by that column name. A second double-click on the same 

header will carry-out a reverse sort.  

 Copy Selected cells or the whole grid can be copied to the clipboard.  

 Print The Print option sends the contents of the active tab to the printer. 

 Definition Re-invokes the Print Results Wizard dialog for editing the output 

 Examine Calculations For a selected result value the contributing envelopes, 

combinations or loadcases, and the values from each, along with the relevant 

factors applied can be examined. 

 Total Contributions For a selected results value reduces the contributing 

envelopes and combinations to a single table of loadcases and factors in use. 

For a smart combination, a loadcase can be created, which includes all the 

loading assignments and factors which gave a particular result (at a particular 

node). 

 

Printing results for Envelopes or Combinations 

When the active loadcase is an envelope or smart combination the results printed will 

show the primary component (e.g. Fx) marked with an asterisk. Additionally, for 

Envelopes only, the loadcase in which the maximum or minimum value was extracted 

will be tabulated in the LCID (Loadcase ID) column.  

When enveloping each component individually, the loadcase from which the results 

are extracted cannot be tabulated because each individual results component may have 

come from a different loadcase. 

Notes 

 Tabulation of beam stress results (such as Sx (Fx,My,Mz) and others) is done 

for a selected fibre location. Note that the specified fibre location does not 

currently appear in the results listed. 

 Selected slice and slideline data and results may be printed from the group 

context menu. 

 To include model images in a model report see Generating Reports 

 Opening pre-version 16 models that included results chapters will cause 

equivalent Print Results Wizard entries to be created in the Utilities  

Treeview. These will be saved when the model is saved. 
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Examine calculations 

Selecting the Examine Calculations  option for a selected value in a Print 

Results Wizard output table shows how the result has been calculated. Any 

envelopes, combinations or loadcases that have been used in the calculation will be 

listed, along with the values from each, and any relevant factors that were applied. 

In the re-sizable dialog presented, the treeview initially shows only the parent 

loadcase, along with a grid below, showing the loadcases or results components that 

are contributing to the result shown for that selected entry in the dialog's treeview. 

 By selecting a nested loadcase, the grid will update to show the loadcases or 

results components that are contributing to that selected entry in the treeview. 

Note that the value shown by a selected entry in the dialog's treeview is 

identified by bold text in the grid. 

 By expanding loadcases and entries of interest in the treeview, loadcases, 

components and values contributing to loadcases and components higher up 

the treeview can be identified. 

The lowest “level” of the treeview is either an unaveraged raw solver component (e.g. 

Mz from loadcase 1) or a user input such as a factor from a combination definition. 
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Notes 

 A results component marked with an asterisk shows that it is a primary results 

component. 

 It is not possible to examine the calculations used for derived components. It 

is only possible to examine the input that the calculations use. This will include 

the full set of raw solver components, but might also include attribute values 

such as Young's modulus or thickness. 

 In some situations results components may be reported in the treeview as 'N/A', 

meaning not available, or not applicable. To give an example of when this may 

occur, it is important to remember that a combination is built from the sum of 

factored loadcase values, whether it is smart or basic. The only difference is the 

way the factors are calculated. For a basic combination, the factors are user 

inputs. For a smart combination, a relatively complex process calculates the 

factors that are used, meaning that some constituents are ignored completely. 

For instance, it is normal practice, when adding a smart combination inside an 

envelope, to add both max and min “sides” of that smart combination to the 

envelope. Subsequently, when calculating max envelope results, LUSAS 

correctly ignores the min “side” of the smart combination, and vice versa, and 

reports 'N/A' for such ignored components. 

 In some situations results components may be reported in the grid as 'Not used'. 

One example of when this would occur is if the location of the calculation 

being examined was at a averaging discontinuity, perhaps because of different 

material or thicknesses being assigned to surfaces either side of the location. 

Total contributions 

 Selecting the Total contributions  option for a selected results value in 

the Print Results Wizard output table reduces the contributing envelopes and 

combinations to a single table of loadcases and factors in use. Where it is notionally 

valid to sum the contributing unfactored load effects, these values are also listed in the 

table generated. 
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 Show zero values Any loadcase that has been considered and rejected (e.g. by 

an envelope) will not be listed in the table. They can be optionally shown with 

a factor of 0.0.  

 Create loadcase Creates a loadcase, for a smart combination, which includes 

all the loading assignments and factors which gave a particular result (at a 

particular node). This may be useful for those wishing to use an onerous 

loadcase identified by a linear analysis as part of a further nonlinear analysis, 

for example. When solved, that loadcase would yield all the coincident effects 

that occur at the time when the original chosen component is at its maximum 

(or minimum) value at the location chosen. No default name is provided for this 

loadcase. A suitable Analysis entry and loadcase name must be specified. 

Printing and Saving Views of a Model 

Printing a view of a model 

Views of a LUSAS model may be printed directly to the default printer by using the 

print  button.  

The File> Print Preview menu item is useful for visualising the document prior to 

printing taking place. Using the File> Print menu item allows alternative printer 

settings to be used. 

Note. When a model is created the default paper size (for printing use) is set from the 

settings of the default printer installed on the local PC. This helps to ensure that 

regional paper sizes are used in preference to otherwise specified sizes. 

Saving a view of a model 

For use in model reports 

See Saved Views for more information. 

Saving a view as a specified file type 

Views of the LUSAS model can be saved as BMP, JPG, PNG files, or as LUSAS 

Picture files using the File> Picture Save menu item.  

BMP, JPG, and PNG files can be saved to a user-defined pixel width (or height) where 

the height (or width) not specified is proportional to the size of the graphics window 

when the file was saved. JPEG and PNG files are the most efficient to save in terms of 

file size. BMP, JPG, and PNG files can be included in a model report, but use of saved 

views should be used instead if automatic updating of images in a report is required. 

Views saved as a LUSAS Picture File can only be viewed using the LUSAS picture 

file utility and legacy viewer, Expose. From Expose, .pic, and types of .wmf, .ps 

and.eps files can be produced. 
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Note that Graphs cannot be saved in LUSAS picture file format. Picture files cannot be 

included in a model report. 

Copying the View Window 

The contents of the View window can also be copied (and subsequently pasted) into 

other applications by clicking the right mouse button in the View Window and 

selecting Copy from the context menu. In this instance the pixel width (or height, if 

greater) is set to be a maximum of 1800 pixels with the other dimension proportional 

to the view window size. 

The contents of the view window can also be transferred to the Windows clipboard 

using the copy  button. 

Generating Reports 

A customised report can be built in the Reports 

 Treeview by defining chapters that reference 

the type of model and results data that are to be 

included in the report. The modelling and results 

data selected can be restricted to particular model 

geometry, model attributes or loadcases, or 

particular results entities. Data can be listed for all 

or selected parts of a model. Chapters containing 

user content in the form of captured or saved 

images can be included, as well as graphs, saved 

views of the model, or one-click reports.  

Note that with the exception of user-captured or user-inserted images, and graphs that 

have been specifically set to not auto-update, all remaining assembled report data is 

automatically updated each time a report is viewed to reflect the current state of a 

model. 

Report templates 

A report template (which is created, modified and saved in the Reports  Treeview 

for each model) holds the information required to generate reports that can include 

model properties or results data. Each time a report is to be viewed the report details 

that are specified in the report template are extracted from the model and results files, 

and used to create the report. Each report template can include any number of chapters 

that define the model attributes and analysis results.  

A new (empty) report template is created by selecting the Utilities > Report... menu 

item and selecting the New report menu item, or from right-clicking New Report 

from the Reports context menu in the Report  Treeview.   
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Any number of report templates may be created and saved in the Reports  Treeview 

of a model. The order of information in a report can be changed by dragging and 

dropping the chapter names up and down the Report Treeview. 

Report data may be exported to Microsoft Excel spreadsheets for additional 

calculations to be carried out as well as being exported in PDF, RTF (for use in 

Microsoft Word) and other formats. 

If results are required only to be displayed on-screen (rather than be assembled for 

printing in a report) the Print Results Wizard may be a better choice. 

Creating a Report 

A new (empty) report template is created by selecting the Utilities> Reporting... 

menu item and selecting the New Report menu item, or from right-clicking on the 

Reports folder in the Reports  Treeview, and selecting the New Report menu item 

from the context menu. 

On the Report properties dialog: 

 The report Title is optional and is used as a title in the exported report. 

 Units for a report are, by default, the same as those of the model. However, it is 

possible to prepare a report in a different system of units, in which case most 

values seen in the report will be converted appropriately. See notes for details 

of which types of values are not converted.  

 Front page view This permits a saved view of the model to be used as an 

image on the first page of the report for identification purposes. 

 It is also possible to control the number of significant figures and decimal 

places seen in the report. These can also be specified independently for each 

chapter. Show trailing zeros includes the required number of zeros for a 

chosen number of significant figures. 

 Threshold value This is an absolute value, up to which all values between zero 

and the threshold value will be written as zero. For example, setting a threshold 

value of 1e-6 would ensure that any values in the range of -1e-6 < 0 < 1e-6 , 

which are effectively zero but would otherwise be written in full in a results 

listing, would be written as zero (0.0). Once set, a threshold value is retained 

but on further visits to the dialog the Threshold value checkbox is un-ticked to 

prevent potentially inappropriate or unnoticed uses of that value. 

 Precision for all chapters This, if selected, uses the values for significant 

figures or decimal places chosen on this dialog throughout the report. This 

option overrides any different values set inside each report chapter. 

 Page break between chapters forces page breaks where stated. 
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 The Report name is the name added to the Reports  Treeview. By default 

reports are named Rpt1, Rpt2 etc. if no name is specified. 

Once a New Report entry has been added to the Reports  Treeview, selecting the 

report name and using its context menu enables the adding of chapters to a report, 

modifying, viewing, renaming, or deleting of a report.  

Report templates are saved in the Reports  Treeview when a model is saved. 

Note that all model units will be converted to a different system of report units with 

the following exceptions: 

 Graphs and graphed data are not converted to selected report units. However, 

graphing units are stated clearly within the image of the graph itself.  

 Slab design units are only partially converted to report units. The units of 

codified values are retained. For example if a value such as reinforcement bar 

area per metre width is 1200 mm
2
/m and a report in feet is requested, then the 

value will be converted to (approx) 400 mm
2
/ft. The units of steel area are not 

converted because they represent a codified value.  

 User Defined Results cannot be converted. 

Report symbols explained 

See "Treeview Panels and Icons" on page 22 for details of all symbols used in the 

Reports  Treeview. 

Adding a Report Chapter 

Model properties, loadcase results, user content, graphs, prestress data, saved views of 

a model, notes and other data can all be added to a model report as a report chapter in 

the Reports  Treeview.  

Chapters can be added to a report by selecting the Add Chapter menu item from the 

Report name context menu (accessed by right-clicking the mouse button), or from the 

context menu of an existing report chapter entry in the Reports  Treeview - in 

which case the new chapter will be inserted to follow that selected chapter.  

The following can be added using the Chapters dialog: 

 Model Properties - Model geometry, attribute and model-related loadcase 

data. 

 Results - any or all loadcase results data. 

 User Content - user-captured or supplied images, or text. 
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 Graphs These can also be added using the Add to Report button in the 

generated window when a Graph is displayed, or from a context menu option 

for the graph entry in the Utilities  Treeview. 

 Prestress  Tendon properties, profile, loading, losses and setting -out data for 

all tendons defined and assigned in a model can be tabulated. 

 Saved Views - a saved view of the model that is updated to reflect the current 

state of the model each time a report is generated. A saved view can also be 

added using the Add to Report context menu option for a saved view entry in 

the Utilities  Treeview. 

 Notes - general user-defined notes relating to one or many chapters. Notes can 

also be added using the Add to Report context menu option for a saved view 

entry in the Utilities  Treeview. 

 Other - includes Response Spectra utilities, if created. 

Additional related information 

Chapters for particular results can also be added by selecting the Add to Report 

button in the generated report window for that result, or from the Utility name context 

menu for that result entry. See below for details. 

The following can be added to a report by using the Add to Report context menu item 

for the named entry in the Utilities  Treeview: 

 Print Results Wizard results 

 

The following can be added to a report by using the Add to Report button in the 

generated window for that report: 

 One-click report   

 Steel design code member report 

file:///C:/SVN/Content/Design/Steel_Frame_Design/steel_frame_design.htm
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Add or Edit a Model Properties Chapter 

 

The Model Properties tab of the Chapters dialog shows Geometry, Attributes and 

Loadcase panels that allow model geometry, attribute and model-related loadcase 

/IMD loadcase information to be added to the report via the use of check boxes.  

 The number of Significant figures or Decimal places can be specified for 

values written to the results listing. 

 Show trailing zeros - includes the required number of zeros for a chosen 

number of significant figures. 

 Threshold value This is an absolute value, up to which, all values between 

zero and the threshold value will be written as zero. For example, setting a 

threshold value of 1e-6 would ensure that any values in the range of -1e-6 < 0 

< 1-e6 , which are effectively zero but would otherwise be written in full, 

would be written as zero (0.0). Once set, a threshold value is retained but the 

Threshold value check-box is un-set on further visits to the dialog to prevent 

potentially inappropriate or unnoticed uses of that value. 

 Use the Loadcases… button to display a dialog which restricts the chapter to 

display data for All, Active or Specified loadcases or combinations. Note that 

by default all loadcases are selected, but for some situations (notably when 

reporting on loading attributes for a model that have been generated by vehicle 

load optimisation software) a physical limit may be met because the generated 

report is too big for Windows to display. If this occurs, use the Loadcases 
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button to reduce the number of loadcases selected so that a report can be 

generated, and generate a separate report for the remaining loadcases. 

 Use the Extent droplist to define the scope or the extent of the chapter to be 

created, for example to restrict the chapter to display data for the Full model, 

the Visible model, Elements showing results, a Selection, or a Specified 

group only. See Chapter Extent for more details.   

 

Note: It is possible to visit this dialog several times to create multiple chapters, each of 

which can have different ordering, scope and loadcase choices.  For example you can 

create one chapter describing the lines in group 1 and subsequently to create a 

different chapter describing the lines in group 2. Once created, the order of chapters in 

the report can be modified at any time by dragging and dropping them up and down 

the Report  Treeview. 

 Add or Edit a Loadcase Results Chapter 

 

The Results tab of the Chapters dialog is always shown regardless of any results being 

available. This enables a report to be assembled prior to solving the model, should that 

be desired.  

Any previously created Print Results Wizard utilities will be listed in the grid for 

inclusion in a report chapter. Click the Include checkbox to add each defined listing of 

results to the report as a sub-chapter. 
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 Use the New... button to add new entities for inclusion in the report as results 

sub-chapters by using the Print Results Wizard. When added, results sub-

chapters are shown in the grid. A corresponding Print Results Wizard entry is 

added to the Utilities  Treeview for the selection made. 

 Use the Edit button to change the results selection to be included in a report 

chapter. Prior to pressing this button a row of the grid must be selected by 

clicking inside the first cell of the row. 

 The Include checkbox (seen when results are present) will include or exclude 

results listings from the report. 

 Maximum components across page restricts the results components listings to 

a specified number of columns. 

 Chapter name can be entered or edited if the default or previously entered 

name is to be altered. It is suggested that the Results Chapter include a 

reference to the Loadcases and Extent included. 

 

It is possible to visit this dialog several times to create multiple chapters, each of 

which can have different ordering, scope and loadcase choices.  For example you can 

create one chapter describing the displacements for the whole of a model and 

subsequently to create a different chapter describing the stress in a particular group of 

elements. Once created, the order of chapters in the report can be modified at any time 

by dragging and dropping them up and down the Report  Treeview. 

Deleting loadcase results chapters 

It is not possible to delete loadcase results chapter entries from the grid on this dialog 

directly, or from the Report  Treeview itself. Instead, the 'Include' checkbox can be 

un-checked on this dialog to remove a Print Results Wizard utility from the model 

report chapter, and the Print Results Wizard utility can also be deleted from the 

Utilities  Treeview using the context menu provided, if it is not otherwise needed.  
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Add or Edit a User Content Chapter 

 

The User Content tab of the Chapters dialog allows images or text files to be added to 

the report  

 The Add file... button allows adding existing saved images or text to the report. 

 The Capture screen button takes a snapshot of the current view window and 

allows it to be saved as a fixed-size BMP, JPG or PNG file to the working 

folder (by default) or to any other specified folder. Note that the captured image 

will include the full view window and not just the extent of the model. As a 

result for some models 'blank space' will appear around each image saved. To 

avoid this, the view window can be re-sized to the proportions of the model 

width and height in order to reduce the amount of unwanted area captured. 

Note that screen captures do not automatically update to reflect any 

changes made to the model or its re-calculated results if the report is re-

generated. If it is required to have all model and results-related images 

automatically update each time a report is generated add a Saved view chapter 

instead. 

 The Caption field provides the means to associate a title with each image and 

have it written beneath each image in the report. 

 Clicking the OK button adds this image to the report as a separate chapter. 

Only BMP files currently appear in the preview pane. Each image added to the 

report is added as a separate chapter.  
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Note: It is possible to visit this dialog several times to create multiple chapters. Once 

created, the order of chapters in the report can be modified at any time by dragging 

and dropping them up and down the Report  Treeview. 

 Add or Edit a Graph Chapter 

 

The Graphs tab of the Chapters dialog is only present if Graph Wizard-created graphs 

are present in the Utilities  Treeview. 

Graphs defined by Graph Wizard can be added to a report as a report chapter. Graphs 

that were defined and added to the Utilities  Treeview are initially listed in the 

Graphs panel of the Chapters dialog. Check (tick) the appropriate graphs to include 

those graphs as a chapter in the report. Note that the name of a graph is automatically 

used as a title beneath the inserted graph in the report.  

Self-explanatory options when adding graphs to a report are: 

 Each selected graph in its own chapter 

 All selected graphs in one chapter 

 Append to previous chapter 
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Notes:  

 It is possible to visit this dialog several times to create multiple chapters.   

Once created, the order of chapters in the report can be modified at any time by 

dragging and dropping them up and down the Report  Treeview. 

 Each time a report is generated graphs included in a report will update to 

reflect any changes that may have been made to the model since the graph was 

last displayed, unless the auto-update feature has been turned-off. 

 Graph chapters can also be added using the Add to report button in the 

generated window when a Graph is displayed, or from a context menu option 

for the graph entry in the Utilities  Treeview. 

 Add or Edit a Prestress Results Chapter 

 

The Prestress tab of the Chapters dialog is shown if at least one tendon loading has 

been assigned in a model.  

Tendon properties, profile, loading, losses and setting -out data for all tendons defined 

and assigned in a model can be reported in a prestress chapter. 
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Assignments 

The assignments panel contains details of all tendons assigned to the model. Select all 

or individual items to add data relating to them to the report. 

Including setting-out information 

 Include setting-out information The calculated tendon profile shape (after all 

smoothing has been applied) can be included in a tendon summary report in a 

format that is suitable for setting-out the tendon on-site.  

 Tendon profile setting out data can be tabulated for a defined Spacing 

along a beam with reference to Vertical origin and Horizontal origin. 

The origin settings can be set to be an Assigned line or the top or bottom, 

left or right, or centre of a geometrically defined cross-section. Note that 

'Section centre' may differ from 'Assigned line' by any eccentricity that 

may be applied.  

 Each tendon assignment writes a separate setting-out chapter where the 

setting-out tendon profile information is stated as relative distances 

between setting-out points. In some cases, several assignments may 

generate duplicate tables of data, for example where the same profile has 

been used on many lines, but the details of the assigned lines may be 

different so a separate report is provided as a safety measure.  

 At any given point on the structure the interpretation of 'Section top', 

'Section bottom', 'Section left' or 'Section right' depends upon the specified 

vertical direction (set using Utilities > Vertical Axis), the assigned line, 

and the direction of increasing x distance along the tendon profile. 'Section 

top' is always interpreted as vertical, which (for non-level decks) is not 

necessarily perpendicular to the section at that point. A 'forwards' direction 

is always along the assigned line, but may be opposite to the line's x-axis, 

as it must follow the tendon's increasing x value. 'Section left' and 'Section 

right' are calculated from the cross-product between the 'up' and 'forwards' 

directions at each point.  
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Selected tendon profile setting-out terms explained 

  

Precision 

Independent precision options for a prestress chapter can be set if the precision settings 

for the report as a whole are not set. See Creating a Report. 

 The number of Significant figures or Decimal places can be specified for 

values written to the results listing. 

 Show trailing zeros - includes the required number of zeros for a chosen 

number of significant figures. 

 Threshold value This is an absolute value, up to which, all values between 

zero and the threshold value will be written as zero. For example, setting a 

threshold value of 1E-6 would ensure that any values, which are effectively 

zero, but would otherwise be written in full in a results listing, would be written 

as zero (0.0). Once set, a threshold value is retained but the Threshold value 

check-box is un-set to prevent potentially inappropriate or unnoticed uses of 

that value on further visits to the dialog.  

When a report is generated, prestress results data for all tendon loading can be 

presented in a report. 
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If the prestress results become out-of-date an appropriate message will appear in the 

report. A re-solve of the model will update the report the next time it is requested. 

 Add or Edit a Saved View Chapter 

 

The Saved Views tab of the Chapters dialog is always present.  
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Saved views or the current view can be added to a report as a report chapter. Any 

saved views that were defined and added to the Utilities  Treeview are listed in the 

Saved views treeview panel of the Chapters dialog.  

Check (tick) the appropriate checkbox to include the contents of that view as a chapter 

in the report. Note that a title for the view is automatically added beneath the inserted 

image of the view in the report. This title is comprised of the Saved view name 

followed by a loadcase name in parentheses as, for example, 'Contours Fx (Loadcase 

1)'. 

 Use the Save view... button to save the current active view into the Saved view 

list. 

 Use the Loadcases… button to display a dialog which restricts the chapter to 

display results for All, Active or Specified loadcases or combinations.  

 TheExtent droplist controls the scope or the extent of the chapter to be created, 

for example to restrict the chapter to display results for the Full model, the 

Visible model, Elements showing results, a Selection, or a Specified group 

only. See Chapter Extent for more details.  

 

Self-explanatory options when adding saved views to a report are: 

 Each selected view in its own chapter 

 All selected view in one chapter 

 Append to previous chapter 

 

Notes: 

 It is possible to visit this dialog several times to create multiple chapters, each 

of which can have different ordering, scope and loadcase choices.   

 Once created, the order of chapters in a report can be modified at any time by 

dragging and dropping within the Report  Treeview. 

 Each time a report is generated the contents of a saved view chapter are 

updated to reflect the current state of the model and/or results referenced by the 

saved view. 

 Saved view chapters can also be added using the Add to Report context menu 

option for a saved view entry in the Utilities  Treeview. 
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Add or Edit a Notes Chapter 

 

The Notes tab of the Chapters dialog is always present.  

Notes can be added to a report as a report chapter. Any notes that were defined and 

added to the Utilities  Treeview by using the Utilities > Notes... menu item are 

listed in the Notes treeview panel of the Chapters dialog.  

 Use the checkboxes to select which notes to include in this chapter. 

 Use the Create note button to define additional notes. When these notes are 

defined they will be saved as entry within the Utilities  Treeview. 

 

Note adding options are: 

 Each selected note in its own chapter 

 All selected notes in one chapter 

 Append to previous chapter 

 

Notes: 

  It is possible to visit this dialog several times to create multiple chapters. 
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 Once created, the order of chapters in a report can be modified at any time by 

dragging and dropping them within the Report  Treeview. 

 Notes chapters can also be added using the Add to report context menu option 

for a note entry in the Utilities  Treeview. 

 Add or Edit an 'Other' Chapter 

 

The Other tab of the Chapters dialog is only shown if any of the tree-frame entries it 

can list are available. 

Response Spectra utilities are an entry that will be listed in the tree-frame for optional 

inclusion in a report chapter for this tab setting. Checking (ticking) each entry will add 

a single report chapter for each, but containing all the defined utilities for these 

selections. Relevant data will be tabulated and accompanying response spectra graphs 

automatically added to the report. 

Notes: 

 Once created, the order of chapters in a report can be modified at any time by 

dragging and dropping them up and down the Report  Treeview. 
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Chapter Extent 

The extent of data that particular report chapters can report on can be specified by 

selecting one of the following options on the relevant dialog:  

 Full model - default option which reports for all elements of the model 

regardless of whether the elements are visible or displaying results in the 

Modeller view window. 

 Visible model - reports for all elements that are visible in the Modeller view 

window at the time the report is viewed. 

 Elements showing results - reports for those elements that are displaying 

results in the Modeller view window at the time the report is viewed. 

 Specified group - reports for a specified named group. Options are: Selected 

Items, Visible Items, Empty Group. 

Loadcase / Basic Combination Selection 

The loadcases, combinations or envelopes that the model properties chapter is to report 

on can be specified by selecting either: 

 <Current active loadcase name> - reports on results for this loadcase name 

only. 

 Active - reports on results for the loadcase that is active at the time the results 

are being viewed. Setting this option will allow results for different loadcases to 

be created or included in separate reports, simply by changing the Active 

loadcase in the Analyses Treeview, after each report has been created. 

 All - reports on results for all loadcases. 

 Specified - reports for a specified named loadcase. 

If multiple loadcases are specified, multiple entries will appear in the report. 

Viewing a Report 

Reports are viewed from the Report  Treeview by choosing the View Report... 

menu item from the report name context menu. By default, and after time is taken to 

assemble and format the report data, a report consisting of all the selected chapters will 

be created as a PDF file and displayed on screen if a PDF viewer is installed on the 

PC is use. 

Exporting Report Data 

Model report data may be exported to a chosen file location in a variety of formats by 

use of the Export context menu item for each report entry, as listed in the Reports  

Treeview. 
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File formats permitted include: 

 Portable Document Format (*.pdf) 

 Rich Text Format (*.rtf) 

 Microsoft Excel 97-2003 (*.xls) 

 Tab Separated Text (*.ttx) 

 Print Files (*.prn) 

Note: When the number of columns in a report become too large for a portrait view, 

use Page Setup (accessed from the Report Name context menu) to either change the 

report page margins, or to change the report page orientation to Landscape. 
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Appendix A : 

Smart 

Combination 

Examples 

  

Smart Combination Examples 

The following examples demonstrate how the different factors and settings can be 

used in smart combinations. For the purposes of these examples the results at a single 

node are going to be considered. 

 Case 1 - Considers a node where long term load effects are all negative.  

 Case 2 - Considers a node where short-term load effects are of mixed sign.  

 Case 3 - Considers a node where short-term load effects are of mixed sign with 

the “Loadcases to consider” set to four.  

 Case 4 - Considers a node where short-term load effects are of mixed sign with 

the “Loadcases to consider” set to four and the “Variable loadcases” set to four.  

 Case 5 - Considers a node where short-term load effects are of mixed sign with 

the “Loadcases to consider” set to four and the “Variable loadcases” set to one.  

Smart Combination - Case 1 

Consider a node where long term load effects are all negative.  

In this instance the beneficial and adverse load factors are considered and will be 

added together based on the nodal result being adverse. 
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Smart combination (Max) will assemble results from the loadcases using just the 

beneficial factors given for negative load effects and using adverse factors for positive 

load effects. 

 
Loadcase 

Nodal 
result 

Beneficial 
factor 

Adverse 
factor 

Factor used for 
maximum combination 

Factored nodal 
results 

Dead load -20 1.0 1.15 Beneficial -20 x 1.0 = -20 

Deck surfacing  -10 1.0 1.75 Beneficial -10 x 1.0 = -10 

Superimposed 
load 

-15 1.0 1.2 Beneficial -15 x 1.0 = -15 

    Smart combination (Max) -45 

  

Smart combination (Min) will assemble results from the loadcases using just the 

beneficial factors given for positive load effects and using beneficial + adverse factors 

for negative load effects. 

 
Loadcase 

 Nodal 
result 

 Beneficial 
factor 

 Adverse 
factor 

Factor used for 
maximum combination 

 Factored nodal 
results 

Dead load -20 1.0 1.15 Adverse -20 x 1.15 = -23 

Deck surfacing  -10 1.0 1.75 Adverse -10 x 1.75 = -17.5 

Superimposed 
load 

-15 1.0 1.2 Adverse -15 x 1.20 = -18 

    Smart combination (Min) -58.5 

Smart Combination - Case 2 

Consider a node where short-term load effects are of mixed sign.  

In this instance the beneficial and adverse load factors are considered and will be 

added together based on the nodal result being adverse. However as the permanent 

effects have been set to zero, this will only combine the results that are adverse. 

Smart combination (Max) will assemble results from the loadcases using just the 

beneficial factors given for negative load effects and using adverse factors for positive 

load effects. 
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Loadcase 

Nodal 
result 

Beneficial 
factor 

Adverse 
factor 

Factor used for 
maximum combination 

Factored nodal 
results 

Temperature -5 0 1.3 Beneficial -5 x 0 = 0 

Wind  -5 0 1.4 Beneficial -5 x 0 = 0 

Settlement -10 0 1.2 Beneficial -10 x 0 = 0 

Live load 1 -20 0 1.5 Beneficial -20 x 0 = 0 

Live load 2 -15 0 1.5 Beneficial -15 x 0 = 0 

Live load 3 10 0 1.5 Adverse 10 x 1.5 = 15 

Live load 4 -5 0 1.5 Beneficial -5 x 0 = 0 

    Smart combination (Max) = 15 

  

Smart combination (Min) will assemble results from the loadcases using just the 

beneficial factors given for positive load effects and using adverse factors for negative 

load effects. 

 
Loadcase 

Nodal 
result 

Beneficial 
factor 

Adverse 
factor 

Factor used for 
maximum combination 

Factored nodal 
results 

Temperature -5 0 1.3 Adverse -5 x 1.3 = -6.5 

Wind  -5 0 1.4 Adverse -5 x 1.4 = -7 

Settlement -10 0 1.2 Adverse -10 x 1.2 = -12 

Live load 1 -20 0 1.5 Adverse -20 x 1.5 = -30 

Live load 2 -15 0 1.5 Adverse -15 x 1.5 = -22.5 

Live load 3 10 0 1.5 Beneficial 10 x 0 = 0 

Live load 4 -5 0 1.5 Adverse -5 x 1.5 = -7.5 

    Smart combination (Min) =  -85.5 

  

Within the smart combination facility there are also two check boxes marked 

“Loadcases to consider” and Variable loadcases”. These additional options are used 

for a number of bridge design codes that require the loadcases in the combination to be 

filtered. 
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Smart Combination - Case 3 

Consider a node where short-term load effects are of mixed sign with the “Loadcases 

to consider” set to four.  

In this instance the beneficial and adverse load factors are considered and will be 

added together based on the nodal result being adverse. With the number of 

“Loadcases to consider” set to four, only the four most positive effects will be 

combined for the Max combination and the four most negative effects will be 

combined for the Min combination. 

Smart combination (Max) will assemble results from the loadcases using just the 

beneficial factors given for negative load effects and using adverse factors for positive 

load effects. The number of load effects summed is restricted to the number of 

loadcases specified. The loadcases used are the most adverse, for example the most 

positive for max combination and all other load effects assembled are discarded. 

 
Loadcase 

Nodal 
result 

Beneficial 
factor 

Adverse 
factor 

Factor used for 
maximum combination 

Factored nodal 
results 

  

Temperature -5 0.7 1.5 Beneficial -5 x 0.7 = -3.5 Used 

Wind  -5 0.7 1.5 Beneficial -5 x 0.7 = -3.5 Used 

Settlement -10 0.7 1.5 Beneficial -10 x 0.7 = -7 Not 
used 

Live load 1 -20 0.7 1.5 Beneficial -20 x 0.7 = -14 Not 
used 

Live load 2 -15 0.7 1.5 Beneficial -15 x 0.7 = -10.5 Not 
used 

Live load 3 10 0.7 1.5 Adverse 10 x 1.5 = 15 Used 

Live load 4 -5 0.7 1.5 Beneficial -5 x 0.7 = -3.5 Used 

    Smart combination (Max) =  4.5   

  

Smart combination (Min) will assemble results from the loadcases using just the 

beneficial factors given for positive load effects and using adverse factors for negative 

load effects. The number of load effects summed is restricted to the number of 

loadcases specified. The loadcases used are the most adverse, for example the most 

negative for min combination and all other load effects assembled are discarded. 
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Loadcase 

Nodal 
result 

Beneficial 
factor 

Adverse 
factor 

Factor used for 
maximum combination 

Factored nodal 
results 

  

Temperature -5 0.7 1.5 Adverse -5 x 1.5 = -7.5 Used 

Wind  -5 0.7 1.5 Adverse -5 x 1.5 = -7.5 Not 
used 

Settlement -10 0.7 1.5 Adverse -10 x 1.5 = -15 Used 

Live load 1 -20 0.7 1.5 Adverse -20 x 1.5 = -30 Used 

Live load 2 -15 0.7 1.5 Adverse -15 x 1.5 = -22.5 Used 

Live load 3 10 0.7 1.5 Beneficial 10 x 0.7 = 7 Not 
used 

Live load 4 -5 0.7 1.5 Adverse -5 x 1.5 = -7.5 Not 
used 

    Smart combination (Min) =  -75   

Smart Combination - Case 4 

Consider a node where short-term load effects are of mixed sign with the “Loadcases 

to consider” set to four and the “Variable loadcases” set to four.  

In this instance the beneficial and adverse load factors will only be considered for the 

number of loadcases specified as the number of Variable loadcases to consider. The 

factors will be added together based on the nodal result being adverse. With the 

number of “loadcases to consider” set to four, only the four most positive effects will 

be combined for the Max combination and the four most negative effects will be 

combined for the Min combination. However by setting the “variable loadcases”, only 

positive results will be considered for the Max combination and negative results for 

the Min combination.  

Smart combination (Max) will assemble results from the loadcases using just the 

beneficial factors given for negative load effects and using adverse factors for the 

number of positive load effects specified by the number of Variable loadcases to 

consider. The remaining positive load effects will only use the beneficial factor. The 

number of load effects summed is restricted to the number of loadcases specified and 

the other loads are discarded. The loadcases used are the most adverse, for example, 

the most positive are used for a maximum combination and all other load effects 

assembled are discarded. Also with the variable loadcases set to four the max 

combination will include only positive load effects, all negative load effects are 

discarded. 
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Loadcase 

Nodal 
result 

Beneficial 
factor 

Adverse 
factor 

Factor used for 
maximum combination 

Factored nodal 
results 

  

Temperature -5 0.7 1.5 Beneficial -5 x 0.7 = -3.5 Not 
used 

Wind  -5 0.7 1.5 Beneficial -5 x 0.7 = -3.5 Not 
used 

Settlement -10 0.7 1.5 Beneficial -10 x 0.7 = -7 Not 
used 

Live load 1 -20 0.7 1.5 Beneficial -20 x 0.7 = -14 Not 
used 

Live load 2 -15 0.7 1.5 Beneficial -15 x 0.7 = -10.5 Not 
used 

Live load 3 10 0.7 1.5 Adverse 10 x 1.5 = 15 Used 

Live load 4 -5 0.7 1.5 Beneficial -5 x 0.7 = -3.5 Not 
used 

    Smart combination (Max) =  15   

  

Smart combination (Min) will assemble results from the loadcases using just the 

beneficial factors given for positive load effects and using adverse factors for negative 

load effects for number of negative load effects specified by the number of Variable 

loadcases to consider the remaining negative load effects will only use the beneficial 

factor. The number of load effects summed is restricted to the number of loadcases 

specified and the other loads are also discarded. The loadcases used are the most 

adverse, for example the most negative for min combination and all other load effects 

assembled are discarded. Also with the variable loadcases set to four the min 

combination will include only negative load effects, all positive load effects are 

discarded. 
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Loadcase 

Nodal 
result 

Beneficial 
factor 

Adverse 
factor 

Factor used for 
maximum combination 

Factored nodal 
results 

  

Temperature -5 0.7 1.5 Adverse -5 x 1.5 = -7.5 Used 

Wind  -5 0.7 1.5 Beneficial -5 x 0.7 = -3.5 Not 
used 

Settlement -10 0.7 1.5 Adverse -10 x 1.5 = -15 Used 

Live load 1 -20 0.7 1.5 Adverse -20 x 1.5 = -30 Used 

Live load 2 -15 0.7 1.5 Adverse -15 x 1.5 = -22.5 Used 

Live load 3 10 0.7 1.5 Beneficial 10 x 0.7 = 7 Not 
used 

Live load 4 -5 0.7 1.5 Beneficial -5 x 1.5 = -7.5 Not 
used 

    Smart combination (Min) =  -75   

Smart Combination - Case 5 

Consider a node where short-term load effects are of mixed sign with the “Loadcases 

to consider” set to four and the “Variable loadcases” set to one. The beneficial 

+ adverse load factors will only be considered for the number of loadcases specified as 

the number of Variable loadcases to consider. The remaining three loadcases are 

considered using the beneficial factor. With the number of “loadcases to consider” set 

to four, only the four most positive effects will be combined for the Max combination 

and the four most negative effects will be combined for the Min combination. 

However by setting the “variable loadcases” only positive results will be considered 

for the Max combination and negative results for the Min combination.  

Smart combination (Max) will assemble results from the loadcases using just the 

beneficial factors given for negative load effects and using adverse factors for number 

of positive load effects specified by the number of Variable loadcases to consider the 

remaining positive load effects will only use the beneficial factor. The number of load 

effects summed is restricted to the number of loadcases specified and the other loads 

are also the discarded. The loadcases used are the most adverse, for example the most 

positive for max combination and all other load effects assembled are discarded. Also 

with the variable loadcases set to one the max combination will include only positive 

load effects, all negative load effects are discarded. 
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Loadcase 

Nodal 
result 

Beneficial 
factor 

Adverse 
factor 

Factor used for 
maximum combination 

Factored nodal 
results 

  

Temperature -5 0.7 1.5 Beneficial -5 x 0.7 = -3.5 Not 
used 

Wind  -5 0.7 1.5 Beneficial -5 x 0.7 = -3.5 Not 
used 

Settlement -10 0.7 1.5 Beneficial -10 x 0.7 = -7 Not 
used 

Live load 1 -20 0.7 1.5 Beneficial -20 x 0.7 = -14 Not 
used 

Live load 2 -15 0.7 1.5 Beneficial -15 x 0.7 = -10.5 Not 
used 

Live load 3 10 0.7 1.5 Adverse 10 x 1.5 = 15 Used 

Live load 4 -5 0.7 1.5 Beneficial -5 x 0.7 = -3.5 Not 
used 

              

    Smart combination (Max) =  15   

  

Smart combination (Min) will assemble results from the loadcases using just the 

beneficial factors given for positive load effects and using adverse factors for negative 

load effects for number of negative load effects specified by the number of Variable 

loadcases to consider the remaining negative load effects will only use the beneficial 

factor. The number of load effects summed is restricted to the number of loadcases 

specified and the other loads are discarded. The loadcases used are the most adverse, 

for example the most negative for min combination and all other load effects 

assembled are discarded. Also with the variable loadcases set to one the min 

combination will include only negative load effects, all positive load effects are 

discarded. 



  Appendix A : Smart Combination Examples 

    

791 

 
Loadcase 

Nodal 
result 

Beneficial 
factor 

Adverse 
factor 

Factor used for 
maximum combination 

Factored nodal 
results 

  

Temperature -5 0.7 1.5 Beneficial -5 x 0.7 = -3.5 Used 

Wind  -5 0.7 1.5 Beneficial -5 x 0.7 = -3.5 Not 
used 

Settlement -10 0.7 1.5 Beneficial -10 x 0.7 = -7 Used 

Live load 1 -20 0.7 1.5 Adverse -20 x 1.5 = -30 Used 

Live load 2 -15 0.7 1.5 Beneficial -15 x 0.7 = -10.5 Used 

Live load 3 10 0.7 1.5 Adverse 10 x 1.5 = 15 Not 
used 

Live load 4 -5 0.7 1.5 Beneficial -5 x 0.7 = -3.5 Not 
used 

              

    Smart combination (Min) =  -51   
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Appendix B : 

LUSAS Solver 

Trouble Shooting 

  

LUSAS Solver Troubleshooting 

During an analysis, warning and error messages may appear in the LUSAS Solver 

output file. An error message will terminate the solution immediately. A warning 

message will attempt to continue the analysis. The most common warning and error 

messages are: 

 Negative Jacobian (Error) 

 Diagonal Decay (Warning) 

 Small Pivot (Warning) 

 Negative Pivot (Warning) 

 Zero Pivot (Error) 

A description of these Warning and Error messages follows. 

Negative Jacobian Errors 

A Jacobian determinant is a measure used to give an accurate value of the current area 

or volume of an element. A magnitude of less than or equal to zero will automatically 

invoke this message and may be a result of one of the following: 

 Incorrect definition of the 2D continuum and plate elements 
 

By design, LUSAS requires these element types to have an anti-clockwise 

node numbering sequence. The order is controlled from the underlying surface 
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feature in which the element resides. If this message is output, the solution is to 

reverse the ordering of the surfaces for the elements having these warning 

messages output. Do this in LUSAS Modeller with the Geometry> Surface> 

Reverse menu item. 

 

Note that, in LUSAS Modeller, the local axis system of the surface may be 

viewed prior to tabulation - the xy axis system displayed on each surface 

represents a right handed axis system, from which the anti-clockwise (or 

positive qz definition may be checked). 

 Too large a loading increment causing massive deformation of one or more 

elements 

This means that the elements are inverting. Note that this is only applicable for 

nonlinear analyses 

Diagonal Decay Warnings 

The stiffness matrix is a crucial component in a finite element analysis, but it can be 

poorly conditioned. Poor conditioning may result in round-off error, which is a loss of 

accuracy in the evaluation of the terms during the reduction process of the solution. 

This in turn leads to inaccuracies in the predicted displacements and stresses. 

LUSAS monitors the round-off error by evaluating the amount of diagonal decay 

present during the Gaussian reduction process. This criterion is based on the 

assumption that initially large diagonal terms accumulate errors proportional to their 

size. As reduction progresses, the diagonal term is reduced, amplifying the errors until 

they become a maximum when the diagonal term is the pivot. An indication of 

probable errors may be obtained by examining the change in magnitude of the 

diagonal term. 

The tolerance threshold above which a diagonal decay warning is output is actually 

quite conservative (controlled by a system variable DECAYL, default = 0.1E5). 

Although a check would always be recommended for any Warning of this description, 

significant effects are not generally expected until the decay reaches a value of 0.1E8 

or greater. 

Poor conditioning of the stiffness matrix occurs because of large variations in the 

magnitude of diagonal stiffness terms and may be due to: 

 Large stiff elements being connected to small less stiff elements. An 

example may be where a stiff beam element is being used to transfer load into 

the structure. The stiffness of the beam would need to be reduced - typically, 

the beam would only need to be 1000 times the stiffness of the local elements. 

 Elements with highly disparate stiffnesses, e.g. a beam element may have a 

bending stiffness that is orders of magnitude less than it's axial stiffness. 
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For instance, the cantilever beam problem is notoriously problematic with 

respect to ill-conditioning because of the potential for large differences between 

the axial and shear/rotational stiffness components. A typical stiffness matrix 

might be 

 

The longer the beam, the greater the difference between  and . 

 

Potential data input mistakes leading to poor conditioning 

Poor conditioning may be as a result of deliberate modelling strategy but, more 

usually, an error in one or more of the following data input areas: 

 Mesh description - typical mistakes: 

 The aspect ratio of some elements is greater than the recommended 

limits (see the corresponding element section in the Element Reference 

Manual for further information). An ideal value is 1:1. however, values 

up to 1:10 are reasonable. Depending on the results required, this value 

may be increased still further (a test run would be recommended first). 

This problem is indicated by the WARNING message: "Unreasonably 

distorted element..." The only exception is explicit dynamic elements 

which do require aspect ratios of 1:1. 

 Some element shapes are too distorted (see the corresponding element 

section in the Element Reference Manual for further information). 

 Geometric properties - typical mistakes: 

 Omission of values for any shear area parameters in the geometric 

properties for beams 

 Omission of values for other important properties, such as the torsional 

constant or thickness 

 Defining incompatible 1st and 2nd moment section properties for 

beams 

 Material properties - typical mistakes: 

 Different units used to define the nodal coordinates and the material 

properties. 

 Incorrect nonlinear material parameters (yield stress and hardening 

values particularly) 
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 Inconsistent units throughout the model. 

 Incorrect definition of orthotropic properties. The inequalities given in 

the appropriate element section of the theory manual need to be adhered 

to. Numerical instabilities may result when the material 

characterisations approach their limits (see Notes on material 

properties orthotropic for a list of these inequalities). 

 Support nodes - typical mistakes: 

 The structure has not been restrained against free body translation and 

rotation. 

Each of the above suggestions are of interest because they make a contribution to the 

stiffness matrix. 

A further possibility is that the LUSAS Modeller model geometry is invalid because 

the element mesh contains gaps or has discontinuities in the connection of the 

elements. Such modelling problems may be found in LUSAS Modeller by: 

 Using the Mesh layer to view only the outline of the mesh. The view 

will show lines wherever a discontinuity occurs. 

 Using the Labels layer to draw the node numbers onto the mesh to see 

if any node numbering is overwriting at any point (indicating two nodes 

at the same point). Correction would normally require either a merging 

or an equivalencing operation. 

The diagonal decay message is closely related to the small pivot WARNING message 

(see below). See also the additional notes in the Theory Manual regarding the 

Gaussian solution method. 

Small Pivot Warnings 

See the section titled Diagonal decay warnings. 

Negative Pivot Warnings And Errors 

A negative pivot could be the result of poor conditioning so make sure you have seen 

the section titled Diagonal decay warnings. However, a well conditioned stiffness 

matrix can produce a negative pivot if: 

 The system is unstable- an unstable structure could be passing through a 

bifurcation or limit point, as shown in the following diagram: 
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Such a bifurcation point could permit another, non-physical, solution path to be 

followed because, numerically, it requires less energy. 

Every negative pivot warning occurring in the LUSAS output file represents a 

bifurcation point. A negative CSTIF value, together with a negative PIVMIN 

value corresponds to a limit point but a positive CSTIF and a negative 

PIVMIN correspond to a bifurcation point (although this is only the first one 

located in each case since limit points are detected by a change in sign of the 

slope of the force displacement curve). See The nonlinear logfile. 

A negative pivot sometimes occurs during the iterative solution (indicating that 

the load step may be too big) but disappears when the solution has converged. 

If negative pivots occur and the solution will not converge then first try 

reducing the load step. 

If the solution still does not converge, a limit or bifurcation point may have 

been encountered and the solution procedure may need to be changed. Running 

the problem under arc-length control gives the best chance of negotiating a 

limit or bifurcation point. A load limit point can also be overcome by using 

prescribed displacement loading. 

 The system is not adequately restrained - for example when using a 3D beam 

in a 2D analysis. 

 Mechanism has been excited - This is a further possibility when reduced 

integration is used. The use of Option 18 will normally solve this problem. If 

the problem persists, continue with the use of the option but refine the mesh 

further. 

 

A count of the number of negative pivots is given in the LUSAS log file (parameter 

NSCH). Initially NSCH = 0 since, initially, a stable path is assumed. When NSCH = 1, 

an unstable point (limit or bifurcation) has been reached, PIVMN will give the value of 

the minimum pivot at this point. 
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Notes 

 The use of LUSAS Option 62 is not recommended until all other checks have 

been carried out to ensure model integrity. 

 Before modifying the solution procedure to arc-length, the checklist given in 

the section above on small pivots should be checked. 

Zero Pivot Errors 

LUSAS uses a Gaussian reduction solution technique to solve the finite element 

equations. This technique requires the structure stiffness matrix to be non-singular. 

This means that for static analyses the structure, or any components of the structure, 

must not permit any rigid body displacements or rotations. Failure to comply with this 

criterion will result in a zero pivot message. 

The error message includes the node and variable number that may be affected by the 

poor conditioning - these variables should be investigated in the model. Typical 

mistakes can include: 

 Omission of a support condition in one or more of the rigid body directions for 

the structure. 

 Insufficient additional restraint when connecting a beam element to a 

continuum element. In this case a rigid body torsional spin about the axis of the 

beam may occur. 

 Six degrees of freedom have been specified for a thick shell element, but the 

drilling rotation has not been correspondingly restrained. 

 Insufficiently large slideline interface stiffness coefficients allowing the two 

bodies to pass through each other as rigid bodies. The load increment may also 

be too large. 

 Incorrect nonlinear material parameters, such as a zero yield stress. 

 Joint elements may require investigation as the stiffnesses operate in local 

directions and can be easily defined incorrectly - as a result, the joint 

stiffnesses will not be providing support in the required directions. 

 There may be totally or partially unconnected elements within the structure as 

a result of incomplete merging or equivalencing of the model.  

Other Warnings 

Other warnings that may be found in the LUSAS output file include: 

 Aspect ratios warnings - See the appendix on element restrictions in the 

Element Reference Manual for more information. 
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 Excessive curvature for beams warnings - See the appendix on element 

restrictions in the Element Reference Manual for more information. 

 

Notes On Orthotropic Material Properties 

For orthotropic material models the D matrix must be symmetric and a number of 

further relations must also be satisfied: 

Material properties orthotropic (e.g., QPM4) 

To maintain symmetry:  

nyx = nxy * Ey/Ex 

and to obtain a valid material: 

nxy < (Ex/Ey)1/2 

This applies to Fourier elements as a special case to simulate a bladed 

structure. 

Material properties orthotropic plane strain (e.g. QPN4).  

Ey * (nxy*Ez + nyz*nxz*Ex) = Ex * (nxy*Ez + nxz*nyz*Ey) 

Material properties orthotropic axisymmetric (e.g. QAX4).  

To maintain symmetry: 

nyx = nxy * Ey/Ex 

nzx = nzx * Ez/Ex 

nzy = nyz * Ez/Ey 

and to obtain a valid material: 

nxy < (Ex/Ey)½ 

nxz < (Ex/Ez)½ 

nyz < (Ey/Ez)½ 

Material properties orthotropic solid (e.g. HX8, QSL8).  

To maintain symmetry: 

nyx = nxy * Ey/Ex 

nzx = nxz * Ex/Ez 

nzy = nyz * Ez/Ey 
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and to obtain a valid material: 

nxy < (Ex/Ey)½ 

nxz < (Ex/Ez)½ 

nyz < (Ey/Ez)½ 

Material properties orthotropic thick (e.g. QSC4).  

To maintain symmetry: 

nyx = nxy * Ey/Ex 

and to obtain a valid material: 

nxy < (Ex/Ey)½ 

Notes 

 Option 16 can be used to override non-convergence as a result of poor 

conditioning. When Option 16 is specified and an increment has failed to 

converge within the maximum number of iterations allowed, LUSAS assumes 

convergence, writes the output/plot file results, and then continues with the 

next increment. Load step reductions can also be suppressed via the STEP 

REDUCTION section under the NONLINEAR CONTROL data chapter. 

Using these procedures may help to locate the source of the problem when 

investigating an unconverged configuration in the LUSAS Modeller post-

processor. 

 A pivot refers to the diagonal element of the upper triangular matrix that is 

formed after elimination has been completed. Note that in the frontal solution 

these pivots are computed as soon as all the relevant equations have been 

assembled. 

 Computation of det(K) as part of a nonlinear solution scheme is not necessary 

since a count of the number of negative pivots (NSCH in the log file) together 

with the value of PIVMN gives all the information required. 

 A zero pivot implies that det(K)=0. 

 If NSCH=2 then another unstable point has been reached and implies that 

det(K)>0. 

Eigenvalue Analysis: Troubleshooting 

It is good practice to perform a linear static analysis prior to the eigenvalue analysis. 

This eliminates the added complexities of the dynamic variables and will enable a 

check on the basic stiffness matrix for the structure. Any warning or error messages in 

the LUSAS output file (such as zero, negative or small pivots) should be investigated.  
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In the event of problems occurring after completing the linear static and the eigenvalue 

analysis consider some of the more common queries and their typical solutions as 

listed below.  

Eigenvalues are missing 

A Sturm sequence check is performed by default to indicate the number of modes 

which may be missing. 

 Check for Warnings or Errors Check the output file for any other warnings 

or errors. There may be diagonal decay or pivot warnings that will indicate 

node and element numbers and help to identify any suspect areas of the mesh. 

 Iteration Vectors Increase the number of starting iteration vectors. If any of 

the modes are close together, the default magnitude for this parameter may not 

be sufficient to allow accurate resolution in their extraction. 

 Convergence Tolerance Tighten the convergence tolerance since, again, some 

modes may be close together. This would normally also require an increase in 

the number of iterations permitted. 

 Convergence Achieved Ensure the solution converged correctly. If not, then 

increase the number of iterations permitted. 

 Mesh Refinement Increase the mesh refinement of the model in order to 

increase the number of degrees of freedom in the structure to simulate all the 

modes expected. 

 Symmetry Taking advantage of symmetry in an eigenvalue analysis may cause 

the inadvertent omission of several eigenvalues as a result of the corresponding 

symmetry supports restraining certain non-symmetric eigenmodes. 

 Increase Shift If a shift has been used to eliminate rigid body motions when 

analysing unsupported structures, then it may be that the value used is 

insufficient. The solution is typically not overly sensitive to changes in this 

parameter and, therefore, any changes tried should be in terms of orders of 

magnitude. 

 Constraint Equations If constraint equations have been defined in the problem 

the Sturm sequence check may prove unreliable. This is a limitation of the 

Lagrange multiplier technique used in LUSAS. 

 

The Solution Did Not Converge 

 Check for Warnings or Errors Check the output file for any other warnings 

or errors. There may be diagonal decay or pivot warnings that will contain node 

and element numbers, and help identify any suspect areas of the mesh. 

 Iteration Vectors Increase the number of starting iteration vectors. If any of 

the modes are close together, the default magnitude for this parameter may not 
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be sufficient to allow accurate resolution in their extraction. Increasing this 

parameter is also essential if only requesting a small number of eigenvalues (1-

2). Ten iteration vectors would be a reasonable starting value for such a 

situation. This parameter is not used for Lanczos extraction. 

 Convergence Tolerance The convergence tolerance criteria may be too tight - 

try slackening this criteria. This would normally also require an increase in the 

number of iterations permitted. 

 Increase Shift If a shift has been used to eliminate rigid body problems when 

analysing unsupported structures, then it may be that the value used is not 

sufficient. The solution is typically not overly sensitive to changes in this 

parameter and, therefore, any changes tried may be in terms of orders of 

magnitude. 

 

Negative Eigenvalues Are Calculated 

 Check for Warnings or Errors Check the output file for any other warnings 

or errors. There may be diagonal decay or pivot warnings that will indicate 

node and element numbers and help to identify any suspect areas of the mesh. 

 Iteration Vectors Increase the number of starting iteration vectors. If any of 

the modes are close together the default magnitude for this parameter may not 

be sufficient to allow accurate resolution in their extraction. Increasing this 

parameter is also essential if only requesting a small number of eigenvalues (1-

2). Ten iteration vectors would be a reasonable starting value for such a 

situation. 

 Convergence Achieved Ensure that the solution converged correctly. If not, 

then increase the number of iterations permitted. 

 Convergence Tolerance Tighten the convergence tolerance, since some modes 

may be close together and require greater numerical resolution. This may also 

require an increase in the number of iterations permitted. 

 Reduce Load Level Reduce the load applied to ensure that it is below the 

lowest expected buckling mode of the structure. A negative eigenvalue in a 

buckling analysis could also simply mean that the applied loading is in the 

opposite direction to that which would cause buckling; e.g. a strut subjected to 

tensile load instead of compression. 

 Alternative Buckling QSL8 elements have given negative eigenvalues for thin 

structures and resulted in negative projected mass errors. The remedy is to use 

the alternative buckling algorithm where positive eigenvalues should be 

obtained. This is always the case except when the buckling load factor is less 

than unity. Adjust the load level to ensure that all the load factors are greater 

than 1 if this occurs. Additionally, use Option 18 (fine integration rule for the 

element) to overcome the excitation of any element mechanisms. 
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Why Loading is Ignored in an Eigenvalue Analysis 

In a standard eigenvalue analysis, the loading will be ignored completely. For a linear 

analysis, once the eigen-pairs have been obtained, the stress distribution s for each 

mode shape F is evaluated using: 

s = D * B * F 

where D and B are the elastic constitutive and strain-displacement matrices 

respectively.  

The reason that the forces have no effect on the vibrational behaviour is because the 

loading conditions in a linear analysis do not affect the D or B matrices. To include 

their effects, a nonlinear D and B matrix must be evaluated prior to the eigen analysis. 

This is achieved by performing a static nonlinear analysis (with a geometrically 

nonlinear option) followed by an eigenvalue analysis. In this way the effects of the 

loads are included via the updated B matrix (and D matrix if a nonlinear material has 

been specified). 
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Appendix C : 

Model Selection 

and Viewing 

Shortcuts 

  

Keyboard Shortcuts 

Selecting Model Features 

Features displayed in the View window may be selected using either specific cursors 

or by using normal cursor mode in conjunction with specific keys.  

Feature / Mesh Object Selection Options 

Hold the key shown down when using the left mouse button.  

Specific cursor  = Normal cursor + key 

  

  Select geometry (any feature type)  

  

=  + G key 

  Point selection  =  + P key 

  Line selection  =  + L key 

  Surface selection  =  + S key 
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  Volume selection  =  + V key 

  Mesh selection =  + M key 

  Node selection =  + N key 

  Edge selection (displayed for 

mesh-only models only) 

=  + B key 

  Face selection =  + F key 

  Element selection  =  + E key 

  Annotation selection  =  + A key 

Note. Key shortcuts can be used to override specific cursor selections. 

Planar selection options 

These can be used to define planes in which, or axes along which features can be 

selected. When used in isolation all features/objects in a chosen axis or plane will be 

selected within a cursor selection. When a planar option is set prior to using the 

previously mentioned Feature/Mesh Object Selection option individual points or lines 

or elements etc can be selected within the axis or plane chosen.  

Axes and planes are defined by model view axes and the model vertical axis. 

Specific cursor  = Notes 

  

  Select Any 

 

Selects any features/objects within the selection 
made 

  Select Vertical only 
Select features/objects that are vertical with respect 

to the model vertical axis 

  Select Horizontal only  
Select features/objects that are horizontal with 
respect to the model vertical axis 

  Select X axis only 
Select features/objects in the X direction only with 

respect to the model vertical axis and in relation to 

any active local coordinate set 

  Select Y axis only only 
Select features/objects in the Y direction only with 

respect to the model vertical axis and in relation to 

any active local coordinate set 

  Select Z axis only 
Select features/objects in the Z direction only with 

respect to the model vertical axis and in relation to 

any active local coordinate set 
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  Select XY plane only 
Select features/objects that are in the XY plane with 
respect to the model vertical axis and in relation to 

any active local coordinate set 

  Select YZ plane only 
Select features/objects that are in the YZ plane with 
respect to the model vertical axis and in relation to 

any active local coordinate set 

  Select XZ plane only 
Select features/objects that are in the XZ plane with 
respect to the model vertical axis and in relation to 

any active local coordinate set 

 

Area Selection Options 

Rectangular, circular, or polygonal areas can be selected by using specific area toolbar 

buttons or by using normal cursor mode with a specific key: 

Specific cursor  = Normal cursor + key 

  

  Click and drag the cursor to the 

opposite diagonal corner. 

  

=  

  Click the centre of the circle and 

drag the cursor to the required radius. 

=   + C key 

  Click each corner of a polygon and 

either double click to close the polygon 

or select Close Polygon from the context 

menu.  

=   + X key 

 

For a rectangular area selection, the default behaviour is to select items that are wholly 

within a selection box regardless of whether left-to-right or right-to-left movement of 

the cursor has taken place when selecting the extents. A right-to-left definition of 

extents can be optionally set to select all features crossed by the selection box (as often 

used by CAD software). 

Cumulative selection 

Note that cursor selection options are cumulative, so it is possible, for example, to 

make a rectangular selection, of only all the vertical surfaces within a model. This 

would be achieved by selecting the   Select Vertical only toolbar button, prior to 

either selecting the   Surface selection toolbar button, or selecting the  

Rectangle Select toolbar button whilst holding down the S key to limit the selection to 

just Surfaces. 
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Memory shortcuts 

After features have been selected: 

Ctrl + M key = Set selected items into Selection Memory 

Selection Modifiers for All Cursors 

Features displayed in the View window may be added to, or removed from, any initial 

selection using these selection modifers: 

Shift key = Add to current selection 

Ctrl key = Toggle (include /exclude selection) 

Ctrl + Shift key = Remove from current selection 

Tab key = Cycle (items at the same location) 

Shift + Tab key = Cycle previous 

Alt key = Intersect mode. By default all items completely enclosed in a selected area 

will be selected. By holding down the Alt key, items intersecting the selection 

perimeter will also be selected. The Alt key may be used with, or independently from, 

the Shift or Ctrl keys. The Alt key can also be used with feature selection shortcuts 

e.g. Alt + Shft + L adds lines to the current selection. 

Alt + Return key = Display properties of item 

'Datatip' + Return key = Adds current item to selection 

Mapping of Keyboard Modifiers for Cursor and Area 

Selection 

The Cursor drop-down menu contains a Keyboard Mapping... menu item which 

allows the default Windows-based cursor and area selection keyboard modifiers to be 

changed to suit those that are generally used with CAD modelling systems or be user-

defined. For more information see Selection of model features. 

Browsing Selected Features 

Items in the current selection may be viewed in the Selection panel which can be 

displayed from the View> Selection Panels menu. This window can also be triggered 

by a right mouse button click in the Selected area of the status bar at the bottom of the 

Modeller user interface, or by right-clicking in a View window. Selected features can 

be deselected and reselected as necessary from those listed. 
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Model Viewing Shortcuts 

The model can be rotated, zoomed, panned, and viewed at predefined orthogonal and 

non-orthogonal views using specific cursors or view buttons, or by using normal 

cursor mode in conjunction with specific keys, that are described here. Rotation, zoom 

and pan can also be carried out in other cursor input modes such as when defining 

lines by cursor or section slicing for example. 

Dynamic Pan (Drag) 

Specific cursor  = Normal cursor + key 

  

  Hold down the left mouse button to 

pan the model. 

  

=  + D key 

=  + Middle mouse button 

Note. Hold down the key(s) to restrain the pan for either specific or normal cursor 

mode about the axis stated: 

X or Shift key = Restrain in the screen X axis  

Y or Ctrl key = Restrain in the screen Y axis 

Dynamic Rotation 

Specific cursor  = Normal cursor + key 

  

  Rotates the model around various 

multiple axes. 

  

  

=  + R key 

=  + Middle + Left or  Right mouse 

button 

Note. The model is rotated about its centre unless any part of the model is selected in 

which case the model is rotated about the centre of the selection. Hold down the key(s) 

to restrain rotation about the axis stated: 

X or Shift key = Restrain in the screen X axis  

Y or Ctrl + Shift keys = Restrain in the screen Y axis 

Z or Ctrl key = Restrain in the screen Z axis  
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Dynamic Zoom 

Specific cursor  = Normal cursor + key 

  

 Hold down the left mouse button 

and move the mouse. 

  

=  + Scroll mouse wheel 

=  + Z key 

Note. If any part of the model is selected it is used as the centre of the zoom. 

Zoom 

  Drag a box around the region to be enlarged or click the left mouse button to 

zoom in progressively with each click. 

Ctrl key = Zoom out (when held at same time) 

Note. The cursor position dictates the centre of the zoom. 

Orthogonal Model Views 

These buttons are located in the status bar. 

  = View along the +X axis towards the origin 

  = View along the +Y axis towards the origin 

  = View along the +Z axis towards the origin 

Any of the views along these axes can be modified by using these key sequences 

which select an alternative view orientation: 

Shift key +  = View along the -X axis towards the origin  

Ctrl key +  = View along the -Y axis towards the origin 

Ctrl + Shift key +  = View along the -Z axis towards the origin 

Equivalent toolbar buttons for these view shortcuts can be found on the customisable 

toolbar dialog or by clicking the right mouse button on the orthogonal model view 

buttons. 

Non-Orthogonal Model Views 

  = Isometric view 



  Appendix C : Model Selection and Viewing 
Shortcuts 

    

811 

Ctrl key +  = Reverse isometric view 

  = Dimetric view 

Ctrl key +  = Reverse dimetric view 

  = Trimetric view 

Ctrl key +  = Reverse trimetric view 

Useful Windows Shortcuts 

The following standard Windows shortcuts are useful when creating and printing 

models in LUSAS Modeller: 

Ctrl key + N key  = New 

Ctrl key + O key = Open 

Ctrl key + S  key = Save 

Ctrl key + P  key = Print 

Ctrl key + A  key = Select all items 

Ctrl key + C  key = Copy 

Ctrl key + X  key = Cut (for text only) 

Ctrl key + V  key = Paste 

Ctrl key + Z  key = Undo 

F2 key = Rename (when name is selected)  

F5 key = Redraw / Refresh 
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Appendix D : Real 

Numbers and 

Expressions in 

LUSAS 

  

Expressions and Functions Supported 

Expressions may be entered anywhere in LUSAS Modeller where numbers may be 

input. For example, in point definition, it is possible to enter 3+10, 4*6, and 5-1 as 

valid co-ordinates. All arithmetic operators including braces are available, as well as 

the standard trigonometry functions sin, cos, log etc. This facility is available in all 

text entry fields throughout the Modeller user interface. 

The following functions are supported: 

Arithmetic 

(A), -A, A+B, A-B, A*B, A/B, A^B, ceil(A), floor(A), 

abs(A), max(A, B, C...), min(A, B, C...), sum(A, B, 

C...) average(A, B, C...) ,pow(val, exp), mod(val, div) 

Trigonometric 

sin, cos, tan, asin, acos, atan, sinh, cosh, tanh, 

sind, cosd, tand, asind, acosd, atand, atan2, atan2d 

Mathematical 

exp, log, log10, sqrt, ceil, floor, abs, 
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Logical 

A > B, A < B, A = B, not(A), and(A, B), or(A, B), 

boolEq(A, B), boolNE(A, B), gt(A, B), ge(A, B), lt(A, 

B), le(A, B), eq(A, B), ne(A, B), if (condition, then, 

else) 

Other 

radians(angle) Converts an angle entered in degrees into an angle 

in radians 

degrees(angle) Converts an angle entered in radians into an angle 

in degrees 

sign()  Returns 1 for positive numbers, 0 for zero and -1 

for negative numbers. 

convertFromSI  Takes two arguments. The first can be any 

expression. The second is assumed to be a packed 

integer, which within LUSAS can come from the 

standard KSharedEnum implementation, or 

alternatively from the new packDimension() 

function below. The input value will be converted 

from “N,m,kg,s,C” into model units. 

case() Takes any number of arguments, assumes that the 

last argument is an error condition, and that all 

other arguments are in pairs of condition and 

value. If the first condition is true, the first value 

will be returned, otherwise control passes to the 

second condition – and so on until the last 

argument, which will be returned when none of the 

conditions is met. 

error() Takes only one argument, which may be a string or 

an integer error code – i.e. x = error(“text to 

describe the error”) or x = error(12345). In 

practice, the function never returns a value – 

instead it stops execution of the current expression, 

and stores the given message / error code. At the 

end of drawing the screen / preparing the report / 

etc, Modeller checks to see if any errors have been 

stored, and if so displays them to the user. 

none() Takes no arguments. In practice, the function never 

returns a value – instead it stops execution of the 

current expression, and prevents the program 

displaying any results for the current location. 
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isNumber() Takes one argument. It returns 'true' if the only 

argument is a valid number. It returns 'false' in 

response to any numerical error, such as 

isNumber(log(-1)) or isNumber(none()). 

isDefined() Takes one argument. It returns 'true' if the only 

argument is a valid variable name. E.g. 

isDefined(“displacement.DX”) is true, whilst 

isDefined(“displacement.DZ”) would return 'false' 

in a 2d analysis. 

member.parametric() 

parent.parametric()  

A parametric distance is given along the parent 

line, which enables the program to indentify an 

element. The parametric distance is converted to a 

parametric distance along that element, and then 

the element is asked to return the value of the 

given named value. E.g. member.parametric(0.5, 

“My”) returns the mid-span bending moment for a 

line. If the parent line belongs to a combined line, 

then the member variant treats the parametric 

distance as parametric within that combined line. If 

the parent line does not belong to a combined line, 

the two functions return the same result. 

member.max() 

member.min() 

parent.max() 

parent.min() 

These simply loop all the elements along the parent 

/ member and return the numerically largest or 

smallest number encountered. 

lookup()  Takes three arguments. The first argument is the 

name of a table of values, which must be attached 

to an attribute assigned to the element in question. 

The second and third arguments are simple indices 

into this table. For example, 

lookup(geometric.myTable, 2, 3) returns the value 

at location (2,3) in the variable “myTable” which 

must be in the geometric attribute assigned at the 

node, element node, gauss point, or internal 

calculation point, depending upon which has been 

selected. 

packDimension()  converts simple separate integers into the packed 

integer required for the convertFromSI function. 

E.g. stressUnit = packDimension(1,-2,0,0,0) means 

“force / area”. 

interp()  Takes 7 arguments. The first argument is the name 

of a table of values. The second argument is the 
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name of a vector of row header values, in which to 

search for the third argument. Similarly, the fifth 

argument is the name of a vector of column header 

values, in which to search for the sixth argument. 

The fourth and last arguments are mode switches 

for row and column respectively. A mode of 0 

requires an exact match. A mode of 1 returns the 

nearest match. A mode of 2 returns an exact match 

if possible, but otherwise the highest value which 

is smaller than the given value. A mode of 3 

returns an exact match if possible, but otherwise 

the smallest value which is higher than the given 

value. A mode of 4 performs linear interpolation 

between adjacent cells. Having determined the 

modes, the program searches the row and column 

headers for the input values. Having identified row 

and column numbers, it can then return (or 

interpolate) values from the main table. 

equroot Takes two arguments. Returns a single root of a 

polynomial defined by the given array of 

coefficients. 

pwl Takes two arguments. Returns y given x given an 

array of values defining a 2D graph 

pwlt Takes two arguments. Returns y given x given an 

array of values defining a 2D graph and returns an 

error if an attempt is made to interpolate beyond 

the extent of the graph. 

 Variables 

parent.type 

parent.length 

The value of type is 1 for points, 2 for lines, 3 for surfaces 

and 4 for volumes, allowing expressions like “IF 

(parent.type = 1, ...” to be created. Having checked that the 

parent type is indeed a line, the variable ‘length’ may safely 

be used, as: L = IF(parent.type = 1, parent.length, 0) will set 

L to 0 for points, surfaces and volumes. 

member.length  Returns the length of the combined line parent of the line, if 

there is one, or the length of the line if there isn’t. 

parent.x  Returns the parametric distance along the parent at which 

the calculation is being performed. 

member.x Returns the parametric distance along the parent at which 
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the calculation is being performed. 

User Defined Results Scopes 

Name scoping (an association of a name to an entity, such as a component or variable) 

can be used within the User Defined Results facility to help clarify the actual meaning 

of an included component or variable. Name scoping is optional as long as there is no 

ambiguity. 

“Parent” The feature containing the location being evaluated, 

offering values such as type and radius. 

“material” The material attribute assigned to the feature containing the 

location being evaluated, offering values such as E and rho. 

“composite” The composite attribute assigned to the feature containing 

the location being evaluated, offering values such as layer 

name and material. 

“damping”  The damping attribute assigned to the feature containing the 

location being evaluated, offering values such as ar and br. 

“geometric” The geometric attribute assigned to the feature containing 

the location being evaluated, offering values such as A and 

Iyy. 

“age”  The age attribute assigned to the feature containing the 

location being evaluated, offering the single value age. 

“mesh”  The mesh attribute assigned to the feature containing the 

location being evaluated, offering values such as ratio and 

size. 

“equivalence”  The equivalence attribute assigned to the feature containing 

the location being evaluated, offering the single value 

tolerance. 

“design” The design code attribute assigned to the feature containing 

the location being evaluated, containing values specified by 

the design code author. 

“entity”  The result entity within which this UDR expression 

appears, offering values such as DX or Fy as appropriate 

“loadcase” The loadcase specified within the UDR expression, offering 

values such as ldnum. 

“global” The global coordinates of the location being considered, 

offering the values X, Y and Z. 
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“scripted” The scripted result entity. 

“displacement”  The results entity displacement, offering values such as DX, 

DY,DZ and RSLT 

“forceMoment” The results entity “force/moment”, offering values such as 

Fx, My, and SED 

“stress” The results entity stress, offering values such as SX, Sy and 

Sx(Fx) 

“stressTop” The results entity stress(top), offering values such as SX 

and SY (and similarly for Middle and Bottom) 

“strain” The results entity strain, offering values such as EX and 

EY. 

“strainTop” The results entity strain(top), offering values such as EX 

and EY (and similarly for Middle and Bottom. 

“Potentials” Consistent with its structural equivalent. 

“Flux”  Consistent with its structural equivalent. 

"Gradient” Consistent with its structural equivalent. 

“reaction”  The results entity reaction, offering values such as FX and 

RSLT 

Notes 

 The following attribute scopes cannot currently be used since they can be 

assigned multiple times, and as a result their values cannot be considered to be 

unique: “loading”, “support”, “slideline”, “constraint”, “retained freedom”, 

“activate”, “deactivate”, “influence”, “search area”. 

 The following results entity scopes cannot currently be used since their names 

cannot be considered to be unique: “loading”, “support”, “slideline”, 

“velocity”, “acceleration”. 
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Appendix E : 

Working with 

larger models 

  

How to speed up LUSAS Modeller when working with 

larger models 

LUSAS Modeller’s default settings and its general use are intended to be convenient 

and suitable for most models, however these default behaviours may need to be 

adjusted to speed up Modeller's performance for larger models. The headings below 

contain details of how to do this. 

Use mesh lock when making multiple modifications to a model 

By default, Modeller remeshes a model every time it identifies a change has been 

made that requires this to happen. Obvious examples of this include editing of model 

geometry, or mesh definitions, but there are many less obvious occasions when this 

will occur. For smaller models this remeshing process may only take a few seconds, 

but for larger models it may cause some noticeable delays. If multiple modifications to 

attributes and/or geometry are required, it may be best to lock the mesh in advance 

using the Tools > Mesh lock menu item, make the changes and then unlock the mesh 

using the Tools > Mesh lock menu item again so that only one remesh operation will 

take place. See "About Meshing" on page 182 for more details. 

Close results files when editing geometry or mesh details 

Making changes to the geometry or mesh whilst results are loaded causes Modeller a 

lot of additional processing because it must keep track of which elements are still 

valid, and can still show results, and which have been deleted or modified and 

therefore can no longer show results. Many of these operations will run faster if results 

files are closed prior to the changes being made by selecting the File> Close All 

Results Files menu item.  
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Turn-off visibility feedback in the Groups treeview 

In the Groups  treeview, whether all, some or no objects are currently visible in a 

group is visualised by green ticks and red crosses. To keep these 'statuses' up-to-date, 

Modeller must recompute every tick every time anything is made visible or invisible. 

In each case it is necessary to compare a long list of elements (the visible set) against 

many other long lists of elements (each group definition). For large models, with lots 

of groups, this usually takes much longer than the operation itself – often several 

minutes each and every time the user changes any kind of visibility. Ensuring that the 

option at the bottom of the Groups treeview to 'Show visibility feedback in treeview' is 

not selected will usually result in a much better performance. See "Groups" on page 64 

for more details. 

Turn-off averaging of results 

By default, Modeller does not average over discontinuities (e.g. between two different 

materials, or between shells that meet at an angle) and this can be very important when 

looking closely at the detail of a small area of a model. However, for a large model, 

when zoomed out, each element is represented by only a few pixels, and so this detail 

is rarely noticeable. Modeller performs a lot of operations to determine whether or not 

to average at a feature boundary. Simply asking for unaveraged contours instead of 

averaged contours on a results properties dialog avoids all this extra work. Engineering 

judgement should be used to decide when averaging should be used or not. 

An 'Averaging settings' dialog can also be accessed by selecting the File > Model 

properties menu item and selecting the 'Options' tab and choosing 'Averaging 

Options'. Switching checks off will improve performance, but engineering judgement 

must be used – these settings are important when unaveraged results should be 

presented. 

Visualise loading by coloured geometry and not by arrows 

Modeller’s default loading visualisation is for a cyan arrow at each assigned node. 

This can be very useful when looking closely at the detail of a small area of a model. 

However, for a large model, when zoomed out, each element is represented by only a 

few pixels, and so this detail is rarely noticeable. By visiting the Attributes layer's 

properties dialog and selecting the 'Loading' tab and choosing the 'Settings' option, a 

much faster visualisation is available by choosing 'Visualise by colouring geometry' 

instead of 'Visualise using arrows'. Engineering judgement should be used to decide 

when each representation is appropriate. See "Attributes" on page 175 for more 

details. 

Minimise the number of patch load divisions 

The 'Patch divisions' dialog that can be accessed from the Patch divisions object in the 

Attributes treeview allows control of how many individual loads are considered for 

each patch. For many elements (e.g. surface elements) there is no point in having a 

density of loads which is greater than one load for every element contained by the 

patch. However, when using line beam elements, loading that varies between nodes is 
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accounted for in the force diagrams by way of a post-processing technique – i.e. patch 

divisions will be reflected within the length of one beam element. Therefore having a 

few loaded patch points per each beam element is suggested. See Default Patch 

Divisions and "Discrete Structural Loads" on page 415 for more details. 

Minimise search area calculations with grillage models  

In a typical grillage model, the use of one grillage element along each longitudinal and 

transverse member is usually adequate. With this modelling approach, typically two 

transverse and two longitudinal members together make a “loading cell” (an enclosed 

quadrilateral). This means that each cell typically contains four elements. When trying 

to identify loading cells, Modeller follows “chains” of connected elements, checking 

for a closed loop. In some models, large numbers of lines, or large numbers of 

elements per lines can nonetheless form a loop and therefore a loading cell. Note that: 

 Reducing the number of elements that Modeller searches will improve 

performance – but larger loading cells will be missed. 

 Increasing the number of elements that Modeller searches finds those larger 

cells, but this has an impact on speed. 

An option is available from LUSAS Technical Support to change the number of 

elements that Modeller searches for, but in general it is better to build models without 

such large loading cells.  

Cache results 

Some results inevitably take a long time to compute. To show accurate results for an 

envelope of 1000 loadcases, Modeller must do 1000 times as much work as for a 

single loadcase alone. It is possible to save the results of such long computations, to 

avoid recomputation. It is also possible to request that calculates these results 

immediately after a solution. To do this, use the print results wizard user interface to 

define the results of interest, and then make appropriate selections on the 

Combinations and Envelopes Options dialog (which is accessed from the 

Combinations and envelopes object in the Analyses treeview) to compute those results 

each time the job is solved. 

Turn-off fleshing 

When working with larger models that have tapering members, significant calculation 

are involved in working out the properties for each and every element within the 

tapering sections in order to generate the fleshed shape. Saving a model without 

fleshing active will speed-up the loading time next time the model is opened. 

Turn-off datatips 

Datatips are a convenient and useful way of quickly obtaining basic information about 

an object under the mouse. Windows triggers a request for a datatip every time the 

mouse stops moving. Modeller then has to determine which objects are under the 
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mouse, and prepare a datatip for each. When there are a very large number of objects 

under the mouse, this can take a noticeable period of time, which can affect the 

response of the mouse. Turning off datatips by selecting the View > Show datatips 

menu item solves this problem. 

Turn off unwanted drawing layers 

For a large model, each drawing layer can take significant time to gather information 

and to actually draw, and that time is often wasted if the resulting image is (for 

example) hidden behind contours. Turning off unwanted drawing layers (especially the 

deformed mesh) can make a considerable difference. 

Reduce recalculation of results where possible 

In general, it will be necessary for LUSAS to recalculate/reassemble results when: 

 The results entity plotted is changed; for example from "Displacement" to 

"Force/Moment - Thick Shell". 

 The loadcase that is set active is changed. 

 A results transformation is changed. 

 The results component is changed for an envelope. 

 The visibilty of groups/features/elements iin the model is changed. 

  Results plots are changed. 

  Wood Armer options are changed. 

When values of 'Displacement' and component 'DX' are plotted, for example, all 

component results for 'Displacement' will be assembled and cached in memory. If 

subsequently values of 'DY' are plotted, the display of those results will straight from 

the cache in memory. If values of 'Force/Moment - Thick Shell' and component 

'My"'are subsequently chosen the cached displacement results will be discarded and all 

results components for 'Force/Moment - Thick Shell' will then be assembled and 

cached. For efficiency when working with a large model, or when post-processing 

large quantities of data with a script then it is best to avoid changing between plots of 

one entity, then another and back again, or between plots for one active loadcase, then 

another and then back again. Methodical post-processing of the model one entity at a 

time where possible will reduce time spent recalculating results. 

Disable undo 

Undo can be useful when creating a model, but if you are not using undo, then keeping 

the undo information up-to-date can waste significant time and memory. To disable 

undo, select the File > Model properties menu item and on the 'General' tab deselect 

the option 'Enable undo'. 
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Work on a local hard drive, not over a network 

LUSAS strongly recommends working on a local hard drive and not over a network. 

However, if files must be saved on a network drive, you must ensure that the time and 

date settings on both machines match. If there is any difference between the time and 

date of the processing machine and that of the network disk, Modeller will wait each 

and every time it saves a file to ensure that files cannot appear to have been created in 

the future. 

There is more information on this User Area (password protected) 

page: http://www.lusas.com/protected/instruct/file_management.html 

Act on modelling / meshing warnings 

Large numbers of warning messages can take a very long time to be displayed. If you 

are seeing 100s of warning messages whenever you perform some operations 

(e.g.when re-meshing), it is suggested to resolve these warnings to avoid constant 

reminders. 

Optimise the mesh density 

Optimise the mesh density and avoid an excessively fine mesh. Start with a coarser 

mesh when testing the model or developing it and then refine the mesh if needed. 

Consideration should always be given to the mesh refinement to avoid the following 

pitfalls: 

  Mesh too coarse. Using a small number of elements may produce stress 

results which are significantly different from the stresses in the "real" structure. 

Moreover, a coarse mesh may produce results which are unconservative for 

design purposes. 

 Mesh too fine. Beyond a certain level of refinement, the accuracy of the results 

does not improve significantly. Using a more refined mesh will increase the 

time taken to carry out the solution and the subsequent time to interactively 

process results. In extreme cases hardware resource problems may be 

encountered when attempting to solve the model or display results graphically. 

Batch processing 

Modeller has a very powerful scripting interface. It is easy to record sessions, saving 

the instructions as a script, and replay those instructions later. This makes it easy to 

(for example) create a script which produces reports, animations, and screen captures 

for later viewing. Such a script can be run overnight to save time during working 

hours. 

Check the status of your Windows operating system 

Windows itself can become slow as resources are used up. Here are some basic 

checks: 
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1. Run Task Manager and check the Performance tab. If the “free” memory 

number is close to zero, when compared to the total, consider closing some 

other applications, or buying extra RAM. 

2. Run Windows Explorer and check the properties of the C: drive. If for 

example there is less than 15% free space, consider following Windows 

instructions for deleting unwanted files, or buying a larger hard disk. 

3. Run Windows Explorer and check the properties of the drive on which 

LUSAS is saving files. If for example there is less than 15% free space, 

consider following Windows instructions for deleting unwanted files, or 

buying a larger hard disk. 

For more information see these pages on the LUSAS User Area: 

http://www.lusas.com/protected/instruct/clearing_temporary_files.html 

http://www.lusas.com/protected/instruct/relocating_virtual_memory.html 

http://www.lusas.com/protected/instruct/relocating_lusas_temp.html 

http://www.lusas.com/protected/instruct/relocating_windows_temp.html#all 

http://www.lusas.com/protected/instruct/upgrade_pc_hardware.html 

Further information 

For more suggestions see the following page in the LUSAS User Area: 

 http://www.lusas.com/protected/instruct/tips_for_large_models.html 

file:///C:/SVN/Content/1using/Treeview_Icons.htm
file:///C:/SVN/Content/1using/Treeview_Icons.htm
file:///C:/SVN/Content/1using/Treeview_Icons.htm
file:///C:/SVN/Content/1using/Treeview_Icons.htm
file:///C:/SVN/Content/1using/Treeview_Icons.htm
http://www.lusas.com/protected/instruct/tips_for_large_models.html


  Index 

    

  

Index 

. 

.eps files, 97 

.ps files, 97 

.wmf files, 97 

3 

32 bit solver, 650 

6 

64 bit solver, 650 

A 

absolute envelope, 672 

Acceleration loading, 414 

activation/deactivation of elements, 

477 

active composite lamina, 462, 662 

active fibre, 662 

active load case, 661 

active loadcase, 661 

setting, 518 

active mesh, 182 

advanced selection, 60 

Age, 501 

Akhras-Dhatt optimiser, 647 

analyses symbols explained, 583 

Analyses treeview, 581 

analysis, 649, 651 

branching, 591 

failed, 651 
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Area 

selection modifers, 59 

Area Selection, 807 

assign, 175 

associativity, 119 

attribute symbols explained, 177 

attributes, 175, 177, 181, 182, 397 

dependency across analyses, 588 

manipulation, 178 

transfer between models, 101 

visualising, 180 

Australia steel sections, 249 

automatic equivalencing, 486 

axes, 453 

changing element orientation, 169 

displaying element axes, 184 

local coordinate systems, 452 

axisymmetric, 633 

B 

background grid, 194 

backing-up model data, 87 

backup, 82 

Backups, 86 

base analyses, 587, 590 

Base analyses 

creating, 588 

basic combination, 672, 678 

beam cross-section, 222, 223 

beam loads, 411, 412 

beam stress resultants from shell 

models, 734 

beam stresses 

displaying, 730 

bending moment diagrams, 713 

BFP loading, 404 

BIM files 

import and export, 107 

birth and death, 477 

bmp, 98 

BMP, 763 

boolean geometry, 155 

boundary discretisation, 192 

branched analyses, 591 

bridge deck geometric attributes, 230 

bridge deck grillage material, 282 

Browsing Selected Features, 59, 808 

buckling analysis, 612, 618 

buckling lengths 

defining, 246 

C 

cable tuning analysis, 643 

cables 

modelling sag, 201 

modelling without sag, 202 

cache results, 681 

CAD, 173 

Canada steel sections, 249 

case studies, 77, 173, 191 

geometry, 173 

meshing, 191 

case study 

arbitrary section calculation of a 

compound section, 578 

cable stay analysis, 493, 496 

CBF loading, 404 

centripetal stiffening, 617 

China steel sections, 249 

Cholesky  solver, 647 

CL loading, 404, 405 

combination 

examine calculations, 761 

show total contributions, 762 
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combinations, 672, 783 

Combinations and envelopes, 672 

advanced options, 681 

combined line, 119, 136 

command files, 96, 117 

composite analysis, 455, 709 

Composite Damage Model, 341 

Composite layup 

defining, 458 

definition methods, 455 

visualisation, 459 

Composite model data 

visualisation, 462 

compound material 

reinforced concrete, 329 

compound sections 

defining, 258 

section property calculation, 575 

compression only 

linear material, 369 

compression only bar material, 370 

concentrated load, 404 

concrete (nonlinear), 284 

concrete (reinforced), 329 

concrete material model, 268, 724 

concrete sections library, 249 

conduction, 503 

conjugate gradient solver, 647 

Connecting beams and shells, 197 

Connecting shells and solids, 198 

consolidation analysis, 611 

constant body force, 403 

constraint equations, 470 

dependency across 

analyses/loadcases, 474 

contact, 463, 503 

contact support, 392 

context menu, 21 

contouring, 712 

contouring attributes, 180 

contract treeview items, 583 

convection, 503 

coordinate system, 452 

coplanar neighbours 

selecting, 60 

copying geometry, 157 

coupled analysis, 628 

crack patterns, 724 

Crack width calculation methods, 707 

crash recovery, 655 

creating, 748 

creep, 268, 340, 368, 610 

creep and shrinkage, AASHTO LRFD 

7th, 286 

creep and shrinkage, CEB-FIP 1990, 

292 

creep and shrinkage, EN1992, 295 

creep and shrinkage, fib moxcel code 

2010, 299 

creep and shrinkage, IRC 

112, 304 

creep and shrinkage, JTG 3362-2018, 

307 

Cross-section, 224 

crushing material model, 365 

crushing symbols, 724 

cursor 

selection filters, 56 

selection tool, 55 

Cursor 

selection modifiers, 59 

cusping 

accuracy of influence solution, 639 

customize startup templates, 76 

Cuthill-McKee optimiser, 647 

cycling geometric features, 169 
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D 

Damage, 341, 368 

damping, 476 

DAT, 90, 114 

deactivate elements, 477 

deassigning attributes, 181 

deassigning supports, 397 

default assignment, 228 

default attribute assignment, 177 

defining member buckling lengths, 

246 

defining surface, 227 

definition for Surface, 227 

deformed mesh, 712 

delamination model, 213, 359 

deleting geometric features, 119 

derived components, 669 

design combinations, 682 

Diagonal Decay, 794 

diagonal solver, 647 

diagrams, 721 

differences between, 338, 354 

dimetric, 811 

Direct Method Influence, 490 

Direct Method Influence Analysis - 

general use, 639 

Direct Method Influence Analysis - 

Rail use, 641 

direct method influence attributes 

defining, 490 

direct Method Influence attributes 

assigning, 491 

Direction Definition, 563 

discrete loads, 415 

editing, 423, 442 

Discrete loads 

hygro-thermal, 436 

Discrete Thermal Loads, 436 

discretisation, 182 

displacement loading, 413 

Displaying results for attributes, 723 

Displaying results for groups, 722 

distance interpretation 

multiple varying sections, 251 

distributed load, 405 

distributed mass, 211 

Distributed Perimeter Load, 406 

drained soil, 484 

drained/undrained soil, 343 

draping, 457 

Draping grid 

extending, 461 

visualisation, 461 

drawing attribute labels, 182 

Drucker-Prager material model, 338, 

355 

Duncan-Chang, 347 

DXF, 108 

dynamic analysis, 621, 624 

E 

earth pressure 

tri-linear joint material, 376 

Eccentricities, 225 

multiple varying sections, 252 

Eccentricity, 227 

edge collapsing, 192 

eigenvalue analysis, 612, 620, 800 

elasto-plastic interface material, 357, 

360 

elasto-plastic material, 268, 331, 332, 

334, 338, 354, 355 
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ELDS loading, 411, 412 

Ellipse, 133 

Elliptical arc, 133 

emulating behaviour, 17 

envelope 

examine calculations, 761 

Envelope examples, 680 

envelopes, 672, 675 

environmental load, 427, 432 

ENVT/TDET loading, 427, 432 

equivalencing, 485 

error reporting 

automated, 655 

manual, 655 

errors, 793 

EU steel sections, 249 

examine calculations 

combinations, envelopes, 761 

expand treeview items, 583 

Export 

files, 102 

Exporting a Solver data file, 104 

Expose, 97 

Expressions 

supported, 813 

F 

facet, 121 

failed analysis, 651 

Fast Parallel Solvers, 645 

fatigue analysis, 683 

feature based models, 34 

Feature Selection, 805 

feature-based models, 34 

FiberSIM 

defining composite stack, 457 

Fibre directions 

visualisation, 461 

Fibre locations, 733 

definition and adding, 224 

field analysis, 624 

field loads, 426 

File 

backups, 86 

File and folder naming 

260 character path limit, 89 

file locations, 86 

file types, 81, 82, 90, 91, 94, 96, 98, 

101 

find 

by advanced selection, 60 

location of assigned influence 

attribute, 500 

Fixing Mesh Problems, 199 

FLD loading, 405 

fleshing, 229 

Floor loading, 406 

flow, 393 

Flux patch load, 437 

foam material model, 365 

Fourier   expansion, 744 

Fourier analysis, 633 

Fourier results, 707, 743 

frequency analysis, 612 

frequency response, 689 

Friction Pendulum, 373 

Frictional slideline, 463 

Functions 

supported, 813 

G 

general loads, 415 

geometric Attributes, 224 
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Geometric Attributes, 228 

geometric nonlinearity, 599 

Geometric Properties, 220 

geometry, 119 

geometry orientation, 169 

geostatic control, 611 

gnl, 599 

graph wizard, 727, 743 

graphing, 743, 744 

gravity loading, 401 

Grid layout, 149 

group symbols explained, 67 

groups, 64 

Guyan reduction analysis, 475, 615 

H 

HA/HB loading, 415 

Hashin failure contours, 710 

Hashin material model, 341 

Heat of Hydration, 329 

heat transfer, 503 

Heat transfer, 503 

hexahedral, 145 

highway load, 415 

Hill yield criteria, 332 

Hoek-Brown, 349 

Hoffman yield criteria, 332 

holes 

creating in surfaces, 139 

hollow volume, 148 

home view, 47 

hook contact, 376 

how to speed up modeller when 

working with larger models, 819 

Hydration, 329 

hygro-thermal / structural coupled 

analysis, 630 

carrying out, 631 

hygro-thermal analysis 

load curves, 520 

hygro-thermal loading, 429 

Hygro-thermal loads 

discrete, 436 

hygro-thermal material, 274 

hyper-elasticity, 363 

hysteretic joint material, 383 

I 

IFFLR, 710 

IGES, 111 

IMD, 620, 685, 743 

IMDPlus, 685 

IMDPlus analysis, 692 

impact analysis, 463, 624 

Import 

files, 104 

interface file data, 105 

options, 104, 106 

included joints and end releases for 

beam elements, 187 

India steel sections, 249 

Influence Analysis, 635 

Influence Analysis Attributes, 637 

Influence Attributes, 487, 488, 490 

Influence solutions 

accuracy, 638 

Initial Acceleration, 414 

Initial state 

of analysis, 585 

inspection locations 

viewing results, 721 

Inspection locations, 507 
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Intelligent averaging, 664 

interactive modal dynamics, 685 

interface elements, 208, 213 

interface files, 99 

interface material models, 724 

internal point 

thick beam elements, 186 

inverse iteration solver, 616 

Isometric, 810 

isotropic material, 268 

J 

Joint 

defining and assigning, 208 

local axes, 210 

material properties, 211 

Joint and interface elements, 208 

joint material models, 372 

Joint Models, 372, 373 

joints 

automatic insertion to ends of line 

beams, 208 

general settings required, 373 

jpeg, 98 

JPG, 763 

K 

K0 initialisation, 346 

keyboard 

mapping modifiers, 60 

Keyboard modifiers, 808 

keyboard shortcuts, 805 

knife edge load, 415 

KS steel sections, 249 

L 

labels, 124, 182 

Lamina thicknesses, 459 

Lanczos, 617 

lane load, 415 

large strains, 363 

larger models 

suggestions for working with, 819 

layer symbols explained, 54 

layers 

using, 53 

Layout grids, 149 

layup 

methods, 455 

Layup 

defining a composite stack, 458 

visualisation, 459 

Lead Rubber Bearings, 373 

libraries, 265, 267, 564 

library files, 557 

Licensing, 15, 648 

lift-off, 376 

lift-off support, 391 

line 

define with respect to a layout grid, 

151 

Line by manifolding, 129 

line elements, 216 

line feature, 119, 127 

line reinforcement, 548 

linear, 372 

lines 

defining, 127 

reversing direction, 169 

load combinations, 672 

load curves, 515, 518, 661 

load envelopes, 672 
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Load train, 415, 436 

loadcase 

create from basic combination, 676 

loadcases 

creating, 513 

manipulating, 517, 675 

viewing assignments, 517 

Loadcases 

creating, 515 

loading 

assigning to a load curve, 521 

assignment of, 400 

dependency across 

analyses/loadcases, 402 

hygro-thermal, 429 

variation with time, 515 

visualising, 228, 402 

loading attributes 

assigning and manipulating, 399 

Loading grid 

for influence attribute use, 494 

loading grid examples, 495 

local and global results, 666 

local coordinate, 452 

local sections, 249 

LT, 17 

lumped mass, 211 

M 

main panels, 18 

Manifolding, 144 

manipulating attributes, 177 

manipulating geometric features, 169 

manipulating the view, 47 

mass lumping, 211 

master degrees of freedom, 475 

master slideline, 463 

material data 

editing, 264 

material libraries, 265, 267, 564 

material models, 268, 269, 270, 271, 

284, 286, 292, 295, 299, 304, 307, 

311, 322, 329, 331, 332, 334, 335, 

337, 338, 340, 341, 342, 343, 347, 

349, 351, 353, 354, 355, 357, 359, 

360, 361, 363, 365, 368, 369, 371, 

372, 376, 380, 382, 383 

material properties, 262, 313 

materials 

dependency across analyses, 229, 

265 

matrix properties 

for pile group, 390 

maximum value plots, 712 

maximum/minimum load, 672 

merging geometric features, 162 

mesh, 156, 182 

refinement, 200 

mesh divisions, 182 

mesh lock, 200 

mesh objects, 33 

Mesh only models, 34 

mesh reset, 200 

mesh utilities, 199 

meshing 

connecting shells and solids, 198 

Meshing 

connecting beams and shells, 197 

meshing techniques, 192 

Mesh-only models, 34 

minimum value plots, 712 

mirror plane, 159 

Modal damping, 616 

modal dynamics, 685 

model 

creating new, 28 

creation of new, 28 
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new from commad line input, 31 

model file, 82 

Model folders, 86 

model merge, 87 

model recovery, 655 

model types, 33 

Model:, 86 

modeller licence selection, 15 

modelling cables 

methods and options available, 201 

Modified Cam-clay, 351 

modified mohr coulomb, 337, 353 

mohr coulomb friction interface 

material, 357, 361 

Mohr-Coulomb material model, 335 

Mohr-Coulomb material models 

differences between, 338, 354 

moving geometry, 157 

Moving load analysis 

with IMDPlus, 693 

Moving mass analysis 

with IMDPlus, 694 

Multiple varying sections, 250 

distance types and methods of 

assignment, 255 

N 

named components, 64 

Negative Jacobian Errors, 793 

Negative Pivot, 796 

New Zealand steel sections, 249 

nodal equivalencing, 485 

nodes, elements, geometry, 565 

nonlinear, 372 

nonlinear analysis, 262, 596, 604 

nonlinear loadcase controls 

manual or automatic?, 607 

Non-Orthogonal Model Views, 810 

Non-structural mass elements, 211 

notes 

adding to a report, 778 

O 

one-click reporting, 558 

one-click reports, 558 

adding to main report, 561 

orientation of geometry, 169 

Orthogonal Model Views, 810 

orthotropic material model, 268 

output, 657, 712 

P 

page layout, 70 

panning, 47 

patch load, 415 

Paths, 553 

PATRAN, 115 

p-delta analysis, 600 

PDSP/TPDSP loading, 426, 431 

peak value plots, 712 

pen colour 

of selected items, 62 

pen library, 51 

pentahedral, 145 

Perimeter loading, 406 

phi-c reduction 

attribute, 483 

picture files, 97 

pictures, 763 

piecewise linear bar material, 369 
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piecewise linear joint material (axial 

force depedendent), 382 

piecewise linear joint material 

(general), 380 

piecewise linear joint material 

(hysteretic), 383 

pile group 

matrix properties, 390 

Pivot Errors, 798 

pivot problems, 793 

Planar, 126 

Planar selection options, 806 

playback 

script, 95 

plotting results on a graph, 743 

plus elements, 215 

png, 98 

PNG, 763 

point feature, 119, 126 

point load, 415 

point mass, 211 

points 

defining, 125 

polymer material model, 368 

pore pressure, 343, 393 

power spectral density, 690 

prescribed loads, 413 

prestress 

reporting, 773 

prestress report 

including setting-out information, 

774 

pretress parameters 

material library, 266 

print results wizard, 751 

printed output, 751 

Printing and Saving Pictures, 763 

progress bar, 683 

properties, 262, 476, 503 

properties panel, 62 

PRW, 751 

PSD response, 685 

R 

radiation properties, 503 

Rate of Heat Inflow 

point load, 437 

raw components, 669 

rc frame design 

bar spacing and crack width 

calculation, 547 

line reinforcement, 548 

section reinforcement, 539 

rc frame design code attributes, 245 

RC slab design attribute, 243 

Reciprocal Theorem, 488 

record 

script, 95 

Reference path, 553 

reference paths 

defining, 554 

deleting, 555 

reinforcement 

line beams, 548 

sections, 539 

Reinforcement 

bar attribute, 239 

Renumbering, 565 

report 

add chapter, 766 

add graph, 772 

add image, 771 

add loadcase results data, 769 

add model data, 768 

add or edit a prestress results 

chapter, 773 

add saved view, 776, 779 
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add user data, 771 

adding notes, 778 

creating, 765 

exporting, 780 

viewing, 780 

report generator, 764 

report symbols explained, 766 

report template, 764 

reports, 558, 764 

resize the model to fit the screen, 47 

response spectrum 

code-based for IMD loadcase, 552 

user-defined for IMD loadcase, 

552 

Restart file 

generation of, 587 

restart files, 90 

Restart options 

for a new analysis, 585 

results, 657, 666, 712, 743, 748 

caching, 681 

display options, 663 

inspection locations, 507 

orientation by default, 713 

sign conventions, 667 

user-defined, 710 

Results 

averaging options, 664 

results file, 657 

results files, 659 

closing, 661 

management of, 93 

opening, 659 

Attributes, 506 

results transformation, 666 

retained freedoms, 475 

reversing geometric features, 169 

rigid zones 

meshing, 187 

Rigid Zones, 203 

rigidities, 270 

rubber material models, 363 

S 

Saved views, 51 

scaling geometry, 157 

script 

recording, 77 

script files, 94, 96 

Scripts 

running with toolbar buttons, 79 

scrolling the model, 47 

search areas, 443 

processing loads outside, 446 

section library, 248 

Section property calculation, 571 

multiple varying sections, 253 

section property modification, 222 

section reinforcement, 539 

section through the model, 725 

Seismic analysis 

with IMDPlus, 692 

with PSD, 685 

seismic isolator, 373 

selecting model features, 54, 805 

selection 

advanced, 60 

chanbging pen colour, 62 

cycling through items, 61 

Selection 

cumulative, 59, 807 

selection memory, 61 

Selection Modifiers, 808 

selection panels, 20 

sending files to LUSAS technical 

support, 653 
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Sending files to LUSAS technical 

support, 654 

server sections, 249 

session file, 96 

set default, 177 

setting active composite lamina, 462 

setting the environment colours and 

style, 73 

shape wizard, 154 

shear force diagrams, 712 

sign conventions 

results, 667 

Simulayt, 457 

slave degrees of freedom, 475 

slave slideline, 463 

slice, 725 

slicing 

of beam and shell models, 734 

slidelines, 463, 744 

results, 740 

Sloan optimiser, 648 

smart combinations, 783 

Smart combinations, 673 

smoothed multi-crack concrete, 322 

S-N curve, 683 

soil 

active/passive pressure modelling, 

376 

soil material modelling, 343 

soil stresses 

K0 initialisation, 346 

solver, 648 

32 bit or 64 bit, 650 

solver restart files, 90 

solver results files, 91 

Solvers supported, 644 

Sorting of nodal results, 755 

spectral response, 620, 686 

splitting geometric features, 135, 142 

splitting options, 142 

SSI and SSR loading, 410 

staged construction 

activation and deactivation, 477 

Standard sections 

calculation of properties, 571 

startup templates, 76 

steel design code attributes, 245 

steel design code checking, 704 

steel section library, 248 

STEP, 116 

stiffness analysis, 612 

STL, 116 

strain profile 

general, 407 

stress and strain, 410 

stress potential, 332 

stress resultant material model, 331 

stress vectors, 718 

structural damping, 476 

structural loads, 403 

structural supports, 391 

Sturm sequence check, 616 

subspace iteration solver, 614 

superelements, 475 

Support tool, 654 

supports, 391 

assigning, 395 

dependency across 

analyses/loadcases, 396 

visualising, 397 

surface elements, 218 

surface feature, 119, 138 

surfaces 

defining, 138 

orientating axes, 169 

sweeping geomtry, 157 
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T 

tabulating a solver data file, 104 

Tapering, 223 

target values, 696, 698 

TDET loading, 427, 432 

TEMP loading, 406 

temperature dependent materials 

defining, 265 

temperature loading, 406 

temperature profile 

general, 407 

tendon loading, 412 

tension only 

linear material, 369 

tension only bar material, 370 

thermal analysis, 426, 503, 624, 625 

thermal link 

defining geometric properties, 228 

thermal loading, 426 

Thermal loads 

discrete, 436 

thermal supports, 394 

thermal surface graphs, 743 

Thermal Surface Results, 743 

thermal surfaces, 503 

Thermal surfaces, 503 

thermal-structural coupled analysis, 

628 

thermo-mechanical coupled analysis, 

628 

Thickness, 227 

thin walled box sections 

section property calculation, 575 

Tied slidelines, 463 

time history, 690 

TMPE loading, 406 

toolbar buttons 

user-defined, 79 

toolbar groups, 78 

customising layout, 78 

toolbars, 77 

tools, 562 

total contributions, 762 

TPDSP loading, 426, 431 

transferring data between models, 101 

transformations, 157 

transforming results, 666 

transient analysis, 621, 624, 625 

transient smoothed multi-crack 

concrete, 313 

translating geometry, 157 

Tresca material model, 331, 354 

trimetric, 811 

troubleshooting, 793 

trouble-shooting, 800 

two-phase analysis, 343 

U 

UDL loading, 405 

UK steel sections, 249 

undo / redo, 69 

undrained soil, 484 

uniformly distributed load, 405 

US steel sections, 249 

User, 249 

User Interface explained, 17 

user-defined results, 710 

utilities, 525 

utilities symbols explained, 527 
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V 

values, 719 

variations, 527 

Varying attributes over features, 527 

vbs, 94, 96 

vectored results plots, 712 

vehicle load optimisation, 642, 643 

vehicle loading, 415 

Velocity loading, 414 

vertical axis, 564 

view, 46, 809 

View Properties, 73 

viscosity, 269, 342 

Viscous dampers, 373 

viscous damping, 476 

visual basic, 94, 96 

Visualise, 222 

visualise users, 177 

visualising, 120, 487, 712, 725, 743 

contour plots, 715 

deformed mesh, 715 

results, 712, 725, 743, 748 

Visualising 

composite properties, 462 

visualising attribute assignments, 180 

volume, 145 

orientating axes, 147 

volume elements, 219 

volume feature, 119, 145 

volumetric crushing material model, 

365 

von-Mises material model, 332, 334 

W 

windows, 46, 811 

Wood Armer, 704 

Attributes, 241 

wood armer attributes, 241 

working with larger models, 819 

Y 

yielded material visualisation, 724 

Z 

Zhu (1999) - mass concrete (China), 

311 

Zoom, 809 

zooming, 47 
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